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Introduction

Purchase Orders provides all the transaction entry, processing, and reporting features you need to 
fully automate your purchase order procedures and meet your management needs.

You can use Purchase Orders to enter and process purchase requisitions, purchase orders, receipts, 
vendor invoices, returns, credit notes, and debit notes. You can also print forms for your requisitions, 
purchase orders, receipts, and returns, as well as mailing labels. 

Purchase Orders takes full advantage of integration with  Inventory Control, if you use it, and Accounts 
Payable, using Inventory Control item numbers and Accounts Payable vendor numbers and other 
information.

It also integrates with Sage Fixed Assets, so you can easily record new company assets, and with 
Project and Job Costing, so you can track committed and actual quantities and costs by contract, 
project, category, and resource.

Transactions in Purchase Orders update item quantities and costs in Inventory Control, and create 
batches of invoices, credit notes, and debit notes in Accounts Payable.

Depending on your purchase agreement, some features described in this guide may not be 
available in your product.

The Purchase Orders User's Guide contains the following chapters:

 l Chapter 1: Setting Up Purchase Orders

Use Purchase Orders setup screens to set up options, vendor information, shipping 
information, General Ledger integration, and other details for your Purchase Orders system.

 l Chapter 2: Entering and Posting Purchase Orders Transactions

Use Purchase Orders transaction entry screens to process purchase orders, requisitions, 
receipts, invoices, returns, credit notes, and debit notes

 l Chapter 3: Periodic Processing in Purchase Orders

Use Purchase Orders Periodic Processing screens to create batches, and to clear history and 
inactive records.  If you use Purchase Orders as a stand-alone program, you can also use the 
Day End Processing screen to run Day End Processing.
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 l Chapter 4: Looking Up Statistics and Information in Purchase Orders

Use Purchase Orders Statistics and Inquiries screens to look up information about vendors and 
transactions.

 l Chapter 5: Printing Purchase Orders Reports and Forms

Use Purchase Orders Reports screens to print setup reports and analytical reports.

Use the report forms that come with Purchase Orders to print purchase orders, requisitions, 
returns, mailing labels, and receiving slips, or select a customized version.

 l Appendix A: Purchase Orders Screen Guides

Learn how to find and use Sage 300 screens. Each screen guide includes navigation 
information, field help, and a list of tasks you can use the screen to perform.

 l Appendix B: Purchase Orders Security Authorizations

If security is turned on for your Sage 300 system, the system administrator must assign these 
security authorizations to users for Purchase Orders screens.

 l Appendix C: Data Entry Tools, Tips, and Shortcuts

Use these tools and shortcuts to speed up data entry in Sage 300. 

 l Appendix D: Support and Resources

Find support and resources to help get Sage 300 up and running quickly.
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Chapter 1: Setting Up Purchase Orders

Set up accounts, security authorizations, records, templates, options, and other details for your 
Purchase Orders system.

Setting up Purchase Orders
You can use Purchase Orders with or without Inventory Control. If you are setting up Purchase 
Orders as a stand-alone program (without Inventory Control), you must set up some additional 
records and options in Purchase Orders.

Before You Start

 l Activate the following   Sage 300 programs: 

 l System Manager (with Bank Services and Tax Services).

 l Accounts Payable.

 l General Ledger (if you use it).

 l Inventory Control (if you use it).

 l Create a company database and choose company-wide options   in Common Services. If 
needed, add information about the currencies used in your Purchase Orders   system.

 l Activate Tax Services, and then add information about   the taxes used in your Purchase Orders 
system. 

To set up your Purchase Orders system:

 1. Activate Purchase Orders, select options, and add background information   and optional fields. 
Mo re ...

 a. Activate the Purchase   Orders program for your data.      

 b. Use the Options screen to specify how your system will operate. For more information, 
see "P/O Options Screen  " (page 344).
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 c. Use the G/L Integration screen to specify how your Purchase Orders program will 
integrate with the General Ledger module. For more information, see "P/O G/L 
Integration Screen" (page 323).

 d. Design coding schemes for your Purchase Orders records.

 e. Add records and print reports for:

 l Account sets (stand-alone program). For more information, see "P/O Account Sets 
Screen   " (page 314).

 l Additional cost codes. For more information, see "P/O Additional Costs Screen" (page 
316).

 l Items (stand-alone program). For more information, see "P/O Items Screen" (page 
335).

 l Optional Fields. For more information, see "P/O Optional Fields Screen  " (page 340).

 l Ship-via codes. For more information, see "P/O Ship-Via Codes Screen" (page 357).

 l Templates. For more information, see "P/O Templates Screen  " (page 359).

 l Vendor contract costs. For more information, see "P/O Vendor Contract Costs Screen" 
(page 362).

 l Vendor details (stand-alone program). For more information, see "P/O Vendor Details 
Screen   " (page 369).

 l Weight Units of Measure (stand-alone program). For more information, see "P/O 
Weight Units of Measure Screen   " (page 372).

 2. Design the formats for your printed and e-mailed forms. Mo re ...

 a. Design and test formats for printing requisitions, purchase orders,   receiving slips, 
returns, and mailing labels, or adapt the sample formats to print on your own forms. For 
more information, see Customizing and Printing Purchase Orders Forms.

 b. Design and test e-mail messages for purchase orders and purchase returns. For more 
information, see "P/O E-mail Messages Screen" (page 321).

 3. Add current transactions. Mo re ...

 a. Add outstanding requisitions.

 b. Add outstanding purchase orders.

 c. Add current invoices, receipts, credit notes, debit notes, and returns.

 d. Print reports of the transactions you added (optional).

To properly set up your Purchase Orders system, you should enter and post all incomplete 
requisitions and purchase orders when you are setting up.
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You use the Requisition Entry and Purchase Order Entry screens to add the transactions. 
When you post purchase orders, quantities on purchase order are updated in Inventory 
Control. For more information, see "P/O Requisition Entry Screen " (page 651) and "P/O 
Purchase Order Entry Screen  " (page 517).

You can run Day End Processing after posting requisitions and purchase orders to update 
history and statistics in both Purchase Orders and Inventory Control (if you keep history and 
statistics in both programs).

You can also add some statistical information from your previous system. For more 
information, see "About Adding Purchase Statistics" (page 72).

 4. Add historical transactions and statistics (optional). Mo re ...

 a. Add purchasing history for previous periods and years.

 b. Add purchasing statistics for previous periods and years.

 c. Print the Purchase History and Purchase Statistics reports. For more information, see 
"P/O Purchase History Report Screen" (page 289) and "P/O Purchase Statistics Report 
Screen" (page 294).

 5. If you are setting up Purchase Orders as a stand-alone program and you want to allow 
fractional quantities, select Allow Fractional Quantities on the Processing tab of the P/O 
Options screen, and add the weight unit of measure. 

Selecting Options for Purchase Orders
After activating Purchase Orders for your company database, you select Purchase Orders 
processing options and enter general information about your purchase orders ledger. You enter this 
information on the P/O Options screen, which you also use to change settings after setup.

About Document Numbers

Purchase Orders can automatically assign document numbers to each purchase order, requisition, 
receipt, and return document you add, or you can type your own document numbers as you enter the 
transactions. (When entering     invoices, credit notes, and debit notes, you use the document numbers 
assigned by your vendors.)

To automatically assign the consecutive, unique document numbers you need to requisitions, 
purchase orders, receipts, and returns, specify the numbers to use on the Document tab of the P/O 
Options screen. You can probably continue using the numbering scheme from your old purchase 
order system.

When you first activate your Purchase Orders system, the program provides   default document 
number lengths, prefixes, and numbers.
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You can change all of the default information, setting a different length,   prefix, and next number for 
each type of document.

Changing the Next Document Number

You can change document number specifications as needed, varying the   lengths, prefixes, or next 
numbers to use.

If you want to change the next number to assign in the P/O Options screen   to a lower number you 
may have used before, you should also change the   prefix for the document type, to avoid accidentally 
creating duplicate   numbers.

Entering Your Own Document Numbers with Transactions

If you enter your own document numbers when you add transactions in   Purchase Orders, the 
program does not update the next number in the Options   screen, even if you use the same number 
as the program would have assigned.   

If the program tries to assign a document number that you entered manually   for another transaction, 
you will see an error message. You must then   change the next number in the Options screen for the 
type of document before   you can resume automatically assigning numbers.

Number of Characters in Document Numbers 

The numbers you assign to requisitions, purchase orders, receipts, and   returns can be up to 22 
characters long, including prefix characters,   if any. You can change the number of characters in any 
of your document   numbers at any time.

Although you do not have to use prefixes in your document numbers, they   are an important means of 
identifying the transaction type and creating   meaningful document numbers. Each prefix must be 
unique and can include   up to six characters.

The next number to assign can contain as many characters as are permitted   by the length you 
specify, minus the prefix characters. If you type a   shorter number, the program places as many 
zeroes in front of it as are   needed for the specified length.

Purchase Orders increases the number for each document type by 1 each   time you post a 
transaction of the type and let the program assign the   document number. You are not forced to use 
the number assigned by the   program (you can type your own numbers); but if you use automatic 
numbering,   your auditing procedures are simplified because you cannot accidentally   skip any 
numbers. 

Numbers assigned to each type of document can go as high as all 9s.   They are then automatically 
reset to zero. 
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Reusing Document Numbers 

You cannot use the same prefix and document number more than once for   requisitions, purchase 
orders, receipts, and returns, unless you first   use the Clear History screen to clear completed 
transactions with the numbers   you wish to reassign. 

When you enter an existing document number, the program assumes you   wish to edit the requisition, 
purchase order, receipt, or return, and   displays the information for the transaction.

If necessary, you can enter more than one invoice, credit note, or debit   note with the same number in 
Purchase Orders, (although you cannot post   duplicate document numbers in Accounts Payable). 
When you enter an existing   document number in the Invoice Entry or Credit/Debit Note Entry screen,   
the program displays a Finder that lets you choose whether to view the   previous transaction or enter 
a new transaction with the same number.

Using Default Document Numbers 

If you do not specify lengths, prefixes, and document numbers, but allow   Purchase Orders to assign 
the numbers, the program automatically assigns   1 as the first number for each document type. The 
assigned number is preceded   by the number of zeroes that will make up the default number of 
characters   set by the program as the number length.

Using Purchase Orders Document Numbers in Inventory Control and Accounts Payable 

Because you can enter receipts in both Inventory Control and Purchase   Orders, and because you 
post Purchase Orders invoices, credit notes, and   debit notes in Accounts Payable, you may want to 
avoid duplicate numbers   in the three programs. You should then take care when assigning document   
numbers in Purchase Orders. 

 l Inventory Control receipt numbers. If you post receipts in both Purchase Orders   and 
Inventory Control, you can assign a different prefix and next number   for receipts in the two 
programs so that you easily identify the program   where a receipt was entered.

 l Using unique invoice, credit note, and debit note numbers. To avoid conflicts   with the 
document numbers you assign to invoices, credit notes, and debit   notes in Accounts Payable, 
use unique prefix and number combinations for   these transactions when you post them in 
Purchase Orders.

Processing and Posting Options

Set up Purchase Orders options for processing and posting transactions, and for running Day End 
Processing.
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About Selecting Processing Options

Use the Processing tab of the P/O Options screen to set options that determine how Purchase    Orders 
processes transactions, including whether it:

 l Permits entry of transactions       using item numbers that are not included in Inventory Control 
(Allow Non-inventory       Items option). For more information, see "About Allowing Entry of Non-
inventory Item Numbers" (page 9).

 l Saves transaction history       (all details of posted transactions) to a file for reporting (Keep 
Transaction       History option).

 l Keeps a list of all the       vendors from whom you purchase individual items (Accumulate Purchase 
History       option).  For more information, see "About Accumulating Purchase History" (page 14).

 l Saves statistical totals       from posted transactions (Accumulate Statistics option).  For more 
information, see "About Accumulating Statistics" (page 14).

 l Requires requisition approval      before they can be added to purchase orders.  For more 
information, see "About Requiring Approval for Requisitions" (page 734).

You can also specify the following information:

 l Default Template Code—for       the information that is displayed when you enter new purchase 
orders      and requisitions. For more information, see "About Templates" (page 60).

 l The Default       Item Cost       —costing method for default item costs that appear for transaction detail 
lines, if you use Inventory Control.  For more information, see "About Default Item Cost" (page 
9).       (If you do not use Inventory Control, the default item cost is set to      Vendor Cost.)

 l Item Options, if you do not use Inventory Control:

 l Choose whether to       process transactions that use fractional quantities      of items.

 l Set the weight unit       of measure that Purchase Orders will use to allocate additional charges       to 
items by weight. If necessary, you can change the weight unit of measure       after setting up 
your system. However, if you have entered any weights       in item records, you will need to 
change them so they correspond to the      new unit of measure.   For more information, see 
"About Weight Units of Measure" (page 13).

 l Set the default aging       periods by which the program groups outstanding orders on reports. Mo re ...

Purchase Orders groups outstanding transactions for the Aged Purchase     Orders report into 
five periods: a current (not due) period and four previous     periods. 

You specify the length of each aging period on the Processing    tab of the P/O Options screen.

Note: You can specify different periods when you are printing the report, and    you can 
change the default periods at any time.

8Sage 300 2021 Purchase Orders User's Guide



In multicurrency    systems, you can also check the functional currency for     the ledger and the choice for 
the Multicurrency option, and you can specify a default rate type. For more information, see "About 
Specifying Currency Information" (page 23).

About Allowing Entry of Non-inventory Item Numbers

All purchase order documents require item numbers and details before     you can save and post the 
transactions. The Allow Non-inventory Items     option lets you use item numbers in Purchase Orders 
that you have not    added to your Sage 300 Inventory Control system.

Non-inventory items can include non-stock items you have not added to     Inventory Control, items you 
plan to add to Inventory Control later, one-time    purchases, services, and items needed for use in your 
business.

Purchase Orders does not update item quantities or other information     in Inventory Control when you 
post transactions for non-inventory items.     The general ledger entries for non-inventory details are 
created in Accounts     Payable, so are not listed on the G/L Transactions List if you print it    from 
Purchase Orders.

When entering details for non-inventory items, you must type an item     number, using up to 24 
characters (including separators), and a description     of up to 60 characters. You also specify a 
general ledger expense account    number for each non-inventory detail. 

When Not to Use the Option

Do     not select the option if you want to enter transactions only for items     that are defined in Inventory 
Control, so that item details posted in     Purchase Orders always update item quantities and other 
information in    Inventory Control.

Changing Your Selection

You can     change your selection for this option at any time. If you change from     allowing non-inventory 
items to not allowing them, you must edit any open     purchase orders and other transactions to remove 
non-inventory item numbers,    or add the item numbers in Inventory Control. 

About Default Item Cost

If you use Sage 300 Inventory Control, you can specify during setup     the type of cost you want the 
program to use when selecting default unit     cost amounts to display for the item details you enter on 
transactions.     The option displays costs by location for the item numbers in your Inventory    Control 
system.

You can choose to display Most Recent Cost, Standard Cost, Average Cost,     Last Unit Cost, Vendor 
Cost, or either of the two user-defined costs you    can enter with item records in Inventory Control. 
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Note: If you do not use Inventory Control, Vendor Cost is set as the default    item cost, and you 
cannot change it.

When entering transaction details, you can change the cost amount that     appears. You can also 
change your choice for the Default Item Cost option    at any time.

About Retainage (Holdback) Accounting   

If you use retainage accounting in Accounts Payable, Purchase Orders lets you account for retainage 
(or a holdback) that occurs when you withhold a percentage of an invoiced amount, usually by mutual 
agreement or according to a statute (such as a Builders Lien Act).

Note: You can only specify retainage if you are using Project and Job Costing and the transaction is 
job-related.

Before Using Retainage Accounting

Before you can process retainage in Purchase Orders, you must:

 l Select the option to use retainage accounting on the Processing tab of the A/P Options screen.

 l Specify default retainage settings for vendors on the Retainage tab of the A/P Options screen.

 l Specify a retainage control account for each account set in your Accounts Payable system.

 l Set up contracts in Project and Job Costing.

There are three steps in processing retainage:         

 1. Process a receipt, invoice, debit note or credit note that specifies a holdback (retainage) for the 
document.

 2. Transfer the invoice or debit note with the retainage to Accounts Payable and post it in that 
program.

 3. Later, post a separate retainage invoice, debit note, or credit note to invoice the outstanding 
retainage amount.

Entering Original Documents with Retainage

An invoice, debit note, or credit note from which retainage is taken is called an original document.

You enter the receipt, invoice, debit note, or credit note using the standard P/O entry screens. To 
indicate that retainage applies to the document, however, you select the Job-Related option and the 
Retainage option.
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Note: The Retainage option appears only if you selected the Retainage Accounting option for your 
Accounts Payable system.

The program then displays the Retainage tab for the entry screen, where you can specify:

Retainage Percentage

The program uses the retainage percentage to calculate the retainage amount.

You can enter a different retainage percentage in the Retainage Percentage (%) field. When you 
enter a new percentage, the program recalculates the retainage amount.

Retention Period

The program uses the retention period to calculate the due date for the retainage document. When 
you change the retention period, the program recalculates the retainage due date, and vice versa.

Retention Rate

You use this field to specify how the exchange rate is determined for the retainage document. You 
can choose one of the following:

 l Use Original Document Exchange Rate. Use the same rate as the document you are 
processing.

 l Use Current Exchange Rate. Use the rate that is in effect when you process the retainage 
document.

Retention Terms

You can use different terms for retainage documents (used to process invoices for outstanding 
retainage) than you used for the original document from which the retainage was taken.

The program displays the code specified for retainage terms in the vendor record, but you can 
change the retainage terms for a document, if you wish.

Note: All tax amounts are included on the original retainage document. No tax amounts are 
included on the retainage invoice, debit note, or credit note that you process to clear the 
outstanding retainage amount.
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Posting original invoices, debit notes, and credit notes

When you post the original retainage document in Accounts Payable, the program deducts the 
retainage from the document total, and posts the amount to the retainage control account.

For example, if you enter an invoice for $10,000 with 10% retainage, an invoice is posted for $9,000 
with retainage outstanding of $1,000.

The retainage amount remains in the control account until you invoice it in accordance with:

 l The retention period or retainage due date specified for the invoice.

 l The number of days in advance specified on the A/P Options screen for generating retainage 
documents.

Adjusting Original Documents

Use Adjustment Entry in Accounts Payable to change retainage related to existing invoices, debit 
notes, and credit notes. When you post the adjustment, the program adjusts the outstanding 
retainage account.

Note that Accounts Payable does not calculate any retainage on adjustment transactions. You must 
enter the retainage manually, whether you are adding it for the first time, or adjusting existing 
retainage debits or credits.

    Options for Reporting Tax on Retainage Documents

Sage 300 lets you specify when to report tax on retainage amounts     to meet the requirements of your 
tax jurisdictions.

Example: In Canada, you report the GST for a retained amount when     you issue the retainage 
invoice.

You can choose from three options when you set up Tax Authorities in     Tax Services:

 l No      Reporting. If the Report Tax on Retainage Document field is set to No Reporting,       users can 
enter values for the tax authority in the Maximum Tax Allowable      and No Tax Charged Below 
fields.

 l At      Time of Retainage Document. When this option is selected, taxes are calculated on the 
retainage      portion of an invoice when the retained amount is invoiced.

 l At      Time of Original Document. When this option is selected, the program calculates and 
invoices the      retainage portion of the tax up front.
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About Weight Units of Measure

Note: You set up weight units of     measure in Purchase Orders only if you do not use Inventory 
Control. 

Weight units of measure (UOM) are used to express order weights. Purchase Orders can also use 
the weight UOM to prorate (distribute)    additional costs on orders.

In a stand-alone Purchase Orders system, you use the P/O Weight Units     of Measure screen to set up 
weight units of measure for all the items    in the Purchase Orders item list. 

For each weight unit of measure, you specify a default weight unit of measure that has a conversion 
factor of 1. All other weight UOMs are defined in terms of the default weight UOM.

Example: 
You could use Pound as the default weight unit of    measure, and convert the weight of items using 
metric measures.

Weight       UOM Conversion       Factor 1 pound       equals

Pound default UOM 1 Pound—1       lb

Kilogram 2.2 .4545       kg.

Ton 2,000 .005       tons

If you change the weight unit of measure, you need to update the weight in each previously added 
item record to make it consistent with the new weight unit of measure.

Example: Suppose the weight unit of measure is kilograms and you add an inventory item that 
weighs one kilogram. If you then change the weight unit of measure to pounds, you need to change 
the item’s weight to 2.2 to agree with the new weight unit of measure.

Note: You can use fractions in weight conversion factors even if you do not use fractional inventory 
quantities.

For step-by-step instructions on using the Weight Unit of Measure screen to add, edit, or delete a 
weight units of measure, see "P/O Weight Units of Measure Screen   " (page 372).

History and Statistics

Set up options for entering and maintaining transaction history and statistics.
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About Accumulating Purchase History

In Purchase Orders, you can keep purchase history for analysis and reporting purposes.

Selecting Options for Keeping History

You select options to keep history on the Processing tab of the P/O Options screen. 

Select the Accumulate Purchase History option to keep information about the items you have 
purchased and the vendors who supplied them. Selecting the option also keeps information about 
invoices, credit notes, debit notes, and items you returned.

You can then view the information in the Purchase History screen, use the History button to look it up 
when you are entering transactions, and print it on the Purchase History report.

Purchase Orders keeps purchase history by the type of year (fiscal or calendar) and period you select 
for the Accumulate By and Period Type options on the Processing tab.

If you choose to accumulate by calendar year, the starting date for the year will be January 1. If you 
accumulate by fiscal year, the starting date will be the first day of your fiscal year.

Note: You can turn on or turn off the Accumulate Purchase History option at any time. If you turn off 
the option after you have used it, Purchase Orders keeps the figures already accumulated until you 
clear them. If you turn on the option again before clearing the history you accumulated previously, 
the data will still be available, but there will be no figures for the period during which the option was 
off.

Note: You can keep data for up to 53 periods per year (54 periods in a leap year), for any number 
of years.

Turning the Options On and Off

You can turn any of the options to keep history and statistics on or off at any time. If you turn them off 
after you have used them, Purchase Orders immediately stops saving information, although it retains 
the figures already collected until you clear (delete) them using the Clear History screen.

If you turn the option on again, there will be a gap in the collected information corresponding to the 
period when the option was not used.

For more information, see "About Selecting Processing Options" (page 8).

About Accumulating Statistics

Use the Accumulate Statistics option (on the P/O Options screen) to keep statistical totals for   all the 
transactions you post in Purchase Orders, including for each period:
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 l The number of posted purchase orders, receipts, invoices, returns, credit notes, and debit 
notes.

 l The net quantity purchased, net purchase amount, and net invoice amount.

 l The largest and smallest invoice, credit note, and debit note amounts, and the vendors for 
whom you posted them.

 l The average invoice, credit note, and debit note amount.

You can see the information in the Purchase Statistics screen and print it on the Purchase Statistics 
report.

Purchase Orders keeps purchase statistics by the type of year (fiscal or calendar) and period you 
select using the Accumulate By and Period Type options on the Processing tab of the P/O Options 
screen.

Selecting the Type of Year

If you choose to accumulate by calendar year, the starting date for the year will be January 1.

If you accumulate by fiscal year, the starting    date will be the first day of your fiscal year.

Selecting the Type of Period

You can also keep the data for up to 53 periods per year (54 periods in a leap year), for any number of 
years.

Use the Period Type option to select from these period types: weekly (Sunday = day 1), seven days     
(beginning on the first day of the week in your fiscal calendar), bi-weekly     (Sunday = day 1), four 
weeks, monthly, bi-monthly, quarterly,    semi-annually, annually, or fiscal period (use the Period Type 
option).

Editing Statistics

If you use the Allow Edit Of Statistics option, you can edit and import the statistical totals that are kept 
by Purchase Orders.

Use the Purchase Statistics screen to edit the statistics.

Note: Normally, you do not need to change statistics, because they are updated automatically and 
accurately by Purchase Orders. However, if you set up your Purchase Orders system partway 
through a fiscal year, you may want to select the Allow Edit Of Statistics option so that you can enter 
statistics from your old purchase order system for previous periods of the current year or for 
previous years. 

For more information, see "P/O Purchase Statistics Screen" (page 379).
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Changing the Method of Accumulating Statistics

Transaction history is kept by date. 

You can     change the type of year and period by which Purchase Orders keeps purchase     history and 
statistics, but you will not then be able to compare new period    figures directly to figures in past 
periods.

If you need to change the type of year or period by which Purchase Orders     accumulate purchase 
history and statistics after you have processed transactions,     you should either do so after year-end, 
or edit the statistics for the     earlier periods in the year to correct distortions. The program reminds     you 
of this information when you change the selection for the Accumulate     By or Period Type option for 
the Accumulate Statistics and Accumulate    Purchase History options.

Note: Sage 300 Standard maintains statistics by fiscal year and period.

About Keeping Transaction History

If you select Keep Transaction History in the P/O Options screen, the program keeps details of 
posted transactions until you remove them using the Clear History screen. 

You can print Transaction Lists of the data—and reprint requisitions, purchase orders, receiving slips, 
and returns—until you clear the transaction history for them.

Transaction and Audit Reports

You can print transaction history on the Transaction List. All transactions you posted in Purchase 
Orders can appear on the list until you clear them using the Clear History screen.

You can also print the Payables Clearing Audit list for receipts you posted in Purchase Orders and 
invoices you processed using Day End Processing.

Transaction History Required for Drilldown

You must keep history to drill down from the G/L Transaction History screen in General Ledger, or 
from the Invoice Entry screen in Accounts Payable, to the originating transaction in Purchase Orders.

16Sage 300 2021 Purchase Orders User's Guide



Important! 
If you do not keep transaction history, Purchase Orders automatically deletes completed 
transactions when you run Day End Processing, and you will not be able to drill down to Purchase 
Orders transactions from General Ledger or Accounts Payable. Mo re ...

Purchase Orders treats the following transactions as completed:

 l Requisitions, purchase orders, receipts, and returns with a Completed status on all detail 
lines.

 l All invoices, credit notes, and debit notes (these transactions are completed when you post 
them).

If you do not keep history, you cannot display or print copies of completed     requisitions, purchase 
orders, receipts, and returns after you run Day     End Processing, and you cannot look up the 
invoices, credit notes, and    debit notes you posted before posting or running Day End Processing.

Allowing Editing Of Sales Statistics

If you selected the Allow Edit Of Statistics option in the P/O Options screen, you can add 
transaction data for inventory items, as well as for purchases and return quantities and amounts for 
the years and periods for which you keep data in your Purchase Orders system. 

Before You Start

 l Make sure you have the proper security rights for this task.

 l Select the Keep Item Statistics and Allow Edit Of Statistics options in the P/O Options 
screen.

To change processing options for Purchase Orders:

 1. Open Purchase Orders > P/O Setup > Options.

 2. Click the Processing tab.

 3. Change the Allow Edit Of Statistics     option.

 4. Click Save.

After changing statistics

 l Print the Sales Statistics report to check the new record information and to update your printed 
records.
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 l Compare the report you printed before changing or deleting statistics to those printed after the 
changes, to verify that you made the required changes correctly.

 l Clear the Allow Edit Of Statistics option on the Processing tab of the P/O Options screen.

About Changing Purchase Orders Options

You can readily change most of your choices on the P/O Options screen. These changes include:

 l Company name and address.

 l Multicurrency option.

 l History and statistics.

Make sure you understand   the impact the options have on processing within Purchase Orders before 
changing any of the   settings or other information in the P/O Options screen. 

Important! Before attempting to save changes to the P/O Options screen, make sure that no other 
users are using the data for the Purchase Orders company and that no other Purchase Orders 
screens are open for the company on your computer. You cannot save most changes if other 
Purchase Orders screen are open.

Company Name and Address

Use the Options screen in the P/O Setup folder to change the contact name, telephone number and 
fax number for the Purchase Orders administration.   

Use the Company screen in Common Services to change the company name and   address, or to 
change the contact name, telephone number, and fax number at the company level.

Multicurrency Option

You select the Multicurrency option in the Accounts   Payable Options screen, turning it on or not for 
Purchase Orders as well.   Once you select the option in Accounts Payable, you cannot turn it off.

If you will be using the Multicurrency option in Purchase Orders, you   also specify a default rate type to 
use when converting multicurrency   Purchase Orders transactions to the functional currency. 

History   and Statistics

You should change the type of year and period by which you keep statistics   only at year end. If you 
change partway through a year, figures will be   distorted in some periods and you will have to make 
corrections in all   records for which you keep statistics.

Note: The Sage 300 Standard accumulates statistics by fiscal year and fiscal period.
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Changing Purchase Orders Processing Options

You can change any of the selections and information on the P/O Options screen, with a few 
restrictions. Mo re ...

 l You cannot change the choice for the Multicurrency option. You make the selection for this 
option in the A/P Options screen, and can change your choice only   in Accounts Payable. (Note 
that you cannot turn off the Multicurrency option once you have selected it and saved your 
changes to the A/P Options screen.)

 l You can change the type of year (fiscal or calendar) and period by which you accumulate item 
statistics (in Sage 300 Advancedand Sage 300 Premium), but you should do so only at fiscal or 
calendar year end.

 l If you change either method part way through a year, the statistics already accumulated will be 
incorrect or in the wrong period.

For more information on options that you select or change on the Processing tab in the P/O Options 
screen, see "P/O Options Screen  " (page 344).

Note: If you use Inventory Control, you use the I/C Options screen to specify when to cost 
inventory. 

Before You Start

 l Make sure that you know   the effects of all changes and understand the impact the options 
have   on processing within Purchase Orders.

 l Print the P/O Options   report from the Setup Reports folder so you have a record of your 
processing   options before you start.

 l If you are changing from   updating costs during day end processing to updating costs during 
posting,   you must first run day end to cost all outstanding posted transactions.

 l Before saving changes   to the P/O Options screen, make sure that no other Purchase Orders 
screens are open   for your database on your computer or on any other computer on a network.   
You cannot change most of your choices in the P/O Options screen if other Purchase Orders   
screens are open, or other users are working with the Order Entry   data.

To change P/O processing options:

 1. Open Purchase Orders > P/O Setup > Options.

For more information, see "P/O Options Screen  " (page 344).

 2. Click the Processing tab. 
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Note: Costing items and creating subledger transactions and   audit information during posting 
increases the time it takes to post   transactions. If you change from   updating costs during day end 
processing to updating costs during posting,   you must first run day end to cost all outstanding 
posted  transactions.

 3. Click Save to save any changes to processing options.

After   changing P/O Options

Print the P/O Options   report from the Setup Reports folder to check that the settings were changed   
correctly.

Changing Posting and Day End Processing Options

Important! If you use the Inventory   Control module, you select day-end processing and costing 
options in that program. 

You change day end processing and costing options in Purchase Orders only if you do not use 
Inventory Control. Mo re ...

If you use Purchase Orders as a stand-alone program, you set all the following options in Purchase 
Orders:

 l When Purchase Orders creates   G/L batches, and whether it should also post them 
automatically. (You select   this option in the P/O G/L Integration screen.)

 l Whether Purchase Orders   should post A/P batches automatically or using the Create Batch 
icon.   (You select this option in the P/O Options screen.)

 l When Sage 300 costs   inventory—either when   posting transactions or when you run Day-End 
Processing.

Tip: If you have high transaction volumes or if processing speed is an issue, we suggest that 
you cost inventory during Day End Processing—not each time you post a transaction in 
Purchase Orders.

 l When to  create sub-ledger and audit information. Again,   if speed is a concern, we suggest 
during Day End Processing. 

 l When to   create General Ledger transaction batches, and whether it should also   post them 
automatically. 

If you use Inventory Control, you set these options in the corresponding screen in that program. 
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Note: These options also affect when Purchase Orders   posts General Ledger and Accounts 
Payable batches.

Before You Start

 l Make sure that no   other users are working with Purchase Orders, or you will not be able to 
save your changes.

 l Print the G/L Integration   report from the Setup Reports folder so you have a record of your G/L   
Integration settings before you start.

 l If you are changing from   updating costs during day end processing to updating costs during 
posting,   you must first run day end to cost all outstanding posted transactions.   

 l If you are changing from   using the Create G/L Batch screen to creating general ledger 
transactions   during day-end processing, be sure to run Create G/L Batch to process   any 
outstanding transactions first, to avoid accidentally omitting transactions   from your general 
ledger batches.

 l See "About Day End Processing" (page 194)   to understand how Day End Processing works.

Note: Make sure that no one else is using the Purchase Orders   data and that no other Purchase 
Orders screen s are open for the company   before you save changes.

To change batch creation and posting options for A/P transactions created   by 
Purchase Orders:

 1. Open Purchase Orders > P/O Setup > Options.

For more information, see "P/O Options Screen  " (page 344).

 2. Click the Processing tab. 

 3. Change the Post A/P Batches option.

Note: If   you choose to post A/P batches when you post P/O transactions, and you   cost inventory 
during transaction posting, Purchase Orders will create   and post an A/P batch each time you post 
an invoice.

 4. When you have finished, click Save  .
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To change batch creation and posting options for G/L transactions created   by 
Purchase Orders:

Important! If you have been using the Create Batch screen to create transactions, print a copy of 
the latest G/L Transactions report, then create any outstanding transactions before changing your 
choice for this option.

 1. Open Purchase Orders > P/O Setup > G/L Integration.

For more information, see "P/O G/L Integration Screen" (page 323).

 2. Change batch creation and posting options, as needed.

 3. When you have finished, click Save  .

To change day end processing options:

 1. Open Purchase Orders > P/O Setup > G/L Integration.

 2. On the Costing tab, specify:

 l Whether to cost items during posting or day-end processing

 l When to create subledger transactions and   audit information (during posting or day-end 
processing).

 3. When you have finished, click Save  .

To change batch creation and posting options for G/L transactions created   by Inventory 
Control:

Note: Inventory Control generates G/L transactions from purchase order receipts   and returns.

 1. Open Purchase Orders > P/O Setup > G/L Integration.

 2. Change batch creation and posting options, as needed.      

For more information, see "P/O G/L Integration Screen" (page 323).

 3. When you have finished, click Save  .

After   changing Day End Procesing and posting options

 l Print the P/O Options   report from the P/O Setup Reports folder to check that the settings were   
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changed correctly.

 l Print the Purchase Orders   G/L Integration report from the P/O Setup Reports folder if you 
changed   integration settings.

 l Print the I/C Options   report from the I/C Setup Reports folder to check that the settings were   
changed correctly.

 l Print the Inventory Control   G/L Integration report from the I/C Setup Reports folder if you 
changed   integration settings.

Currency Information
Specify your functional currency, and set up your system for multicurrency accounting.

About Specifying Currency Information

The functional currency is the home currency in which your company books are kept.

 l You select the functional currency for your Sage 300 database in the Company Profile screen 
in Common Services when you first set up your Sage 300 system.

 l You cannot change the functional currency once you have selected it.

For more information about the functional currency, see the System Manager Help.

Accounts Payable Determines whether Purchase Orders is Multicurrency

The Multicurrency option is set for Purchase Orders in Accounts Payable, and, once it is selected, you 
cannot change it.

The Processing tab in the P/O Options screen indicates whether Purchase Orders is multicurrency:

 l If Accounts Payable is multicurrency, Purchase Orders is multicurrency also.

 l If Accounts Payable is single-currency, Purchase Orders is single-currency.

If the Multicurrency option is turned on, the tab also displays:

 l The company's functional currency.

 l The company's default rate type for converting source-currency amounts to functional-
currency equivalents.

The default rate type is displayed on transactions you enter for multicurrency vendors you have not 
yet added to Accounts Payable. You can select a different default rate type to use for Purchase 
Orders at any time. You can also select different rate types for individual transactions as you enter 
them.
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Information about creating multicurrency records is included throughout these Help topics in 
discussions of records and activities affected by currency. For a summary of the steps to take to set 
up a multicurrency ledger, see "Setting up Multicurrency Accounting" (page 24).

Setting up Multicurrency Accounting

Purchase Orders lets you process transactions in any currencies your vendors use. This section 
summarizes the steps you take to set up a multicurrency Purchase Orders system.

To create a multicurrency Purchase Orders system:

 1. Turn on the Multicurrency option for the company and select a default rate type on the 
Company Profile screen in Common Services.

 2. Use the Common Services Currency screens to add any currency codes you need for 
Purchase Orders, and enter rates for the currencies you use.

Sage 300 comes with a comprehensive set of currency codes that use standard international 
abbreviations and the format and number of decimal places that are normally used with each 
currency. You probably will not need to define new codes unless you do not use the international 
codes.

 3. Turn on the Multicurrency option on the Accounts Payable Options screen. This step 
automatically turns on the Multicurrency option for Purchase Orders as well.

 4. Create an account set in Accounts Payable for each currency you want to use for Accounts 
Payable vendors in Purchase Orders.

 5. If you post transactions to add current or year-to-date requisitions or purchase orders, enter      
the amounts in the vendors' currencies.

 6. If you enter statistics for previous years and periods, enter the amounts in both the functional 
and vendor currencies. Purchase Orders cannot calculate equivalent amounts from statistics 
you enter yourself.

For more information, see "About Processing Multicurrency Transactions in Purchase Orders" (page 
90).

Designing a Coding Scheme For Purchase Orders Records
This section describes the codes you assign     to the records you can add to Purchase Orders, and 
offers some tips to help you    decide on the codes to use. 
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About Purchase Orders Coding Schemes

When designing new coding schemes, define codes that make it easy to identify each record type and 
that list records in the order you want them to appear on reports and in Finder screens.

Each code of a single type (such as an additional cost code) must be unique. In most cases, you 
should also assign unique codes to all your records, so there is no chance of confusing one type of 
record with another.

You can use any combination of numbers and letters in all Purchase Orders codes. For example, all 
of the following would be valid ship-via codes:

 l A1

 l 123

 l A01

 l 123A

 l AB1234

To simplify codes, we recommend that you:

 l Use the same number of characters in all codes of the same record type.

 l Use codes of at least three characters, to allow for future expansion.

 l Use a system that is significant for your business, such as codes that identify a geographical 
region, or a type of template or cost.

 l If possible, use only numbers in your codes, for consistency of sorting.

The following table shows the types of characters permitted and the maximum length for each type of 
code you can define in Purchase Orders:

Code Name Maximum 
Length

Permitted Characters

Additional cost code 6 numbers and letters

Account set code (stand alone program) 6 numbers and letters

Item code (stand alone program) 24 alphanumeric, plus blanks and 
special characters

Ship-via code 6 numbers and letters

Permitted Characters and Lengths for P/O Codes
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Code Name Maximum 
Length

Permitted Characters

Template code 6 numbers and letters

Requisition, purchase order, receipt, or return 
document number

22 alphanumeric prefix, numbers

Sorting Order of Codes

Purchase Orders sorts codes on screens and reports in a specific order, which you should take into 
consideration when designing codes.

Purchase Orders reads codes from left to right, and uses the following sequence to put them in order:

[Blank] ! " # $ % & ' ( ) * + , - . / 0 1 2 3 4 5 6 7 8 9 : ; < = > ? @ A B C D E F G H I J K L M N O P Q R S T U 
V W X Y Z [ \ ] ̂  _ ̀  a b c d e f g h i j k l m n o p q r s t u v w x y z { | } ~

The codes listed in the introduction to this discussion would be sorted by Purchase Orders into the 
following order:

 l 123

 l 123A

 l A01

 l A1

 l AB1234

Codes containing fewer than the maximum number of permitted characters are left-justified in 
Purchase Orders Finders, screens, and on reports.

    Integrating Purchase Orders with Other Sage 300 Programs
 
You must activate Accounts Payable before you can activate Purchase Orders. You can also use 
Purchase Orders with General Ledger, Order Entry, and Accounts Receivable.

If you plan to use Purchase Orders with Inventory Control, rather than as a "stand-alone" program, 
you must activate Inventory Control before activating Purchase Orders.

Important! If you activate Purchase Orders before activating Inventory Control, Sage 300 sets up 
Purchase Orders as a "stand-alone" program; it will not integrate with Inventory Control.
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About G/L Integration Options

You use the P/O G/L Integration screen to select options that determine how Purchase Orders 
interacts with General Ledger, including:

 l When and how to create general ledger transactions from Purchase Orders transactions. Mo re ...

You use the Create G/L Transactions option to specify whether to generate general ledger 
transactions when you post transactions or run day-end processing, or at a later time of your 
choosing using the Create G/L Batch screen.

 l Select On Request Using Create Batch Icon to create a batch or append to an existing 
batch or transaction file       only when you are ready to create general ledger transactions.

Note: Select this option if you want to be able to consolidate       general ledger 
transaction details and print Purchase Orders' G/L Transactions      report.

You must select this option if you want       to consolidate general ledger transactions and to 
print the G/L Transactions       report in Purchase Orders. (The G/L Transactions report lists 
the general ledger transactions created by Purchase Orders. You might      need to print 
this report for your audit trail.)

 l Select During Posting or During Day       End Processing to create general ledger 
transactions       when you post or run day-end processing. 

G/L transactions are created when you cost       inventory items—that is, either during posting 
or when you run Day End Processing. Costing options are set in Inventory Control, if you 
use that program.

Warning! If you select one these options, you cannot print the G/L Transactions report 
from Purchase Orders. If you need this       information for your audit control, print it from 
General       Ledger. If you do not use General Ledger, you may be able to print it      from the 
general ledger system that you are using.

 l Whether to create a new batch of general ledger transactions, or add the new transactions to 
an existing batch. Mo re ...

Use the Create G/L Transactions By option to add general ledger transactions       to an existing 
General Ledger batch each time you post P/O       transactions, run day-end processing, or to 
create      a new General Ledger batch (depending on your other options settings). 

If you have activated General Ledger, Purchase Orders, and Inventory Control for the same 
company, the general ledger transactions are automatically placed in new general ledger 
batches (and optionally posted) or added to existing batches. 
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If your general ledger is at another location or in a separate database,     general ledger 
transactions are appended to a file you     can import into another general ledger, or print, and 
then enter manually    into your general ledger. 

Select Adding G/L Transactions to an Existing Batch to have only one General Ledger batch 
to which all transactions are appended. Purchase Orders must use the same database as 
General Ledger.

 l Whether to consolidate transactions with similar details, and whether to consolidate by account 
only, or by a combination of account, fiscal period, and source. Mo re ...

Use the Consolidate G/L Batches option to specify whether to consolidate       related general 
ledger details into single transaction details, or to      create detailed general ledger transactions 
(Do Not Consolidate). You can select:

 l Do         Not Consolidate.  All the details posted in Purchase Orders will        be included in the 
General Ledger transaction batch.

Tip: Choose this option if you use optional fields and pass        optional field information to 
the General Ledger transactions.

 l Consolidate         Transaction Details by Account.  During posting, all the details         from a 
transaction with the same general ledger account number (and otherwise         differ only in 
the amount) are combined into one detail. No further consolidation        occurs during G/L 
batch creation.

Tip: Choose this option if you do not use optional fields,         but still want to associate 
general ledger transactions with originating        documents (for drill down or to maintain a 
manual audit trail).

 l Consolidate         by Account and Fiscal Period.  All the details with the same general        
ledger account number and fiscal period are combined into one detail.

 l Consolidate         Transaction Details by Account.  All the details with the         same general 
ledger account number, fiscal period, and source code are        combined into one detail.

 l Whether to create general ledger transactions for additional costs. Mo re ...

The Create G/L Entries for Expensed Additional Costs option lets you update your general 
ledger with additional cost       expenses directly from Purchase Orders, or wait until invoices are posted      
in Accounts Payable.
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Select this option to create debit entries to expense accounts and credit       entries to the Expensed 
Additional Cost Clearing Account when you post       additional costs. (Posting the invoices later in A/P 
will credit the payables      control account and debit the Expensed Additional Cost Clearing Account.)

Do not select this option if you want to send expenses with invoices to Accounts Payable,      where 
posting will debit the expense accounts and credit payables control.

Note: For job-related documents, Purchase Orders       always       creates G/L entries for expensed 
additional costs during posting—whether you select this option      or not.

 l Whether to create general ledger transactions for non-inventory expenses. 

 l Default Inventory Expense Account. Mo re ...

Use the Default Inventory Expense Account field on the Integration tab   of the P/O Options screen to 
specify the general ledger account   that should appear when you enter transactions for items that 
are not   defined in Inventory Control. You would normally select an account from   the Expense 
section of your general ledger chart of accounts.

You can change the account number for individual transactions, as needed.   You can also change 
the default account number in the P/O Options screen at   any time. 

If you select the Allow Non-inventory Items option, you must specify   this account number before you 
can save changes to the Options screen.

The general ledger entries for non-inventory transactions are created   in Accounts Payable, and 
they do not appear on the Purchase Orders G/L   Transactions list.

 l Default Cost Expense Account Option. Mo re ...

Use the Default Cost Expense Account field on the Integration tab of   the Options screen to specify 
the general ledger account to use with transactions   that do not specify a general ledger account.

Purchase Orders creates transactions for the account, for example, when   additional costs are 
expensed on a receipt then, before running Day End   Processing, the designated general ledger 
expense account is deleted.   The program also uses the account to contain the discrepancy that can   
occur in tax amounts when users manually prorate additional costs and   change tax information on a 
receipt or invoice. 

Note: You must assign the account   before you can run Day End processing. Day End Processing 
stops and displays   an error message if you try to run it before specifying the default cost   expense 
account.

 l Expensed Additional Cost Payables Clearing Account. Mo re ...

This is the general ledger account that is used if you choose the option   to create G/L entries for 

29Sage 300 2021 Purchase Orders User's Guide



expensed additional costs in Purchase Orders.

If you create G/L entries in P/O, when you process the additional cost,   Purchase Orders credits the 
payables clearing account and debits the expense   account during day-end processing (or when you 
run Create Batch). 

When you post the invoice in Accounts Payable, Sage 300 debits the   payables clearing account and 
credits the payables control account.

If you do not choose the option to create G/L entries for non-inventory   expenses in Purchase 
Orders, Sage 300 will generate G/L entries when   the invoice is posted in A/P, and this account will 
only be used for job-related   transactions.

Note: For job-related documents, Purchase Orders       will always       create G/L entries for expensed 
additional costs during posting—whether you select this option      or not.

You can change the account number for individual transactions, as needed.   You can also change 
the default account number in the Options screen at   any time. 

 l Non-Inventory Payables Clearing Account. Mo re ...

This is the general ledger account that is used if you choose the option   to create G/L entries for non-
inventory expenses in Purchase Orders when   processing receipts for non-inventory items.

If you create G/L entries in P/O, when you enter the receipt, Purchase   Orders credits the payables 
clearing account and debits the expense account   during day-end processing (or when you run 
Create Batch). 

When you post the invoice in Accounts Payable, Sage 300 debits the   payables clearing account and 
credits the payables control account.

If you do not choose the option to create G/L entries for non-inventory   expenses in Purchase 
Orders, Sage 300 will generate G/L entries when   the invoice is posted in A/P, and this account will 
not be used.

Note: You can change the account number for individual transactions, as needed.   You can also 
change the default account number in the Options screen at   any time.

 l Information to be sent to General Ledger with the transaction. You specify this information on 
the Transactions tab. Mo re ...

You can select the type of information to include in the following general ledger transaction 
fields:
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 l G/L Reference Field

 l G/L Entry Description Field

 l G/L Detail Description Field

 l G/L Detail Comment Field

The Integration tab also displays the day-end     number up to which you have created general ledger 
batches. You can compare     this number to the current day end number in the P/O Options screen to 
make    sure you have created all outstanding general ledger transactions.

For more information, see "P/O G/L Integration Screen" (page 323).

Costing Options Affect P/O G/L Integration

If you want to create general ledger transactions       automatically, you can create them when you cost 
inventory items—that is, either during posting or when you run Day End Processing, depending on 
costing options specified on the I/C Options screen if you are      using Inventory Control, or on the P/O 
Options screen if you     are using Purchase Orders as a standalone program.

If you want to create general ledger transactions when you post transactions in Purchase Orders:

 l Choose to cost inventory      items during posting.

 l Select During Posting for the Create G/L Transactions option on the P/O G/L Integration 
screen. 

Note: If the program      is set to cost items during Day End Processing, choose During Day End     
Processing, and then change the setting for costing inventory items.

If you want to create general ledger transactions when you run Day End Processing:

 l Choose to cost inventory      items during Day End Processing.

 l Select During Day End Processing for the Create G/L Transactions option on the P/O G/L 
Integration screen. 

Note: If      the program is set to cost items during posting, choose During Posting,     and then 
change the setting for costing inventory items.

Warning! If you select one these options, you cannot print the G/L Transactions report from 
Purchase Orders. If you need this       information for your audit control, print it from General       Ledger. If 
you do not use General Ledger, you may be able to print it      from the general ledger system that you 
are using.

31Sage 300 2021 Purchase Orders User's Guide



Consolidating G/L Transactions

If you use the On Request Using Create Batch Icon option, you can consolidate       G/L transaction 
details generated from all Purchase Orders transactions      for each general ledger account by either:

 l Account number and fiscal        period, or

 l Account number, fiscal       period, and source code.

You cannot consolidate general ledger transactions from different Purchase       Orders transactions if 
you do not use the On Request Using The Create       G/L Batch Icon option. If you create G/L 
transactions      during posting, the program will consolidate only within entries. 

Note: If       you consolidate transactions across originating entries, you cannot drill       down from a 
transaction in General Ledger to view or print the originating       transaction in Purchase Orders. If you 
want to       use drill down, use either Do Not Consolidate or Consolidate Transaction      Details by 
Account.

When to Consolidate            

Consolidate       transaction details if you do not need a record of all details posted      to each general ledger 
account from Purchase Orders transactions.

Consolidation reduces the amount of information in the general ledger       batch and results in a shorter 
G/L Transactions report. Consolidation       also "consolidates" the information in the Reference and 
Description      fields for each transaction.

When Not to Consolidate

If       you require detailed general ledger transaction information for your Purchase       Orders records, or if 
you want to be able to drill down from other Sage 300 programs to originating transactions in 
Purchase orders, use the      Do Not Consolidate option.

The Do Not Consolidate option provides complete information in your       general ledger transaction 
batch, but can result in a long G/L Transactions       report and a large general ledger batch. However, 
you can also consolidate       transaction details during posting in General Ledger, if you      use it.

Descriptions for Consolidated Entries       and Details

Consolidation also reduces       the information in the Reference and Description fields for each 
transaction      as described in the later section, "G/L Reference and Description." 

 l The description given        to consolidated entries is "Transactions consol. by P/O on <date>."
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 l The description for consolidated        details (if the original descriptions were different) is "Details        
consol. by P/O." Consolidation will keep the original descriptions       if they were the same for all 
original details.

Changing Your Choices for General Ledger Options   

You can change your selections for all the general ledger options in     the Purchase Orders G/L 
Integration screen at any time. Your new choices     are used only in the general ledger transactions that 
are created after     you make the change, and do not affect general ledger batches that already    exist.

Using Purchase Orders and General Ledger at the Same Site   

If you use Sage 300 General Ledger with Purchase Orders, the Purchase     Orders general ledger 
batches are created in General Ledger. To avoid     making accidental changes to General Ledger 
batches created by Purchase     Orders, select No Edit for the Edit Imported Entries option in the G/L     
Options screen.

Changing General Ledger Integration Options

To change General Ledger Integration options:

 1. Open Purchase Orders > P/O Setup > G/L Integration.

 2. On the Integration tab, select options that determine how and when to create transactions for 
the general ledger.

For help on the fields you can select on the G/L Integration screen, see "P/O G/L Integration 
Screen" (page 323).

 3. On the Transaction   tab, select information that will appear for the   G/L Detail Comment,   G/L 
Detail Description,   G/L Detail Reference,   and G/L Entry Description fields for each type of 
transaction and transaction detail. 

The table lists each of the transactions produced   by Purchase Orders, and displays the information 
that is currently included   in G/L transactions produced from these P/O transactions. 

 a. Double-click the transaction   description or transaction detail information that you want to 
change.

 b. On the G/L Integration Detail screen that appears,   select the information that you want to add 
to the transaction field,   and then use the Include and Exclude buttons to add or remove field 
information.

33Sage 300 2021 Purchase Orders User's Guide



Note: You can assign one or more pieces of information (segments)   to each G/L transaction 
field, provided that the combined length of the   segments and separators does not exceed 60 
characters. Fields exceeding   this limit will be truncated when you post the general ledger 
transactions.

 c. Click Save to save   the contents of the G/L transaction field.

 4. Choose a different   field to edit, or click Close to return to the Transaction tab.

 5. Click Save to save changes   to the G/L Integration screen.

After   changing G/L Integration options

Print the G/L Integration   report from the Setup Reports folder to check that the settings were changed   
correctly.

About Using Purchase Orders With Accounts Receivable   

If you use Accounts Receivable with Purchase Orders, you can display and edit customer and ship-to 
location address information when specifying drop shipments.

When entering a job-related transaction, you also assign the A/R item number for billing the customer 
to each job-related detail.

About Using Purchase Orders With Accounts Payable   

Purchase Orders uses Accounts Payable vendor records to display vendor numbers, names, 
addresses, tax groups, and terms codes on Purchase Orders transactions. It also enters Accounts 
Payable vendor payment terms on invoices.

You can add new vendor records to Accounts Payable from the Vendor Number field in Purchase 
Orders.

A/P Batches Created During Posting or Day-End Processing

When you run Post transactions or run Day End processing (depending on when you cost 
transactions), the Purchase Orders program creates an Accounts Payable batch containing the 
invoices, credit notes, and/or debit notes directly in Accounts Payable.

Note: You choose when to cost transactions with the Cost Items During option on the Processing 
tab of the I/C Options screen.

34Sage 300 2021 Purchase Orders User's Guide



A/P Batches Posted Automatically or Manually 

You can specify in P/O Options when to post A/P batches generated from Purchase Orders Invoices, 
credit notes and debit notes:

 l During Posting or Day End Processing

 l On Request Using Create Batch Icon

You can also post the A/P batch using the Post Batches screen in Accounts Payable.

Note: These choices can have a large impact on the speed of processing transactions in Purchase 
Orders and on the number of A/P batches that Purchase Orders produces.

If you choose to post A/P batches automatically and you cost inventory during transaction posting, 
Purchase Orders will create and post an A/P batch for each invoice it creates.

If you are processing a large volume of receipts, you should cost inventory during day-end processing 
or use the Create Batch icon to post A/P batches.

Optional Fields in Accounts Payable Invoices

Depending on your settings for optional fields, Purchase Orders can also pass optional field 
information with invoices to Accounts Payable if you use the same optional fields for Purchase Orders 
invoices and Accounts Payable invoices.

About Using Purchase Orders With General Ledger   

If you use General Ledger with the same database as Purchase Orders, Purchase Orders displays 
and validates the General Ledger account numbers you enter.

When the programs are used together, batches of Purchase Orders journal entries are created in 
General Ledger, either during posting or day-end processing, or when you create them using the 
Create Batch screen.

On the P/O Options screen, you can choose whether to:

 l Create a new General Ledger batch each time you process Purchase Orders transactions.

 l Add new transactions to an existing batch.

You also have a Finder of General Ledger accounts on your Purchase Orders account fields.

Depending on your settings for optional fields, Purchase Orders can include optional field information 
with G/L transactions if you use the same optional fields for Purchase Orders transaction details and 
General Ledger account details.
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You can drill down for General Ledger Transaction History to the originating transaction in Purchase 
Orders.

About Using Purchase Orders With Inventory Control   

If you use Inventory Control:

 l Purchase Orders displays item numbers, inventory locations, and price list information from 
Inventory Control when you enter transactions. If you use the Allow Receipt Of Non-stock Items 
in Inventory Control, you can also use non-stock items in Purchase Orders transactions.

 l Optional field information from inventory items will appear by default in P/O transaction detail 
lines if you use the same optional fields in both programs.

 l Purchase Orders transactions are processed by Day End Processing in Inventory Control.

 l You can use the Create POs From I/C screen to create purchase orders from the reorder 
quantities information entered for items in Inventory Control.

At posting, Purchase Orders transactions affect Inventory Control item quantities as follows:

 l Purchase orders increase the item quantities on purchase order in Inventory Control.

 l Receipts increase quantities on hand in Inventory Control and decrease quantities on 
purchase order, if a purchase order is specified on the receipt.

 l Returns of items to inventory decrease item quantities on hand in Inventory Control.

During posting or day-end processing (depending on when you do item costing in Inventory Control):

 l Item costing information is updated in Inventory Control.

 l Statistics and history are updated in both Purchase Orders and Inventory Control (if you keep 
history and statistics in both programs).

Printing item labels

When you specify a number of labels for inventory items on Purchase Orders receipts, the number is 
used by the I/C Item Labels screen to determine how many labels to print for each item received. If 
you change the number of item labels for a detail on a previously posted Purchase Orders receipt and 
you have not yet printed the labels, the number of labels is updated in Inventory Control.

About Using Purchase Orders With Order Entry

If you use Order Entry with Purchase Orders, you can use the Create POs From O/E screen to create 
purchase orders from the items on sales order in Order Entry. You can also select Order Entry sales 
order numbers when entering transactions in Purchase Orders, and print the Shippable Backorders 
report by order number.
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If you use the Allow Receipt Of Non-Stock Items in Inventory Control, you can accept non-stock items 
from Order Entry and process them on Purchase Orders transactions.

About Using Purchase Orders with Project and Job Costing

If you use  Project and Job Costing:

 l You can enter   job-related transactions in Purchase Orders, where you assign items on 
requisitions,   purchase orders, receipts, returns, credit notes, and debit notes. 

Note: You cannot mix job-related details and non-job-related   details in the same transaction. 

 l Job-related transactions   affect the committed and actual quantities and costs for jobs in Project   
and Job Costing.

Generally, only purchase orders and receipts affect the committed and   actual quantities and costs 
in jobs. However, all P/O transactions can   affect jobs if your invoices change receipt information, or 
if you have   returns, credit notes, and debit notes.

Invoices for Job-Related Receipts

Do not change a job-related invoice   in Accounts Payable if the invoice originated in Purchase Orders. 
Accounts Payable   does not send your changes to Project and Job Costing. 

You must process invoice changes in Purchase Orders, or with an Accounts   Payable transaction such 
as an adjustment.

Job-Related Additional Costs

Depending on the cost category, you can calculate overhead or labor   burden for the additional cost. 
Overhead and labor are calculated by Project   and Job Costing and passed back to Purchase Orders 
when you post the receipt.

If job-related additional costs are expensed rather than prorated, you   can specify the contract, 
project, category, cost class, resource, billing   type, billing rate (if appropriate), currency, A/R item 
number, and unit   of measure for the additional cost.

About Using P/O with Sage Fixed Assets

Sage 300 provides full integration with Sage Fixed Assets, allowing you to enter asset transactions in 
Inventory Control,    Purchase Orders, Accounts Payable, and Intercompany Transactions. 

Sage Fixed Assets Integration lets you:
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 l In Inventory Control,      identify items as financial assets when you withdraw them from inventory     
for internal use by your company. 

 l In Purchase Orders, Accounts      Payable, and Intercompany Transactions, identify items as 
financial assets     when you purchase them. 

 l Send asset information     to Sage Fixed Assets to set up program assets that you have identified 
in Sage 300. 

Note: Sage Fixed Assets works with Purchase Orders 5.5 and higher.

Adding Purchase Orders Setup Records
This section describes the records you can add to Purchase Orders to streamline data entry and 
include additional information you want to keep with Purchase Orders documents. It also describes 
the additional records you must add if you are setting up Purchase Orders without Sage 
300 Inventory Control.

About Importing and Exporting Purchase Orders Setup Records

If you currently have a computerized purchase order system, you may     be able to transfer records 
directly into Sage 300 Purchase Orders by importing them..

You can also export records from another Sage 300 Purchase Orders     database, edit them in a 
spreadsheet or other program to change codes,     amounts, and other information, then import them 
into the new Sage 300    Purchase Orders system you are setting up.

Purchase Orders setup records you can both import and export include:

 l Additional cost codes

 l Ship-via codes

 l Vendor contract costs

 l Templates

 l E-mail messages

 l Optional fields (with      Transaction Analysis and Optional Field Creator)

 l Account Sets (PO standalone      system)

 l Items (PO standalone system)

 l Vendor details (PO standalone      system)

 l Weight units of measure      (PO standalone system)
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You can also import and export requisitions, purchase orders, and receipts.    You can export returns, 
invoices, credit notes, and debit notes. 

For additional information about importing and exporting all Purchase     Orders records and 
transactions, see the System Manager Help.

Account Sets

If you do not use Inventory Control, use the P/O Account Sets screen to add and manage account 
sets in Purchase Orders.

About Setting Up Account Sets

The Account Sets screen is available in Purchase Orders only if you do     not use Sage 300 Inventory 
Control. If you use Inventory Control, you    set up account sets using that program.

Account sets are groups of general ledger accounts to which you post     Purchase Orders transactions. 
By defining more than one account set, you     can identify transactions for different types of items in 
your general    ledger.

You can use as many account sets as you need for your inventory items.     For example, you could use 
separate account sets for different item     categories, for items assembled in different areas, or for 
items obtained    from different suppliers.

When you add an account set, you enter a unique code of up to six characters     to identify the set, and 
a description (for example, Assembled Items).    Account set codes can contain letters and numbers.

For each account set, you enter account numbers for the following general    ledger accounts:

 l Payables Clearing. A suspense account to which Purchase Orders posts the "other side"       of 
the accounting entries for items you receive (and for previous receipts      you return to suppliers).

Purchase Orders normally generates credit entries to     this account for items you receive. 
Therefore, the account can be thought     of as the accrued amount payable for goods received. 
Purchase Orders debits    this account when you enter receipt returns.

As you post the related vendor invoices in Sage 300     Accounts Payable, offsetting journal 
entries (debits) related to the items     purchased are generated against the Payables Clearing 
account to clear    the balance that is left in this account from posting the inventory receipt.

 l Inventory/Expense. The account that you debit when you receive items and credit      when you 
enter returns.

For more information, see "P/O Account Sets Screen   " (page 314).
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Adding Account Set Records  

Note: This screen is available only if you are using Purchase Orders as a stand-alone program 
(that is, you do not use Inventory Control).

You add account sets to define a group of general ledger accounts to which to post Purchase Orders 
transactions (if you use Purchase Orders as a stand-alone system without Inventory Control). Mo re ...

You must add at least one account set to Purchase Orders before you   can add item records. If you 
add more than one account set, you can group   items by the account set to which they belong.

To add Account Set records:

 1. Open Purchase Orders > P/O Setup > Account Sets.

 2. In the Account Set Code field, type a code of up to six   characters to identify the account set.

 3. Type a description for   the account set.

 4. Type the general ledger   account numbers for the payables clearing and inventory/expense 
accounts   that make up the set.

Tip: If you use Sage 300 General Ledger with Purchase   Orders, you can use the Finder  

icons to select general ledger   accounts.

 5. Click Add.

 6. To add another record,   click the New  icon beside the Account Set Code field to clear the 
screen   for a new record, and then repeat steps 2 through 5.

Managing Account Set Records    

Note: You maintain account sets in Purchase Orders only in a stand-alone system (that is, you do 
not use Inventory Control).

You can add and delete account set records  in your Purchase Orders system, and you can change 
the description, active status, and general ledger account   numbers for an account set at any time. Mo re ...

New general ledger account assignments are used only in transactions   you add after the change. 
Existing transactions in the general ledger   batch use the previous account numbers. Make any 
corrections you need   in existing transactions in Sage 300 General Ledger, if you use it,   or in your 
other general ledger.
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If you make an account set inactive, you cannot assign it to a new item   record. You can post 
transactions for and make changes to item records   that were assigned to the account set before you 
made it inactive.

You cannot delete an account set that is assigned to an item number.   Before deleting an account set, 
reassign any item numbers that are assigned   to the account set to other account sets.

To edit account set records:

 1. Open Purchase Orders > P/O Setup > Account Sets.

 2. In the Account Set Code field, type the code for the   record you want to edit, or select it using the 
Finder or the navigation   buttons beside the field.

 3. Make the changes you need.

 4. Click Save.

To delete Account Set records:

 1. Open Purchase Orders > P/O Setup > Account Sets.

 2. In the Account Set Code field, type the code for the   record you want to edit, or select it using the 
Finder or the navigation   buttons beside the field.

 3. Click Delete.

 4. If a message appears asking   you to confirm the deletion, click Yes.

You can also use the Delete Inactive Records screen to delete inactive   account sets. For more 
information, see "P/O Delete Inactive Records Screen" (page 278)

Additional Costs

Enter additional cost records for   extra costs you are charged by your vendors (such as shipping or 
handling   charges).

About Additional Cost Codes

You can use additional cost codes to identify the extra costs, such     as for shipping and handling, that 
your vendors or carriers charge on     the orders they send to you. 

When you enter the codes with receipts, invoices,     credit notes, or debit notes, the corresponding 
information is displayed    for you to accept or change, as needed. Mo re ...

You can also add additional costs to transactions without using additional    cost codes. For more 
information,    see "About Entering Additional Costs on Receipts" (page 129).

41Sage 300 2021 Purchase Orders User's Guide



Creating Additional Cost Records

You choose    the Additional Costs icon from the Setup folder to create records for    the additional costs 
in your Purchase Orders system. Each record includes:

 l A unique code of up to      six characters to identify the cost.

 l An optional description      of the cost.

 l The vendor number (optional). Mo re ...

Because you can create additional cost records by vendor number, you              can set up separate records 
for the additional costs assessed by particular              vendors. When you use one of these additional cost 
codes with a transaction,              the specified vendor number and associated tax group are automatically              
displayed.

You can also set up additional cost codes without vendor numbers, then              use the code for any 
vendor, entering the vendor number and tax group              when using the cost in a transaction.

Tip: If you              use multicurrency accounting and you do not assign a vendor number to the              cost, you 
specify the currency in which you pay the cost. You can use              the code for all vendors who use the 
same currency.

If you assign a vendor number to a cost, the vendor's currency is displayed,              and you cannot change 
it.

 l The amount of the cost (optional). Mo re ...

If you are creating an additional cost code for a standard charge, you     can enter the amount of the 
charge. When you select the additional cost     code for a transaction, the set amount is displayed, but 
you can change     it.

If the additional cost amount varies, you may prefer to leave the amount     at zero in the additional 
cost record, then enter the amount with each     transaction that uses the cost.

Note: If you     use multicurrency accounting, you type amounts in the currency specified     for the 
cost.

 l The method by which you       prorate      the cost over items on a receipt. Mo re ...

You can choose to:

 l Expense the cost separately   from the items in the transaction (no proration).

 l Prorate the cost to item   details by quantity, cost, or weight. 
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Note: When you prorate a cost by quantity, the   program does not convert units of measure 
to stocking units. For example,   if you order 12 boxes and 12 single units of the same item 
on two separate   detail lines, the program prorates additional costs over 24 units, 
regardless   of how many single units are contained in a box.

 l Manually calculate and   add the costs to the item details in a receipt. 

For documents created in version 5.3A or earlier multicurrency   ledgers, you can use this method 
only when the vendor for the transaction   uses the functional currency.

 l The general ledger expense      account to which you post amounts for costs you expense (do not 
prorate).

 l The method you use to       reprorate      additional costs that were prorated to items that you 
returned. Mo re ...

Use the Reproration field to specify whether to reallocate costs from   items you returned to other 
items on the same receipt.

You can choose to:

 l Leave the additional cost   (that was prorated to the returned items) as originally allocated in 
the   receipt.

 l Prorate the additional   cost from the returned items to the remaining items on the receipt.

 l Expense the additional   cost that was originally prorated to returned items to a general ledger   
account you specify in the additional cost record. 

 l The general ledger account       to which you post cost amounts on returns when you expense the 
costs (that      is, you do not prorate them).

 l Optional field information      if you added fields to the Additional Cost screen.

 l The tax authorities and      purchase tax classes that apply to the cost, if any. Mo re ...

If the cost is taxable,       you specify all the tax authorities and purchase tax classes that apply       to 
the cost, so that Purchase Orders can calculate correct tax amounts       for you when you enter 
transactions for the cost. When you prorate taxable       additional costs, the tax amount is added to 
the additional cost, then      the total amount is prorated.

You select from the tax authorities and purchase tax     classes you have set up for your company 
in the Tax Services screens in    Common Services.

Adding Additional Cost Records

You add additional cost records to define codes to identify   the extra costs you are charged by your 
vendors (such as shipping or handling   charges).
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To add additional cost records:

 1. Open Purchase Orders > P/O Setup > Additional Costs.

 2. Fill in the following fields:

 l Additional Cost. Type a unique code of   up to six characters to identify the additional cost 
record, and enter   a description of the cost.

 l Vendor Number. If the cost is regularly   charged by a particular vendor, type the vendor 
number or select it from   the Finder. You can also leave this field blank if you want to use 
the   additional cost code for more than one vendor. 

 l Currency. Select the currency in   which you will enter the additional cost.

 l Amount. Type the amount of the   cost, if known. (If the cost varies, leave the Amount field 
showing zeroes.)

 l Proration. Specify whether to expense   the cost or allocate it to items on a receipt. 

Select No Proration to   charge the cost to a general ledger account, or select a proration 
method   (by quantity, weight, cost, or manually).

 l Expense Account. If you choose not to prorate   the cost, type the number of the general 
ledger expense account to which you post   the additional cost. If you use Sage 300 
General Ledger, you can select   the account from the Finder.

 l Return Proration. If you choose to prorate   the cost, specify whether to prorate the cost to 
remaining items on a   receipt when you return items. You can also leave the cost amount 
in the   account it was posted to with the receipt or expense it to another general   ledger 
account.

 l Return Account.  If you expense the cost   on returns, type the general ledger account 
number to use.

 l Click Add.

 l If the additional cost   is subject to taxes, specify the tax authorities and associated tax 
classes   that apply. If more than one tax authority applies, press the Insert key   on your 
keyboard to start a new line, after you have completed the tax   information for a previous 
line.

 3. To add another record,   click the New  button beside the Additional Cost field to clear the 
screen   for a new record, and then repeat steps 2 and 3.

Managing Additional Cost Records  

You can edit and delete additional cost records in your Purchase Orders system. Mo re ...

You can edit additional cost records at any time. 
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You can change all   the information, except the additional cost code. To change the code,   you first add 
a new record that uses the code you want, then delete the   record for the code you no longer want to 
use.

You can delete an additional cost only if it is not in use on an incomplete   receipt or return.

To edit additional cost records:

 1. Open Purchase Orders > P/O Setup > Additional Costs.

 2. Type the code for the   record you want to edit, or select it using the Finder or the navigation   
buttons beside the Additional Cost Code field.

 3. Make the changes you need.

 4. Click Save.

To delete additional cost records:

 1. Open Purchase Orders > P/O Setup > Additional Costs.

 2. Type the code for the   record you want to delete, or select it using the Finder or the navigation   
buttons beside the Additional Cost Code field.

 3. Click Delete.

 4. If a message appears asking   you to confirm the deletion, click Yes.

E-mail Messages

Create e-mail messages to send with purchase orders and returns.

Creating E-mail Messages

You can e-mail purchase orders and purchase returns directly to vendors that use an e-mail delivery 
method in the A/P vendor record. When e-mailing the purchase orders and returns, you also specify a 
pre-defined e-mail message to send along with the e-mailed form. Mo re ...

Note: 
Before you can send the forms by e-mail, you must also do the following:

 l In Accounts Payable, select an Email delivery method for each vendor that you want to e-
mail. (You set the delivery method on the Processing tab of the vendor record in Accounts 
Payable.)

 l Choose Vendor as the Delivery Method on the Print Purchase Orders or Print Returns 
screen when you print purchase orders or returns.
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To create e-mail messages for purchase orders and returns:

 1. Open Purchase Orders > P/O Setup > E-mail Messages.

 2. Create the e-mail message that you want to send to vendors:

 a. In the Message Type field, select Purchase Order or Return from the list.

 b. Click the New  button beside the Message ID field.

 c. In the Message ID field, enter a code to identify this message, using up to 16 
characters.

 d. In the Description field, enter a description for the message, using up to 60 characters.

 e. In the E-mail Subject field, enter a subject.

Note: You can use e-mail information codes in this field. They will be replaced by the 
company or document information when the message is sent.

 f. Type your message, using company or document information codes to specify PO or 
return details.

Note: To identify variable information that you want to include with the message, use 
information codes preceded by a dollar sign.

 3. When you are satisfied with your message, click Add or Save.

E-mail Message Variables  

You can use the following variables in the messages you create to send with e-mailed purchase 
orders and returns.     Purchase Orders replaces the variables in the e-mail messages with information 
from your Sage 300 database when you send the    message. 

Orders (PO3020)

Value to Insert E-mail Message Variable

Company contact $COMPANY_CONTACT

Company name $COMPANY_NAME

Description $DESCRIPTION

Expected receipt date $EXPECTED_RECEIPT_DATE

Order E-mail Message Variables
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Value to Insert E-mail Message Variable

Fax number $COMPANY_FAX

Purchase order amount $PURCHASE_ORDER_AMOUNT

Purchase order date $PURCHASE_ORDER_DATE

Purchase order number $PURCHASE_ORDER_NUMBER

Telephone number $COMPANY_PHONE

Reference $REFERENCE

Vendor contact $VENDOR_CONTACT

Vendor name $VENDOR_NAME

Vendor number $VENDOR_NUMBER

Returns (PO3040)

Value to Insert E-mail Message Variable

Company contact $COMPANY_CONTACT

Company name $COMPANY_NAME

Description $DESCRIPTION

Fax number $COMPANY_FAX

Purchase order date $PURCHASE_ORDER_DATE

Purchase order number $PURCHASE_ORDER_NUMBER

Receipt date $RECEIPT_DATE

Reference $REFERENCE

Return amount $RETURN_AMOUNT

Ship-via description $SHIP_VIA_DESCRIPTION

Return E-mail Message Variables
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Value to Insert E-mail Message Variable

Ship-via information $SHIP_VIA

Telephone number $COMPANY_PHONE

Vendor contact $VENDOR_CONTACT

Vendor name $VENDOR_NAME

Vendor number $VENDOR_NUMBER

Items

If you do not use Inventory Control, use the P/O Items screen to add and manage item records for 
items that you regularly purchase from your vendors for sale to your customers.

About Setting Up Items

Note: The Items screen is available in Purchase Orders only if you do not use     Sage 300 Inventory 
Control. If you use Inventory Control, you set up    items in that program.

Before you can enter inventory transactions, you need to add item records.     Item records contain 
information about items that you regularly purchase    from your vendors for sale to your customers.

Note: You must set    up account sets before you can add item records to Purchase Orders.

You record the following information for each item that you want to    add to your inventory list:

 l The number you use to       identify the item. Item numbers can be up to 24 characters, and can 
contain      blanks and special characters.

 l A description of the item.

 l The account set the item       uses. (You assign an account set to define the general ledger 
balance-sheet      accounts for the item.)

 l (Optional) A commodity      number if your company reports a value-added tax (VAT).

 l The unit weight (the weight       of one stocking unit of the item). The weight must be in the same 
weight      units (such as pounds) that you specified in the Options screen. 

 l The name of the unit of measure and the conversion factor associated with one stocking unit of 
the item. (For example, if the unit of measure is "dozen," you type 12.)

 l (Optional) Tax information       used to calculate tax amounts, including the taxing authority and tax      
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classes for purchases and sales of the item.

 l Up to 300 characters of      additional item information.

For step-by-step instructions on using the Items screen to add, edit,    or delete an item record, see 
"P/O Items Screen" (page 335).

You can import item records into Purchase Orders from non-Sage 300     programs, instead of entering 
them in the Items screen. For information    about importing item records, see "About Importing and 
Exporting Purchase Orders Setup Records" (page 38).

Adding Item Records   

Note: You add item records in Purchase Orders only if you do not use Inventory Control.

To add an item record:

 1. Open Purchase Orders > P/O Setup > Items.

For more information on the fields on this screen, see "P/O Items Screen" (page 335)

 2. In the Item Number field, type a number to identify the item. 

 3. In the adjacent field, enter a  description of the item.

 4. On the Items tab, enter the following information:

 l The   general ledger account set you want to assign to the item. (Type or use   the Finder to 
select the account)

 l If   your company reports a value added tax (VAT), the commodity number for   the item.

 l The   weight for one unit of the item. (The weight you enter should be in terms   of the 
Weight Unit Of Measure you entered on the Processing tab of the P/O  Options screen.)

 l Purchase   Orders lets you use up to four additional fields to include descriptive   
information for the item. You can use up to 75 characters in each   of the four fields.

 5. On the Units tab, add units of measure, as follows:

 a. Click the table, press the Insert   key, and then enter the following information:     

 i. The   name for the unit of measure (for example: dozen, gallon, ton).

 ii. The   conversion factor (the number of stocking units for the unit of measure).   For 
example, if the unit of measure is "dozen," you type 12.  You   must enter the unit of 
measure you intend to use for the stocking unit   before you can save the record. 
The conversion factor for the stocking   unit must be 1 (one).
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 6. On the Taxes tab:  

 a. Use   the Finder to select the taxing authorities you want to assign to the   item. (You define 
taxing authorities in the Tax Services folder of Common   Services.)

 b. Type   or select the numbers of the tax classes you want to assign to the item   for 
purchases for each selected tax authority.

 7. On the Optional Fields   tab (if it is available):

 a. Click   the first column heading to display the Optional Field Finder, and then select   the 
fields you want to add to this item (if the item fields are   not automatically inserted). 

 b. Enter   the information for the field in the third column.

 8. Click Add.

 9. Repeat steps 2 through 8 for each item you want to   add.

Managing Item Records

Note: You can edit or delete item records in Purchase Orders only if you do not use Inventory 
Control.

You can change most of the information in an item record at any time. Mo re ...

Note: 
You cannot: 

 l Directly change   an item number. You must first create a new item record with the new 
number,   copy the item information to the new record, then delete the old item   record. 

 l Assign an item   to an inactive account set.

The changes have no effect on current transactions. You will see the   changes the next time you 
select the item in a new transaction.

We do not recommend that you change the account set assigned to an item   record for which you 
have posted transactions. Purchase Orders warns you   if you attempt to change an item’s account set 
while there are posted   transactions for the item for which Day End Processing has not been run.

Once you make an item inactive, you cannot use it in transactions (except   for purchase order returns) 
unless you make it active again.

Before You Start

 l Before you can delete an item record, you must have completed all receipts   involving the item 
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and, if you posted   any transactions for the item since the last day-end processing, you must 
run day-end processing.

To edit item records:

 1. Open Purchase Orders > P/O Setup > Items.

 2. Type the code for the   item record you want to edit or select it using the Finder or the navigation   
buttons next to the field.

 3. Make the changes you need.

 4. Click Save.

To delete Item records:

 1. Open Purchase Orders > P/O Setup > Items.

 2. Type the item number for   the item you want to delete, or select it using the Finder or the 
navigation   buttons beside the field.

 3. Click Delete.

 4. If a message appears asking   you to confirm the deletion, click Yes.

Tip: You can also use the Delete Inactive Records screen to delete inactive   item records. For more 
information, see "P/O Delete Inactive Records Screen" (page 278).

Optional Fields

If you use Sage 300 Transaction Analysis and Optional Field Creator, you can add optional fields to 
records, transactions, and transaction details.

About Optional Fields

Purchase Orders supports Transaction Analysis and Optional Field Creator, a separately licensed 
package that you can use with any    edition of Sage 300.

Optional fields provide exceptional     flexibility to customize     your Purchase Orders system. You can use 
an unlimited     number of optional fields to store additional information with your purchase     orders 
transactions (such as requisitions, purchase orders, receipts,    and invoices).

Note: Like     all other Sage 300 modules, Purchase Orders lets you add optional fields     to transaction 
documents and to each detail line of a transaction. It     also lets you pass optional field information 
through the complete transaction     cycle—from purchase requisitions, to purchase orders, to 
receipts, to     invoices, and even to downstream ledgers like Accounts Payable and General    Ledger. 
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Optional field information can originate with vendor and item records,    and flow through requisitions, 
purchase orders, receipts and invoices.

Optional Field Information Flow

When you create invoices or general     ledger transactions in Purchase Orders, the program passes 
the optional     field values used in the transactions to Accounts Payable and to General     Ledger if the 
optional fields in Purchase Orders are the same as the optional     fields assigned in those programs. 

Optional field information even appears in the General Ledger journal entries for Purchase Orders 
accounts,    as well as in the Transaction Details Optional Fields report.

And, if the optional fields that you assign to Purchase Orders documents     match the optional fields 
used for Accounts Payable vendors and Inventory     Control items, the information entered in those 
programs appear as   default entries on transactions that you add in Purchase Orders..

If you use Sage 300 Project and Job Costing, you     can also specify whether optional field information 
for job-related transactions    will be passed to Project and Job Costing (as an external cost 
transaction).

 l Optional fields that     flow to A/P.

Invoice/credit       note/debit note header and detail optional fields if the optional fields       assigned to 
Accounts Payable invoices match the optional fields assigned      to Purchase Orders invoices and 
credit/debit notes.

 l Optional fields that     flow directly to G/L The following optional     field information can be 
passed to General Ledger directly from Purchase    Orders:

 l Invoice/credit       note/debit note detail optional fields if the transaction optional fields       
assigned to G/L accounts match the optional fields assigned to P/O invoice      and 
credit/debit note details.

 l Receipt       and return detail optional fields if the transaction optional fields assigned       to G/L 
accounts match the optional fields assigned to P/O receipt and      return details.

Generated Transactions Use Optional Fields

Purchase orders that are generated from requisitions, from low stock levels in Inventory Control, and 
from    backorders in Order Entry, also include optional fields.
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If you want information from I/C item optional   fields to appear with Purchase Orders transactions, 
assign the same optional fields to P/O transaction details as those assigned to item records in 
Inventory Control.

If you want optional field information to flow from requisitions,   to purchase orders, to receipts, and so 
on, assign the same optional fields to each P/O transaction and transaction   detail .

For more information, see "About Setting Up Optional Fields" (page 53).

About Setting Up Optional Fields

Note: You can set up and use optional fields only if you use Transaction Analysis and Optional Field 
Creator.

Setting up optional fields is a two-step process. You must:

 1. Set up system-wide optional fields in Common Services. Mo re ...

Before you can use optional fields in Purchase Orders, you must define optional fields for your 
Sage 300 system using the Optional Fields screen in Common Services.

 2. Set up optional fields for use with Purchase Orders transactions and records. Mo re ...

You use the Optional Fields screen in the P/O Setup folder to assign optional fields to:

 l Requisitions, purchase orders, receipts, invoices, returns, and credit/debit notes.

 l Requisition, purchase order, receipt, invoice, return, and credit/debit note transaction 
details.

 l Additional costs and receipt additional costs.

 l Receipt additional cost details, invoice additional cost details, and credit/debit note 
additional cost details.

 l Item records defined in Purchase Orders (if you are not using Inventory Control).

Important! Make sure that you use       the same optional fields for invoices in Accounts Payable and 
for general       ledger accounts in the General Ledger program in order to pass information      between 
programs. For more information about how optional fields flow from one module to another in Sage 
300, see "About Optional Fields" (page 51).

After setting up optional fields in Purchase Orders, you can use them in Purchase Orders records and 
transactions.

Optional Field Settings

You specify the following settings for each optional field you set up in Purchase Orders: 
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 l A default       value (depending       on the type of field).

Note: 
If an optional field requires validation, you can select     only a value that is assigned to the 
optional field in Common Services.     (If the optional field allows blanks, you can leave the 
default value    field blank.)

If the optional field does     not use validation, you can select a value from the list (if any were     
assigned in Common Services), leave the field blank, or enter any value     that is consistent 
with the type of field (yes/no, text, number, date,     amount, and so on) and does not exceed 
the maximum number of characters    permitted for the optional field.

 l Whether the optional field will be      automatically inserted in new records or transactions.

 l Which optional fields will be passed      to other Sage 300 modules, and which will be included in 
transactions      that are passed to General Ledger for posting to G/L accounts. 

Unless you restrict the fields that are passed to other modules, all optional fields in Purchase Orders     
that match optional fields in Accounts Payable and in General Ledger accounts are passed those 
modules.

Example: When setting up invoice detail optional fields, you click the Settings button, and then 
choose the types of     G/L accounts that receive optional field information from invoice details,     and 
the details in Accounts Payable invoices that will receive optional    field information.

Note: The Settings button is available only for transactions     that are sent to another Sage 300 
program. For example, invoices     are sent to Accounts Payable, but requisitions are    used only in 
the Purchase Orders program.

Creating Validation Tables for Optional Fields

You can create a list of permitted entries for each field you add to     a screen, using the Optional Tables 
screen in Common Services. 

For information    about creating optional tables, see the System Manager Help.

   Adding Optional Fields to Purchase Orders that Use Datapipes

You can add optional field information to the purchase order forms that come with the program by:

 l Setting datapipe query parameters in the PORPT.INI file, so that the datapipe      will process 
optional fields. Mo re ...

The purchase orders datapipe allows you to extract fields    from the following database tables:
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 l APVENO (optional fields for Accounts Payable vendors).

 l POPORHO (optional fields for purchase order headers).

 l ICITEMO (optional fields for inventory items).

 l POPORLO (optional fields for purchase order details).

The purchase orders datapipe identifies the various types of details that       it prints by parameters 
in PORPT.INI and by different LNTYPE codes.

LNTYPE is       a field in the datapipe record provided to the Crystal report. For more information, 
see "About Detail LNTYPE Codes" (page 70).

All optional fields are initially turned off in PORPT.INI.

 l Using SAP Crystal Reports®  for Sage 300 to add the optional fields to a detail section in the 
report form. Mo re ...

Purchase Orders comes with four standard purchase orders formats: 

 l Two formats use datapipes (POPOR01.rpt and POPOR02.rpt).

Note: Datapipes     are programs that extract and organize data to increase the efficiency    of 
particular reports.

 l Two formats read data directly      from the Sage 300 database (POPOR03.rpt and 
POPOR04.rpt).

To set the datapipe query parameters for printing purchase orders:

 1. In your Sage 300 program folder, locate the PORPT.INI file in the PO folder, and then open it in 
text editing software.

 2. Search for POPOPRN.DLL for POPOR01.RPT or POPOR02.RPT.

 3. To include optional field information, set the following parameters to 1:

 l Parameter 15 (vendor optional fields)

 l Parameter 16 (header optional fields)

 l Parameter 17 (item optional fields)

 l Parameter 18 (detail optional fields)

Note: If the information   is not required on the forms, set the parameter to 0.

 4. Save, and then close the file.

 5. Restart Sage 300.
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After setting the datapipe query parameters

Use SAP Crystal Reports®  for Sage 300 to edit the POPOR01.RPT or POPOR02.RPT to use the 
optional fields.

For more information on designing and adapting forms and reports, see the Customizing Printed 
Forms guide, which is available online at 
https://cdn.na.sage.com/docs/en/customer/300erp/Sage300ERP_Documentation.htm.

Setting Up Optional Fields        

Note: You must install Transaction Analysis and Optional Field Creator before you can use optional 
fields.

You add optional field records to define additional information to keep with Purchase Orders 
transactions and transaction details. Mo re ...

You must use the same optional fields for transactions   in Purchase Orders, Accounts Payable, and 
General Ledger if you want to   pass optional field information from Purchase Orders transactions to 
Accounts   Payable when you create A/P invoice batches and to General Ledger when   you create 
batches for G/L transactions.

Similarly, you must define the same fields for transaction   details as you define for additional costs and 
item records if you want   information from costs and items to appear by default in transactions.   (Items 
are used only if you do not have Sage 300 Inventory Control.) 

For more overview information, see "About Optional Fields" (page 51) and "About Entering Optional 
Data on Transactions" (page 149).

Before You Start

 l Determine which optional   fields you need in Purchase Orders.

 l Decide which optional   field information you want to pass to other ledgers with item records   and 
with G/L transactions to the general ledger.

 l If the optional fields   you need have not been added to Sage 300, use the Optional Fields   
screen in Common Services to add them.

To set up optional fields Purchase Orders transactions and transactions details:

 1. Open Purchase Orders >   P/O Setup > Optional Fields.

For more information, see "P/O Optional Fields Screen  " (page 340).

 2. From the Optional Fields For list, select a transaction   type.
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 3. Click in the optional   field entry table, and then press the Insert key to start   a new line.

 4. Enter information for each optional field you are adding to the record, transaction, or 
transaction detail, as follows:

 a. In the Optional Field column, click the Finder  or press   F5, and then select an 
optional field   from the Finder list.

Tip: For optional field information to flow through   all transactions in the purchasing 
process, you must add the same fields   to each record. For the information to flow to 
Accounts Payable and General Ledger, also, you must use identical optional fields for 
transactions and transaction details in Purchase Orders and in Accounts Payable as 
you use for accounts and transaction details in General Ledger.

 b. To set a default   value for the optional field:

 c. Double-click in the Value Set column to change it to Yes. Mo re ...

The Value Set   field alerts the data entry clerk that a seemingly blank optional field   
actually has an entry. By looking at the Value field, you cannot tell whether it has a 
“blank”   default value or no value at all.

 d. Type or select the value   to appear as the default for each optional field. Mo re ...

If the optional field   you selected requires validation, you must select a value that is 
defined   for the optional field in Common Services. If the optional field   allows blanks, you 
can leave the default value field blank.

If the optional field   does not use validation, you select a value that   is defined for the 
optional field in Common Services or leave the field blank.

Note: The entry must be consistent with the type of field   (text, number, date, amount, 
and so on) and must not exceed the number   of characters specified for the optional 
field. In a Yes/No field, you   can enter only Yes or No.

 e. To make the optional field   mandatory,   double-click in the Required column. Mo re ...

During data entry, if an optional field is required, but does not have   a default value, you 
must fill in the field before you can proceed. If   the optional field has a default value, you 
can accept the value that   appears, or assign a different one. 

 f. If you   want the optional field and its default value to appear automatically in   new records 
and transactions, select Yes in the Auto Insert   column.

Note: If the field is a required field, the   Auto Insert field changes to Yes. 
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 g. Click the Settings button, if  is available, and then specify which optional fields   to send to 
other Sage 300 subledgers and which to include in transactions sent to General Ledger.

Tip: Send to General Ledger   only optional fields that are used for financial analysis, 
and only to the accounts where they   are required. For more information, see "P/O 
Optional Fields Screen  " (page 340).

 h. Click Save.

After   adding optional fields to P/O

 l Use the Optional Fields   screen in General Ledger to add optional fields to G/L transaction 
details,   if you are passing optional fields from P/O transaction details to G/L.

 l Use the Optional Fields   screen in Inventory Control if you want to add optional fields 
associated   with I/C items to transaction details.

Ship-Via Codes

Set up ship-via codes to identify the shipping methods or carriers you use to deliver your orders from 
vendors.

About Setting Up Ship-Via Codes

If you regularly use particular carriers or shipping methods when receiving items into stock, you can 
set up a code to identify each method. You then type the code on purchase orders, instead of typing 
in the information each time.

In the record for each ship-via code, you can type the name, address, and phone numbers of the 
carrier, as well as the name of a contact person or position to call if there is a problem with a delivery. 
You can also enter a comment of up to 80 characters.

You do not have to use ship-via codes. Instead, you can type a description of the shipping method, 
using up to 60 characters, on each transaction you enter. You can also omit shipping information from 
transactions altogether.

To add ship-via records, choose the Ship-Via screen from the Setup folder.

Adding Ship-Via Records   

You can add records for each   carrier you use to deliver your orders from vendors. 

58Sage 300 2021 Purchase Orders User's Guide



To add a ship-via record:

 1. Open Purchase Orders > P/O Setup > Ship-Via Codes.

 2. In the Ship-Via Code field, type a unique code of up to six characters to identify the ship-via 
record.

 3. Press Tab, and then enter a description for the code.

 4. Type the address, telephone and fax numbers, and contact name.

 5. Type a comment of up to 80 characters, if desired.

 6. Click Add.

 7. To add another record, click the New  icon beside the Ship-Via Code field to clear the 
screen for a new record.

Managing Ship-Via Records   

You can edit or delete Ship-Via Codes in your Purchase Order system at any time.

Note: You cannot delete ship-via records that are entered on incomplete requisitions, purchase 
orders, receipts, or returns.

To edit Ship-Via records:

 1. Open Purchase Orders > P/O Setup > Ship-Via Codes.

 2. Type the code for the record you want to edit, or select it from the Finder beside the Ship-Via 
Code field.

 3. Make the changes you need.

 4. Click Save.

To delete Ship-Via records:

 1. Open Purchase Orders > P/O Setup > Ship-Via Codes.

 2. Type the code for the record you want to delete, or select it using the Finder or the navigation 
buttons beside the Ship-Via Code field.

 3. Click Delete.

 4. If a message appears asking you to confirm the deletion, click Yes.

Templates

Speed up and simplify transaction entry in Purchase Orders by setting up templates that specify 
default settings for new transactions.
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About Templates

A template is a set of default information for transaction headers (the information that applies to all 
transaction details such as transaction date, vendor, FOB point, description, and reference). Mo re ...

You use templates to automatically fill in fields in the Requisition Entry, Purchase Order Entry, Receipt 
Entry, Invoice Entry, Return Entry, and Credit/Debit Note Entry screens with the information and 
selections you use most often, so you do not have to retype standard information every time you add 
a transaction.

Note: Templates are optional. You can enter transactions without using templates.

Purchase Orders templates let you speed up and simplify transaction entry by providing default 
settings which appear when you start a new transaction. Mo re ...

You can specify the following information for each template that you define:

 l Purchase order type

 l FOB point

 l On hold 

 l Ship-to and bill-to locations   (if you use Inventory Control)

 l Description

 l Reference

 l Comment

 l Ship-via code

 l Tax group

 l Terms

You must specify the purchase order type and tax group in a template;   the other information is 
optional.

Note: The information in a number of the template fields can also come from other records.

Example: The On Hold, Terms, and Tax Group fields are also in the vendor records.

If you want to use templates, use the Templates screen, selected from the P/O Setup folder, to define 
them.

You must specify the purchase order type (Active, Standing, Future, Blanket) and the tax group for 
each template. You can also select codes for the shipping and billing locations (if you use Inventory 
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Control), shipping method, and payment terms you want to use. You can type an FOB point, 60-
character description, 60-character reference, and comment of up to 250 characters.

After setting up your templates, you can specify a default template code on the P/O Options screen. 
This template then provides the initial settings for every transaction you enter.

You can change the default settings in a transaction by entering a vendor number that uses a 
different tax group or terms code from the default template, or by selecting another template code 
that uses different settings. You can also change any of the individual settings provided by a template.

Note: In multicurrency systems, you can change a transaction's template only to another template 
with a tax group that uses the vendor's currency.

Assigning a Default Template Code

After setting up templates, use the Default Template Code option to specify a default template that 
contains the general information that you want to appear on transaction-entry screens when you start 
entering   a new requisition, purchase order, or other type of transaction.

This option can help you speed up data entry by automatically inserting the information you use most 
often when entering these types of documents.

Default templates. You can specify a default template on the P/O Options screen to have a standard 
set of default vendor and purchase order settings appear for each new transaction you create.

Changing templates and vendors.   The default template provides initial settings, but these are 
overridden by settings from the vendor record— and from another template if you choose another one 
after selecting the vendor.

Vendor tax group and terms.Templates override a vendor's tax group and terms. When you select a 
new template code, the vendor's tax group and terms will be changed consistent with   the new 
template code.

Adding Templates

Add templates that contain default header and vendor information to use in transactions. Mo re ...

You use the templates to automatically fill in fields in the transaction-entry screens with the 
information and selections you use most often, so you do not have to enter the information every time 
you add a transaction.

To add templates:

 1. Open Purchase Orders > P/O Setup > Templates.

 2. Type a unique code of up to six characters to identify the template.
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 3. Type information and make selections, as needed, to define the template.

Note: You must specify a tax group and terms code for each template.

 4. Click Add.

 5. To add another template, click the New  icon beside the Template Code field, and then 
repeat steps 2 through 4 for each template you want to add.

Managing Templates   

You can edit or delete templates from your Purchase Order system at any time. However, you cannot 
delete the default template (selected in the P/O Options screen). Mo re ...

You can change everything in template records except the identifying code. To change the code, you 
first add a template with the code you want to use, then delete the template with the code you do not 
want.

Transactions that existed before you change the template are not affected by your editing.

Note: In multicurrency ledgers, you can assign a template only to a vendor that uses the same 
currency as the specified tax group.

To edit templates:

 1. Open Purchase Orders > P/O Setup > Templates.

 2. Type the code for the record you want to edit, or select it from the Finder beside the Template 
field.

 3. Make the changes you need.

 4. Click Save.

To delete templates:

 1. Open Purchase Orders > P/O Setup > Templates.

 2. Type the code for the record you want to delete, or select it using the Finder or the navigation 
buttons beside the Template field.

 3. Click Delete.

 4. If a message appears asking you to confirm the deletion, click Yes.
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Vendor Details

If you do not use Inventory Control, use the P/O Vendor Details screen to record the vendors and 
costs for each item you purchase.

About Vendor Details

Note: The Vendor Details screen is available in Purchase Orders only if you do not use Sage 300 
Inventory Control. If you use Inventory Control, you set up vendor details in that program.

You use the Vendor Details screen to link each item record to up to nine vendors. You also use this 
screen to record details about each vendor and the costs for the item.

When a vendor is linked to an item record, you can select the vendor's item number as you enter item 
details on requisitions and purchase orders. Purchase Orders fills in the cost of the item for you, and 
prints the vendor's item number, rather than your company's item number, on the purchase order.

You normally assign vendors to an item record in order of priority. For example, if you buy the same 
item from more than one vendor, you would assign Vendor 1 to the vendor you use most often.

For step-by-step instructions on using the Vendor Details screen to add, edit, or delete a vendor 
details record, see "P/O Vendor Details Screen   " (page 369).

Note: Before you can add vendor detail records, you need to add item records in Purchase Orders 
and add the vendor records in Accounts Payable.

Adding Vendor Details   

Note: You add vendor details in Purchase Orders only if you do not use Inventory Control.

You add vendor details in a stand-alone Purchase Orders system to:

 l Record the vendors and costs for each item you purchase.

 l Establish the order of priority of your suppliers, if you buy the same item from more than one 
vendor.

To add vendor details for items:

 1. Open Purchase Orders > P/O Setup > Vendor Details.

 2. In the Item Number field, type the item number or select it using the Finder or the navigation 
buttons beside the field.

 3. Fill in or edit the details for each vendor.
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 4. To add another vendor to the same item, press the Insert key.

The program automatically assigns the next highest priority number (Type) to the vendor, but 
you can change this to any value between 1 and 9 not already assigned to a vendor. Fill in or 
edit the fields as before.

 5. Click Save.

Managing Vendor Details   

Note: You maintain vendor details in Purchase Orders only if you do not use Inventory Control).

You can edit or delete vendor details at any time. The changes have no effect on current transactions. 
You will see the changes the next time you select the item in a new transaction.

Tip: You can change any of the details for a vendor except the vendor’s currency, if the vendor is 
set up in Accounts Payable.

To edit vendor detail records:

 1. Open Purchase Orders > P/O Setup > Vendor Details.

 2. Type the item number for the record you want to edit, use the Finder to choose an item from 
the list, or use the navigation buttons to move through the list.

 3. Make the changes you need.

 4. When finished, click Save.

To delete vendor detail records:

 1. Open Purchase Orders > P/O Setup > Vendor Details.

 2. Type an item number in the Item Number field, use the Finder to choose an item from the list, 
or use the navigation buttons to move through the list of items.

 3. Select a vendor record from the list of vendors.

 4. Click Delete.

 5. Click Yes if you are asked to confirm the deletion.

Vendor Contract Costs

Use the P/O Vendor Contract Costs screen to enter costs for items you purchase, based on which 
vendor you purchase them from.
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Managing Vendor Contract Costs   

You can edit or delete vendor contract costs in Purchase Orders at any time. Your changes have no 
effect on current transactions. You see the changes the next time you select the item in a new 
transaction.

To edit vendor contract costs:

 1. Open Purchase Orders > P/O Setup > Vendor Contract Costs.

 2. Choose to edit costs by vendor number or item number.

 3. Enter or select the number of the vendor or item that you want to edit.

 4. Double-click the line containing the costs that you want to edit.

 5. Press F1 again for help on editing item cost details when the Vendor Contract Costs screen 
appears.

 6. Click Save.

To delete vendor contract costs:

 1. Open Purchase Orders > P/O Setup > Vendor Contract Costs.

 2. Choose to delete costs by vendor number or item number.

 3. Enter or select the number of the vendor or item that you want to delete.

 4. Click (select) the line containing the costs that you want to delete.     

Note: Double-click the line to review cost details before deleting.

 5. Click Delete. 

 6. Click Yes if you are asked to confirm the deletion.

Setting Up Vendor Contract Costs   

Add Vendor Contract Costs records to assign vendor prices   to your inventory items. Mo re ...

Vendor contract costs appear as defaults when you add purchase orders,   receipts, invoices, returns, 
and credit/debit notes. If no contract cost   exists for an item and vendor, Purchase Orders displays the 
default item   cost specified in the P/O Options screen. 

Tip: You can view all vendors’ contract costs in the Unit Cost item Finder in the Purchase Order 
Entry, Receipt Entry, Invoice Entry, Return Entry, and   Credit/Debit Note Entry screens.
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To add vendor contract costs:

 1. Open Purchase Orders > P/O Setup > Vendor Contract Costs.

 2. Click New to start adding vendor contract costs.     

Tip: If reviewing costs, choose whether to view costs for an item number or a vendor.

 3. On the P/O Vendor Contract Costs screen that appears next, enter the vendor number for 
which you want to set up contract costs, or select it using the Finder.

 4. Select the first item number for which you want to enter costs.

 5. Fill in the cost, discount, and tax information for the item.

 6. When you have finished adding contract cost information, click Add.

Designing Formats for Purchase Orders Reports and Forms
Purchase Orders comes with several formats for printing purchase orders forms (requisitions, 
returns, mailing labels, and receiving slips), analytical reports, and setup reports. You can use these 
formats "as is" or, if you use SAP Crystal Reports®  for Sage 300, you can customize these formats or 
design your own.

About SAP Crystal Reports

All reports in Purchase Orders use SAP Crystal Reports®, and have the file extension RPT.

You can:

 l Modify any report using SAP Crystal Reports®  for Sage 300.

 l View previous tabs in the Print Preview screen without having to restart the report.

 l Attach reports to an e-mail using the E-mail print destination in System Manager.

 l Export reports (for the Print Preview screen) to a large number of formats, including:

 l Comma-Separated Values (CSV)

 l Data Interchange Format

 l Excel 2.1, 3.0, 4.1, and 5.0

 l HTML

 l Lotus 1-2-3

 l ODBC
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 l Text

 l Paginated test

 l Columnar text

 l Rich Text Format (RTF)

 l Word for Windows

 l Lotus Notes

 l Microsoft Mail

Modifying Forms

To modify or create forms or repots, you must install SAP Crystal Reports®  for Sage 300.

For more information on designing and adapting forms and reports, see the Customizing Printed 
Forms guide, which is available online at 
https://cdn.na.sage.com/docs/en/customer/300erp/Sage300ERP_Documentation.htm.

About Purchase Orders Forms

Purchase Orders provides standard report formats for printing copies of Purchase Orders 
transactions. You can use these report forms "as is," or you can customize them to suit your own 
needs using SAP Crystal Reports®  for Sage 300. For more information, see "About SAP Crystal 
Reports" (page 66).

You can print forms immediately after posting Purchase Orders transactions, or you can print a range 
of these documents at any time.

Purchase Orders

You can print purchase orders immediately after posting, or at any time using the P/O Purchase 
Orders screen.

 l To print a purchase order after posting, select Yes to print the purchase order after posting. 
For more information, see "Printing a Purchase Order Immediately After Posting" (page 229).

 l To print a range of purchase orders, open the P/O Purchase Orders screen and fill in the range 
of purchase orders you want to print before they are cleared from Purchase Orders. For more 
information, see "Printing Purchase Orders" (page 227).

Requisitions

You can print requisitions immediately after posting, or at any time using the P/O Requisitions screen.
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 l To print a requisition after posting, select Yes to print the requisition after posting. For more 
information, see "Printing a Requisition Immediately After Posting" (page 232).

 l To print a range of requisitions, open the P/O Requisitions screen and fill in the range of 
requisitions you want to print before they are cleared from Purchase Orders. For more 
information, see "Printing Requisitions" (page 231).

Receiving Slips

You can print receiving slips immediately after posting, or at any time using the P/O Receiving Slips 
screen.

For more information, see "Printing Receiving Slips" (page 224).

Mailing Labels

You can print mailing labels at any time using the P/O Mailing Labels screen.

For more information, see "Printing Mailing Labels" (page 223).

Returns

You can print returns immediately after posting, or at any time using the P/O Returns screen.

 l To print a return after posting, select Yes to print the return after posting. For more information, 
see "Printing a Return Immediately After Posting" (page 236).

 l To print a range of returns, open the P/O Returns screen and fill in the range of returns you 
want to print before they are cleared from Purchase Orders. For more information, see 
"Printing Returns" (page 234).

Printing and E-mailing Forms

 l Mailing labels. For more information, see "P/O Mailing Labels Screen" (page 257).

 l Purchase orders. For more information, see "P/O Purchase Orders Screen" (page 267).

 l Receiving slips. For more information, see "P/O Receiving Slips Screen" (page 259).

 l Requisitions. For more information, see "P/O Requisitions Screen" (page 262).

 l Returns. For more information, see "P/O Returns Screen" (page 264).

Sending Purchase Orders and Returns by E-mail

If you want to e-mail purchase orders and returns to vendors, you use the E-mail Messages screen in 
the P/O Setup folder to create the e-mail messages that you want to send to vendors.
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For each vendor that you want to email, you must select an Email delivery method on the Processing 
tab of the vendor record in Accounts Payable.

You use the same icons in the P/O Forms folder to print forms or send e-mail messages to vendors.

For more information on designing and adapting forms and reports, see the Customizing Printed 
Forms guide, which is available online at 
https://cdn.na.sage.com/docs/en/customer/300erp/Sage300ERP_Documentation.htm.

Sample Formats for Printed Forms

Sage 300 Purchase Orders includes sample formats you may be able to use with your laser or ink-jet 
printer "as is" or adapt to print on the forms you use for purchase orders, requisitions, receiving slips, 
returns, and mailing labels. Mo re ...

The files containing the formats include:

Form Printing On Plain Paper Printing On Preprinted Forms

Requisitions PORQN01 PORQN02

Purchase 
Orders

POPOR01
POPOR04

POPOR02
POPOR05

Receiving Slips PORCP01
PORCP03

PORCP02
PORCP04

Returns PORET01 PORET02

Mailing Labels POLABEL n/a

If possible, you should design the formats you want to use and test them with the sample data before 
you begin entering transactions in your new Purchase Orders system.

For more information on designing and adapting forms and reports, see the Customizing Printed 
Forms guide, which is available online at 
https://cdn.na.sage.com/docs/en/customer/300erp/Sage300ERP_Documentation.htm.

The Purchase Orders program also lets you email purchase orders and purchase order returns to 
vendors.

If you want to email purchase orders and returns to vendors, you use the E-mail Messages screen in 
the P/O Setup folder to create the email messages that you want to send to vendors.
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For each vendor that you want to email, you must select an Email delivery method on the Processing 
tab of the vendor record in Accounts Payable.

About Detail LNTYPE Codes

Each detail type associated with a purchase order is identified by a     particular line type code. The 
standard SAP Crystal Reports® purchase order     forms shipped with Purchase Orders use a 
suppression formula to select the type of    detail appearing in each detail section. 

For example, the suppression formula LNTYPE <> 1     prints purchase order header optional fields, 
but you could refine the    formula to print only a single optional field.

The purchase orders datapipe provides six different detail line types:

 l 0—Accounts Payable vendor optional fields

 l 1—Purchase order header optional fields

 l 2—Normal purchase order details

 l 3—Inventory Control item optional fields

 l 4—Purchase order detail optional fields

 l 5—Comments / instructions

Datapipe Report Parameters for Purchase Order Forms

A "datapipe" is a dynamic link library (DLL) program that performs database queries for reports or 
forms. Mo re ...

Because datapipes are compiled and optimized for specific reports, they can provide significant 
performance advantages over reports that use standard database access techniques (ODBC 
access).

The disadvantage of datapipes is that they provide access to a fixed group of fields. You cannot 
customize a datapiped report as much as you can customize non-datapiped one.

For more information on designing and adapting forms and reports, see the Customizing Printed 
Forms guide, which is available online at 
https://cdn.na.sage.com/docs/en/customer/300erp/Sage300ERP_Documentation.htm.

You can include detail comments and   instructions, item information, and/or vendor information (such 
as website and e-mail addresses, and vendor optional fields) on the purchase   order forms. For more 
information about editing datapiped forms, see "Editing Datapiped Purchase Order Forms" (page 71)
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Editing Datapiped Purchase Order Forms

Purchase Orders includes both "datapiped" and "non-datapiped" purchase order forms. You may be 
able to print these templates "as is," or you can use SAP Crystal Reports® to change the    layout to suit 
your needs (or to create your own forms).

You can also include detail comments and   instructions, item information, and/or vendor information 
(such as Web   site and e-mail addresses, and vendor optional fields) on the purchase   order forms. To 
do so, you set certain parameters in the PORPT.INI datapipe query to 1.(If the information is not 
required on the forms, set the parameter to 0.)

To edit datapiped purchase order forms:

 1. In your Sage 300 program folder, locate the PORPT.INI file, and then open it in text editing 
software.

 2. To include detail comments and   instructions, item information, and/or vendor information, set 
the following parameters to 1:

 l Parameter 12 (comments   and instructions)

 l Parameter 13 (item information)

 l Parameter 14 (vendor information)

 l Parameter 15 (vendor optional fields)

 l Parameter 16 (header optional fields)

 l Parameter 17 (item optional fields)

 l Parameter 18 (detail optional fields)

Note: If the information   is not required on the forms, set the parameter to 0.

 3. Save, and then close the file.

 4. Restart Sage 300.

Using Non-datapiped Purchase Order Forms

Purchase Orders includes both "datapiped" and "non-datapiped" purchase order forms. You may be 
able to print these templates "as is," or you can use SAP Crystal Reports®  for Sage 300 to change the 
layout to suit your needs (or to create your own forms).

To use non-datapiped purchase order forms, you must edit the PORPT.INI file. For more information, 
see Sage Knowledgebase article 21367.
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Adding Purchase Orders Statistics and History
If you want to add purchase statistics for prior fiscal periods from your old purchase orders system, 
you should do so before you add any new purchase orders and requisitions. Purchase Orders 
automatically creates statistical data from the transactions you post after setting up if you use the 
Accumulate Statistics option.

About Adding Purchase Statistics

If you set up Purchase Orders partway through a fiscal year, you may want to add statistical data for 
the year to date and previous years. You should add statistics that you want to view online or print on 
reports.

To add statistical information during setup or to edit it later, you must first select the Accumulate 
Statistics and Allow Edit Of Statistics options on the P/O Options screen.

Keeping Purchase History and Statistics

Depending on the options you select for keeping purchase history and statistics, Purchase Orders 
automatically updates statistical information with every transaction that you post. The program keeps 
this data until you clear it using the Clear History screen.

Entering Statistics from Your Previous Purchase Orders System

If you select the Accumulate Statistics option, Purchase Orders creates statistics for each 
transaction you post.

If you also select the Allow Edit Of Statistics option, you can manually enter statistics from prior 
periods in your old purchase order system when you are setting up your new Purchase Orders 
system.

You use the Purchase Statistics screen to add the data to your Purchase Orders system, and to look 
at the data online or print the data on the Purchase Statistics report. For more information, see "P/O 
Purchase Statistics Screen" (page 379).

For each period, you can enter:

 l Number of purchase orders, receipts, invoices, and credit notes and debit notes.

 l Net quantity purchased and net purchase amount.

 l Net invoice amount.

 l Average invoice, credit note, and debit note amounts.
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 l Largest and smallest invoice, credit note, and debit note amounts, and the vendors who issued 
them.

Important! Do not add the same statistics twice. If you post opening and year-to-date 
transactions to set up your new Purchase Orders system, Purchase Orders will also create 
statistics for these transactions and periods (if you use the Accumulate Statistics option). If you are 
also adding statistical data you want to keep in Purchase Orders, be careful not to duplicate 
statistics that the program has already created for you.

For more information about the historical information you can keep in Purchase Orders, see "About 
Accumulating Statistics" (page 14).

Adding and Managing Statistics

Before You Start

 l Select the options to      Accumulate Statistics and Allow Edit Of Statistics on the P/O Options 
screen.

 l Select the type of year      and period to accumulate statistics by on the P/O Options screen.

To create or manage statistics:

 1. Open  Purchase Orders > P/O Statistics and Inquiries >      Purchase Statistics.

 2. Choose the year and period   for which to add or edit statistics, and the currency in which you will   
enter amounts (multicurrency ledgers only).

 3. Add or edit statistical   information in the Purchases group or the Invoices And Credit Notes   
group.

If the screen does not let you enter data, close the   screen and any Purchase Orders screens 
that are open for the company, then   select the Allow Edit Of Statistics option on the P/O 
Options screen and save   the change to the screen.

Note: You can save changes to the P/O Options   screen only when no Purchase Orders 
screens are open for the company on your   computer or on any other workstations, if you are 
working on a network.

 4. When finished   adding the statistics for a period, click the Add button. (The button   name then 
changes to "Save.") When finished editing statistics   for a period, choose the Save button.
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Deleting Purchase Statistics

To delete statistics:

 1. Open  Purchase Orders > P/O Statistics and Inquiries >      Purchase Statistics.

 2. Choose the year and period   for which to delete statistics, and select the currency in which to 
display   amounts (multicurrency ledgers only).

 3. Click Delete. 

If you see a message asking you to confirm that you want to delete the   statistics, click Yes.
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Chapter 2: Entering and Posting 
Purchase Orders Transactions

Use Purchase Orders transaction entry screens to process requisitions, purchase orders, receipts, 
invoices, returns, credit notes, and debit notes.

About Transaction Processing in Purchase Orders
This article describes how posting, day-end processing,   and audit trails relate to transaction 
processing in Purchase Orders.   

In Purchase Orders, you enter requisitions, purchase orders, receipts,   invoices, returns, credit notes, 
and debit notes. The purchase order processing cycle can include:

 l Posting requisitions.

 l Creating and posting purchase orders from requisitions or without using requisitions.

 l Posting receipts to purchase orders or without referencing particular purchase orders.

 l Posting returns to receipts or without referencing receipts.

 l Posting invoices to receipts or without receipts (for additional costs).

 l Posting credit notes to invoices or returns or without referencing invoices or returns.

 l Posting debit notes to invoices or without invoices.

Online Posting

Purchase   Orders uses online transaction   processing rather than batch processing. This means that 
each transaction   is posted when you click Post after entering the transaction.

When you post transactions, Purchase Orders immediately updates item   quantities on purchase 
order and on hand in Inventory Control, so you always   know your inventory levels. 

Item costs may be updated by posting or by running Day End Processing —depending on your setting 
for the Inventory Control option Cost   Items During Posting or Day End Processing.
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Also, depending on your I/C and P/O options, posting may add G/L transactions   to new or existing 
batches, or they may be added during Day End Processing   or, manually, using the Create Batch 
screen

Job-Related Transactions

For   job-related transactions, posting updates committed and actual quantities   and costs in Project 
and Job Costing. (Most updates   to jobs arise from purchase orders and receipts. However, Purchase 
Orders also updates Project and Job Costing whenever invoices differ from the   originating receipts, 
or if you have returns (with credit notes) and debit   notes.

Day End Processing Updates Everything Else

You must run Day End Processing to   create posting journals and update history and statistics in both 
Inventory   Control (if you use it) and Purchase Orders (if you keep history and statistics).   

You may also update item costs during Day End Processing—depending on   your options in Inventory 
Control. 

Day End Processing also creates batches of Accounts Payable invoices,   credit notes, and debit notes 
from Purchase Orders transactions, and creates   general ledger transactions (if you use the option to 
create them during   posting or day end processing, and you cost items during day-end processing).

If necessary, you can run Day End Processing several times a day to   keep this information more 
current.

Using P/O without Inventory Control

If you use Purchase Orders without Sage 300   Inventory Control, the program treats all items as non-
stock items. If you use a stand-alone Purchase Orders system, it:

 l Does not maintain item quantities on order or on hand. 

 l Does not update   item costs. 

 l Uses the most recent cost of an item from a vendor as the   default item cost in Purchase Orders 
screens. 

Keeping Transaction History

If   you use the Keep Transaction History option, Purchase Orders keeps transaction   details until you 
remove them using the Clear History screen. You can print   reports of the data—and reprint 
requisitions, purchase orders, receiving slips, and returns—until you clear the   transaction history for 
them.
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If you do not keep transaction history, completed transactions are deleted   when you run Day End 
Processing. Purchase Orders considers the following   transactions to be completed:

 l Requisitions and purchase orders with a Completed status (all detail lines are completed).

 l Receipts for which an invoice has been posted for every vendor specified on the receipt.

 l Returns for which credit notes have been posted.

 l Invoices, credit notes, and debit notes (complete on posting) transferred to Accounts Payable.

Important! If you do not keep history, you cannot display completed transactions   after you run Day 
End Processing.

Posting Journals

You can print posting journals for receipts,   invoices, returns, credit notes, and debit notes after 
running Day End   processing. 

You can print the journals until you delete the information   for them, using the Clear History screen. 

Purchase Order Types 

The type specified for a purchase order determines how the purchase order is processed. You can 
create active, standing, future, and blanket purchase orders.

Active

An active purchase order is a purchase order you intend to process immediately.

Standing

Standing purchase orders contain   items you often order together. You can issue active purchase 
orders from   standing purchase orders, as frequently as needed. 

You can create standing purchase orders that contain items you often   order together, and then 
create active purchase orders from the standing purchase   orders.

Creating active purchase orders from standing purchase orders. To create an active purchase 
order from a standing purchase order, you   call up the standing purchase order and change the type 
to Active (you   can also select Future or Blanket to create other types of purchase orders),   make the 
changes you need, then post the new order with a new purchase   order number you typed or a 
number assigned automatically by the program.
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When you post a purchase order you created from a standing purchase   order, the standing purchase 
order is retained in the system, unchanged   and with its original number, regardless of how many 
purchase orders you   issue from it.

Changing a standing purchase order. To change the contents of a standing purchase order, you 
display the   purchase order, make the changes you need, then post them. You can change   everything 
about an existing standing purchase order except its number   and type. If you change the purchase 
order number or type, the program   assumes you are creating a new purchase order.

Future 

Future purchase orders are purchase orders you enter with a future date   on which you expect to 
activate and issue the purchase order.

Day End Processing automatically activates future purchase orders on   the purchase-order date (or 
the first time you run Day End processing   after the purchase-order date). Alternatively, you can 
change the status   of a future purchase order to Active before the purchase-order date, or   change the 
activation date.

Day End Processing posts newly activated future purchase orders so that   purchasing statistics are 
updated and items are placed on purchase order   in Inventory Control.

Tip: If   you usually run Day End Processing at the end of the work day, future   purchase orders set to 
be activated on a certain day will not become active   until the end of the day. To be sure a future 
purchase order is ready   to be processed on the correct date, assign a date earlier than the desired   
date..

Blanket

Blanket purchase orders are purchase orders you set up for  a certain monetary amount, from which 
you issue active purchase orders   until you have used up all the available funds.

When to use blanket purchase orders.   You might use blanket purchase orders when you want to 
make a number   of purchases over time, but want to avoid having to post a new requisition   and 
purchase order for each purchase. For example, you might use a blanket   purchase order to 
periodically replenish office supplies.

Blanket purchase orders are not normally used to buy inventory items.   If you plan to buy a lot of 
inventory over time, you should process it   through a large active purchase order, with all the details, 
rather than   by using a blanket purchase order. 

Setting up and using blanket purchase   orders. When you set up a blanket purchase order, you 
specify the   total amount (cost) of items that can be purchased. With each new purchase,   you add 
detail lines to the blanket purchase order.
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Tip: You can change the total amount allowed for a blanket purchase   order at any time. If you wish, 
you can assign security to the Original   Amount field on the Order tab, so that only authorized 
persons can change   the amount.

When you post new details, the amount still available is calculated   and displayed.

When the available amount reaches zero, the blanket purchase order is   completed and you cannot 
use it to make any further purchases.

Posting   additional costs for blanket purchase orders. Because you do not   enter additional costs on 
purchase orders, and you can change costs on   receipts without updating the purchase order, you 
may post a receipt total   that exceeds the available amount on the blanket purchase order. Although   
Purchase Orders lets you post this type of receipt, your procedures may   not permit you to exceed the 
amount specified on the blanket purchase   order.

About General Ledger Journal Entries Generated by Purchase Orders

This topic describes the general ledger journal entries that are created   for Purchase Orders 
transactions. 

Journal entries are   created for Purchase Orders transactions in two stages: 

 l Posting or Day End processing creates inventory   entries (or general ledger entries, if you do 
not use Inventory Control)   from receipts and returns.

 l Accounts Payable posting creates entries   from invoices, returns, credit notes, and debit notes. 
(No general ledger   entries are created for requisitions or purchase orders.)

Printing the G/L Transactions Report

If you use the option to create G/L transactions using the Create   Batch icon in Purchase   Orders, you 
can print the G/L Transactions report and check the entries   before creating G/L batches.

Note: If you use the   option to create G/L transactions during posting, transactions are created and 
the report information is deleted   by posting or Day End Processing (depending on when you cost 
inventory). You must use the G/L Listing in General Ledger to see the information.

Taxes

Allocated taxes are posted to the same general ledger accounts as their corresponding   item or 
additional cost details. 

Recoverable and expensed taxes are posted   to the accounts specified for the tax authorities in Tax 
Services.
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About Optional Fields in Transactions

Purchase Orders supports Transaction Analysis and Optional Field Creator, a separately licensed 
package that lets you add optional fields to transaction documents (like purchase orders and 
invoices) and to each detail line of a transaction.

Note: You can use optional fields only if you use Transaction Analysis and Optional Field Creator.

To use optional fields in Purchase Orders transactions, you must first add them to transaction entry 
screens using the Optional Fields screen in the P/O Setup folder.

If you use the same fields in Purchase Orders transactions screens, optional field information will be 
passed as default entries from one transaction to the next transaction in the transaction cycle—from 
purchase requisitions, to purchase orders, to receipts, to invoices.

It will even pass the information to downstream ledgers, such as Accounts Payable and General 
Ledger—as long as you assign the same optional fields to each of the transaction screens and to the 
general ledger accounts.

You can change the optional field information for particular transactions, and change which fields 
appear in each screen.

Optional Field Information Transferred to A/P and G/L

When you create invoices or general ledger transactions in Purchase Orders, the program passes 
the optional field values used in the transactions to Accounts Payable and to General Ledger if the 
optional fields in Purchase Orders are the same as the optional fields assigned in those programs. 
Optional field information will even appear in the General Ledger journal entries for Purchase Orders 
accounts, as well as in the Transaction Details Optional Fields report.

And, if the optional fields that you assign to Purchase Orders documents match the optional fields 
used for Accounts Payable vendors and Inventory Control items, the information entered in those 
programs will appear by default on transactions that you add in Purchase Orders.
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Optional Fields in Generated Transactions

Purchase orders that are generated from requisitions, from low stock levels in Inventory Control, and 
from backorders in Order Entry also include optional fields.

If you use the same optional fields for invoices, credit notes, and debit notes as you use in the 
Accounts Payable Invoice Entry screen, the optional entries are transferred to Accounts Payable with 
Purchase Orders transactions.

About Vendors

You can add new vendor records to Accounts Payable from all of the Purchase Orders transaction-
entry screens, or type new vendor numbers then add them later in Accounts Payable.

This feature lets you add new vendors "on the fly" so that you can enter transactions for vendors who 
are not in your Accounts Payable data, even if you do not have time or rights to add vendor accounts 
in Accounts Payable.

To add a new vendor record from a Purchase Orders screen, type the vendor number, press Tab, 
then use the "New" icon next to the Vendor Number field to open the Vendors screen in Accounts 
Payable and add the record. When you close the Vendors screen, you are returned to the Purchase 
Orders screen you were using.

If you do not want to add the record in Accounts Payable while you are entering Purchase Orders 
transactions, you can just type the new vendor number and the name of the account in the Purchase 
Orders transaction-entry screen, then add the vendor to Accounts Payable later (before you post the 
Purchase Orders transactions).

Primary and Secondary Vendors

The primary vendor is the vendor from which you received goods. You can include both item details 
and additional cost details for primary vendors on receipts, invoices, credit notes, and debit notes.

A secondary vendor is one that just adds charges to the receipt—such as for freight.

The secondary vendor is the vendor who charged you costs on a shipment of goods, but who did not 
supply the goods themselves.

Note: You cannot enter item details for secondary vendors. You can enter additional cost details 
only.
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About Importing and Exporting Purchase Orders Transactions

Importing Transactions

You can import requisitions, purchase orders, and receipts that you   previously exported for reuse. 
You cannot import documents with numbers   that you have already assigned in Purchase Orders, 
unless you have cleared   the transactions with those numbers.

The original file from which you imported the information is retained   until you delete it. 

Purchase orders can include requisition numbers, and receipts can include   purchase order numbers. 
You can import additional cost details for the   primary vendor on a receipt, but you cannot import 
additional costs for   secondary vendors.

You cannot import multicurrency requisitions, purchase orders, or receipts   into a single-currency 
Purchase Orders system. Edit a multicurrency import   file to remove the multicurrency fields before 
importing.

Exporting Transactions

You can export all Purchase Orders transaction types, including requisitions,   purchase orders, 
receipts, invoices, returns, credit notes, and debit   notes.

Use the Export command on the File menu to transfer credit note and debit note, invoice, receipt, and 
return transactions created in Purchase   Orders to non-Sage 300 applications, or to a file to be edited 
and   imported later.

Before exporting, decide which fields to include in the export file.   You must select fields for each type 
of record used for the transaction type. You should also find out the path for the export file you   want to 
use or create.

Tip: If you do not want to export   all transactions, use the Set Criteria option to specify which 
documents to export. 

When you click Export, Purchase Orders exports all the transactions of the current type currently in 
the system. 

Note: Purchase Orders uses more than one database table to store   transaction records. If you are 
exporting any of these records (including   additional costs), the Export dialog box shows a list of the 
tables that   you can export for the record once you select the export file type and   the file to which to 
export the data. 
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Tax Information

Change tax amounts, tax groups, and tax classes for Purchase Orders documents.

About Tax Information and Amounts

Purchase Orders calculates a tax amount on purchase orders, receipts,     invoices, returns, credit 
notes, and debit notes if all three of the following    conditions apply:

 l You have entered tax rates      for the applicable tax authorities and classes in Tax Services.

 l The vendor for the document      is subject to tax.

 l The transaction contains      taxable items or taxable additional costs.

In Purchase Orders, tax information is calculated and displayed for     individual details and for the total 
purchase order, receipt, invoice,     return, credit note, or debit note. (No tax information is displayed for    
requisitions.)

Tax calculations are based on the rates entered for the various authorities    and tax classes in Tax 
Services.

You can edit some tax information for individual detail lines, but you     can change tax amounts directly 
only for the document as a whole. To change     tax amounts for the primary vendor, use the Taxes tab 
on the transaction-entry screen. For secondary vendors,    use the Additional Cost Vendor Taxes 
screen.

About Document Tax Information

The Taxes tab in Purchase Orders screens displays the tax calculations   for a document as a whole on 
purchase orders, invoices, returns, credit   notes, and debit notes. 

For receipts, total taxes are displayed on the   Taxes tab for the primary vendor, and on the Additional 
Cost Vendor Taxes   screen for secondary vendors. 

Tax information for a transaction total includes:

 l Tax authority and description   (for the vendor's tax authorities).             

 l The vendor's tax class   and description for each tax authority. You can change to another tax   
class that is assigned to the tax authority. New vendors you have not   yet added to Accounts 
Payable are assigned tax class 1 and its corresponding   description for each tax authority in the 
tax group selected for the transaction. 

For information about entering taxes for details, see "About Detail Tax Information" (page 84).
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Recalculating Taxes

On the Taxes tab and on the Additional Cost Vendor Taxes screen, you use   the Calculate Tax button 
to have the program recalculate taxes using the   tax tables from Tax Services after you have changed 
tax amounts. Taxes   are calculated automatically when you choose the Totals tab or when you   post 
the transaction.

Changing the Tax Amount

You can change the total tax amount to correct small discrepancies, such   as rounding errors. (You 
should correct large errors by updating the tax   rates and other information for the tax authorities in 
Tax Services.)

 l The total amount of tax   that is included in the cost   amounts entered for the vendor. You cannot 
edit this amount.             

 l The total amount of tax   that is charged in addition to   (not included in) the cost amounts entered 
for the vendor. You cannot   edit this amount.             

 l Tax amount (the total   of all tax amounts calculated for the transaction). The total tax amount   for 
an authority is the sum of the tax included and tax excluded. If you   change the tax amount, the 
program adjusts the tax amounts on the details.             

Editing Taxes for the Document Vendor

Purchase Orders automatically calculates the vendor taxes on each transaction,   using the rates 
entered in Tax Services for the tax authorities and classes   assigned to the vendor in Accounts 
Payable.

You can change the tax class and the tax amount for each tax authority   assigned to the document 
vendor for a transaction on the Taxes tab of   the screen you are using.

About Detail Tax Information

You can select a detail on a detail-entry grid on any transaction-entry     form, then click the Item/Tax 
button to open a separate screen where you can view or edit information for the selected detail, and 
add new details.

Note: If you are entering an additional cost, you click the Cost/Tax button     to open a similar screen 
that displays a single additional cost detail.    

You can also open the screen by selecting the item or additional cost    detail, then clicking the Zoom 

 button.
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Tax Information on the Detail Taxes Screens

The Detail Items/Taxes screen and the Detail Costs/Taxes screen provide     additional tax information 
for the detail that you do not see on the details table. You can check the tax information for the detail, 
and you can change     the tax class and the tax-included status for each tax authority (if the    vendor's tax 
authority allows tax-included costs).

The Detail Items/Taxes screen shows, for the selected detail:

 l Tax authorities      and their descriptions in the vendor's tax group. Mo re ...

You can change to another tax class that is assigned to the tax authority.

If you enter a detail line for a non-inventory item or additional cost,   or an item that does not have the 
vendor's tax authority assigned to its   item record, the tax class for the detail is determined by the 
additional   cost code, if any. If no additional cost code is used the class is set   to 1, with the description 
entered for tax class 1 in Tax Services.

If you change an item's tax class to non-taxable for a tax authority,   no tax is charged for the detail 
and authority, even if the vendor   is subject to tax for the authority.

 l Detail tax class      —whether the item is      taxable. Mo re ...

The tax classes and class descriptions that are assigned to the tax   authority.

If necessary, you can change the tax class to another tax class that   is assigned to the authority (for 
example, if the particular item is not   taxable). You cannot change the description here.

To change the tax class description or make other changes to the specified   tax group, use the Tax 
Services screens in Common Services. 

 l Tax Included option—whether tax is included       in the cost (the default choice for this option is 
provided from the vendor      record in Accounts Payable). Mo re ...

The default choice for this option is provided by the vendor record   in Accounts Payable or by the 
vendor contract cost.

Note: You can include tax in item costs and change the choice for the Tax   Included option only   if 
Allow Tax In Price is selected for the tax authority in   Tax Services.

 l Tax amount—      the total of allocated, recoverable, and expensed tax amounts for each      authority. 
Mo re ...

Tax amounts in the Detail Items/Taxes screen do not include taxes charged   on additional costs that 
you prorated to the detail.

Similarly, tax amounts in the Detail Costs/Taxes screen show tax totals   only for the additional cost 
detail.
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 l Allocated Tax     — the total tax amount       that was allocated to the selected detail line for the tax 
authority. Mo re ...

This is the tax that you wish to include in the cost of an item. It   can be either tax-included or tax-
excluded, but the full amount of the   allocated tax is added to item costs in Inventory Control.

 l Recoverable Tax—a tax amount that      is refundable. Mo re ...

A tax amount that is refundable to the purchaser, so is not part of   the cost that is posted to the 
Inventory Control item record. Recoverable   taxes are displayed only by detail line.

General ledger transactions are created during posting or Day End Processing   to post recoverable 
taxes to the general ledger account specified for   them in Tax Services.

 l Expensed Tax      —if the tax is expensed      rather than included in the value of inventory. Mo re ...

A tax amount that is posted to a general ledger expense account, rather   than to the account to 
which you post the cost. This tax amount is not   posted to the Inventory Control item record.

 l Tax Included      —the tax that is included      in the cost of the item. Mo re ...

Use this field to indicate whether tax amounts are included in the item   cost or additional cost amount 
(instead of charged in addition to the   detail cost).

The default choice for this option is provided from the vendor record   in Accounts Payable or from 
the vendor contract cost. 

You can choose Yes for this option only if Allow Tax In Price  is selected for the authority in Tax 
Services.

 l Tax Base      —the amount on which      the tax is based. Mo re ...

This field shows the net cost of items before tax is added for the tax   authority. You cannot change 
the amount that appears in this field.

(This field is particularly useful for items that have tax included   in their prices.)

You specify whether a tax is allocated, recoverable, or expensed, and     assign the general ledger 
account for the tax in the Tax Authorities screen    in Tax Services.

Detail Tax Calculation   

Tax amounts are calculated for details when you post the transaction    or click the Totals tab on the 
screen.

To check tax amounts for details before     posting a transaction, select the detail on the detail table, 
click     Item/Tax to open the Items/Taxes screen, then click the Calculate     Taxes button. The program 
calculates taxes for the entire document, not    just for the detail you were editing.
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If you edit a tax amount on the Taxes tab, and then click Calculate     Tax, the program uses the tax 
tables in Tax Services and your selections    for the tax class and the tax-included option to recalculate 
taxes.

Once taxes are calculated, you can see the allocated tax, tax-included,     and net-of-tax amounts for a 
detail on the detail    line, but you cannot change any information in these fields.

About General Ledger Transactions for Edited Taxes 

New general ledger transactions are created by posting or Day End Processing   (depending on when 
you cost inventory items) if you change tax amounts   when you:

 l Edit tax information or   change item quantities or costs on a posted receipt or return, or on an   
invoice, credit note, or debit note.

 l Reprorate additional costs.

 About Tax for Additional Cost Details

You enter additional costs only with receipts, invoices, credit notes,   and debit notes. The same tax 
information is displayed for additional   cost details as for item details. 

Tax on Prorated Additional Costs

For each additional cost detail, you can choose a proration method that specifies   how or whether to 
prorate the additional cost and associated allocated   tax amounts to the item costs.

Prorating Automatically 

If you choose to prorate automatically, posting or Day End Processing calculates   the tax amount for 
each additional cost and prorates the additional cost   amount and allocated taxes to item details, 
according   to the proration method you choose (by quantity, cost, or weight). 

The prorated amounts are not displayed with the affected details. They   are also not included in the 
tax amounts you see in the Item Tax Distribution   screen (because they are not part of the base on 
which taxes are calculated   for items), but they are shown on the posting journals for the transactions.

Recoverable and Expensed Taxes 

Journal entries for recoverable and expensed taxes are created in Accounts Payable   when the 
invoice batch from Purchase Orders is posted.
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Adding Taxes to Manually Prorated Additional   Cost Amounts

If you prorate additional   costs manually, you must accurately calculate the tax amount for each   cost 
you are prorating, then allocate the full amount of the cost and   applicable allocated taxes to item 
details. You must enter the exact amount   to prorate to each item detail in the Manual Proration field 
for the detail   line on the receipt or return.

Multicurrency Ledgers

If you use multicurrency accounting, you can enter additional costs to be   manually prorated only for 
vendors who use the functional currency.

Checking Manual Proration Tax Amounts

If you are manually prorating an additional cost, you can use the Additional Cost Vendor Taxes 
screen to check the allocated tax amount calculated by the program for the additional cost detail.

If the tax calculations for a transaction include recoverable and expensed   taxes, you should calculate 
the allocated tax to prorate manually for   each detail, using the Item/Tax button on the detail entry grid 
(on the   first tab) or in Detail Items/Taxes screen.

Use the Totals tab to check the total additional cost amount (including taxes)   to prorate manually to 
item details. The Totals tab lists:

 l The total amount to be   prorated manually (in the Additional Cost To Be Allocated field). This   
amount is for all vendors included in the transaction whose costs you   are prorating manually.

 l The amount you have prorated   so far (in the Manually Prorated field).

 l The amount, if any, which   has not been prorated or by which the manual proration is greater or 
less   than the total (in the Out Of Balance field).

Changing Tax Information and Amounts on Purchase Orders Documents

To change tax amounts for purchase orders, receipts, invoices, returns, or credit/debit notes, you 
can:

 l Change the tax groups and tax classes for the vendor.

 l Change the tax class for any of the detail lines.

 l Directly change the tax amounts for the whole document.
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To change the total tax amount for a document:

 1. Click the Taxes tab on the the document entry screen. 

 2. Edit the vendor tax class if necessary, and then click the Calc. Taxes button to see the results 
of the change. 

 3. To manually change the total tax amount for the vendor, enter new tax totals in the Tax 
Amount column.

 4. Purchase Orders distributes the updated tax amounts when you move to another tab or post 
the transaction.

To change tax information for single items:

 1. Click the Item/Tax button on the first tab of the document entry screen. 

 2. Change the tax class for an authority, or the tax included option, if necessary. 

Note: 
 l You cannot change the Tax Included setting unless the tax authority allows it. (Tax 

authorities are defined in Tax Services.)

 l The tax amount is not  automatically recalculated until you close this screen and move to 
another tab.

 l The tax amount is not recalculated if you overrode the total tax amount on the Taxes tab. If 
you want to recalculate the tax, you have to use the Calc. Taxes button on the Order tab, the 
Taxes tab, or on the Detail Item/Taxes window.

To change tax amounts for additional costs:

 1. Click the Additional Costs tab, and then click the Vendor Taxes button.

 2. Edit the tax class if necessary, then click the Calc. Taxes button to see the results of the 
change.

 3. To manually change the total tax amount for the vendor's additional changes, enter new tax 
totals in the Tax Amount column. 

 4. Purchase Orders distributes the updated tax amounts to the additional charges when you 
move to another tab or post the transaction.

To change tax information for a single additional cost detail:

 1. Click the Additional Costs tab, and then click the Cost/Tax button to display the Detail 
Costs/Taxes screen. 

 2. Change the detail tax class for a tax authority, or the tax included option, if necessary. 
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Note: 
 l You cannot change the Tax Included setting unless the tax authority allows it. (Tax 

authorities are defined in Tax Services.)

 l The tax amount is not  automatically recalculated until you close this window and move to 
another tab.

 l The tax amount is not recalculated if you overrode the total tax amount on the Vendor Taxes 
screen. If you want to recalculate the tax, you have to use the Calc. Taxes button on the 
Detail Costs/Taxes screen or on the Additional Costs tab.

Currency and Exchange

Learn about currency exchange rates, tax reporting currencies, and multicurrency transactions.

About Processing Multicurrency Transactions in Purchase Orders

You enter multicurrency transactions in Purchase Orders in the same   way as functional-currency 
transactions. The only extra consideration   arises if you need to change exchange rates or assign a 
different tax   group to the transaction.

The currency for a transaction is displayed along with the current exchange   rate when you enter a 
vendor number or select a tax group. (You can change   the tax group for a document only to another 
tax group that also uses   the vendor's currency.)

To change exchange-rate information, use the Rates tab (it appears only   with multicurrency 
transactions for vendors who do not use the functional   currency). You can change the rate type, rate 
date, and exchange rate   for the document. 

When you post multicurrency transactions, Purchase Orders converts the   amounts to the functional 
currency, using the exchange rate information   entered with the transaction. 

About Currency Exchange Rates

If you use multicurrency accounting, you can enter exchange rate information    for vendors who do not 
use the functional currency.

When you select a vendor who does not use the functional currency, a Rates tab appears in the 
transaction screen. This tab displays the vendor's default     rate type, the rate date that corresponds to 
the document date, and the     exchange rate for the rate date. You can enter different information for    
each transaction. 
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Exchange Rates for Retainage Amounts

If you are entering a transaction with retainage, you specify on the     Retainage tab whether the 
retainage invoice uses the same exchange rate    as the original document or the current rate.

    About Tax Reporting Currencies

You specify a tax reporting currency to report taxes in a currency that is not the     vendor currency or 
the functional currency. (This can be a requirement    in some jurisdictions.)

Tax Reporting currency fields appear on purchase orders, receipts,     invoices, returns, credit notes, 
and debit notes only     if the tax reporting currency for one or     more of the tax authorities is different from 
your functional currency    and the vendor's currency.

Set up Taxes in Common Services

You set the tax reporting currency in the Tax Services module    in Common Services.

Changing Tax Reporting Amounts in Transactions

You can change the total tax reporting amount on the Taxes tab during     transaction entry. 

If you do change     the tax reporting amount, you can use the Derive button on the Rates tab    to derive 
the effective tax reporting exchange rate for a transaction. 
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Requisitions
Enter, import, print, and approve requisitions for planned purchases.

About Processing Requisitions

Use the P/O Requisition Entry screen to enter requisitions for purchases you plan to make and for 
which you need approval before you can issue purchase orders.

If you use requisition approval, the requisition is automatically placed on hold unless it is posted by a 
user with approval security authorization. You cannot convert an on-hold requisition to a purchase 
order.

Note: Requisitions are optional in Purchase Orders. You can enter purchase orders with or without 
requisition numbers.

Use requisitions to:

 l Keep current records of present and expected purchasing needs by entering and updating 
requisitions as you run low or out of stock in inventory items and supplies.

 l Specify the vendor for the items you need to purchase, either by selecting a single vendor 
number for an entire requisition or by assigning a vendor number to each detail line. 

 l Create purchase orders from requisitions, either by selecting details and vendors from 
requisitions when adding a single purchase order, or by automatically creating a series of 
purchase orders from existing requisitions.

When you enter a requisition, you specify the date on which you need   to issue the purchase order. 
You can also specify an expiration date that lets you delete an unused requisition automatically during 
Day End Processing, so that you do not have to keep track of and manually clear unwanted 
requisitions.

When you specify a requisition number on a purchase order, the requisition   details that specify the 
vendor number are automatically included (as   are details with no vendor number if you choose to 
include them). You   can change the displayed information and insert and delete detail lines   to create 
exactly the purchase order you need.

Entering New Vendor Numbers

If you enter a vendor number, it becomes the default number for new   detail lines you add to the 
requisition. 
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If you type a vendor number that   you have not yet added to Accounts Payable, you also type the 
vendor's   name or a description of the account.

To add a new vendor while entering a requisition, you can: 

 l Type the vendor number,   press Tab, click the New button, and then enter the vendor 
information "on   the fly" in Accounts Payable, before returning   to Purchase Orders to finish 
entering the requisition.

 l Type a new vendor number and name in the Requisition Entry screen, then add the remaining 
vendor information later in Accounts Payable. 

If the vendor account is on hold in Accounts Payable, the requisition is placed on hold too.   You cannot 
issue purchase orders from it until you remove the hold in   Accounts Payable. You can also put a 
requisition on hold if you do not   want to create purchase orders from it right away.

You cannot enter requisitions   for vendors whose accounts are inactive in Accounts Payable.

Editing Requisitions   

As long as a requisition exists in your Purchase Orders system, you   can edit it and issue purchase 
orders from it. You can add new detail   lines and make other changes to requisitions, whether a 
purchase order   has been posted to the requisition or not.

Even if a requisition is complete, you can edit it and issue purchase   orders from it. You can add new 
detail lines, delete others, and make   changes to incomplete lines.

Deleting Requisitions 

You can delete requisitions or requisition details at any time, even   if a purchase order has been 
posted for the requisition or line.

Job-Related Requisitions

If   the requisition is for a contract that you manage using Sage 300 Project and Job Costing, you must 
specify a contract and a project for each   requisition detail, and, depending on the project type, specify 
the project   category, cost class and resource for the job.

You can allocate items directly to jobs, rather than receive them    into inventory.
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Note: 
You cannot mix job-related and non-job-related items    on a requisition.

Also, you cannot add serialized items or items assigned     to lots to job-related transactions. Instead, 
you must order them as non-job-related     items, receive them into inventory, and then use the 
Material Usage screen in Project and Job Costing to move them from inventory to jobs.

About Completing Requisitions 

A requisition is completed when all its detail lines have a Completed   status. ("Yes" appears in the 
Completed column or field.)

You complete requisitions by:

 l Posting purchase orders   for all the requisitioned items.             

 l Canceling outstanding   requisition details.             

 l Specifying an expiration   date, then automatically clearing the requisition during Day End 
processing.               

When you post a purchase order for a requisition detail line, the line   is automatically completed, 
whether you ordered the full quantity or not.   

Note: Once a detail line is completed, you cannot change it, even if you want   to order the remaining 
quantity. However, you can still create purchase   orders for quantities that remained unordered 
when the requisition detail   was completed.

When you post a purchase order for all the outstanding details on a   requisition, the requisition is 
completed. You cannot make further changes   to the completed details, but you can add details to a 
completed requisition,   making it active again. 

Important! If you do not keep history, completed requisitions are deleted from   your Purchase 
Orders system the next time you run Day End processing.   

You can also delete completed requisitions by displaying the requisition   in the Requisition Entry 
screen, and then clicking Delete.

Creating a New Purchase Requisition   

Requisitions are optional in Purchase Orders. You can enter purchase orders with or without 
requisition numbers. Mo re ...

If you use requisitions, Purchase Orders provides you with a requisition approval system to enforce 
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purchase approvals.

For more information, see "About Requiring Approval for Requisitions" (page 734).

You can enter requisitions without specifying a vendor, and you can enter requisitions that include 
items from several vendors.

You can change requisitions and individual requisition detail lines until they are completed. When you 
post a purchase order that uses a requisition detail, the detail is completed, regardless of the quantity 
that was ordered.

Before You Start

 l If you want to assign numbers automatically, assign or verify the length, prefix, and number for 
Purchase Orders to assign to the next new requisition you create.

 l If you use Transaction Analysis and Optional Field Creator (a separate package), define any 
optional fields you want to add to the Requisition Entry screen (and the other transaction-entry 
screens).

 l Find out the numbers of requisitions you wish to edit or delete.

To create a new requisition:

 1. Open Purchase Orders > P/O Transactions > Requisition Entry.

 2. Press Tab to accept *** NEW *** as the number in the Requisition Number field.     

Purchase Orders will assign a requisition number when you post the requisition.

If you do not want Purchase Orders to assign the number automatically, you can enter the new 
number yourself.

 3. Enter the Vendor number or select it using the Finder. Mo re ...

 l You can skip the vendor number and enter a vendor name—such as for a new vendor—or 
you can skip the vendor fields entirely.

 l You can click the New  button to add a new vendor record in Accounts Payable.

 4. Enter a requisition date, a date required, and an expiration date.     

Note: If the requisition is not completed by the expiration date, it will be deleted when you run 
Day End Processing.

 5. Choose whether this requisition is on hold.     

Note: You cannot create purchase orders from on-hold requisitions.

95Sage 300 2021 Purchase Orders User's Guide



 6. If you are approving a requisition that was previously entered:     

 l You must have requisition approval security rights.

 l You must log on with your own ID.

 l You must remove the On Hold status from the requisition, and then post it.

 7. Choose the Job Related option if you use the Project and Job Costing module and this 
requisition is for a job. Mo re ...

If the purchase requisition is job-related, all items must be for particular contracts, projects, and 
categories in Project and Job Costing.

Also, you cannot add serialized items or items assigned to lots to job-related transactions. 
Instead, you must order them as non-job-related items, receive them into inventory, and then 
use the Material Usage screen in Project and Job Costing to move them from inventory to jobs.

 8. In the Requested By field, enter the name of the person requesting the order.     

Note: If you use Sage 300 Payroll, you can select the requester from the Finder.

 9. Enter the location where you want the goods delivered, and enter a requisition description and 
reference.

 10. Enter requisition details. Mo re ...

You can enter details directly in the detail entry table. (Use the tab key to move through the 
columns.)

Note: 
 l Some columns may not be displayed. Purchase Orders lets you hide columns and 

change the column order.

 l To enter a new detail line, you may have to press Insert.

Alternatively, you can click Detail or press F9 to enter a detail on the Detail Items screen, which 
displays all the fields for one detail.

Enter the following information for each detail:

 a. If this is a job-related requisition:        

 i. Double-click the Contract field and enter the contract number, or click the 
Contract column heading to select a contract number using the Finder.

 ii. Enter the project and category to which you are allocating items.

 b. Double-click the Item Number field and enter an item number, or click the Item Number 
column heading to select an item number using the Finder.
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 c. Enter vendor information.        

Note: You can leave the vendor fields blank, and you can specify different vendors on 
each line. You can create more than one PO from a single requisition.

 d. Enter the location for the detail.

Note: The location for each detail defaults from the Location field in the header fields.

 e. Enter a Quantity Ordered.

 f. To change currency exchange rates in a multicurrency system, click Detail or press F9 
to open the Detail Items screen.

 11. To check the totals for the requisition, click the Totals tab.

 12. Click Post to post the purchase requisition.

Note: If you do not have the security right to approve requisitions, the requisition will be on hold 
after you post it, and the Approval Status field will display "Entered."

After posting the requisition

 l Print copies of the requisitions you posted (if you did not print them individually after posting 
them).                         

You can also print the purchase requisition separately, from the P/O Forms folder.

 l Enter purchase orders for the requisitions.

Editing a Requisition   

To edit a requisition:

 1. Open Purchase Orders > P/O Transactions > Requisition Entry.

 2. Enter the requisition number of the requisition to edit.

 3. Make the changes you need to the requisition information. (You can change all information 
except the requisition number, detail item numbers, and completed requisition details.)

 4. When you have finished, click Post.

 5. Choose whether to print the requisition at the "Posting completed" message. (You can also 
choose Requisitions from the P/O Forms folder to print requisitions.)
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Importing Requisitions   

To import a requisition:

 1. Create the requisitions you want to import, either in another Purchase Orders database or in a 
non-Sage 300 program.

 2. On the Requisition Entry screen, click Import on the File menu.

 3. Do one of the following:     

 l Specify the name and format of the file you want to import.

 l If you have created an import template for the file, choose Load Template, and then 
select the template file.

 4. Specify default entries for any required fields that do not already have entries.

 5. If you expect to import the file again, create a template for it:     

 a. Click Save Template.

 b. Specify a file name and path for the template file.

 6. Click OK to begin importing.

After importing a file you created in a non-Sage 300 program, delete the file in the other program if 
you do not intend to import it again. Purchase Orders does not delete files as it imports them.

Printing Requisitions   

To print requisitions, choose Requisitions from the P/O Forms folder. You can also print a single 
requisition using the Requisition Entry screen, right after posting it. You can reprint requisitions until 
they are complete.

To print a requisition:

 1. Open Purchase Orders > P/O Forms > Requisitions.

 2. If you use more than one requisition form, select the file containing the format you want to use.

 3. Enter the range of requisition numbers to print. To limit printing to a single requisition, enter the 
same requisition number in both the From Requisition Number and To Requisition Number 
fields.

 4. If you want to print new copies of requisitions you printed before, select the Include 
Requisitions Already Printed option.

 5. If you are printing on preprinted forms, click Align to print a test copy and check that the forms 
are correctly inserted in your printer. (You can repeat this step as often as needed.)

 6. When ready, click Print to print the selected requisitions.
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For more information on designing and adapting forms and reports, see the Customizing Printed 
Forms guide, which is available online at 
https://cdn.na.sage.com/docs/en/customer/300erp/Sage300ERP_Documentation.htm.

Deleting a Requisition

You can delete requisitions from the Purchase Orders system through the Requisitions Entry screen.

To delete a requisition:

 1. Open Purchase Orders > P/O Transactions > Requisition Entry.

 2. Enter the requisition number of the requisition to delete.

 3. Click Delete.

 4. If you see a message asking you to confirm the deletion, click Yes.

99Sage 300 2021 Purchase Orders User's Guide

https://cdn.na.sage.com/docs/en/customer/300erp/Sage300ERP_Documentation.htm


Purchase Orders
Enter, import, and set up security for purchase orders.

About Processing Purchase Orders   

Use the Purchase Order Entry screen to issue new purchase orders and to edit existing purchase 
orders.

When you post a purchase order, quantities on hand for the ordered items are immediately placed on 
purchase order in Inventory Control unless the purchase order is job-related.

If the purchase order is job-related, posting updates committed quantities and amounts in Project and 
Job Costing for the contract, project, and category that you specify (and does not change the quantity 
on purchase order for the inventory location).

You can enter four types of purchase orders: active, standing, future, and blanket. For more 
information, see "Purchase Order Types " (page 77).

The information you enter to add purchase orders includes:

 l Header, vendor, and purchase order detail information. For more information, see "Entering a 
Purchase Order" (page 103).

 l Optional field information (if you use Transaction Analysis and Optional Field Creator and you 
have added optional fields). For more information, see "About Optional Fields in Transactions" 
(page 80).

 l The exchange rate for converting amounts from the vendor's currency to the functional 
currency (in multicurrency ledgers only). For more information, see "About Currency Exchange 
Rates" (page 90).

Specifying Requisition Numbers on Purchase Orders

You do not have to create requisitions before entering purchase orders. If you do not use requisitions, 
you enter all the information and details on the purchase order.

If you create requisitions first, the details and most of the other information entered on the requisition 
appear automatically on the purchase order. You can also choose to include requisition details with 
no vendor number (when the purchase order vendor is assigned as the item's vendor type) in the 
purchase order. You can edit all the information from the requisition, and add or delete lines.

Selecting from More than One Requisition

You can select details from more than one requisition to create a single purchase order.
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When you post a purchase order that references a requisition, the requisition details you include are 
marked as completed on the requisition, whether you ordered the full quantity or a greater or lesser 
amount. When you post a purchase order for all the outstanding details on a requisition, the 
requisition is marked as completed and will be deleted the next time you run Day End Processing, if 
you do not keep transaction history.

Creating Purchase Orders Automatically

You can use the Copy Purchase Orders screen to enter a new PO by copying   the details from one or 
more existing purchase orders to a new order. Mo re ...

You can also automatically create new POs from purchase requisitions,   from Inventory Control 
reorder quantities, and from sales orders in the   Order Entry module.

Non-existent vendor records.   You can enter a purchase order for a vendor who is not in Accounts 
Payable, but you must add the vendor before you post an invoice, credit note, or debit note for that 
vendor in Accounts Payable.  

One-time vendors. If you frequently make one-time cash purchases, create a record for one-time 
vendors in Accounts Payable.

Posting Purchase Orders   

When you post a purchase order:

 l Item quantities on purchase order are increased in Inventory Control.

 l If the purchase order is job-related, the committed quantities and costs for the job are updated 
in Project and Job Costing.

 l If you use the automatic-numbering option, the purchase order number is assigned and 
displayed.

 l Information for the Purchase Order List is updated, so that you can print an accurate list 
immediately.

 l Purchase order lines that you set to Completed are completed.                 

Note: You cannot edit these lines after posting.

 l If you specified requisition numbers for the purchase order, requisition detail lines on the 
purchase order are completed on the requisitions.

Note: If a purchase order completes all the details on any specified requisition, the 
requisition itself is completed when the purchase order is posted.

After posting, you can print copies of the purchase order.
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Deleting Purchase Orders

If no receipts have been posted to a purchase order, you can delete the purchase order or individual 
details on the purchase order. After posting a receipt to a purchase order, you cannot delete the 
purchase order or any of its details.

To cancel a purchase order detail after posting a receipt, you cancel the outstanding quantity.

To remove a completed purchase order from your system, do one of the following:

 l If you do not keep transaction history, run Day End Processing.

 l If you keep transaction history, remove completed purchase orders using the Clear History 
screen. For more information, see "Clearing Historical Purchase Orders Data" (page 211).

About Adding Purchase Order Details   

You enter the information for each item on a purchase order as a separate detail line. There are no 
restrictions on the number of detail lines you can add to a purchase order.

When you add a detail line, the program updates the purchase order subtotal displayed at the bottom 
of the screen.

Note: You do not enter additional costs (such as shipping and handling charges) on purchase 
orders. You add those amounts when entering receipts.

Displayed information

Purchase Orders displays the following non-editable information for each detail:

 l The amount of tax that is included in the extended item cost. (Tax amounts are not displayed 
until you click the Calculate Taxes button or the Totals tab, or you post the purchase order.)

 l The net cost of items with tax included in their prices (the tax base).

 l Total allocated tax amount—the amount of tax that will be allocated to the cost of the item.

 l The quantity of each detail that has been received (this number is updated when you post 
receipts for the detail).

Tax information

You can check or edit tax distributions for a detail line on the Detail Items/Taxes screen. For each tax 
authority, you can change the item's tax class and, if permitted by the authority, specify whether tax is 
included in the item cost.

For information about calculating and editing taxes, see "About Tax Information and Amounts" (page 
83).
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About Editing Purchase Orders   

You can change information on any incomplete active or blanket purchase order, and on all future 
and standing purchase orders. You can even delete a posted purchase order, if no receipts are 
posted against it.

Multicurrency Ledgers

If you use multicurrency accounting, you can change the tax group on a transaction until you add 
details, but only to another tax group that uses the vendor's currency.

Editing Purchase Orders after Posting

After you post a purchase order, you can change everything you entered on the order except:

 l Purchase order number.

 l Vendor number.

 l Completed detail lines.

You can add detail lines to a purchase order at any time, even after posting receipts for all the 
purchase order details and completing all detail lines. You can delete detail lines for which you have 
not received any items, and you can change the outstanding amounts of partially received details.

If you change quantities or delete purchase order details, quantities on purchase order are updated in 
Inventory Control.

About Importing Purchase Orders   

You can import purchase orders that you previously exported for reuse, but you must change the PO 
numbers before you import them.

You cannot import purchase orders with numbers that you have already assigned in Purchase 
Orders, unless you have cleared the transactions with those numbers.

The original file from which you imported the information is retained until you delete it.

For detailed instructions about importing or exporting purchase orders, see the System Manager 
help.

Entering a Purchase Order

You use the P/O Purchase Order Entry screen to enter, edit, and post   purchase orders, including 
active, blanket, future, and standing purchase   orders.
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Before You Start

 l If you require requisitions   for purchase orders, add the requisitions first using the Requisition   
Entry screen.

 l Make sure you have full information for each purchase order, including vendor number, 
purchase order number (if you enter your own document numbers), requisition number (if 
required), your company's shipping and billing locations or addresses   for the purchase order, 
arrival date and type of purchase order, and the   vendor's address, contact, phone numbers, 
tax group, and terms code.

 l For each item on the order,   find out the item number, unit of measure, quantity to order, and 
location   (if you use Inventory Control). For items for which no record exists in   your system, you 
also must have turned on the Allow Non-inventory Items   option and know the general ledger 
expense account for each detail.

 l For each drop-shipment,   find out the address and customer number or inventory location (if 
applicable,   and you have Inventory Control) for the shipment.

 l If you use multicurrency   accounting, find out the rate type, rate date, and exchange rate to use   
for each purchase order.

 l If the purchase order   is job-related, get (for each item detail) the contract, project, category,   
resource (if applicable), billing type and rate, and A/R item number.

To create a new purchase order:

 1. Open Purchase Orders > P/O Transactions > Purchase Order Entry.

 2. Press the Tab key to accept  *** NEW *** in the PO Number field, and let Purchase Orders 
assign a purchase order number   when you post the purchase order.

If you do not want Purchase Orders to assign the number, type the new number in the PO 
Number field, and then press the   Tab key.

 3. In the Vendor   Number field, type the vendor number or select it from the Finder.

 4. If your   company uses templates to fill in default field entries, select the code in the Template 
field.

 5. To select one or more requisitions from which to issue the purchase   order, click the Zoom  
button beside the From Requisition field. Mo re ...

In the Create PO From Requisition screen, click the Finder to display requisition   numbers for 
the selected vendor. You may have to press the Insert key   first if you are adding a requisition to 
an existing purchase order.
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You can select a single requisition number. You can also select several   requisition numbers to 
create a purchase order that includes details entered   on the selected requisitions for the 
vendor and, if you wish, any detail   lines that do not include a vendor number.

Tip: Skip these fields if you are creating a purchase order   without referencing a requisition.

 6. If you use the Project and Job Costing module and this is a   job-related purchase order, select 
the Job Related   option. Mo re ...

If the purchase order is job-related, all items must   be for particular contracts, projects and 
categories in Project and Job   Costing. Posting the purchase order updates committed   
quantities and amounts for the jobs.

Also, you cannot add serialized items or items assigned   to lots to job-related purchase orders. 
Instead, you must order them on   a non-job-related purchase order, receive them into 
inventory, and then use the Material   Usage screen in Project and Job Costing to move them 
from inventory to jobs.

 7. Use the remaining   fields in the top part of the Order tab to enter general information for the 
purchase order. 

Note: If you want to change   the vendor account set, you can choose only from account sets 
that use   the vendor's currency.

 8. Tab into the detail entry   table (or click the table), and then enter purchase order details. (You   
may have to press the Insert key to start a new line.)

Tip: You can click the Item/Tax button   or press F9 to display a separate screen that lets you 
view and edit all the information for a single detail, including tax information.

 a. If this is a job-related   purchase order, double-click the Contract field and then type the 
contract number, or   use the Finder to select it.

You must also enter or select the project and category   to which you are allocating items. 

 b. Double-click the Item   Number field, and then enter an item number.

 c. Enter a quantity in the Quantity   Ordered field.

For information on other detail fields, see "P/O Purchase Order Entry Screen  " (page 517)

 9. Use the remaining tabs to complete the information required for the purchase order.

 l To check or edit vendor's tax group or tax classes, click the Taxes tab.

 l To add optional field information for the order, click the Optional Fields tab.
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 l To change currency exchange rates in a multicurrency system, click the Rates tab.

 l To check the totals for the order, click the Totals tab.

 10. Click Post.

After posting

You can print the purchase order   immediately after posting.

You can also print the purchase order later, using the Purchase Orders screen in  the P/O Forms 
folder.

Entering a Blanket Purchase Order

Before You Start

 l If you require requisitions   for purchase orders, add the requisitions first using the Requisition   
Entry screen.

 l Make sure you have full information for each purchase order, including vendor number, 
purchase order number (if you enter your own document numbers), requisition number (if 
required), your company's shipping and billing locations or addresses   for the purchase order, 
arrival date and type of purchase order, and the   vendor's address, contact, phone numbers, 
tax group, and terms code.

 l For each item on the order,   find out the item number, unit of measure, quantity to order, and 
location   (if you use Inventory Control). For items for which no record exists in   your system, you 
also must have turned on the Allow Non-inventory Items   option and know the general ledger 
expense account for each detail.

 l For each drop-shipment,   find out the address and customer number or inventory location (if 
applicable,   and you have Inventory Control) for the shipment.

 l If you use multicurrency   accounting, find out the rate type, rate date, and exchange rate to use   
for each purchase order.

 l If the purchase order   is job-related, get (for each item detail) the contract, project, category,   
resource (if applicable), billing type and rate, and A/R item number.

To enter a blanket purchase order:

 1. Open Purchase Orders > P/O Transactions > Purchase Order Entry.

 2. Press the Tab key to accept  *** NEW *** in the PO Number field, and let Purchase Orders 
assign a purchase order number   when you post the purchase order.
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If you do not want Purchase Orders to assign the number, type the new number in the PO 
Number field, and then press the   Tab key.

 3. In the Vendor   Number field, type the vendor number or select it from the Finder.

 4. In the      PO Type field, select Blanket.

 5. In the Original Amount      field, enter the total amount       that can be used for the blanket purchase 
order.

 6. Complete the remaining       Purchase       Order Information and Vendor Information      tabs with the 
information you need for the purchase order.

For more information, see "P/O Purchase Order Entry Screen  " (page 517).

 7. Add the details       you are ready to order from the purchase order. (You do not have to add      all the 
details at this time.)

For more information, see "About Adding Purchase Order Details   " (page 102).

 8. Add optional field entries      (if used) and other information for the purchase order. For more 
information, see "About Optional Fields in Transactions" (page 80).

 9. In multicurrency ledgers,       edit the exchange       rate information,      if necessary. 

For more information, see "About Currency Exchange Rates" (page 90).

 10. Click Post.

Entering a Future Purchase Order

Before You Start

 l If you require requisitions   for purchase orders, add the requisitions first using the Requisition   
Entry screen.

 l Make sure you have full information for each purchase order, including vendor number, 
purchase order number (if you enter your own document numbers), requisition number (if 
required), your company's shipping and billing locations or addresses   for the purchase order, 
arrival date and type of purchase order, and the   vendor's address, contact, phone numbers, 
tax group, and terms code.

 l For each item on the order,   find out the item number, unit of measure, quantity to order, and 
location   (if you use Inventory Control). For items for which no record exists in   your system, you 
also must have turned on the Allow Non-inventory Items   option and know the general ledger 
expense account for each detail.

 l For each drop-shipment,   find out the address and customer number or inventory location (if 
applicable,   and you have Inventory Control) for the shipment.
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 l If you use multicurrency   accounting, find out the rate type, rate date, and exchange rate to use   
for each purchase order.

 l If the purchase order   is job-related, get (for each item detail) the contract, project, category,   
resource (if applicable), billing type and rate, and A/R item number.

To enter a future purchase order:

 1. Open Purchase Orders > P/O Transactions > Purchase Order Entry.

 2. Press the Tab key to accept  *** NEW *** in the PO Number field, and let Purchase Orders 
assign a purchase order number   when you post the purchase order.

If you do not want Purchase Orders to assign the number, type the new number in the PO 
Number field, and then press the   Tab key.

 3. In the Vendor   Number field, type the vendor number or select it from the Finder.

 4. In the PO Date field, type the date when you   want to activate the purchase order.

 5. In the      PO Type field, select Future.

 6. Complete the remaining       Purchase       Order Information and Vendor Information      tabs with the 
information you need for the purchase order.

For more information, see "P/O Purchase Order Entry Screen  " (page 517).

 7. Add the details       you are ready to order from the purchase order. (You do not have to add      all the 
details at this time.)

For more information, see "About Adding Purchase Order Details   " (page 102).

 8. Add optional field entries      (if used) and other information for the purchase order. For more 
information, see "About Optional Fields in Transactions" (page 80).

 9. In multicurrency ledgers,       edit the exchange       rate information,      if necessary. 

For more information, see "About Currency Exchange Rates" (page 90).

 10. Click Post.

Entering a Standing Purchase Order

Before You Start

 l If you require requisitions   for purchase orders, add the requisitions first using the Requisition   
Entry screen.

 l Make sure you have full information for each purchase order, including vendor number, 
purchase order number (if you enter your own document numbers), requisition number (if 
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required), your company's shipping and billing locations or addresses   for the purchase order, 
arrival date and type of purchase order, and the   vendor's address, contact, phone numbers, 
tax group, and terms code.

 l For each item on the order,   find out the item number, unit of measure, quantity to order, and 
location   (if you use Inventory Control). For items for which no record exists in   your system, you 
also must have turned on the Allow Non-inventory Items   option and know the general ledger 
expense account for each detail.

 l For each drop-shipment,   find out the address and customer number or inventory location (if 
applicable,   and you have Inventory Control) for the shipment.

 l If you use multicurrency   accounting, find out the rate type, rate date, and exchange rate to use   
for each purchase order.

 l If the purchase order   is job-related, get (for each item detail) the contract, project, category,   
resource (if applicable), billing type and rate, and A/R item number.

To enter a standing purchase order:

 1. Open Purchase Orders > P/O Transactions > Purchase Order Entry.

 2. Press the Tab key to accept  *** NEW *** in the PO Number field, and let Purchase Orders 
assign a purchase order number   when you post the purchase order.

If you do not want Purchase Orders to assign the number, type the new number in the PO 
Number field, and then press the   Tab key.

 3. In the Vendor   Number field, type the vendor number or select it from the Finder.

 4. In the      PO Type field, select Standing.

 5. Complete the remaining       Purchase       Order Information and Vendor Information      tabs with the 
information you need for the purchase order.

For more information, see "P/O Purchase Order Entry Screen  " (page 517).

 6. Add the details       you are ready to order from the purchase order. (You do not have to add      all the 
details at this time.)

For more information, see "About Adding Purchase Order Details   " (page 102).

 7. Add optional field entries      (if used) and other information for the purchase order. For more 
information, see "About Optional Fields in Transactions" (page 80).

 8. In multicurrency ledgers,       edit the exchange       rate information,      if necessary. 

For more information, see "About Currency Exchange Rates" (page 90).

 9. Click Post.
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Creating Purchase Orders Automatically

Use the Create Purchase Orders screens to create purchase orders automatically from     current 
requisitions,     from reorder quantities     in Inventory Control, and from active sales orders    in Order Entry.

About Creating Purchase Orders Automatically

You can save time by creating purchase orders automatically from     current requisitions,     from reorder 
quantities     in Inventory Control, and from active sales orders    in Order Entry.

You can create purchase orders only for active items,     vendors, and locations (if you use Inventory 
Control). Inventory Control     must also allow the items at all locations for which they are ordered,    if you 
use that program.

When you create purchase orders automatically, the program selects Active as the purchase order     
type, posts the purchase orders, and increases quantities on purchase    order in Inventory Control.

To review and edit the purchase orders you create automatically, you use the Purchase Order Entry 
screen.

To print the new purchase orders, you use the Purchase Orders screen, available in the P/O Forms 
folder.

For step-by-step instructions on creating purchase orders automatically, see "Creating Purchase 
Orders from Requisitions" (page 120), "Creating Purchase Orders from Inventory Control Reorder 
Quantities" (page 115), and "Creating Purchase Orders from Order Entry Sales Orders" (page 117).

Assigning Dates and Purchase Order Numbers  

When     creating purchase orders automatically, the program:

 l Assigns the current session date to each purchase order.

 l Assigns the next available   purchase order number to each document, using the length, prefix, 
and   number specified for purchase orders in the Options. 

After posting, the program displays the number of purchase orders that     were created. 

Purchase Orders Created by Vendor Type

You     can create purchase orders by vendor type. The following example describes    the purchase order 
details that are created when a vendor type is specified.

Assume purchase orders will be created from the following requisition details,     and that details with 
blank vendor numbers are selected for vendors who are Vendor1 in the item records:
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Line
Number

Item
Number

Vendor
Number 

Vendor 1 in
Item Record

1 A1-103/0 Blank 1200

2 A1-400/0 Blank 1400

3 A1-401/0 Blank 1350

4 A1-650/0 1200 1500

These details would create three purchase orders, one each for vendors    1200, 1400, and 1350. 

The purchase order for vendor 1200 would include two item details because     vendor 1200 is assigned 
in the item record as the selected vendor type    for line1, and specified as the vendor number for line 4. 

Note: You     cannot mix job-related and non-job-related requisitions when creating     purchase orders. 
If you use Project and Job Costing and are creating POs    from both types of requisitions, you must 
run this function twice.

Purchase Orders for Requisitions or Vendors  on Hold  

If you create a purchase order for a vendor account that is on hold   in Accounts Payable, the purchase 
order will also be on hold. 

Purchase   orders are not created from requisitions that are on hold.

Assigning Entries for Optional Fields   

You can specify entries for any optional     fields that you use for purchase order documents and details. 
All the new purchase orders will have these    entries in their optional fields, but you can change them if 
necessary.

When     you create a purchase order from more than one requisition, the fields     on the Optional Fields 
tab are taken from the first requisition that    you select.

About Creating Purchase Orders from Requisitions

You can create purchase orders from requisitions using the Purchase Order Entry screen, or you can 
create them automatically using the Create POs From Requisitions screen.

Using the Purchase Order Entry screen, you can:

 l Specify a requisition number on a purchase order. The program then displays the information       
entered for the requisition, including detail lines that specify the vendor      number and, optionally, 
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detail lines that have no vendor number.

 l Select more than one requisition number for a single purchase order, to add details from 
different requisitions posted for the vendor (and for blank vendors, if desired) to a single 
purchase order.

 l Select item details with no vendor number when the purchase order vendor is specified as the      
vendor type in the item records.

 l Consolidate like detail lines into single lines.

For more information, see "About Processing Purchase Orders   " (page 100).

Using the Create POs From Requisitions screen, you can:

 l Create purchase orders automatically from requisitions.

 l Specify a range of requisitions, requisition dates, and vendors from which to create purchase 
orders.

 l Optionally, consolidate item details from more than one requisition into single details on 
purchase orders.

 l You can also create purchase orders from requisitions that contain detail lines without vendor 
numbers and you can specify entries for any optional fields you use.

For more information, see "About Creating Purchase Orders Automatically" (page 110).

Posting Purchase Orders Created from Requisitions

Posting assigns item costs based on the default item cost type in the P/O Options screen and the 
amount entered for the cost type in the item records in Inventory Control (if you use it).

Posting also enters the current session date as the purchase order date, and completes the selected 
requisitions. The requisitions will be deleted the next time you run Day End Processing unless you 
keep transaction history.

About Consolidating Requisition Details on Purchase Orders

You can consolidate details from separate requisitions into single details on purchase orders for the 
same vendor, item, unit of measure, and (if you use Inventory Control) inventory location. The 
program combines all related details, with the exception of details that include drop-ship addresses. A 
separate purchase order detail is created for each requisition detail with a drop-ship address.

Important! Consolidation deletes order numbers! Any order numbers entered in requisition 
details are lost if you consolidate when creating purchase orders, but you can edit the new 
purchase orders to re-enter the order numbers you   need.
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Example: 
For example, assume the following detail lines exist for a vendor on the requisitions from which you 
are creating purchase orders and you have chosen to consolidate details:

Line Item Loc. Qty. Unit Drop-
Ship

Order 
No.

1 A1-
103/0

1 10 Ea. Yes None

2 A1-
103/0

1 15 Ea. No 21234

3 A1-
103/0

1 7 Ea. No 37288

4 A1-
103/0

2 9 Ea. No None

The following details are included on the purchase orders:

Line Item Loc. Qty. Unit Drop-
Ship

Order 
No.

1 A1-
103/0

1 10 Ea. Yes None

2 A1-
103/0

1 22 Ea. No None

3 A1-
103/0

2 9 Ea. No None

Lines 2 and 3 were combined because they are identical except for the quantity and order number. 
Notice that the line now has no order number and that the quantities are combined.

Line1 was not consolidated because it contains a drop-ship address. Line4 was not consolidated 
because it is for a different location.

Note: Lines will not be consolidated if they have optional fields, and they will not be consolidated 
if the vendor item numbers are different.
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About Determining the Quantity to Order

This article describes how to use the Reorder   Quantity option to order the number of items you need. 

Example: 
Assume you are reordering an item for which the Reorder   Quantities screen (in Inventory Control) 
shows the following figures:

 l Minimum quantity = 10             

 l Projected sales = 25             

 l Maximum quantity = 30             

 l Reorder quantity = 10             

 l Quantity   on hand = -13             

You   can order up to the maximum quantity or projected sales (for the period),   or over the maximum 
quantity or projected sales, as follows: 

 l To order up to, but not   exceeding, the maximum quantity, you would order 40 stocking units   
(4 x 10), bringing the on-hand quantity to 27. (Choose the   Up To Maximum option.)             

 l To order up to at   least the maximum quantity, you would   order 50 stocking units (5 x 10) 
bringing the on-hand   quantity to 37. (Choose the Above Maximum option.)             

 l To order up to, but not exceeding, the projected sales   quantity for the number of days in the 
period (selected by the run date),   you would order 30 stocking units   (3 x 10) bringing the on-
hand quantity to 17. (Choose the   Up To Projected Sales option.)             

 l To order up to at   least the projected sales quantity for the period, you would order 40 
stocking units (4 x 10)   bringing the on-hand quantity to 27. (Choose the Above Projected   
Sales option.)             

About Ordering Items by Vendor Type

You can specify vendor types to use for an item, so that you can select an item   only if the vendor is a 
designated   vendor type in the item record. (For information on vendor types, see the help for the I/C   
Vendor Details screen, or, if you use Purchase Orders without Inventory Control, see "P/O Vendor 
Details Screen   " (page 369).)

You can select items with quantities under the minimum level or projected   sales specified for them in 
the Reorder Quantities screen, and you can order   item quantities up to or above the maximum or 
projected sales figures.
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Creating Purchase Orders from Inventory Control Reorder Quantities

If you have Sage 300 Inventory Control, you can use the Create POs      From I/C screen to create 
purchase orders from Inventory Control reorder     quantities.                 Mo re ...

You can create purchase orders for:

 l All items with less than       their maximum quantities on hand.

 l Items with quantities       below their minimum amounts.

 l Items with insufficient        quantities on hand to meet their sales targets for the number of days       you 
specify.

You create a purchase order for one vendor at a time, using an Accounts      Payable vendor number. 
You also specify the range of items and locations     for the order.

Note: The program creates a purchase order for an item and location only if      Inventory Control 
allows the item at the location and the location is     active. 

Before You Start

 l Set up or update reorder      information using the Reorder Quantities screen in Inventory Control.

 l Assign vendor types to      item records using the Vendor Details screen in Inventory Control.

 l Determine the vendors,      items, and locations for which you want to create purchase orders. 

 l Determine the run date       to use to select reorder periods from Inventory Control and to assign      to 
the purchase orders you create.

 l Determine the methods      by which to select items and quantities to order.

 l Decide what information       you need for purchase order optional fields and purchase order detail      
optional fields.

 l Choose Reorder Report       from the Stock Control Reports screen in Inventory Control to print a 
report      of the quantities you need to order. 

To create purchase orders from reorder quantities:

 1. Open Purchase Orders >       P/O Create Purchase Orders > Create POs from I/C.   

For more information, see "P/O Create POs From I/C Screen" (page 246).

 2. Enter the run      date.

You enter a run date to identify the reorder period    used to determine order quantities, and set the 
purchase order date.

115Sage 300 2021 Purchase Orders User's Guide



 3. Specify the vendor       number and the ranges of item numbers and locations for which to create      
purchase orders.

 4. Specify whether to create POs for      a specific location or for all locations.

 5. Select the vendor types      to include. Mo re ...

Use this option to create POs only if a vendor is listed    as Vendor 1, or Vendor 2, and so on, for 
an inventory item. 

Items in the range you specified are selected if the     vendor number for which you are creating a 
purchase order is one of the selected vendor types in the vendor details record.

 6. Select the method      for determining which item numbers to order. Mo re ...

 l All      Items. Select this option to order all selected items that are below their       maximum 
quantities in Inventory Control.

 l Items      Below Minimum. Select this option to order selected items if their quantities on 
hand       are below the minimum quantities entered for them in the Reorder Quantities       form 
in Inventory Control.

 l Items      Below Projected Sales for [ ] Days. Select this option to order items for which 
quantities on hand will       be below the period's projected sales for the number of days you 
type. 

Note: The run date you specify sets the beginning date of the number of days       you specify.

 7. Select the method for      determining item quantities. Mo re ...

 l Up      to Maximum. Select this option to order the quantity of each item that will bring       the 
quantity on hand for the item up to or close to, but not over, the       maximum amount 
specified in the Reorder Quantities screen.

 l Above      Maximum. Select this option to order the item quantity that will bring the quantity       
on hand for each item up to at least the maximum amount specified for       the item in the 
Reorder Quantities screen.

Note: This choice can result in quantities       that are higher than the maximum amount.

 l Up      to Projected Sales for [ ] Days. Select this option to order the item quantity that will 
bring each item's       quantity on hand up to or close to, but not over, the projected sales       
quantity for the number of days you specify, beginning on the run date.

 l Above      Projected Sales for [ ] Days. Select this option to order the item quantity that will 
increase the       quantity on hand for each item to more than the number of units specified       as 
the projected sales of the item over the number of days you specify,       beginning on the run 
date.
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 8. Click the Optional       Fields tab (if you use optional fields on the purchase orders screen), and      
specify entries for the optional fields that appear on the purchase orders.

 9. Click the Detail Optional       Fields tab (if you use optional fields with purchase order details), and      
specify entries for the optional fields that appear on detail lines.

 10. Click the Process button      to create the purchase orders.

The program creates a purchase order for each vendor    in the ranges you specified.

When the purchase orders have been posted, you see    a message that lists the range of purchase 
order numbers that were assigned.

Note:  If     vendor accounts are on hold, the purchase orders will be created, but    the POs will be On 
Hold.

After creating purchase orders

 l Print a detailed Transaction   List for the purchase orders you created, choosing Transaction 
List from   the Analytical Reports folder.

 l Make any changes you need   to the purchase orders, using the Purchase Order Entry screen, 
then post   the purchase orders and print copies of them. 

 l Print a new copy of the   Reorder report in Inventory Control to find out whether you ordered all   
the items you need.

Creating Purchase Orders from Order Entry Sales Orders

If you have Sage 300 Order Entry, you can create purchase orders for all items on current       active 
Order Entry sales orders, or only for backordered items       or items with insufficient inventory quantities 
on hand to fill the orders. Mo re ...
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Note: 
You cannot create purchase orders from future or standing sales orders     or from orders that are on 
hold in Order Entry. 

You can create purchase orders from Order Entry by ranges of customer      numbers, order numbers, 
order dates, and expected ship dates. You can      also consolidate purchase orders by vendor 
number or create a purchase     order for each vendor listed on each order.

If you create purchase      orders by vendor number, all orders for the same item, location,      and vendor 
are consolidated into a single detail on the purchase order     for the vendor.

If you create purchase      orders by sales order, you produce a separate purchase order for      each 
vendor specified on the selected orders, resulting in more than one      purchase order for vendors 
specified on more than one order. This option      retains order numbers and lets you print the 
Shippable Backorders report     for the transactions you post for Order Entry orders.

If you want to create        purchase orders by sales order, you can still select the Consolidate Items        
option to consolidate like details for vendors. Consolidated purchase        orders are shorter. Use the 
option if you do not print the Shippable Backorders       report by order number. (Consolidation deletes 
order numbers.)

Before You Start

 l Assign vendor types to      item records in Inventory Control.

 l Determine the customers,       orders, dates, and vendor types for which you want to create 
purchase      orders.

To create purchase orders from Order Entry sales orders:

 1. Open Purchase Orders >       P/O Create Purchase Orders > Create POs from O/E.   

For more information, see "P/O Create POs From O/E Screen" (page 250).

 2. Use the From and To fields to specify ranges       of customers, orders, order dates, and expected 
ship dates by which to      select the purchase orders to create.

 3. Select the I/C vendor type.

 4. For the Create Purchase Order for Each option, specify whether to:

 l Create       only one purchase order for       each vendor (select Vendor). Mo re ...

If     you create purchase orders by vendor number, all orders for the     same item, location, 
and vendor are consolidated into a single detail    on the purchase order for the vendor.
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 l Create a separate purchase order for each order number      and each vendor listed on the 
order (select Order). Mo re ...

If     you create purchase orders by sales order, you produce a separate     purchase order for 
each vendor specified on the selected orders, resulting     in more than one purchase order 
for vendors specified on more than one     order. This option retains order numbers and lets 
you print the Shippable    Backorders report for the transactions you post for Order Entry 
orders.

 5. For the Include option, specify whether       to order all items on the selected orders, or only items 
for which you      have insufficient quantities on hand, or only items that are on backorder.

 6. To include drop-ship addresses entered for items and customers on the       Order Entry orders, 
select Drop-Ship Items.  Mo re ...

If you use the Drop-Ship Items option, every purchase     order detail is assigned either the 
address entered on the sales order    or the customer's address in Accounts Receivable.

Note: If you select this option, you cannot consolidate      details.

 7. To consolidate       details on the purchase orders with the same item number, location, and      unit of 
measure into single details on purchase orders, select Consolidate Items. 

Note: This option is not available if any optional fields or detail    optional fields are assigned to 
this screen.

 8. To include      non-stock items on the purchase order, select Include Non-Stock Items. 

Note: This option    appears only if you allow receipt of non-stock items in Inventory Control.

If you do not select this option, non-stock items are omitted from the Finder and treated as non-
inventory items. 

 9. If you use optional fields with purchase orders (at the document level), click the Optional 
Fields       tab, and then specify      entries for the optional fields.

 10. If you use optional fields with purchase order details, click the Detail Optional       Fields tab, and      
then specify entries for the optional fields that appear on detail lines.

 11. Click the Process button      to create the purchase orders.

After creating purchase orders

 l Print a detailed Transaction   List for the purchase orders you created, choosing Transaction 
List from   the Analytical Reports folder. 
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 l Make any changes you need   to the purchase orders, using the Purchase Order Entry screen. 

 l Print copies of the purchase   orders for your records and to mail to vendors.

Creating Purchase Orders from Requisitions

You can create purchase orders for requisition details that do not have   vendor numbers, assigning 
the vendors either by creating purchase orders   for only one vendor number or by selecting a vendor 
type used with items   in Inventory Control. Mo re ...

Purchase Orders does not create POs from requisitions that are on hold.

If you use Purchase Order's   requisition approval system, requisitions must be entered   or saved by 
users who are authorized to approve POs before they can be   added to purchase orders.

Before You Start

 l Use the Requisition Entry      screen to create or import requisitions.

 l Determine the requisitions,      vendors, and dates for which you want to create purchase orders.

 l If you are using Project      and Job Costing, choose ether job-related or non-job-related 
requisitions.

In Accounts Payable:

 l Add any new vendor       numbers used in requisitions for which you want to create purchase 
orders.       (The program cannot create purchase orders for vendor numbers that are      not defined 
in Accounts Payable.)

 l Make sure the vendor       numbers you want to use are all active. You cannot create purchase 
orders      for inactive vendors.

In Inventory Control,      make sure that:

 l All items you are      ordering for a location are allowed at the location.

 l You specified only       active items and locations on the requisitions for which to create purchase      
orders.

 l Choose Transaction List       from the Analytical Reports folder. For more information, see "P/O 
Transaction List Report Screen" (page 297).

 l Then print a detailed list of the       requisitions from which you are ready to create purchase 
orders. Make       any changes you need to the requisitions, using the Requisition Entry      screen.

To create purchase orders:

 1. Open Purchase Orders >       P/O Create Purchase Orders > Create POs from Requisitions.   

For more information, see "P/O Create POs From Requisitions Screen" (page 254).
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 2. Use the From and To fields to specify ranges   of requisition numbers, dates, and vendors for 
which to create purchase   orders.

 3. Select   options, as follows:

 l Select Consolidate Items to consolidate details from separate requisitions into single 
details   on purchase orders for the same vendor, item, unit of measure, and (if   you use 
Inventory Control) inventory location. Mo re ...

The program combines all related details, with the exception of details   that include drop-
ship addresses. A separate purchase order detail is   created for each requisition detail 
with a drop-ship address.

 l If you select Include Blank Vendors, you must specify the vendor type for which   to 
create the purchase orders.

Example: You can have all requisitions with blank vendors   use the vendor that is listed 
as Vendor 1 in the items' vendor details   records (in Inventory Control).

 l if you   use Project and Job Costing, select Job   Related to create job-related purchase 
orders.

Note: You cannot mix job-related and non-job-related requisitions when creating   
purchase orders. If you use Project and Job Costing and you are creating POs   from 
both types of requisitions, you must run this function twice.

 4. If optional fields are assigned to purchase order (at the document level), click the Optional 
Fields   tab, and then specify   entries for the optional fields that appear on purchase orders.              Mo re ...

If you use the same fields on requisitions and purchase   orders, the optional field entries on the 
requisition detail lines   appear defaults on purchase orders, unless you specify different entries 
here.

When you create a purchase order from more than one   requisition, the fields on the Optional 
Fields tab are taken from   the first requisition that you select.

 5. if you use optional fields with purchase order details, click the Detail Optional   Fields tab, and 
then   specify entries for the detail optional fields.

 6. Click Process to create   the purchase orders.

Purchase Orders creates   a purchase order for each vendor for whom details were entered on 
requisitions   in the ranges you specified.

When the purchase   orders have been posted, you see a message that lists the range of 
purchase   order numbers that were assigned.
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After creating purchase orders

 l Print a detailed Transaction   List for the purchase orders you created, choosing Transaction 
List from   the Analytical Reports folder.

 l Make any changes you need   to the purchase orders, using the Purchase Order Entry screen.

 l Print copies of the purchase   orders you need to mail to vendors and to file with your records.

Copying Purchase Orders

You can use the Copy Purchase Order screen to create new purchase orders based on existing 
purchase orders. Mo re ...

The details from the existing POs, including item numbers, quantities ordered, costs, and other 
information, appear as defaults for the new purchase order.

You can select the details that you want to copy to the new purchase order, and you can change the 
location, expected arrival date, whether items are drop-shipped, the quantity ordered, cost, unit of 
measure, unit weight, and optional fields for any detail lines.

To create a new purchase order from one or more existing POs:

 1. Open Purchase Orders > P/O Transactions > Copy Purchase Orders.

 2. In the From Vendor Number field, type the code for the vendor whose purchase order details 
you want to copy for the new PO.

 3. In the To Vendor Number field, type the code for the vendor for whom you are creating the 
new purchase order, or use the Finder or the navigation buttons to select   it.

 4. In the From PO Number and To PO Number fields, specify the range of existing orders (for 
the From Vendor)   to use as the basis for the new purchase order.

 5. The tax group for the To Vendor appears as the default in the Tax Group field, but you can 
change it.

 6. In the PO Type field, select the type of purchase order to copy.

 7. If you are copying job-related purchase orders, select the Job Related option.

 8. If you want to copy costs from the original purchase orders to the new purchase order, select 
the Use PO Cost option. (This choice is available only if both vendors use the same currency, 
and you use Project and Job Costing.)

 9. Click the Go  button to add the details from the existing purchase orders to the new order.

 10. In the PO Number field, type a purchase order number or accept the ***New*** entry to let the 
program assign the next number in the purchase order number sequence.
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 11. In the PO Date field, enter the date for the purchase order. The program displays the session 
date as the default PO date.

 12. If you need to put the new purchase order on hold, select the On Hold option.

 13. Enter a description and a reference for the PO.

 14. Use the detail table on the Copy POs tab to edit the details as you require.

To delete a detail line, select it on the table, and then press the Delete key.

 15. When you have finished editing information for the purchase order, click the Create button to 
generate the PO.

You can then view, edit, and post the order using the Purchase Order   Entry screen.
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Receipts
Enter, import, export, and set up security for receipts to record items you enter into inventory.

About Processing Receipts

Use the Receipt Entry screen to receive items into inventory. For more information, see "P/O Receipt 
Entry Screen" (page 561).

You can enter receipts with or without purchase order numbers. If you use a purchase order number 
on a receipt, the purchase order information is displayed.

If you need to edit a receipt you created from a purchase order, you can change the vendor and 
header information (except for the template and tax group codes), delete item details, and add 
additional cost details, but you cannot add item details. When editing a posted receipt, you cannot 
delete detail lines but you can add additional cost details.

Note: You cannot view or edit costs unless you are assigned the security right to "Show Receipt 
Costing Information."

Use the Return Entry screen to return items to suppliers. For more information, see "About 
Processing Returns" (page 155).

Effects on Inventory Control

When you post a receipt in Purchase Orders, item quantities on hand are increased in Inventory 
Control for the received items.

If you post the receipt with a purchase order number, quantities on purchase order are reduced in 
Inventory Control, and the purchase order's received quantities and outstanding quantities are 
updated on the purchase order.

You can process receipts either in Purchase Orders or Inventory Control. However, we recommend 
that you enter all receipts in Purchase Orders because Purchase Orders' Receipt Entry screen allows 
you to fully track and prorate additional costs, and record more information for each receipt than you 
can record in Inventory Control.

When you enter receipts with existing purchase order numbers in Purchase Orders, the purchase 
orders are updated. They are not updated by receipts you enter in Inventory Control.

If you enter or change additional costs on invoices in Purchase Orders, you can also prorate the new 
costs to the corresponding receipts.
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For more information about processing receipts in Inventory Control, see "About Using Purchase 
Orders With Inventory Control   " (page 36).

About Entering Receipts

This topic describes the information you enter     for receipts and receipt adjustments on the Receipt 
Entry screen. For more information, see "P/O Receipt Entry Screen" (page 561).

Setup Records Required to Process Receipts

Before processing receipts, you need to set up the following Purchase   Orders records:

 l Additional cost codes

 l Optional fields (if you use them)

 l Ship-via codes

 l Templates

You need to select the following options for receipts on the P/O Options screen:

 l Edit or verify the lengths, prefixes, and numbers you want the program to assign to receipts, if 
you want the numbers assigned automatically.

 l Select the options to use when processing receipts.

 l Select a default template code (optional).

Also, set up related records in other Sage 300 programs:

 l Terms codes in Accounts Payable.

 l Vendor records in Accounts Payable.

 l Optional fields in Inventory Control, Accounts Payable, and General Ledger

 l Tax records in Common Services.

 l Currency records (multicurrency ledgers) in Common Services.

 l Item, price list, location, account set, and category records in Inventory Control.

 l Contacts in Project and Job Costing.

Specifying Vendors and Purchase Orders

You can enter receipts for vendor numbers that exist in your Accounts Payable data and for new 
vendors. You can add a vendor to Accounts Payable from the Receipt Entry screen.

You can also apply receipts to existing purchase orders, or you can enter a receipt that doesn't 
reference a purchase order.
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Entering Details for Job-Related Receipts

If the receipt is for a project you are managing with Project and Job Costing, different fields appear for 
the details to let you enter job-related information. If the retainage option is selected in Accounts 
Payable, you can choose retainage accounting for the receipt.

Note: If the receipt is being created from multiple purchase orders, all purchase orders must be 
either job-related or non-job-related.

Specifying Item and Cost Details

You can enter individual item receipts and additional costs (such as shipping     charges) as separate 
details, and you can edit tax information for each    detail and cost, and for the vendor.

You can enter additional cost details for the primary     vendor (the vendor from whom you received the 
goods) or for secondary vendors (vendors who charged costs on the shipment but did not supply the 
goods). 

If necessary, you can assign a different vendor and tax group to each additional cost detail. In 
multicurrency ledgers, you enter all details in the primary vendor's currency.

During receipt entry, you can look up purchasing history by vendor or item number. You can also print 
receipts after posting them using the standard form for receiving slips supplied with Purchase Orders, 
or using forms you design.

Note: You must use the option Allow Receipt of Non-Stock Items in Inventory Control to enter 
receipt transactions for non-stock items.

Posting Receipts

When you post a receipt in Purchase Orders, item quantities on purchase order are reduced and 
quantities on hand are increased in Inventory Control.

If the receipt is job-related, Purchase Orders also updates the actual and committed quantities and 
costs for the job in Project and Job Costing.

If you specified a purchase order number on a receipt, posting enters or updates outstanding and 
received quantities on detail lines in the purchase order, and completes purchase order detail lines 
that have been fully received or canceled. Posting also deletes purchase order details for which no 
quantity was received on the receipt, so that they do not appear on the receipt if you select it for 
editing after you have posted it. You should make sure you have entered all the received quantities 
you want to include on a receipt before you post it.

After posting a receipt, you cannot change additional cost information (except for the amounts) and 
you cannot delete detail lines—although you can change the quantity received and cost amounts, and 
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you can add additional costs for the primary vendor on the invoice. In multicurrency ledgers, you 
cannot edit exchange rates.

Editing Receipts   

After posting a receipt, you can no longer change the purchase order numbers, template code, or tax 
group, and you cannot delete any item or additional cost details that were posted with the receipt. You 
can add new additional cost details and, if the receipt does not reference a purchase order number, 
you can add item details. In multicurrency ledgers, you cannot edit exchange rates.

If you change receipt quantities, quantities on hand are updated in Inventory Control.

Job-related changes to receipt quantities will change the committed and actual quantities and costs in 
Project and Job Costing.

If you edit an existing receipt that was created from a purchase order, you see only the detail lines 
(from the purchase order) that have a received quantity or have a non-zero amount (other than the 
received quantity), such as a manual proration or a canceled quantity.

You cannot change the proration or reproration method you assign to any additional cost after you 
post the receipt. If you need to change the method, either on the receipt or for a return, you post the 
change as an adjustment in Inventory Control.

Note: Once you have posted an invoice for the primary vendor, all the vendor's details are 
complete and you cannot edit them. When you have posted invoices for all the vendors on a 
receipt, the receipt is complete and can no longer be changed.

Invoicing Receipts

You can     post invoices for receipts from the Receipt Entry screen, invoicing the     items received and 
additional costs charged by the primary vendor (the     receipt vendor), as well as additional costs 
charged on receipts by other     vendors (secondary vendors). 

You can also use the Invoice Entry screen to    post invoices. 

Entering 1099 Codes and Remit-to Locations

You can enter 1099 codes and remit-to locations     in Invoice Entry or in Accounts Payable. 

Important! If you     need to record 1099 codes and amounts or remit-to locations, you must     enter 
invoices in the Invoice Entry screen, or edit Purchase Orders invoices    in Accounts Payable to add 
the codes and 1099 amounts.
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Assigning Serial Numbers and Lot Numbers

If you also use Serialized Inventory and Lot Tracking, you can assign serial numbers    to items after 
inserting an amount in the Quantity field. For more information, see "Receiving and Invoicing 
Serialized Items   " (page 187).

About Importing Receipts

Use the Import command on the File menu in the Receipt Entry screen to transfer receipts created in 
non-Sage 300 applications (or in another Purchase Orders database at a different location) to 
Purchase Orders.

Purchase Orders posts imported receipts and returns as they are imported, but does not delete the 
original file of transactions. To avoid importing the same transactions twice, you should delete the file 
when you are finished.

You must make sure that the receipts and returns for importing use unique document numbers. You 
cannot import a transaction that uses a document number you have posted and not cleared in 
Purchase Orders. You can also import additional costs only for the primary vendor.

Multicurrency ledgers

You cannot import multicurrency transactions into a single-currency ledger. Edit import files to 
remove multicurrency fields before importing.

Guidelines for importing

If the file does not contain valid data, Purchase Orders will not import it. For an example of valid data, 
export receipts using the fields you plan to import later and use this as a guide.

The import file you specify must be located on the drive and in the directory that you select. If you are 
on a network, you must have access rights to the import file and the directory.

For detailed instructions about importing receipts, see the System Manager help.

After importing

 l Check data integrity.

 l Run Day End Processing to create journal entries from the imported data.

 l Print the posting journal for the type of transaction imported and use it to check the posted 
details and the general ledger distributions generated from Purchase Orders transactions.

 l Unless you need to use it again, delete the file from which you imported the transactions.
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About Exporting Receipts

Use the Export command on the File menu in the Receipt Entry screen to transfer transactions 
created in Purchase Orders to either of the following:

 l Non-Sage 300 applications.

 l A file to be edited and imported later.

Before exporting, decide which fields to include in the export file. You must select fields for each type 
of record used for the selected transaction type. You should also determine the path for the export file 
you want to use or create.

When you choose Export, Purchase Orders exports all the transactions of the selected type currently 
in the system. If you do not want to export everything, use the Set Criteria option to specify the 
documents to export.

About Entering Additional Costs on Receipts

When entering a receipt, you can add additional costs charged on the shipment, such as handling 
charges, service charges, and duty. You can include additional costs charged by the primary vendor, 
and you can include costs charged by other vendors.

You enter additional cost details by vendor on the Additional Costs tab of the Receipt Entry screen. 
You can add as many cost details as you need for the primary vendor and secondary vendors.

You can expense these costs or prorate them to received items. You can also edit additional-cost 
amounts on previously posted receipts that are not yet fully invoiced. 

Note: If you return items, later, you can specify how to reallocate costs that were prorated to the 
returned items on the receipt.

You can post an invoice for each vendor's costs from the Receipt Entry screen, or you can enter the 
invoices in Invoice Entry.

Proration of Additional Costs

For each additional cost, you can choose from five proration methods. You can choose to expense 
the cost (No Proration), or you can prorate it by item cost, quantity, or weight. You can also choose to 
prorate the cost manually.

Note: You cannot change the proration method after you post the receipt.

For examples and information about how costs are prorated, see "About Calculating Prorated 
Additional Costs" (page 133).    
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If you do not prorate an additional cost, you expense it to the general ledger account you assigned to 
the additional cost record or to another account you specify when entering the additional cost 
transaction.    

If you want to prorate or expense a job-related cost to several jobs, you must have a receipt detail for 
each of the jobs to which you want to apportion costs.

You can also specify retainage for job-related costs.

No Proration for Non-inventory Items

When entering additional costs for non-inventory items, you must     select No Proration. If you try to 
prorate by quantity, cost, or weight,     the program displays an error message and prevents you from 
posting    the receipt.

Reporting Prorated Amounts

The Receipts Posting Journal lists the additional cost amounts prorated     to each item on a receipt. Use 
the journal to check the amounts that were     prorated automatically during posting or Day End 
Processing, and to check    the amounts you prorated manually.

Tax on Additional Cost Amounts

The tax information for each additional cost detail is determined by     the vendor's tax group. For each 
detail, you can change the tax class     and specify whether tax is included in the cost amount (if allowed 
by    the tax authority).

You can also check the tax amount for the detail and the allocated,    recoverable, and expensed tax 
amounts. For more information, see "About Tax Information and Amounts" (page 83).

About Specifying Vendors for Additional Costs

To add information about additional costs on a receipt, you specify the vendor who charged the cost 
before entering the costs charged by each vendor.

You specify the following vendor information on the Additional Cost tab on the Receipt Entry screen:

 l Vendor number and name (the code and name of the vendor who charged you the cost). Mo re ...

You can enter an existing vendor number or a new vendor number that you have not yet added to 
Accounts Payable. You can also enter a new vendor's name in Purchase Orders and add the 
vendor to Accounts Payable from the Additional Costs tab in the Receipt Entry screen.
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If you are adding a cost for a vendor who is not the primary vendor, you can edit the vendor's 
address, phone and fax numbers, and contact on a separate zoomed screen you open from the 
Additional Costs tab. You can also edit the information for an existing vendor number.

When you enter a valid vendor number, the program displays the vendor's tax group and terms. 

Note: In multicurrency ledgers, the program also displays   exchange rate information for the 
vendor's currency.

 l Tax group (the tax authorities, classes, and       related tax information that apply to the cost). In 
multicurrency ledgers,       the tax group you select identifies the currency in which the additional      
cost was charged.Mo re ...

A tax group is displayed if you use an Accounts Payable vendor number,   but you can change it, 
provided the vendor for the cost is not the primary   vendor (from whom you received the goods). You 
specify the tax group for   a new vendor you have not yet added to Accounts Payable.

 l Terms code.Mo re ...

Use the Terms Code field to add or change the code that identifies the payment terms the vendor 
allows your company.

To change a terms code, type the new code or select the code from the   Finder. You must enter a 
terms code for each vendor and you must use one   of the terms codes you have defined in Accounts 
Payable.

You can also edit dates, payment, and discount information on the Terms   tab.

Note: In multicurrency ledgers, you can enter the rate type, rate date, and     exchange rate for each 
secondary vendor. You use the Rate Information     tab to edit currency rate information for a primary 
vendor who does not    use functional currency.

Displayed Information 

The program displays the subtotal, tax included, and total amounts of    the additional costs you enter 
for each vendor.

For more information, see "P/O Receipt Entry Screen" (page 561).

About Prorating Additional Costs on Receipts 

You can choose from five proration methods   for each additional cost, as follows:

 l No Proration. If you do not prorate an      additional cost, you expense it to a general ledger 
account instead. 
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Note: 
When entering additional costs for non-inventory items, you must     select No Proration. If you 
try to prorate by quantity, cost, or weight,     the program displays an error message and 
prevents you from posting    the receipt.

 l Prorate by Cost.

 l Prorate by Quantity.

 l Prorate by Weight.

 l Prorate Manually.

You cannot change the proration method after you post a receipt. 

For examples and information about how costs are prorated, see "About Calculating Prorated 
Additional Costs" (page 133). 

Expensing Additional Costs

If you do not prorate an additional cost, you expense   it to the general ledger account you assigned to 
the additional cost record   or to another account you specify when entering the additional cost 
transaction.

Prorating Job-Related Additional Costs

If you want to allocate an additional cost to several jobs, you need to   add a detail line for each job.

Returns and Adjustments

When you   return items to which costs were prorated, you specify the reproration method. If you used 
an additional cost code on the receipt, the program displays the reproration   method specified in the 
additional cost record, but you can select another method   for the detail. 

You can choose to leave the cost as originally prorated, reprorate it   using the original proration 
method, or expense it to the general ledger   account you specify. You can select:

 l Prorate—to allocate the returned additional   cost amount over the remaining goods on the 
receipt using the original   proration method.

 l Leave—if you do not want to reprorate the additional cost to the remaining   goods on the receipt.

Tip: You can also use the Adjustments screen in Inventory   Control to write off the additional 
cost to a general ledger write-off   account, rather than add it to other item costs. 
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 l Expense—to debit a general ledger expense account   for the returned portion of the additional 
cost amount. Enter the general   ledger account number to which the expensed amount is 
posted.

Note: You cannot change the proration or reproration method   after you post the return.

Editing Tax Distributions

The tax information for each additional cost detail is determined by   the vendor's tax group. For each 
detail, you can change the tax class   and specify whether tax is included in the cost amount (if allowed 
by   the tax authority).

You can also check the tax amount for the detail and the allocated,   recoverable, and expensed tax 
amounts. For more information, see "About Tax Information and Amounts" (page 83).

Reporting Prorated Amounts

The Receipts Posting Journal lists the additional cost amounts prorated   to each item on a receipt. Use 
the journal to check the amounts that were   prorated automatically during posting or Day End 
Processing, and to check   the amounts you prorated manually.

About Calculating Prorated Additional Costs

You can prorate additional costs to items on a receipt either automatically or manually.

 l If you prorate automatically, the extra cost amounts do not appear as part of the item detail 
costs in the Receipt Entry screen, although they are reported on the posting journal for each 
transaction.

 l If you prorate manually, you click the Distribute Proration zoom button, and enter the prorated 
cost amounts in the Distribute Proration screen.

Prorating Automatically

Additional costs you choose to prorate automatically are apportioned across all items on a receipt 
during posting or Day End Processing, based on each detail's total quantity received, total weight, or 
extended cost, as a percentage of the receipt's total quantity, weight, or cost, respectively.

You can prorate by:

 l Quantity. If you prorate by quantity, prorated amounts are calculated based on the quantity 
specified for each detail. For example, you would prorate a handling cost by quantity if the cost 
depended on the number of items shipped.
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The program does not convert units to stocking units. If you enter two detail lines for the same item 
number and specify ten stocking units for the first detail and ten boxes (of ten stocking units each) 
for the second detail, the same additional cost amount will be prorated to both details.

You cannot prorate costs for non-inventory items. You must choose No Proration.

 l Weight. If you prorate by weight, prorated amounts are calculated based on the weight 
specified for each detail. You would choose this proration method for a freight charge that was 
determined by the weight of the shipment.

 l If you do not enter a weight amount for a detail, no additional cost amount will be calculated 
for it.

 l If no weight is specified for any of the item details, the additional cost amount is prorated 
evenly to all item details on the receipt.

Note:  The calculation is by total weight after conversion to the default weight unit of measure. 
Note also that you cannot prorate costs for non-inventory items. You must choose No Proration.

 l Cost. For more information, see "About Prorating by Cost" (page 141).

About Manually Prorated Amounts

You can post a receipt only when the you have completely allocated     any additional costs you selected 
for manual proration, plus their associated    tax amounts.

Tip: Check the Totals tab to see whether you entered all manual proration    amounts. 

You can manually prorate additional costs only to item details, including     non-stock items, that have 
valid inventory item numbers. You cannot manually    prorate costs to non-inventory items.

In multicurrency ledgers, you can manually prorate additional costs    only for vendors who use the 
functional currency.

Note: For a job-related receipt, you can prorate additional costs to different     contracts, projects, and 
categories. However, if you want to     allocate an additional cost to several jobs, you need to add a 
receipt    detail line for each job.

Entering Receipts

You use the Receipt Entry screen to record the receipt of both   inventory and non-inventory items in 
Purchase Orders. When you receive items, you can also post an invoice for the primary vendor and 
for any secondary vendors for which you record additional costs on the receipt. Mo re ...

While entering receipts, you can also:
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 l Edit details on an existing receipt if you have not posted an invoice for the vendor and receipt. A   
receipt is complete when you have posted invoices for all vendors on the receipt. You cannot 
change a completed receipt.

 l Enter or change the vendor address information.

 l Enter additional costs for receipts (from primary or secondary vendors).

 l Invoice receipts and additional costs.

 l Identify items as fixed assets for management by Sage Fixed Assets.

 l Specify drop-ship addresses for receipt details.

 l Check and edit tax distributions by detail line and for the primary and secondary vendors.

 l Assign serial numbers to serialized items (if you use Serialized Inventory and Lot Tracking).

 l Assign lot numbers to lotted items (if you use Serialized Inventory and Lot Tracking).

For more information, see "About Entering Receipts" (page 125).

Before You Start

 l Make sure you have complete information about the received shipment, including bills of 
lading and information about additional costs that pertain to this receipt.

 l If you use multicurrency accounting, find out the rate type, rate date, and exchange rate to use   
for this receipt.

 l If the receipt is job-related, make sure you know the contract, project, category,   resource (if 
applicable), billing type and rate, and A/R item number to charge for each item detail.

To enter a receipt:

 1. Open Purchase Orders > P/O Transactions > Receipt Entry.

For more information, see "P/O Receipt Entry Screen" (page 561).

 2. Press the Tab key to accept   *** NEW *** in the Receipt Number field, and let Purchase Orders 
assign a receipt number   when you post the document.      

If you do not want Purchase Orders to assign the number   automatically, you can type the new 
number yourself, and then press the   Tab key.

 3. In the Vendor Number field, type the vendor   number or select it from the Finder.      

Tip: You  can skip this field, and then select the PO number. However, you must enter the 
vendor number first   if you are receiving goods from several purchase orders

 4. If you are receiving goods from one purchase order, in the PO Number   field, enter or select 
the purchase order number.      
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To select several purchase orders from which to create   the receipt, click the Zoom  button 

beside the From Multiple POs  field. Mo re ...

In the Create PO From PO screen, click the Finder to display purchase order  numbers for the 
selected vendor. You may have to press the Insert key first if you are adding a purchase order 
to an existing receipt.

You can select a single purchase order. You can also select several   purchase order numbers 
to create a receipt that includes details entered on the selected purchase orders for the vendor.

Tip: Skip these fields if you are creating a receipt   without referencing a purchase order.

 5. If this is a job-related receipt and you did not specify a purchase order number, select the Job 
Related option. (If you selected a job-related purchase order,   the job-related option is selected 
automatically.)

Note: You   cannot mix job-related and non-job-related purchase orders on a receipt.

 6. Use the remaining fields in the top part of the Receipt tab to enter general information for the 
receipt.      Mo re ...

 l The posting date is the date for transactions being posted to the General Ledger, so it 
also determines the contents of the Fiscal Year and Period fields. The date   applies also 
to the invoice.

 l If you use Inventory Control, select a location code to which bills for the receipt will be 

sent. You can also use the Zoom  button to edit the address.

 l If you want to change   the vendor account set, you can only choose from account sets that 
use   the vendor's currency.

 7. Tab into the detail entry table (or click the table), and then enter receipt details. (You   may have 
to press the Insert key to start a new line.) Mo re ...

To receive all goods on purchase orders, click the Receive All button.

To partially   receive goods on purchase order, enter the quantity received for each item in the 
detail section. You can also delete lines that are not being received, although you do not need 
to delete lines if the amount received is "0".

You can change other information, including item descriptions, item costs (if you have 
appropriate security authorizations), discount amounts, item weights, quantity canceled and 
outstanding, number of item labels required, arrival date, comments, and optional fields.

Note: You cannot add detail lines if you are receiving specific purchase orders.
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Tip: You can click the Item/Tax button   or press F9 to display a separate screen that lets you 
view and edit all the information for a single detail, including tax information.

For information on   detail fields, see "P/O Receipt Entry Screen" (page 561).

 8. Use the remaining tabs to complete the information required for the receipt.

 l To check or edit vendor's tax group or tax classes, click the Taxes tab.

 l To add optional field information for the receipt, click the Optional Fields tab.

 l To change currency exchange rates in a multicurrency system, click the Rates tab.

 l To check the totals for the receipt, click the Totals tab.

 9. Click Post.

After posting

You can print the receipt   immediately after posting.

You can also print the receipt later, using the Receipts screen in  the P/O Forms folder.

Creating a Receipt from Multiple Purchase Orders

You can use the P/O Create Receipt From PO screen to select purchase orders you are receiving 
from the vendor.

To create a receipt from multiple purchase oders:

 1. Open Purchase Orders > P/O Transactions > Receipt Entry.

 2. Select From Multiple   POs, then either click the Zoom  button beside the field or press the 
F9 key to open the Create Receipt From PO screen.

 3. Use the Finder to select incomplete purchase orders for the vendor.   

Note: All purchase orders must have the same tax group. 

 4. When you have finished entering purchase orders, click Receive.

Tips: 
 l If you enter an incorrect purchase order number, highlight it and press the Delete key. 

 l To delete all the purchase order numbers or to cancel   all the numbers press Close 
without pressing Receive.

 5. Press Close to return to the Receipt Entry screen.
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    Creating Invoices From a Receipt Using the P/O Receipt Entry Screen

You can use the Invoices button on the Receipt Entry screen to create invoices for the primary 
vendor and any secondary vendors on a receipt. Mo re ...

Invoices are created during posting. You can post only one invoice for each vendor on the receipt, 
and the invoice includes all charges entered for the vendor on the receipt.

Important! After posting, you cannot change information in the Invoice Entry screen or on the 
receipt for item and additional costs you have invoiced.

Before You Start

 l Open the P/O Receipt Entry screen, and display the receipt you are going to invoice:

 1. Open Purchase Orders > P/O Transactions > Receipt Entry.

 2. Enter header information for the receipt, including the vendor number and, if you are 
receiving an existing purchase order, specify the purchase order number (or numbers if 
you are receiving multiple purchase orders).

 3. Use the Details table to receive items on the purchase order, or click Receive All to 
receive all the items.

To create invoices for the primary and secondary vendors:

 1. With the receipt displayed in the P/O Receipt Entry screen, click the Invoice button.

 2. To create an invoice for the primary vendor, type the invoice number in the Invoice Number 
field at the top of the screen.

 3. To create invoices for secondary vendors, type the invoice number in the Invoice Number field 
on the line for each vendor whose invoice you are creating.

 4. When finished, click Close to return to the Receipt tab.

 5. Click Post to post the receipt and the invoices.

    Adding or Editing Details Using the Detail Items/Taxes Screen

The Detail Items/Taxes screen contains the same fields as the detail entry     grid on the Receipt tab, 
plus additional tax-related fields that you use to view or change tax information for a selected detail. Mo re ...

Rather than displaying fields for all the details in tabular format,     this screen lets you see all the fields 
for a single detail on a separate    screen.

For more information, see "P/O Receipt Entry Detail Items/Taxes Screen" (page 617).
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Before You Start

 l Open the Receipt Entry Detail Items/Taxes screen:

 1. Open Purchase Orders > P/O Transactions > Receipt Entry.

 2. Enter header information for the receipt, including the vendor number and, if you are 
receiving an existing purchase order, specify the purchase order number (or numbers if 
you are receiving multiple purchase orders).

 3. Select an existing detail, or enter a new one, and then press F9, or click the Item/Tax       
button.

To add or edit details in the Detail Items/Taxes screen:

 1. To start a new detail      line, click the New icon beside the Line Number field.

To view or edit an existing detail, type its     line number or use the navigation buttons beside the 
Line Number field    to display the detail you want.

 2. Enter the information      or changes for the detail.           

You can change a tax class to another tax     class that is assigned to the authority, and you can 
change the choice     for the Tax Included option (if the tax authority permits tax-included    costs).

 3. When you are finished,      click Close.

 4. To check tax amounts for       a receipt and compare the totals on the screen with the totals on the       
source document, view the Totals      tab.

To delete details in the Detail Items/Taxes screen:

Note: You cannot delete details after you have posted the receipt.

 1. To display the detail you want to delete, type its line number or click the navigation buttons 
beside the Line Number field until the line you want is displayed.

 2. Click Delete. 

If a message appears asking you to confirm the deletion, click Yes.

Adding, Editing, or Deleting Additional Costs

You use the Additional Costs tab on the Receipt Entry screen to add costs     such as handling charges, 
service charges, and duty to a receipt. Mo re ...

You can:
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 l Add additional costs charged on the shipment by both primary vendors      and secondary 
vendors, such as for handling charges, service charges, and duty. For more information, see 
"About Vendors" (page 81).

 l You can expense costs or prorate them to received items. 

 l Edit additional-cost amounts on previously posted receipts which are not yet fully invoiced.

 l Assign or edit the terms code and tax group for the additional cost vendor.

 l Check the number of details and the total amount of additional costs entered for the vendor.

 l In multicurrency ledgers, edit exchange rate information for vendors who do not use the 
functional       currency.

 l Specify how to reallocate prorated costs of received items that you return.

To enter, edit, or delete additional cost details:

 1. Open Purchase Orders > P/O Transactions > Receipt Entry.

For more information, see "P/O Receipt Entry Screen" (page 561).

 2. On the Receipt tab, enter vendor and purchase order information, along with receipt quantities.

 3. On the Additional Costs tab, use the Finder or the navigation buttons beside the Additional 
Cost Vendors field to select an existing additional   cost vendor for which to enter or edit an 

additional cost detail, or click   the New  icon to add a new vendor in Accounts Payable. 

Note: A new receipt lists only the primary vendor. 

 4. When you have displayed the correct vendor in the vendor number field, enter or edit   the 
additional cost details for the selected vendor in the detail entry table.       

Tip: To display all the information for a selected detail on a separate screen, or to edit tax 
classes or the tax included fields   for the detail, select the detail, then either click the Cost/Tax 
button or press the F9 key.

 l In the Proration Method field, specify whether to prorate the additional cost to the details 
automatically (by quantity, cost, or weight) or manually, or not to prorate.

Note: If you are adding additional costs for non-inventory items, you must   choose No 
Proration. If you choose to prorate by quantity, cost, or weight,   the program will display 
an error message and prevent you from posting the receipt.

 l To delete a detail, select it, and then click Delete.   If a message appears asking you to 
confirm the deletion, click Yes.
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 5. Click the Calculate Taxes button if you want to see tax amounts for   a detail before you have 
posted the receipt or opened the Totals tab.   (Tax amounts are not automatically calculated 
until you click the Taxes tab or the Totals tab, or post the receipt.)

 6. If you edit tax amounts on the Taxes tab, and then use the Calculate Taxes   button, the 
program replaces your changes with amounts it calculates   using the tax tables in Tax Services.

 7. Click Post.

Prorating Additional Costs on Receipts

You can prorate additional costs for a single receipt or for several receipts.

To prorate additional costs   for a single receipt:

 1. Select the additional cost on the Additional Cost entry table.

 2. Click the Item/Tax button or press   F9 to open the Detail Costs/Taxes screen.

 3. Click the Zoom  button beside the Distribute Proration field.

 4. Distribute the additional cost (and billing rate for billable details).

To prorate additional costs for several receipts:

 1. Select the additional cost on the Additional Cost entry table.

 2. Click the Cost/Tax button or press F9 to open the   Detail Costs/Taxes screen.

 3. Click the Dist. Cost button to display the Cost Allocation screen.

 4. Highlight the receipt you want, and then click the Distribute Proration column heading.

 5. In the Distribute Proration screen that appears, distribute the additional cost and the billing rate 
(for billable details).

About Prorating by Cost

If you prorate by cost, the program determines the additional cost for     each item detail by calculating 
the cost amount cumulatively for each     detail, then subtracting the amounts already prorated to 
previous details.     Use this method, for example, to process brokerage fees for shipping and    handling. Mo re ...

For example, assume that a receipt contains the following items and    costs:

Item # Quantity Unit Cost Extended Cost

A1-010 10 10.00 $100.00

A1-320 5 25.00 125.00
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Item # Quantity Unit Cost Extended Cost

A2-240 2 40.00 80.00

Subtotal $305.00

Vendor 1—     Packaging 40.00

Vendor 2—     Freight 80.00

Allocated Tax on Additional Costs 25.00

Total $450.00

When you enter the item costs and the additional costs (packaging, freight,     and associated allocated 
taxes) from the preceding receipt information,    the costs are apportioned as shown in the following 
table.

Item # Extended 
Cost

Additional Cost 
Calculation

Total 
Prorated

Prorated/Unit 
(rounded)

A1-
010

$100.00 100.00 x 145.00 - 0
305.00

$47.54 $4.75

A1-
320

125.00 225.00 x 145.00 - 47.54
305.00

59.43 11.87

A2-
240

80.00 305.00 x 145.00 - 106.97
305.00

38.03 19.02

Total $305.00  $145.00  

The additional costs apportioned to the items in the preceding example     add up to $145.00, the total 
amount of the additional costs for packaging,    freight, and associated allocated taxes in the sample 
receipt.

The following general     ledger journal entry would be created for the above proration during Day    End 
Processing.

General Ledger Account Debit Credit

Inventory Control (item A1-010) 47.54  
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General Ledger Account Debit Credit

Inventory Control (item A1-320) 59.43  

Inventory Control (item A2-240) 38.03  

…Payables Clearing  145.00

Prorating by Cost on Zero-Amount Receipts   

If you post a receipt for a zero amount, and prorate additional costs by cost, the additional costs are 
apportioned evenly   to all items on the receipt.

Note: For non-inventory items, you must choose No   Proration.

Using Manual Proration   

Select the Prorate Manually to prorate   additional costs to receipt details using a formula that does 
not assign   the amounts proportionally. 

Example: When you are charged duty on imported items, the amount   normally depends on the 
type of item and is an identifiable cost of purchasing   the item..

Select Prorate Manually, double-click the Distribute Proration   column to display the Distribute 
Proration screen, and then enter the amount   the you want to allocate to each receipt detail (including 
allocated tax).

Make sure the prorated amounts equal the total additional cost amount,   plus allocated taxes. 

Note: You cannot post a receipt if total additional costs   and prorated additional costs do not 
balance. 

Tip: You can check the total amount you have manually prorated (from more   than one vendor) on 
the Totals tab.

    Recording the Receipt of Items for Sage Fixed Assets

You use the Receipt Entry screen in Purchase Orders to receive items and identify them as fixed    
assets for Sage Fixed Assets.
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To record the purchase of an asset for Sage Fixed Assets:

 1. Open Purchase Orders > P/O Transactions > Receipt Entry.

For more information, see "P/O Receipt Entry Screen" (page 561).

 2. Create a new receipt transaction, entering header information as usual. (For detailed 
instructions on entering receipt transactions, see "Entering Receipts" (page 134).)

 3. Tab into the detail entry table (or click the table), and then enter information for the item detail, 
including the item number for the asset you are receiving, location, quantity, and unit of 
measure, as usual.  Mo re ...

Tip: You can click the Item/Tax. button or press F9 to display a separate screen that lets you 
view and edit all the information for a single detail, including tax information.

 4. Double-click ini the he Fixed Assets column cell to display "Yes," and then click the Zoom  
button to open the Fixed Assets screen.

 5. Enter information for the asset record as follows: Mo re ...

 a. If you want to use a different template than the one displayed on the Fixed Assets 
screen, use the Finder for the Template field to select a different one. Otherwise, either 
accept the default template code that appears or clear the entry from this field. (You do 
not have to use a template to create the asset in Sage Fixed Assets.)

 b. Use the Description field to enter the description that you want to use for the asset in 
Sage Fixed Assets.      

 c. If you are using more than one asset item and you want to create separate asset records 
for each one in Sage Fixed Assets, select the Separate Assets option.

 The program allocates the Sage Fixed Assets value entered on the Fixed Assets screen 
proportionately to each Sage Fixed Assets record it creates. For example, for a quantity of 10 
and a value of $25,000, the program creates 10 asset records with a value of $2,500 each.

 d. In the Fixed Asset Quantity field, type the quantity of asset items you are receiving.

 e. In the Fixed Asset UOM field, type the unit of measure for the quantity that you entered.

 f. In the Fixed Asset Value field, type the value to book for the asset in Sage Fixed 
Assets.      

 g. Click Close to return to the item detail entry screen.

 6. When you have finished adding details for the transaction, click Close to return to the main 
Receipt Entry screen.

 7. Click Add, and then click Close.

Note: You must run Create Assets     in Sage Fixed Assets Integration to update Sage Fixed Assets 
with the asset information.
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Invoices
Enter and post invoices, including additional costs and exchange rate information.

About Processing Invoices

Use the Invoice Entry screen to enter invoices for goods received and     additional costs billed, to 
complete receipts and provide information     for invoices that are transferred to Accounts Payable from 
Purchase Orders.     

You can also look up posted invoices until you clear them from Purchase    Orders.

When you select a receipt for an invoice, the information     entered with the receipt is displayed. You 
can make any changes you need    to the vendor and header information. 

Duplicate Invoice Numbers

If necessary, you can enter more than one invoice with the same invoice number, for either the same 
vendor or different vendors.

When you enter a duplicate invoice number, a screen displays all invoices with the specified invoice 
number. On this screen, you can choose to create a new invoice with the same number or display 
other invoices with that number.

Valid Receipt Numbers Are Required

You can enter invoices only for existing receipts. When you post the    invoice, the receipt details are 
completed for the vendor.

You can add new additional costs and prorate them for the receipts used     in the invoice. You can 
delete item and cost details that were posted     on a receipt, and you can change the amounts and 
quantities (if you have    rights to change quantities and costs).

When you enter the receipt number, all receipt details and other information   for the selected vendor 
are displayed in Invoice Entry. You cannot change   the tax group or add or delete item detail lines (for 
the primary vendor).   You can add additional cost details.

The receipt details that appear include all item and additional cost   details for the primary vendor, or all 
the additional costs for vendors   who charged only additional costs on the original receipt.
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Note: You can enter any number of invoices for a receipt. Only receipt   details that have not already 
been fully invoiced can be used in the current   invoice. Once all the details are fully invoiced, you can 
no longer use   the receipt in an invoice.

Invoice Details

When specify a receipt or multiple receipts for an invoice, Purchase Orders displays all of the     vendor's 
receipt details, including item details and additional cost details,     if any, for the primary vendor. 

The invoice displays item details only for the primary vendor. 

You can add new additional cost details     on an invoice, but you cannot add or delete item details. You 
also cannot    delete additional cost details, although you can change the amounts.

Posting Invoices to Cleared Receipts

If you need to post an invoice for a secondary vendor on a receipt that you     have cleared from 
Purchase Orders, use the Credit/Debit Note Entry screen to add and post a debit note or a credit note 
to ensure that all costs are correctly    updated. 

Job-Related Invoices

Job-related invoices update Project and Job Costing quantities and costs     only if the invoices differ 
from the posted receipts (which have already    updated the committed and actual quantities and costs 
for the job).

If the     invoice is job-related, changes to the quantities, billing rate, and cost     will affect the committed 
and actual quantities and costs for the job     in Project and Job Costing. If the invoice is posted exactly 
like the    receipt, no transactions will be sent to Project and Job Costing.

About Invoicing Receipts

You can use the Invoice button in the Receipt Entry screen to post an invoice for the item details and 
additional costs entered for the primary vendor, and for the additional costs entered for secondary 
vendors.

 l When you post an invoice from the primary vendor, the invoice automatically includes all the 
item and additional cost details entered for the vendor on the selected receipt, and completes 
the receipt details for the vendor and the details on the purchase order, if any, used with the 
receipt.

 l When you post an invoice for a secondary vendor, all the additional costs you entered for 
the vendor on the specified receipt are invoiced and completed at the same time.
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When invoicing from the Receipt Entry screen, you enter the invoice number for each of the vendors 
for which you are posting an invoice.

Note: You can also use the Invoice Entry screen to post invoices for a receipt. For more 
information, see "About Processing Invoices" (page 145).

About Entering Additional Cost Details on Invoices

When entering an invoice for a receipt, you   see additional costs only for the vendor selected for the 
invoice. Additional   costs for secondary vendors appear on separate invoices.

You can add new additional costs to an invoice,   and you can select any proration method except 
manual proration. 

You can also edit additional costs that were entered on the receipt, except   for amounts that were 
manually prorated on the receipt. Mo re ...

Information you can edit for additional cost details includes:

 l Description, reference, and comment.

 l Amount.

You can change all additional cost amounts, except   those that were manually prorated on the 
receipt. Although you cannot   delete an additional cost detail, you can change the amount to 
zero.

 l General ledger accounts.

Non-inventory Items

When entering additional costs for non-inventory items, you must     select No Proration. If you try to 
prorate by quantity, cost, or weight,     the program displays an error message and prevents you from 
posting    the receipt.

Displayed Tax Information 

Purchase Orders displays the following tax information for each additional   cost detail:

 l Amount of tax that is included in the extended item cost.

 l Net cost of additional cost items with tax included in their prices (the tax base).

 l Total allocated tax amount—the amount of tax that will be allocated to the cost of the item.

Use the Cost/Tax button on the Additional Cost tab to view and edit   tax information for the additional 
cost, as described below.
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Allocating Additional Costs to Multiple Receipts

To prorate a new additional cost to multiple receipts, select the detail   line and then click the Distribute 
(Dist.) Cost button to open the Cost   Allocation screen. You can manually enter amounts to allocate to 
each receipt,   or you can let Purchase Orders calculate the amount to allocate according   to the 
proration method you selected on the Additional Costs tab.

If you want to prorate or expense a job-related cost to several jobs,   you must have a receipt detail for 
each of the jobs to which you want   to apportion costs.

You can also specify retainage for job-related costs.

Editing the Tax Distribution 

To check or edit tax distributions for an additional cost detail, you use the Costs/Taxes screen. (Select 
the detail line on the Additional Costs tab, then click the Cost/Tax button.)

For each tax authority, you specify:

 l The tax   class for the item. 

Note: If you change the tax class for an additional cost that was manually prorated on the 
receipt, any resulting difference in the tax amount is posted to the default cost expense 
account specified in the P/O Options screen.

 l Whether tax is included in the cost (if allowed by the authority).

The Costs/Taxes screen also displays the recoverable and expensed tax amounts in the tax 
distribution pop-up screen.

You can override the additional cost tax amount by changing the total tax on the Taxes tab. However, 
the program prorates the tax change to each of the details.

Tip: You can use the Calc. Taxes button to recalculate all of the tax on the invoice.

About Entering Exchange Rate Information on Invoices 

If you use multicurrency accounting, you can edit the invoice rate   type, rate date, and exchange rate 
for vendors who do not use the functional   currency. 

If you selected a receipt for the invoice, the Rates tab displays the   vendor's rate date, type, and 
amount from the receipt and default entries   for the invoice rates. You can change the rate information 
for the invoice.

If you are entering a transaction with retainage, you specify on the   Retainage tab whether the 
retainage invoice uses the same exchange rate   as the original document or the current rate.
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About Entering Optional Data on Transactions

Optional fields are company-defined fields that can be added to any   of the transaction-entry screens 
and to transaction detail lines if   you use Transaction Analysis and Optional Field Creator.   

Optional field entries can flow from   requisitions and purchase orders to the associated receipts and 
invoices if you use the   same fields for all the transaction screens.

You use the Optional Fields tab in a transaction-entry screen to enter information that applies to the 
transaction as a whole (header information). Optional fields on detail lines apply only to the   single 
detail line. Changing the information in   any of these fields has no effect on the transaction. 

If Accounts Payable invoice header and detail optional fields are the same as those used in Purchase 
Orders invoices, the optional   field information can be passed automatically to Accounts Payable.

If General Ledger transaction details optional fields defined for the   General Ledger accounts match 
the transaction header and detail optional   fields used in Purchase Orders invoices, the optional field 
data can be passed automatically   to General Ledger (depending on your optional fields settings).

About Posting Invoices

When you click Post to post an invoice, Purchase Orders compares the total of all details and taxes to 
the   invoice total entered on the Invoice tab. The invoice   is posted only if the two totals are the same.

Posting assigns the invoice number you entered, and completes the invoice   and the receipt details for 
the selected vendor. You cannot change or   delete an invoice after posting it, and you cannot change 
the receipt   details for the vendor. 

Effect on Inventory Control

If you changed the quantity received on an invoice, the quantity on   hand in Inventory Control is 
adjusted during posting. Otherwise, invoice   posting in Purchase Orders has no effect on Inventory 
Control data.

Effect on Project and Job Costing

Job-related   invoices update Project and Job Costing quantities and costs only if the   invoice differs 
from the posted receipt.

Keeping Information for Posted Transactions

If   you use the Keep Transaction History   option, you can display posted invoices in the Invoice Entry 
screen and   print them on the Transaction   List   until you clear them from Purchase Orders. For more 
information, see "P/O Transaction List Report Screen" (page 297).
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If you do not keep transaction   history, posted invoices are deleted during posting or Day End 
Processing   in Inventory Control (depending on when you cost inventory). For more information, see 
"About Day End Processing" (page 194).

Entering an Invoice

You can enter invoices when you receive goods or at any time afterward. Mo re ...

If an invoice arrived       with the shipment, you can enter the invoice in Purchase Orders using the 
Receipt Entry screen. If you also incurred charges from additional vendors,      you can also enter the 
additional cost invoice numbers. The program      automatically creates all invoices for the received 
goods when you post     the receipt.

If you decide to invoice later, you use the Invoice Entry screen, which lets you enter an invoice for one 
or more receipts from the same vendor. (However, you cannot mix job-related and non-job-related       
receipts.) The Invoice Entry screen provides full control        over invoice creation, so you can edit vendor 
information, tax information,        prices, discounts, optional field information, currency exchange rates, 
and so on.

To      invoice goods when you receive them, using the Receipt Entry screen:

 1. When you enter the receipt, enter an amount in the        Quantity Received field for each detail line 
for which you are receiving       goods, or click Receive All to receive all the goods on the purchase 
order.

 2. Enter any additional costs       on the Additional Costs tab.

 3. Before you post the receipt, click the Invoice.

 a. In the Invoice window that appears, type the invoice number from the primary vendor.

 b. If you entered additional        costs from other vendors, enter their invoice       numbers in the 
Invoice Number column in the table.

 c. Click Close.

 4. Click Post       to post the receipt.

The program also creates and posts the invoices,     and then displays a message asking if you 
want to print the invoice.

For more information on the Receipt Entry screen, see "P/O Receipt Entry Screen" (page 561).
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To invoice one or more receipts using the Invoice    Entry screen:

 1. Open Purchase Orders > P/O Transactions > Invoice Entry.

For more information on the Invoice Entry screen, see "P/O Invoice Entry Screen" (page 451).

 2. In the Invoice Number field, type the number of the      invoice that you received from the vendor.

 3. In the Vendor Number field, type the vendor number      or select it from the Finder.

If the     invoice is for several receipts or for a secondary vendor, you      must enter the vendor 
number.

Tip: If     you are invoicing a single receipt for the primary vendor, you     can skip the Vendor 
Number field. 

 4. If you are invoicing a single receipt, in the Receipt Number field, type the receipt number or 
select it using      the Finder.

If you are invoicing several receipts:

 a. Select From     Multiple Receipts, then click the Zoom  button beside the option. 

 b. On the Create Invoice     From Receipts screen that appears, select the receipt numbers 
using the Finder.

 c. Click the Invoice button.

The program displays all the information from     the selected receipts. You can then edit 
the information,    or post the default invoice.

Note: The Invoice tab displays only details for the     primary vendor. Details for secondary 
vendors appear on the Additional     Costs tab—not on the    Invoice tab.

 5. Check the header information for the invoice      to make sure that it is correct. Mo re ...

 a. In          the Invoice Date field, type or select the invoice date.

 b. In the Posting Date field, type or select the date to use          for posting the transaction in the 
general ledger. The posting date         determines the year and period to which the 
transaction is posted.

 c. In          the Remit-To Location field, enter or select the code for the address to which         you are 
sending your payment.

 d. In the Bill-To Location field, optionally specify the location that is responsible for paying 
the invoice.

 e. Enter         an optional description and a reference for the invoice.
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 6. Edit invoice details on the detail      entry table, or click the Item/Tax button (or press F9) to enter 
details using the Items/Taxes screen. Mo re ...

For each detail, you can:

 l Delete a detail line if it does not appear on the vendor's invoice.

 l Set the Fully Invoiced field to Yes if the quantity invoiced equals the amount that you 
received. 

 l Edit the following information:

 l Item description

 l Quantity invoiced (if different from the quantity received)

 l Unit cost and extended cost

 l Discount percentage or discount amount

 l Weight UOM, unit weight, and extended weight

 l Vendor item number

 l Order number

 l Comments

 l Manufacturer's item number

 l Optional fields

 l Whether the item is discountable

Tip: To change item tax classes or tax included information, use the Items/Taxes screen. 
(Select the detail on the detail-entry grid on the Invoice tab, then press F9 or click the 
Item/Tax button.)

 7. Use the remaining tabs to enter additional information for the invoice.

 l Click the Additional Costs tab to edit invoice details for a secondary vendor (and for 
primary vendor additional costs).

 l Click the Taxes tab to check the tax totals. You can change the tax class and tax amount 
for each jurisdiction, if necessary.

 l Click the Totals tab to check the totals for the invoice.

 8. When you have finished entering information, click Post.

When posting is finished, you can print the invoice.
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Entering Additional Costs on Invoices

You use the Additional Costs tab on the Invoice Entry screen to add costs   such as handling charges, 
service charges, and duty. You can expense costs   or prorate them to received items. Mo re ...

You can:

 l Specify how to prorate new additional costs or reprorate   the costs if you return the items.

 l Allocate new additional costs (added to the invoice)   to one or more receipts.

To enter an additional cost:

 1. Open Purchase Orders > P/O Transactions > Invoice Entry.

For more information on the Invoice Entry screen, see "P/O Invoice Entry Screen" (page 451).

 2. In the Invoice Number field, type an invoice number or use the Finder or the navigation 
buttons to select an existing invoice.

 3. If you are entering a new invoice, type the vendor number in the Vendor Number field, or use 
the Finder to select the number. 

 4. On the Invoice tab, enter   or edit vendor and receipt information, along with invoice quantities, 
as usual. 

 5. On the Additional Cost tab, select an existing cost detail, or press the Insert key to start a new 
one. 

 6. If you are entering a new additional cost:       

 a. Double-click in the Additional Cost column, and then select an additional cost code.

 b. In the Amount column, type the amount of the additional cost, and then press the Tab 
key.

Tip: You can also click Cost/Tax or press F9 to open the Detail Costs/Taxes screen, where 
you can view and edit all the information for a single detail, and change the detail tax classes 
and tax included status for the detail.

 7. In the Proration Method field, specify whether to prorate the cost by quantity, cost, or weight, 
or prorate manually.      

To prorate additional costs manually for a single receipt:

 a. Click the Distribute Proration column heading.

 b. Distribute the additional cost (and billing rate for billable details).
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 c. Click Close.

To prorate additional costs   for several receipts:

 a. Click the Dist. Cost button to display the Cost Allocation screen.

 b. For each receipt, select (highlight) the receipt, click the Distribute Proration column 
heading to display the Distribute Proration screen, and then distribute the additional 
cost and billing rate (for billable details).

 c. Click Close to return to the Cost Allocation screen, and then click Close again.

Note: If you are entering additional costs for non-inventory items, you must select No 
Proration. (If you try to prorate by quantity, cost, or weight, the program prevents you from 
posting the receipt.)

For more information on prorating additional costs, see "About Calculating Prorated Additional 
Costs" (page 133).

To delete a detail, select it, and then click Delete.        

If a message appears asking you to confirm   the deletion, click Yes.

 8. Check the Invoice total on the Totals tab.

 9. Click Post.
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Returns
Enter, export, post, and print returns of items to vendors.

About Processing Returns

You can post returns of items to inventory against existing receipts     or against receipts you have 
already cleared from Purchase Orders. You    can also post returns without entering any receipt 
number.

If you enter a receipt number, the return is to the primary vendor on     the receipt. (You cannot post 
returns to secondary vendors specified on    receipts.)

When you post a return, inventory quantities are immediately updated     for the returned items in 
Inventory Control. You can edit posted returns    until they are completed (when credit notes are 
posted).

Entering   Returns for Existing Receipts   

When you return items from an existing receipt, Purchase Orders displays   information from the 
original receipt in the Return Entry screen. You can   edit all the information on the Return tab except 
for the purchase order   number (if any), vendor number, and template code.

You enter the returned quantity for each item in the detail entry grid   on the Return tab. You can either 
delete the details that you are not   returning, or leave the returned quantity at zero. 

Tip: If you are returning all items from a receipt, you can click Return   All to enter the full quantity 
received on each detail line. If   necessary, you can change all of the inserted returned quantities.

Detail Information You Can Edit

On   each detail line, you can enter a return cost (the total cost of the returned   items) and edit the item 
description, location (if you use Inventory Control),   unit of measure, unit and return cost, unit and 
extended weight, vendor's   item number, order number, comments, and optional fields. For non-
inventory   items, you can edit the general ledger expense account. 

Detail Information You Cannot Change

You cannot add detail lines to the return,   and you cannot change the item number, quantity received, 
and extended   cost (from the receipt detail).

If the return is job-related, you cannot change job information.
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Tax Information 

Detail   taxes are calculated for the returned quantities only. As with other Purchase   Orders transaction 
types, you use the Detail Items/Taxes screen to change   tax class and tax-included options for a detail 
line. (Select the line,   then click the Item/Tax button.) You cannot change tax information on   the line 
itself.

Prorating Additional Costs

If you return all items on a receipt that included additional costs   and used Prorate as the return 
proration method, the costs remain allocated   as specified on the receipt.

Entering   Returns for Non-Existing Receipts   

When you enter returns to cleared receipts, you can enter and change   all the default information that 
appears from the vendor record and template   code. You can also add as many detail lines as you 
need to match the information   on the cleared receipt.

You enter the details of the returned items on the detail entry grid   on the Return tab of the Return 
Entry screen. With each detail, you must   enter the item number, item description, location (if you use 
Inventory   Control), and quantity returned. 

You can also enter the unit and return cost, unit of measure, unit weight,   extended weight, vendor's 
item number, order number, and comments. If   the detail includes a non-inventory item, you also enter 
the general ledger   account to which the returned cost is expensed.

For Job-Related Returns

you enter contract, project, and category information.

You do not enter the quantity received or extended cost.

Tax Information

You edit tax information as for returns to receipts. Click the Item/Tax button on the Return tab to open 
the Detail Items/Taxes to edit the tax class and tax-included option for detail lines; use the Taxes tab 
to edit the tax class and tax amount for the vendor.

Checking Return Totals

Use the Totals tab on the Return Entry screen to       check totals for the current return and to specify the 
number of shipping labels      to print.

The Totals tab lets you enter: 
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 l A comment for the      return.

 l A discount percentage       or a total discount amount for the return. When you enter a discount on       
this tab, the program distributes the total amount to the return details,      overwriting any 
discounts you entered for details.

The Totals tab also displays:  

 l The weight of the      returned items.

 l Totals for the primary       vendor. Information includes the total weight and number of details on      
the return and total of item details.

Note: You use the Taxes tab to view       or to edit vendor tax classes or the tax amount for the tax 
authorities      assigned to the vendor.

Posting Returns

When you post a return, item quantities on hand are immediately reduced     in Inventory Control. If 
Purchase Orders uses automatic-numbering, posting    also assigns the return number.

Note: If the return is job-related, Purchase Orders also updates the actual    quantities and costs for 
the job in Project and Job Costing.

Editing Returns

If you change return quantities or return costs, Inventory Control item     quantities are updated with the 
changes, and Day End Processing creates    new general ledger transactions to reflect the changes.

Note: On a job-related return, changes to returned quantities change the actual quantities    and 
costs in Project and Job Costing.

Job-Related Returns

Job-related returns update Project and Job Costing actual quantities    and costs, reducing the WIP 
account for the job.

About Exporting Returns

You can export returns to     transfer return transactions created in Purchase Orders to non-Sage 300    
applications, or to a file to be edited and imported later. (On the Return Entry screen, you click File >  
Export.)
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Before exporting, decide which fields to include in the export file.     You must select fields for each type 
of record used for returns. You should    also find out the path for the export file you want to use or 
create.

Important! When you export, Purchase Orders exports all the posted returns     currently in the 
system. If you do not want to export everything, use    the Set Criteria option to specify the returns to 
export. 

About Printing Returns

You can print returns in the following ways in Purchase Orders:

 l Using the Returns screen in the P/O Forms folder to print a range of returns.

 l Using the Return Entry screen to print a copy of a single return immediately after you post it.

You can reprint returns until they are complete.

You can print returns from Purchase Orders using the forms that come with the program, or you can 
use SAP Crystal Reports®  for Sage 300 to design the return forms you want to use. Mo re ...

For more information on designing and adapting forms and reports, see the Customizing Printed 
Forms guide, which is available online at 
https://cdn.na.sage.com/docs/en/customer/300erp/Sage300ERP_Documentation.htm.

E-mailing Returns

The Purchase Orders program also lets you e-mail purchase returns and purchase orders to 
vendors.

Note: You use the E-mail Messages screen in the P/O Setup folder to create an e-mail message to 
send to vendors along with e-mailed returns. Then, for each vendor that you want to email, you 
must select an Email delivery method on the Processing tab of the vendor record in Accounts 
Payable.

About Reprorating Costs on Returns

When you return items to which additional costs were prorated on the receipt, you select a reproration 
method that determines how to reallocate additional costs attached to the returned items. Mo re ...

If you use an additional cost code, the program displays the reproration   method specified in the 
additional cost record, but you can select another method   for the detail. 
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You can choose to leave the cost as originally prorated, reprorate it   using the original proration 
method, or expense it to the general ledger   account you specify, as follows:

 l Select Prorate   to prorate the "returned" additional   cost amount over the remaining goods on 
the receipt, using the original   proration method.

 l Select Leave   if you do not want to reprorate the additional cost to the remaining   goods on the 
receipt. The additional cost amount remains in the Inventory Control account to which you   
originally posted it, and is applied to all other item costs that   are posted to the control account.

Note: The Leave option is available only if you select   No Proration or Manual Proration for the 
detail. 

Tip: You can also use the Adjustments screen in Inventory   Control to write off the additional cost 
to a general ledger write-off   account, rather than add it to other item costs. 

 l Select Expenseto debit a general ledger expense account   for the returned portion of the 
additional cost amount. Enter the general   ledger account number to which the expensed 
amount is posted.

Note: 
If you originally prorated the costs     manually, you cannot choose to reprorate the costs from 
returned items.     The amounts remain in the general ledger accounts to which they were originally     
posted and are part of the cost of the items that remain in your inventory.     If necessary, you can post 
an adjustment to the Inventory Control general    ledger account to remove the cost.

If you reprorate the additional     costs associated with the returned items, the program recalculates the    
amounts for each remaining item, as shown in the following examples.
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Example: 
If the following items and     quantities were received with prorated additional costs, and the quantities     
shown were returned, their additional costs would be reprorated to the    remaining items, as follows: 

Item Qty.       
Rec'd

Qty.       
Ret'd

Prorate       
Amt.

New       
Qty

New       
Ext. 
Cost

Reproration
Calculation

Total       
Repro-
rated

Diff.

A1-
010

10 2 47.54 8 80.00 80.00 x 145.00 - 0
     220.00

52.73 5.19

A1-
320

5 1 59.43 4 100.00 180.00 x 145.00 - 
52.73
     220.00

65.91 6.48

A2-
240

2 1 38.03 1 40.00 220.00 x 145.00 - 
118.64
220.00

26.36 -
11.67

Total 17 6 145.00      

A     general ledger journal entry would be created by Day End Processing for     the difference in 
prorated amounts. Debits to the first two Inventory     Control accounts equal the credit to the third 
account, with no net effect    on Payables Clearing. 

General Ledger Account Debit Credit

Inventory       Control (item A1-010) 5.19  

Inventory       Control (item A1-320) 6.48  

Inventory       Control (item A2-240)  11.67
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Example: 
If you did not reprorate     additional costs after returning items, the total unit cost for each item     is 
increased proportionally with the amount originally prorated to the    returned items. 

Item Qty.       
Rec'd

Qty.       
Ret'd

Total 
Prorated

Original
Pro-rated

/Unit 
(rounded)

Calculation
(based on ret'd 

qty.)

New Add'l
Cost Per Unit

A1-010 10 2 47.54 4.75 47.548 5.94

A1-320 5 1 59.43 5.94 59.434 14.86

A2-240 2 1 38.03 3.80 38.031 38.03

Total 17 6 145.00    

When you choose to reprorate costs on returns, the program apportions     the amounts on the basis by 
which you originally prorated them (by cost,    quantity, or weight). 

Entering Returns   

You can post returns of items to inventory against existing receipts or against receipts you have 
already cleared from Purchase Orders. You can also post returns without entering any receipt 
number. Mo re ...

If you enter a receipt number, the return is posted to the primary vendor on the receipt. (You cannot 
post returns to secondary vendors specified on receipts.)

When you post a return, inventory quantities are immediately updated for the returned items in 
Inventory Control. You can edit posted returns until they are completed (when credit notes are 
posted).

Note: 
 l If you change return quantities or return costs on posted returns, Inventory Control item 

quantities are updated with the changes, and Day End Processing creates new general 
ledger transactions to reflect the changes.

 l Job-related changes to returned quantities change the actual quantities and costs in Project 
and Job Costing, reducing the WIP account for the job.
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Entering Returns for Existing Receipts

When you return items from an existing receipt, Purchase Orders displays information from the 
original receipt in the Return Entry screen. You can edit all the information on the Return tab except 
for the purchase order number (if any), vendor number, and template code.

You enter the returned quantity for each item in the detail entry table on the Return tab of the Return 
Entry window. You can either delete the details that you are not returning, or leave the returned 
quantity at zero.

If you are returning all items from a receipt, you can use the Return All button to enter the full quantity 
received on each detail line. If necessary, you can change all of the returned quantities inserted by 
the Return All button.

Entering Returns for Non-Existing Receipts

When you enter returns to cleared receipts, you can enter and change all the default information that 
appears from the vendor record and template code. You can also add as many detail lines as you 
need to match the information on the cleared receipt.

You enter the details of the returned items on the detail entry table on the Return tab of the Return 
Entry window. With each detail, you must enter the item number, item description, location (if you use 
Inventory Control), and quantity returned.

You can also enter the unit and return cost, unit of measure, unit weight, extended weight, vendor's 
item number, order number, and comments. If the detail includes a non-inventory item, you also 
enter the general ledger account to which the returned cost is expensed.

Prorating additional costs

No additional cost details appear on a return. You cannot edit costs or add new costs. When you 
return items to which you prorated additional costs on the receipt, the costs are allocated according 
to the reproration method specified on the receipt.

If you return all items on a receipt that included additional costs and used Prorate as the return 
proration method, the costs remain allocated as specified on the receipt.

Before You Start

 l If you want to assign numbers to returns automatically, use the Options window to assign or 
verify the length, prefix, and next number for Purchase Orders to assign to returns.
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 l Post any receipts from which you are returning items.

 l Make sure you have complete information for each return, including:       

 l Vendor number.

 l Return number (if you assign your document numbers).

 l Receipt number, if any.

 l All returned item numbers and corresponding locations, units of measure, and 
quantities to return.

To enter a return:

 1. Open Purchase Orders > P/O Transactions > Return Entry.

 2. In the Return Number field, press Tab to accept ***NEW*** as the return number.     

Purchase Orders will assign a return number when you post the return.

Tip: If you do not want Purchase Orders to assign a number automatically, you can manually 
enter a number.

 3. In the Vendor Number field, enter the vendor number or select it from the Finder.     

Tip: You do not have to enter a vendor number. However, doing so can be helpful if you want 
to select a receipt number using the Finder, because specifying a vendor number limits the 
length of the receipt list.

 4. In the Receipt Number field, enter the receipt number or select it from the Finder.     

The program will display all of the information from the receipt that you selected, allowing you 
to return all items or edit the quantities and then post the return.

 5. Check the header information for the return to make sure that it is correct. Mo re ...

 a. In the Return Date field, enter the return date or select it using the Calendar.

 b. If the posting date is different from the return date, enter it in the Posting Date field.

Note: The posting date is the date that you want to use for posting the transaction in 
the General Ledger. This date also determines the year and period to which the 
transaction is posted.

 c. In the Bill-To Location field, enter or select the code for the inventory location that is 
returning the items.

 d. You can also specify a ship-via code for the return.
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 e. You can change the vendor account code to post the transaction to a different set of 
Accounts Payable control accounts.

 f. Enter a description and a reference for the return.

 6. To return everything from the receipt, click Return All. You can change quantities, if 
necessary, and delete lines which are not being returned.

 7. If you are entering returns for cleared receipts (the receipt no longer exists), enter the details of 
the returned items on the detail entry table on the Return tab. Mo re ...

For each detail, you must enter:

 l Item number.

 l Item description.

 l Location (if you use Inventory Control).

 l Quantity returned.

 l Unit cost.

 l Return cost.

 l Unit of measure.

 l Unit weight.

 l Extended weight.

 l Vendor's item number.

 l Order number.

 l Comments.

 l The general ledger account to which the returned cost is expensed (if the detail includes 
a non-inventory item).

 8. For job-related returns, enter contract, project, and category information.     

You do not enter the quantity received or extended cost.

 9. Edit return details on the detail entry table. Mo re ...

For each detail, you can:

 a. Delete the detail line if it's not being returned.

 b. Change the Quantity Returned.

 c. Edit information such as unit cost and extended cost, discount percentage or discount 
amount, weights, quantities, vendor item number, order number (if PO is created from a 
customer order), comments, manufacturer's item number, and optional fields.
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 10. If you need to change item tax classes or tax included information, use the Detail Items/Taxes 
window. Mo re ...

To open the Detail Items/Taxes window:

 a. Select a detail on the detail entry table on the Return tab.

 b. Press F9 or click Item/Tax.

 11. Click the Taxes tab to check the tax totals. You can change the tax class and tax amount for 
each jurisdiction, if necessary.

 12. Click the Totals tab to check the totals for the return.

 13. Click Post to post the return.

For more information, see "P/O Return Entry Screen   " (page 675).

After entering a return

 l Run Day End Processing in Inventory Control to:       

 l Update inventory records.

 l Create general ledger entries from returns.

 l Create the Returns Posting Journal of transactions you posted in Purchase Orders 
since the last time you ran Day End Processing.

 l Print the Returns Posting Journal to check the returns you posted.

 l Create credit notes from returns. When you create credit notes from returns, the credit notes 
complete the returns.

    Adding or Editing Details Using the Detail Items Taxes Screen

The Detail Items/Taxes screen contains the same fields as the detail entry     grid on the Return tab, plus 
additional tax-related fields that you use to view or change tax information for a selected detail. Mo re ...

Rather than displaying fields for all the details in tabular format,     this screen lets you see all the fields 
for a single detail on a separate    screen.

For more information, see "P/O Return Entry Detail Items/Taxes Screen   " (page 701).

Before You Start

 l Open the Return Entry Detail Items/Taxes screen:
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 1. Open Purchase Orders > P/O Transactions > Return Entry.

 2. Enter header information for the return, including the vendor number and, if you are 
creating a new return for an existing receipt, specify the receipt number.

 3. Select a detail line to credit or debit, and then press F9, or click the Item/Tax       button.

To add a detail in the Detail Items/Taxes screen:

Note: You can add detail lines only if you are entering a return without a receipt number.

 1. To add a detail, click the New  button next to the Line Number field. (If no other detail is 
displayed, press tab to accept the number in the Line Number field.)

 2. Enter information for the detail.                 

Note: You can change a tax class to another tax class that is assigned to the authority, and 
you can change the choice for the Tax Included option (if the tax authority permits tax-
included costs).

 3. Click Add.

To edit a detail using the Detail Items/Taxes screen:

 1. To open an existing detail you want to edit, enter a line number in the Line Number field, or 
select a line number using the navigation buttons beside the Line Number field.

 2. Type the information or changes for the detail, then click Save.

Note: To compare tax amounts for a return on the screen with the totals on the source document, 
check the Totals tab. For more information, see "P/O Return Entry Screen   " (page 675).

Entering a Return for a Cleared or Missing Invoice

You can post a return or credit note to an invoice number that has already      been cleared from your 
Purchase Orders system, or to an invoice that you     have not yet entered in your Purchase Orders 
system. Mo re ...

When you enter credit notes and debit notes to cleared or non-existing      invoices, you can enter and 
change all the default information that appears      from the vendor record and template code. You can 
also add as many detail     lines and additional cost details as you need.

Important! To credit an invoice that was deleted from Purchase Orders      but still exists in Accounts 
Payable, you must enter the original invoice     number to ensure that the credit is properly posted in 
Accounts Payable.
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To credit an invoice that no longer exists in Purchase Orders:

 1. Open Purchase Orders > P/O Transactions > Credit/Debit Note Entry.

For information on the fields on the Credit/Debit Note Entry screen, see "P/O Credit/Debit Note 
Entry Screen" (page 397).

 2. In the Document Number field, enter the credit note number (issued by the vendor), and then 
press the Tab key.

 3. In the Vendor Number field, type the vendor number or use the Finder to select it.

 4. Accept Credit Note as the document type, and then fill in general (header) information for the 
credit note on the Credit Note tab, as follows:

 a. In the From Document field, select Invoice.

 b. In the Invoice Number field, type the number of the invoice you are crediting. If you do 
not know the number, leave the field blank.

Note: If the invoice still exists in Accounts Payable, you must use the correct invoice 
number to properly credit the invoice.

 c. In the Credit Note Date field, enter or select the date for the credit note.

 d. In the Posting Date field, enter or select the date to which the credit note should be 
posted in the general ledger. (The posting date you enter determines the entry in the 
adjacent year/period field.)

 e. In the Credit Note Total field, enter the total amount of the credit note.

 f. If the original invoice was job-related, select the Job Related option.

 g. Enter a description and an optional reference for the credit note.

 5. Tab into the detail entry table or click the table, and then enter credit note details, as follows:

Tip: You may have to press the Insert key to start a new line.

 a. Double-click the Item Number field, and then type an item number or a miscellaneous 
charge code. (If this is a job-related credit note, you have to enter the contract and job 
information before you can choose the item.)

You can also click the Item Number column heading to look up item numbers.

Note: If you are using a scanner, click in the Item Number field before scanning the 
bar code.

 b. Use the tab key to move through the columns on the screen. Or, you can click the 
Item/Tax... button or press F9 to display an entry screen for adding items.
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 6. Use the remaining tabs, as necessary, to complete the information for the credit note.

 l To add optional field information to this credit note, click the Optional Fields tab.

 l To change currency exchange rates in a multicurrency system, click the Rates tab.

 l To check the totals for the credit note, or to add an extended comment, click the Totals 
tab.

 7. When you have finished, click Post to post the credit note.

168Sage 300 2021 Purchase Orders User's Guide



Credit/Debit Notes
Enter, export, and post credit and debit notes to credit or debit vendor accounts.

About Processing Credit Notes and Debit Notes   

You can post credit notes that apply to existing and non-existing (cleared) returns and invoices, as 
well as credit notes that do not reference returns or invoices. You can post debit notes that apply to 
existing and non-existing invoices, or just to the vendor.

Credit notes and debit notes are completed when you post them. You cannot recall them after posting 
to make changes. When you create credit notes from returns, the credit notes complete the returns.

If you use the Keep Transaction History option, you can display posted credit notes and debit notes in 
the Credit/Debit Note Entry screen until you use the Clear History screen to clear them from Purchase 
Orders. If you do not keep transaction history, posted credit notes and debit notes are deleted during 
day-end processing (run in Inventory Control).

Effects on Inventory Control

Credit notes that apply to returns affect quantities and costs in Inventory Control only when the credit 
note adjusts returned quantities and costs.

If you adjust the returned quantities on a credit note, posting the credit note adjusts the quantity on 
hand for the location in Inventory Control for the difference between the quantity returned on the 
return and the quantity on the credit note.

If you adjust the return costs on a credit note, posting the credit note or running Day End Processing 
adjusts the item costs in Inventory Control and creates the appropriate general ledger journal entries.

When credit notes and debit notes are applied to invoices, the transactions affect item costs in 
Inventory Control, but they do not change item quantities.

Job-Related Credit Notes

Job-related credit notes generally arise from returns. They update Project and Job Costing quantities 
and costs only if the credit note differs from the posted return (which has already reduced the actual 
quantities and costs in WIP).

About Entering and Posting Credit and Debit Notes   

When you select an existing invoice for a credit note or debit note, or a return for a credit note, the 
information from the original document is displayed in the Credit/Debit Note Entry screen. Some of 
this information cannot be changed, such as:
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 l Vendor number.

 l Template code.

 l Currency (in multicurrency ledgers).

 l Key information from each detail line, such as the item number, location, and unit of measure.

Creating a Credit or Debit Note from an Invoice

If you are creating a credit note or debit note from an invoice, the quantities received from the invoice 
are displayed and you can either accept or change them. The unit and extended costs are displayed 
as zeros. 

You specify the credit or debit amount for the items you are crediting or debiting. You then delete 
details you are not crediting or debiting, or leave the amounts for them at zero.

Creating a Credit or Debit Note from a Return

If you are creating a credit/debit note from a return, the program displays the quantities returned and 
the unit and extended costs. 

If you have security rights to these fields, you can change the amounts, but you cannot delete detail 
lines. 

If the credit/debit pertains to a serialized or lotted item, you can allocate lot numbers and/or serial 
numbers when entering the note. For more information, see "Returning and Issuing Credit/Debit 
Notes for Serialized Items   " (page 188).

Entering Credits or Debits to Non-existing Invoices or Returns

When you enter credit notes and debit notes to cleared or non-existing invoices, you can enter and 
change all the default information that appears from the vendor record and template code. You can 
also add as many detail lines and additional cost details as you need.

Posting Credit Notes and Debit Notes   

During posting, the total of all details and taxes is compared to the document total you entered. The 
document is posted only if the two totals are the same.

Posting assigns the document number you entered and completes the credit note or debit note and 
any returns to which you posted credit notes. You cannot change or delete a credit note or debit note 
after posting it.

If the credit note affects item quantities, posting updates the quantities in Inventory Control.
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Job-Related Credit Notes

When you post a job-related credit note that differs from the posted return, Project and Job Costing 
quantities and costs are updated.

Keeping History and Reviewing Posted Credit Notes and Debit Notes

If you use the Keep Transaction History option, you can display posted credit notes and debit notes in 
the Credit/Debit Note Entry screen until you clear them from Purchase Orders. If you do not keep 
transaction history, the transactions are deleted during posting or day-end processing (depending on 
when you cost inventory).

About Entering Additional Costs on Credit Notes and Debit Notes   

If you are creating a credit note from a return, the additional cost details for the primary vendor are 
displayed from the originating receipt, if any. If you are creating a credit note or debit note from an 
invoice, the additional cost details are displayed from the invoice. The additional cost amount appears 
as zero and you enter the amount to be credited or debited. You cannot change the additional cost 
code, proration and reproration methods, or the expense and return general ledger accounts.

You can add new additional costs on credit notes and debit notes. If you do this, you must select No 
Proration as the proration method for each new additional cost, so that the cost is expensed to a 
general ledger account. If you select any other proration method, you cannot post the credit note or 
debit note.

Entering a Credit or Debit Note for a Return or Invoice

If you issue a credit note for an existing Purchase Orders invoice, all the details of the invoice are 
displayed when you enter the invoice number. If there are errors on the invoice, the lines containing 
the errors are omitted and messages explain the errors. Mo re ...

When you enter an existing invoice number, the program displays all detail lines from the invoice so 
you can select details to credit. All item lines display the default credit type (Items Returned to 
Inventory). If you want to credit the entire invoice, click the Post button to post the credit note.

Before You Start

 l Post any invoices or returns for which you are being credited or debited.

 l Make sure you have complete information for each transaction. Once you post a credit note or 
debit note, it is completed, and you cannot edit it.

 l Find out the credit note or debit note number to use.
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To credit/debit a return or invoice:

 1. Open Purchase Orders > P/O Transactions > Credit/Debit Note Entry.

For information on the fields on the Credit/Debit Note Entry screen, see "P/O Credit/Debit Note 
Entry Screen" (page 397).

 2. In the Document Number field, enter the credit note number (issued by the vendor), and then 
press the Tab key.

 3. In the Vendor Number field, type the vendor number or use the Finder to select it.

 4. Use the fields on the Credit Note tab to fill in general (header) information for the credit note, as 
follows:

 a. In the Document Type field, select Credit Note or      Debit Note.

 b. In the From Document field, select Invoice or Return (if you are entering a credit note).

 c. Type the return or invoice number from which you are creating the credit note or debit 
note, or use the Finder to select it. The program displays information from the original 
document. Mo re ...

If the return or invoice has been cleared from Purchase Orders, you will have to add all 
item details and additional costs for the credit note or debit note, and then match the 
credit note or debit note to the invoice in Accounts Payable. If a message appears stating 
that the document does not exist, click Close to continue.

 d. In the Credit/Debit Note Date field, enter or select the date for the credit note.

 e. In the Posting Date field, enter or select the date to which the credit note should be 
posted in the general ledger. (The posting date you enter determines the entry in the 
adjacent year/period field.)

 f. In the Credit/Debit Note Total  field, type the total amount of the credit note or debit note. 
Mo re ...

If you are entering a credit note from a return, the program displays the total from the 
return.

If you are entering a credit or debit note for an invoice, the program displays a zero total.

Note: The amount in this field must match the total displayed on the Totals tab before 
you can post this document.

 g. You can also specify the vendor payment location and change the vendor account set 
(to change the Accounts Payable control accounts).

 h. Enter a description and optional reference for the document.

 i. Tab into the detail entry table, and then follow these steps to add or edit the type of 
details required:
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If this is a credit note for a return.

Note: You can delete lines that do not appear on the credit note, and you can change 
item descriptions. You cannot add detail lines.

 i. Adjust the quantities being credited, if necessary. You can also adjust the cost 
and discount fields.

By default, the program displays the quantities and costs from the return.

 ii. Use the Tab key to move through the remaining columns on the screen.        

Alternatively, you can click the Item/Tax button or press F9 to display an entry 
screen where you can change the item tax status.

You can change the weight UOM, unit weight and extended weight, as well as the 
sales order number, comments, manufacturer's item number, and optional fields. For 
information on other detail fields, see "P/O Credit/Debit Note Entry Screen" (page 
397).

If this is a credit/debit note for an invoice.

Note: You can delete lines that do not appear on the credit/debit note, and you can 
change item descriptions. You cannot add detail lines.

 i. Adjust the quantities being credited/debited.

By default, the program displays the quantities from the invoice and a zero cost.

 ii. You must enter the amount of the credit/debit for each detail line.

You can also enter discount percentages or amounts that apply to the credit/debit 
amounts.

Note: The costs you enter are the amounts being credited or debited. They are not 
new invoice amounts.

 iii. Use the Tab key to move through the remaining columns on the screen. 

Alternatively, you can click the Item/Tax button or press F9 to display an entry 
screen where you can change the item tax status.
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You can change the weight UOM, unit weight and extended weight, as well as the 
sales order number, comments, manufacturer's item number, and optional fields. For 
information on other detail fields, see "P/O Credit/Debit Note Entry Screen" (page 
397).

If the return or invoice has been cleared, and you need to add detail 
lines.

Note: You may have to press the Insert key to start a new line.

 i. Enter the number of the item that you are crediting or debiting, or choose it from 
the Finder.

 ii. Select the location being credited or debited.

 iii. Enter the item quantities being credited/debited.

 iv. Enter the cost being credited or debited for each item detail line.

You can also enter discount percentages or amounts that apply to the credit/debit 
amounts.

 v. Use the Tab key to move through the remaining columns on the screen. 

Alternatively, you can click the Item/Tax button or press F9 to display an entry 
screen where you can change the item tax status.

You can change the weight UOM, unit weight and extended weight, as well as the 
sales order number, comments, manufacturer's item number, and optional fields. For 
information on other detail fields, see "P/O Credit/Debit Note Entry Screen" (page 
397).

 5. Once you are finished editing the detail lines, check the information on the remaining tabs.  Mo re ...

 l To edit the vendor tax class or to edit the total tax amounts for each jurisdiction, click the 
Taxes tab.

 l To credit/debit additional costs or to add new additional costs to the credit/debit note, 
click the Additional Costs tab. (For more information, see "Entering or Editing Additional 
Costs on Credit and Debit Notes" (page 176).)

 l To add optional field information to this document, click the Optional Fields tab.

 l To change currency exchange rates (in a multicurrency system), click the Rates tab.

 6. Check the Credit/Debit Note Total field on the Totals tab, and make sure that it matches the 
credit/debit note from the vendor.
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Tip: You can also enter a long comment for the document on the Totals tab.

 7. Return to the Credit/Debit tab to check the Credit/Debit Note Total field.

 8. When you have finished entering information for the document, click Post.

    Adding or Editing Details Using the Detail Items Taxes Screen

The Detail Items/Taxes screen contains the same fields as the detail entry     grid on the Credit/Debit 
tab, plus additional tax-related fields that you use to view or change tax information for a selected 
detail. Mo re ...

Rather than displaying fields for all the details in tabular format,     this screen lets you see all the fields 
for a single detail on a separate    screen.

For more information, see "P/O Credit/Debit Note Entry Detail Items/Taxes Screen" (page 435).

Before You Start

 l Open the Credit/Debit Note Detail Items/Taxes screen:

 1. Open Purchase Orders > P/O Transactions > Credit/Debit Note Entry.

 2. Enter header information for the debit note or credit note, including the vendor number 
and, if you are crediting or debiting an existing invoice or return, specify the document 
number.

 3. Select a detail line to credit or debit, and then press F9, or click the Item/Tax       button.

To add a detail in the Detail Items/Taxes screen:

Note: You cannot add details to an invoice or a return for an existing   receipt.

 1. If an existing detail      is displayed, click the New icon beside the Line Number field.

 2. Type the information for      the detail, and then click Add.

To edit a detail using the Detail Items/Taxes screen:

 1. On the Detail Items Taxes screen, use the navigation buttons beside Line Number field to 
display the detail line you want to change.

 2. Make the changes you need.
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You can change a tax class to another tax class that     is assigned to the authority, and you can 
change the choice for the Tax    Included option (if the tax authority permits tax-included costs).

Note: You can change item details only until you    post the credit note or debit note.

 3. Click Save.

 4. When you are finished, click the Close button or press the F9 key to return to the Credit/Debit      
tab.

Entering or Editing Additional Costs on Credit and Debit Notes

You can add new additional costs on credit notes and debit notes, but      you must select No Proration 
as the proration method, charging the expense to a general ledger account. Mo re ...

When you create a credit note from a return, if the original receipt included any additional costs, the 
details for the primary vendor are displayed.

When you create a credit note or debit note from an invoice, the additional cost details from the 
invoice are displayed.

Initially, additional cost amounts are zero. You enter the amount to be credited or debited. 

Note: You cannot change the additional cost code, proration and reproration methods, or the 
expense and return general ledger accounts. 

To adjust existing additional costs:

 1. Open Purchase Orders > P/O Transactions > Credit/Debit Note Entry.

 2. On the Credit/Debit tab, specify the type of document and the return or invoice for which you 
are creating the credit note or debit note.

 3. In the detail section, enter the return or invoice quantities, along with cost differences and 
quantities.

 4. Click the Additional Cost tab to display the additional cost details.

Note: If     this is a credit note for a return, the program displays additional     cost details for the 
primary vendor only.
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 5. Select the additional cost detail that you want to adjust, and then:    

 a. Click the Amount field.

 b. Enter the credit or debit amount for the additional cost. 

Note: You cannot change the proration      methods or accounts.

 c. Tab to the end of the detail line to enter a reference and comment.

 6. To change the detail     tax class for a selected additional cost:

 a. Click the Cost/Tax      button or press F9 to open the Detail Costs/Taxes screen.

 b. Change the detail      tax class, and then click the Calc. Taxes button to recalculate the tax.

 7. To change the total tax     amount for the credit note or debit note (including the tax for the 
additional    cost):

 a. Click the      Taxes tab.

 b. In the Tax Amount      column, enter the total tax       amount to credit or debit for each tax 
authority.

To add new additional costs to debit notes:

 1. On the Additional Costs      tab, click the detail entry table, and then press the Insert key to start a 
new line.

 2. Click the Additional      Cost column heading to display the Finder.

 3. Select the new additional      cost from the Finder, and then enter information for the additional 
cost detail as follows:

 a. In the Amount      field, enter the amount of the additional charge.

 b. Select No Proration       as the proration method. 

 c. In the Expense       Account field, specify the expense account to charge.

 d. Use the Reference      and Comments fields to provide more information about the cost.

 4. To change the detail     tax class for the new additional cost:

 a. Select the      additional cost on the Additional Cost entry grid.

 b. Click the Cost/Tax      button or press F9 to open the Detail Costs/Taxes screen.

 c. Change the detail      tax class, and then click the Calc. Taxes button to recalculate the tax.

 5. To change the total tax     amount for the credit note or debit note (including the tax for the 
additional    cost):
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 a. Click the      Taxes tab.

 b. In the Tax Amount      column, enter the total tax       amount to credit or debit for each tax 
authority.

 6. To      check the additional cost totals and tax totals, click the Totals tab.

 7. Click Post.   

    Distributing Additional Costs to Multiple Receipts on a Debit Note

You can adjust existing additional costs on a debit note for an invoice that included multiple receipts. 
You cannot automatically prorate the costs to multiple receipts. Instead, you identify the amount to 
distribute to each receipt on the debit note.

You can also add new additional costs to a debit note, but you cannot prorate them. You must identify 
a general ledger expense account to charge for the new additional cost.

To distribute an additional cost on a debit note for multiple    receipts:

 1. Open Purchase Orders > P/O Transactions > Credit/Debit Note Entry.

 2. Enter header information for the debit note, including the new document number, the vendor 
number, and the invoice number for which you are creating the debit note.

 3. Click the Additional Costs tab.

Any additional costs entered with the invoice appear on the tab, but the amounts are zero. You 
must enter the adjustment amount, as follows, for each additional cost you are adjusting:

 a. Select the additional cost you need to distribute to receipts.

 b. In the Amount      field, enter the amount of the additional cost.

 c. Click the Dist. Cost button to open the Cost Allocation screen.

 d. For each receipt number displayed, enter the amount you want to distribute to that 
receipt, if the correct amount is not already displayed. 

Note: To restore the default distribution, or to prorate the additional cost automatically 
to the receipts, click Redist.

 4. When you have      finished, click Close to return to the Additional Costs tab. 
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Project and Job Costing
Enter job-related transactions and manage related journal entries and additional costs.

About Job-Related Transaction Details  

If you use Project and Job Costing, Purchase Orders lets you flag transactions as job-related, so you 
can:

 l Track committed and actual quantities and costs by contract, project, and category (and 
resource, on a standard project).

 l Receive goods for a job rather than into inventory.

 l Update jobs in Project and Job Costing with billing information.

 l Create invoices with retainage amounts and information for Accounts Payable.

Note that if a transaction is job-related:

 l All transaction details must be job-related. You cannot mix job-related details and non-job-
related details in the same transaction.

 l Different fields appear for the details to let you enter job-related information.

 l For each transaction detail, you must specify:     

 l A contract.

 l A project.

 l Depending on the project type, the project category, cost class, and resource for the job.

Note: If you use different terms than "Contract," "Project," and "Category" in Project and Job 
Costing, the program displays those field names instead.

 l If the transaction uses retainage accounting, you must specify the holdback percentage and 
retention period for each transaction detail.              

You specify the retainage rate (for a multicurrency transaction) and terms for receipts, 
invoices, and debit/credit notes on the Retainage tab.

Purchase Orders

 l If the purchase order is being created from multiple requisitions, all requisitions must be of the 
same type: either job-related or non-job-related.
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Receipts and Invoices

 l Receipt entries that originated with purchase orders will update the actual and committed 
quantities and costs in Project and Job Costing.

 l Invoice Entry will only send transactions to Project and Job Costing if the invoice creates an 
adjustment to one of the following:

 l Receipt for the quantity received.

 l Item costs.

 l Additional costs.

 l Billing rate.

 l Job-related returns update:

 l Actual quantities and costs for contracts in Project and Job Costing.

 l Appropriate work-in-progress (or expense) accounts.

 l Credit notes that apply to returns affect quantities and costs in Inventory Control and quantities 
in Project and Job Costing only when the credit note changes the returned quantities and costs.

Additional Costs

 l If you prorate additional costs manually, you can assign costs to as many different jobs as you 
wish.

 l If you prorate additional costs by cost, weight, or quantity, all item details for the transaction will 
be affected.

 l You can allocate additional costs to several contracts by adding separate additional cost detail 
lines for each job and selecting No Proration as the proration method.

Changing Invoices after posting

Important! 
Do not make changes in Accounts Payable to job-related invoices that originated with Purchase 
Orders.

Accounts Payable does not update Project and Job Costing when it posts invoices that originated 
with Purchase Orders, because Purchase Orders has already directly updated Project and Job 
Costing.

To change a job-related invoice that originated with Purchase Orders, do one of the following:

 l Process the changes in Purchase Orders.

 l Create an adjustment in Accounts Payable (which will update Project and Job Costing).
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About Converting Units of Measure for Committed and Actual Quantities

You must receive goods using the same units of measure that are used     in the estimates in Project 
and Job Costing. 

Purchase Orders does not     convert different units of measure when it updates PJC with quantities    
from receipts or invoices.

Example: 
This example shows what can happen it you receive goods using    different units of measure.

Assume that:

 l Your estimate includes      70 items that cost $10 each.

 l Shipment 1 includes 50      items, packed in 5 boxes.

 l Shipment 2 includes 20      items, packed individually.

Shipment Material Category Quantity Conversion Factor Cost

1 Item 1001 5    boxes 10 $500

2 Item 1001 20    items 1 $200

When Project and Job Costing is updated with the quantities and costs     of these shipments, the 
actual quantity and cost for item 1001 appears    as follows:

Shipment Material Category Quantity Conversion Factor Cost

1 and 2 Item 1001 25 None $700

About Expensing Job-Related Additional Costs   

If job-related additional costs are expensed rather than prorated, you can specify the contract, 
project, category, cost class, resource, billing type, billing rate (if appropriate), currency, A/R item 
number, and unit of measure for the additional cost.

Depending on the category, you may choose to calculate overhead or labor burden for the additional 
cost. Overhead and labor are calculated by Project and Job Costing and passed back to Purchase 
Orders when you post the receipt.

Expensed additional costs are assigned their own transaction numbers, because they are sent to 
Project and Job Costing as separate transactions.
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Note: Once you post a receipt, you cannot change the billing type, billing currency, A/R item 
number, A/R unit of measure, overhead calculation, or labor calculation for additional costs.

About Job-Related Transactions

All job-related transactions in Purchase Orders must reference a particular contract, project, 
category, and (depending on the item and type of job) resource. Each time you post job-related 
transactions,   Purchase Orders updates the job information and work-in-progress accounts for the 
job.

When Purchase Orders sends transactions to Project and Job Costing, it updates:

 l Committed quantities and committed costs for the job's contract, project, category, and 
resource (posted with the original P/O).

 l Actual quantities and costs in Job Costing (posted with receipts, invoices, returns, credit   notes 
and debit notes).

 l Billing information (sent as a billing adjustment transaction). Billing transactions are primarily 
generated by receipts, but they can also arise from invoices, returns, and credit/debit notes.

Purchase Orders

Any of the following types of changes in a Purchase Order generate transactions for Project and Job 
Costing:

 l Changing quantities.

 l Changing an item cost.

 l Adding new lines to a Purchase Order.

 l Deleting a line or a Purchase Order.

 l Changing exchange rates (changes functional currency amount, and so will change amounts 
in Project and Job Costing).

 l Changing taxes (change in cost).

Retainage Accounting

If you use retainage accounting, you can enter a retainage percentage and a retention period on the 
Retainage tab for receipts, invoices, returns, and credit/debit notes.

Each detail line on a P/O transaction can have different retainage percentages and retention periods.

Note: You must set the retainage accounting option in Accounts   Payable to use retainage 
accounting in Purchase Orders.
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Journal Entries for Job-Related Receipts

The usual difference between job-related and non-job-related journal entries is that items received 
for projects do not go into inventory. Instead, the value of the item goes to a Work-In-Progress 
account specified for the contract in Project and Job Costing.

Example: 

G/L Entry for Non-job-related Receipt Dr Cr

Debit I/C Control account X  

Credit   A/P Clearing account  X

Example: 

G/L entry for Job-related   Receipt Dr Cr

Debit WIP/Cost of Sales X  

Credit   A/P Clearing account  X

For non-inventory items, Purchase Orders provides an option to create general ledger entries during 
posting in P/O, or later when you post invoices in A/P.

For expensed additional costs, Purchase Orders always creates general ledger entries for job-related 
documents during posting, although you can generate the entries in Accounts payable for non-job-
related receipts.

Posting a job-related receipt for costs or additional costs will produce transactions to update actuals in 
Project and Job Costing, as will posting adjustments to a job-related receipt to change any of the 
following:

 l Quantity received

 l Cost

 l Additional cost or amount

 l Tax

 l Exchange Rate

Note: Purchase Orders does not create entries for expensed taxes   for Project and Job Costing.
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Additional Cost Lines and Proration

If you add an additional cost to a receipt, you can choose to prorate by cost, weight, or quantity, or you 
can prorate manually. If you prorate, all items are affected. If you want to assign portions of a cost to 
different projects or categories, you must enter separate lines for each portion of the cost and prorate 
manually.

Overhead / Labor calculations

Project and Job Costing calculates labor and overhead costs for items and passes the results back to 
Purchase Orders. Purchase Orders creates the necessary journal entries.

Overhead is usually calculated on the discounted extended amount.

If you have additional costs (such as shipping costs), you can specify that you don’t want overhead or 
labor on the additional cost. (If you expense the additional cost, the program lets you specify whether   
overhead or labor is calculated.)

Job-Related Invoices

If a receipt is invoiced without changes to quantities and costs, and without any additional costs, Job 
Costing will be unaffected by the invoice.

If an invoice includes an adjustment to the receipt—such as a change to the cost, quantity, or billing 
rate—Purchase Orders sends transactions to Project and Job Costing. These transactions do not 
affect the G/L or A/P.

For example:

 l If you change the billing rate, Purchase Orders generates a new transaction for the difference 
between the old billing rate and the new billing rate.

 l If you also change quantities, Purchase Orders will also create a billing adjustment transaction 
for the quantity difference.

 l If the receipt originated from a purchase order and you change the quantity outstanding, 
Purchase Orders will update the committed quantities and costs in Project and Job Costing.

Important! Do not change P/O invoices in Accounts   Payable. Job-related invoices transferred to 
Accounts Payable from Purchase Orders do not update Project and Job Costing when posted in 
Accounts Payable. Purchase Orders directly updates Project and Job Costing with invoice 
amounts.
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Job-Related Serialized Items or Items Assigned to Lots

You cannot add serialized items or items assigned to lots to job-related   requisitions, purchase orders, 
or receipts. 

If you use Serialized Inventory or Lot Tracking, and you use items or   serialized items or items 
assigned to lots in projects, you must order   these items with non-job-related purchase orders.

When the serialized or lotted items arrive, receive them into inventory,   and then use the Material 
Usage screen in Project and Job Costing to move   them from inventory to jobs.

About Changing Job-Related Invoices   

Important! 
Do not make changes in Accounts Payable to job-related invoices that originated with Purchase 
Orders.

Accounts Payable does not update Project and Job Costing when it posts invoices that originated 
with Purchase Orders, because Purchase Orders has already directly updated Project and Job 
Costing.

To change a job-related invoice that originated with Purchase Orders, do one of the following:

 l Process the changes in Purchase Orders.

 l Create an adjustment in Accounts Payable (which will update Project and Job Costing).
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Serialized and Lotted Transactions
If you use Serialized Inventory and Lot Tracking, assign serial numbers and lot numbers to items that 
you purchase or return to the vendor.

About Lotted Inventory Items   

Lotted items are goods that have lot numbers assigned to them for tracking purposes. For example, a 
food distribution company can use lot numbers to record purchases and sales of unique batches of 
product.

Note: Lot numbers are used for tracking stock from the point of receipt through   to the point of sale, 
and can be used to track returned items from the   customer and back to the vendor.

Lot numbers are used to track groups of items. Unlike serial numbers, a lot number can be allocated 
to multiple items.

You may be prompted to assign lot numbers to items when performing the following transactions:

 l Receiving inventory purchased from a vendor and entering an invoice. For more information, 
see "Receiving and Invoicing Lotted Items" (page 189).

 l Returning stock back to a vendor and entering debit or credit notes. For more information, see 
"Returning and Issuing Credit/Debit Notes for Lotted Items" (page 190).

When assigning lot numbers in Purchase Orders, you are either generating new lot numbers or 
selecting from a pool of previously created numbers. The actual management and maintenance of lot 
numbers is performed using Inventory Control.

About Serialized Inventory Items   

Serialized items are goods that have serial numbers assigned to them for tracking purposes. For 
example, an electronics retailer can use serial numbers to record sales of inventory items that have 
warranty periods.

Note: Serial numbers are used for tracking stock from the point of receipt   through to the point of 
sale, and can be used to track returned items   from the customer and back to the vendor.

Serial numbers are used to track individual items, so each serial number must be unique to one 
specific item.

You may be prompted to assign serial numbers to items when performing the following transactions:
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 l Receiving inventory purchased from a vendor and entering an invoice. For more information, 
see "Receiving and Invoicing Serialized Items   " (page 187).

 l Returning stock back to a vendor and entering debit or credit notes. For more information, see 
"Returning and Issuing Credit/Debit Notes for Serialized Items   " (page 188).

When assigning serial numbers in Purchase Orders, you are either generating new serial numbers or 
selecting from a pool of previously created numbers. The actual management and maintenance of 
serial numbers is performed using Inventory Control.

Receiving and Invoicing Serialized Items   

When you receive serialized items from vendors in Purchase Orders, the program prompts you to 
assign serial numbers.

Note: Serial numbers are used for tracking stock from the point of receipt   through to the point of 
sale, and can be used to track returned items   from the customer and back to the vendor.

You use the same procedure when entering a vendor invoice, except you start with the Invoice Entry 
window instead of the Receipt Entry window.

You can assign serial numbers when you receive serialized items, or when you create the invoice for 
the items, provided the item does not use the serial costing method and the Allow Serial Quantity To 
Be Different From The Quantity In The Entries option is selected on the I/C Items screen.

Generally, there are not big differences in assigning numbers during receipt or invoicing. However, 
there can be an impact when using the Inventory Control Serial Inquiry report, because this report 
displays only the net change from the time of receipt to invoice, not the original receipt cost..

Example: If you enter the cost of a serialized item as two dollars during receipt entry, but you don't 
assign the serial number. Then, you use the P/O Invoice Entry window to enter the serial number, 
and you change the cost of the item to three dollars. The value that appears on the I/C Serial 
Number Inquiry for that transaction is one dollar.

To assign serial numbers when receiving serialized items:

 1. Open Purchase Orders > P/O Transactions > Receipt Entry.

 2. Process the receipt. For more information, see "Entering Receipts" (page 134).

 3. Do one of the following:     

 l Enter a value in the Quantity Received field, and then press either Enter or Tab.

 l If the correct number already appears in the Quantity Received field, and you just want to 
change a serial number already assigned, click the Quantity Received column header.
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Note: You cannot partially invoice receipts of serialized items.

The Serial Numbers Generation/Allocation window appears.

 4. Either accept or edit the default value that appears in the Next Serial Number field. The value 
in this field is the starting point for the serial numbers you will assign.

 5. Assign serial numbers in one of the following ways:              

 l Automatically. Click Auto-Gen. to generate serial numbers for the quantities you 
require, starting with the value in the Next Serial Number field.

 l Manually. Click Add for each serial number you need to create. Edit the Next Serial 
Number value if you don't want to assign the next sequential number.

Note: In both cases, assigned serial numbers appear in the details table. You can select 
entries in the table to change serial numbers as required.

 6. Click Close.              

Note: If the Remaining value is not zero, there are still serial numbers to assign. You cannot 
close the window until the Remaining value is zero.

After closing the Serial Numbers Generation/Allocation window, you can complete and post the 
transaction.

Returning and Issuing Credit/Debit Notes for Serialized Items   

Purchase Orders prompts you to allocate serial numbers when you return serialized items to vendors.

Note: Serial numbers are used for tracking stock from the point of receipt   through to the point of 
sale, and can be used to track returned items   from the customer and back to the vendor.

You use the same procedure when creating a debit or credit note for a vendor, except you start with 
the Credit/Debit Note Entry window instead of the Return Entry window.

To allocate serial numbers to returned serialized items:

 1. Open Purchase Orders > P/O Transactions > Return Entry.

 2. Process the return. For more information, see "Entering Returns   " (page 161).

 3. Do one of the following:     

 l Enter a value in the Quantity Returned field for the serialized items you want to return, 
and then press either Enter or Tab.
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 l If the correct number already appears in the Quantity Returned field, and you just want to 
change a serial number already allocated, click the Quantity Returned column header.

The Serial Numbers Allocation window appears.

Note: If you selected a Receipt Number in the Return Entry window, only serial numbers 
from that receipt appear in the Serial Numbers Allocation window.

 4. If you did not select a Receipt Number in the Return Entry window, enter the serial number 
manually, or select it using the Finder.

 5. To return all the serial numbers that appear in the details grid, click Return All.

Note: 
 l The Return All button in the Return Entry window returns all items on the entire invoice.

 l The Return All button on the Serial Numbers Allocation window returns all items for the 
specific detail line previously selected in the Return Entry window.

 6. Allocate serial numbers in one of the following ways:     

 l Automatically. Select the Auto-Allocate From option, enter or select a value in the field 
that appears, and then click Auto-Alloc.       

Available serial numbers appear in the grid.

 l Manually. Enter serial numbers manually or select them using the Finder.

 7. Click Close.

Note: If the Remaining value is not zero, there are still serial numbers to allocate. You cannot 
close the window until the Remaining value is zero.

After closing the Serial Numbers Allocation window, you can complete and post the transaction.

Receiving and Invoicing Lotted Items

When you receive lotted items from vendors in Purchase     Orders, the program prompts you to assign 
lot numbers.

You use the same procedure when entering a vendor invoice,     except you start with the Invoice Entry 
screen instead of the Receipt Entry    screen.

Note: Lot numbers are used for tracking stock from the point of receipt through   to the point of sale, 
and can be used to track returned items from the   customer and back to the vendor.
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To assign lot numbers when receiving lotted items:

 1. Open Purchase Orders > P/O Transactions > Receipt Entry.

For more information, see "P/O Receipt Entry Screen" (page 561).

 2. Create a new receipt,      entering header information as usual. (For detailed instructions on 
entering receipt transactions, see "Entering Receipts" (page 134).) 

Important! Lot numbers are stored and displayed by location. Therefore,    you must specify a 
location before entering the quantity.

 3. Enter a value       in the Quantity Received field, and then press either the Enter key or      the Tab 
key to display the Serial/Lot Numbers Generation screen.

If the correct number already appears in the Quantity     Received field, and you just want to change a 

lot number already assigned,    click the Zoom  button in the Quantity Received column heading.

Note: You cannot    partially invoice receipts of lotted items.

 4. Specify the number of lots and quantities in       each lot using the Make X Lots OR Each Lot Has 
fields.

 5. If       desired, edit the default value that appears in the Next Lot Number field.       The value in this field 
is the starting point for      the lot numbers you will assign.

 6. Assign      lot numbers automatically or manually, as follows:

 l To generate lot numbers automatically, click the Auto Gen button. The lot numbers are 
generated sequentially starting with the value in the Next Lot Number field.

 l To assign lot numbers yourself (for example, if you do not want them to be sequential), 
edit the       Next Lot Number value, and then click the Add button       for each lot number you 
need to create.

 7. Click       Close. 

Important! If the Remaining value is not zero, there are still lot numbers to assign. You 
cannot close the screen until the Remaining value is zero.

After assigning lot numbers

After closing the Serial/Lot Numbers Generation screen, you can complete    and post the transaction.

Returning and Issuing Credit/Debit Notes for Lotted Items

Purchase Orders prompts you to allocate lot numbers when you return lotted items to vendors.
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Note: Lot numbers are used for tracking stock from the point of receipt through   to the point of sale, 
and can be used to track returned items from the   customer and back to the vendor.

You also use the following procedure when entering a debit note or a credit note for a vendor, except 
that you start from the Credit/Debit Note Entry screen instead of the Return Entry screen.

To assign lot numbers to returned lotted items:

 1. Open Purchase Orders > P/O Transactions > Return Entry.

For more information, see "P/O Receipt Entry Screen" (page 561).

 2. Enter the return as usual, with the following differences:

 a. After entering a value in the Quantity Returned field for the lotted items you want to 
return, press the Enter key or the Tab key to display the Serial/Lot Numbers Allocation 
screen. 

If the correct number already appears in the Quantity Returned field, and you just want 
to change a lot number already allocated, click the Zoom button in the Quantity Returned 
column heading.

Note: If you selected a receipt number, only the lot numbers from that receipt are listed in 
the Serial/Lot Numbers Allocation screen. If you did not select a receipt number, enter the 
lot number manually or select it using the Finder.

 b. To return all the lot numbers that appear in the table, click Return All. "Ye"s appears in 
the Returned column for all items in the table. 

Note: The Return All button in the Return Entry screen returns all items on the entire 
invoice, while the Return All button on the Serial/Lot Numbers Allocation screen returns 
only items for the selected detail line.

 c. Allocate lot numbers automatically or manually, as follows:

 l To generate lot numbers automatically, click the Auto-Allocate From option, and 
then enter or select a value in the field that appears. Click the Auto-Alloc button to 
allocate lot numbers sequentially starting with the value in the Next Lot Number 
field.

 l To allocate lot numbers individually, select them from the Finder or type the 
numbers.
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 d. Click Close. 

Important! If the Remaining value is not zero, there are still lot numbers to assign. You 
cannot close the screen until the Remaining value is zero.

After assigning lot numbers

After closing the Serial/Lot Numbers Allocation screen, you can complete    and post the transaction.
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Chapter 3: Periodic Processing in 
Purchase Orders

At the end of each period, perform procedures such as creating batches and clearing history.

About Periodic Processing in Purchase Orders
This topic outlines tasks you might follow as part of your weekly, bi-weekly, or monthly procedures, 
and tells you how to use Purchase Orders to accomplish these tasks.

Use the Create Batch screen (unless you create transactions during posting or day end processing) 
and Clear History screen to complete processing and to clear out obsolete data and records at the 
end of your accounting periods.

At each period end, you should:

 l Create any new purchase orders you wish to process in the period.

Use the Purchase Order Entry screen and the Create Purchase Orders From Requisitions, 
Create Purchase Orders From I/C, and Create Purchase Orders From O/E screens.

 l Post other transactions that apply to the period.

Use the Requisition Entry, Purchase Order Entry, Receipt Entry, Invoice Entry, Return Entry, 
and Credit/Debit Note Entry screens.

 l Print the Purchase Order Action and Aged Purchase Orders reports to identify purchase orders 
that require action.

Use the Purchase Order Action and Aged Purchase Orders screens from the Analytical 
Reports folder to print the reports.

 l Print the G/L Transactions report, then create general ledger transactions (if you do not use the 
option to create general ledger transactions during posting or Day End Processing). Process 
the batches in General Ledger, if you use it, or post them manually to another general ledger.
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Choose the G/L Transactions icon from the Analytical Reports folder to print the report. Choose 
the Create Batch screen from the Periodic Processing folder to create the general ledger 
transactions.

 l Clear the paid transactions, posting journals, and statistics that you no longer need.

Choose the Clear History screen from the Periodic Processing folder to clear this information.

Sage 300 will mark reports as printed no matter which print destination you use when you print 
posting journals.

 l If you use Purchase Orders as a stand-alone program (without Inventory Control), use the 
Delete Inactive Records screen to delete inactive item and account set records from your 
Purchase orders system.

Choose the Delete Inactive Records icon from the Periodic Processing folder and specify the 
types and ranges of records you want to clear.

Day End Processing of P/O Transactions
Run Day End Processing to update your data in Purchase Orders, Inventory Control,    Accounts 
Payable, and Project and Job Costing. This keeps your audit trail and reports up to date.

About Day End Processing

When you post Purchase Orders transactions that affect item quantities,     the program immediately 
updates item records and quantities on purchase    order in Inventory Control, if you are using it.

Most     Day End Processing tasks are performed during posting if Inventory Control uses     options to cost 
items and    create subledger transactions and audit information during posting. However, you must run 
Day     End Processing to completely update your Purchase Orders, Inventory Control,    Accounts 
Payable, and Project and Job Costing data.

Tip: You should run Day End Processing as part of your daily routine, to     keep your audit trail and 
reports up to date. You can run Day End Processing    as many times a day as you want.

Note: If you use Inventory Control, you run Day End Processing     from the Inventory Control folder. If 
you do not use Inventory Control,     you run Day End Processing from the Purchase Orders folder. 
(For more     information about running Day End Processing in a stand-alone system,     see "P/O Day 
End Processing Screen   " (page 277).)
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Assign the Default Cost Expense Account

Before running Day End Processing, you must assign the general     ledger account code for the default 
cost expense account on the P/O     Options screen. 

Day End Processing will display an error message and stop    processing if the account is not 
designated.

Tasks Performed by Day End Processing

Each time you run Day End Processing, the program:

 l Processes all the transactions      you have posted since the last time you ran Day End 
Processing. 

 l Creates a batch of Accounts       Payable invoices, credit notes, and debit notes from posted 
Purchase Orders       transactions, using the next available Accounts Payable batch number.      

 l Creates general ledger       transactions from posted receipts, returns, invoices, credit notes, and      
debit notes. 

 l Optionally posts Accounts      Payable and General Ledger batches in the A/P and G/L modules.

 l Updates costs in Inventory       Control for non-job-related invoices, if you use Inventory Control 
(unless      you chose the Inventory Control option to do costing during posting).

 l Updates quantities and      costs in Project and Job Costing for job-related invoices.

 l Activates and posts future       purchase orders that have reached their purchase order date. When 
Day      End Processing is complete, you can print the new POs.

 l Clears requisitions that      have reached their expiration dates.

 l Deletes completed transactions      if you do not keep transaction history.

 l Updates statistics and       history in both Purchase Orders and Inventory Control (if you keep 
history      and statistics).

 l Creates the receipt, invoice,       return, and credit/debit note posting journals in Purchase Orders 
for      the new day-end sequence number. 

Important!  The     time it takes to complete day-end processing varies according to your     computer 
and the number of transactions you entered since the last time     you ran Day End Processing. We 
recommend that you run Day End Processing     when you do not need to use your computer for other 
tasks. You might find    it best to run it overnight.

About Locked Fiscal Periods

Note that if a fiscal period is locked for General Ledger but not for   Purchase Orders, you can create 
batches for General Ledger during posting,   during Day End Processing, or using the Create G/L 
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Batch icon (depending   on your system and settings). When you try to post transactions to a locked   
period in General Ledger, however, the transactions will be placed in   an error batch. You can avoid 
this situation if you create and post General   Ledger batches for outstanding Purchase Orders 
transactions before locking the period for General Ledger.

Similarly, you can create transactions for Accounts Payable from Purchase   Orders transactions, but 
you cannot post them to a period that is locked   for Accounts Payable.

About Day End Processing of Job-Related Transactions

Project and Job Costing actual and committed costs are updated during     Day End processing with the 
total cost, plus the allocated and expensed     taxes that are payable when a receipt is invoiced 
(excludes tax on retainage).

Project and Job Costing is also updated with taxes on retainage amounts    when the retainage is 
invoiced in Accounts Payable.
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Example: 
Assume a series of transactions for $440.00 cost, plus $27.72     in expensed taxes,    for a total of 
$467.72.

The following transactions are sent from     to Project and Job Costing after you post a purchase order 
and run Day    End Processing:

 Committed Costs Actual Costs

Extended cost $470.80 $0.00

Labor amount 0.00 0.00

Overhead amount 0.00 0.00

Total cost $470.80 $0.00

The following transactions are sent to Project and Job Costing    after you post a receipt and run Day 
End Processing:

 Committed Costs Actual Costs

Extended cost $3.08 $467.72

Labor amount 0.00 0.00

Overhead amount 0.00 0.00

Total cost $3.08 $467.72

The 3.08 committed amount is the expensed portion of tax for the retainage.     When the retainage is 
invoiced in Accounts Payable, the committed and    actual costs are updated for the retainage tax 
amount. 

About Day End Processing of Credit Notes and Debit Notes

Day End Processing performs the following tasks when processing credit notes and debit notes:

Note: If     you cost inventory during posting instead of during Day End Processing,     almost all Day End 
processing tasks take place when you post    transactions.

 l When processing credit notes that include    changes to costs, updates item costs in Inventory 
Control.
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 l Adds information from each credit     note and debit note to the invoice batch that is created for     
Accounts Payable. Mo re ...

If a credit note is applied to an invoice, the invoice number appears     in the Apply To field when 
you display the transaction in Accounts Payable's    Invoice Entry screen.

Note: General ledger transactions are created when you    post the credit and debit notes in 
Accounts Payable. For information on the general ledger accounts affected by credit notes     
and debit notes, see "About General Ledger Journal Entries Generated by Purchase Orders" 
(page 79).

 l Creates the Credit/Debit Note Posting Journal and     the general ledger transactions for the G/L 
Transactions report, if you     print it in Purchase Orders.

 l If you keep transaction history, updates history and statistics     in Purchase Orders and Inventory 
Control. If you do not keep transaction    history, the program deletes all credit and debit notes.

About Day End Processing of Purchase Orders Invoices

Day End Processing performs the following tasks when processing P/O invoices:

Note: If     you cost inventory during posting instead of during Day End Processing,    almost all Day End 
processing tasks take place when you post transactions.

 l Creates and optionally       posts a batch of invoices in Accounts Payable, with a batch       type of 
Imported. Information for each invoice includes the remit-to location      and 1099 code and 
amount, if any.

 l Updates costs in Inventory      Control for non-job-related invoices, if you use Inventory Control.

 l Updates quantities and      costs in Project and Job Costing for job-related invoices.

 l If you keep history and      statistics, updates history and statistics with invoice data.

 l Creates the Invoice Posting       Journal that lists details of the invoice transactions and the 
corresponding      general ledger distributions.

Note: The general ledger transactions for invoices     are created in Accounts Payable when the 
invoice batch is posted in Accounts    Payable.

 l If you posted invoices       with new prorated additional costs, Day End Processing prorates the 
costs       to the items on the receipt, updates costs in Inventory Control, and creates      adjusting 
entries for your general ledger.

You must run Day End Processing to:

 l Delete invoices from Purchase      Orders if you do not keep transaction history.

 l Activate future purchase      orders.
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About Day-End Processing of Purchase Orders

Day End Processing performs the following tasks when processing purchase orders:

Note: If     you cost inventory during posting instead of during Day End Processing,    almost all Day End 
processing tasks take place when you post transactions.

 l Creates active purchase       orders from future purchase orders that have reached their activation      
dates.

 l Updates quantities on       purchase order in Inventory Control (that can also be viewed in Order      
Entry).

 l Updates committed quantities      in Project and Job Costing for job-related purchase orders.

 l If you keep history and       statistics, updates purchase order history and updates the number of 
purchase       orders for the year and period in the Purchase Statistics screen and on      the Purchase 
Statistics report.

 l If you do not keep transaction       history, deletes completed purchase orders. (Posting deletes the 
purchase      orders if you cost items during posting).

About Day End Processing of Receipts

Day End Processing performs the following tasks when processing P/O receipts:

Note: If     you cost inventory during posting instead of during Day End Processing,    almost all Day End 
processing tasks take place when you post transactions.

 l Inserts the item costs as the most recent costs in Inventory Control item records (unless you      
cost items when you post transactions). Mo re ...

For items using LIFO or FIFO costing, posting or Day     End Processing creates a new LIFO or FIFO 
bucket for the receipt, quantity,     and cost. For receipt adjustments, Day End Processing updates the 
buckets     created for the original receipt. If a bucket has been cleared, Day End    Processing posts any 
receipt adjustments to the offset bucket.

If an item is processed at more than one cost, posting     or Day End Processing uses the cost from the 
last detail processed for     an item as the most recent cost in the item record, unless the receipt    cost 
on the last detail is zero or a negative amount.

If the last item cost is zero, posting or Day End Processing     uses the last non-zero cost processed for 
the item, or if no other details    are processed for the item, does not change the most recent item 
cost.

 l Prorates any additional       costs posted with a receipt to the items on the receipt using the 
methods      you specified.
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 l Creates the Receipts Posting      Journal and general ledger transactions for the processed 
receipts (except for non-inventory items and expensed additional costs). Mo re ...

Day End Processing does not create general ledger entries     for non-inventory item details and 
additional cost details that you expense     rather than prorate, because these details are posted 
to general ledger     expense accounts, rather than to Inventory Control accounts. Journal entries     
for non-inventory items and expensed additional costs are created when    the transactions are 
posted in Accounts Payable.

If you adjust a receipt after running Day End Processing,     journal entries are created for the 
amount of the adjustment, including    additional costs, the next time you run day-end.

For more information about the general ledger accounts affected by receipts, see "About 
General Ledger Journal Entries Generated by Purchase Orders" (page 79).

 l Completes all receipt      details for vendors with invoices posted to the receipt.

 l Deletes completed receipts      if you do not keep transaction history.

 l Updates history and statistics       in Purchase Orders and Inventory Control, if you keep history 
and statistics.

About Day End Processing of Returns

Day End Processing performs the following tasks when processing P/O returns:

Note: If     you cost inventory during posting instead of during Day End Processing,    almost all Day End 
processing tasks take place when you post transactions.

 l Updates costs in Inventory      Control for non-job-related invoices, if you use Inventory Control.

 l Updates quantities and      costs in Project and Job Costing for job-related returns.

 l Creates general ledger       transactions for the processed returns, and creates the Return Posting      
Journal.

For more information about the general ledger accounts affected by return transactions, see 
"About General Ledger Journal Entries Generated by Purchase Orders" (page 79).

 l Adjusts and reprorates       or expenses any additional costs posted with a receipt to remaining 
items      on the receipt using the methods you specified. Mo re ...

If you expensed or prorated additional costs     that were originally prorated to the items being 
returned, Day End Processing     expenses the costs or prorates them to the remaining items on 
the original    receipt. You can check the prorated amounts on the Return Posting Journal. 

For more information, see "P/O Posting Journals Screen" (page 285).
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 l If you do not keep history, deletes completed       returns.

If you keep history and statistics,       updates Purchase Orders and Inventory Control history and 
statistics with      returns information.

Performing Day End Processing

Perform Day End Processing as part of your daily routine, to keep your audit     trail and reports up to 
date. You can run Day End Processing as many times    a day as you want. Mo re ...

Depending on the processing options selected on the I/C Options screen, Day End Processing: 

 l Optionally updates costing data from all transactions. (You can also choose to update costing 
information during transaction posting.)

 l Optionally produces general ledger journal entries from the transactions that were posted 
during the day. (You can choose to create G/L entries at the same time as you cost items, or 
you can use the Create G/L Batch screen to create G/L transactions.)

 l Optionally produces other subledger journal entries from the transactions that were posted 
during the day. (If you cost items during posting, you can also choose to create subledger 
entries at the same time.) 

 l Always updates item statistics       and transaction history for I/C, O/E and P/O (if you have them).

 l Creates the posting journals       for each type of transaction posted.

 l Deletes completed transaction       detail if you do not keep transaction history.

 l Activates and posts future        sales orders and purchase orders that have reached their order 
date, and       updating quantities on sales order and on purchase order.

 l Removes quotes and purchase        requisitions with expiration dates up to and including the 
session date       for day-end processing. 

 l Updates sales commissions.

Before You Start

 l Post all the transactions that you want to be processed. Any transactions you post while 
Day End Processing is running will not be processed if processing has already been completed 
for the transaction type.                      

To be sure of processing all the day's transactions, post them before starting Day End 
Processing.

 l Back up your Purchase Orders data. For information about making backups, see the System 
Manager help.
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 l Allow enough time to perform day-end processing. The time it takes to complete day-end 
processing varies according to your computer and the number of transactions you entered 
since the last time you ran Day End Processing.                      

Tip: We recommend that you run Day End Processing when you do not need to use your 
computer for other tasks. You might find it best to run it overnight.

 l Assign a default cost expense account. If you use Purchase Orders as a stand-alone system 
(without Inventory Control), you must assign a default cost expense account in the P/O G/L 
Integration screen. 

To perform day-end processing in a stand-alone Purchase Orders system:

 1. Open Purchase Orders > P/O Periodic Processing > Day End Processing.

(If you use Inventory Control, you must open Inventory Control > I/C Periodic Processing > 
Day End Processing.)

 2. Click Process.

A message appears to confirm that processing is complete.

 3. Click OK or press      the Enter key to close the message and the Day End Processing screen.

After performing Day End Processing

Before you post new transactions:

 l Print the posting journals   for a record of the general ledger entries created from Purchase 
Orders   transactions, both in Purchase Orders and in Accounts Payable.

 l Print any reports that   you need for updating your records.

 l Modify options in the   A/P Options screen, as needed.

G/L Batches and Journal Entries
Use the P/O Create Batch screen to create a general ledger transaction batch to record the inventory 
transactions and entries to payables clearing.

About Creating General Ledger Batches

If you do not use the option to create general ledger transactions during posting or during day-end 
processing, you must use the Create Batch screen when you want to create a general ledger 
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transaction batch to record the inventory transactions and entries to payables clearing. You can then 
process the batch in General Ledger.

If you want to print the G/L Transactions report you must print it before you create the general ledger 
batch. When you create the batch, Purchase Orders deletes the information in the G/L Transactions 
report.

The Create Batch screen also lets you post a batch of invoices in Accounts   Payable from invoices or 
credit/debit notes posted in Purchase Orders.   

You can use this screen to post A/P invoices created by Purchase Orders   only if you selected On 
Request Using Create Batch Icon for the Post A/P   Batches option on the Processing tab of the P/O 
Options screen.

About General Ledger Journal Entries Generated from Returns

Returns of items to vendors are assigned source code PO-RT   on the G/L Transactions report.

In Inventory Control, returns debit the item's payables clearing account   and credit the item's inventory 
control/expense account with the value   of the returned items, prorated additional costs, and allocated 
taxes. 

Reprorated Additional Costs

If additional costs prorated to returned items are reprorated, additional   entries are created to debit or 
credit the Inventory Control and Payables   Clearing accounts for the remaining items on the receipt.

If you post a credit note for the return and then run Day End   processing, a credit note is created in the 
Accounts Payable batch. When   it is posted in Accounts Payable, the credit note debits   the vendor's 
payables control account and credits the vendor's payables   clearing account with the value of the 
returned items, prorated additional   costs, and allocated taxes.

Non-inventory Items 

When   non-inventory items are returned, Day End Processing does not create any   journal entries for 
Inventory Control accounts. 

The transaction is sent   to Accounts Payable as an invoice or credit note which will debit or credit   the 
G/L expense account specified for the item and post the corresponding   credit or debit to the vendor's 
payables control account. 

About General Ledger Journal Entries Generated from Receipts 

Receipts are assigned source code PO-RC on the G/L   Transactions report.
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Receipt transactions debit the item's inventory control account and   credit the item's payables clearing 
account with the total of extended   item cost, allocated taxes, and any prorated additional costs and 
their   allocated taxes.

If an item uses the LIFO or FIFO costing method, the receipt number   and date, item quantity 
received, and item cost are added to Inventory   Control's receipt buckets for the item.

Receipt Adjustments

If receipts are edited to change   item quantities or costs, additional   general ledger transactions are 
created:

 l If quantities or costs increased, the journal entries debit the inventory control   (or 
Inventory/Expense) account and credit the payables   clearing account.

 l If quantities or costs decreased, the journal entries debit the payables clearing account and 
credit the inventory   control account.

Non-inventory Items

If a receipt includes a non-inventory item, the expense   is posted during posting or day-end 
processing, and the non-inventory   payables clearing account is credited. 

Posting the invoice in Accounts   Payable generates a general ledger entry to debit the non-inventory 
payables   clearing account and credit the payables control account.

Prorated Additional Costs Added   on an Invoice 

If a new additional cost   is added on an invoice, general ledger journal entries are created to   prorate 
the cost to the receipt items, if applicable, debiting the inventory   control accounts for the items and 
crediting the payables clearing account.

Job-Related Receipts

Items   received for projects do not go into inventory. Instead, the value of   the item goes into a Work-In-
Progress account specified for the contract   in Project and Job Costing.

When you post job-related receipts or invoices, credit notes, and debit   notes with changes to the 
receipt information, Purchase Orders creates   general ledger journal entries to update the Work-In-
Progress and Payables   Clearing accounts with the total of extended item cost, allocated taxes,   and 
any prorated additional costs and their allocated taxes.

The program also updates the committed and actual quantities and costs   for the contract in Project 
and Job Costing.
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Purchase Orders also creates transactions for any overhead associated with the   items or additional 
costs, and for non-inventory items (such as labor)   received for the job.

About General Ledger Journal Entries Generated from Credit Notes

Credit notes are assigned source code PO-CR on the   G/L Transactions report.

When credit notes are posted in   Accounts Payable, journal entries are created during posting or Day 
End Processing to:

 l Debit the vendor's payables clearing account.

 l Credit   the vendor's payables control account.

Credits for Additional Costs

When   you post a credit note for an additional cost:

 l The expense account you assign is debited.

 l The vendor's payables   control account is credited.

Credits to Returns

When   you post a credit note to a return with no quantity or cost changes:

 l The   vendor's payables control account is debited. 

 l The item's payables clearing   account is credited. 

When   you post a credit note to a return that includes cost changes: 

 l Purchase   Orders debits or credits the payables clearing and inventory control accounts. 

 l When the credit note is posted in Accounts Payable:

 l The payables control   account is debited.

 l The payables clearing account is credited.

Credits to Invoices

When a credit note is posted for an invoice, Purchase Orders creates a   journal entry to:

 l Debit the payables clearing account.

 l Credit the   inventory control account.

Day End Processing creates a credit note   for the transaction in the Accounts Payable batch. When 
you post the batch   in Accounts Payable, a journal entry is created to:
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 l Debit the payables   control account.

 l Credit the payables clearing account.

Item Cost Adjustments

When you post   credit notes to adjust item costs, Day End Processing creates   general ledger journal 
entries to:

 l Debit the payables clearing account.  

 l Credit the item's inventory control accounts.

When you post the credit note in Accounts Payable, a journal entry   is created to:

 l Debit the vendor's payables control account.

 l Credit the   payables clearing account. 

Taxes

Allocated   taxes from credit notes are posted to the same general ledger accounts   as costs. 

Recoverable and expensed taxes are posted to the accounts specified   for the tax authorities in Tax 
Services and the inventory control or payables   accounts used for the related costs.

About General Ledger Journal Entries Generated from Invoices

Invoices are assigned source code PO-IN on the G/L Transactions report.   

When P/O invoices are posted in Accounts Payable, journal entries for invoices are created, as 
follows:

 l If a receipt is invoiced without changes to quantities and costs, a   journal entry is created to:

 l Debit the item's payables clearing account.  

 l Credit the vendor's payables control account (with the total of the   extended item cost, 
allocated taxes, and any prorated additional costs   and their allocated taxes).

 l If quantities or costs were changed on the invoice, Purchase Orders   creates journal entries 
to:

 l Debit or credit the item's   inventory control (or inventory/expense) account for the 
difference between   the receipt amount and the invoice amount.

 l Debit or credit the item's payables clearing account for the difference between the 
receipt amount   and the invoice amount.

 l Debit the Payables Clearing   account for the original amount of the receipt, net of any 
adjustments   as listed above.

206Sage 300 2021 Purchase Orders User's Guide



Example: If the item cost increases on an invoice, the difference   between the invoice cost and the 
receipt cost is debited to the item's   inventory control or inventory/expense account.

Prorated Additional Costs Added   on an Invoice 

If a new additional cost   is added on an invoice, general ledger journal entries are created by   Day End 
Processing to:

 l Debit the Inventory Control account for the cost.

 l Credit the payables clearing account.

Non-inventory Items 

When   invoices for non-inventory items are posted in Accounts Payable, general ledger journal   entries 
are created to:

 l Debit the expense account specified   for the non-inventory item.

 l Credit the vendor's payables control account.

If Purchase Orders uses the option to create G/L entries for non-inventory   expenses on 
receipts/returns (on the P/O G/L Integration screen), when you post receipts, Purchase Orders 
creates entries to:

 l Debit expense accounts.

 l Credit the non-inventory payables clearing   account.

When you post the invoices later in Accounts Payable, general ledger journal entries will be created 
to:

 l Credit the payables control account.

 l Debit the non-inventory payables   clearing account.

Expensed Additional Costs

If   additional costs are expensed, rather than prorated to the items on a   receipt, Day End Processing 
creates an Accounts Payable invoice to debit the additional cost expense account and credit the 
vendor's   payables control account when it is posted in Accounts Payable.

If Purchase Orders uses the option to create G/L entries for expensed additional   costs, Purchase 
Orders creates debit entries to expense accounts and   credit entries to the Expensed Additional Cost 
Clearing Account when you   post additional costs. (Posting the invoices later in Accounts Payable 
credits   the payables control account and debits the Expensed Additional Cost Clearing   Account.)
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Note: If the additional costs are job-related, Purchase Orders always creates G/L entries for 
expensed additional costs during posting - whether you select this option or not.

Job-Related Items 

If a job-related invoice includes   an adjustment to the receipt -  such as a change to the cost, quantity, 
or billing rate -   Purchase   Orders sends transactions to Project and Job Costing. These transactions   
do not affect the general ledger or Accounts Payable.

Example: 
 l If you change the billing   rate, Purchase Orders generates a new transaction for the 

difference between   the old billing rate and the new billing rate.

 l If you also change quantities,   Purchase Orders will also create a billing adjustment 
transaction for   the quantity difference.

 l If the receipt originated   from a purchase order and you change the quantity outstanding, 
Purchase   Orders will update the committed quantities and costs in Project and Job   Costing.

Warning! 
Do not edit job-related invoices in Accounts   Payable. 

Job-related invoices transferred   to Accounts Payable from Purchase Orders do not update Project 
and Job Costing when posted in   Accounts Payable. 

Purchase Orders directly   updates Project and Job Costing with invoice amounts.

About General Ledger Journal Entries Generated from Debit Notes

Debit notes are assigned source code PO-DB on the G/L Transactions report.

When debit notes are posted in   Purchase Orders, journal entries are created during posting or Day 
End Processing to:

 l Debit the item's inventory control account.

 l Credit   the item's payables   clearing account.

When the debit notes are posted in   Accounts Payable, journal entries are created to:

 l Debit the item's payables   clearing account.

 l Credit the vendor's payables control account.
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Taxes

Allocated   taxes from debit notes are posted to the same general ledger accounts   as their related 
costs. 

Recoverable and expensed taxes are posted to the   accounts specified for the tax authorities in Tax 
Services and the inventory   control or payables accounts used for the related costs.

Creating a Batch of General Ledger Transactions in Purchase Orders

You use the Create Batch screen to create general ledger batches if you     do not automatically     create 
G/L transactions when you post transactions or when you run Day     End Processing. Mo re ...

You can find out how you currently create G/L transactions by looking       at the Create G/L Transactions 
option on the Integration tab of the G/L       Integration screen       (in the P/O Setup folder). For more 
information, see "P/O G/L Integration Screen" (page 323).

The Create Batch screen performs two separate operations:

 l Produces a batch of general         ledger transactions from posted receipts (or appends to an 
existing general      ledger batch), and optionally posts them automatically.

You can use this screen to produce G/L batches only if       you selected On Request Using 
Create G/L Batch Icon for the Create G/L      Transactions option in the G/L Integration screen.

 l Posts a batch of invoices         in Accounts Payable from invoices or credit/debit notes posted in 
Purchase      Orders.

You can use this screen to post A/P invoices created       by Purchase Orders only if you selected 
On Request Using Create Batch       Icon for the Post A/P Batches option on the Processing tab of 
the P/O    Options screen.

Before You Start

 l Select the On Request       Using Create Batch Icon option and other general ledger options on 
the Integration      tab of the G/L Integration screen.

 l Select the On Request       Using Create Batch Icon option for the Post A/P Batches option in the 
P/O Options      form.

 l Run Day End Processing      to update the company’s Purchase Orders data. 

For more information, see "About Periodic Processing in Purchase Orders" (page 193).

 l Print the G/L Transactions       report, then file it with your audit trail reports. (You must print the       
report before using the Create Batch screen. When you create general ledger       transactions, 
the data for the G/L Transactions report is deleted from      Purchase Orders.) 
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For more information, see "P/O G/L Transactions Report Screen" (page 282).

To create a batch of G/L transactions:

 1. Open Purchase Orders > P/O Periodic Processing > Create Batch.

 2. Specify the day-end      number through which to create general ledger transactions. (You create      
the transactions for all outstanding day-end numbers up to and including     the number you 
specify.)

 3. If you also want to post invoice transactions created by Purchase     Orders in Accounts Payable, 
select Post      A/P Batch. 

 4. Click Process.

After using

 l Post the batches in General Ledger (unless they are posted automatically).

 l If you use a different       general ledger, update the general ledger in one of the following ways:

 l Import the CSV batch file into your general ledger, then      delete the file.

 l Using the G/L Transactions report, transfer the entries    to your general ledger manually, 
then delete the CSV batch file.

Posting a Batch of Purchase Orders Invoices in Accounts 
Payable
You can use the Create Batch screen to post Accounts Payable batches created     from Purchase 
Orders Invoices, credit notes and debit notes, depending on Purchase Orders settings for posting A/P 
batches and on item costing settings. Mo re ...

Note: You      can use the Create Batch screen to post batches in Accounts Payable only if you do not 
automatically      post batches when you post invoice transactions or when you run Day End     
Processing (depending on when you cost items).

The Post A/P Batches option (on the P/O Options     screen), determines how you post A/P batches. 

Costing options are set on the I/C Options screen (if you use Inventory Control), or on the P/O Options 
screen (if you do not use Inventory Control).

For more information about Purchase Orders options, see "P/O Options Screen  " (page 344).

For information about the I/C Options screen, see the help for Inventory Control.
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Before You Start

 l Run Day End Processing        to complete processing and update the Purchase Orders and 
Inventory Control       data.

 l Check the Processing tab of the P/O Options screen to find out whether you can use the 
Create Batch screen to post A/P batches.

To post an A/P invoice batch using the Create Batch screen:

 1. Open Purchase Orders > P/O Periodic Processing > Create Batch.

 2. In the Create G/L Batch Through Day End Number field, specify the day-end       number 
through which to create general ledger transactions. (You create       the transactions for all 
outstanding day-end numbers up to and including      the number you specify.)

 3. Select Post A/P Batch       to post invoice transactions created by Purchase Orders in Accounts      
Payable. 

 4. Click Process.

After using

 l Post the batches in General Ledger (unless they are posted automatically).

Clearing Historical Purchase Orders Data
You can clear transaction history, purchase order history, statistics,     and posting journals that you no 
longer need using the Clear History     screen. (You can     also clear P/O's item transaction history if you 
use Purchase Orders without Inventory    Control.) Mo re ...

Unless you use the options to keep Purchase Orders history and statistics,     the program clears all 
completed transactions during Day End Processing,     and will not keep purchase history and statistics. 
You then use Clear    History mainly to clear printed posting journals.

Before You Start

 l Make sure you have posted all the transactions    you need.

 l Run Day End Processing       to update Purchase Orders transactions and statistics that could 
affect      records you want to clear. 

For more information, see "About Day End Processing" (page 194).

 l Determine the date through      which to clear transaction history.
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 l Determine the fiscal year      and period through which to clear purchase statistics and purchasing 
history.

 l Determine the day-end       number through which to clear printed posting journals and the types 
of      journals to clear.

 l Print reports of the data      you want to clear. For example:

 l Before       clearing transaction history, print the Transaction List       for the transaction history you 
plan to clear. Also, make sure you have       printed copies of any completed requisitions, purchase 
orders, receiving      slips, and returns you require. 

For more information, see "P/O Transaction List Report Screen" (page 297).

 l Before       clearing purchase history, print the Purchase History      report for the historical data you 
plan to clear. 

For more information, see "P/O Purchase History Report Screen" (page 289).

 l Before       clearing sales statistics, print the Purchase Statistics      report for the statistics you plan 
to clear. 

For more information, see "P/O Purchase Statistics Report Screen" (page 294).

 l Before       clearing posting journals, print a copy of each posting journal       you want to clear. 
(Make sure you have printed the posting journals to      a printer or a file.)

 l If you use the Create Batch icon to create the general     ledger batch, print the G/L Transactions 
report for the journals. 

Note: You must print the G/L Transactions report before   you use the Create Batch icon.

 l Before       clearing the Payables Clearing Audit list, print the Payables Clearing Audit list      for the 
year, period, and account sets you want to clear.  

For more information, see "P/O Payables Clearing Audit List Report Screen" (page 284).

 l Before       clearing item transaction history (in stand-alone systems only),       print the Item 
Transaction       History      report for the period you plan to clear. 

For more information, see "P/O Item Transaction History Report Screen" (page 283).

To clear historical data:

 1. Open Purchase Orders > P/O Periodic Processing > Clear History.

 2. To clear transaction history,       select the Transaction History option, then type the date up to 
which      to clear history. Mo re ...

Purchase Orders clears the details from requisitions, purchase orders,   receipts, invoices, 
returns, credit notes, and debit notes that were completed   on or before the clearing date you 
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specify.

Completed transactions.

 l Requisitions   are complete when a purchase order has been posted for each requisition   
detail or you manually complete the line. (You can also delete requisitions   in the 
Requisition Entry screen.)

 l Purchase orders are complete when all ordered quantities have been received   or 
canceled. (You can also delete purchase orders in the Purchase Order   Entry screen.)

 l Receipts are complete when invoices have been posted for the primary   vendor and all 
secondary vendors on the receipt.

 l Invoices, credit notes, and debit notes are complete when Day End Processing   has 
added them to an Accounts Payable batch.

 l A return is complete when a credit note is posted to it.

Note: Cleared transactions are not reported on the Transaction Lists.

Completion dates.

 l Day   End Processing assigns the current session date as the completion date   for 
transactions.

 3. To clear purchase history,       select the Purchasing History option, then select the year and 
period      up to which to clear history, and the range and type of records to clear. Mo re ...

Clear History clears purchase history through the year and period you   specify, and by the 
range of item numbers or vendor numbers you select.   Cleared data no longer appears in the 
Purchase History screen or on the   Purchase History report.

 4. To clear purchase statistics,       select the Purchase Statistics option, then select the year and 
period      up to which to clear statistics. Mo re ...

Clear History clears purchase statistics through the year and period   you specify. Cleared 
statistics no longer appear in the Purchase Statistics   screen or on the Purchase Statistics 
report.

 5. To clear printed posting       journals, select the Printed Posting Journals option, then select the       
type of posting journal to clear and the day-end number up to which to      clear. Mo re ...

You can clear all posting journals including the journals produced during   the day-end 
processing run you specify. You select the types of journals   to clear, including any combination 
of journals for receipts, invoices,   credit notes and debit notes, and returns.
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 6. To clear the Payables       Clearing Audit list, select the Payables       Clearing Audit option and the 
year, period, and the account      sets to clear.

 7. To clear item transaction       history, select the Item Transaction History option, then select the 
year       and period through which to clear data. (This option is available only in      a stand-alone 
Purchase Orders system.) Mo re ...

Use this option to remove transaction history   for items maintained by the Purchase Orders 
program if you are not using   Inventory Control. Cleared transactions are not reported on the 
Transaction Lists.

 8. Click Process to clear      the specified data.

    Deleting Inactive Purchase Orders Records

If you use Purchase Orders as a stand-alone program, you can use the Delete Inactive Records 
screen to remove obsolete item and account set records. 

Before You Start

 l Print reports.

 l Update records.

 l Assign Inactive status      to all records you want to delete. The     program removes only records 
that have an Inactive status and    were set to inactive within the range of dates you specify.

 l Assign to another account       set item records that are currently assigned to the account set you 
want      to delete.

 l Run day-end processing       if you have posted, since the last day-end processing, any 
transactions      for items you will be deleting.

To delete inactive records:

 1. Open Purchase Orders > P/O Periodic Processing > Delete Inactive Records.

 2. Select the types of inactive      records to delete.

 3. Enter the range of codes       or numbers to delete for each record type you selected, or use the 

Finder        to select the ranges.

 4. Enter a range of dates       to indicate when a record must have been made inactive to delete it. 
Purchase       Orders selects records that have a status of Inactive and a corresponding      "inactive" 
date within the range of dates you specify.

 5. Click Process.

 6. When you have finished      deleting records, click Close.
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The     program removes records that have an Inactive status and    were set to inactive within the 
specified range of dates.

After deleting inactive records

Print new copies of the reports of the types of records you deleted     to update your files with current 
information. For information about reports you can print, see "About Purchase Orders Reports" 
(page 238).
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Chapter 4: Looking Up Purchase Orders 
Statistics and Information

Use Purchase Orders Statistics and Inquiries screens to look up information about vendors and 
transactions.

Viewing Pending Receipts
You can review items that are expected to arrive at      particular locations within a given time period (for 
example, in the next      7 days), and check whether there will be sufficient stock to cover current     sales 
orders. Mo re ...

You can search pending receipts by item number or by vendor, and also      view completed purchase 
orders to see if items were delivered within the     expected arrival times. 

Pending Receipts Inquiry finds all active purchase orders that are not on hold and      that fit your 
selection criteria. You can limit     the inquiry to specific locations.

To view pending receipts:

 1. Open Purchase Orders > P/O Statistics and Inquiries >      Pending Receipts Inquiry.

 2. Specify whether       to inquire by item or by vendor, and then select the item number or vendor      
number for which you want to view details.

 3. Select a range of locations,      or skip the Location fields to display all locations.

 4. In the PO Date fields,       leave the From and To fields blank to include all purchase orders, or      
specify a range of PO dates.

 5. In the Expected Arrival       Date fields, leave the From field blank to include all purchase orders       
with outstanding items, and enter the end date for the inquiry in the      To field.

 6. To see whether items were delivered within the expected arrival      times, select Include 
Completed       Detail Lines.

 7. To see incomplete detail lines that are past their expected arrival dates, select Show Late POs 
Only.
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 8. Click Go  .  

The program fills in the detail table with PO line information    that matches the select criteria that you 
specified.

 9. To view more information       for any PO line item —      such as receipt quantities and days late —      
double-click the PO line on the detail grid, or select the line, and click     the Details button.

The program displays additional information    for each receipt associated with the PO line.

Looking Up Purchase History
If you use the Accumulate Purchase History option, you can view sales   history, and drill down to 
transactions for the years and periods for   which you keep data. Mo re ...

You can use the Purchase History screen to display all items ordered from a vendor, or   to display all 
vendors who supplied an item.

Before You Start

 l Select the Accumulate   Purchase History option in the P/O Options screen.

 l Specify the type of year   and period by which to accumulate purchase history.

Note: Purchase Orders accumulates purchase history after you select these options.

To look up purchase history:

 1. Open  Purchase Orders > P/O Statistics and Inquiries >      Purchase History.

Tip: You can also open the Purchase History screen using the History   button when entering 
documents in the transaction entry screens.

 2. Select the range of year   and period for which you want to see purchase history.

 3. Specify whether to sort   by item number or vendor number. Mo re ...

 l Select Vendor   to view all of the items ordered from and returned to a particular vendor.

 l Select Item Number to view all of the vendors   who supplied a particular item.

 4. Choose your functional   currency or the vendor currency, if you have a multicurrency system.

 5. Click the Go  button or press the F7 key.
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If you chose Vendor in step 3, the program lists all of   the item details on invoices or returns for the 
vendor.

If you chose Item Number, the program lists all of   the invoices and returns on which the item that 
you specified appears.

 6. To view the transaction   details for an item or vendor entry, double-click the line for which   you 
want more information, or select the line and then click the Details button.   The Purchase 
History Detail screen appears.

 7. For transactions   that include serialized or lotted items, you can select the entry   in the table, and 
then click the Serial/Lot Numbers button to display the serial   and/or lot numbers for the 
selected entry.

To view the details of a transaction:

 1. On the Purchase History screen, click Details while reviewing history to see the details   of the 
transactions posted for a particular vendor or item number.

 2. Click Close to return to the main Purchase   History screen.

Looking Up Transaction History in Inventory Control
You can use the I/C Transaction History Inquiry screen to look up transactions created in Sage 300 
Purchase Orders, Order Entry, or Inventory Control.

To look up Purchase Orders transactions in Inventory Control:

 1. Open Inventory Control I/CStatistics and Inquiries >      Transaction History Inquiry.

 2. To change the fiscal year and period, select a new one from the drop-down list beside the As 
At Year/Period field.

 3. Enter the beginning and ending item numbers, or select them using the Finders.

 4. Enter the beginning and ending account set numbers, or select them using the Finders.

 5. Enter the beginning and ending location numbers, or select them using the Finders.

 6. When you are satisfied with your inquiry criteria, click the Go  button.

 7. A list of items matching your criteria is displayed. To view a list of recent transactions involving 
an item, select the item from the list, and then click the Details button.

 8. The list includes the document number and other information about the transaction.

 9. To drill down to the original document, highlight a transaction, and then click the Details button.

Sage 300 displays the original transaction unless it has been cleared from the database.
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Looking Up Purchase Statistics
If you use the Accumulate Purchase Statistics option, you can view purchase    statistics for the years 
and statistical periods for which you keep data.

To look up purchase statistics:

 1. Open  Purchase Orders > P/O Statistics and Inquiries >      Purchase Statistics.

 2. Select the year, period,      and currency for which you want to see purchase statistics.
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Chapter 5: Printing Purchase Orders 
Reports and Forms

Use the report formats that come with Purchase Orders to print purchase orders forms (requisitions, 
returns, mailing labels, and receiving slips), analytical reports, and setup reports, or select a 
customized version.

About Print Destinations
There are several ways to print reports in Sage 300, depending on your needs. Before you print, you 
can select a print destination to:

 l Print to a physical printer, to create permanent copies of the information.

 l Print to a preview on your screen, for quick review.

 l Print to a file that you can save, print later, import into another program, or transfer to other 
electronic media.

 l Print to e-mail, to send a report as an e-mail attachment.

Note: To change the print destination for screens and reports, you must have Change Print 
Destination security authorization for Administrative Services.

You select print destinations from the Sage 300 desktop. For more information, see "Selecting a Print 
Destination" (page 241).

Important! When you print to any destination, the report’s status is updated to Printed.

Tips: 
If you use Preview as your print destination, you can print or export the report from the preview 
screen in the following ways:

 l To print the report on your printer, click Print  on the SAP Crystal Reports® menu bar.

 l To export the report to a file, click Export  on the SAP Crystal Reports® menu bar. (You 
can select Crystal Reports, PDF, Excel, RTF, or CSV as the export format.)
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Printing Purchase Orders Forms
Purchase Orders includes forms that you can print "as is" or adapt to print on forms that you already 
use for requisitions, purchase orders, receiving slips, returns and mailing labels. Mo re ...

You can open Purchase Orders forms from the Sage 300 desktop, or you can print these forms 
immediately after posting the corresponding transaction.

For more information about these forms, see "About Purchase Orders Forms" (page 67).

Before You Start

 l Find out which report format to use for printing the form you are working with.

 l If you are e-mailing forms to vendors:

 l Use the E-mail Messages screen in the P/O Setup folder to create the e-mail message 
that you want to send to vendors.

 l Select an Email delivery method for each vendor that you want to e-mail. You set the 
delivery method on the Processing tab of the vendor record in Accounts Payable.

 l Check the print destination for forms and reports that you are printing.

To print a form in Purchase Orders:

 1. Open Purchase Orders > P/O Forms.

 2. Double-click the icon for the form you want to print, or right-click the icon and then click Open 
on the menu that appears.

 3. Specify print options for the form. Mo re ...

For information about the options available on the screen you are working with, you can:

 l Use the Related Topics link, below.

 l On the help Contents tab, click Screen Guides > Forms, and then click the name of the 
form.

 l In the screen you are using to print the form, press the F1 key.

 4. To review a document before printing, or to print a test copy to verify that information is aligned 
correctly on a preprinted form, click Align.

Clicking Align does not set document status to "Printed." To set document status to "Printed," 
you must click Print.
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 5. Click Print.

Purchase Orders prints the form to your usual print destination, and sets the document status 
to "Printed."

Tips: 
If you use Preview as your print destination, you can print or export the report from the preview 
screen in the following ways:

 l To print the report on your printer, click Print  on the SAP Crystal Reports® menu bar.

 l To export the report to a file, click Export  on the SAP Crystal Reports® menu bar. (You 
can select Crystal Reports, PDF, Excel, RTF, or CSV as the export format.)

For more information about print destinations, see "About Print Destinations" (page 221).

Printing Mailing Labels

You use the P/O Mailing Labels screen to print mailing labels for sending purchase orders     to vendors 
and for returning goods. Mo re ...

When you print mailing labels you can choose:

 l The label form that you want to use.

 l Whether to print labels for purchase orders or returns.

 l Whether to reprint labels.

 l Whether to print labels for returns marked as required when you printed the returns.

Before You Start

 l Specify the number of labels to print for each purchase order or return on      the Totals tab of the 
transaction entry form.

 l Decide which report format to use for printing labels.

Purchase Orders ships with two standard labels. 

 l POLABEL.RPT. A mailing label format that prints 12 labels [2-up].

 l POLABELP.RPT. A mailing label format that prints  14 labels. 

 l Check the print destination to make sure that you are printing to the correct printer.
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To print mailing labels:

 1. Open Purchase Orders > P/O Forms > Mailing Labels.

 2. Fill in the following fields:

 l Use Label. Specify the report format that you want to use to print labels. 

You can accept the default label report format, or click Browse to select a different one. 
(Purchase Orders displays the format that you last used for labels.)

 l Select.  Specify whether to print labels for purchase orders or returns.

 l From/To. Specify the range of document numbers for which      you want to print labels.

 l Include Labels Already Printed. Specify whether to      print new copies of labels that you 
printed before.

 l Print       Only Labels Marked Required. Specify whether      to print labels       for returns for 
which you selected the option Require Mailing Labels when you printed the returns.

 3. Click Print.

Tip: If you are printing labels on a printer, you can click     the Align button to print a sample 
copy of the label to check that the    information prints in the right places on label stock.

Printing Receiving Slips

You can print receiving slips until receipts are completed. Once they are completed, you can no 
longer print them, and they will be deleted when you run Day End processing if you do not keep 
transaction history. Mo re ...

You can print a receiving slip immediately after posting the receipt in the Receipt Entry screen, or use 
the Receiving Slips print screen in the P/O Forms folder when you want to print several Receiving 
slips together.

Before You Start

 l Find out which report file to use for printing receiving slips.

 l If you are printing forms, check the print destination for forms and reports.
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To print receiving slips:

 1. Open Purchase Orders > P/O Forms > Receiving Slips.

 2. Specify options for the receipts, as follows:           

 l Use receipt. Specify the report format to use for printing the receipts. You can accept the 
default format that appears, or click the Browse button to select a different one. 
(Purchase Orders displays the format that you last used for printing receipts.)      Mo re ...

Purchase Orders ships with four standard formats for printing receiving slips:

 l PORCP01.RPT—for printing on blank paper.

 l PORCP02.RPT—for printing on preprinted forms.

 l PORCP03.RPT—for printing on blank paper (include quantities received and 
costs).

 l PORCP04.RPT—for printing on preprinted forms (include quantities received and 
costs).

Note: Pre-printed forms PORCP03.RPT and PORCP04.RPT print cost information. If 
you want to hide costs on these forms, you will need to customize them.

 l From Receipt Number/To Receipt Number.      Specify the range of receipts to print.

 l Include Receipts Already Printed. Choose to print new copies of receipts that you 
printed before.

 l Print Serial/Lot Numbers. Choose to print the serial and/or lot numbers of any serialized 
or lotted items included in the receipts.

 3. Click Print.

Tip: If you are printing receiving slips on a printer, you can click the Align button to print a 
sample copy to check that the information prints in the right places on a preprinted receipt 
form.

Purchase Orders

Use the P/O Purchase Orders screen to print one or more purchase orders.

About Printing Purchase Orders

You can print purchase orders from the P/O Purchase Orders screen. You can also print a purchase 
order directly from the P/O Purchase Order Entry screen, right after posting it. You can reprint 
purchase orders until they are complete.
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If you wish, you can print purchase orders by type (Active, Future, Standing, Blanket), and you can 
choose to reprint or exclude previously printed purchase orders, or print only incomplete purchase 
orders. You can also print copies of edited purchase orders, including only the details added since the 
last time you printed a purchase order.

You can print purchase orders using the forms that come with the program, or you can change the 
forms. Mo re ...

For more information on designing and adapting forms and reports, see the Customizing Printed 
Forms guide, which is available online at 
https://cdn.na.sage.com/docs/en/customer/300erp/Sage300ERP_Documentation.htm.

Printing drop-ship addresses

If the purchase order includes drop-ship addresses, all details with the same drop-ship address are 
printed together on the purchase order, followed by the address, rather than repeating the address 
for each detail line that uses it.

E-mailing purchase orders

You can email purchase orders and purchase returns to vendors.

If you want to email purchase orders to vendors, you use the Email Messages screen in the P/O 
Setup folder to create the email message that you want to send to vendors.

For each vendor that you want to email, you must select an Email delivery method on the Processing 
tab of the vendor record in Accounts Payable.

E-mailing Purchase Orders to Vendors

You can use the P/O Purchase Orders print screen to send purchase orders to vendors by e-mail.

Before You Start

 l Use the E-mail Messages screen in the P/O Setup folder to create the e-mail message that you 
want to send to vendors with e-mailed purchase orders. Purchase orders are sent as 
attachments with the e-mail messages.

For more information about setting up e-mail messages, see "Creating E-mail Messages" 
(page 45).

 l In Accounts Payable, in the vendor record for each vendor that you want to e-mail, select an 
Email delivery method.
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For more information about setting options in vendor records, see the Accounts Payable help.

To e-mail purchase orders to vendors:

 1. Open the P/O Purchase Orders print screen. Mo re ...

To e-mail a purchase order immediately after posting it:

 a. Click Post while the purchase order is displayed.

 b. Click Yes to print the purchase order. Purchase Orders opens the P/O Purchase Orders 
print screen, selecting the purchase order that you just posted.

To e-mail a range of purchase orders, open Purchase Orders > P/O Forms > Purchase 
Orders.

 2. On the P/O Purchase Orders print screen, select Vendor in the Delivery Method field.

 3. In the Message ID field, accept the default message ID defined for purchase orders, or click the 

Zoom  button, and then select the ID for a different e-mail message.

 4. Specify other options for the purchase orders, as usual. (For help on these fields, see "P/O 
Purchase Orders Screen" (page 267).)

 5. Click Print.

Each purchase order is printed to a file and the file is attached to a new email message.

Printing Purchase Orders

You can print purchase orders until they are completed. Once they are completed, you can no longer 
print them, and they will be deleted when you run Day End processing if you do not keep transaction 
history. Mo re ...

You can print an order immediately after posting it in the Purchase Order Entry screen, or use the 
Purchase Orders print screen in the P/O Forms folder when you want to print several purchase orders 
together. For step-by-step instructions on printing immediately after posting, see "Printing a Purchase 
Order Immediately After Posting" (page 229).

Before You Start

 l Find out which report format to use for printing the form you are working with.

 l If you are e-mailing forms to vendors:

 l Use the E-mail Messages screen in the P/O Setup folder to create the e-mail message 
that you want to send to vendors.
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 l Select an Email delivery method for each vendor that you want to e-mail. You set the 
delivery method on the Processing tab of the vendor record in Accounts Payable.

 l Check the print destination for forms and reports that you are printing.

To print purchase orders:

 1. Open Purchase Orders > P/O Forms > Purchase Orders.         

For information about the Purchase Orders screen, see "P/O Purchase Orders Screen" (page 
267).

 2. Specify options for the purchase orders, as follows:

 l Use Purchase Order. Specify the report format to use for printing purchase orders. You 
can accept the default format that appears, or click the Browse button to select a different 
one. (Purchase Orders displays the format that you last used for printing purchase 
orders.) Mo re ...

Purchase Orders ships with four standard formats for printing purchase orders:

 l POPOR01.RPT—for printing on blank paper.

 l POPOR02.RPT—for printing on preprinted forms.

 l POPOR04.RPT—for printing on blank paper.

 l POPOR05.RPT—for printing on preprinted forms.

The first two report formats connect directly to the Purchase Orders database and are 
easier to change if you need to customize your purchase order forms.

The second two formats print more quickly, but may be less adaptable to your needs.

 l From Purchase Order Number/To Purchase Order Number. Specify the range of 
purchase orders to print.

 l Delivery Method. Specify how to send documents to your vendor:

 l Select Print Destination to print to your usual print destination.

 l Select Vendor to use the delivery method specified in each vendor record in 
Accounts Payable.

If you select Vendor as the delivery method, select the ID for the e-mail message 
you send with e-mailed documents for vendors that use an e-mail delivery method.

 l Message ID. If you selected Vendor as the delivery method, select the ID for the e-mail 
message you want to send with purchase orders for vendors that use an e-mail delivery 
method. Mo re ...
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To view or edit the message for the selected ID, or to add a new e-mail message for 
purchase orders, click the Zoom button for the Message ID field.

 l Include Active / Future / Standing / Blanket Orders. Select the types of purchase 
orders to print.

 l Include Purchase Orders Already Printed. Specify whether to print new copies of 
purchase orders that you printed before.

 l Include Details Already Printed. Specify whether to include details that you printed 
before (if you have added to the purchase order) or only details added later.

 l Use Custom Form. Do not select this option unless you are using a customized 
purchase order format that requires it. (This option is for formats that do not use the 
report selection criteria sent by this print window.)

 3. Click Print.

Tip: If you are printing purchase orders on a printer, you can click the Align button to print a 
sample copy to check that the information prints in the right places on a preprinted PO form.

Printing a Purchase Order Immediately After Posting

You can print purchase orders until they are completed. Once they are completed, you can no longer 
print them, and they will be deleted when you run Day End processing if you do not keep transaction 
history. Mo re ...

You can print an order immediately after posting it in the Purchase Order Entry screen, or use the 
Purchase Orders screen in the P/O Forms folder when you want to print several purchase orders 
together. For step-by-step instructions on printing several purchase orders, see "Printing Purchase 
Orders" (page 227).

Before You Start

 l Find out which report format to use for printing the form you are working with.

 l If you are e-mailing forms to vendors:

 l Use the E-mail Messages screen in the P/O Setup folder to create the e-mail message 
that you want to send to vendors.

 l Select an Email delivery method for each vendor that you want to e-mail. You set the 
delivery method on the Processing tab of the vendor record in Accounts Payable.

 l Check the print destination for forms and reports that you are printing.
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To print a purchase order immediately after posting it:

 1. In the Purchase Order Entry screen, click Post while the purchase order is displayed.

When Purchase Orders finishes posting, it displays a message asking whether to print the 
purchase order.

 2. Click Yes.

Purchase Orders opens the P/O Purchase Orders print screen, selecting the purchase order 
that you just posted.

 3. Select options for printing the purchase order, as follows:

 l Use Purchase Order. Use the default purchase order report format, or click Browse to 
select a different one. Mo re ...

Purchase Orders ships with four standard formats for printing purchase orders:

 l POPOR01.RPT—for printing on blank paper.

 l POPOR02.RPT—for printing on preprinted forms.

 l POPOR04.RPT—for printing on blank paper.

 l POPOR05.RPT—for printing on preprinted forms.

The first two reports connect directly to the P/O database, and are easier to change if you 
need to customize your purchase order forms.

The second two print more quickly, but may be less adaptable to your needs.

Note: Purchase Orders displays the format that you last used for purchase orders.

 l Delivery Method. Specify how to send documents to your vendor:

 l Select Print Destination to print to your usual print destination.

 l Select Vendor to use the delivery method specified in each vendor record in 
Accounts Payable.

If you select Vendor as the delivery method, select the ID for the e-mail message 
you send with e-mailed documents for vendors that use an e-mail delivery method.

 l Message ID. If you selected Vendor as the delivery method, select the ID for the 
message you want to send with the e-mailed purchase order (if the vendor record uses 
an e-mail delivery method). Mo re ...

To view or edit the message for the selected ID, or to add a new e-mail message for 
purchase orders, click the Zoom button for the Message ID field.
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 l Include Details Already Printed. Choose whether to include the details that you printed 
before (if you have now added to the PO) or only details added later.

 l Use Custom Form. Do not select this option unless you are using a customized 
purchase order form that requires it. (This option is for custom forms that do not use the 
report selection criteria sent by this print window.)

 4. Click Print.

Tip: If you are printing the purchase order on a printer, you can click the Align button to print 
a sample copy of the purchase order to check that the information prints in the right places 
on preprinted forms. If the sample form does not line up correctly, ensure that you have 
correctly inserted the forms in the printer.

Requisitions

Use the P/O Requisitions screen to print requisitions for   purchases you plan to make and for which 
you may need approval before   you can create purchase orders.

Printing Requisitions

You can print purchase requisitions until they are completed. Once they are completed, you can no 
longer print them and they will be deleted when you run Day End processing if you do not keep 
transaction history. Mo re ...

You can print a requisition immediately after posting it in the Requisition Entry screen, or use the 
Requisitions print screen in the P/O Forms folder when you want to print several requisitions together. 
For instructions on printing a requisition after posting it, see "Printing a Requisition Immediately After 
Posting" (page 232).

Before You Start

 l Find out which report format to use for printing the requisitions.

 l Check the print destination to make sure that you are printing to the correct printer.

To print requisitions:

 1. Open Purchase Orders > P/O Forms > Requisitions.

 2. Specify options for the requisitions, as follows:           

 l Use Requisition. Specify the report format to use for printing requisitions. You can 
accept the default format that appears, or click the Browse button to select a different 
one. (Purchase Orders displays the format that you last used for printing requisitions.)      Mo re ...
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Purchase Orders ships with three standard formats for printing requisitions:

 l PORQN01.RPT—for printing on blank paper.

 l PORQN02.RPT—for printing on preprinted      forms.

 l PORQN03.RPT—an alternative format that includes optional fields for      printing on 
blank paper.

 l From Requisition Number/To Requisition Number.      Specify the range of requisitions to 
print.

 l Include Requisitions Already Printed. Specify whether to print new copies of 
requisitions that you printed before.

 3. Click Print.

Tip: If you are printing requisitions on a printer, you     can click the Align button to print a 
sample copy of the label to check     that the information prints in the right places on a 
preprinted requisition    form.

Printing a Requisition Immediately After Posting

You can print copies of requisitions only until they are completed. 

Once they are completed, you can no longer print them and, unless you keep transaction history, they 
will be deleted when you run Day End processing.

Before You Start

 l Find out which report format to use for printing the requisition.

 l Check the print destination.

To print a  purchase requisition immediately after posting it:

 1. In the Requisition Entry screen, click Post while the purchase requisition is displayed. 

When Purchase Orders is finished posting, it displays a message asking whether    to print the 
requisition.

 2. Click Yes. 

Purchase Orders opens the P/O Requisitions print screen, selecting the requisition you just 
posted.

 3. In the Use Requisition field, select the report format to use to print the requisition. You can 
accept the default format that appears, or click the Browse button to select a different one. 
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(Purchase Orders displays the format that you last used for printing requisitions.) Mo re ...

Purchase Orders ships with three standard formats for printing requisitions: 

 l PORQN01.RPT—for printing on blank paper.

 l PORQN02.RPT—for printing on preprinted forms.

 l PORQN03.RPT—an alternative format for printing on blank paper that includes optional 
fields.

 4. Click Print.

Tip: If you are printing the purchase requisition on a printer,     you can click the Align button to 
print a sample copy of the requisition     to check that the information prints in the right places 
on preprinted     forms. If the sample form does not line up correctly, ensure that you    have 
correctly inserted the forms in the printer.

Returns

Use the P/O Returns screen to print returns of merchandise to vendors.

About Printing Returns

You use the Returns screen in the P/O Forms folder to print a range of returns.

You can print a single return from the Return Entry screen immediately after you post it.

Note: You can reprint returns until they are complete.

Returns Report Formats

The following return formats are included with Purchase Orders:

 l PORET01.RPT – A format for printing   returns on blank paper.

 l PORET02.RPT – A format for printing returns on preprinted forms.

E-mailing Returns

You can also e-mail purchase returns to vendors. To do so, you must:

 l Use the E-mail Messages screen in the P/O Setup folder to create an e-mail message to send 
to vendors along with the return report.

 l For each vendor that you want to email, select an Email delivery method on the Processing tab 
of the vendor record in Accounts Payable.
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E-mailing Returns to Vendors

You can use the P/O Returns print screen to send returns to vendors by e-mail.

Before You Start

 l Use the E-mail Messages screen in the P/O Setup folder to create the e-mail message that you 
want to send to vendors with e-mailed returns. Returns are sent as attachments with the e-mail 
messages.

For more information about setting up e-mail messages, see "Creating E-mail Messages" 
(page 45).

 l In Accounts Payable, in the vendor record for each vendor that you want to e-mail, select an 
Email delivery method.

For more information about setting options in vendor records, see the Accounts Payable help.

To e-mail returns to vendors:

 1. Open the P/O Returns print screen. Mo re ...

To e-mail a return immediately after posting it:

 a. Click Post while the return is displayed.

 b. Click Yes to print the return. Purchase Orders opens the P/O Returns screen, selecting 
the return that you just posted.

To e-mail a range of returns, open Purchase Orders > P/O Forms > Returns.

 2. On the P/O Returns print screen, select Vendor in the Delivery Method field.

 3. In the Message ID field, accept the default message ID defined for returns, or click the Zoom 

 button, and then select the ID for a different e-mail message.

 4. Specify other options for the returns, as usual. (For help on these fields, see "P/O Returns 
Screen" (page 264).)

 5. Click Print.

Each return is printed to a file and the file is attached to a new email message.

Printing Returns

You can print returns until they are completed. Once they are completed, you can no longer print 
them and they will be deleted when you run Day End processing if you do not keep transaction 
history. Mo re ...
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You can print a return immediately after posting it in the Return Entry screen, or use the Returns 
screen in the P/O Forms folder when you want to print several returns together.

Before You Start

 l Find out which report format to use for printing the returns.

 l If you are e-mailing forms to vendors:

 l Use the E-mail Messages screen in the P/O Setup folder to create the e-mail message 
to send to vendors with e-mailed returns.

 l Select an Email delivery method for each vendor that you want to e-mail. You set the 
delivery method in the vendor record in Accounts Payable.

 l Check the print destination for returns that you are printing.

To print returns:

 1. Open Purchase Orders > P/O Forms > Returns.

 2. Specify options for the returns, as follows:

 l Use Return. Specify the report format to use for printing returns. You can accept the 
default format that appears, or click the Browse button to select a different one. 
(Purchase Orders displays the format that you last used for printing returns.) Mo re ...

The following return formats are included with Purchase Orders:

 l PORET01.RPT – A format for printing   returns on blank paper.

 l PORET02.RPT – A format for printing returns on preprinted forms.

 l From Return Number/To Return Number. Specify the range of returns to print.

 l Delivery Method. Specify how to send documents to your vendor:

 l Select Print Destination to print to your usual print destination.

 l Select Vendor to use the delivery method specified in each vendor record in 
Accounts Payable.

If you select Vendor as the delivery method, select the ID for the e-mail message 
you send with e-mailed documents for vendors that use an e-mail delivery method.

 l Message ID. If you selected Vendor as the delivery method, select the ID for the e-mail 
message you want to send with returns for vendors that use e-mail as the delivery 
method. Mo re ...
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To view or edit the message for the selected ID, or to add a new e-mail message for 

returns, click the Zoom  button for the Message ID field.

 l Include Returns Already Printed. Specify whether to print new copies of returns that 
you printed before.

 l Print Serial/Lot Numbers. Specify whether to print the serial and/or lot numbers of any 
serialized or lotted items returned.

 l Require Mailing Labels. Specify whether to print the number of labels on the Return 
Entry Totals tab for each return (select the option) or only one label per return (do not 
select the option).

 l Use Custom Form. Do not select this option unless you are using a customized return 
format that requires it. (This option is for formats that do not use the report selection 
criteria sent by this print window.)

 3. Click Print.

Tip: If you are printing returns on a printer, you can click the Align button to print a sample 
copy to check that the information prints in the right places on a preprinted PO form.

Printing a Return Immediately After Posting

Before You Start

 l Find out which report format to use for printing the form you are working with.

 l If you are e-mailing forms to vendors:

 l Use the E-mail Messages screen in the P/O Setup folder to create the e-mail message 
that you want to send to vendors.

 l Select an Email delivery method for each vendor that you want to e-mail. You set the 
delivery method on the Processing tab of the vendor record in Accounts Payable.

 l Check the print destination for forms and reports that you are printing.

To print a return immediately after posting it:

 1. Click Post while the return is displayed.

When Purchase Orders is finished posting the return, it displays a message asking whether to 
print the return.

 2. Click Yes to print the return. Purchase Orders opens the P/O Returns screen and selects the 
return that you just posted.
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 3. Select options for printing the return, as follows:

 l Use Purchase Order. Use the default report format for returns, or click Browse to select 
a different one. Mo re ...

Purchase Orders ships with two standard formats for printing returns:

 l PORET01.RPT—for printing on blank paper.

 l PORET02.RPT—for printing on preprinted forms.

Note: Purchase Orders displays the format that you last used for printing returns.

 l Delivery Method. Specify how to send documents to your vendor:

 l Select Print Destination to print to your usual print destination.

 l Select Vendor to use the delivery method specified in each vendor record in 
Accounts Payable.

If you select Vendor as the delivery method, select the ID for the e-mail message 
you send with e-mailed documents for vendors that use an e-mail delivery method.

 l Message ID. If you selected Vendor as the delivery method, select the ID for the 
message you want to send with the e-mailed return (if the vendor record uses an e-mail 
delivery method). Mo re ...

To view or edit the message for the selected ID, or to add a new e-mail message for 

returns, click the Zoom  button for the Message ID field.

 l Print Serial/Lot Numbers. Choose whether to print the serial and/or lot numbers of any 
serialized or lotted items included in the returns.

 l Require Mailing Labels. Choose whether to print the number of labels on the Return 
Totals tab for each return (select the Require Mailing Labels option) or only one label per 
return (do not select the option).

 l Use Custom Form. Do not select this option unless you are using a customized return 
form that requires it. (This option is for custom forms that do not use the report selection 
criteria sent by this print window.)

 4. Click Print.

Tip: If you are printing the return on a printer, you can click the Align button to print a sample 
copy of the return to check that the information prints in the right places on preprinted forms. 
If the sample form does not line up correctly, ensure that you have correctly inserted the 
forms in the printer.
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Printing Purchase Orders Reports
Use Purchase Orders Reports screens to print setup reports and analytical reports.

About Purchase Orders Reports

You can print a variety of reports to help you manage your     Purchase Orders system, and to help you 
analyze Purchase Orders transactions. Printed reports also serve as a source of backup information    
in case the data is damaged.

Note: If you use multicurrency accounting, some of these reports can include    source and 
functional-currency information. 

This section contains an overview of the Purchase Orders analytical and setup reports. 

Purchase Orders also comes with standard forms you can use to provide printed copies of 
transactions to vendors. For more information, see "About Purchase Orders Forms" (page 67).

Printing Reports

Purchase Orders prints reports to your usual print destination. When you print to any destination, 
Order Entry updates the report status to "Printed." For more information about print destinations, see 
"About Print Destinations" (page 221).

Purchase Orders comes with several report formats that you can use "as is," or you can adapt them 
for your own needs using SAP Crystal Reports®  for Sage 300. For more information, see "About SAP 
Crystal Reports" (page 66).

You can print all Purchase Orders reports on 8½-inch x 11-inch paper    or A4-sized paper. 

Tip: Printed reports can serve as a source of backup information in the event that data is lost or 
damaged.

For information about printing reports, see "Printing Purchase Orders Analytical and Setup Reports" 
(page 244).

Setup Reports   

Setup reports show the information entered to define     records you create when setting up or updating 
your Purchase Order system, and the options you selected    in the P/O Options screen and G/L 
Integration screen.
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 l "P/O Options Report Screen" (page 307).

 l "P/O G/L Integration Report Screen" (page 304).

 l "P/O Additional Costs Report Screen" (page 301).

 l "P/O E-mail Messages Report Screen" (page 303).

 l "P/O Ship-Via Codes Report Screen" (page 308).

 l "P/O Vendor Contract Costs Report Screen" (page 310).

 l "P/O Optional Fields Report Screen" (page 306).

 l "P/O Templates Report Screen" (page 309).

If you do not use Inventory Control, the program also    includes:

 l "P/O Account Sets Report Screen" (page 300)

 l "P/O Items Report Screen" (page 305)

 l "P/O Vendor Details Report Screen" (page 312).

 l "P/O Weight Units of Measure Report Screen" (page 313).

When you add, delete, or change any of these records, you should     print and file the corresponding 
reports to keep your printed records    up to date.

Analytical Reports   

Purchase Orders provides Status reports that let     you check on current orders, backorders, unfilled 
orders, lost orders,    and invoicing status. Status reports include:

 l "P/O Purchase Order Action Report Screen" (page 291).

 l "P/O Aged Purchase Orders Report Screen" (page 279).

 l "P/O Shippable Backorders Report Screen" (page 296)

Purchase Orders also provides Audit reports for printing    transaction lists, posting journals, and 
purchase history. Audit reports include:

 l "P/O Transaction List Report Screen" (page 297).

 l "P/O Posting Journals Screen" (page 285).

 l "P/O Purchase History Report Screen" (page 289).

 l "P/O Purchase Statistics Report Screen" (page 294).

 l "P/O Payables Clearing Audit List Report Screen" (page 284).

 l "P/O G/L Transactions Report Screen" (page 282).

If you do not use Inventory Control, the program also    includes:
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 l "P/O Item Transaction History Report Screen" (page 283)

Selecting a Printer for Reports

When your print destination is Printer, Sage 300 prints reports to the Windows default printer, unless 
you have assigned a specific printer to a report.

The ability to assign different printers to different reports at print time means that you are not limited to 
printing to the default printer. For example, you can use a different printer to print item labels than you 
use to print inventory worksheets.

To assign a specific report to a specific printer:

 1. Open the report screen that you want to assign to a printer.

 2. On the report screen, click File > Print Setup.

The program displays the Windows default printer, but you can change the printer for a specific 
report.

 3. Select the Specific Printer option, and then select from the list the printer to use for this report.

The printer list includes all printers that have been added to the Printers and Faxes list in 
Windows.

 4. Select a paper source if you want to use a particular paper tray or paper stock for this report.

 5. Click OK to close the Print Setup screen.

To clear the assigned printer for a specific report:

 1. On the Sage 300 Desktop, do one of the following:

 l Select (highlight) the icon for the report, and then click Object > Restore Defaults.

 l Right-click the icon for the report, and then click Restore Defaults on the list that 
appears.

 2. In the Restore Defaults screen, select the Print Settings option, and then click OK.

The print setup for that report is reverted to the desktop default.

To have the program prompt you to specify a printer and print options each time you 
print:

On the Sage 300 Desktop, click View > Print Preferences, and then select Confirm on print.
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Saving Default Report Settings

Sage 300 lets you save report settings as defaults for printing     Purchase Orders forms (such as 
purchase requisitions, POs, receiving slips,     returns, and mailing labels) and for several Purchase 
Orders Analytical     reports, including the Transaction List, Purchase Order Action Report,    Aged 
Purchase Orders, and Purchase History reports. 

To save current settings as defaults:

 1. Open the Purchase Orders      form or report for which you want to save printing settings.

 2. Choose the settings      that you want as defaults whenever you print this report or form.

 3. On the report menu, click Settings > Save      Settings As Defaults.

To clear saved settings:

 1. Open the Purchase Orders      form or report for which you want to reset printing settings.

 2. On the report menu, click Settings > Clear      Saved Settings,

Selecting a Print Destination

You can print reports to a printer, to the screen, to a file, or as an attachment to an e-mail message.

Note: If you are not assigned to a security group that has authorization to change the print 
destination, the only destination available is a physical printer.

To select a print destination:

 1. On the Sage 300 Desktop, click Print Destination.

 2. Select a print destination:

 l Printer. Print to a physical printer. Mo re ...

Note: If you have multiple printers, you can specify the one to use when you print. For 
more information, see "Selecting a Printer for Reports" (page 240).

Tip: If you want to confirm the destination printer, page size, and orientation each time 
you print a report, on the Desktop, click View > Print Preferences, and then select 
Confirm on print.
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 l Preview. Display reports in a preview screen. Mo re ...

Note: From the preview screen, you can do things such as saving the report to a file, or 
printing the report to a physical printer.

 l File. Print to a file. Mo re ...

When you print, you specify details about the file to create, including:

 l Format (for example, PDF, DOC, or XLS).

 l Destination.

 l Name.

 l Location.

 l E-mail. Print reports as attachments to e-mail messages. Mo re ...

You specify the type of file to create:

 l Adobe Acrobat (PDF). You can open PDF files with Adobe Acrobat Reader 
(available as a free download from the Adobe Software website).

 l Rich Text Format (RTF). You can open RTF files with most Windows and Linux 
word processing programs.

When you print a report, Sage 300 creates a PDF or RTF version of the report and 
attaches the report file to a new e-mail message.

 3. Click OK.

About Reporting General Ledger Data   

The G/L Transactions report is a listing of the general ledger transactions created by Purchase 
Orders that you might need to print as part of your audit trail.

If Purchase Orders uses the option to create G/L transactions using the Create Batch icon (on the 
P/O G/L Integration screen), you can print the G/L Transactions report from Purchase Orders after 
you run day-end processing, but before you create or append to general ledger batches. You can 
print this report whether or not you use Sage 300 General Ledger with the same database as 
Purchase Orders.

However, if Purchase Orders uses the option to create G/L Transactions during Day End Processing, 
you cannot print the G/L Transactions report from Purchase Orders. If you need this transaction 
information for your audit trail, you can print from your general ledger.
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About Vendor Delivery Methods for Purchase Orders Forms

You can send purchase orders and returns using the delivery methods and addresses specified in 
Accounts Payable vendor records. Mo re ...

Delivery methods include:

 l Mail

 l Email (customer)

 l Email (contact)

 l Email (multiple contacts)

When you print purchase orders and returns, you choose to print using the vendor's delivery method 
(Vendor), or you print all the documents to the current print destination.

If you choose Vendor, the program uses the delivery method from the vendor record.

 l Purchase orders and returns are sent by e-mail to vendors that use an e-mail delivery method, 
along with the e-mail message you select when you print these documents.

 l Purchase orders and returns are printed to your usual print destination for vendors that use 
Mail as the delivery method.

Printing the Purchase History Report

Print the Purchase History report to obtain summary or detailed purchase information   by vendor or 
inventory item. 

To print the Purchase History report:

 1. Open Purchase Orders > P/O Analytical Reports > Purchase History.

 2. Select Detail or   Summary from the Report Type list. Mo re ...

For Detail   reports, you can select purchase orders by document date or year/period,   and you 
can include serial and lot numbers for serialized or lotted items. 

For   Summary reports, you can select purchase orders only by year/period and   you cannot 
include serial and lot numbers on the report.

 3. Specify the range of year/periods or document dates for the report.

 4. In the Sort By list,  select how to report purchase history information (by vendor   number or item 
number).

 5. Specify the range of vendors and/or   items to include on the report. Mo re ...
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You can select ranges of vendor number and item numbers for Detail reports. 

For Summary   reports, you select numbers according to your choice for the Sort By option.

 6. If you selected the Include Serial/Lot Numbers option, specify the   ranges of serial numbers 
and lot numbers to appear on the report.

 7. If you use multicurrency   accounting, specify the range of currency codes for which to print 
transactions   (only transactions posted with the selected currency codes are listed),   and specify 
whether to print amounts in the vendor's currency or functional   currency.

 8. If you are printing a Detail   report, you use Sage 300 Project and Job Costing, and you want to 
include job information for all job-related   transactions, select   Include Job Details.

 9. Click Print.

Printing Purchase Orders Analytical and Setup Reports

Purchase Orders includes analytical reports that provide order status information, statistics, and 
transaction information. It also includes setup reports that provide basic setup record information.                   

For more information about the reports available in Purchase Orders, see "About Purchase Orders 
Reports" (page 238).

Purchase Orders prints reports to your usual print destination. When you print to any destination, 
Order Entry updates the report status to "Printed." For more information about print destinations, see 
"About Print Destinations" (page 221).

You can print all Purchase Orders reports on 8½-inch x 11-inch paper    or A4-sized paper. 

To print Purchase Orders reports:

 1. Open Purchase Orders > P/O Analytical Reports or P/O Setup Reports, and then select a 
report.

 2. Specify options to include the information you need on the report.

When the Print screen appears, you can press F1 to see detailed information about report 
options.

 3. Click Print.              
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Appendix A: Purchase Orders 
Screen Guides

Learn how to find and use Sage 300 screens. Each screen guide includes navigation information, 
field help, and a list of tasks you can use the screen to perform.
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Create Purchase Orders Screens
Use these screens to create purchase orders automatically from     current requisitions,     from reorder 
quantities     in Inventory Control, and from active sales orders    in Order Entry.

P/O Create POs From I/C Screen

To Open this Screen

Open Purchase Orders >       P/O Create Purchase Orders > Create POs from I/C.   

Related Tasks

 l "Creating Purchase Orders from Inventory Control Reorder Quantities" (page 115)

 l "Creating Purchase Orders from Order Entry Sales Orders" (page 117)

 l "Creating Purchase Orders from Requisitions" (page 120)

Overview   

Use this screen to create purchase orders automatically from the reorder    quantities that are defined 
for items in Inventory Control.

Note: You must set up vendors in Accounts Payable before you can create    Purchase Orders.

For more information, see "Creating Purchase Orders from Inventory Control Reorder Quantities" 
(page 115).

Assigning Dates and Purchase Order Numbers        

Purchase Orders creates a single purchase order for the specified vendor   and for every item and 
quantity that fits the criteria you defined. The program   assigns the next available purchase order 
number to the document, using   the length, prefix, and number for purchase orders on the P/O 
Options screen.
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Fields and Controls

Buttons

Close

Click Close to close the screen.

Process

Click Process to create and post the purchase orders you specified.

Above Maximum

Select this option to order the item quantity that will bring the quantity   on hand for each item up to at 
least the maximum amount specified for the item on the I/C Reorder Quantities screen.

Note: This choice can result in quantities that are higher than the maximum   amount.

Above Projected Sales for [ ] Days

Select this option to order the item quantity that will increase the   quantity on hand for each item to 
more than the number of units specified as the projected sales of the item   over the number of days 
you specify, beginning on the run date.

All Items

Select this option to order all selected items that are below their   maximum quantities in Inventory 
Control.

Create If The Vendor Is

If you want to select items by their vendor types, specify the vendor types for which to select items.

Items in the range you specify are selected if the vendor number for   which you are creating a 
purchase order is specified as one of the selected   vendor types in the vendor details record.

From/To Item Number

Use these fields to specify the range of items for which to create purchase orders.
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From/To Location

Use these fields to specify the range of locations.

From/To Vendor Number

Use these fields to specify the range of vendor numbers for which to create purchase orders.

Items Below Minimum

Select this option to order selected items if their quantities on hand   are below the minimum 
quantities entered for them on the I/C Reorder Quantities   screen.

Items Below Projected Sales for [ ] Days

Select this option to order items for which quantities on hand will   be below the period's projected 
sales for the number of days you specify.

Note: The run date sets the beginning date of the number of days   you specify.

Reorder Quantities For

Select Specific Location or All Locations.

 l If you select Specific Location, Purchase Orders calculates a separate   reorder quantity for 
each location.

 l If you select All Locations, Purchase Orders uses the sum of the quantities   at all locations to 
determine the quantity to order.

Run Date

Select the date   to assign to the purchase orders you create. This date is used to select the period   
from which to order items on the I/C Reorder Quantities screen.

Up to Maximum

Select this option to order the quantity of each item that will bring   the quantity on hand for the item up 
to or close to, but not over, the maximum amount specified on the I/C Reorder Quantities   screen.

Up to Projected Sales for [ ] Days

Select this option to order the item quantity that will bring each item's   quantity on hand up to or close 
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to, but not over, the projected sales   quantity for the number of days you specify, beginning on the 
run date.

Optional Fields tab

This tab appears only if optional fields are assigned to purchase orders on the P/O Optional 
Fields setup screen. 

Select the entries   you want to insert on the Optional Fields tab of each purchase   order you 
create.

If a Finder  appears beside an optional field, you see a default entry   for the field, and you 

can select another entry from the Finder.

Detail Optional Fields tab

This tab appears only if optional fields are assigned to purchase   order details on the P/O 
Optional Fields setup screen.

Select the entries   you want to insert on each detail line for each purchase   order.

If a Finder  appears beside an optional field, you see a default entry   for the field, and you 

can select another entry from the Finder.
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P/O Create POs From O/E Screen

To Open this Screen

Open Purchase Orders >       P/O Create Purchase Orders > Create POs from O/E.   

Related Tasks

 l "Creating Purchase Orders from Inventory Control Reorder Quantities" (page 115)

 l "Creating Purchase Orders from Order Entry Sales Orders" (page 117)

 l "Creating Purchase Orders from Requisitions" (page 120)

Overview   

If you use Sage 300 Order Entry with Purchase Orders, you can use the Create POs From O/E screen 
to create purchase orders automatically from Order Entry    sales orders.

The program creates a purchase order for each vendor of the  specified vendor type for the items and 
orders that meet the criteria you specify.

For instructions on creating purchase orders from sales orders, see "Creating Purchase Orders from 
Order Entry Sales Orders" (page 117).

Fields and Controls

Buttons

Process

Click the Process button to create and post the purchase orders that match your criteria.

Consolidate Items

If you do not select the Drop-Ship Items option, you can select this option   to consolidate details that 
have the same item number, location, and unit of   measure into single details on the purchase orders 
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for selected vendors.

Note: The Consolidate Items   check box is not available if any optional fields   are defined for 
purchase order documents or details.

Create Purchase Order for Each

Use the Create Purchase Order For Each field to specify whether to:

 l Create purchase orders   by vendor number, producing only one purchase order for each 
vendor (choose   Vendor), or

 l Create a separate purchase   order for each order number and each vendor listed on the order 
(choose   Order).

Drop-Ship Items

Select this option to include the drop-ship addresses entered for items   and customers on the Order 
Entry orders.

From/To Customer Number

Use these fields to specify the first and last customer numbers   in the range of customers for whom 
you want to create purchase   orders.

From/To Expected Ship Dates

Use these fields to specify the earliest   and latest expected ship dates in the range of ship dates for 
which to create purchase orders. (You can use the calendar associated with each field, or you can 
click the   fields, and then enter the dates manually.)

From/To Order Dates

Use these fields to specify the earliest   and latest order dates for which to create purchase orders. 
(You can use the calendar associated with each field, or you can click the   fields, and then enter the 
dates manually.)

From/To Order Number

Use these fields to specify the the first and last order numbers in   the range of Order Entry orders 
from which to create purchase orders.
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I/C Vendor Type

Select the vendor type to identify the item records for which you will   create purchase orders.

The program creates purchase orders only for item records that have   the selected vendor type 
assigned to them.

Include Non-Stock Items

Select this option to include non-stock items from Order Entry orders.   If you do not choose this 
option, non-stock items do not appear in   the Finder, and they are treated as non-inventory items.

Note: This option appears only   if you allow receipt of non-stock items in Inventory Control.

Reorder

Use the Reorder field to select the method by which to determine which items and quantities to   
order:

 l All   Items. Select this option to order all items and quantities   specified on the selected sales 
orders.

 l Items With Insufficient Quantities. Select   this option to order only items for which there are 
not enough units on   hand in Inventory Control to fill the selected orders.

 l Items On Backorder. Select this option to order   only the number of units of each item for 
which a backorder quantity exists   in the selected orders.

Note: The program subtracts any quantity of the specified items that was added   to a previous 
purchase order.

Optional Fields tab

You see this tab only if you have activated optional fields for the   purchase orders screen.

Optional Fields

On the Optional Fields tab, type or use the Finder to select the entries   you want the program to 
insert on the Optional Fields tab of each purchase   order.
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You can leave optional fields blank if they do not require entries (that   is, there is no Finder beside 
the field and no default entry in the field).

If an optional field has a Finder beside it, you see a default entry   for the field. You can select another 
entry from the Finder.

Detail Optional Fields tab

You see this tab only if you have activated optional fields for purchase   order details.

Detail Optional Fields

On the Detail Optional Fields tab, type or use the Finder to select   the entries you want the program 
to insert on each detail line on each   purchase order.

You can leave optional fields blank if they do not require entries (that   is, there is no Finder beside 
the field and no default entry in the field).

If an optional field has a Finder beside it, you see a default entry   for the field. You can select another 
entry from the Finder.
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P/O Create POs From Requisitions Screen

To Open this Screen

Open Purchase Orders >       P/O Create Purchase Orders > Create POs from Requisitions.   

Related Tasks

 l "Creating Purchase Orders from Inventory Control Reorder Quantities" (page 115)

 l "Creating Purchase Orders from Order Entry Sales Orders" (page 117)

 l "Creating Purchase Orders from Requisitions" (page 120)

Overview   

Use this screen to create purchase orders automatically from the requisitions    you have added in 
Purchase Orders.

For example,     you can create purchase orders automatically for specified ranges of requisition 
numbers, dates, and vendor numbers  . You can create purchase     orders for requisition details that do 
not have vendor numbers, assigning     vendors either by creating purchase orders for only one vendor 
number    or by selecting a vendor type used with items in Inventory Control. 

When you create purchase orders automatically, the program selects Active as the purchase order     
type, posts the purchase orders, and increases quantities on purchase    order in Inventory Control.

For more information, see "About Creating Purchase Orders Automatically" (page 110).

Fields and Controls

Buttons

Process

Click the Process button to create and post purchase orders that match your specified criteria.
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Consolidate Items

If you do not select the Drop-Ship Items option, you can select this option   to consolidate details that 
have the same vendor, item, unit of measure, location, and expected arrival date into   single details 
on the purchase order.

Requisition details that include drop-ship addresses are not consolidated. A separate detail line is 
created on the purchase order for each requisition   detail with a drop-ship address.

Note: The Consolidate Items   check box is not available if any optional fields   are defined for 
purchase order documents or details.

From/To Requisition Date

Use these fields to specify the first and last dates in the range of requisition dates for which you are 
creating purchase orders.

From/To Requisition Number

Use these fields to select the first and last requisition numbers   in the range of requisitions for which 
you are creating purchase orders.

From/To Vendor Number

Use these fields to select the first and last vendor numbers in   the range of vendors for which you are 
creating purchase orders.

Include Blank Vendors

Select this option to add requisition details with blank vendor numbers   to purchase orders created 
for vendors who are assigned to   items with the vendor type you specify in the Using I/C Vendor Type 
field.

Job Related

Select this option to create purchase orders from job-related requisitions.

Note: You cannot mix job-related and non-job-related requisitions   when creating purchase 
orders. If you want to create POs from both types   of requisitions, you must run this function twice.
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Using [I/C] Vendor Type

Select this option to add requisition details without vendor numbers   to purchase orders when the 
purchase order vendor is assigned in Inventory   Control item records as the vendor type specified for 
the requisition   details.

If you use Inventory Control, the field is named Using I/C Vendor Type.   If you use Purchase Orders 
as a stand-alone program (without Inventory   Control), it is called Using Vendor Type.

Note: The Using Vendor Type option appears only if you select the Include   Blank Vendors option.

Optional Fields tab

You see this tab only if you have defined optional fields for   purchase orders documents.

Optional Fields

On the Optional Fields tab, type or use the Finder to select the entries   you want the program to 
insert on the Optional Fields tab of each purchase   order.

If you use the same fields on requisitions and purchase orders, the   optional field entries on the 
requisition will appear by default on the   purchase orders unless you specify entries here.

If an optional field has a Finder beside it, you see a default entry   for the field. You can select another 
entry from the Finder.

Detail Optional Fields tab

You see this tab only if you have defined optional fields for purchase orders details.

Detail Optional Fields

On the Detail Optional Fields tab, type or use the Finder to select   the entries you want the program 
to insert for each detail line on the   purchase order.

If you use the same fields on requisitions and purchase orders, the   optional field entries on the 
requisition detail lines will appear by   default on the purchase orders unless you specify entries here.

If an optional field has a Finder beside it, you see a default entry   for the field. You can select another 
entry from the Finder.
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Purchase Orders Forms
Use the report forms that come with Purchase Orders to print purchase orders, requisitions, receiving 
slips, returns, and mailing labels, or select a customized version.

P/O Mailing Labels Screen

To Open this Screen

Open Purchase Orders > P/O Forms > Mailing Labels.

Related Tasks

 l "Selecting a Print Destination" (page 241)

 l "Printing Mailing Labels" (page 223)

Overview

Use mailing labels to attach address information to envelopes in which you are mailing documents to 
vendors and to shipments you are returning to vendors.

Mailing Labels Print Formats

Purchase Orders ships with two standard labels. 

 l POLABEL.RPT. A mailing label format that prints 12 labels [2-up].

 l POLABELP.RPT. A mailing label format that prints  14 labels. 

You can either use the label format that comes with Purchase Orders, adapt it to your needs, or 
design your own.

Fields and Controls

Buttons

Align
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You can use the Align button when printing to a printer. This   button lets you print a sample copy of 
the mailing label to check that the labels print properly on preprinted forms. (If the mailing 
information does not appear in the right places, ensure that the forms are correctly inserted in the 
printer.)

Print

Click the Print button to print the mailing label.

From/To

Enter the range of purchase order numbers for which to print labels.

Include Labels Already Printed

Select this option to print   labels you have already printed.

Print Only Labels Marked Required

Select this option to print labels for returns for which you selected the Require Mailing Labels option 
when you printed return forms.

Select

Use the Select field to choose whether   to print labels for purchase orders or returns.

Use Label

Use the Use Label field to select a mailing label format.

Purchase Orders ships with two standard labels. 

 l POLABEL.RPT. A mailing label format that prints 12 labels [2-up].

 l POLABELP.RPT. A mailing label format that prints  14 labels. 
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P/O Receiving Slips Screen

To Open this Screen

Open Purchase Orders > P/O Forms > Receiving Slips.

Related Tasks

 l "Selecting a Print Destination" (page 241)

 l "Sample Formats for Printed Forms" (page 69)

 l "Printing Receiving Slips" (page 224)

Overview

A receiving slip is a detailed list of the items you received from vendors,   and it includes any additional 
costs posted with the receipt.

Note: You can print copies of receiving slips only until they are completed. Once they are 
completed, you can no longer print them and, unless you keep transaction history, they will be 
deleted when you run Day End processing.

Receiving Slip Report Formats

The following receiving slip report formats are included with Sage 300:

 l PORCP01.RPT — A receiving slip format for printing on blank paper.

 l PORCP02.RPT — A receiving slip format for preprinted   forms.

 l PORCP03.RPT — An alternative format for printing on blank paper   that includes quantities 
received.

 l PORCP04.RPT — An alternative format for preprinted forms  that includes quantities received.

Pre-printed forms PORCP03.RPT and PORCP04.RPT also print cost information. If you want to hide 
costs on receiving slips, you will need to customize them. Mo re ...

For more information on designing and adapting forms and reports, see the Customizing Printed 
Forms guide, which is available online at 
https://cdn.na.sage.com/docs/en/customer/300erp/Sage300ERP_Documentation.htm.
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Fields and Controls

Buttons

Align

Click the Align button if you want to print a sample copy of a document to check that preprinted   
forms are correctly inserted in the printer.

Print

Click the Print button to print the report.

Include Receipts Already Printed

Select this option if you want to include receiving slip reports that have already been printed.

Print Serial/Lot Numbers

Select this option if you want to include   serial and lot numbers on the receiving slip.

From/To Receipt Number

Use the From and To Receipt Number fields to specify the   range of receipts for which to print 
receiving slips.

Use Receipt

Select a receiving slip report format to use.

The following receiving slip report formats are included with Sage 300:

 l PORCP01.RPT — A receiving slip format for printing on blank paper.

 l PORCP02.RPT — A receiving slip format for preprinted   forms.

 l PORCP03.RPT — An alternative format for printing on blank paper   that includes quantities 
received.

 l PORCP04.RPT — An alternative format for preprinted forms  that includes quantities 
received.
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Pre-printed forms PORCP03.RPT and PORCP04.RPT also print cost information. If you   want to hide 
costs on receiving slips, you will need to customize them. Mo re ...

For more information on designing and adapting forms and reports, see the Customizing Printed 
Forms guide, which is available online at 
https://cdn.na.sage.com/docs/en/customer/300erp/Sage300ERP_Documentation.htm.
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P/O Requisitions Screen

To Open this Screen

Open Purchase Orders > P/O Forms > Requisitions.

Related Tasks

 l "Printing Requisitions" (page 231)

 l "Selecting a Print Destination" (page 241)

Overview   

Use the P/O Requisitions screen to print a list of items you want to include on the purchase order that 
you plan to issue from the requisition. It can also list the vendors from whom you plan to purchase the 
items.

Note: 
You can print copies of requisitions only until they are completed. 

Once   they are completed, you can no longer print them and, unless you keep transaction history, 
they will be deleted   when you run Day End processing. 

Requisitions Report Formats

The following requisition report formats are included with Sage 300:

 l PORQN01.RPT. A requisition format for printing on blank paper.

 l PORQN02.RPT. A requisition format for preprinted forms.

 l PORQN03.RPT. An alternative format for printing on blank paper that includes optional fields.

You can also create your own requisition format using Sage 300's  report designer. Mo re ...

For more information on designing and adapting forms and reports, see the Customizing Printed 
Forms guide, which is available online at 
https://cdn.na.sage.com/docs/en/customer/300erp/Sage300ERP_Documentation.htm.

Print a requisition immediately after posting it in the Requisition   Entry screen, or use the Requisitions 
screen when you want to print several   requisitions together.

262Sage 300 2021 Purchase Orders User's Guide

https://cdn.na.sage.com/docs/en/customer/300erp/Sage300ERP_Documentation.htm


Fields and Controls

Buttons

Align

Click the Align button if you want to print a sample copy of a document to check that preprinted   
forms are correctly inserted in the printer.

Print

Click the Print button to print the report.

Include Requisitions Already Printed

Select this option if you want to include requisition reports that have already been printed.

From/To Requisition Number

Enter the range of requisition report numbers to print.

Use Requisition

Select a requisition report format to use. 

The following requisition report formats are included with Purchase Orders:

 l PORQN01.RPT — A requisition format for printing on blank paper.

 l PORQN02.RPT — A requisition format for preprinted   forms.

 l PORQN03.RPT — An alternative format for printing on blank paper   that includes optional 
fields.
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P/O Returns Screen

To Open this Screen

Open Purchase Orders > P/O Forms > Returns.

Related Tasks

 l "Selecting a Print Destination" (page 241)

 l "Printing Returns" (page 234)

 l "E-mailing Returns to Vendors" (page 234)

Overview

A purchase return is a detailed list of the items you are returning   to a vendor.

Returns Report Formats

The following return formats are included with Purchase Orders:

 l PORET01.RPT – A format for printing   returns on blank paper.

 l PORET02.RPT – A format for printing returns on preprinted forms.

You can print returns from Purchase Orders using the forms that come with the program, or you can 
use SAP Crystal Reports®  for Sage 300 to design the return forms you want to use. Mo re ...

For more information on designing and adapting forms and reports, see the Customizing Printed 
Forms guide, which is available online at 
https://cdn.na.sage.com/docs/en/customer/300erp/Sage300ERP_Documentation.htm.

Fields and Controls

Buttons

Align

Click the Align button if you want to print a sample copy of a document to check that preprinted   
forms are correctly inserted in the printer.
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Print

Click the Print button to print the report.

Delivery Method

Specify how to send documents to your vendor:

 l Select Print Destination to print to your usual print destination.

 l Select Vendor to use the delivery method specified in each vendor record in Accounts 
Payable.

If you select Vendor as the delivery method, select the ID for the e-mail message you send 
with e-mailed documents for vendors that use an e-mail delivery method.

Include Returns Already Printed

Select this option to print new copies of returns that were printed previously.

Message ID

This field appears only if you selected Vendor in the Delivery Method field.

Select the code for the message you want to send with the e-mailed returns.

Print Serial/Lot Numbers

Select this option to print serial and/or lot numbers on the return slip.

Require Mailing Labels

Select this option to print the number of labels specified on the Return Totals tab for each return.

If you do not select this option, only one label per return is printed.

From/To Return Number

Enter the range of returns for which to print the forms.

Use Custom Form

Select this option if you are using a customized   return form that requires it. 
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Note: This option   is for custom forms that do not use the report selection criteria set   by this print 
screen.

Use Return

Select a report format to use for printing the return.

The following return formats are included with Purchase Orders:

 l PORET01.RPT – A format for printing   returns on blank paper.

 l PORET02.RPT – A format for printing returns on preprinted forms.

You can print returns from Purchase Orders using the forms that come with the program, or you can 
use SAP Crystal Reports®  for Sage 300 to design the return forms you want to use. Mo re ...

For more information on designing and adapting forms and reports, see the Customizing Printed 
Forms guide, which is available online at 
https://cdn.na.sage.com/docs/en/customer/300erp/Sage300ERP_Documentation.htm.
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P/O Purchase Orders Screen

To Open this Screen

Open Purchase Orders > P/O Forms > Purchase Orders.         

Related Tasks

 l "Selecting a Print Destination" (page 241)

 l "Printing Purchase Orders" (page 227)

 l "E-mailing Purchase Orders to Vendors" (page 226)

Overview   

A purchase order is a detailed list of the items you plan to purchase   from a particular vendor you 
selected for the purchase order.

Print each purchase order immediately after posting it in the Purchase   Order Entry screen, or use the 
Purchase Orders screen to print several purchase   orders together when you need copies to send to 
vendors or for other reasons.

Note: You can print copies of purchase orders until they are completed. Once   they are completed, 
you can no longer print them, and, if you do not keep transaction history, they will be deleted   when 
you run Day End processing. 

E-mailing Purchase Orders to Vendors

If you e-mail purchase orders to your vendors, you can use one of the standard e-mail messages that 
come with the program, or you can create your own. For more information, see "Creating E-mail 
Messages" (page 45)

Printing Drop-Ship Addresses

If the purchase order includes drop-ship addresses, all details with the   same drop-ship address are 
printed together on the purchase order, followed   by the address, rather than printing an address with 
each detail line   that uses it.
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Purchase Order Print Formats

Purchase Orders provides four standard 8½-inch by 11-inch or A4-sized purchase order print 
formats, including two formats for preprinted forms.

The following print purchase order formats are included with Sage 300:

 l POPOR01.RPT. A purchase order format for printing on blank paper. 

 l POPOR02.RPT. A purchase order format for preprinted forms.

 l POPOR04.RPT. A purchase order format for printing on blank   paper and is non-data piped for 
greater flexibility.

 l POPOR05.RPT. A purchase order format for preprinted forms and is non-data piped for 
greater flexibility.

You can use these formats "as is," or you can create your own formats. Mo re ...

For more information on designing and adapting forms and reports, see the Customizing Printed 
Forms guide, which is available online at 
https://cdn.na.sage.com/docs/en/customer/300erp/Sage300ERP_Documentation.htm.

Fields and Controls

Buttons

Align

Click the Align button if you want to print a sample copy of a document to check that preprinted   
forms are correctly inserted in the printer.

Print

Click the Print button to print the purchase order.

Delivery Method

Specify how to send documents to your vendor:
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 l Select Print Destination to print to your usual print destination.

 l Select Vendor to use the delivery method specified in each vendor record in Accounts 
Payable.

If you select Vendor as the delivery method, select the ID for the e-mail message you send 
with e-mailed documents for vendors that use an e-mail delivery method.

Include

Select the type of purchase orders you want to print.

Include Details Already Printed

Select this option if you want to include details you printed before.

Include Purchase Orders Already Printed

Select this option if you want to print new copies of purchase orders that you have already printed.

Message ID

This field appears only if you select Vendor in the Delivery Method field.

Select the code for the message you want to send with the e-mailed purchase orders.

From/To Purchase Order Number

Use these fields to specify the range of purchase orders to print.

Use Custom Form

Select this option only if you are using a customized return form that requires it. (This option is for 
custom forms that do not use the report selection criteria set by this screen.)

Use Purchase Order

The following print purchase order formats are included with Sage 300:

 l POPOR01.RPT. A purchase order format for printing on blank paper. 

 l POPOR02.RPT. A purchase order format for preprinted forms.
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 l POPOR04.RPT. A purchase order format for printing on blank   paper and is non-data piped 
for greater flexibility.

 l POPOR05.RPT. A purchase order format for preprinted forms and is non-data piped for 
greater flexibility.

You can use these formats "as is," or you can create your own formats. Mo re ...

For more information on designing and adapting forms and reports, see the Customizing Printed 
Forms guide, which is available online at 
https://cdn.na.sage.com/docs/en/customer/300erp/Sage300ERP_Documentation.htm.
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Periodic Processing Screens
Use Purchase Orders Periodic Processing screens to create batches, and to clear history and 
inactive records.  If you use Purchase Orders as a stand-alone program, you can also use the Day 
End Processing screen to run Day End Processing.

P/O Clear History Screen

To Open this Screen

Open Purchase Orders > P/O Periodic Processing > Clear History.

Related Tasks

 l "Performing Day End Processing" (page 201)

 l "Clearing Historical Purchase Orders Data" (page 211)

Overview   

Use the Clear History screen to selectively clear (delete) data you no     longer want to keep in your 
Purchase Orders system, including:

 l Transaction history.

 l Purchasing history.

 l Purchase statistics.

 l Printed posting journals.

 l Payables Clearing Audit      list.

 l If you do not use Inventory      Control, item transaction history.

You can clear one or more types of data at the same time.

Fields and Controls

Credit/Debit Notes
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Select this option to clear the Credit/Debit Note Posting Journal up to and including  the specified 
day-end number.

From/To

Type the range of vendor numbers or item numbers or account sets for   which you want to clear 
history, or select the first and last records   in the range from the respective Finders.

Invoices

Select this option to clear the Invoice Posting Journal up to and including  the specified day-end 
number.

Payables Clearing Audit

Select this option to clear the Payables Clearing Audit list to the   year and period and for the account 
sets you specify.

Period

Type the period up to which you want to clear data.

Purchasing history will be cleared for all years and periods up to and   including the year and period 
you specify.

Printed Posting Journals

Select the Printed Posting Journals option to clear posting journals.   Then select the types of posting 
journals to clear. (You can clear any   combination of journals at a time, including Receipts, Invoices, 
Credit/Debit   Notes, and Returns.)

If you want to change the day-end number through which the program clears   printed posting 
journals, type over the number in the Through Day End   Number field. The field displays the most 
recent day-end number.

Clear History clears journal data up to and including the day-end number you specified. After 
clearing the journals, you can   no longer print them.

Purchase Statistics

Select this option to clear purchase statistics from the Purchase Statistics   screen, then specify the 
fiscal year and period up to which to clear the   data.
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Purchase statistics will be cleared for all years and periods up to   and including the year and period 
you specify.

Purchasing History

Select this option to clear data for the Purchase History screen and report,   then specify the fiscal 
year and period up to which to clear the data,   and the type and range of records to clear.

Purchasing history will be cleared for all periods up to and including   the period you specify.

Receipts

Select this option to clear the Receipts Posting Journal up to and including  the specified day-end 
number.

Returns

Select this option to clear the Return Posting Journal up to and including  the specified day-end 
number.

Select by

Specify whether to clear history by vendor number   or item number.

Through

Type the date up to which you want to clear data, or choose the date   from the calendar associated 
with the field..

Transactions are cleared up to and including the date you specify.

Through Day End Number

Type the day-end sequence number through which you want to clear posting   journals.

Through Year

Type the year up to which you want to clear data.

Purchasing history will be cleared for all years and periods up to and   including the year and period 
you specify.
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Transaction History

Select this option if you want to clear transaction history. To select   the option, either click the field or 
tab to the field, then press the   Spacebar.

When you select the Transaction History field, the Through field appears   for you to enter the 
clearing date.

274Sage 300 2021 Purchase Orders User's Guide



P/O Create Batch Screen

To Open this Screen

Open Purchase Orders > P/O Periodic Processing > Create Batch.

Related Tasks

 l "Creating a Batch of General Ledger Transactions in Purchase Orders" (page 209)

 l "Posting a Batch of Purchase Orders Invoices in Accounts Payable" (page 210)

Overview   

Use the Create Batch screen to: 

 l Create a batch of general ledger transactions (or append to an existing general ledger batch) 
from the receipt, invoice, return, credit note, and debit note transactions you posted in 
Purchase Orders.                 

You can use this screen to produce batches for the general ledger only if On Request Using 
Create Batch Icon is selected for the Create G/L Transactions option on the G/L Integration 
screen.

Purchase Orders creates and optionally posts the batch in General Ledger, depending on the 
selection for the Create G/L Transactions By option in the G/L Integration screen.

 l Post a batch of invoices in Accounts Payable from invoices or credit/debit notes posted in 
Purchase Orders.                 

You can use this screen to post invoices in Accounts Payable only if On Request Using Create 
Batch Icon is selected for the Post A/P Batches option      on the P/O Options screen.

Fields and Controls

Create G/L Batch

Select this option to create a batch of General Ledger transactions from   posted receipts, invoices, 
returns, credit notes, and debit notes, or to append transactions to an existing General Ledger 
batch.
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Through Day End Number

Specify the range of day end numbers to include in the General Ledger batch. The program includes 
transactions created up to and including the specified day-end number.

Post A/P Batch

Select this option to post a batch of invoices   in Accounts Payable from invoices or credit/debit notes 
posted in Purchase Orders.
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P/O Day End Processing Screen   

Note: This screen is available only if you are using Purchase Orders as a stand-alone program 
(that is, you do not use Inventory Control).

To Open this Screen

Open Purchase Orders > P/O Periodic Processing > Day End Processing.

Related Tasks

 l "Performing Day End Processing" (page 201)

Overview

If you use Purchase Orders as a stand-alone program, you use this screen to run Day End 
Processing.

Unless you cost inventory during transaction posting, you must run Day End Processing to update 
your audit trail and item statistics, to create general ledger inventory/expense transactions, and to 
update your Accounts Payable data.

Note: Most Day End Processing tasks will be performed during posting if you choose the Purchase 
Orders option to cost inventory items during posting.

Important! Day End Processing will not work until you assign a default cost expense account in the 
P/O G/L Integration screen.
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P/O Delete Inactive Records Screen

Note: This screen is available only if you are using Purchase Orders as a stand-alone program 
(that is, you do not use Inventory Control).

To Open this Screen

Open Purchase Orders > P/O Periodic Processing > Delete Inactive Records.

Related Tasks

 l "    Deleting Inactive Purchase Orders Records" (page 214)

Overview   

If you use Purchase Orders as a stand-alone program, you can use the Delete Inactive Records 
screen to remove obsolete item and account set records. The     form removes records only if they 
currently have an Inactive status and    were set to inactive within the range of dates you specify.

Fields and Controls

Delete Inactive Account Sets

Enter the range of codes or numbers for the account   set records you wish to delete, or use the 
Finder to select the ranges.

Delete Inactive Items

Enter the range of codes or numbers for the item   records you want to delete, or use the Finder to 
select the ranges.

Inactive Dates

Enter a range of dates to indicate when a record must have been made   inactive to delete it. 
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Purchase Orders selects records that have a status   of Inactive and a corresponding "inactive" date 
within the range   of dates you specify.

The default To date is the current session date.

If you do not want to delete all the records in a range of inactive   dates, process each set of records in 
separate ranges.

Reports
Use Purchase Orders report screens to print setup reports and analytical reports.

Analytical Reports

Print reports on Purchase Orders transactions, statistics, purchase history, and more.

P/O Aged Purchase Orders Report Screen

To Open this Screen

Open Purchase Orders > P/O Analytical Reports >  Aged Purchase Orders.

Related Tasks

 l "Selecting a Print Destination" (page 241)

 l "Printing Purchase Orders Analytical and Setup Reports" (page 244)

Overview   

Print the Aged Purchase Orders report periodically to  identify purchase orders that have   not been 
completed. 

The Aged Purchase Orders report lists all incomplete purchase   orders and their relative ages in the 
system. It compares the Aged As Of dates to the   order dates and determines the aging category to 
which each order belongs. Mo re ...

 l The Aged As Of date which   determines the aging period to which each purchase order 
belongs.
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 l The subtotal for the current   period and each aging period, and the grand total of all aged 
purchase   orders.

 l The amount of purchase   orders for each period, expressed as a percentage of the grand total 
(single-currency   ledgers only). (Shows where the bulk of aged purchase orders occurs.)

 l Amounts in the functional   or vendor currency (multicurrency ledgers).

 l Report subtotals and,   in multicurrency ledgers, a grand total for each currency.

You can list all or a range of purchase orders by purchase order number,   vendor number, or currency 
(in multicurrency systems). You specify the   number of days in each of three aging periods. There is 
also a current   period and a fifth period, which includes purchase orders that have been   outstanding 
for more than the number of days in the last period you specified.   (You set default report periods in 
the P/O Options screen.)

In multicurrency ledgers, you also specify:

 l The range of currency codes   to use to select transactions for the report. (Only the transactions   
entered in the selected currencies are printed.)

 l Whether to print amounts   in the vendor currency or in the functional currency.

Fields and Controls

Aged as of

Enter the date from which you   want purchase orders aged.

All purchase orders older than the Aged As Of date   fall into one of the aging periods. Purchase 
orders more recent   than the Aged As Of date (and up to the cutoff date) appear in the Current   
column.

Cutoff Date

Enter the date   of the most recent purchase order you want listed. The report does not   list orders with 
a document date later than this date. If you do not want   to list any current purchase orders, enter the 
same date you entered in the Aged as   of field.

From/To Purchase Order

Use these fields to specify a range of purchase orders  to include on the report.
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From/To Vendor Number

Use these fields to specify a range of vendor numbers to include on the report.

Include Extra Information

Select the Contact/Phone option and the Space for Comments option to include  contact names, 
phone numbers, and comments on the report.

Sort By

Select the sorting order for the report: by purchase order number, vendor number, or currency 
code.

Use Aging Periods

The number of days in each report aging period. The default aging periods are defined in the P/O 
Options screen.
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P/O G/L Transactions Report Screen

To Open this Screen

Open Purchase Orders > P/O Analytical Reports > G/L Transactions.

Related Tasks

 l "Selecting a Print Destination" (page 241)

 l "Printing Purchase Orders Analytical and Setup Reports" (page 244)

Overview   

Print the G/L Transactions report to obtain a list of the general ledger   journal entries created from all 
transactions posted in Purchase Orders   since the last time you created the general ledger batch. You 
can print detailed or summary versions of the report.

You should print the report before   you use the Create Batch screen to produce general ledger 
transactions.   When you create the general ledger batch, the program erases the data   for the G/L 
Transactions report.

In multicurrency systems, you can print amounts either in the functional   currency or in the source 
(vendor) currencies in which you posted the   transactions in Purchase Orders.

Note: You cannot print   the G/L Transactions report if Purchase Orders creates   transactions during 
posting or day-end processing. Mo re ...

The option Create G/L Transactions (on the Integration tab of the P/O G/L Integration screen) 
determines whether and when you can print this report:

 l During Day End Processing. If Purchase Orders uses this option, the program sends general 
ledger transactions immediately to General Ledger. You can view the transactions only in 
General Ledger, and you cannot print the G/L Transactions report in Purchase Orders.

 l On Request Using Create Batch Icon.  If Purchase Orders uses this option, you can print the 
report in Purchase Orders after you post transactions or run Day End Processing (depending 
on when you cost inventory), but before you create G/L batches.

Tip: Remember to run Day End Processing   before you create the general ledger batch if you want 
to include the   latest costing information in the report. For more information, see "Performing Day 
End Processing" (page 201).
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P/O Item Transaction History Report Screen

Note: This screen is available only if you are using Purchase Orders as a stand-alone program 
(that is, you do not use Inventory Control).

To Open this Screen

Open Purchase Orders > P/O Analytical Reports >  Item Transaction History.

Related Tasks

 l "Selecting a Print Destination" (page 241)

 l "Printing Purchase Orders Analytical and Setup Reports" (page 244)

Overview   

If you do not use Sage 300 Inventory Control, you can print the Item    Transaction History report from 
Purchase Orders when you want to review transaction history by item,    or list transactions from all 
posting journals.

The Item Transaction History report lists all transactions posted for     the items assigned to the account 
sets and period that you select for     the report. The report also shows the net change to the 
Inventory/Expense    account for the account set and period. Mo re ...

Item transaction history is accumulated and reported according to the     fiscal year you defined in 
Common Services. Transactions are accumulated     for this report only if you use the Keep Transaction 
History option in    the P/O Options screen.

Transactions cleared by the Clear History screen is not included    in the report.
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P/O Payables Clearing Audit List Report Screen

To Open this Screen

Open Purchase Orders > P/O Analytical Reports > Payables Clearing Audit List.

Related Tasks

 l "Selecting a Print Destination" (page 241)

 l "Printing Purchase Orders Analytical and Setup Reports" (page 244)

Overview   

This report lists the debits and credits posted to the Payables Clearing   account for  receipts, invoices, 
returns, credit notes, and debit notes. Use the list to reconcile the Payables Clearing   account.

Data for the report includes everything back to the year and period   from which you keep history. If you 
do not keep history, the report prints   only transactions created by the last time you ran Day End 
Processing.

If you keep history, the report lists transactions that occurred during and since the last year and fiscal 
period for which you keep history.

The report shows the account sets, fiscal years, and periods you choose   and, if you have a 
multicurrency ledger, it also reports in the currency   you choose. If you include source currencies for 
the report, there are also totals for each currency. Mo re ...

 l In a multicurrency ledger,   the report shows whether you chose the functional currency or a 
combination   of the functional and source currencies. When you choose to print the   report in 
source and functional currency, a Currency heading appears.   The currencies are listed under 
each account set and the vendors are grouped   by the currency they use.

 l The details of the transaction   are shown, including the vendor numbers and names. 

 l The report shows the amount   debited or credited to the account for each receipt, invoice, 
return,   debit note, and credit note transaction. 

 l The report shows the total   debits and credits by period and the total for each account set (AVG.   
in the example) during the time specified for the report. 
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P/O Posting Journals Screen

To Open this Screen

Open Purchase Orders > P/O Analytical Reports > Posting Journals.

Related Tasks

 l "Selecting a Print Destination" (page 241)

 l "Printing Purchase Orders Analytical and Setup Reports" (page 244)

Overview   

The Receipts, Return, Invoice, and Credit/Debit Note Posting Journals   are part of your Purchase 
Orders audit trail. 

Tip: Print the posting journals at the end of each day, as part of your day-end   procedure and audit 
trail documentation. 

The journals contain the   detailed record of the general ledger transactions arising from the receipts,   
invoices, returns, credit notes, and debit notes posted in Purchase   Orders. Mo re ...

 l On the Receipts Posting   Journal, the additional cost amount prorated to each item detail.

 l Details of each transaction   of the selected type. (You can list transactions by day end number, 
transaction   date, vendor number, or transaction number.)

 l On the Receipts Posting   Journal, the secondary (additional cost) vendor, description, amount,   
tax, and proration information. (Select the Include Additional Costs option   to include this 
section.)

 l Tax information for the   document. (Select the Include Tax Summary option to include this 
section.)

 l Job-related information   if you have Project and Job Costing.

 l Serial and lot numbers   for applicable items. (Select the Include Serial/Lot   Numbers check box 
to include.)

 l Optional field information   if you use Optional Fields.
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 l On multicurrency reports,   the totals for the journal in both functional and source (vendor) 
currencies.

 l A General Ledger Distribution   Summary, which includes the debit and credit totals for each 
account affected   by the transactions on the journal. The multicurrency version of the summary   
lists totals in both functional and source (vendor) currencies.

In multicurrency systems, posting journals list the vendor's currency   code for each transaction, along 
with the exchange rate, rate type, and   rate date. The journals include amounts in both the vendor's 
currency   and the functional currency.

Note that return posting journals and credit note posting journals display   numbers as negative 
amounts. (This applied to quantities, extended amounts,   prorated additional costs, tax summary 
amounts, retained amounts, and   job expensed amounts.) 

Example: If you post a return of 5 items, the   return posting journal will display a quantity of "-5." If 
you   later adjust the return to 2 items, the Return Posting Journal will show   a +3 to record the 
change in quantity.

Fields and Controls

From Day End Number

Specify the range   of day-end numbers for which you are printing the report.

Include Accounts Payable Audit

Select this check box    to help you match postings in Purchase Orders to Accounts Payable 
transactions. This field is available only if Credit/Debit Notes is selected in the Select Posting Journal 
area.

Include Additional Costs

Select this check box to include   additional costs on receipt journals. This field is available only if 
Receipt is selected in the Select Posting Journal area.

Include Job Details

If you have Sage 300 Project and   Job Costing, select this check box to print job-related information.
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Include Optional Fields

Select this check box  to include optional field information on posting journals (if you use   Optional 
Fields).

Include Serial/Lot Numbers

Select this check box to include serial   and or lot numbers for applicable items on the report. 

Include Tax Reporting Information

Select this check box to include   a summary of taxes.

Paper Size

Select the paper size for printing.

Reprint Previously Printed Journals

Select this check box   to reprint journals you have printed before.

Select Posting Journal

Select the type of transaction   for which to print a posting journal (Receipt, Return, Invoice, 
Credit/Debit   Note).

Sort By

Select the method by which   to group transactions on the journal:

 l Day   End Number— lists transactions by the Day End Processing run when they were posted,   
beginning with transactions posted during the earliest selected day-end.

 l Transaction   Date—lists   transactions in order of their transaction date (such as the receipt 
date   for receipt transactions). The transaction with the earliest date is listed   first.

 l Vendor   Number—lists   transactions by vendor number so that you can easily see all 
transactions   posted for each vendor. 

 l (Transaction)   Number—lists   transactions by their document numbers (Receipt Number, 
Return Number,   Invoice Number, Credit/Debit Note Number), beginning with the lowest 
number.
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To Day End Number

Specify the range   of day-end numbers for which you are printing the report.
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P/O Purchase History Report Screen

To Open this Screen

Open Purchase Orders > P/O Analytical Reports > Purchase History.

Related Tasks

 l "Selecting a Print Destination" (page 241)

 l "Printing Purchase Orders Analytical and Setup Reports" (page 244)

 l "Printing the Purchase History Report" (page 243)

Overview   

Print this report to obtain summary or detailed purchase information   by vendor or inventory item. Mo re ...

 l Transactions can be listed      by vendor number or item number.

 l The detail report includes       all item details posted for the vendor in the selected periods, and lists       
the year, period, transaction type, date, transaction number, location       (if you use Inventory 
Control), quantity, cost, and unit of measure, and       the number of days between the purchase 
order and receipt posting dates      for each item detail.

 l The detail report lists       all purchases of an item from the vendor in the selected period, and it       also 
lets you include job details if you use Purchase Orders with Project      and Job Costing.

 l The detail report can       provide serial and lot numbers for applicable items if the Include 
Serial/Lot       Numbers check box on the Purchase History Report screen is selected. You       will be 
prompted to enter a start and end range for serial and lot numbers      you want included in the 
report.

 l The summary report lists       the year and period, total quantity received of each item (in stocking       
units), total cost, quantity returned, and return, credit note, and debit      note totals.

 l The summary report consolidates       details with the same item number, year, period, and date 
into single      details.

 l The multicurrency version       of the report includes each vendor's currency code. You can print 
amounts      in the functional currency or in the vendors' currencies.

Because Summary reports provide less information   than Detail reports, some fields will be hidden if 
you select Summary   in the Report Type list. For instance, summary   reports retrieve purchase orders 
from a range using specific years and   periods, while detail reports can also select by Document Date 
and filter   by Item Number.
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You can use the report as a purchases journal, to record     purchases by vendor or item, and to indicate 
the strengths and weaknesses    in company purchasing history.

Tip: Print this report after running Day End Processing, at the end of an accounting cycle,   or any 
time you want to check your purchasing history.
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P/O Purchase Order Action Report Screen

To Open this Screen

Open Purchase Orders > P/O Analytical Reports > Purchase Order Action.

Related Tasks

 l "Selecting a Print Destination" (page 241)

 l "Printing Purchase Orders Analytical and Setup Reports" (page 244)

Overview   

Print the Purchase Order Action report to view a summary or detail   list of your current purchase 
orders. 

 l Detail reports can be sorted by   purchase order number, vendor number, or item number. The 
detail report allows you to   sort by Item Number and filter by Item Status.

 l The summary report lists the date, expected arrival date, vendor number   and name, and the 
purchase order amount for each purchase order selected   for the report. Summary   reports can 
not be sorted by Item Number, nor can they be filtered by   Item Status. 

Depending on the options you select, the report:

 l Displays the item (detail)   status you selected for the report. (You can list all details, or only   
those details that are either completed with no receipts, completed, or   incomplete.)

 l Shows the vendor's currency   (multicurrency systems only).

 l Lists the amount and percentage   by which received quantities differ from the quantities 
entered with the   purchase order.

 l Lists the item details   on the purchase order.

 l Lists job-related information   entered with purchase orders (If you have Project and Job 
Costing).

 l Includes optional field   information (If you use Optional Fields). 
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Fields and Controls

From/To (Sort By)

Enter a start and end range of numbers   for the selection you made in the Sort By field.

From/To (Then By)

Specify the start and   end range for the secondary sort option (displayed at the Then By field). If   you 
are printing a Detail report, select the range   for the third sort option.

From/To Expected Arrival Date/Purchase Order Date

Enter a start and end date range for the selection made at the Select By field.

From/To Item Number

Select a range   for the third sort option. This field is available only if Detail is selected at the Report 
Type field. 

Item Status

Specify whether to select purchase orders with all items defined in   the range, or items that are partly 
complete, complete, or incomplete. This field is available only if Detail is selected at the Report Type 
field. 

Job Details

If you are printing a   detail report and you use Sage 300 Project and Job Costing, select this check 
box to include job-related information   with purchase orders.

Optional Fields

If you are printing a detail report, and you use optional fields, select this check box to include optional 
field information with purchase orders.

Print Amounts in

In multicurrency ledgers,   select to print amounts in the functional or vendor currency. This field 
appears only if a multicurrency ledger is set up.
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Print Status

Specify whether to print all purchase orders in the range, or only   those that are posted or printed.

Purchase Order Source

Select a purchase order   source. 

Purchase Order Type

Select a purchase order type. You can choose   all purchase orders, those that have yet to be 
received, partially received   or are on hold.

Report Type

Select a report type. If you select Detail, you can sort the report by purchase order number, vendor 
number, or item number.   Summary reports can only be sorted by purchase order number or vendor   
number.

Select By

Select whether to list purchase orders by expected arrival date or purchase order date. Then enter a 
start and end date range for the selection made.

Sort By

Specify the start and   end range for the secondary sort option, which is automatically determined   for 
you and displayed in the Then By field. If   you are printing a detail report, select the range   for the third 
sort option.

Then By

This field displays a secondary sort option based on the selection made at the Sort By field.
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P/O Purchase Statistics Report Screen

To Open this Screen

Open Purchase Orders > P/O Analytical Reports > Purchase Statistics.

Related Tasks

 l "Selecting a Print Destination" (page 241)

 l "Printing Purchase Orders Analytical and Setup Reports" (page 244)

Overview  

This report lists statistics accumulated from Purchase Orders transactions   since you last cleared the 
purchase statistics data for the period you   specify. 

Statistics are reported for the type of year (fiscal or calendar)   and period you specified for the 
Accumulate Statistics option in the P/O Options   screen. Mo re ...

Information printed on the report includes:    

 l Amounts in source (vendor) currencies (multicurrency reports). 

 l Source-currency code and description. The program prints a set of statistics for each source 
currency   (multicurrency reports).

 l The net purchase amount.   

The net purchase amount does not include additional   costs or taxes. All other dollar amount 
items on the report do include   additional costs and taxes.

The report can help you understand and analyze the level of processing   in your Purchase Orders 
system. Note that you must use the Keep Purchase   Statistics option in the P/O Options screen to print 
this report.

Tip: Print the report when you need to check the volume of purchase orders, receipts, invoices,   
credit notes, and debit notes you processed during a period. You can print   the report after running 
Day End processing, only if you use the Accumulate   Statistics option.
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Fields and Controls

Consolidate Currencies

Select whether to consolidate   statistics for the range of currencies you specify. This field appears 
only if you have a multicurrency company.

From/To Currency

Enter a range of currency codes (to list only the purchase   orders entered in the selected currencies).  
This field appears only if you have a multicurrency company.

From Year/Period / To Year/Period

Specify the range of year/periods for which to print the report.

Print Amounts in

Specify whether to print amounts in vendor currency or functional   currency. This field appears only if 
you have a multicurrency company.
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P/O Shippable Backorders Report Screen

To Open this Screen

Open Purchase Orders > P/O Analytical Reports > Shippable Backorders.

Related Tasks

 l "Selecting a Print Destination" (page 241)

 l "Printing Purchase Orders Analytical and Setup Reports" (page 244)

Overview   

The Shippable Backorders report lists the sales orders that you may     be able to fill as a result of 
receipts you have posted in Purchase Orders.

The report lists receipt details that were posted with order numbers,     showing the item and amount 
received at each location. (Location information    appears only if you use Inventory Control).

The report contains meaningful data only if you enter sales order numbers   with detail lines on 
receipts. If you use Sage 300 Order Entry with   Purchase Orders, you can select order numbers from 
Order Entry and include   them on the report.

Tip: Print the report after posting receipts to find out which sales orders   you may now be able to fill.
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P/O Transaction List Report Screen

To Open this Screen

Open Purchase Orders > P/O Analytical Reports > Transaction List.

Related Tasks

 l "Selecting a Print Destination" (page 241)

 l "Printing Purchase Orders Analytical and Setup Reports" (page 244)

Overview    

Use the Transaction List to print detailed or summary listings of   all current Purchase Orders 
transactions.

Print the report for information about current transactions and,   if you keep transaction history, about 
past transactions you have not   yet cleared.

You can sort transaction reports   by transaction number or vendor number, and you can specify a 
range of   transaction numbers, vendor numbers, and currency codes (if you have a   multicurrency 
system) by which to select the transactions to report. Mo re ...

Depending on the printing options you select, the report lists:

 l The currencies selected   for the report (multicurrency systems only).

 l The optional information   selected for the report.

 l The serial and lot numbers   when working with transactions involving serialized and/or lotted 
items.   

 l Total amount of the purchase   order. In multicurrency systems, the vendor currency is identified 
and   the total is shown in both source (vendor) and functional currencies.

The summary report includes the outstanding purchase order total together   with the numbers, dates, 
and totals of any receipts, invoices, returns,   credit notes, and debit notes that were posted with the 
purchase order   number.
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Note: If you do not keep transaction history, Purchase Orders deletes transaction   information when 
you run Day End processing. If you keep transaction history,   you delete the data for the reports 
using the Clear History   screen at a time of your choosing.

Fields and Controls

From/To (Sort By)

Select the range of transaction   numbers, vendor numbers, and currencies (if you have a 
multicurrency system).

From/To (Then By)

Select the range of transaction numbers for the secondary sort option displayed at the Then By field.

Include

Select the additional   information you want to include in the report such as the entries from   the 
"Information" tab for the transaction type, transaction   details, addresses, requisition numbers (for 
purchase orders) and additional   costs (for receipts). You can also choose job details (for job-related   
transactions),   and serial/lot numbers (if working with transactions involving serialized/lotted   items).

Print

Select the type of transaction to print.

Report Type

Select the type of report to print.

Sort By

Specify whether to sort the report by vendor number or transaction number. 

Source

Specify whether to print purchase orders or requisitions that were manually entered or entered from 
the Internet. 
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Status

When printing the Purchase   Order or Requisition List, select the statuses to include (Entered, 
Purchase   Order Printed, Never Received, Partially Received, Completed, On Hold). Also select to 
sort the report by vendor number or transaction number. 

Then By

This field displays a secondary sort option based on the selection made at the Sort By field.

Type

Select the types of purchase orders to list. These options appear only if Purchase Orders is selected 
at the Print field.
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Setup Reports

Print reports that list setup options for your Purchase Orders system.

P/O Account Sets Report Screen

Note: This screen is available only if you are using Purchase Orders as a stand-alone program 
(that is, you do not use Inventory Control).

To Open this Screen

Open Purchase Orders > P/O Setup Reports > Account Sets.

Related Tasks

 l "Printing Purchase Orders Analytical and Setup Reports" (page 244)

 l "Selecting a Print Destination" (page 241)

Overview

If you use Purchase Orders without Inventory Control, you can print the Account Sets report from 
Purchase Orders to list descriptions and numbers of the general ledger accounts in your Purchase 
Orders account sets.

The report lists, for each account set:

 l The account numbers for the Payables Clearing and Inventory/Expense accounts.

 l The date on which the account set was last edited (Last Maintained).

 l The date the account set became inactive. The date appears in the Inactive On column.
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P/O Additional Costs Report Screen

To Open this Screen

Open Purchase Orders > P/O Setup Reports > Additional Costs.

Related Tasks

 l "Selecting a Print Destination" (page 241)

Overview

Print the Additional Costs report to list the information entered to define each of the additional cost 
codes used in your Purchase Orders system. Additional costs are extra charges, such as for shipping 
and handling, that are entered separately from the costs of the items you purchase, then prorated to 
item costs, if you wish. Print the report when you change information for the additional cost codes you 
have defined.

Information Printed on the Report

If you list the costs by vendor number, additional costs entered without vendor numbers appear first.

The report lists each cost's default amount and proration and reproration methods. You can change 
this information when you enter the cost on a new transaction.

When you edit an additional cost or make it inactive, the dates are listed in the Last 
Maintained/Inactive On column.

Fields and Controls

From Additional Cost

Enter a range of additional cost codes to print.

From Currency

For multicurrency ledgers, enter the range of currencies to include.
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From Vendor Number

Enter a range of vendor numbers to print.

Include Optional Fields

Select this option to print optional fields on the report.

Sort By

Specify whether to print data by additional cost code or vendor number first.

To Additional Cost

Enter a range of additional cost codes to print.

To Currency

 For multicurrency ledgers, enter the range of currencies to include.

To Vendor Number

Enter a range of vendor numbers to print.
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P/O E-mail Messages Report Screen

To Open this Screen

Open Purchase Orders > P/O Setup Reports > E-mail Messages.

Related Tasks

 l "Selecting a Print Destination" (page 241)

Overview

Print the E-mail Messages report to see a list of all the e-mail messages defined for purchase orders 
and returns.

Information Printed on the Report

The report includes, for each e-mail message:

 l The message type.

 l The message ID and description.

 l The subject.

 l The body of the message.

 l The last maintained date.

 l The Inactive date, if applicable.
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P/O G/L Integration Report Screen

To Open this Screen

Open Purchase Orders > P/O Setup Reports > G/L Integration.

Related Tasks

 l "Selecting a Print Destination" (page 241)

Overview

The G/L Integration report lists the G/L transaction and batch creation options and other information 
you entered in the G/L Integration screen to specify how your Purchase Orders system sends 
transactions to General Ledger.

When to print

Print the report before and after changing options.

Information printed on the report

 l General ledger integration options.

 l Information transferred from source transactions to G/L transaction fields.

304Sage 300 2021 Purchase Orders User's Guide



P/O Items Report Screen

Note: This screen is available only if you are using Purchase Orders as a stand-alone program 
(that is, you do not use Inventory Control).

To Open this Screen

Open Purchase Orders > P/O Setup Reports > Items.

Related Tasks

 l "Selecting a Print Destination" (page 241)

 l "Printing Purchase Orders Analytical and Setup Reports" (page 244)

Overview

Print the Items report to list the information entered for each item on the Items screen (for example, 
when you need a quick reference list of item information or after adding, deleting, or changing item 
records).

Depending on your selections, the report can list the following information:

 l Information entered on the Item Information tab.

 l Text entered in the Comment fields on the Item Information tab.

 l All defined units of measure, as entered on the Item Units tab, and the corresponding 
conversion factors for each unit.

 l The authorities and other tax information entered on the Item Tax Classes tab.

 l Optional field information entered on the Optional Fields tab.

 l Item vendor information from the Vendor Details screen, including vendor type, vendor 
number, vendor name, and vendor item number.
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P/O Optional Fields Report Screen

To Open this Screen

Open Purchase Orders > P/O Setup Reports > Optional Fields.

Related Tasks

 l "Selecting a Print Destination" (page 241)

Overview

This report lists the optional fields you defined for Purchase Orders.

Information Printed on the Report

For each type of optional field, the report shows the optional field codes, descriptions, default values, 
and whether the optional field is set for automatic insertion in new records.

When to Print

Print the report when you add, change, or delete optional field records, or when you need a listing of 
all the optional fields set up for Purchase Orders.

Fields and Controls

Show Settings

Select this check box to print optional fields settings on the report. 
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P/O Options Report Screen

To Open this Screen

Open Purchase Orders > P/O Setup Reports > Options.

Related Tasks

 l "Selecting a Print Destination" (page 241)

Overview

Print the Options report to list the information and options you entered when you set up your 
Purchase Orders system, or when you change the information using the P/O Options screen.

Information printed on the report

The report lists:

 l The company address, and the Purchase Orders contact person and telephone number.

 l In multicurrency ledgers, the functional (home) currency and the default exchange rate type.

 l Processing options specified in the P/O Options screen:     

 l Whether you allow entry of non-inventory item numbers with Purchase Orders 
transactions.

 l Whether you keep transaction history.

 l The default template you use for entering new orders.

 l The default item cost you use when displaying item costs in transactions.

 l Whether and how you accumulate purchase statistics.

 l Whether and how you accumulate purchase history.

 l The number of days in the default aging periods for the Aged Purchase Orders report.

 l The size, prefix, and next number to assign as the document number for requisitions, purchase 
orders, receipts, and returns.

 l How you process general ledger transactions for your Purchase Orders system, as well as the 
default inventory expense account, default cost expense account, and non-inventory payables 
clearing account you use.
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P/O Ship-Via Codes Report Screen

To Open this Screen

Open Purchase Orders > P/O Setup Reports > Ship-Via Codes.

Related Tasks

 l "Selecting a Print Destination" (page 241)

Overview

Print the Ship-Via Codes report to list the ship-via codes defined in Purchase Orders. Ship-via codes 
are specified on requisitions, purchase orders, receipts, and returns to identify the shipping method 
or carrier by which your vendors ship goods to you or which you will use to return goods to vendors 
(for example, courier, air mail, parcel post).

Print the report when you change ship-via information.

Information Printed on the Report

 l Ship-via codes and descriptions.

 l Names, addresses, telephone numbers, and contacts for all listed ship-via codes.

Fields and Controls

From Ship-Via Code

Specify a range of ship-via codes.

To Ship-Via Code

Specify a range of ship-via codes.
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P/O Templates Report Screen

To Open this Screen

Open Purchase Orders > P/O Setup Reports > Templates.

Related Tasks

 l "Selecting a Print Destination" (page 241)

Overview

The Templates report lists the information entered to define the templates that are used in your 
Purchase Orders system.

You can speed up and simplify Purchase Orders by setting up templates. Templates provide default 
information and settings when you add a new transaction.

Print the report when you add or change templates.

Information Printed on the Report

 l Template codes and descriptions.

 l The information entered and selections made to define the templates.

Fields and Controls

From Template Code

Specify the range of template codes.

To Template Code

Specify the range of template codes.
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P/O Vendor Contract Costs Report Screen

To Open this Screen

Open Purchase Orders > P/O Setup Reports > Vendor Contract Costs.

Related Tasks

 l "Selecting a Print Destination" (page 241)

Overview

The Vendor Contract Costs report lists the vendors from whom you purchase items and the costs of 
the items that each supplies.

You can specify the following vendors’ prices for inventory items:

 l Base unit costs for single or multiple units of measure.

 l Sale unit costs for single or multiple units of measure.

 l Volume discount amounts or percentages.

 l Tax authorities and tax statuses for the contract cost.

The order in which information appears on the report depends on whether you choose to sort by item 
number or vendor number.

Note: The report includes only the item costs that you entered using the Vendor Contract Costs 
screen. The Vendor Contract Costs report uses the Rate Type specified for the vendor.

When to print

Print the report to check the costs of inventory items from your standard vendors.

Fields and Controls

From

Specify the range of items or vendors to include in the report.
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Print

Choose the type of report to print:

 l Summary. lists one line for each base vendor cost in Purchase Orders.

 l Detail. lists all of the information entered for each item contract cost in Purchase Orders.

 l Vendor Contract Cost. lists each unit cost for items and vendors, providing one line for each 
unique cost arising from unit, quantity, and sale discounts.

Print Amounts in

For multicurrency systems, select whether to print amounts in the vendor currency or in your 
functional currency.

Note: The reports use the rate type from the vendor, along with the session date, to determine the 
exchange rate.

Sort By

Specify the order for listing vendor details. You can sort by item number or vendor number.

To

Specify the range of items or vendors to include in the report.
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P/O Vendor Details Report Screen

Note: This screen is available only if you are using Purchase Orders as a stand-alone program 
(that is, you do not use Inventory Control).

To Open this Screen

Open Purchase Orders > P/O Setup Reports > Vendor Details.

Related Tasks

 l "Selecting a Print Destination" (page 241)

 l "Printing Purchase Orders Analytical and Setup Reports" (page 244)

Overview

The Vendor Details report lists vendors from whom you purchase items and the items each supplies. 
The report includes only the vendors you have assigned to item numbers on the Vendors tab of the 
Items screen.

The order in which information appears on the report depends on your sorting selection. The Vendor 
Details report lists:

 l The number you assign to identify a vendor in Accounts Payable.

 l The number you use to identify an item in Purchase Orders.

 l A number you assign to the vendor (vendor type) in the vendor details record, usually to 
identify vendors from whom you most frequently order the item.
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P/O Weight Units of Measure Report Screen

Note: This screen is available only if you are using Purchase Orders as a stand-alone program 
(that is, you do not use Inventory Control).

To Open this Screen

Open Purchase Orders > P/O Setup Reports > Weight Units of Measure.

Related Tasks

 l "Selecting a Print Destination" (page 241)

 l "Printing Purchase Orders Analytical and Setup Reports" (page 244)

Overview

The Weight Units of Measure report lists the information entered to define the inventory weight units 
of measure used in your Purchase Orders system (if you do not use the Inventory Control module).

The report lists the weight units of measure along with their descriptions and weight conversion 
factors. It also identifies the default weight unit of measure.

Print the report when you add, change, or delete weight units of measure, or to provide people setting 
up items with a list of the weight UOMs that have already been added.
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Setup Screens
Use Purchase Orders setup screens to set up options, vendor information, shipping information, 
General Ledger integration, and other details for your Purchase Orders system.

P/O Account Sets Screen   

Note: This screen is available only if you are using Purchase Orders as a stand-alone program 
(that is, you do not use Inventory Control).

To Open this Screen

Open Purchase Orders > P/O Setup > Account Sets.

Related Tasks

 l "Adding Account Set Records  " (page 40)

 l "Managing Account Set Records    " (page 40)

Overview   

Use the Account Sets screen to define a set of general ledger accounts to which you post Purchase 
Orders transactions (if you use Purchase Orders as a stand-alone system without Inventory Control).

You must add at least one account set to Purchase Orders before you   can add item records. If you 
add more than one account set, you can group   items by the account set to which they belong.

Fields and Controls

Account Set

Type a number or code that will identify the account set record you are creating.

The code can be up to six characters long, and contain letters and numbers.
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Description

Type a description using up to 30 characters. This description will appear on purchase   orders, 
receipts, invoices, etc. 

If you want to describe the item more completely, use the comments fields.

Inactive

Select this option if you do not want to use the account set in transactions.

If you make an account set inactive, you can no longer assign it to transactions.

This option is useful if you decide to delete an account set and want to ensure no further 
transactions are entered for it.

Inventory/Expense (General Ledger Account)      

Type the number of the general ledger inventory or expense account to debit when you receive 
items and to credit when you enter returns that use this account set code.

Last Maintained

This field displays the date of the last change made to the record.

Payables Clearing (General Ledger Account)      

Type the number of the general ledger suspense account to which Purchase Orders will post 
receipts and returns that use this account set code.

This account could be considered the accrued amount payable for goods received.

As you post the related vendor invoices in Accounts Payable, offsetting journal entries (debits) 
related to the items purchased are generated against the Payables Clearing account to clear the 
balance that is left in this account from posting P/O receipts.
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P/O Additional Costs Screen

To Open this Screen

Open Purchase Orders > P/O Setup > Additional Costs.

Related Tasks

 l "Adding Additional Cost Records" (page 43)

 l "Managing Additional Cost Records  " (page 44)

Overview   

Use the Additional Costs screen to define codes to identify   the extra costs you are charged by your 
vendors (such as shipping or handling   charges).

Fields and Controls

Account Cost

Type a number or code that will identify the account cost record you are creating.

The code can be up to six characters long, and can contain letters and numbers.

Amount

Type the amount of the additional cost, if known. If the cost varies, leave this field blank.

Currency

This field is needed only if you use a multicurrency ledger.

Type the code for the currency in which you will enter the additional cost amounts, or select the 
currency code from the Finder.

316Sage 300 2021 Purchase Orders User's Guide



If you are adding an additional cost for a particular vendor number, you must select the vendor's 
currency code, and the currency must match the currency for any tax authorities you assign to the 
cost.

Description

Type a description using up to 30 characters. This description will appear on purchase   orders, 
receipts, invoices, etc. 

If you want to describe the item more completely, use the comments fields.

Expense Account

Type the number of the general ledger account to which you post transactions entered for the 
additional cost.

Inactive

Select this option if you do not want to use the additional cost in transactions.

If you make an additional cost inactive, you can no longer assign it to receipts, invoices, credit notes, 
and debit notes. Making a cost inactive after entering it on a receipt has no effect on the receipt. You 
can still edit the inactive cost amount on the receipt, post changes to the receipt, and invoice it with 
the inactive cost included.

This option is useful if you decide to delete an additional cost and want to ensure no further 
transactions are entered for it. You can change your entry any time.

Last Maintained

This field displays the date of the last change made to the record.

Optional Fields

Optional fields are fields that have been added by your company to the records or transactions in 
purchase orders. 

Note: You must have Transaction Analysis and Optional Field Creator to add and use optional 
fields.

If optional fields appear on the Additional Costs screen, you can click the Zoom  button to display 

the optional fields that have been assigned to additional costs, and edit their contents.

317Sage 300 2021 Purchase Orders User's Guide



If you assign the same optional fields to additional cost records and to invoice additional costs, the 
optional field entries in additional cost records will appear on invoice additional cost details by 
default.

Optional field information can pass from invoices (or credit/debit notes) to downstream ledgers like 
Accounts Payable and General Ledger.

Proration

Select the default proration method for the cost:

 l No Proration. If you select No Proration, you must specify the general ledger expense 
account number for the cost.         

When entering additional costs with transactions, you can select another proration method 
and you can change to another general ledger account number when you are expensing the 
cost.

 l Prorate By Weight

 l Prorate By Cost

 l Prorate By Quantity

 l Prorate Manually

Return Account

Type the number of the general ledger account to which you normally expense the additional cost 
when you return items and do not leave or reprorate the additional cost amount assigned to them. If 
you use General Ledger, you can also select the account number from the Finder.

You can specify a different account number or proration method when entering transactions for the 
additional cost code.

Return Proration

Select the method by which you allocate costs when items are returned:

 l Leave

 l Prorate

 l Expense. If you select Expense, you must specify the general ledger expense account 
number for the return cost.
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The return proration methods that are available depend on the proration method you selected. For 
example, if you selected No Proration or Prorate Manually as the proration method, Leave is 
automatically selected as the return proration method and you cannot change it.

If you selected No Proration as the proration method, when entering new additional costs with 
receipts, invoices, credit notes, and debit notes, you can select another reproration method and you 
can change to another general ledger account number when you are expensing the cost.

Tax Authority

Type the code for the authority that taxes the cost, or select the code from the Finder for the Tax 
Authority field.

To add another line of tax information, press Insert after entering all the information for a particular 
authority and purchase tax class.

Tax Authority Description

This field displays the description entered in Common Services for the tax authority you specified. 
You cannot change the description in this screen. Use the Tax Authorities screen in Common 
Services to change the descriptions of tax authorities.

Tax Class

Type the number of the tax class that applies to the cost for the associated tax authority.

To add another line of tax information, press the Insert key on your keyboard after entering all the 
information for a particular authority and purchase tax class.

Tax Class Description

This field displays the description entered for the purchase tax class you specified. You cannot 
change the description in this screen. Use the Tax Classes screen in Common Services to change 
the descriptions of tax classes.

Vendor Number

If you wish to assign a vendor number to the cost, type a valid number or select it from the Finder of 
Accounts Payable vendor numbers. You can then use the additional cost on receipts only for that 
vendor.
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Leave the field blank if you want to use the cost for any of your vendors. (In multicurrency ledgers, 
you can use an additional cost with a blank vendor number for any other vendor who uses the same 
currency.)
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P/O E-mail Messages Screen

To Open this Screen

Open Purchase Orders > P/O Setup > E-mail Messages.

Related Tasks

 l "Creating E-mail Messages" (page 45)

 l "Setting up Purchase Orders" (page 3)

Overview

You can create e-mail messages to use when sending purchase orders and returns, specifying codes 
for adding information specific to the vendor or specific to your company. Each e-mail message is 
identified by a unique 16-character message ID code.

To e-mail purchase orders and returns, you must:

 l Select an Email delivery method for the vendor in Accounts Payable.

 l Select Vendor as the Delivery Method when you print Returns and Purchase Orders. You 
select the particular e-mail message that you want to use when you print the purchase orders 
or returns.

Fields and Controls

Description

Enter a description of up to 60 characters for the e-mail message.

E-mail Subject

Enter a subject line for the e-mail message. You can also use variables to insert specific information 
in the subject line. For more information, see "E-mail Message Variables  " (page 46).

321Sage 300 2021 Purchase Orders User's Guide



Inactive

Select this field only when you want to make this message unavailable for use.

Last Maintained

This read-only field displays the system date on which the record was last modified.

Message ID

A message ID is a unique code of up to 16 characters that identifies an e-mail message. You select 
messages using this message ID when you send order confirmations, quotes, invoices, or credit 
notes by e-mail.

Use this field to create a new message ID, or to select an existing message ID so you can view or 
edit details.

Message Type

Select the type of document for which you are creating the e-mail message.
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P/O G/L Integration Screen

To Open this Screen

Open Purchase Orders > P/O Setup > G/L Integration.

Related Tasks

 l "Changing General Ledger Integration Options" (page 33)

 l "Setting up Purchase Orders" (page 3)

Overview   

Use the G/L Integration screen to choose various options for integrating Purchase Orders   with the 
General Ledger program.

Integration and Transaction Tabs   

Tasks you can perform in the Integration tab:

 l Specify whether to add   general ledger transactions to the G/L batch during posting or each 
time   you run Day End Processing, or to create the transactions at a later date.

Note: This   choice can have a large impact on the speed of processing transactions   in 
Purchase Orders, especially if you are costing inventory during posting   (in which case, you 
may want to create transactions at a later date).   

 l Choose whether to create   a separate G/L batch each time you create the G/L batch (and 
optionally   automatically post the batch) or add new transactions to the existing   batch. (This 
option applies only if you use General Ledger with Purchase Orders at the same location.)

 l Choose whether to consolidate   the G/L batch when you post, or always enter full transaction 
details   in the batch. 

 l Decide when to generate entries for non-inventory expenses and for expensed additional   
costs:

 l Choose whether to   generate G/L entries in the Purchase Orders program for expenses 
from   receipts and returns for non-inventory items, or have the G/L entries   for expenses 
created in the Accounts Payable program.
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 l Choose whether to   generate G/L entries in the Purchase Orders program for additional 
cost   expenses on receipts, or have the G/L entries for expenses created in   the Accounts 
Payable program. (This is similar to the previous option.)

 l Specify several General Ledger accounts used by the Purchase Orders program:

 l The G/L account number of the default inventory expense account, default cost expense 
account, and non-inventory payables clearing account. 

 l The G/L account that you want to update with expensed additional costs if you create 
general   ledger transactions from Purchase Orders.

 l Look up the last Day End Number for which you have created general ledger batches.

Tasks you can perform in the Transactions tab:

 l Select the information to appear in the Entry Description, Detail Description, and Detail 
Reference and Comment fields in G/L transactions arising from invoices and shipments. (This 
information appears for transactions in the G/L Transactions report.)

 l Look up the last Day End Number for which you have created general ledger batches.

 l Choose the information that you want to appear in different fields of G/L transactions.

 l The Transaction Type column lists each type of Purchase Orders transaction,   and the 
remaining columns list the various G/L transaction fields for which you can specify P/O 
transaction information:     

 l G/L Entry Description (derived from the P/O transaction header)

 l G/L Detail Description (derived from P/O transaction details)

 l G/L Detail Reference (derived from P/O transaction details)

 l G/L Detail Comments (derived from P/O transaction details)

Double-click the cell for the transaction type and G/L field that you   want to specify.

Changing Settings

You can change any of your choices on the G/L Integration page at any   time. Any changes you make 
will apply only to general ledger transactions created after the change, and will not affect existing 
general ledger batches.

If you want to change from using the Create Batch screen to produce your   general ledger 
transactions to creating them during day-end processing,   be sure to run Create Batch to process any 
outstanding transactions first,   to avoid accidentally omitting transactions from your general ledger 
batches.
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Before Using the G/L Integration Screen 

Before changing any of the settings or other information in the G/L Integration screen, make sure you 
understand the impact the options have on processing within Purchase Orders.

Note: You cannot change settings on the Integration tab of the G/L Integration screen if other 
Purchase Orders screens are open, or other users are working with the Purchase Orders 
database.

Make sure that no one else is using the Purchase Orders data and that no other Purchase Orders 
screens are open for the company before you save changes to the G/L Integration screen.

A/P Integration Option is Set in the P/O Options Screen

Purchase Orders also lets you choose when to post Accounts Payable batches   arising from invoices 
posted in Purchase Orders.

To specify when to post A/P batches generated from Purchase Orders Invoices,   credit notes and 
debit notes, use the option Post A/P Batches During Posting or Day   End Processing/On Request 
Using Create Batch Icon. 

Creating and Posting a New G/L Batch

Purchase Orders lets you create new batches and optionally post them   automatically to the general 
ledger.

Note: If you choose this option, and you are creating   G/L transactions when you post Purchase 
Orders transactions, the program   will create a G/L batch every time that you post a P/O transaction, 
and   automatically post that batch in the General Ledger module.

Creating Only One Batch 

To have only one General Ledger batch to which all transactions are   appended, select the Adding To 
An Existing Batch option. Purchase Orders   must use the same database as General Ledger.

Fields and Controls

Integration tab

Consolidate G/L Batches
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Use this option to specify whether to combine transaction details for the same general ledger 
account into a single detail, or send unconsolidated Purchase Orders transaction details to General 
Ledger.

Consolidation reduces the amount of information in the general ledger batch and results in a shorter 
G/L Transactions Listing. Consolidation also:

 l Removes transaction-specific information from the Reference and Description fields for each 
transaction.

 l Removes optional field information from transactions.

 l Blocks drilldown from G/L transactions to the originating entries in Purchase Orders (unless 
consolidating by account only).

Use the Create Batch icon to consolidate details from separate transactions

If you selected the On Request Using Create Batch Icon option to create general ledger 
transactions, you can consolidate transaction details from all transactions for each general ledger 
account if you choose Consolidate by Account and Fiscal Period or Consolidate by Account, Fiscal 
Period, and Source.

Consolidate details within transactions if creating batches during posting or day end processing

If you create batches of G/L transactions during posting or day end processing, the program can 
only consolidate the details within transactions; it cannot consolidate the details from different 
transactions.

Consolidation choices

 l Do Not Consolidate. All the details posted in Purchase Orders will be included in the General 
Ledger transaction batch.                                         

Choose this option if you use optional fields and pass optional field information from P/O 
transaction details to the G/L transaction details.

 l Consolidate Transaction Details by Account. All the details within a transaction with the 
same general ledger account number are combined into one detail if the G/L Detail 
Description and the G/L Detail Reference are also the same. The program will not consolidate 
details that have a different description or reference.                                         

Choose this option if you do not use optional fields, but still want to associate general ledger 
transactions with originating documents (for drilldown or to maintain a manual audit trail).

 l Consolidate by Account and Fiscal Period. All the details with the same general ledger 
account number and fiscal period are combined into one detail.                                         
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This option will consolidate details from different transactions if you create transaction 
batches using the Create Batch screen.

 l Consolidate by Account, Fiscal Period, and Source. All the details with the same general 
ledger account number, fiscal period, and source code are combined into one detail.                                         

This option will consolidate details from different transactions if you create transaction 
batches using the Create Batch screen.

Note: The posting date for consolidated entries is the last date of the fiscal period.

Create G/L Entries for Expensed Additional Costs

This choice lets you choose when entries are generated for expensed additional costs—during P/O 
posting/day end or when the invoices are posted in Accounts Payable. (This option is similar to the 
option Create G/L Entries For Non-Inventory Expenses.)

Select this option to create debit entries to expense accounts and credit entries to the Expensed 
Additional Cost Clearing Account when you post additional costs. (Posting the invoices later in A/P 
will credit the payables control account and debit the Expensed Additional Cost Clearing Account.)

Do not select this option if you want to send expenses with invoices to Accounts Payable, where 
posting will debit the expense accounts and credit payables control.

Note: For job-related documents, Purchase Orders will always create G/L entries for expensed 
additional costs during posting—whether you select this option or not.

Create G/L Entries for Non-Inventory Expenses from Receipt/Return

This choice lets you update your general ledger with non-inventory expenses directly from 
Purchase Orders, or wait until invoices are posted in Accounts Payable. (This option is similar to the 
option Create G/L Entries For Expensed Additional Costs.)

Select this option to create debit entries to expense accounts and credit entries to the non-inventory 
payables clearing account when you post receipts. (Posting the invoices later in A/P will credit the 
payables control account and debit the non-inventory payables clearing account.)

Do not select this option if you want to send expenses with invoices to Accounts Payable, where 
posting will debit the expense accounts and credit payables control.

Note: For job-related documents, Purchase Orders will always create G/L entries for non-
inventory expenses during posting—whether you select this option or not.
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Create G/L Transactions

Use one of the Create G/L Transactions options to specify when to create general ledger 
transactions:

 l During Posting or Day End Processing. This option lets you create general ledger 
transactions during posting or when you run day end processing—depending on when you 
cost transactions.                                   

You choose when to cost transactions with the Cost Items During option on the Processing 
tab of the I/C Options screen. The Cost Items During option gives you two choices:

 l During Posting (G/L transactions will be created when transactions are posted.)

 l Day End Processing (G/L transactions will be created during day end processing.)

Note: These choices can have a large impact on the speed of processing inventory 
transactions and transactions in Purchase Orders. If you want to speed up order 
processing, switch to costing inventory when you run Day End Processing.

 l On Request Using Create Batch Icon. This option lets you create general ledger 
transactions at any time.                                   

Once you create the transactions, you cannot print the G/L Transactions report. If you wish to 
print the report, select the On Request Using Create Batch Icon for this option. You must then 
print the report before you use the Create Batch screen to create the transactions.

You can change your selection any time. If you were using the Create Batch screen to create 
the transactions, print a copy of the latest G/L Transactions report, then create any 
outstanding transactions before changing your choice for the option.

Create G/L Transactions By

Purchase Orders lets you choose whether to add new general ledger transactions to new batches 
or create new batches and optionally post them automatically to the general ledger. You can 
choose:

 l Adding to An Existing Batch. Add general ledger transactions to an existing General Ledger 
batch.           

To have only one General Ledger batch to which all transactions are appended, select the 
Adding To An Existing Batch option.

 l Creating a New Batch. Create a new General Ledger batch each time you generate G/L 
transactions.
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 l Creating and Posting a New Batch. Create a new General Ledger batch each time you 
generate G/L transactions, and automatically post the batch in the General Ledger program.

Note: Remember to create and post G/L batches for outstanding transactions before locking 
periods for General Ledger.

Default Cost Expense Account

Use this option on the Integration tab of the Options screen to select the general ledger account to 
which you want the program to post cost amounts in transactions for which no general ledger 
account is specified (such as when you change the tax class for an additional cost that was manually 
prorated on a receipt, indirectly changing the tax amount as well).

Note: 
 l You must specify this account number before you can run Day End processing.

 l You can change the default account number in the Options screen at any time.

 l If you use General Ledger with Purchase Orders, you can select general ledger account 
numbers from the Finder.

Default Inventory Expense Account

Use this option on the Integration tab of the Options screen to specify the general ledger account to 
display when you enter transactions for items that are not defined in Inventory Control.

You need to specify this account number only if you use the Allow Non-inventory Items option. If you 
selected Allow Non-inventory Items on the Processing tab, you cannot save changes to the Options 
screen until you enter a number for this account.

The account number is displayed when you enter transactions for non-inventory items, but you can 
change it for individual transactions, as needed. You can also change the default account number in 
the Options screen at any time.

If you use General Ledger with Purchase Orders, you can select general ledger account numbers 
from the Finder.

Expensed Additional Cost Payables Clearing Account

Use this option on the Integration tab of the Options screen to select the general ledger account that 
you want to update with expensed additional costs when you create general ledger transactions.
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Note: You can choose when entries are generated for expensed additional costs—during PO 
posting/day end or when the invoices are posted in Accounts Payable. This account is used if you 
create G/L transactions in Purchase Orders.

If you generate entries in PO, the program debits the expense account and credits the payables 
clearing account.

You can change the default clearing account number in the Options screen at any time.

G/L Transactions Generated Through Day End Number

This field displays the last day end number generated. You can see the next day end number on the 
Documents tab in the P/O Options screen.

Non-Inventory Payables Clearing Account

Use this option on the Integration tab of the Options screen to select the general ledger account that 
you want to update with receipts and returns of non-inventory items when you create general ledger 
transactions.

Note: You can choose when entries are generated for non-inventory expenses—during PO 
posting/day end or when the invoices are posted in Accounts Payable. This account is used if you 
create G/L transactions in Purchase Orders.

For the receipt of a non-inventory item, the program debits the expense account and credits the 
payables clearing account.

For the return of a non-inventory item, the entry debits the payables clearing account and credits 
the expense account.

You can change the default account number in the Options screen at any time.

If you use General Ledger with Purchase Orders, you can select general ledger account numbers 
from the Finder.

G/L Source Codes table

Source Ledger

This column shows the source ledger code for all general ledger transactions created by the 
Purchase Orders module.

330Sage 300 2021 Purchase Orders User's Guide



You can change the source type code for each type of transaction created by P/O, but you cannot 
change the source ledger code.

The combination of source ledger code and source type code is called a source code in the General 
Ledger module.

Source Type

This column lists the two-character codes assigned to various types of transactions that are 
generated by the Purchase Orders system, such as invoices, credit notes, or consolidated G/L 
entries.

If you want to, you can change the source type code for each type of transaction created by 
Purchase Orders. You cannot change the source ledger code.

If you change the source type code for source codes, the new source codes are automatically 
added to the General Ledger module, but you will have to update G/L source journal profiles to 
include transactions on source journals.

Transaction Type

This column lists the various types of transactions that are generated by the Purchase Orders 
system, such as invoices, credit notes, or consolidated G/L entries.

You can change the source type code for each type of transaction created by P/O. You cannot 
change the source ledger code.

If you change the source type code for source codes, the new source codes are automatically 
added to the General Ledger module, but you will have to update G/L source journal profiles to 
include transactions on source journals.

The combination of source ledger code and source type code is called a source code in the General 
Ledger module.

Transactions tab

G/L Detail Comment

Select the type of information that you want to appear with unconsolidated details in the Comment 
column on the G/L Transactions report and in that field in the general ledger batch.

You can assign one or more pieces of information (segments) to each G/L transaction field, 
provided that the combined length of the segments and separators does not exceed 60 characters. 
Fields exceeding this limit will be truncated when you post the general ledger transactions.
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 l If you do not consolidate general ledger transactions, information for all the G/L fields is 
passed to General Ledger.

The information you can select depends on the type of transaction for which you are assigning 
information.

For example, you can include information like the purchase order number, vendor number, vendor 
name, receipt number, reference, source code, day end number, or entry number. You can 
separate pieces of information with slashes, parentheses, hyphens, periods, spaces, or number 
signs.

 l When you create general ledger transactions, if no data exists in the source transaction field, 
the field will be blank in the general ledger transaction.

G/L Detail Description

Select the type of information that you want to appear with unconsolidated details in the Description 
column on the G/L Transactions report and in that field in the general ledger batch. (The Detail 
Description field is the description on each detail line, not the main description for the General 
Ledger transaction.)

You can assign one or more pieces of information (segments) to each G/L transaction field, 
provided that the combined length of the segments and separators does not exceed 60 characters. 
Fields exceeding this limit will be truncated when you post the general ledger transactions.

 l When you consolidate general ledger transactions, the description for each transaction is 
changed to "Consol. by P/O on date."                                         

Note: When there is only one of a particular transaction type, the description for the 
transaction is whatever you selected on the G/L Integration screen.

 l If you do not consolidate general ledger transactions, information for all the G/L fields is 
passed to General Ledger.

The information you can select depends on the type of transaction for which you are assigning 
information.

For example, you can include information like the purchase order number, vendor number, vendor 
name, receipt number, reference, source code, day end number, or entry number. You can 
separate pieces of information with slashes, parentheses, hyphens, periods, spaces, or number 
signs.

 l When you create general ledger transactions, if no data exists in the source transaction field, 
the field will be blank in the general ledger transaction.
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G/L Detail Reference

Select the type of information that you want to appear with unconsolidated details in the Reference 
column on the G/L Transactions report and in that field in the general ledger batch.

You can assign one or more pieces of information (segments) to each G/L transaction field, 
provided that the combined length of the segments and separators does not exceed 60 characters. 
Fields exceeding this limit will be truncated when you post the general ledger transactions.

 l When you consolidate general ledger transactions, the description for each transaction is 
changed to "Consol. by P/O on date."                                         

Note: When there is only one of a particular transaction type, the description for the 
transaction is whatever you selected on the G/L Integration screen.

 l If you do not consolidate general ledger transactions, information for all the G/L fields is 
passed to General Ledger.

The information you can select depends on the type of transaction for which you are assigning 
information.

For example, you can include information like the purchase order number, vendor number, vendor 
name, receipt number, reference, source code, day end number, or entry number. You can 
separate pieces of information with slashes, parentheses, hyphens, periods, spaces, or number 
signs.

 l When you create general ledger transactions, if no data exists in the source transaction field, 
the field will be blank in the general ledger transaction.

G/L Entry Description

The Entry Description field is the main description for the General Ledger transaction (not the 
description on each detail line).

You can assign one or more pieces of information (segments) to the description for each G/L 
transaction, provided that the combined length of the segments and separators does not exceed 60 
characters. Fields exceeding this limit will be truncated when you post general ledger transactions.

For example, you can include information like the purchase order number, vendor number, vendor 
name, receipt number, reference, source code, day end number, or entry number. You can 
separate pieces of information with slashes, parentheses, hyphens, periods, spaces, or number 
signs.
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 l If you use the On Request Using Create Batch Icon option to consolidate general ledger 
transactions, the description for each G/L transaction is changed to "Consol. by P/O on date" 
(unless there is only one of a particular transaction type).

The information you can select depends on the type of transaction for which you are assigning 
information.
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P/O Items Screen

Note: This screen is available only if you are using Purchase Orders as a stand-alone program 
(that is, you do not use Inventory Control).

To Open this Screen

Open Purchase Orders > P/O Setup > Items.

Related Tasks

 l "Adding Item Records   " (page 49)

 l "Managing Item Records" (page 50)

Overview   

Use the Items screen to add a record for each item to your inventory list.

An item record includes the item code, account set, tax authority, and tax classes that the item uses. It 
also includes units of measure and a unit of weight for the item, as well as up to 300 characters of 
additional descriptive information.

Before adding item records:

 l Add the account sets you require for posting transactions to general ledger accounts.

 l Add the taxing authorities and tax classes you require (using the Tax Services icon in the 
Common Services folder).

Items Tab

Use this tab to enter identifying information about the item, such as the item number and description, 
the account set code to be used for the item in transactions, the commodity number (if you are 
required to report VAT amounts), the unit weight for the item, as well as additional item description 
information that you can print on customized forms.

Units Tab

Use this tab to enter units of measure and the conversion factor for each item. (You must enter a 
stocking unit of measure with a conversion factor of 1.)
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Taxes Tab

Use this tab to enter codes for the taxing authorities you want to assign to the item. (You define taxing 
authorities in the Tax Services folder of Common Services.) You can also enter codes for the tax 
classes you want to assign to the item for purchases for each selected tax authority.

Optional Fields Tab

This tab appears if you have assigned optional fields to the Items screen (using the Optional Fields 
screen in the P/O Setup folder).

Use this tab to add or change information in the optional fields that are assigned to this item.

If you have assigned the same optional fields to transaction entry screens, the information in these 
fields will appear by default on new transaction details for this item.

To enter optional information, type or choose your entry for each optional field.

If the optional field has a Finder, you can select one of the entries from the Finder list. Depending on 
how the list has been set up, you may be able to leave the field blank.

Weight Unit of Measure

You define weight units of measure using the Weight Units Of Measure screen in the P/O Setup 
folder.

Select the unit of measure that you use for measuring the weight of one unit of this item.

The weight unit of measure record includes a conversion factor for converting this unit to the default 
weight unit of measure specified in the P/O Options screen.

Fields and Controls

Item tab

Account Set Code

Type or use the Finder to select the general ledger account set you want to assign to the item.

Comment

Use up to four additional fields to include descriptive information for the item. You can type up to 80 
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characters in each of the four fields.

If you use customized invoices or other forms, you can have Purchase Orders print this additional 
item information on the forms.

Commodity Number

If your company reports a value added tax (VAT), type the commodity number for the item.

Description

Type a description using up to 30 characters. This description will appear on purchase   orders, 
receipts, invoices, etc. 

If you want to describe the item more completely, use the comments fields.

Inactive

Select this option if you do not want to use the item in transactions.

Note: Inactive items can still be processed in purchase order returns.

This option is useful if you decide to delete an item record, and want to ensure no further 
transactions are entered using it. You can change your entry any time.

Item Number

Type a number or code that will identify the Item record you are creating.

The code can be up to 24 characters long, and contain letters and numbers as well as special 
characters.

Last Maintained

This field displays the date of the last change made to the record.

Unit Weight

Type the weight for one unit of the item.

The weight you enter must be in terms of the Weight Unit Of Measure you enter in the Weight Unit of 
Measure field.
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Item weights are used by Purchase Orders to determine order weight.

Item Taxes tab

(Item Tax) Authority

Use the Finder to select the taxing authorities you want to assign to the item. (You define taxing 
authorities in the Tax Services folder of Common Services.)

Purchase Tax Class

Type or select the numbers of the tax classes you want to assign to the item for purchases for each 
selected tax authority.

To add another line of tax information, press the Insert key on your keyboard after entering all the 
information for a particular authority and purchase tax class.

Tax Class Description

Purchase Orders displays the description entered for the purchase tax class you specified. You 
cannot change the description in this screen. Use the Tax Classes screen in Common Services to 
change the descriptions of tax classes.

Optional Fields tab

The Optional Fields tab contains optional fields added by your company to the Items screen. 
These fields will appear by default on transaction screens as long as the transaction screens 
contain the same optional fields.

This tab appears only if you have Transaction Analysis and Optional Field Creator.

Units tab

Conversion Factor

Type the number of stocking units for the unit of measure.

Example: If the unit of measure is “dozen,” you type 12.

You must enter the unit of measure you intend to use for the stocking unit before you can save the 
record. The conversion factor for the stocking unit must be 1 (one).
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Unit Of Measure

Type the names for alternative units of measure for this item (for example, dozen, gallon, ton).

You must also enter a conversion factor for converting each alternative unit to the default weight unit 
of measure that you specified in P/O Options.
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P/O Optional Fields Screen  

To Open this Screen

Open Purchase Orders > P/O Setup > Optional Fields.

Related Tasks

 l "Setting Up Optional Fields        " (page 56)

 l "Setting up Purchase Orders" (page 3)

Overview   

This screen appears in the P/O Setup folder if you use Transaction Analysis and Optional Field 
Creator, a separately licensed package that you can purchase and use with Purchase Orders.

You use optional fields if you want to keep additional information with Purchase Orders transactions 
and records.

For more information, see "About Optional Fields" (page 51) and "About Entering Optional Data on 
Transactions" (page 149).

Optional Field Settings

Optional Field settings let you restrict the amount of information that   is passed to Accounts Payable 
and General Ledger when you post transactions   in Purchase Orders that use optional fields.

When defining an optional field for use with transactions, click the   Settings button, or double-click the 
line on the Optional Fields grid. A separate screen opens, listing the groups of accounts in other 
ledgers that are affected when you post transactions of the type for which you are defining the 
optional field. 

Select whether you want to pass optional field information to Accounts   Payable with invoices, credit 
notes and debit notes, and select the account   groups for which you want to pass values to General 
Ledger when you post   transactions that include the optional field.

Note: You must also use the   same optional fields in Accounts Payable Invoices to pass information   
to Accounts Payable, and use the same optional fields in General Ledger   accounts to pass 
information to General Ledger.
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All account groups are initially selected for new   optional fields. However, if you send all the optional 
fields you use in Purchase   Orders transactions to General Ledger, your G/L may become unwieldy, 
and   you may slow down processing considerably. For this reason, you should send values   to General 
Ledger only for optional fields that require financial analysis,   and only to accounts where they are 
required. For example, you might want   to send optional fields that contain vendor numbers only to 
revenue accounts.

If you use Sage 300 Project and Job Costing, you can also specify   whether optional field information 
for job-related transactions will be   passed to Project and Job Costing, if the optional fields match 
those   used for billings.

Fields and Controls

Auto Insert

Select Yes in this field if you want the program to display the optional field and its default value on the 
screen for the type of optional field when you set up new records or enter transactions.

Select No if you do not want the optional field to appear automatically.

Example: If you define Transit Number as an optional field for Invoices and you select Yes in the 
Auto Insert field, the Transit Number field will appear automatically in Invoice Entry.

Default Value and Description

Enter or select the value that the program will display as the default for the optional field.

If the optional field you selected requires validation, you must select a value that is defined for the 
optional field in Common Services. However, if the optional field allows blanks, you can leave the 
default value field blank.

If the optional field does not use validation, you can do one of the following:

 l Select a value that is defined for the optional field in Common Services.

 l Leave the field blank.

 l Enter a combination of alphanumeric or special characters and spaces. The entry must be 
consistent with the type of field (for example, text, number, date, or amount) and must not 
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exceed the number of characters specified for the optional field. In a Yes/No field, you can 
enter only Yes or No.

When you specify a value that is defined in Common Services, the program displays the description 
for the value.

Optional Field and Description

Use the Finder to select the optional field codes you want to use for each type.

You can define an unlimited number of optional fields for each type, providing the optional fields are 
set up in Common Services for use in your system.

Note: If you want to retain optional field information from Purchase Orders transactions when you 
create batches for General Ledger, you must use the same optional fields for transaction details in 
Purchase Orders as you use for accounts in General Ledger. Similarly, if you want to pass invoice 
optional field information to Accounts Payable, you must use the same fields for P/O invoices and 
for A/P invoices.

When you select an optional field code, the program displays the description for the optional field.

Optional Fields For

Specify the screen and type of information to which you are adding optional fields. You can choose:

 l Additional Costs

 l Requisitions

 l Requisition Details

 l Purchase Orders

 l Purchase Order Details

 l Receipts

 l Receipt Details

 l Receipt Additional Costs

 l Receipt Additional Cost Details

 l Invoices

 l Invoice Details
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 l Invoice Additional Cost Details

 l Returns

 l Return Details

 l Credit/Debit Notes

 l Credit/Debit Note Details

 l Credit/Debit Note Additional Cost Details

 l Items (if you do not use Inventory Control)

Required

You select this option for an optional field if all the records or transactions to which you are adding 
the field must use the field.

If you make an optional field a required field, it must also be inserted automatically in new records or 
transactions. (You must use the Auto Insert option for the field.)

Value Set

Double-click the Value Set column to show whether or not the optional field has a default value.

This column has two purposes:

 l You must set the Value Set to "Yes" in order to set a default value for the optional field.

 l The "Yes" flag provides information to the transaction-entry clerk, letting them know if the field 
contains default information.

343Sage 300 2021 Purchase Orders User's Guide



P/O Options Screen  

To Open this Screen

Open Purchase Orders > P/O Setup > Options.

Related Tasks

 l "Setting up Purchase Orders" (page 3)

Overview

Use the Options screen to select options when you create your Purchase Orders ledger.

After  you have set up your ledger, use this screen when you need to change your   selections. For 
example, you can:

 l Change the contact name, telephone number, and fax number for your ledger. (Choose the 
Company tab.)

 l Check the choice for the Multicurrency option (set in Accounts Payable) and, if you use 
multicurrency accounting, specify a default rate type for the Purchase Orders ledger.   (Choose 
the Processing tab.)

 l Select options to determine whether your Purchase Orders ledger allows non-inventory items, 
keeps transaction and purchasing history, and accumulates statistics, and specify   a default 
template code and a default cost type. (Choose the Processing tab.)

 l Specify the number of days in each of three aging periods. (Choose the Documents tab.)

 l Enter the length, prefix, and next number to assign as document numbers to purchase orders, 
requisitions, receipts, and returns. (Choose the Documents tab.)

 l If you do not use Inventory Control, choose when to cost items maintained by the Purchase 
Orders module.

Note: You cannot save most changes to the P/O Options screen if any other Purchase Orders 
screens are open for the company on your computer or on other workstations on a network.

Company Tab

Use the Company tab to change the contact name, telephone number, and fax number for Purchase 
Orders.
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Depending on the choice of the Format Phone Numbers option in the Company Profile in Common 
Services, parentheses and hyphens may be inserted in telephone-number fields.

Note: To change the company name and address, or to change the contact name, telephone 
number, and fax number at the company level, use the Company Profile screen in Common 
Services.

Processing Tab

Use the Processing tab to set options that determine how Purchase Orders processes transactions. 
These settings include:

 l A default rate type, if your Purchase Orders system uses multicurrency accounting.

For more information, see "Setting up Multicurrency Accounting" (page 24).

 l Settings that determine whether you can order non-inventory items, keep transaction history, 
and use a default template.

 l A default cost type to display for item costs on transactions.

 l Settings that determine whether to keep purchase history and statistics and the type of year 
and period by which you accumulate the history and statistics.

If you do not use inventory control, you can also change settings for the item lists that you keep for 
Purchase Orders: whether you allow fractional quantities, the weight unit of measure, and whether 
you cost items during posting or during day-end processing.

Changing Processing Options

You can change your selections for all Processing options at any time.

Documents Tab

Use the Documents tab to:

 l Set the default aging periods for the Aged Purchase Orders report.

 l Assign or change the maximum length (number of characters) to use in the document numbers 
Purchase Orders assigns to purchase orders, requisitions, receipts, and returns.   

 l Specify an optional prefix and the next number to assign for each type of document (if you allow 
Purchase Orders to assign document numbers automatically, rather than type them in 
yourself).
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Purchase Orders uses the purchase order numbers you specify to assign numbers to purchase 
orders you create automatically from requisitions, Inventory Control reorder information, and Order 
Entry sales orders.

Changing Document Options

At any time, you can change your choices for all document-numbering options.

Note: You cannot post requisitions, purchase orders, receipts, or returns with duplicate document 
numbers. To keep the document numbers unique, be careful not to change to a prefix or next 
number that will create duplicate numbers for a particular type of document.

Costing Tab (standalone Purchase Orders)

Important! The costing tab appears only if you are not using the Inventory Control module.

Use the Costing tab to specify when Purchase Orders costs inventory—whenever you post a 
transaction or only when you run Day End Processing—and to specify when it should create sub-
ledger and audit information.

These settings can have a large impact on the speed of processing transactions in Purchase Orders 
and on the number of A/P batches that Purchase Orders produces.

If you cost inventory during posting, purchase order posting will take longer.

If you create subledger batches during posting, you can also create and post A/P invoice batches at 
the same time as you post purchase order invoices.

For information on other processing options, see "About Selecting Processing Options" (page 8).

Changing Costing Options

After setup, you can change your costing options, with the following restrictions:

 l You can switch from costing during posting to costing during day end processing at any time.

However, you must run Day End Processing before switching to costing during posting to make 
sure that you complete item costing and to make sure that all G/L transactions have been 
created properly.

Fields and Controls

Costing tab

346Sage 300 2021 Purchase Orders User's Guide



This tab is available only if you do not use Inventory Control. (If you use Inventory Control, you 
choose costing options on the I/C Options screen.)

Cost Items During Posting or Day End Processing

Use this option to specify whether to cost items as soon as transactions are posted, or when you run 
Day End Processing.

If you cost items at posting, every receipt or return (and, possibly, invoice, debit note and credit 
note) will update item costs.

This setting also determines when Purchase Orders creates subledger transactions, and—if you 
create batches during posting or day end processing, instead of using the Create Batch icon—when 
it creates G/L batches.

Note: If you use Serialized Inventory or Lot Tracking, you must cost items and create transactions 
at the same time.

Create Subledger Transactions and Audit Info. During (Posting/Day End Processing)

If you cost items during posting, you can choose whether to create subledger transactions and audit 
information during posting or when you run Day End Processing.

If you cost inventory items during Day End Processing, the program also creates subledger 
transactions at that time. (You cannot change this option.)

Tip: This option lets you choose between processing speed and keeping your inventory data up-
to-date. For more efficient processing, create subledger transactions and cost inventory when 
you run Day End Processing.

Note: If you use Serialized Inventory or Lot Tracking, you must cost items and create transactions 
at the same time.

Documents tab

Aging

Purchase Orders groups outstanding transactions for the Aged Purchase Orders report into five 
periods, a current (not due) period and four previous periods. You specify the length of each aging 
period on the Processing tab of the Purchase Order Entry screen.
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You can specify different periods when you are printing the report and you can change the default 
periods at any time.

Document Type

This field displays the type of transaction for which you can automatically assign document numbers 
to Purchase Orders transactions.

Length

Enter the number of characters you want to permit in the document numbers Purchase Orders 
assigns for the corresponding transaction type. Requisition numbers, purchase order numbers, 
receipt numbers, and return numbers can all be up to 22 characters long, including prefix 
characters.

Next Day End Number

This field displays the day end number that will be assigned when you next run Day End Processing.

Next Number

Type the number to assign as the document number for the next transaction of each type you post 
in Purchase Orders.

The program increases this number by one each time you assign a document number 
automatically.

If you type your own document numbers for transactions, the next number is not updated in the 
Options screen, even if you type the exact prefix (if used) and number that Purchase Orders would 
have assigned.

Prefix

If desired, type a prefix of up to six characters to assign as the first part of any document numbers 
you choose to let Purchase Orders assign automatically.

Processing tab

Accumulate By

Use the Accumulate By and Period Type options to specify whether to report period historical 
transactions or statistics by fiscal year or calendar year, and to specify the period type to use.
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If you accumulate by calendar year, the starting date for history and statistics will be January 1st. If 
you accumulate by fiscal year, the starting date will be the first day of your fiscal year.

The Accumulate By option appears only if the corresponding Keep Purchase History or 
Accumulate Statistics option is turned on.

Note: You     can keep data for up to 53 periods per year (54 periods in a     leap year), for any number 
of years.

Accumulate Purchase History

Select the Accumulate Purchase History option to keep information about the items you have 
purchased and the vendors who supplied them. Selecting the option also keeps information about 
invoices, credit notes, debit notes, and items you returned.

You can then view the information in the Purchase History screen, use the History button to look it 
up when you are entering transactions, and print it on the Purchase History report.

Purchase Orders keeps purchase history by the type of year (fiscal or calendar) and period you 
select for the Accumulate By and Period Type options on the Processing tab.

If you choose to accumulate by calendar year, the starting date for the year will be January 1. If you 
accumulate by fiscal year, the starting date will be the first day of your fiscal year.

Note: You can turn on or turn off the Accumulate Purchase History option at any time. If you turn 
off the option after you have used it, Purchase Orders keeps the figures already accumulated until 
you clear them. If you turn on the option again before clearing the history you accumulated 
previously, the data will still be available, but there will be no figures for the period during which 
the option was off.

Accumulate Statistics

Select this option if you want to accumulate statistics from posted transactions.

When you use this option, Purchase Orders retains statistics from the transactions processed for up 
to 53 periods per year (54 periods in leap years), for any number of years. The program displays 
these statistics in the Purchase Statistics screen and prints them on the Purchase Statistics report.

You can turn on or turn off the Accumulate Statistics option at any time. If you turn off the option after 
you have used it, Purchase Orders keeps the statistics already accumulated until you clear them 
using the Clear History screen. If you turn on the option again before clearing the statistics you 
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accumulated previously, those statistics will still be available, but there will be no statistics for the 
period during which the option was off.

Allow Edit of Statistics

(This option is available only if you select the Accumulate Statistics option.) Select this option if you 
want to:

 l Add or edit statistics for previous periods of the current year or for previous years. (You might 
want to do this if you set up your Purchase Orders system partway through a fiscal year.)

 l Add or edit statistics from posted transactions.

You use the Purchase Statistics screen to add and edit purchase statistics, and the Purchase 
Statistics report to print statistics.

You may want to turn on the option while you are setting up your Purchase Orders system, 
particularly if you are creating the system partway through an accounting year. You can then enter 
more complete purchase-order records by adding the statistics from your previous system.

Once your system is operating, you should turn off the option because the program automatically 
updates the statistics when you post transactions.

The Allow Edit Of Statistics option appears only when the Accumulate Statistics option is turned on. 
You can turn on or turn off the Allow Edit Of Statistics option at any time.

Allow Fractional Quantities

This option is available in Purchase Orders only if you do not use Inventory Control.

Select this option to allow transactions that use fractional quantities (you can use up to four decimal 
places). You can select the Allow Fractional Quantities option at any time but, once you select the 
option, you cannot change back.

Fractional quantities are useful if your inventory includes homogeneous items. (Homogeneous 
items are those with identical elements which can be broken down into multiple, smaller units, such 
as oil or grain.) These items can require a wide range of units of measure.

Instead of using the smallest unit (such as ounces) as the stocking unit, you can use a larger 
stocking unit (such as pounds) and fractional quantities for amounts less than a pound.

If you do not intend to enter any transactions that use fractional quantities, you can simplify 
transaction entry by not selecting the Allow Fractional Quantities option. This means you do not 
have to enter decimal places for quantities, and it means that unnecessary decimal places do not 
appear on reports.
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Allow Non-Existing Vendors

Purchase Orders lets you choose whether you can add a requisition or purchase order for a vendor 
that does not exist in Accounts Payable.

You can add transactions in Purchase Orders before adding the vendor in Accounts Payable, but 
you must use the same vendor code when you add the vendor in Accounts Payable, and, in a 
multicurrency system, you must specify a tax group that matches the vendor's currency.

Finally, you must add the vendor in Accounts Payable before you can post the invoice in A/P.

Allow Non-Inventory Items

Select this option if you want to be able to use item numbers that are not included in your Inventory 
Control system (or Purchase Orders system, if you do not use Inventory Control) when you enter 
Purchase Orders transactions.

Do not select this option if you want to ensure that all transactions use only items for which you have 
created a record in Inventory Control (or in a stand-alone Purchase Orders system). If you use 
Inventory Control and do not select this option, transactions can update item quantities and costs in 
Inventory Control when you post transactions in Purchase Orders and run Day End Processing in 
Inventory Control.

Default Copy Costs to Purchase Order

Choose this option if you want requisition detail costs to be copied to purchase orders that are 
created from requisitions. You can change this setting when entering each line of a requisition. (The 
choice appears on the zoomed requisition detail screen.)

If you do not copy costs from the requisition, Purchase Orders will use the default item cost selected 
in P/O Options, but you can still use the Finder to choose any other cost kept by Sage 300, or you 
can enter an item cost.

Default Item Cost

If you use Inventory Control, use this option to select the type of cost you want to display in 
transaction entry screens. When you enter item details on transactions, the program displays the 
selected type of item costs, but you can enter a different cost or select another cost type for 
individual details.

You can display Most Recent Cost, Standard Cost, Average Cost, Last Unit Cost, Vendor Cost, or 
either of the two user-defined costs you can enter with item records in Inventory Control.
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Note: If you do not use Inventory Control, the Vendor Cost is set as the default item cost.

Default Posting Date

This option lets you specify which date the program displays by default for the Posting Date when 
you enter receipts, invoices, returns, credit notes, and debit notes.

You can choose from two settings:

 l Document Date. Make this selection if you usually want the posting date and fiscal period to 
match the document date.           

If you choose this setting, the program will automatically change the default Posting Date if 
you change the date in the Receipt Date, Shipment Date, Invoice Date, Credit Note Date, or 
Debit Note Date field.

 l Session Date. Make this selection if you usually want the posting date and fiscal period to 
match the current session date.           

If you choose this setting, the program keeps the session date as the default posting date 
even if you change the document date.

The posting date determines the date that a transaction is posted to General Ledger. The Fiscal 
Year and Period are based on the posting date.

If you have a multicurrency system, currency revaluation also uses posting dates to select open 
documents for revaluation, so that revaluation adjustments are posted to General Ledger in the 
correct fiscal year/period.

Default Rate Type

When you turn on the Multicurrency option in Accounts Payable, you also specify a default rate type, 
such as spot rate, for converting source-currency amounts in transactions to their functional-
currency equivalents. The rate type you select in Accounts Payable appears as the default rate type 
in Purchase Orders as well, but you can change it.

To specify the default rate type, either type the code for the type or select a code from the Finder 
beside the field. You must select a rate type that is defined in the Currency screens in Common 
Services.

You can change the default rate type at any time.
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Default Template Code

Use this option to specify a template that contains the information you want to appear as defaults in 
transaction-entry screens when you start entering a new transaction.

Note: You can select a default template code only after you have defined template codes in the 
Templates screen.

This option can help you speed up data entry by automatically inserting the header and vendor 
information you use most often when entering these types of documents.

Note: If you use multicurrency accounting in Purchase Orders, the tax group for the default 
template must use the functional currency for the Purchase Orders ledger.

Default Weight Unit of Measure

This field is available only if you do not use Inventory Control.

Choose the weight unit of measure which is the basic or standard unit that you use for measuring 
the weight of your inventory items—such as pounds or kilograms.

Note: Usually, you will add weight units of measure after choosing inventory options, so you will 
select the default unit at a later time.

Order Entry uses the weights in inventory item records to estimate the total weight of each order in 
the unit of weight you specify here.

Purchase Orders can use the weights in inventory records to prorate (distribute) additional costs on 
orders.

Functional Currency

The functional currency is selected for the company in the Company Profile screen in Common 
Services, and is displayed in the Options screen.

Once the functional currency is assigned for a company, you cannot change it. All modules 
activated for the company automatically use the same functional currency.

Keep Transaction History

Select this option to keep transaction details.
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Purchase Orders saves details for the transactions processed from the time you select the Keep 
Transaction History option. 

The program uses these transaction details to create the Transaction List for each type of 
transaction. Therefore:

 l If you keep history, all transaction details you posted in Purchase Orders appear on the 
Transaction List until they are complete and you clear them in the Clear History screen.

 l If you do not keep history, the Transaction List shows only current transactions (incomplete 
requisitions, purchase orders, receipts, and returns, as well as invoices, credit notes, and 
debit notes that have not been added to the batch that Day End Processing creates for 
Accounts Payable).

Note: If you do not keep transaction history, you cannot drill down to Purchase Orders 
transactions from General Ledger or Accounts Payable transactions.

You can turn on or turn off the Keep Transaction History option at any time.

Multicurrency option

You set the multicurrency option in the Accounts Payable Options screen. If you turn on the option in 
Accounts Payable, you also automatically turn it on for Purchase Orders.

After you turn the option on and save your changes in Accounts Payable, you cannot turn it off.

Period Type

Use the Accumulate By and Period Type options to specify whether to report period historical 
transactions or statistics by fiscal year or calendar year, and to specify the period type to use.

If you accumulate by calendar year, the starting date for history and statistics will be January first. If 
you accumulate by fiscal year, the starting date will be the first day of your fiscal year.

The choices for period type are: Weekly, Seven Days (begins on the day on which weeks begin in 
your fiscal calendar), Bi-weekly, Four Weeks, Monthly, Bi-monthly, Quarterly, Semi-annually, and 
Fiscal Period (if you chose to accumulate statistics by fiscal year).

The Period Type option appears only if the corresponding Keep Purchase History or Accumulate 
Statistics option is turned on.

Note: Sage 300 Standard supports accumulation by fiscal year and fiscal period only.
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Post A/P Batches

This option is available in Purchase Orders only if you use Inventory Control.

Use this option to specify when to post A/P batches generated from Purchase Orders invoices, 
credit notes and debit notes:

 l During Posting or Day End Processing

This option lets you post Accounts Payable invoice batches created by Purchase Orders 
when you post invoices or when you run day end processing in Inventory Control (if you have 
it)—depending on when you cost transactions in Inventory Control.

You choose when to cost transactions with the Cost Items During option on the Processing 
tab of the I/C Options screen. The Cost Items During option gives you two choices:

 l During Posting

 l Day End Processing

Note: These choices can have a large impact on the speed of processing transactions in 
Purchase Orders and on the number of A/P batches that Purchase Orders produces.

If you post A/P batches during transaction posting, Purchase Orders will create and post an 
A/P batch for each invoice it creates.

If you are processing a large volume of receipts, you should cost inventory during day end 
processing or use the Create Batch icon to post A/P batches.

 l On Request Using Create Batch Icon

This option lets you decide when to post Accounts Payable invoice batches created by 
Purchase Orders. Use the Create Batch screen in Purchase Orders and select the option to 
Post A/P Batches.

You can also post the A/P batches created by Purchase Orders using the Post Batch screen 
in the Accounts Payable module.

You can change your selection any time. If you were using the Create Batch screen to create the 
transactions, print a copy of the latest G/L Transactions report, and then create any outstanding 
transactions before changing your choice for the option.

Require Approval

Select this option if requisitions require approval before they can be converted to purchase orders.
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You must also turn on security for the system database in Sage 300 database setup to use 
database security features.

Requisition approval is based on the Requisitions Manual Approval security right which you can 
assign to users in the Security Group screen in Administrative Services.

 l If your security group is assigned the security right to approve requisitions, all requisitions that 
you post are automatically approved, and your User ID appears in the Approver Name field.

 l If your security group is not assigned the security right to approve requisitions, all requisitions 
that you post are automatically put on hold, and the Approval Status field will display 
"Entered" until the requisition is posted by a user with approval rights.

Update Most Recent Cost and Last Cost At

This option lets you choose when Purchase Orders updates the last cost and most recent cost 
stored with items in Inventory Control.

You can update costs when you receive goods or when you post the invoice for the receipt.

By default, Purchase Orders updates costs when you post receipts, and it will not change these 
costs when you post invoices.

This means that if you do not have final costs on your receipts, you should change this setting to 
update costs when you post invoices.

Note: You can change the most recent cost and the last cost on the I/C Location Details screen in 
the Inventory Control module.

Warn For Non-Inventory Items

Purchase Orders lets you turn on or turn off warnings for items that do not exist in inventory.

Select this option if you want the program to warn you each time you add an item to a requisition or 
purchase order that does not exist in your inventory list.

If you are using Project and Job Costing, you may want to turn off this warning so it does not appear 
for non-material items.
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P/O Ship-Via Codes Screen

To Open this Screen

Open Purchase Orders > P/O Setup > Ship-Via Codes.

Related Tasks

 l "Adding Ship-Via Records   " (page 58)

 l "Managing Ship-Via Records   " (page 59)

 l "Setting up Purchase Orders" (page 3)

Overview

Use the Ship-Via Codes screen to set up a record for each carrier you use to deliver your orders from 
vendors.

Ship-via records are optional. Add them for the carriers you regularly use, so that you have a record 
of each carrier's address, phone numbers, and contact people. You can then specify ship-via codes 
on purchase orders, requisitions, receipts, and returns. If you do not use ship-via records, you can still 
type the name of a carrier on transactions (but not the address or any other information), or not 
specify a shipping method at all.

Fields and Controls

Contact tab

Type the name of the person or position you contact at the carrier's office to make 
arrangements or discuss shipping problems.

Ship-Via tab

Address

Type the address, city, state or province, zip or postal code, and country for the carrier's office.
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Comment

Type an optional comment about the ship-via record, using up to 80 characters.

Fax Number

Type the carrier's fax number (if any).

Name

Type the name or a description of the carrier, exactly as you want it to appear on Purchase Orders 
reports and forms.

Ship-Via Code

Type a code of up to six characters to identify the carrier. You can use letters and numbers.

Telephone

Type the carrier's telephone number.
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P/O Templates Screen  

To Open this Screen

Open Purchase Orders > P/O Setup > Templates.

Related Tasks

 l "Adding Templates" (page 61)

 l "Managing Templates   " (page 62)

Overview   

Use the Templates screen to create, edit, or delete sets of default header and vendor information to 
use in transactions.

You use the templates to automatically fill in fields in the transaction-entry screens with the 
information and selections you use most often, so you do not have to enter the information every time 
you add a transaction.

Order Tab

Use the Order tab to:

 l Enter default information for the Order tab and for use on the first tab of transaction-entry 
screens.

 l Modify default template information.

Vendor Information Tab

Use the Vendor Information tab to:

 l Enter default information for the Vendor tab in transaction entry screens.

 l Modify default vendor information.

Fields and Controls

Template Code and Description
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To begin adding a new template, type a code for it, using up to six characters, or choose New by 

clicking the New  button next to the Template code field. You can also type a description to 

identify the template (in the field next to the Template field).

To edit an existing template, type its code or select it from the Finder.

Order tab

Bill-To Location

If you use Inventory Control, type the code for the billing location you want to assign to the template 
or select it from the Finder. You can also leave this field blank.

If you do not use Inventory Control, this field does not appear.

Comment

Type a default comment to use with the template, or leave the field blank. The comment can include 
up to 250 characters.

Note: You can insert line breaks by pressing Ctrl + Enter.

Description

Type a description using up to 30 characters. This description will appear on purchase   orders, 
receipts, invoices, etc. 

If you want to describe the item more completely, use the comments fields.

FOB Point

Type a default free-on-board point (the point at which the vendor begins charging freight on orders) 
for the template.

You can also leave this field blank. You can change the FOB point when you use the template with a 
transaction.

On Hold

Select this option to have transactions entered with the template use "on hold" as the default.
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PO Type

Select the purchase order type for the template. You can select Active, Blanket, Future, or Standing. 
If you do not select a PO type, the template is assumed to be Active.

Reference

Type a default reference for the template. You can change the reference when you use the 
template with a transaction, and you can also leave this field blank.

Ship-To Location

If you use Inventory Control, type the code for the default location where you will receive items 
ordered when the template is used, or select it from the Finder. You can also leave this field blank.

If you do not use Inventory Control, this field does not appear.

Vendor Information tab

Ship Via

Type the code for the default shipping method to assign to the template, or select the code from the 
Finder. You can also leave this field blank.

Tax Group

Type the code for the default tax group that identifies the taxing authorities for the template, or 
select it from the Finder.

Note: You cannot add or save a template without a tax group.

Terms

Type the default payment terms code you want to use for the template. You can also select the code 
from the Finder, or leave the field blank. You can choose another terms code when you use the 
template with a transaction.

If you want to assign a terms code to a template, you must use one of the codes you have defined in 
Accounts Payable.
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P/O Vendor Contract Costs Screen

To Open this Screen

Open Purchase Orders > P/O Setup > Vendor Contract Costs.

Related Tasks

 l "Managing Vendor Contract Costs   " (page 65)

 l "Setting Up Vendor Contract Costs   " (page 65)

 l "Setting up Purchase Orders" (page 3)

Overview

Use the Vendor Contract Costs screen to assign vendors’ prices to your inventory items, specifying:

 l Base unit costs for single or multiple units of measure.

 l Sale unit costs for single or multiple units of measure.

 l Volume discount amounts or percentages.

 l Tax authorities and tax statuses for the contract cost.

Vendor contract costs appear as default entries when you add purchase orders, receipts, invoices, 
returns, and credit/debit notes. If no contract cost exists for an item and vendor, Purchase Orders 
displays the default item cost specified in the P/O Options screen.

You can view all vendors’ contract costs in the Unit Cost item Finder in the Purchase Order Entry, 
Receipt Entry, Invoice Entry, Return Entry, and Credit/Debit Note Entry screens.

The Contract Costs screen is similar to the I/C Item Pricing screen in the Inventory Control module. It 
lets you specify basic and sale costs for single or multiple units of measure, and specify percentage or 
flat amount discounts based purchase volumes.

Note: Vendor Contract Costs are not available in Sage 300 Standard.

Costs Tab

Use the Costs tab to:
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 l Change the description for the item on the purchase orders to match the vendor's description.

 l Choose the base unit cost type (single unit of measure or multiple units of measure).

 l Enter the base cost or costs.

 l Enter the unit of measure for a single base cost.

 l If entering costs for multiple UOMs, specify the default cost and UOM for purchase orders.

 l Choose the sale unit cost type (single unit of measure or multiple units of measure).

 l Enter the sale cost or costs.

 l Specify how the sale cost is calculated:     

 l Base unit cost minus a percentage.

 l Base unit cost minus an amount.

 l Fixed amount.

 l Enter the unit of measure for the cost.

 l If entering costs for multiple UOMs, specify the default cost and UOM for purchase orders.

 l Enter the sale dates for the item.

Discounts Tab

Use the Discounts tab to select the method for calculating volume discounts on costs, and enter the 
discount percentages or amounts to use.

Taxes Tab

Use the Taxes tab to assign the tax authorities and vendor tax classes that   apply to the item.

Fields and Controls

Item Number

Type the number of the inventory item to which you want to add vendor costs.

Vendor Number

Type or use the Finder to select the number for the vendor who supplies the inventory item.

If more than one vendor supplies an item, you can enter item costs for each of the vendors.
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Costs tab

Base Unit Cost

Enter the regular cost for this unit of measure.

Base Unit Cost Type

Choose whether you are entering a cost for a single unit of measure only, or for more than one unit 
of measure.

 l If you choose Base Unit Cost for Single Unit, enter:           

 l Base Unit Cost. The regular amount that you pay for this inventory item.

 l Base Unit of Measure. The unit of measure to which the Base Unit Cost applies.

 l If you choose Base Unit Cost for Multiple Units, click the Zoom button, and then enter:           

 l Unit of Measure. Enter or select one of the units of measure in which you buy this item 
from the vendor.             

Press the Insert key to add another unit of measure and cost.

 l Base Unit Cost. Enter the cost for this unit of measure.

 l Default. Double-click this field to switch it to “Yes” if this is the unit of measure and cost 
that you want to appear by default on requisitions and purchase.

Base Unit of Measure

Enter the unit of measure to which the Base Unit Cost applies.

Default

Double-click this field to switch it to “Yes” if this is the unit of measure and cost that you want to 
appear by default on purchase orders.

Purchase Orders will use the lowest cost unit of measure and cost from the Vendor Contract Cost 
records.

Description

Type a description using up to 30 characters. This description will appear on purchase   orders, 
receipts, invoices, etc. 
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If you want to describe the item more completely, use the comments fields.

Percentage/Amount

Enter the sale percentage reduction or the amount off, depending on the calculation method you 
choose.

For percentage and amount, the program calculates the sale cost from the base cost that you 
entered earlier.

Sale Starts/Sale Ends

Enter starting and ending dates for the sale. Purchase Orders will automatically use the sale cost if 
the requisition or purchase order dates fall within the sale period.

Sale Unit Cost

Enter the fixed sale unit cost for the item. For percentage and amount, the program calculates the 
sale cost from the base cost that you entered earlier, and displays it in the Sale Unit Cost field.

Sale Unit Cost Based On

Select one of the following methods for establishing the sale cost:

 l base cost minus a percentage

 l base cost minus an amount

 l fixed amount

Sale Unit Cost Type

If the vendor also gives you a standard sale price (or an alternate seasonal price), choose a single 
unit of measure cost or costs for multiple units of measure.

 l If you choose Sale Unit Cost for Single Unit, enter the following:           

 l Sale Unit Cost Based On. Purchase Orders provides three methods for establishing 
the sale cost—as the base cost minus a percentage, the base cost minus an amount, or 
as a fixed amount.

 l Percentage / Amount / Sale Unit Cost. Enter the sale percentage reduction, the 
amount off, or the fixed cost, depending on the calculation method you choose. For 
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percentage and amount, the program calculates the sale cost from the base cost that 
you entered earlier.

 l Sale Unit of Measure. Enter the unit of measure to which the sale applies. (You can 
enter base unit costs for multiple units of measure, but specify a sale price for a single 
unit.)

 l Sale Starts / Sale Ends. Enter starting and ending dates for the sale. Purchase 
Orders will automatically use the sale cost if the requisition or purchase order dates fall 
within the sale period.

 l If you choose Sale Unit Cost for Multiple Units, click the Zoom  button, and then enter 
the following:           

 l Unit of Measure. Enter or select one of the units of measure to which the sale applies.

 l Press Insert to add the cost for another unit of measure.

 l Sale Unit Cost Based On. Purchase Orders provides three methods for establishing 
each sale cost—as the base cost minus a percentage, the base cost minus an amount, 
or as a fixed amount.

 l Percentage / Amount / Sale Unit Cost. Enter the sale percentage reduction, the 
amount off, or the fixed cost, depending on the calculation method you choose. For 
percentage and amount, the program calculates the sale cost from the base cost that 
you entered earlier.

 l Sale Starts / Sale Ends. Enter starting and ending dates for the sale. Purchase 
Orders will automatically use the sale cost if the requisition or purchase order dates fall 
within the sale period.

 l Default. Double-click this field to switch it to “Yes” if this is the unit of measure and cost 
that you want to appear by default on requisitions and purchase.

Discounts tab

Discount Based On

Choose Percentage or Amount depending on how the discount is calculated. (For example, you 
might get 10% off when you order more than 100 items.)

Discount Percentage/Discount Amount

Enter the discount available when you order the quantity specified in the From column. The 
program automatically fills in the To column if you add another discount level.

366Sage 300 2021 Purchase Orders User's Guide



Enter the minimum volume required for the discount in the From field.

The program automatically fills in the To value when you add a second discount level.

You can enter up to 10 different discount ranges in the discounts grid, specifying the From volume 
and the Discount Percentage or Amount (depending on the discount method).

The To field of the last line is always blank.

From/To

Enter the minimum volume required for the discount in the From field.

The program automatically fills in the To value when you add a second discount level.

You can enter up to 10 different discount ranges in the discounts grid, specifying the From volume 
and the Discount Percentage or Amount (depending on the discount method).

The To field of the last line is always blank.

Round to a Multiple

This field appears only if you select Round Up or Round Down in the Rounding Method field.

You might enter multiples such as “0.50,” “1.00,” “5.00,” or “10.00.”

Rounding applies to percentage discounts only.

Rounding Method

Rounding applies to percentage discounts only.

Specify if you want to round the discount unit cost of the item calculated by the program. You can 
choose no rounding, rounding up, or rounding down. If you round the amount, you can also specify 
the degree of rounding (such as to the closest dollar or closest 100 dollars).

Taxes tab

Vendor Tax Authority

Select the tax authority for the item contract cost. The Finder displays only those tax authorities that 
allow tax to be included in the price.

The purpose of the Taxes tab is to let you specify taxes that are included in the item contract cost.
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For example, gas prices in Canada have GST included in the price. If the contract price was for gas, 
the GST tax authority would be specified on the Taxes page.

Vendor Tax Class

The program displays the first tax class record for the tax authority. You can accept or change the 
tax class (for example, if you are tax exempt for this item).
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P/O Vendor Details Screen   

Note: This screen is available only if you are using Purchase Orders as a stand-alone program 
(that is, you do not use Inventory Control).

To Open this Screen

Open Purchase Orders > P/O Setup > Vendor Details.

Related Tasks

 l "Adding Vendor Details   " (page 63)

 l "Managing Vendor Details   " (page 64)

 l "Setting up Purchase Orders" (page 3)

Overview   

Use the Vendor Details screen to:

 l Record the vendors and costs for each item you purchase.

 l Establish the order of priority of your suppliers, if you buy the same item from more than one 
vendor.

Fields and Controls

Cost Unit

Enter the cost unit (such as each, crate, or case). The program will adjust the vendor cost 
accordingly.

Item Number

Type the number or code of the item to which you want to add vendor details.

Order Minimum (SIA)

Enter the minimum quantity of the item that you must order from this vendor.
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Note: This information is used only by Sage Inventory Advisor (SIA).

Preferred Vendor (SIA)

If you purchase the item from multiple vendors, you can use this field to specify a preferred vendor.

Note: This information is used only by Sage Inventory Advisor (SIA).

Vendor Contact

Type the name of the contact person at the vendor company.

Vendor Cost

Enter the vendor’s price for the item.

Vendor Currency

This field is available only if you are using a multicurrency ledger.

When entering a new vendor, either type in the three-letter international currency code (for 
example, USD, CAD, or GBP) for the vendor’s home currency, or select one using the Finder. You 
cannot modify this field for an existing vendor.

Vendor Item Number

Type the number that the vendor uses to identify the item.

Vendor Name

Type the name of the vendor company.

Vendor Number

Type or use the Finder to select the identification number you use for the vendor of the item.

Vendor Type

The vendor type is a number that sets the priority for each vendor of the selected item. No two 
vendors can have the same priority.
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You can specify up to nine vendors, and you may enter them in any order you please. However, 
when you return to the screen the program will display them in ascending order.
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P/O Weight Units of Measure Screen   

Note: This screen is available only if you are using Purchase Orders as a stand-alone program 
(that is, you do not use Inventory Control).

To Open this Screen

Open Purchase Orders > P/O Setup > Weight Units of Measure.

Related Tasks

 l "Setting up Purchase Orders" (page 3)

Overview

Use the Weight Units of Measure screen to add the different units that you use for measuring the 
weight of items—such as pounds, tons, kilograms, and metric tons.

The default weight unit of measure (specified on the P/O Options screen) is the unit for expressing the 
weight of orders in Purchase Orders if you do not use the Inventory Control module.

The default weight unit of measure has a conversion factor of 1, and all other weight UOMs are 
defined in terms of a default weight UOM.

Before Adding Weight Units of Measure

 l Decide on the default weight unit of measure that you want to use on orders.

 l Calculate the conversion factors between the default weight unit of measure and all other 
weight units of measure.

Requirements For Adding A Weight Unit of Measure

 l The weight unit of measure.

 l A description of the weight.

 l The weight conversion factor between the default weight unit of measure and the unit you are 
adding (as a multiple of the default weight unit of measure).

 l The conversion factor for a default weight unit of measure is always 1.
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 l You can use fractions in weight conversion factors even if you do not use fractional inventory 
quantities.

You set the default weight unit of measure on the P/O Options screen after adding it to the Weight 
Units of Measure screen.

 l Choose what to call each of the weight units of measure. The names you use appear on data 
entry screens.

Fields and Controls

1.0000 (default unit) Equals (default weight UOM)                     

This column shows the opposite calculation to the conversion factor. For example:

Weight UOM Conversion 
Factor

1 pound 
equals

Pound—default UOM 1 1 lb.

Kilogram 2.2 .4545 kg.

Ton 2,000 .0005 tons

The reciprocal of the conversion factor is automatically calculated by Inventory Control. It provides a 
visual check on the conversion factor.

Default Weight Unit of Measure

This field is available only if you do not use Inventory Control.

Choose the weight unit of measure which is the basic or standard unit that you use for measuring the 
weight of your inventory items—such as pounds or kilograms.

Note: Usually, you will add weight units of measure after choosing inventory options, so you will 
select the default unit at a later time.

Order Entry uses the weights in inventory item records to estimate the total weight of each order in 
the unit of weight you specify here.
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Purchase Orders can use the weights in inventory records to prorate (distribute) additional costs on 
orders.

Description

Enter a description for the unit of measure, such as pound or kilogram.

Weight Conversion Factor

Enter the factor for converting this weight unit to the default weight unit of measure. For example, if 
“pound” is the default weight unit of measure (with a conversion factor of 1), the conversion factor for 
“ton” would be 2,000.

You can use fractions in weight conversion factors even if you do not use fractional inventory 
quantities. For example, the factor to convert kilograms to pounds would be 2.2.

Weight Unit of Measure

Type the weight unit of measure as you want it to appear on data entry screens. For example, “lb” or 
“kg.” You can enter an expanded description in the next field.
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Statistics and Inquiries Screens
Use Purchase Orders Statistics and Inquiries screens to look up information about vendors and 
transactions.

P/O Purchase History Screen

To Open this Screen

Open  Purchase Orders > P/O Statistics and Inquiries >      Purchase History.

Secondary Screens

 l "P/O Purchase History Detail Screen" (page 376)

Related Tasks

 l "Looking Up Purchase History" (page 218)

Overview

Use the P/O Purchase History screen to:

 l Review purchasing data that is kept by Purchase Orders if you use the Keep Purchase History   
option.

 l See details of a selected transaction by clicking the Details button.

The screen displays all purchases and returns of items for the fiscal or calendar years and periods for 
which you keep history.

Tip: You can also check purchase history for an item or a vendor while entering a transaction by 
selecting a detail, and then clicking the History button on the transaction entry screen.
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P/O Purchase History Detail Screen

To Open this Screen

 1. Open  Purchase Orders > P/O Statistics and Inquiries >      Purchase History.

 2. Click Details.

Related Tasks

 l "Looking Up Purchase History" (page 218)

Overview   

Use the P/O Purchase History Detail screen to check and edit the details of transactions posted for   
the selected vendor or item number in the year and period you specified.

Information includes the year and period, transaction type and date,   document number, quantity, unit 
of measure, cost, and number of days between   the time you issued the purchase order and posted 
the receipt.

If working with transactions that include serialized and lotted items,   you can click Serial/Lot Numbers 
to display the numbers.

Fields and Controls

Item Number and Description

Purchase Orders displays the item number and description for the selected   detail.

Vendor Number and Name

Purchase Orders displays the vendor number and name for the selected   detail.

Table

Contract, Project, and Category

The purchase history details screen lists the contract, project and category for items that were 
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purchased for jobs.

Days To Receive

This field displays the number of days between the time you posted the   purchase order for the item 
and the date you posted the first receipt   of the item.

Document Number

The number assigned to the transaction when you posted it. (You either   typed the number or 
allowed Purchase Orders to assign it automatically.)

Extented Cost

This field displays the extended cost of the selected transaction.

Location

This field appears only if you also use Inventory Control. The Location   field displays the code for the 
location at which the item was taken into   inventory.

Quantity

This field displays the number of units of the item that was purchased,   returned, invoiced, credited, 
or debited on the selected transaction.   The quantity is expressed in the unit of measure specified for 
the transaction.

Transaction Date

This field displays the date entered with the transaction.

Transaction Type

This field identifies the type of transaction (receipt, return, invoice,   credit note, or debit note).

Unit of Measure

This field displays the unit of measure specified for the item on the   selected transaction. The 
quantity and cost are expressed in terms of   this unit.
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Year and Period

When you are displaying purchase history for a vendor number, these   fields display the year (fiscal 
or calendar) and period in which you posted   the selected transaction. (Information is displayed by 
the type of year   and period you specify on the P/O Options screen for the Accumulate Purchase   
History option.)
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P/O Purchase Statistics Screen

To Open this Screen

Open  Purchase Orders > P/O Statistics and Inquiries >      Purchase Statistics.

Related Tasks

 l "Adding and Managing Statistics" (page 73)

 l "Deleting Purchase Statistics" (page 74)

 l "Looking Up Purchase Statistics" (page 220)

Overview

Use this screen to:

 l Enter purchase statistics from your previous purchase order system when setting up Sage 300 
Purchase Orders, or edit existing statistics.

 l Review, add, or edit the number of purchase orders, receipts, invoices, credit notes, and debit 
notes posted in your Purchase Orders system for the year and period you specify.

 l Review, add, or edit the net quantity purchased, and net purchase and net invoice amounts 
that were posted in your Purchase Orders system during the year and period you specify.

Purchase Orders can keep purchase statistics from your posted purchase orders, invoices, receipts, 
credit notes, and debit notes. You can review the statistics as far back as the oldest year and period 
for which you keep this information by printing the O/E Purchase Statistics report.

Fields and Controls

Currency

Select the currency in which you are entering the statistics. You can   add statistics in the vendor's 
currency or in the functional currency.

You see this field only in multicurrency ledgers.
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Period

Type the period for which you want to add, edit, delete, or view statistics,   or click the Up or Down 
Arrow key to select the period.

You can accumulate statistics by fiscal or calendar year and period. 

Year

Type the year for which you want to add, edit, delete, or view statistics,   or use the Finder to select 
the year.

Purchases table

Net Invoice Amount

The net amount of all   invoices posted in the period.

The net invoice amount includes additional costs and taxes.

Net Purchase Amount

The net amount of all   purchases in the period.

The net purchase amount does not include additional costs or taxes.

Net Quantity Purchased

The net number of units of all items you received in the period.

Number of POs

The number of purchase orders that were posted in your Purchase Orders   system during the 
selected year and period.

Number of Receipts

The number of receipts that were posted in your Purchase Orders system   during the selected year 
and period.

Invoices, Credit Notes and Debit Notes table

Number of Credit Notes and Debit Notes
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The total number of credit notes and debit notes that were posted in   your Purchase Orders system 
during the selected year and period.

Number of Invoices

The total number of invoices that were posted in your Purchase Orders   system during the selected 
year and period.

Average Credit Note and Debit Note

The average monetary amount of the credit notes and debit notes that   were posted in your 
Purchase Orders system during the selected year and   period.

In multicurrency ledgers, this amount is shown in both the selected   vendor currency and the 
functional currency.

Average Invoice

The average monetary amount of invoices or credit notes that were posted   in your Purchase Orders 
system during the selected year and period.

In multicurrency ledgers, this amount is shown in both the selected   vendor currency and the 
functional currency.

Largest Credit Note and Debit Note

The largest credit note and debit note (monetary amount) that were posted   in your Purchase Orders 
system in the selected year and period.

In multicurrency ledgers, this amount is shown in both the selected   vendor currency and the 
functional currency.

Largest Invoice

The largest invoice (monetary amount) that was posted in your Purchase   Orders system in the 
selected year and period.

In multicurrency ledgers, this amount is shown in both the selected   vendor currency and the 
functional currency.

Smallest Credit Note and Debit Note

The smallest credit note and debit note (monetary amount) that was posted   in your Purchase 
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Orders system in the selected year and period.

In multicurrency ledgers, this amount is shown in both the selected   vendor currency and the 
functional currency.

Smallest Invoice

The amount of the smallest invoice (monetary amount) that was posted   in your Purchase Orders 
system in the selected year and period.

In multicurrency ledgers, this amount is shown in both the selected   vendor currency and the 
functional currency.

Vendor (with largest credit note and debit   note)

The vendor number to whose account the largest credit note and debit   note (monetary amount) was 
posted in the selected year and period.

Vendor (with largest invoice)

The vendor number to whose account the largest invoice (monetary amount)   was posted in the 
selected year and period.

Vendor (with smallest credit note/debit   note)

The vendor number to whose account the smallest credit note and debit   note (monetary amount) 
was posted in the selected year and period.

Vendor (with smallest invoice)

The vendor number to whose account the smallest invoice (monetary amount)   was posted in the 
selected year and period.
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P/O Pending Receipts Inquiry Screen

To Open this Screen

Open Purchase Orders > P/O Statistics and Inquiries >      Pending Receipts Inquiry.

Secondary Screens

 l "P/O Receipt Details Screen" (page 386)

Related Tasks

 l "Viewing Pending Receipts" (page 217)

Overview   

Use the P/O Pending Receipts Inquiry screen to review items that are expected to arrive at particular   
locations within a given time period (for example, in the next 7 days),   and to determine whether there 
will be sufficient stock to cover sales orders.

Purchase Orders lets you search pending receipts by item number or by   vendor, and also lets you 
view completed purchase orders to see if items   were delivered within the expected arrival times. 

The inquiry finds active, standing, future, blanket, or all purchase   orders that are not   on hold and that 
fit the selection criteria. You   can limit the inquiry to specific locations.

For instructions on viewing pending receipts, see "Viewing Pending Receipts" (page 217).

Fields and Controls

From/To Expected Arrival Date

Leave the From field blank to include   all purchase orders with outstanding items, and enter the end 
date for   the inquiry in the To field.

Accept the default entries if you wish to view all purchase orders regardless   of their expected arrival 
dates.
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From/To Location

Enter a range of inventory locations, or skip the Location fields to   display all locations.

This selection includes orders where the shipping location matches the   range of locations that you 
specify.

From / To PO Date

Specify the range of document dates that you want to view. The PO Date   is the document date 
specified on the purchase order.

Include Completed Detail Lines

Select Include Completed Detail Lines to see if items were received   within the expected arrival 
times.

Item Number

Enter the number of the item that you want to review. You   can also use the Select By option to 
review pending receipts by vendor.

PO Type

You can choose to review all pending receipts, or select a particular   type of purchase order, either 
active, standing, future, or blanket POs.

Select By

Choose whether you want to inquire by item or by vendor, and then select   the item number or 
vendor number for which you want to view details.

You can press the Up or Down keys on your keyboard to make your selection, or   type I to select Item 
Number and V to select Vendor Number.

Show Late POs Only

Choose this option to see detail lines that are past their expected   arrival dates.

Vendor Number

Type the vendor number whose purchase orders you want to review. You   can also use the Select 
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By choice to review pending receipts by item number.

Table

Completed

Detail lines are completed on purchase orders when the entire quantity   is received or if you cancel 
any outstanding quantity.

Date Received

If the purchase order detail line has had receipts posted against it,   this field displays the transaction 
date for the receipt.

Days Late

This field will be blank if the receipt was not (or is not) late.

If the date received was later than the expected arrival date, this   field will show the number of days 
that the goods were late.

Expected Arrival Date

The date on the purchase order when you expect the goods to arrive from   your vendor.

Item Number and Description

These fields display the item number on the purchase order that matches   the criteria that you 
specified for pending receipts, as well as the description   for the item number.

Location

The location to which the purchase order detail item will be received,   specified on the purchase 
order.

PO Date

This is the document date specified on the purchase order.
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PO Number and Description

This is the document number assigned to the purchase order where this   detail appeared. The 
program also displays the description entered on   the PO.

PO Type

You can choose to review all pending receipts, or select a particular   type of purchase order, either 
active, standing, future, or blanket POs.

Quantity Ordered

This is the number of items originally ordered on this PO detail line.

Unit Of Measure

This is the unit of measure for the quantity on purchase order (for   example, dozen, crate, etc.).

Vendor Number and Name

The number and name of the vendor on the purchase order.

P/O Receipt Details Screen

To Open this Screen

 1. Open Purchase Orders > P/O Statistics and Inquiries >      Pending Receipts Inquiry.

 2. Specify a range of purchase orders to view, and then    double-click a PO line on the Detail table, 
or select the line and click Details.

Related Tasks

 l "Viewing Pending Receipts" (page 217)

Overview   

Use the Receipt Details screen to view more information   for any PO line item—such as receipt 
quantities and days late.
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The program displays the following additional information   for each receipt associated with the PO 
line:

 l Receipt Number

 l Location

 l Contract,   Project, Category (if job-related)

 l Quantity   Ordered

 l Order   Unit of Measure

 l Quantity   Received

 l Receipt   Unit of Measure

 l Date   Received

 l Expected   Arrival Date

 l Days   Late

Fields and Controls

Item Number and Description

These fields display the item number on the purchase order that matches   the criteria that you 
specified for pending receipts, as well as the description   for the item number.

PO Number and Description

This is the document number assigned to the purchase order where this   detail appeared. The 
program also displays the description entered on   the PO.

Vendor Number and Name

The number and name of the vendor on the purchase order.

Table

Contract, Project, and Category

If the purchase order detail was job-related, these fields will show   the contract, project, and category 
for which the item was ordered.
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Date Received

If the purchase order detail line has had receipts posted against it,   this field displays the transaction 
date for the receipt.

Days Late

This field will be blank if the receipt was not (or is not) late.

If the date received was later than the expected arrival date, this   field will show the number of days 
that the goods were late.

Expected Arrival Date

The date on the purchase order when you expect the goods to arrive from   your vendor.

Location

The location at which the purchase order detail item was received.

Order Unit of Measure

This is the unit of measure for the quantity on purchase order (for   example, dozen, crate, etc.).

Quantity Ordered

This is the number of items originally ordered on this PO detail line.

Quantity Received

This is the number of items that were received in this receipt transaction.

Receipt Unit of Measure

This is the unit of measure for the quantity received (for example,   dozen, crate, etc.).

Receipt Number

The detail grid lists all of the receipts for the detail line displayed in the top part of the screen.

This field shows the receipt numbers assigned when you received items for this detail line.
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Transaction Screens
Use Purchase Orders transaction entry screens to process purchase orders, requisitions, receipts, 
invoices, returns, credit notes, and debit notes

P/O Copy Purchase Orders Screen 

To Open this Screen

Open Purchase Orders > P/O Transactions > Copy Purchase Orders.

Related Tasks

 l "Copying Purchase Orders" (page 122)

Overview   

Use the Copy Purchase Orders screen to select an existing purchase order,   or a range of POs, on 
which to base a new purchase order. The details   from the existing purchase orders, including item 
numbers, quantities ordered, costs,   and other information, appear as defaults for the new purchase 
order.

You can select the details that you want to copy to the new purchase   order, and you can change the 
location, expected arrival date, whether   items are drop-shipped, the quantity ordered, cost, unit of 
measure, unit   weight, optional fields for any detail lines, and contract information   for job-related 
orders.

Note: You cannot add new detail   lines to a purchase order. You cannot select different   item codes 
for the detail lines and, if you are copying job-related purchase orders,   you cannot change the 
contract, project, or category.

Fields and Controls

Buttons

New
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Click the New button to begin creating a new record.

From/To   Vendor Number

You can copy details from previously entered orders for the same vendor   or from a different vendor. 

In the From and To Vendor Number fields, enter or select:

 l The number of the vendor   with the order details that you are copying.

 l The number of the vendor   for whom you are creating a new order.

The Copy Orders program collects the order details from all orders you   specify and adds them to the 
new order that you are creating.

If the vendor currencies   are the same, the program copies order details using the prices   from the 
previous orders. 

If the vendors use different   currencies, you specify the price list to   use for the copied order details. 

You can change the prices for the new details after creating   the new order.

From/To   PO Number

Enter the range of existing orders that contain the details you want   to use in the new order.

Click the Go  button    to display the details from the selected orders.

Tax   Group

The program uses the To vendor's tax group as the default. However, you can specify a different tax 
group for the new order. 

PO   Type

Select one of the following types of purchase orders to copy from:

 l Active—to copy details   from currently active purchase orders.

 l Future—to copy details   from future POs only.

 l Standing—to copy details   from purchase orders   that are placed repeatedly.

 l Blanket—to copy details   from POs for making   a number of purchases over time.
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Job   Related

This option is available only if you have Project and Job Costing. Select it if you want to copy details 
for job-related purchase orders.

If you select this option, the program selects job-related purchase   orders for the specified range of 
purchase orders, and copies the details to a new   purchase order.

Use   PO Cost

Select this option to copy costs from the original POs   to the new PO that you are creating.

Note: In a multicurrency system, this option is available only if both From and To vendors use the 
same currency.

Copy POs tab

Amount Available

This field appears for blanket purchase orders. It   is calculated as the original amount minus the total 
extended costs of   all detail lines in the grid.

Description

Use this field to enter a description for the new purchase order you   are creating.

On Hold

Select this option if you need to place the new purchase order on hold.

If the vendor account is on hold in Accounts Payable, the purchase order   is automatically placed on 
hold. 

Note: You   can clear the On Hold status in Purchase Order Entry. You do not have   to remove the 
On Hold status in Accounts Payable.

You can list the orders currently on hold on the Purchase Order Action   report.

Original Amount

Enter the amount of the blanket PO you are creating.
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PO Date

Type the date for the purchase order. For a future order, enter the date that the purchase order 
becomes active.

The program automatically enters the system date in this field (the date you type when you open the 
company when you start Sage 300).

This date is also used to age the order on the Aged Purchase Orders report.

PO Number

To add a new purchase order, accept "New" or enter the number.

Purchase Order Entry assigns the purchase order number using the numbering scheme defined in 
the Options screen in the P/O Setup folder, unless you enter another number here.

PO Type

Select the type of purchase order you are creating:

 l Active—for a purchase order that you want to fill immediately.

 l Future—for a purchase   order to become active and posted when you run Day End Processing 
on the specified   order date. You can change the purchase order status to Active before the 
purchase order date.

 l Standing—for purchase orders that are placed repeatedly.

 l Blanket—for a particular   amount when making a number of purchases over time.

By default, the program chooses the same type of purchase order that you are copying from.

Reference

Type an optional reference for the purchase order, using up to 60 characters.

The reference appears in Accounts Payable as the reference for the invoice, and in the general 
ledger batch (if you select Reference for the G/L Reference Field or G/L Description field option in 
the G/L Integration screen in the Accounts Payable program, and do not consolidate the general 
ledger transactions   created by Accounts Payable).

Detail table

Contract, Project, Category, Cost Class (if job-related)
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If the new purchase order is job-related, you specify for each purchase order detail where the items 
or resources are going   to be used. If you use different terms than ”Contract,”   ”Project,” and 
”Category” in Project and Job Costing, the program displays them instead. 

You enter/select the resource using the Item Number field.

Copy Detail

Use this field to indicate whether to copy this detail line to the new purchase order.

Double-click the field, or click the field, then press the spacebar to change the value of the field 
between Yes and No.

Drop Ship

To enter a drop-ship address for a detail, click the Zoom  button beside the Drop Ship field, or 

select the field and press Shift+F9. 

Select the type of address to enter, and if necessary, select the   location code, customer number, or 
ship-to address code for the address.

Expected Arrival Date

If necessary, enter or edit the date on which you expect to receive   the goods ordered on the detail 
line. 

If you entered a date in the Arrival Date field on the Order tab (or   on a requisition from which you 
are creating the purchase order), the   date is used as the default expected arrival date for new 
details   you add to the purchase order.

Item Description

The program displays the description from the item record. You can change it for the purchase 
order.

Item   Number

This field displays the code for the item used in the original order.

You cannot select different item codes for the detail lines on the Copy Purchase Orders screen.

You can, however:
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 l Copy the detail line.

 l Change the location, expected arrival date, drop-ship address, quantity ordered, cost (unit or 
extended), units of measure, weight units of measure and weight, vendor item number, and 
optional fields.

Line Number

Line numbers are assigned automatically by the program and you cannot change them. You use 
line numbers to identify details you have entered or to recall them for editing when you are using the 
zoomed screen for entering detail information.

Location

This field appears only if you use Inventory   Control.

Enter the code for the location where you expect to receive the shipment   (or to which you want to 
post drop-shipped items). 

The program displays the ship-to location code, if any, entered on the   first tab, but you can select a 
different location. You can omit the location   when adding details for non-inventory items.

Note: If you change  locations after assigning serial and/or lot numbers, you must re-assign the 
serial and/or lot numbers.

Optional Fields

Double-click the Optional Fields cell on the detail line or click the Zoom button column heading to 
enter information for an optional field that was assigned to this transaction type in the P/O Optional 
Fields setup screen.

The entry in the grid will change from No to Yes.

You can also enter optional field information for the purchase order as a whole on the Optional 
Fields tab.

Quantity Ordered

For new detail lines, type the item quantity to order (in the unit you   select for the Unit Of Measure 
field).

If you are creating a purchase order from a requisition, the quantity   entered for the detail on the 
requisition appears in this field, but you can change   it.
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Unit of Measure

Enter the unit of measure in which to order the item. If you are creating a purchase order from a 
requisition, the unit of   measure entered for the detail on the requisition is displayed, but you   can 
change it.

If you are entering new detail lines, the program displays the stocking   UOM by default, unless you 
have set up vendor contract costs using a different   UOM.

You must use one of the units of measure that is assigned for the item   in Inventory Control. 

Note: The weight UOM can be different from the   order UOM.

Unit/Extended   Cost

You can edit the unit cost or the extended cost for a detail. 

If you selected the Use PO Cost option, the cost is copied from the original PO. Otherwise, the 
program uses the default item cost   specified in the P/O Options screen.

Unit/Extended   Weight

The program uses the unit weight from the original   purchase orders. You can edit the unit weight or 
the extended weight.

Make sure that the weight you enter is for the selected   weight unit of measure.

Vendor Item Number

This field displays the number that the vendor uses to identify the item, if a vendor item number is 
defined for the item in Inventory Control.

Weight   Unit of Measure

This field displays the unit of measure for the item   weight. 

You can choose any of the weight units of measure defined   in Inventory Control.

Optional Fields tab

Optional   Field and Description

Fill in the value field for any optional fields that appear. If a field is required, you cannot save the 
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purchase order until you fill in the   value (unless the program provides a default value).

To add optional item fields that were not automatically inserted, use the Insert key to add a new line 
to the grid, and then use the Finder   to add the optional field.

Optional fields must be assigned to the Purchase Order Entry screen using the P/O Optional Fields 
screen before you can add them to purchase orders.

When you select an optional field code, the program displays the description for the optional field.

Value   Set

The Value Set column shows whether a blank optional field currently has a value. (You cannot know 
just by looking at the field whether it has a default value that is blank, or no value at all.)

The Value Set field will change from No to Yes if you make an entry in the Value field.

Value   and Description

If the optional field is required, you cannot save the purchase order   until you enter a value.

If the optional field you selected requires validation, you must select   a value that is defined for the 
optional field in Common Services (unless   the optional field allows blanks). 

If you select a value, the description for the value you select will   appear in the description column.

If you delete the value, the optional field will be deleted from the   grid. If the field is required, you will 
have to reinsert it and enter   a value before you can save the order.
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P/O Credit/Debit Note Entry Screen

To Open this Screen

Open Purchase Orders > P/O Transactions > Credit/Debit Note Entry.

Secondary Screens

 l "P/O Credit/Debit Note Entry Bill-To Location Information Screen" (page 434)

 l "P/O Credit/Debit Note Entry Cost Allocation Screen" (page 448)

 l "P/O Credit/Debit Note Entry Detail Comments Screen" (page 443)

 l "P/O Credit/Debit Note Entry Detail Costs/Taxes Screen" (page 444)

 l "P/O Credit/Debit Note Entry Detail Items/Taxes Screen" (page 435)

 l "P/O Remit-To Location Screen" (page 492).

Related Tasks

 l "    Adding or Editing Details Using the Detail Items Taxes Screen" (page 175)

 l "Entering a Credit or Debit Note for a Return or Invoice" (page 171)

 l "Entering or Editing Additional Costs on Credit and Debit Notes" (page 176)

 l "Entering a Return for a Cleared or Missing Invoice" (page 166)

 l "Entering or Editing Additional Costs on Credit and Debit Notes" (page 176)

 l "Prorating Additional Costs on Receipts" (page 141)

 l "Returning and Issuing Credit/Debit Notes for Lotted Items" (page 190)

 l "Returning and Issuing Credit/Debit Notes for Serialized Items   " (page 188)

Overview   

Use Credit/Debit Note Entry screen to enter credit notes and      debit notes from your vendors. Mo re ...

On the P/O Credit/Debit Note Entry screen, you can:
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 l Review existing credit notes and debit notes.

 l Enter new additional costs on credit notes and debit notes.

 l Export credit notes and debit notes.

 l Assign serial/lot numbers to items (if you use Serialized       Inventory and Lot Tracking).

Additional   Costs Tab

Use the Additional Costs tab to enter the additional costs   your vendors charge on credit notes and 
debit notes. Mo re ...

On this tab you can:

 l Specify how to reprorate   the costs if you returned the items.

Note: If   you are adding additional costs, you must choose No Proration. If you   choose to prorate, 
the program displays an error message and prevents   you from posting the credit note or debit 
note.

 l Allocate new additional   costs (added to the credit note/debit note) to one or more receipts.

 l Edit additional cost details   from invoices you are crediting or debiting.

Credit/Debit Tab

The name of this tab is Credit Note or Debit Note, depending on the document type you selected. It 
provides separate sections, where you can enter or view document information, as follows:

 l Header. You use the top portion of the tab to enter general information that applies to the entire 
document (for example, the date, description, the invoice or return   number to which the 
transaction applies, the billing and remit-to locations, , and whether the document is job 
related).

 l Details. You use the Details table to add and edit item detail lines for items.   Mo re ...

On the Details table, you can:

 l Enter new details for   a credit note or debit note you are entering without an invoice or 
return   number.

 l Edit the item detail lines   for a credit note or debit note for an existing invoice or return 
from   a primary vendor.   (You cannot add new detail lines when working with an existing 
invoice   or return, and you cannot delete detail lines displayed from returns.)

 l Open a separate screen to   edit tax or other information for a single detail. The Detail 
Items/Taxes screen   displays all the fields for a single detail, including tax fields. For more 
information, see "P/O Credit/Debit Note Entry Detail Items/Taxes Screen" (page 435).
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Optional Fields Tab

If optional fields are assigned to the Credit/Debit   Note Entry screen, use the Optional Fields tab to 
enter optional field information that applies to the entire debit note or credit note. Mo re ...

Optional fields and values appear automatically on this tab if you selected the Auto Insert option for 
those fields on the O/E Optional Fields setup screen.

If you use identical optional fields in Order Entry transactions and Accounts Receivable invoices, the 
information in the Order Entry fields is sent to Accounts Receivable.

Note: If an optional field is required but does not have a default value, you must specify a value for 
the field.

For more information, see "About Optional Fields" (page 51).

Rates Tab

This tab appears only in multicurrency ledgers when you are entering   a credit note or debit note for a 
vendor who does not use the functional   currency. Mo re ...

Use this tab to:                                                                 

 l Change the rate type,   rate date, and exchange rate for converting the credit note or debit note   
amount from the vendor's currency to your functional (home) currency.

 l Look up the rate information   entered with the invoice or return, if any, to which you are posting 
a   credit note or debit note.

Retainage Tab

The Retainage appears only if the receipt or invoice you are crediting or debiting was job related and 
it included retainage amounts. 

You use this   tab for multicurrency documents to specify whether to use   the original retainage 
exchange rate for the credit/debit note, or use   the current exchange rate. 

Taxes Tab

Use the Taxes tab  to review and change tax information and vendor tax group for the credit or debit 
note. Mo re ...

On the Taxes tab, you can:
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 l View or change the vendor's   tax group.

 l Check tax information   and edit the tax classes and amounts for the vendor's tax authorities.

Click Calculate Taxes to cancel changes you make to tax amounts.   (The program recalculates tax 
amounts using the tax tables in Tax Services.)

 

Totals Tab

Use the Totals tab to review and edit discounts, totals, and other final document details.   Mo re ...

On the Totals tab, you can:

 l Enter a comment for the   credit or debit note.

 l Enter a discount that   applies to the whole transaction.

 l Verify credit note or   debit note totals for the vendor.

 l Check tax amounts.

 l Check the estimated weight   of the goods for which you were credited or debited.

 l Check the number of item   and additional cost details entered for the vendor on the credit note   
or debit note.

 l Check the document subtotal   and total additional costs for the vendor.

Fields and Controls

Buttons

Calculate Taxes

Click the Calculate Taxes button to see tax amounts for   a detail before you post the credit note or 
debit note or click   the Totals tab. (Tax amounts are not automatically calculated until you   post the 
credit note or debit note, or click the Taxes tab or Totals   tab.)

If you edit tax amounts on the Taxes tab, and then click the Calculate Taxes button  on any tab, the 
program replaces any tax   amounts you entered on the Taxes tab with the amounts recalculated 
using the tax tables from Tax Services.

History

Click the History button to open the P/O Purchase History screen, where you can check information 
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about the items you have purchased from your vendors.

For more information, see "P/O Purchase History Screen" (page 375).

Item/Tax

Click the Item/Tax button to open the Detail Items/Taxes screen for a selected detail so that you can 
check the tax information, and change the tax classes and taxable status, as needed. (Select the 
detail line on the Credit/Debit tab, then click the Item/Tax button.)

Post

Click Post to post the document, including any changes you   made to an existing document. 

Document Number

Enter the number of the credit note or debit note in the the Document Number field.   Purchase 
Orders does not assign credit note and debit note numbers.

You can:

 l Start a new credit note or debit note. (Type the number in the Document Number field, then 
press Tab.)

 l Enter a credit note or debit note with the same number as a credit note or debit note you 
posted   previously. (Type the number, press Tab, and then click New in the Finder   that 
appears.)

 l View a credit note or debit note you posted previously, if you keep history or have not yet   run 
Day End Processing. (Type the credit note or debit note number, or select   it from the Finder. 
You cannot change credit notes and debit notes after posting them.)

Entered By

If the transaction was entered manually in Purchase Orders, the field displays the user ID of the 
person who entered the transaction.

Vendor Number

Enter the code for the vendor from whom you received the credit note or debit   note. 
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The vendor number sets the default tax group. In multicurrency systems,   the vendor number also 
specifies the currency of the document.

Note: After you enter a vendor number, the field to the right displays the vendor's name.

Skip this field if you plan to specify a return or invoice   number. (The return or invoice number 
determines the vendor number for   the credit note or debit note.)

If you are entering a credit note or debit note without a return or   invoice number, you can: 

 l Select an existing vendor using the Finder, or type the vendor number, and then press Tab.

 l Add a new vendor by doing one of the following:

 l If you want to add the vendor record now, click the New button after typing the vendor 
number. Fill in the vendor information in Accounts Payable,   click Add, then Close to 
return to Purchase Orders.

 l If you do not want to add the vendor record now, type only the vendor number. (You 
can enter   the vendor name on the next tab.) 

Important! You must   add the vendor record in Accounts Payable before you can post the invoice   
for the vendor in the Accounts Payable program. You cannot enter credit notes or debit notes for 
inactive vendor accounts. For more information about adding vendors, see the Accounts Payable 
help.

Additional Costs tab

Table

Additional Cost (code and description)                                     

Type the code for the additional cost you want to add, or select the code from the Finder. If you are 
adding a cost for which no code is defined, skip this field and type the name of the cost in the 
Description field (the field beside the Additional Cost field on the Detail Items/Taxes screen).

You cannot change the additional cost code when editing a detail from an invoice or return.

You use the Additional Costs screen, in the P/O Setup folder, to add or edit additional cost codes in 
Purchase Orders.
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Amount

Use the Amount field to enter the amount of the cost (excluding taxes, unless you are entering   a 
tax-included cost).

Billing Type, Billing Rate, and A/R Item Number (job-related only)                                     

For additional costs on job-related credit and debit notes, the program provides the Billing 
Type, Billing Rate, and AR Item Number that was used for the invoice or return.

The invoice or return must be job-related for these fields to appear.

A/R     Item Number

This field displays the A/R item number associated with the project resource     used for the contract in 
Project and Job Costing. You can select a different     A/R item number only for time and material 
projects, as follows:

 l On a standard project,        this field displays the A/R item number and unit of measure specified        
for the project resource category as the default. You can accept the item       number or select 
another valid A/R item number.

 l On a basic project, this field        displays the A/R item number and unit of measure specified for 
the project        category. You can accept the item number or select another valid A/R item       
number.

 l If you change the A/R        item number, the item number must be a valid item number in 
Accounts Receivable,        and the unit of measure must be a valid unit of measure both for the 
new       item number and the vendor’s currency.

Cost plus and fixed price projects do not use an A/R item number. 

Billing Currency

This field appears only in multicurrency systems for time and materials projects and for fixed price 
projects using billings and costs or accrual-basis accounting methods.

The billing currency is the customer's currency specified on the contract, and you cannot change it.

Billing currency is blank for Fixed Price projects using completed project or project percentage 
complete methods, and for Cost Plus projects.
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Note: Billing currency is not displayed for basic or standard internal Time and Materials projects, 
or for single-currency Fixed Price projects that use billings and costs or accrual-basis accounting 
methods.

Billing Rate

This field displays the billing rate for the specified resource (for standard projects) or category (for 
basic projects).

You can edit the billing rate if the billing type is Billable. The field displays 0.000000 if the billing type 
is Non-Billable or No Charge.

Note: 
 l You can specify the billing rate for Time and Materials projects and for Fixed Price projects 

that use Billings and Costs or Accrual-Basis accounting methods.

 l Billing rate is disabled and set to 0.000000 on a basic or standard internal contract for 
Time and Materials projects or for Fixed Price projects using Billings and Costs or Accrual-
Basis accounting methods.

 l The billing rate cannot be negative.

 l If a job-related additional cost is prorated by cost, quantity, or weight, the specified billing 
rate in functional currency will be prorated to the item details for projects that are Time and 
Materials or Fixed Price with an accounting method of Billings and Costs or Accrual-Basis.

The billing rate is not prorated to item details for Cost Plus or Fixed Price projects with completed 
project or project percentage complete accounting methods. Instead, it is converted to the contract 
customer’s currency when it is prorated to the item details during day end processing (using the 
current exchange rate).

The prorated billing rate for each detail is not displayed (and, therefore, you cannot change it).

Note: This field is disabled if you are prorating manually.

Billing     Type

This field appears in the detail-entry section only for job-related     purchase orders.

The billing type indicates to Project and Job Costing whether to bill      the cost to the customer. You 
can change this field only for a time and     materials project, as follows:
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On a basic project:

For a billable project,        the category billing type determines whether you can change the billing       type 
for the detail. If the specified category is:

 l Billable, the default       billing type for the detail is billable, but you can change it.

If the detail is billable you can specify a billing     rate for the detail.

If you change the billing type for the detail to no      charge or non-billable, the program sets the billing 
rate to zero and     you cannot change it.

 l No charge or non-billable,        the program sets the same billing type for the detail, and cannot 
change        it. You cannot specify a billing rate for the detail, which the program       sets as zero.

If the project is no charge        or non-billable, the detail uses the same billing type as the project,       the 
billing rate is set to zero, and you cannot change them.

On a standard project:

If the project is billable,        the resource billing type determines whether you can change billing type       for 
the detail.  If the specified resource is:

 l Billable, the program        displays Billable as default billing type, but you can change it for the        
detail. If the detail is billable, you can specify a billing rate for       the detail.

If you change the billing type for the detail to no      charge or non-billable, the program sets the billing 
rate to zero, and     you cannot change it.

 l No charge or non-billable,        the program sets same billing type for the detail, and you cannot 
change        it. You cannot specify a billing rate for the detail, which the program       sets as zero.

If the project is no charge        or non-billable, the detail uses the same billing type as the project,        and 
you cannot change it. The program also sets the billing rate to zero,       and you cannot change it.

For fixed price and cost plus projects,      the Billing Type field is blank. A billing type is not required for 
these     types of projects.

Unit     of Measure

This field appears for Time and Materials projects if you selected the     Job Related option for this 
transaction.

You must enter a unit of measure that is valid for the item number/resource     that you specified and 
for the contract customer's currency.
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Note: For internal time and materials projects (basic or standard     contracts) the A/R item unit of 
measure will be disabled or blank.

Calculate Labor 

Select the Calculate Labor field if you want Project and Job Costing   to calculate labor amounts for 
this cost and pass the amount back to Purchase   Orders. (Purchase Orders creates the G/L entries 
for the additional costs.)

Do not select this option for an additional cost for which you don't   want to calculate labor.

The program also lets you specify whether overhead or labor is calculated   if you expense the 
additional cost. 

Calculate Overhead              

Select the Calculate Overhead field if you want Project and Job Costing   to calculate overhead 
amounts for this cost and pass the amount back to   Purchase Orders. (Purchase Orders creates the 
G/L entries for the additional   costs.)

Overhead is usually calculated on the discounted extended amount.

For example, you would not select this option if an invoice or debit note had additional   shipping 
costs for which you didn't want to calculate overhead or labor.

The program also lets you specify whether overhead or labor is calculated   if you expense the 
additional cost. 

Comments

If desired, enter a comment for the detail, using up to 250 characters.

Lines automatically wrap, but if you want to start a new line before   a line wraps, press the Ctrl and 
Enter keys together. 

To open the screen, click the Zoom  button beside the field, or, with the insertion   point in the 

field, press the Shift and F9 keys at the same time.

Contract, Project, Category and Resource (job-related only)                                     

If the return or invoice was job-related, the program will provide the job to which each cost was 
assigned. If you use different terms than “Contract,” “Project,” and “Category” in Project and 
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Job Costing, the program displays   them instead.

For job-related transactions, you can also specify the Billing Type, Billing Rate, AR Item 
Number, and AR Item UOM for the customer invoice near the end of the detail line.

Note: 
 l You specify this information   only if you are not prorating the cost to individual detail 

lines (No Proration). The fields are disabled if you are prorating by cost, quantity or 
weight, or prorating manually (where you allocate costs to the individual lines on the 
Distribute Additional Costs screen).

 l You enter/select the resource   using the Item Number field.

 l You cannot change these fields once you have added the detail line.

 l These fields appear only for job-related credit or debit notes.

Category

Select or enter a category that is assigned to the project in Project   and Job Costing.

Contract

Specify a contract number for each detail. You can enter or   select only contracts that are open or 
on hold. (You cannot process transactions   to a contract that is on hold, if it has never been 
opened.)

Cost   Class

The program displays the cost class for the category used in each detail.   You cannot change this 
field.

Item   Number (Resource)

Use the Item Number field to identify the resource for this detail.

You must specify a resource that is assigned to the project and category in   Project and Job Costing. 
You can specify an inventory item number, or the code for another type of resource (such as an 
equipment code, subcontractor code, or employee number). 

Note: You cannot leave this field blank.
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Project

You can only enter or select projects that are:

 l Assigned to the contract   that you selected.

 l Open or on hold. (If   a project that is on hold has never been opened, you cannot select it.)

 l Not closed to costs.

Distribute Proration 

If you selected manual proration, click this column heading to open the "P/O Distribute Proration 
Screen" (page 511). You must calculate all the costs and associated allocated taxes to prorate   
manually for each detail, then enter the amounts with the details.

Expense Account

Type the account number, or select the account number from the Finder.

Line Number

To add a new detail, skip the Line Number field. If an existing detail is displayed, click the New 
button beside the field.

To select an existing line to edit or delete, highlight the line (or type its line number in the zoomed 
screen).

Note that you can edit additional cost details only until you post the credit note or debit note.

Net of Tax              

This field displays the net amount of the additional cost you entered   for the detail (excluding 
allocated taxes that are not included in the   amount of the cost).

Proration (method)

Select No Proration. You cannot prorate new additional cost details on credit notes or debit notes, 
you can only expense them to a general ledger account.

Receipt Number  

The receipt number on which the original invoice or return was based   appears in this field.
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Reference

Enter optional reference information for the detail.

Reproration Method (for returning)

You can select only Expense for the reproration method. You cannot reprorate   additional costs 
from credit notes or debit notes to item details.

Return Expense Account

Type the number of the general ledger account to which you will post   the cost, or select the account 
number   from the Finder.

Tax Included 

The program displays the total amount of taxes that were included in   the cost amount of the 
additional cost detail.

To edit tax settings, press F9 to display the zoomed cost entry screen.

You can also edit total tax amounts on the Taxes tab.

Allocated Tax                                       

This field displays the amount of allocated tax for the detail. (Allocated   taxes are included in the cost 
of the detail. Recoverable and expensed   taxes are not included in detail costs.) 

Distribute   Proration (if prorating additional costs manually)

Item Number  

The program displays all of the items on the purchase order so you can   easily distribute the 
additional cost in the amount fields.

If this is a job-related Invoice, the Item Number may be a resource.

Item Description                           

The program displays the item description from Inventory Control or the description you entered for 
the detail on the purchase order.
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Amount (manually prorated) (if not job-related)                                     

Enter the amount of the additional cost that is being allocated to this line item. The amounts on all 
lines must add up to the total amount of   the additional cost.

Distribute   Cost (if distributing costs among several   receipts)

Amount                           (additional cost detail total)                                     

This field displays the amount entered for the additional cost detail at the top of the Cost   Allocation 
screen.

Amount                           (prorated for each receipt)                                     

This field displays the amount of the additional cost allocated to   each receipt when you click 
Reallocate.

To allocate the additional cost manually, you can enter amounts beside each receipt number. The 
sum of all the amounts you allocate   to receipts must equal the total amount for the additional cost 
detail.

Billing Rate                           (cost allocation screen)                                     

If the receipt was job-related, Purchase Orders displays a billing rate for the cost that you are 
allocating (along with the amount being allocated).

Note: The   Billing Rate is also allocated with the additional costs to more than one receipt.

If you are prorating the cost manually to other receipts, you can enter a different billing rate with 
each distribution.

Proration Method                           (display only for existing costs)                                     

You cannot change the proration method for an existing cost.

If you are adding a new additional cost, you can select Prorate By Quantity, Prorate By Cost, or 
Prorate By Weight. 

Note: You cannot manually prorate an additional cost on an invoice or debit note.

If the invoice, credit note, or debit note is job-related:
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 l You can also adjust the retainage amounts and period if retainage applies to the document.

 l You can adjust the billing rate and currency if prorating by cost, quantity or weight.

 l You can specify a single contract, project and category, or use the Distribute Proration button 
to distribute costs to more than one contract, project, and/or category (if applicable) if you are 
prorating manually.

Receipt Number                           

The program displays the receipt numbers used in this invoice, credit note, or debit note. You 
cannot change the receipt numbers.

Retainage Percentage, Amount, and Period

If the receipts were job-related and the credit note or debit note uses the retainage option, the   
program displays additional retainage fields for each receipt to which   you can allocate additional 
costs.

The default retainage percentage and retention period that appears in   these fields depends on how 
you are prorating the costs.

 l If prorating by cost,   quantity, or prorating manually, the settings come from the vendor 
record.

 l If you are not prorating,   the retainage settings are based on the Default Retainage From 
option   for the contract in Project and Job Costing.

Use the Distribute Cost button to allocate a new additional cost to multiple receipts.

Select the additional cost detail on the Additional   Costs tab, then click the Distribute Cost 
button to open the Allocate Cost screen.

Purchase Orders automatically allocates the additional   cost amount according to the proration 
method you selected on the Additional Costs tab. However, you can enter different amounts 
for each receipt manually.

Credit/Debit  tab

The name of this tab is Credit Note or Debit Note, depending on the document        type you selected. It 
provides separate sections, where you can enter or view document information, as follows:
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Bill-To Location

If you use Inventory Control, select an Inventory Control location code   to which the credit note or 
debit note should be sent. (Normally, this is the same location to which the matching invoice or 
return was sent.)

You can also use the Zoom button to open a separate screen where you can edit the address for the 
code you select, or you can omit the code and   type in a billing address, or not specify a bill-to 
location at all.

Credit Note/Debit Note Date

Type the date you want to use as the credit note or debit note date.   The program displays the sign-
on date you entered to start Sage 300.

If you want to use a different date for   the G/L transactions when they are posted in the General 
Ledger, you can change the posting date. (The   posting date determines the fiscal year and period 
displayed beside the   Posting Date field.)

Credit Note Total

Enter the total credit note amount, including taxes and additional costs.   This amount must equal the 
total of all details and taxes you enter for   the credit note before you can post it.

Debit Note Total

Enter the total debit note amount, including taxes and additional costs.   This amount must equal the 
total of all details and taxes you enter for   the debit note before you can post it.

Description

Type an optional description for the credit note or debit note.

The description, if any, entered on the receipt is displayed, but you   can change it.

Document Type

Select Debit Note or Credit Note from the list, if the correct choice is not already displayed.

From Document

If you are entering a credit note, select the type of document that you are crediting (either Invoice or 
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Return).   

You can enter debit notes only for invoices.

If you are crediting or debiting an invoice or return   that does not exist in Purchase Orders, leave the 
field blank.

Invoice Date(display only)

After you select the invoice number for the credit note or debit note,   the invoice date is displayed for 
your information.

Invoice Number

Type the number of the invoice you are crediting or debiting, or select   it from the Finder.

You can also enter an invoice number that does not exist in the Purchase   Orders system. (For 
example, it may have been cleared.)

Job Related(selected on original document)                             

If the return or invoice was job-related, the Job Related option is selected for the credit/debit note, 
and you cannot change this selection.

The program supplies the contract, project, category, cost class and resource for each detail   — as 
will the customer billing type, billing rate, and A/R item used for   billing.

If you use different terms than “Contract,” “Project,” and “Category”   in Project and Job Costing, the 
program displays them instead.

On Hold

Select On Hold to prevent a debit note from being paid in   the Accounts Payable program. If you 
want to pay this amount, you can edit the document in Accounts Payable, clearing this option before 
posting   the document.

When you post the invoice batch in Accounts Payable, A/P does not apply any matching 
prepayments if the credit note or debit note has On Hold status. In addition, you cannot post credit 
notes or debit notes if either the credit (or debit) note or the specified Apply-To document is on hold.

You cannot apply a payment to a document that is on hold when using the Create Payment Batch 
screen. You must first remove the On Hold status using the Control Payments screen. However, you 
can apply the document manually in Payment Entry, without removing the hold, if necessary.
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PO Number

Optionally, type the purchase order number in this field. You can type a number that   does not exist 
in Purchase Orders.

Posting Date

Enter the posting date for the transaction.

The posting date is different from the document   date. The posting date is the date for transactions 
being posted to the General   Ledger, so it also determines the contents of the Fiscal Year and Period   
fields.

If you have a multicurrency system, currency revaluation uses posting   dates to select open 
documents for revaluation purposes, and thus, revaluation   adjustments are posted to General 
Ledger in the correct fiscal year and   period.

Depending on your settings in the P/O Options screen, Purchase Orders   automatically displays the 
session date or the document date by default   in this field.

You can change the posting date, but you cannot separately change   the fiscal year and period.

Note: If you consolidate G/L transactions, the posting date for consolidated entries is the last date 
of the fiscal period.

Reference

Type an optional reference for the credit note or debit note.

The reference, if any, from a return or invoice is displayed, but you   can change it.

Remit-To Location

If you have defined remit-to addresses for the vendor, either type the   code for the address to use or 
select it from the Finder. To check that   you have selected the correct address to which to send 
payments for the   vendor, choose the Zoom button or press F9 in the field.

If a primary remit-to address is assigned for the vendor in Accounts   Payable, the code for the 
address appears automatically, but you can change   it.

Retainage Percentage and Period(selected on original document)                             

If the invoice or return used retainage accounting, the program   displays additional percentage and 
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period retainage fields for each detail   line.

The program also displays the Retainage tab, where you specify the   exchange rate to use for the 
multicurrency retainage on   credit/debit notes.

If you clear the Retainage check box, the percentage and period retainage   fields disappear from the 
item detail section, and the Retainage   tab also disappears.

You can select the retainage option for job-related transactions even   if retainage was not used on 
the original transaction.

Note: Retainage accounting applies only to job-related transactions,   and is available only if 
Accounts   Payable uses retainage accounting.

Return Date (display only)                             

After you select the return number for the return, the return date is   displayed for your information.

Return Number

Type the number of the return you are crediting, or select it from the   Finder. (The return must exist 
in Purchase Orders.)

Vendor Account Set

The account set from the vendor record appears in this field as the   default. It specifies the general 
ledger payables   control, purchase discounts, prepayment, and retainage accounts to which   the 
transaction will be distributed.

You can change the account set for a particular purchase order, receipt,   return, invoice, credit note, 
or debit note. If you use   multicurrency accounting, however, the new account set must use the same   
currency as the vendor's account set.

Note: If you change the account set on a receipt, make sure that you use the   same account set 
for returns, invoices, and credit or debit notes.

Year and Period(display only)

This is the fiscal year and period to which the credit/debit note transactions   will be posted in the 
general ledger. You can change the fiscal period by changing the Posting Date.
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You can enter a different Credit or Debit Note Date, and you can enter   a different Posting Date for 
the document.

(Remember that you cannot post transactions to closed fiscal periods.)

1099/CPRS Code and Amount

If the vendor is subject to 1099 reporting, type the 1099 code and amount.   (These fields appear only 
if the Subject To 1099 Reporting option is selected for the vendor in Accounts Payable.)

Credit/Debit Details table

This details table appears on the Credit/Debit tab.

Allocated Tax              

This field displays the total tax amount that was allocated to the selected detail   line for each tax 
authority.

Billing Type, Billing Rate, and A/R Item Number (job-related only)                                     

For job-related credit and debit notes, the program provides the Billing   Type, Billing Rate, and 
AR Item Number that was used for the invoice or   return.

The invoice or return must be job-related for these fields to appear.

A/R     Item Number

This field displays the A/R item number associated with the project resource     used for the contract in 
Project and Job Costing. You can select a different     A/R item number only for time and material 
projects, as follows:

 l On a standard project,        this field displays the A/R item number and unit of measure specified        
for the project resource category as the default. You can accept the item       number or select 
another valid A/R item number.

 l On a basic project, this field        displays the A/R item number and unit of measure specified for 
the project        category. You can accept the item number or select another valid A/R item       
number.

416Sage 300 2021 Purchase Orders User's Guide



 l If you change the A/R        item number, the item number must be a valid item number in 
Accounts Receivable,        and the unit of measure must be a valid unit of measure both for the 
new       item number and the vendor’s currency.

Cost plus and fixed price projects do not use an A/R item number. 

Billing Currency

This field appears only in multicurrency systems for time and materials projects and for fixed price 
projects using billings and costs or accrual-basis accounting methods.

The billing currency is the customer's currency specified on the contract, and you cannot change it.

Billing currency is blank for Fixed Price projects using completed project or project percentage 
complete methods, and for Cost Plus projects.

Note: Billing currency is not displayed for basic or standard internal Time and Materials projects, 
or for single-currency Fixed Price projects that use billings and costs or accrual-basis accounting 
methods.

Billing Rate

This field displays the billing rate for the specified resource (for standard projects) or category (for 
basic projects).

You can edit the billing rate if the billing type is Billable. The field displays 0.000000 if the billing type 
is Non-Billable or No Charge.

If you are referencing an existing document, the program displays the original billing rate.

For new detail lines, a default billing rate appears, as follows:

 l For standard projects:     

 l For a category cost class of Subcontractor, Overhead, Miscellaneous Equipment, or 
Material, the default billing rate comes from the category resource.

 l For a category cost class of Labor, the default billing rate is based on the Default 
Billing Rate From option for the employee resource category.

 l For basic projects:     

 l For a category cost class of Subcontractor, Overhead, Miscellaneous Equipment, or 
Material, the default billing rate comes from the category.

 l For a category cost class of Labor, the default billing rate is based on the Default 
Billing Rate From option for the labor category.
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The Billing Rate option does not apply to internal contracts.

Note: 
 l You can specify the billing rate for Time and Materials projects and for Fixed Price projects 

that use Billings and Costs or Accrual-Basis accounting methods.

 l Billing rate is disabled and set to 0.000000 on a basic or standard internal contract for 
Time and Materials projects or for Fixed Price projects using Billings and Costs or Accrual-
Basis accounting methods.

 l The billing rate cannot be negative.

Billing     Type

This field appears in the detail-entry section only for job-related     purchase orders.

The billing type indicates to Project and Job Costing whether to bill      the cost to the customer. You 
can change this field only for a time and     materials project, as follows:

On a basic project:

For a billable project,        the category billing type determines whether you can change the billing       type 
for the detail. If the specified category is:

 l Billable, the default       billing type for the detail is billable, but you can change it.

If the detail is billable you can specify a billing     rate for the detail.

If you change the billing type for the detail to no      charge or non-billable, the program sets the billing 
rate to zero and     you cannot change it.

 l No charge or non-billable,        the program sets the same billing type for the detail, and cannot 
change        it. You cannot specify a billing rate for the detail, which the program       sets as zero.

If the project is no charge        or non-billable, the detail uses the same billing type as the project,       the 
billing rate is set to zero, and you cannot change them.

On a standard project:

If the project is billable,        the resource billing type determines whether you can change billing type       for 
the detail.  If the specified resource is:

 l Billable, the program        displays Billable as default billing type, but you can change it for the        
detail. If the detail is billable, you can specify a billing rate for       the detail.
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If you change the billing type for the detail to no      charge or non-billable, the program sets the billing 
rate to zero, and     you cannot change it.

 l No charge or non-billable,        the program sets same billing type for the detail, and you cannot 
change        it. You cannot specify a billing rate for the detail, which the program       sets as zero.

If the project is no charge        or non-billable, the detail uses the same billing type as the project,        and 
you cannot change it. The program also sets the billing rate to zero,       and you cannot change it.

For fixed price and cost plus projects,      the Billing Type field is blank. A billing type is not required for 
these     types of projects.

Unit     of Measure

This field appears for Time and Materials projects if you selected the     Job Related option for this 
transaction.

You must enter a unit of measure that is valid for the item number/resource     that you specified and 
for the contract customer's currency.

Note: For internal time and materials projects (basic or standard     contracts) the A/R item unit of 
measure will be disabled or blank.

Comments

To enter comments for a selected detail line, click the Zoom  button for the field, type the 

remarks, then click Close. (Press the Shift and F9 keys to open or close the screen using your 
keyboard.)

The program displays any comments you entered for the detail line on an invoice or return you are 
crediting or debiting, but you can change   or delete them.

Contract, Project, Category and Resource (job-related only)                                     

If the return or invoice was job-related, the program will provide the job to which each detail 
was assigned. If you use different terms than   “Contract,” “Project,” and “Category” in Project 
and Job Costing, the program displays them instead. (The "resource" appears in the Item 
Number column.)

Purchase Orders updates the actual quantities and costs for jobs with the amounts on credit or 
debit notes. For example, costs are affected   by credit and debit notes, and quantities are 
affected by credit note returns. (Quantities are not affected by credit notes that reference 
invoices or debit notes.)
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For job-related credit notes and debit notes:

 l The Job-Related check box   will be automatically selected if the invoice or return was 
job-related.   You cannot change it.

 l You enter/select the resource   using the Item Number field.

 l You must select the Job-Related   check box if the reference document no longer exists 
in PO.

Category

Select or enter a category that is assigned to the project in Project   and Job Costing.

Specify a contract number for each detail. You can enter or   select only contracts that are open or on 
hold. (You cannot process transactions   to a contract that is on hold, if it has never been opened.)

Cost   Class

The program displays the cost class for the category used in each detail.   You cannot change this 
field.

Item   Number (Resource)

Use the Item Number field to specify the resource for this detail. 

You must specify a resource that you have assigned to the project in   Project and Job Costing (such 
as an equipment code or a subcontractor   code). You cannot leave this field blank.

Project

You can only enter or select projects that are:

 l Assigned to the contract   that you selected.

 l Open or on hold. (If   a project that is on hold has never been opened, you cannot select it.)

 l Not closed to costs.

Expense Account

You specify a general ledger expense account for non-inventory item   details. You can select 
general ledger   account numbers using the Finder.

If you are working with an existing invoice or return, the program   displays the number entered with 
the detail on the invoice or return,   but you can change the number. 
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Extended Cost 

Type the extended cost for the number of units of the item that you are crediting or debiting.

If you change the extended cost, the program automatically recalculates the unit cost.

Extended Weight

Type the extended weight for the number of units of the item for which you that you are crediting or 
debiting.

If you change the extended weight, the program automatically recalculates   the unit weight.

The total weight for all items on the document is displayed in the Totals   tab.

Item Description 

The program displays the item description from the P/O Vendor Contract Costs record (if one 
exists) or from the Inventory Control or Purchase Orders item record, but you can change it.

If you entered a non-inventory item number, you can type a description for it.

Item Number 

If you are entering a credit note or debit note to an existing invoice or return, the program displays 
the item number, and you cannot change it.

If you are entering a transaction without an invoice or return number, type the item number to use or 
select it from the Finder. If you use the   Allow Non-inventory Item Number option, you can also type 
an item number that is not defined in your Inventory Control system.

Line Number

To select an existing line to edit, select the line on the Credit/Debit tab, or type its line number on the 
Detail Items/Taxes screen. You cannot edit details of posted credit notes or debit notes.

To add a new line to a credit note or debit note you are entering without an invoice or return number 
when another detail is displayed in the Detail   Items/Taxes screen, click the New icon beside the 
field.

Location

If you are entering a credit note or debit note without an invoice or return and if you use Inventory 
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Control, type the location code or select it from the Finder.

If you are entering a credit note or debit note to an existing invoice or return number, the program 
displays the location code entered for the   detail on the invoice or return. You cannot change it.

Manufacturer's Item Number  (detail grid)                                     

If you entered a manufacturer's item number in the Item Number field   on the return, credit note, or 
debit note, the program also displays the   manufacturer's item number in the manufacturer's item 
number column.

Manufacturer's item numbers are alternative item numbers—such as bar codes or shortcut codes—
that identify your inventory items. You set up manufacturer's item numbers   in the Inventory Control 
system.

You can enter manufacturer's item numbers wherever you enter item numbers in the Purchase 
Orders program.

Net Of Tax             

This field displays the extended item cost, minus any applicable tax   amount. You cannot edit the 
amount.

Non-Stock Clearing Account

Use the Non-Stock Clearing Account field to change the non-stock clearing account associated 
with this item's account set.

If the item used in the detail is a non-stock item, the non-stock clearing   account associated with the 
item's account set appears.

If you are returning a non-stock item, the non-stock clearing account   associated with the item's 
account set appears. You can specify a different   account, if necessary.

Optional Fields 

Optional fields are fields that have been added by your company to the   transaction entry screens 
and detail lines in Purchase Orders transactions. 

Note: You must have Transaction Analysis and Optional Field Creator   to add and use optional 
fields.
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If the Optional Fields column appears, you can click the column heading   to display the optional 
fields that have been assigned to credit/debit note details, and   edit their contents. 

Optional field information on detail lines is inherited from   any matching optional fields in the invoice 
or return you are debiting or crediting.

If the optional fields   were not on the invoice or return: 

 l For non-job related invoices,   default optional field information comes from item records or, if 
the   fields do not match, from the default value in the P/O Optional Fields   screen.

 l For job-related invoices,   the default optional field information depends on the contract style 
and project type.   

If you use the same optional fields for categories   or resources in Project and Job Costing, 
default optional field information   will be inherited from the category for basic projects, or from 
the resource   with standard projects.

For more information, see "About Optional Fields" (page 51).

Order Number

Type the number of a sales order to which the detail applies. If you   use Sage 300 Order Entry with 
Purchase Orders, you can also select   an Order Entry order number from the Finder.

You can change or erase an order number that is displayed with a detail   you added on the invoice 
or return.

Quantity

Type the number of units of the item for which you are being credited or debited.

Leave this field showing zero for displayed details (from an invoice or return) that are not included 
on the debit note or credit note. You can also delete displayed details if you are working with an 
invoice.

If working with serialized or lotted items, a screen appears after you specify a quantity and press 
Tab or Enter, prompting you to assign serial   and/or lot numbers for the item.

Receipt Number(display only)                                     

The receipt number on which the original invoice or return was based   appears in this field.
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Retainage %, Retainage Amount, and Retention Period

If the invoice or return used retainage accounting, the program will   display additional percentage 
and period retainage fields for each detail   line.

The program will also display the Retainage tab to let you specify the   exchange rate that you want 
to use for the multicurrency retainage on   credit/debit notes.

If you clear the Retainage check box, the percentage and period retainage   fields disappear from 
the item detail section, and the Retainage   tab also disappears.

Note: Retainage accounting applies only to job-related transactions,   and is available only if you 
selected retainage accounting in the Accounts   Payable program.

Default Retainage Percentage and Period

The default retainage percentage and retention period that appears in   these fields are based on the 
Default Retainage From option for the contract   in Project and Job Costing.

Tax Included                                     

In the Detail table, this field displays the amount of tax that is included in the extended   item cost 
(when the cost includes tax).

On the zoomed Detail Items/taxes screen, this field displays Yes or No to indicate whether tax 
amounts are included in the item   cost for each tax authority. The default choice for this option is 
provided from the vendor record   in Accounts Payable or from the vendor contract cost. 

Note: You can select Yes only if the tax authority is set up in   Tax Services to allow tax-included 
costing.

You can also edit total tax amounts on the Taxes tab.

Unit Cost

The program uses the unit cost to calculate the extended cost. 

When adding new detail lines, you can edit the displayed cost for the   item, or enter a cost for a non-
inventory item number. If you   change the unit cost, the program recalculates the extended cost.

If you are referencing an existing document, the program displays the   cost previously specified for 
the item and unit of measure.
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Note: In multicurrency ledgers, the cost is expressed in the vendor's currency.

If you are entering a credit note or debit note to an existing invoice   or return, you can change the 
cost if you have authorization to do so.   Make sure that the cost you enter is the correct item cost for 
the unit   of measure.

Click the Finder  to display any vendor contract costs, regular   vendor costs, and other costs 

maintained in Inventory Control.

If you are adding new detail lines, the program   assigns costs as follows:

 l If you have set up vendor   contract costs, the program displays the contract   cost for the item 
and unit of measure.

 l If P/O does not find a   valid contract cost, it uses the inventory cost specified in the P/O 
Options   screen.

On job-related documents, the default unit cost is determined as follows:

 l If   the project is a standard project:

 l For a category cost   class of Subcontractor, Overhead, or Miscellaneous Equipment, 
the unit   cost is defaulted from the category resource.

 l For a category cost   class of Labor, the default unit cost is based on the Default Unit 
Cost   From option for the employee resource category.

 l For a category cost   class of Material (if you are using Inventory Control), the default 
unit   cost is based on Purchase Orders' default item cost (set in P/O Options).

 l For a category cost   of Material (if you are not using Inventory Control), the unit cost is   
based on Purchase Orders vendor costs.

 l If   the project is a basic project:

 l For a category cost   class of Subcontractor, Overhead, or Miscellaneous Equipment, 
the unit   cost is defaulted from the category.

 l For a category cost   class of Labor, the default unit cost is based on the Default Unit 
Cost   From option for the labor category.

 l For a category cost   class of Material (if you are using Inventory Control), the default 
unit   cost is based on Purchase Orders' default item cost (set in P/O Options).

 l For a category cost   of Material (if you are not using Inventory Control), the unit cost is   
based on Purchase Orders vendor costs.
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Unit of Measure

If you are entering a credit note or debit note to an existing invoice   or return, the program displays 
the unit of measure entered for the detail   on the invoice or return. You cannot change it.

If you are entering new detail lines, the program displays the stocking   UOM by default, unless you 
have set up vendor contract costs using a different   UOM, but you can select another unit of 
measure from the Finder.

You must use one of the units of measure that is assigned to the item   in Inventory Control. If you are 
entering a detail for a non-inventory   item, type the unit of measure.

Unit Weight

Type the weight of a single unit of the item that you are crediting or debiting. The program displays 
the weight specified for the item on the invoice or return or in the item record (for new item details), 
but you can change it.

The program uses the unit weight to calculate the extended weight. If you change the unit weight, 
the extended weight is recalculated.

Weight is expressed in the unit selected for the Weight Unit Of Measure option on the I/C Options 
screen.

You can see the total weight for the credited or debited items by clicking the Totals tab.

Vendor Item Number

Type the code the vendor uses to identify the item or edit a displayed   code, if necessary.

If the vendor's item number is specified on the invoice or return for   which you are entering a credit 
note or debit note, the code appears in   this field. (You can enter vendors' item numbers when 
assigning vendor   types in Inventory Control item records.)

Optional   Fields tab

If optional fields are assigned to this screen, use the Optional Fields tab to enter optional field 
information that applies to the entire document.

Note: This tab appears only if you have Transaction Analysis and Optional Field Creator.

Optional fields and values appear automatically on this tab if you selected the Auto Insert 
option for those fields on the P/O Optional Fields setup screen.
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If you use identical optional fields for Purchase Orders and Accounts Payable transactions , 
optional field information from Purchase Orders transactions is sent to Accounts Payable.

Note: If an optional field is required but does not have a default value, you must specify a 
value for the field.

For more information, see "About Optional Fields" (page 51), "About Setting Up Optional 
Fields" (page 53), and "About Optional Fields in Transactions" (page 80).

Optional Field

Use the Optional Field Finder to select optional fields that are assigned (in the P/O Optional 
Fields setup screen) to this type of transaction.

When you select an optional field code, Purchase Orders displays its description in the next 
column.

Value Set

The Value Set column shows whether a blank optional field currently has a value. (By looking 
at the field, you cannot know otherwise whether the field has a blank default value or no value.)

The Value Set field changes from No to Yes if you make an entry in the Value field.

Value

Use the Value Finder to select a value created for the optional field in Common Services.

When you select a value code, Purchase Orders displays its description in the next column.

Rates tab 

The Rates tab appears only if you use multicurrency accounting and you are entering a document 
for a vendor that does not use your company’s functional currency. You use this tab to view and edit 
rate information for currency conversion.  

Currency                           (display only)                             

In multicurrency ledgers, the vendor's currency code and a description   of the currency appear on 
the Rates tab. All amounts you enter for the   credit note or debit note will be in the vendor's currency.
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The currency is assigned for the vendor in Accounts Payable and you   cannot change it in Purchase 
Orders.

Derive Rate

When Purchase Orders calculates the tax amount in a tax reporting currency,   the program uses the 
Tax Reporting Currency Exchange Rate that appears   (or that you enter) on the Rates tab.

However, if you have changed the tax reporting amount that appears on   the Taxes tab, you can 
click the Derive Rate button to see the actual   exchange rate between the tax amount and the tax 
reporting amount.

In other words, the Derive Rate button appears so you can derive the   exchange rate for the tax 
reporting currency, if you change the calculated   amount on the Taxes tab.

Exchange Rate

The program displays the exchange rate currently in effect for the specified   currency and the 
displayed rate type and rate date, but you can change the   rate.

You receive a warning if you change an exchange rate by an amount that exceeds   the Spread 
setting for the currency in Common Services' Currency Rates table.

The screen also displays the exchange rate entered on the invoice or return,   if you selected an 
invoice or return number for the credit note or debit   note.

Rate Date

Type or select the date to use to select the exchange rate for the document you are entering.

The program displays the rate date that is nearest the   document date you entered, but you can 
specify a different date for which   an exchange rate exists for the currency in   Common Services' 
Currency Rates table.

If you change the rate date, Purchase Orders checks the rate tables   for a date match, and updates 
the rate if necessary. 

The program also displays the rate date used with the invoice or return,   if you selected one for the 
transaction.

Rate Type

If the rate type you want to use is not displayed, type the code or choose it from the Finder.
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The program uses rate types when converting multicurrency amounts on the credit note or debit 
note to functional currency. Examples of rate   types might be "spot rate," "average rate," and 
"contract rate."

You define rate types using the Currency Rate Types screen in Common Services, and assign the 
default rate type for Purchase Orders on the Processing   tab of the P/O Options screen.

The screen also displays the rate type used with the invoice or return,   if you selected one for the 
transaction.

Retainage   tab

The Retainage tab lets you specify the exchange   rate that you want to use for multicurrency 
retainage credit and debit   notes. You can:       

 l Use the original document exchange rate

 l Use the current exchange rate

Note: This tab appears only retainage accounting was used on the original   return or invoice.

Taxes   tab

Retainage Tax Amount

This field appears on the Taxes tab for Receipt Entry, Invoice Entry,   Return Entry, and Credit/Debit 
Note Entry if retainage applies to the   document. 

It shows the amount of tax calculated for this authority for the retainage   portion of the document if 
you report tax for retainage amounts when you   create the retainage document (not when you 
create the original document).   

Retainage appears only on job-related documents if you select   the Retainage option on the first tab 
of the transaction entry screen.

Retainage tax amounts are computed using the retainage tax base and   the tax rate for each tax 
authority. 

Retainage Tax Base

The retainage tax base is the amount (before included taxes) used as   the base for calculating taxes 
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on the retained amount.

Essentially, the retainage tax base is the retainage portion of the   document (excluding tax) if you 
report tax for retainage amounts at the   time that you create the retainage document (not when you 
create the original   document). 

Retainage appears only on job-related documents if you select   the Retainage option on the first tab 
of the transaction entry screen.

Retainage tax amounts are computed using the retainage tax base and   the tax rate for each tax 
authority. 

Tax Authority and Description                             

These columns list the codes and corresponding descriptions for all the tax authorities in the tax 
group specified for the document. 

You enter tax information in the Tax Services module in Common   Services. 

Tax Amount

The program displays the total tax amount calculated for each authority   in the vendor's tax group. 
You can change this amount, if necessary.

To cancel all your changes   to tax amounts at the same time, choose the Calculate Taxes button.

Tax Base (display only)                             

The tax base shows, for the tax authority, the net cost of items before   tax is added. (This field is 
useful for items that have tax included in   their prices.)

Tax Group

To change the tax group, type the tax group that identifies the tax   authorities to which the vendor is 
subject, or select the group from the   Finder. You must use a tax group that is defined for your 
company in Common   Services.

You must enter a valid tax group for every credit note or debit note   vendor.

Tax Excluded                               

The program displays the total amount of tax that is not included in   item costs for the authority.
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Tax Included

The program displays the total amount of tax that is included in item costs for the authority.

You can include tax amounts in item costs only if permitted by the authority.

Tax Reporting Currency

Tax reporting fields appear on the Taxes tab only if the tax group's tax reporting currency is different 
from your functional currency and the vendor's   currency.

Along with the tax reporting currency, the program displays the amount of included   and excluded 
tax to be reported in that currency on tax tracking reports   for all the tax authorities listed on the 
document.

You set the tax reporting currency for tax groups in the Tax Services module   in Common Services.                    

Tax Reporting Total             

This field displays the sum of the tax reporting amounts for all tax authorities.   

It appears only if the tax reporting currency for the   tax group is different from your functional 
currency and the   vendor's currency. 

You set the tax reporting currency for tax groups in the Tax Services module   in Common Services.

Total Retainage Tax

This field appears on the Taxes tab for Receipt Entry, Invoice Entry,   Return Entry, and Credit/Debit 
Note Entry if retainage applies to the   document.

It shows the total amount of tax calculated for the retainage portion   of the document if you report tax 
for retainage amounts when you create   the retainage document (not when you create the original 
document). 

Retainage appears on job-related documents only  if you select   the Retainage option on the first tab 
of the transaction entry screen.

Retainage tax amounts are computed using the retainage tax base and   the tax rate for each tax 
authority. 

Total Tax

This field displays the total tax amount calculated for each authority   in the vendor's tax group. You 
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can change this amount, if necessary. 

To cancel all your changes   to tax amounts at the same time, click the Calculate Taxes button. 

Tax Class and Description

The program displays the tax classes and their corresponding descriptions   as assigned to the 
vendor's tax authorities. You can change each tax class   to another tax class that is permitted by the 
authority.

You can change a tax class description only in Tax Services.

Totals tab

Comment

Type an optional comment for the credit note or debit note, using up   to 250 characters. The 
program automatically wraps text as you reach the   end of a line. If you wish to insert your own line 
breaks, press the Ctrl   and Enter keys where you want a line break to occur.

Credit/Debit Note Detail Subtotal                                   

The program displays the total of all item detail costs, if any, entered   on the credit note or debit note, 
including tax-included amounts. This   subtotal does not include tax amounts that are not included in 
item costs   or the additional costs you added for the vendor.

Credit/Debit Note Total                                   

The program displays the total of all item and/or additional costs and   taxes for the credit note or 
debit note.

Estimated Tax

This is the tax amount that will be applied to the retainage invoice   (if the tax authority allows you to 
defer tax on retained amounts on an original receipt and invoice).

If you are applying all tax amounts to the original invoice, this amount   will be zero.

Retainage amounts are invoiced at a later time, in Accounts Payable.
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Included Tax                                   

This field displays the amount of tax that is included in the extended   item cost (when the cost 
includes tax).

Less Credit/Debit Note Discount

You can enter an optional discount percentage or discount amount   for the entire document, or enter 
discounts for individual detail lines.

If you enter a discount for the entire document, Purchase Orders   prorates the discount amount for 
the document details, overriding any discounts   you may have entered manually for the details.

Less Retainage and Net Credit/Debit Note Totals 

These fields appear if this credit or debit note is a job-related document   that includes retainage 
amounts.

The Net Total is the total after retainage is deducted.

Number of Costs                            

The program displays the number of additional cost detail lines you   entered for the document.

Check this number against source documents to make sure you entered   all the details you require.

Number of Lines                               

The program displays the number of item detail lines you entered for the   primary vendor on the 
document.

Check this number against source documents to make sure you entered   all the details you require.

Number of Lines 

The program displays the number of item detail lines you entered for   the document.

Check this number against source documents to make sure you entered   all the details you require.

Plus Additional Costs

The program displays the total amount of additional costs entered with   the credit note or debit note, 
excluding taxes (except taxes that are   included in the cost amounts).
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This figure appears on credit notes or debit notes that include both   item and additional cost details.

Plus Excluded Tax                              

This field displays the total excluded tax amount of all item and additional   cost details for the vendor. 
This amount does not include   taxes that are included in the cost amounts.

Total Weight                                          

The program displays the total weight of the credited or debited goods,   calculated from the weight 
and quantity entered for each item detail.

Use this amount to check shipping charges.

P/O Credit/Debit Note Entry Bill-To Location Information Screen

To Open this Screen

 1. Open Purchase Orders > P/O Transactions > Credit/Debit Note Entry.

 2. Click the Zoom  button beside the Bill-To Location field, or press       the F9 key in the field.

Overview   

Use the Bill-To Location screen to edit an existing bill-to location address or to type    a new billing 
address for the credit note or debit note.

Note: You do not have to enter a bill-to location code or address information.

Fields and Controls

Address

Use the Address field to type the address for the location, or edit the displayed information   if 
necessary.
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Bill-To Location 

If you use Inventory Control and you selected a bill-to location code,   the program displays the 
location code.

If you do not use Inventory Control, you can click the Zoom  button beside the field name.

Enter the bill-to location information by typing   in the screen that appears.

Contact

Enter the name of a contact person, department, or position.

Description

Use the Description field to type a description of the location, such as a company name, or edit   a 
displayed description if necessary. You do not have to include a description.

E-mail

Use the E-mail field to type the e-mail address for the location, or edit the displayed address   if 
necessary.

Fax Number

Use the Fax Number field to type the fax number for the location or edit a displayed number if 
necessary.

Phone Number

Use the Phone Number field to type the telephone number for the location or edit a displayed 
number   if necessary.

P/O Credit/Debit Note Entry Detail Items/Taxes Screen

To Open this Screen

 1. Open Purchase Orders > P/O Transactions > Credit/Debit Note Entry.
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 2. Enter header information for the debit note or credit note, including the vendor number and, if 
you are crediting or debiting an existing invoice or return, specify the document number.

 3. Select a detail line to credit or debit, and then press F9, or click the Item/Tax       button.

Related Tasks

 l "Entering a Credit or Debit Note for a Return or Invoice" (page 171)

 l "Entering or Editing Additional Costs on Credit and Debit Notes" (page 176)

 l "Entering a Return for a Cleared or Missing Invoice" (page 166)

 l "Entering or Editing Additional Costs on Credit and Debit Notes" (page 176)

 l "Prorating Additional Costs on Receipts" (page 141)

 l "Returning and Issuing Credit/Debit Notes for Lotted Items" (page 190)

 l "Returning and Issuing Credit/Debit Notes for Serialized Items   " (page 188)

Overview

The Detail Items/Taxes screen contains the same fields as the detail entry grid on the Credit/Debit 
tab, plus additional tax-related fields that you use to view or change tax information for a selected 
detail.

Rather than displaying fields for all the details in tabular format, this screen lets you see all the fields 
for a single detail on a separate screen.

Use this screen to:

 l View all the fields for a single credit note or debit note detail on a separate screen.

 l Enter or edit credit note or debit note details, including tax classes and tax-included options.

Fields and Controls

Buttons

Add

Use the Add button   to add a detail you entered in the Detail Items/Taxes   screen. 

Note: You cannot add details to an invoice or a return for an existing receipt.
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Calculate Taxes

Click Calc. Taxes to see tax amounts for   a detail before you post the document. 

Tax amounts   are not automatically calculated until you click Post,  or click the Taxes tab or the Totals 
tab.

If you edit tax amounts on the Taxes tab, then click the Calculate Taxes   button on any tab, the 
program replaces your changes with amounts recalculated using the tax tables   from Tax Services.

Close

Click the Close button to close the Detail Items/Taxes screen, and return   to the Credit/Debit tab. 
(You can also press the F9 key on your keyboard.)

Save

Use the Save button to save changes you made to a detail   in the Detail Items/Taxes form.

Allocated Tax              

This field displays the total tax amount that was allocated to the selected detail   line for each tax 
authority.

Comments

To view comments for a selected detail line, click the Zoom  button beside the Comments field. 

The program displays any comments entered for the detail line on the invoice or return you are 
crediting or debiting, but you can change   or delete them.

To enter comments for the selected detail, click the Detail Comments table, press the Insert key, and 
then type the comments on the new line.

Lines automatically wrap. If you want to start a new line before the line wraps, press Enter.

Tip: You can also press the Shift and F9 keys together to open or close the screen using your 
keyboard.

For more information, see "P/O Credit/Debit Note Entry Detail Comments Screen" (page 443).

Expense Account

You specify a general ledger expense account for non-inventory item   details. You can select general 
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ledger   account numbers using the Finder.

If you are working with an existing invoice or return, the program displays the account number 
entered with the detail on the invoice or return,   but you can change the number.

Extended Cost 

Type the extended cost for the number of units of the item that you are crediting or debiting.

If you change the extended cost, the program automatically recalculates the unit cost.

Extended Weight

Type the extended weight for the number of units of the item for which you that you are crediting or 
debiting.

If you change the extended weight, the program automatically recalculates   the unit weight.

The total weight for all items on the document is displayed in the Totals   tab.

Item Description 

The program displays the item description from the P/O Vendor Contract Costs record (if one exists) 
or from the Inventory Control or Purchase Orders item record, but you can change it.

If you entered a non-inventory item number, you can type a description for it.

Item Number 

If you are entering a credit note or debit note to an existing invoice or return, the program displays 
the item number, and you cannot change it.

If you are entering a transaction without an invoice or return number, type the item number to use or 
select it from the Finder. If you use the   Allow Non-inventory Item Number option, you can also type 
an item number   that is not defined in your Inventory Control system. 

Line Number

To select an existing line to edit, type its line number on the Detail Items/Taxes screen.

Note: You cannot edit details of posted credit notes or debit notes.
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You can add a new line to a credit note or debit note you are entering, providing you did not specify 
an invoice or return number on the Credit/Debit tab. Click the New icon beside the Line Number 
field.

Location

If you are entering a credit note or debit note without an invoice or return and if you use Inventory 
Control, type the location code or select it from the Finder.

If you are entering a credit note or debit note to an existing invoice or return number, the program 
displays the location code entered for the   detail on the invoice or return. You cannot change it.

Net Of Tax             

This field displays the extended item cost, minus any applicable tax   amount. You cannot edit the 
amount.

Optional Fields 

If optional fields have been defined in Purchase Orders for credit/debit note details, you can click the 

Zoom  button beside the Optional Fields field to display the optional fields assigned to a selected 

detail, and edit their contents.

For more information about using optional fields in transactions, see "About Optional Fields in 
Transactions" (page 80). 

Order Number

Type the number of a sales order to which the detail applies. If you use Sage 300 Order Entry with 
Purchase Orders, you can also select an Order Entry order number from the Finder.

You can change or erase an order number that is displayed with a detail you added on the invoice or 
return.

Quantity

Type the number of units of the item for which you are being credited or debited.

Leave this field showing zero for displayed details (from an invoice or return) that are not included on 
the debit note or credit note. You   can also delete displayed details if you are working with an invoice.
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If you are working with serialized or lotted items, a separate screen appears after you specify a 
quantity, and then press Tab or Enter, prompting you to assign serial and/or lot numbers for the 
item.

Unit Cost

The program uses the unit cost to calculate the extended cost. 

When adding new detail lines, you can edit the displayed cost for the   item, or enter a cost for a non-
inventory item number. If you   change the unit cost, the program recalculates the extended cost.

If you are referencing an existing document, the program displays the   cost previously specified for 
the item and unit of measure.

Note: In multicurrency ledgers, the cost is expressed in the vendor's currency.

If you are entering a credit note or debit note to an existing invoice   or return, you can change the 
cost if you have authorization to do so.   Make sure that the cost you enter is the correct item cost for 
the unit   of measure.

Click the Finder  to display any vendor contract costs, regular   vendor costs, and other costs 

maintained in Inventory Control.

If you are adding new detail lines, the program   assigns costs as follows:

 l If you have set up vendor   contract costs, the program displays the contract   cost for the item 
and unit of measure.

 l If P/O does not find a   valid contract cost, it uses the inventory cost specified in the P/O Options   
screen.

On job-related documents, the default unit cost is determined as follows:

 l If   the project is a standard project:

 l For a category cost   class of Subcontractor, Overhead, or Miscellaneous Equipment, 
the unit   cost is defaulted from the category resource.

 l For a category cost   class of Labor, the default unit cost is based on the Default Unit 
Cost   From option for the employee resource category.

 l For a category cost   class of Material (if you are using Inventory Control), the default 
unit   cost is based on Purchase Orders' default item cost (set in P/O Options).

 l For a category cost   of Material (if you are not using Inventory Control), the unit cost is   
based on Purchase Orders vendor costs.
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 l If   the project is a basic project:

 l For a category cost   class of Subcontractor, Overhead, or Miscellaneous Equipment, 
the unit   cost is defaulted from the category.

 l For a category cost   class of Labor, the default unit cost is based on the Default Unit 
Cost   From option for the labor category.

 l For a category cost   class of Material (if you are using Inventory Control), the default 
unit   cost is based on Purchase Orders' default item cost (set in P/O Options).

 l For a category cost   of Material (if you are not using Inventory Control), the unit cost is   
based on Purchase Orders vendor costs.

Unit of Measure

If you are entering a credit note or debit note to an existing invoice or return, the program displays 
the unit of measure entered for the detail on the invoice or return. You cannot change it.

If you are entering new detail lines, the program displays the stocking UOM by default, unless you 
have set up vendor contract costs using a different   UOM, but you can select another unit of measure 
from the Finder.

You must use one of the units of measure that is assigned to the item in Inventory Control. If you are 
entering a detail for a non-inventory item, type the unit of measure.

Unit Weight

Type the weight of a single unit of the item that you are crediting or debiting. The program displays 
the weight specified for the item on the invoice or return or in the item record (for new item details), 
but you can change it.

The program uses the unit weight to calculate the extended weight. If you change the unit weight, 
the extended weight is recalculated.

Weight is expressed in the unit selected for the Weight Unit Of Measure option in the I/C Options 
screen.

You can see the total weight for the credited or debited items by clicking the Totals tab.

Vendor Item Number

Type the code the vendor uses to identify the item or edit a displayed code, if necessary.
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If the vendor's item number is specified on the invoice or return for which you are entering a credit 
note or debit note, the code appears in   this field. (You can enter vendors' item numbers when 
assigning vendor types in Inventory Control item records.)

Tax table

Allocated Tax             

This column displays the tax amounts allocated to the selected detail   line for each tax authority.

Detail Tax Class and Description

These columns list the tax classes and corresponding descriptions that   are assigned to the tax 
authority. You can change the tax   class (to another tax class that is assigned to the authority), but 
not   the description.

To change the tax class description or make other changes to the information   for the specified tax 
group, use the Tax Services screens in Common Services. 

Expensed Tax

The program displays the amount of tax that is separately posted (expensed)   to a general ledger 
account, rather than allocated to details on the credit   note or debit note.

Recoverable Tax 

The program displays the amount of tax that can be recovered by your   company, such as, for 
example, recoverable Canadian Goods and Services   Tax (GST) amounts.

Tax Amount 

The program displays the amount of tax that is due for each authority.

For each authority, Purchase Orders calculates a tax amount if:

 l The vendor is subject to tax.

 l The transaction contains taxable items or taxable additional costs.

 l Tax rates are specified for the tax authorities and classes in Tax Services.

You cannot edit the tax amount for a detail except indirectly, by changing   the tax class or tax-
included option on the Detail Items/Taxes screen.
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To edit tax amounts for the invoice, make your changes on the Taxes   tab.

Tax Authority and Description                                              

These columns list the tax authorities and   that are assigned to the tax group you specified for the 
document.

Tax information is maintained in the Tax Services screens in Common   Services.

Tax Base 

This field shows, for the selected detail, the net cost   of items before tax is added for the tax 
authority. You cannot change   the amount that appears in this field.

This field is particularly useful for items that have tax included in   their prices.

Tax Included                                     

This field displays the amount of tax that is included in the extended   item cost (when the cost 
includes tax).

P/O Credit/Debit Note Entry Detail Comments Screen

To Open this Screen

 1. Open Purchase Orders > P/O Transactions >  Credit/Debit Note Entry.

 2. On the Credit/Debit tab, click the Comments/Instructionsfield for the detail line you need.

 3. Click the Zoom  button, or press the Shift and F9 keys to open the Detail     Comments 
screen.

Use this screen to enter comments for a selected detail line.

To enter or edit a comment:

 1. Type the comment, pressing Enter to start each new line.

 2. When finished, click Close to close the screen.
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To delete comments:

 1. Highlight the text to       delete, then press the Delete key. If a message appears      asking you to 
confirm the deletion, click Yes.

 2. When finished, click Close      to return to detail entry.

Tip: You can also delete comments by changing the entry in     theComments field to No on the 
Credit/Debit tab. If you use this method, your remarks are not deleted, but they     are not printed on 
the credit note or debit note. If you decide     to use the remarks later, change the Comment field to 
Yes. Your original remarks will reappear.     

P/O Credit/Debit Note Entry Detail Costs/Taxes Screen

To Open this Screen

 1. Open Purchase Orders > P/O Transactions > Credit/Debit Note Entry.

 2. Enter header information for the debit note or credit note, specifying the vendor number and 
the invoice or return for which you are creating the debit note or credit note. 

 3. On the Additional Costs tab, add or select a detail line, and then click the Cost/Taxbutton or 
press the F9 key.

Related Tasks

 l "    Adding or Editing Details Using the Detail Items Taxes Screen" (page 175)

 l "Entering or Editing Additional Costs on Credit and Debit Notes" (page 176)

 l "    Distributing Additional Costs to Multiple Receipts on a Debit Note" (page 178)

Overview   

The Detail Costs/Taxes screen displays all the fields for an additional cost, so that you do not have to 
use the scroll bar to see all the information for a single additional    cost detail.

Use this screen to:

 l Check tax information      and calculations for a selected additional cost.

 l Edit the tax class and      tax-included options for the tax authorities.

 l Enter a comment for an      additional cost.
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Fields and Controls

Additional Cost (code) and Description

Type the code for the additional cost you want to add, or select the   code from the Finder. If you are 
adding a cost for which no code is defined,   skip this field, and then type the name of the cost in the 
Description field   (the field beside the Additional Cost field in the Detail Items/Taxes   screen).

Note: You cannot change the additional cost code when editing a detail from an invoice or return.

You use the Additional Costs screen, in the P/O Setup folder, to add or edit additional cost codes in 
Purchase Orders.

Allocated Tax 

The program displays the amount of allocated tax for the detail. (Allocated   taxes are included in the 
cost of the detail. Recoverable and expensed   taxes are not included in detail costs.)

Amount

Type the amount of the cost (excluding taxes, unless you are entering   a tax-included cost).

Comment

If desired, enter a comment for the detail, using up to 250 characters.

Lines automatically wrap, but if you want to start a new line before a line wraps, press the Ctrl and 
Enter keys together. 

To open the screen, click the Zoom  button beside the field, or, with the insertion   point in the field, 

press the Shift and F9 keys at the same time.

Expense Account

Type the account number, or select the account number from the Finder.

Expensed Tax 

The program displays the amount of the tax that is separately posted   (expensed) to a general ledger 
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account, rather than allocated to details   on the invoice.

Item Number 

The program displays the item number entered for the selected detail   line.

Line Number

To add a new detail, skip the Line Number field. If an existing detail   is displayed, click the New  

button beside the field.

To select an existing line to edit or delete, highlight the line (or type its line number in the zoomed 
screen).

Note: You can edit additional cost details only until you post the   credit note or debit note.

Net of Tax 

The program displays the net amount of the additional cost you entered   for the detail (excluding 
allocated taxes that are not included in the   amount of the cost).

Optional Fields 

If optional fields have been defined in Purchase Orders for additional cost details in credit/debit 

notes, you can click the Zoom  button beside the Optional Fields field  to display the optional fields 

assigned to a selected detail, and   edit their contents.   

For more information about using optional fields in transactions, see "About Optional Fields in 
Transactions" (page 80). 

Proration 

Select No Proration. You cannot prorate new additional cost details   on credit notes or debit notes. 
You can only expense them to a general   ledger account.

Recoverable Tax 

The program displays the amount of the tax that can be recovered by   your company (for example, 
recoverable Canadian Goods and Services Tax   (GST) amounts).
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Reference

Type an optional reference for the detail.

Return Expense Account

Type the number of the general ledger account to which to post   the cost, or select the account 
number   from the Finder.

Return Proration

You can select only Expense for the reproration method. You cannot reprorate   additional costs from 
credit notes or debit notes to item details.

Tax Amount 

The program displays the amount of tax that is due to each tax authority.

Purchase Orders calculates a tax amount for each authority if:

 l The vendor is subject   to tax.

 l The additional cost is   taxable.

 l Tax rates are specified   for the tax authorities and classes in Tax Services.

Note: You cannot edit the tax amount for an additional cost detail (except indirectly, by changing   
the tax class or tax-included option). 

Tax Authority and Description 

These columns list the tax authorities and corresponding descriptions   that are assigned to the 
specified tax group.

Tax authorities and other tax information is maintained in the Tax Services screens in Common   
Services.

Tax Base 

The tax base shows, for each tax authority, the net cost of items before   tax is added. 

This field is useful for items that have tax included in   their prices.
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Tax Class and Description

These columns list the tax classes and corresponding descriptions that   are assigned to the tax 
authority. You can change the tax   class (to another tax class that is assigned to the authority), but 
not   the description.

Tip: To change the tax class description or make other changes to the information   for the 
specified tax group, use the Tax Services screens in Common Services.

Tax Included 

You can change this setting only if the tax authority allows tax to be included in prices.

P/O Credit/Debit Note Entry Cost Allocation Screen

To Open this Screen

 1. Open Purchase Orders > P/O Transactions > Credit/Debit Note Entry.

 2. Enter header information for the debit note, specifying the invoice number for which you are 
creating a debit note. 

 3. Click the Additional Costs tab.

 a. Select the additional cost you need to distribute to receipts.

 b. Click the Dist. Cost button to open the Cost Allocation screen.

Related Tasks

 l "    Distributing Additional Costs to Multiple Receipts on a Debit Note" (page 178)

Overview   

Use the Cost Allocation screen to distribute an additional cost to more than one receipt.

Note: This screen is available only if you are adjusting an existing additional cost from an invoice 
that is based on multiple receipts.

You cannot automatically prorate the costs to multiple receipts. Instead, you identify the amount to 
distribute to each receipt on the debit note.
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You can prorate and allocate the additional cost amount manually, or you can let Purchase Orders 
automatically allocate amounts to receipts according to the proration method identified on the 
Additional Costs tab.

Fields and Controls

Buttons

Clear

Use the Clear button to clear all amounts in the screem.

Dist. Cost

Use the Dist. Cost button      to open the Cost Allocation screen for an additional cost detail.

Redistribute

Use the Redist. button to have Purchase Orders automatically prorate   the additional cost amount 
for the purchase orders.

Amount (additional cost detail total)

The program displays   the amount you enter for the additional cost detail at the top of the Cost   
Allocation screen.

Amount (prorated for each receipt)

The program displays the amount of the additional cost allocated to   each receipt when you click the 
Redist. button.

Note: To allocate the additional cost manually, you can enter   amounts beside each receipt 
number. The sum of all the amounts you allocate   to receipts must equal the total amount for the 
additional cost.

Billing Rate

If the receipt was job-related, Purchase Orders displays a billing rate   for the cost that you are 
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allocating, along with the amount being allocated.

Note: The   billing rate is also used to allocate additional costs to more than   one purchase order.

If you are prorating the cost manually to other purchase orders, you can enter   a different billing rate 
with each distribution.

Proration Method (display only)

You cannot change the proration method for an existing additional cost. 

Receipt Number

The program displays the receipt numbers used in this invoice, credit   note, or debit note. You cannot 
change the receipt numbers.

Retainage Percentage, Amount, and Period

For job-related documents to which retainage applies, the   program displays additional retainage 
fields for each purchase order to which   you can allocate additional costs.

The default retainage percentage and retention period that appears in   these fields depends on how 
you are prorating the costs.

 l If prorating by cost,   quantity, or prorating manually, the settings come from the vendor record.

 l If you are not prorating,   the retainage settings are based on the Default Retainage From 
option   for the contract in Project and Job Costing.
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P/O Invoice Entry Screen

To Open this Screen

Open Purchase Orders > P/O Transactions > Invoice Entry.

Secondary Screens

 l "P/O Additional Costs Detail Costs/Taxes Screen" (page 503)

 l "P/O Bill-To Location Screen" (page 491)

 l "P/O Detail Comments Screen" (page 503)

 l "P/O Cost Allocation Screen" (page 509)

 l "P/O Create Invoice from Receipts Screen   " (page 493)

 l "P/O Remit-To Location Screen" (page 492)

 l "P/O Lot Numbers Generation/Allocation Screen" (page 627)

 l "P/O Serial Numbers Generation/Allocation Screen" (page 631)

Related Tasks

 l "Entering an Invoice" (page 150)

 l "Entering Additional Costs on Invoices" (page 153)

 l "Receiving and Invoicing Lotted Items" (page 189)

 l "Receiving and Invoicing Serialized Items   " (page 187)

Overview   

Use the P/O Invoice Entry screen to:

 l Enter invoices for receipts   of goods into Purchase Orders.

 l Review existing invoices.

 l Enter additional costs   for invoices, and allocate additional costs for multiple receipts.

 l Export invoices.
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 l Assign serial numbers   to serialized items (if you use Serialized Inventory and Lot Tracking  ).

 l Assign lot numbers to   lotted items (if you use Serialized Inventory and Lot Tracking  ).

Note: Before entering invoices, make sure you post the receipts to which   the invoices apply.

Additional Costs Tab

Use this tab to:

 l Add additional costs charged   on the shipment by either a primary vendor   or a secondary 
vendor,   such as for handling charges, service charges, and duty. For more information, see 
"About Vendors" (page 81).

 l Specify how to prorate   new additional costs or reprorate the costs if you return the items.

 l Allocate new additional   costs (added to the invoice) to one or more receipts.

Invoice Tab  

Use this tab to enter:

 l The receipt number (or   numbers) to which the invoice applies.

 l The invoice date.

 l The invoice total.

 l The billing address for   the invoice.

 l The remit-to location.

 l An optional description   and reference.

 l The 1099/CPRS code and   amount (for vendors who are subject to 1099 or CPRS reporting).

 l Invoice details.

Optional Fields Tab

This tab appears if you have assigned optional fields to the P/O Invoice   Entry screen (using the P/O 
Optional Fields setup screen). 

If you have assigned optional fields to invoice and additional cost   details, you can enter optional field 
information for each item on the   individual detail lines. For more information about optional fields, see 
"About Optional Fields in Transactions" (page 80).

452Sage 300 2021 Purchase Orders User's Guide



Rates Tab

This tab appears only if you use multicurrency accounting and you are entering an invoice for a 
primary vendor who does not use the functional currency. 

Use the Rates tab to:

 l Change the rate type,   rate date, and exchange rate for converting the invoice amount from the   
vendor's currency to your functional (home) currency.

 l Look up the rate information   entered with the receipt.

For more information, see "About Vendors" (page 81).

Retainage Tab

This tab appears only if you select the Retainage option for job-related   invoices. (This option appears 
only if you use retainage accounting   in Accounts Payable.) 

You use this tab to:

 l Select payment terms   for retained amounts.

 l Specify whether to use   the original retainage exchange rate for the receipt or use the current   
exchange rate (if the items were originally received in another currency).

Taxes Tab   

Use this tab to:

 l Check or change the vendor's   tax group.

 l Check tax information   or edit the tax class and tax amount for the vendor's tax authorities.

Click the Calc. Taxes button to recalculate   tax amounts after changing tax classes or the tax included 
option. (If you changed tax totals on the invoice, the Calc.   Taxes button restores the original 
amounts.)

Terms Tab

Use this tab to:

 l Check the vendor's terms.

 l Enter or edit the due   date and discount terms of an invoice.

 l Edit a payment schedule   when you are making a series of payments over time.

453Sage 300 2021 Purchase Orders User's Guide



Payment terms can be as simple as a due date and a discount date and   rate, or they can include 
payment schedules to allow for several installment   payments. 

All payment terms are defined in Accounts Payable but you can change   them on the Terms tab before 
you post the invoice.

Totals Tab

Use this tab to:

 l Check tax and detail   totals. 

 l Verify invoice totals   for the vendor. 

 l Enter a discount percentage   or a total discount for the invoice. When you enter a discount   on 
this tab, the program distributes the total amount to the invoice details,   overwriting any 
discounts you entered for details.

 l Enter comments for the   invoice.

 l Check the estimated weight   of the goods for which you were invoiced.

 l Check the number of item   and additional cost details entered for the vendor on the invoice.

 l Check the invoice subtotal   and total additional costs and excluded taxes for the vendor. 

Note: 
 l On invoices for the primary vendor, the Totals tab shows   the total weight of the invoiced 

items, number of item and additional   cost detail lines, tax information for the invoice, invoice 
subtotal (net   of taxes and additional costs), totals of additional costs and taxes,   and invoice 
total. 

 l On invoices for a secondary vendor, the Totals tab shows   only the number of additional cost 
details, related tax information, invoice   subtotal, excluded tax amount, and invoice total.

Fields and Controls

Buttons

Derive Rate

When Purchase Orders calculates the tax amount in a tax reporting currency,   the program uses the 
Tax Reporting Currency Exchange Rate that appears   (or that you enter) on the Rates tab.

However, if you have changed the tax reporting amount that appears on   the Taxes tab, you can 
click the Derive Rate button to see the actual   exchange rate between the tax amount and the tax 
reporting amount.
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In other words, the Derive Rate button appears so you can derive the   exchange rate for the tax 
reporting currency, if you change the calculated   amount on the Taxes tab.

Distribute Cost

Use the Distribute Cost button to allocate a new additional cost to multiple receipts.

Select the additional cost detail on the Additional Costs tab, and then   click the Distribute Cost 
button to open the P/O Cost Allocation screen. For more information, see "P/O Cost Allocation 
Screen" (page 509).

Purchase Orders automatically allocates the additional cost amount according to the proration 
method you selected on the Additional Costs tab. However,   you can enter different amounts for 
each receipt manually.

Calc. Taxes

Click the Calc. Taxes button to see tax amounts for   a detail before you post the document. 

Note: Tax amounts are not   calculated automatically until you click the Taxes tab or the Totals tab, 
or you post the purchase order.

Cost/Tax

Click the Cost/Tax button to open the "P/O Additional Costs Detail Costs/Taxes Screen" (page 503). 
(Highlight   the line on the Detail table on the Additional Costs tab, and then click   the Cost/Tax 
button.)

On the P/O Detail Costs/Taxes screen, you can:

 l View existing additional   cost details.

 l Add new additional cost   details.

 l Check the tax information   or change the tax classes and taxable status for a single detail.

 l Allocate the additional   cost to multiple receipts using the Distribute Cost button.

History

Click the History button to open the P/O Purchase History screen, where you can check information 
about the items you have purchased from your vendors.

For more information, see "P/O Purchase History Screen" (page 375).
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Item/Tax

Click the Item/Tax button to open the P/O Detail Items/taxes screen for a detail so that you can 
check the tax information and change the tax classes and taxable status for the selected detail. You 
can also add new details. 

For more information, see "P/O Invoice Entry Detail Items/Taxes Screen" (page 494).

Post

Click Post to post the document, including any changes you   made to an existing document. 

Currency

In multicurrency ledgers, the vendor's currency code is displayed after you enter the vendor 
number. All amounts you enter for the invoice will   be in the vendor's currency.

The currency is assigned for the vendor in Accounts Payable and you   cannot change it in Purchase 
Orders.

Entered By

If the transaction was entered manually in Purchase Orders, the field displays the user ID of the 
person who entered the transaction.

Invoice Number

Use the Invoice Number field to enter a new invoice number or select an existing invoice.

Purchase Orders does not assign invoice numbers. You should use the   number on the vendor 
invoice.

You can:

 l Start a new invoice. You   can click the New  button beside the field to clear existing 
information   from the screen, or simply enter the new invoice number using up to 22 
characters, and  then press Tab.

 l View an invoice you posted   previously. Use the navigation buttons or the Finder  beside 
the field   to select it. Note that you cannot make changes to invoices after posting   them.

If necessary, you can enter more than one invoice with the same invoice number, for either the 
same vendor or different vendors.
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When you enter a duplicate invoice number, a screen displays all invoices with the specified invoice 
number. On this screen, you can choose to create a new invoice with the same number or display 
other invoices with that number.

Subtotal

The Subtotal field displays the   total of all item and additional cost details on the invoice. 

This amount   does not include taxes (unless tax amounts are included in detail cost   amounts).

Vendor Number

Identifies the vendor from whom you received the invoice. The vendor   number sets the default tax 
group and payment terms. In multicurrency   systems, the vendor number also specifies the currency 
of the document.

You can enter any vendor number for the invoice, even if the vendor   was not entered on the receipt. 
This feature lets you enter invoices   for additional costs that were not included on the receipt, and 
prorate   the new costs to the items on the receipt.

If you do not enter the vendor number before selecting a receipt number,   the primary vendor 
number is automatically displayed, but you can change   to another vendor number to enter an 
invoice for additional costs that   were charged on the receipt, or for new additional costs.     

 l To select an existing   vendor, use the Finder , or type the number and then press Tab.

 l To display address information   for a selected vendor, click the Zoom  button beside the 
Vendor Number field.

 l To add a new vendor, do   one of the following:

 l If you want to add   the vendor record now, click the New  button after   typing the 
vendor number. 

 l If you do not want   to add the vendor record now, enter only the vendor number. (You 
can enter   the vendor name on the next tab.) 

Warning! Although   you can add a purchase order before you add the vendor record 
in Accounts   Payable, you should not use this option in a multicurrency system.

Additional Costs tab

Use the Additional Costs tab to:
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 l Add additional costs charged   on the shipment by either a primary vendor   or a secondary 
vendor,   such as for handling charges, service charges, and duty. For more information, 
see "About Vendors" (page 81).

 l Specify how to prorate   new additional costs or reprorate the costs if you return the items.

 l Allocate new additional   costs (added to the invoice) to one or more receipts.

Additional Cost                                      

Type the code for the additional cost you want to add, or select the   code from the Finder. 

If you are adding a cost for which no code is defined,   skip this field and type the name of the cost in 
the Description field   (the field beside the Additional Cost field in the Detail Cost/Taxes   screen).

Note: You use the Additional Costs screen (in the P/O Setup folder) to maintain  the additional cost 
charges you use in Purchase Orders.

Amount

Use the Amount field to enter the amount of the cost (excluding taxes, unless you are entering   a 
tax-included cost).

Billing Type, Billing Rate, and A/R Item Number (job-related only)                                     

For additional costs on job-related invoices, you also specify the Billing   Type, Billing Rate, and 
AR Item Number that will be used for the customer   invoice.

These fields will only appear for job-related invoices.

A/R     Item Number

This field displays the A/R item number associated with the project resource     used for the contract in 
Project and Job Costing. You can select a different     A/R item number only for time and material 
projects, as follows:

 l On a standard project,        this field displays the A/R item number and unit of measure specified        
for the project resource category as the default. You can accept the item       number or select 
another valid A/R item number.

 l On a basic project, this field        displays the A/R item number and unit of measure specified for 
the project        category. You can accept the item number or select another valid A/R item       
number.
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 l If you change the A/R        item number, the item number must be a valid item number in 
Accounts Receivable,        and the unit of measure must be a valid unit of measure both for the 
new       item number and the vendor’s currency.

Cost plus and fixed price projects do not use an A/R item number. 

Billing Currency

This field appears only in multicurrency systems for time and materials projects and for fixed price 
projects using billings and costs or accrual-basis accounting methods.

The billing currency is the customer's currency specified on the contract, and you cannot change it.

Billing currency is blank for Fixed Price projects using completed project or project percentage 
complete methods, and for Cost Plus projects.

Note: Billing currency is not displayed for basic or standard internal Time and Materials projects, 
or for single-currency Fixed Price projects that use billings and costs or accrual-basis accounting 
methods.

Billing Rate

This field displays the billing rate for the specified resource (for standard projects) or category (for 
basic projects).

You can edit the billing rate if the billing type is Billable. The field displays 0.000000 if the billing type 
is Non-Billable or No Charge.

Note: 
 l You can specify the billing rate for Time and Materials projects and for Fixed Price projects 

that use Billings and Costs or Accrual-Basis accounting methods.

 l Billing rate is disabled and set to 0.000000 on a basic or standard internal contract for Time 
and Materials projects or for Fixed Price projects using Billings and Costs or Accrual-Basis 
accounting methods.

 l The billing rate cannot be negative.

 l If a job-related additional cost is prorated by cost, quantity, or weight, the specified billing 
rate in functional currency will be prorated to the item details for projects that are Time and 
Materials or Fixed Price with an accounting method of Billings and Costs or Accrual-Basis.

The billing rate is not prorated to item details for Cost Plus or Fixed Price projects with completed 
project or project percentage complete accounting methods. Instead, it is converted to the contract 
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customer’s currency when it is prorated to the item details during day end processing (using the 
current exchange rate).

The prorated billing rate for each detail is not displayed (and, therefore, you cannot change it).

Billing     Type

This field appears in the detail-entry section only for job-related     purchase orders.

The billing type indicates to Project and Job Costing whether to bill      the cost to the customer. You 
can change this field only for a time and     materials project, as follows:

On a basic project:

For a billable project,        the category billing type determines whether you can change the billing       type 
for the detail. If the specified category is:

 l Billable, the default       billing type for the detail is billable, but you can change it.

If the detail is billable you can specify a billing     rate for the detail.

If you change the billing type for the detail to no      charge or non-billable, the program sets the billing 
rate to zero and     you cannot change it.

 l No charge or non-billable,        the program sets the same billing type for the detail, and cannot 
change        it. You cannot specify a billing rate for the detail, which the program       sets as zero.

If the project is no charge        or non-billable, the detail uses the same billing type as the project,       the 
billing rate is set to zero, and you cannot change them.

On a standard project:

If the project is billable,        the resource billing type determines whether you can change billing type       for 
the detail.  If the specified resource is:

 l Billable, the program        displays Billable as default billing type, but you can change it for the        
detail. If the detail is billable, you can specify a billing rate for       the detail.

If you change the billing type for the detail to no      charge or non-billable, the program sets the billing 
rate to zero, and     you cannot change it.

 l No charge or non-billable,        the program sets same billing type for the detail, and you cannot 
change        it. You cannot specify a billing rate for the detail, which the program       sets as zero.

If the project is no charge        or non-billable, the detail uses the same billing type as the project,        and 
you cannot change it. The program also sets the billing rate to zero,       and you cannot change it.
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For fixed price and cost plus projects,      the Billing Type field is blank. A billing type is not required for 
these     types of projects.

Unit     of Measure

This field appears for Time and Materials projects if you selected the     Job Related option for this 
transaction.

You must enter a unit of measure that is valid for the item number/resource     that you specified and 
for the contract customer's currency.

Note: For internal time and materials projects (basic or standard     contracts) the A/R item unit of 
measure will be disabled or blank.

Calculate Labor 

Select the Calculate Labor field if you want Project and Job Costing   to calculate labor amounts for 
this cost and pass the amount back to Purchase   Orders. (Purchase Orders creates the G/L entries 
for the additional costs.)

Do not select this option for an additional cost for which you don't   want to calculate labor.

The program also lets you specify whether overhead or labor is calculated   if you expense the 
additional cost. 

Calculate Overhead              

Select the Calculate Overhead field if you want Project and Job Costing   to calculate overhead 
amounts for this cost and pass the amount back to   Purchase Orders. (Purchase Orders creates the 
G/L entries for the additional   costs.)

Overhead is usually calculated on the discounted extended amount.

For example, you would not select this option if an invoice or debit note had additional   shipping 
costs for which you didn't want to calculate overhead or labor.

The program also lets you specify whether overhead or labor is calculated   if you expense the 
additional cost. 

Comments             

Enter an optional comment for the document.
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Any comments you entered for the detail on the receipt are included   on the invoice, but you can 
change or delete them.

Lines automatically wrap when you reach the end. If you want to start   a new line before the line 
wraps, press Enter. 

Contract, Project, Category and Resource (job-related only)                                     

If the invoice is job-related, specify for each additional cost detail   where the items or resources 
are going to be used. If you use different   terms than “Contract,” “Project,” and “Category” in 
Project and Job Costing,   the program displays them instead.

You will also specify the Billing Type, Billing Rate, AR Item Number,   and AR Item UOM for the 
additional cost.

Note: You specify this information   only if you are not prorating the cost to individual detail 
lines (No Proration). The fields are disabled if you are prorating by cost, quantity or weight, 
or prorating manually (where you allocate costs to the individual lines on the Distribute 
Additional Costs screen). You enter/select the resource using the Item Number field.

Category

Select or enter a category that is assigned to the project in Project   and Job Costing.

Contract

Specify a contract number for each detail. You can enter or   select only contracts that are open or on 
hold. (You cannot process transactions   to a contract that is on hold, if it has never been opened.)

Cost   Class

The program displays the cost class for the category used in each detail.   You cannot change this 
field.

Item   Number (Resource)

Use the Item Number field to identify the resource for this detail.
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You must specify a resource that is assigned to the project and category in   Project and Job Costing. 
You can specify an inventory item number, or the code for another type of resource (such as an 
equipment code, subcontractor code, or employee number). 

Note: You cannot leave this field blank.

Project

You can only enter or select projects that are:

 l Assigned to the contract   that you selected.

 l Open or on hold. (If   a project that is on hold has never been opened, you cannot select it.)

 l Not closed to costs.

Distribute Proration

If you selected manual proration, click this column heading to open the "P/O Distribute Proration 
Screen" (page 511). You must calculate all the costs and associated allocated taxes to prorate   
manually for each detail, then enter the amounts with the details.

Expense Account

When entering an additional cost detail that you will expense to a general   ledger account, enter the 
account number in this field.

You do not enter a general ledger account number when you select a proration   method for the 
detail.

Line Number

To select an existing line to edit or delete, click the line, or   enter its line number in this field on the 
P/O Detail Items/Taxes screen.

Note: You cannot   delete completed lines.

Net of Tax              

This field displays the net amount of the additional cost you entered   for the detail (excluding 
allocated taxes that are not included in the   amount of the cost).
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Optional Fields

If optional fields have been defined in Purchase Orders for additional cost details for a transaction 
screen, an Optional Fields column appears in the detail entry table on the Additional Costs tab. You 
can click the column heading   to display the optional fields assigned to a selected detail, and   edit 
their contents.   

In the Detail Costs/Taxes screen, you click the Zoom  button beside the Optional Fields field to 

display the optional fields for a detail.

For more information about using optional fields in transactions, see "About Optional Fields in 
Transactions" (page 80). 

Proration Method

For new additional cost details, specify whether to prorate the cost   to the received items by cost, 
quantity, or weight, or to expense the   cost to a general ledger account.

You cannot change the proration method on an additional cost detail   that was added to the receipt 
you are now invoicing. Note that you can   manually prorate additional costs only on receipts. The 
option is not   available on invoices.

If you are adding additional costs for non-inventory items, you must   select No Proration. If you 
choose to prorate by quantity, cost, or weight,   the program will display an error message and 
prevent you from posting   the invoice.

Receipt Number                                       

Purchase Orders displays the receipt number for each detail, indicating   the source of the detail.

Reference

Enter optional reference information for the detail.

Return Expense Account

In this field, enter the general ledger account number to which to post   prorated additional cost 
amounts if you   return items.

Return Proration

For new additional cost details, choose whether to reprorate the cost   to the other items on the 
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receipt if you return items with prorated costs.   You can reprorate the cost amount, leave it as 
originally prorated, or   expense it to a general ledger account.

You cannot change the reproration method on an additional cost detail   that was added to the receipt 
you are now invoicing.

Tax Included

This field displays the total amount of taxes included in   the additional cost amount.

Tax Included                                     

In the Detail table, this field displays the amount of tax that is included in the extended   item cost 
(when the cost includes tax).

On the zoomed Detail Items/taxes screen, this field displays Yes or No to indicate whether tax 
amounts are included in the item   cost for each tax authority. The default choice for this option is 
provided from the vendor record   in Accounts Payable or from the vendor contract cost. 

Note: You can select Yes only if the tax authority is set up in   Tax Services to allow tax-included 
costing.

You can also edit total tax amounts on the Taxes tab.

Allocated Tax                                       

This field displays the amount of allocated tax for the detail. (Allocated   taxes are included in the cost 
of the detail. Recoverable and expensed   taxes are not included in detail costs.) 

Invoice tab

Use the Invoice tab to enter:

 l The receipt number (or   numbers) to which the invoice applies.

 l The invoice date.

 l The invoice total.

 l The billing address for   the invoice.

 l The remit-to location.

 l An optional description   and reference.

 l The 1099/CPRS code and   amount (for vendors who are subject to 1099 or CPRS 
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reporting).

 l Invoice details.

Bill-to Location

Use the Bill-to Location field to edit an existing bill-to location address or to type   a new billing 
address for the invoice. You do not have to enter a bill-to location code or address information.

If you use Inventory Control, select a location code to which the invoice   will be sent for payment.

For more information, see "P/O Bill-To Location Screen" (page 491). 

Description

Use the Description field to enter an optional description for the invoice.

The description, if any, entered on the receipt is displayed but you   can change it.

From Multiple Receipts

If you are creating an invoice based on several receipts, select this   option, then use the Zoom  

button to open the P/O Create Invoice From Receipts   screen.

Note: You must enter a vendor number before you can select this   option. After you select this 
option, the Receipt Number   field is no longer available for the invoice. Likewise, after you enter   a 
receipt number, you can no longer select From Multiple Receipts.

Use the Create Invoice From Receipts screen to select the receipts to which the invoice applies, 
then click the Invoice button to add the details to the invoice   you are creating. 

For more information, see "P/O Create Invoice from Receipts Screen   " (page 493).

Invoice Date

Use the Invoice Date field to enter the date you want to use as the invoice date.

You can specify a fiscal year and period that do not    correspond to the invoice date. 

The program displays   session date you used to sign in to Sage 300.
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You can change the posting date if you want a different date for   the G/L transactions when they are 
posted in the General Ledger. (The   posting date determines the fiscal year and period displayed 
beside the   Posting Date field.)

Invoice Total

Enter the total invoice amount, including taxes and additional costs.

When you post the invoice, the program checks the amount     you entered as the invoice total against 
the total of the details and     taxes you enter with the invoice. You cannot post the invoice if these    
totals do not balance. 

Job Related 

If the receipt is job related, the Job Related option is selected,   and you cannot change this 
selection. If you use retainage   accounting, you can specify that the invoice uses retainage.

Because the invoice is job related, fields appear in the details   section, enabling you to enter the 
contract, project, category, cost class and   resource for each detail. Additional detail fields let you 
enter the customer   billing type, billing rate, and A/R item used for billing.

Note: If you use different terms than “Contract,” “Project,” and “Category”   in Project and Job 
Costing, those terms appear here.

On Hold

Select the On Hold option to prevent this invoice from being paid in   Accounts Payable.

If you want to pay this invoice later, you will have to edit the invoice   in Accounts Payable, and clear 
this option.

PO Number  

If you are entering an invoice to a receipt that specified a purchase   order number, the purchase 
order number is displayed for your information.

Posting Date

Enter the posting date for the transaction.
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The posting date is different from the document   date. The posting date is the date for transactions 
being posted to the General   Ledger, so it also determines the contents of the Fiscal Year and Period   
fields.

If you have a multicurrency system, currency revaluation uses posting   dates to select open 
documents for revaluation purposes, and thus, revaluation   adjustments are posted to General 
Ledger in the correct fiscal year and   period.

Depending on your settings in the P/O Options screen, Purchase Orders   automatically displays the 
session date or the document date by default   in this field.

You can change the posting date, but you cannot separately change   the fiscal year and period.

Note: If you consolidate G/L transactions, the posting date for consolidated entries is the last date 
of the fiscal period.

Receipt Date  

After you select the receipt number for the invoice, the receipt date   is displayed for your information.

Receipt Number

Use the Receipt Number field to enter the receipt number that you are invoicing, or select it from   
the Finder. (The receipt must exist in Purchase Orders.)

When you enter the receipt number, all receipt details and other information   for the selected vendor 
are displayed in Invoice Entry. You cannot change   the tax group or add or delete item detail lines 
(for the primary vendor).   You can add additional cost details.

The receipt details that appear include all item and additional cost   details for the primary vendor, or 
all the additional costs for vendors   who charged only additional costs on the original receipt.

Note: You can enter any number of invoices for a receipt. Only receipt   details that have not 
already been fully invoiced can be used in the current   invoice. Once all the details are fully 
invoiced, you can no longer use   the receipt in an invoice.

Reference

Enter optional reference information for the document. If reference information was entered for the 
receipt, it appears here, but you can change   it.
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Remit-To Location

Use the Remit-To Location field to look up the address information entered for the selected   remit-
to location. Address information appears only if you select a remit-to   code for the vendor.

You cannot edit information in this screen. Use Accounts Payable to add   and edit remit-to locations 
for vendors.

If a primary remit-to address is assigned for the vendor in Accounts   Payable, the code for the 
address appears automatically but you can change   it.

When you post the invoice, the remit-to location you specify is included   on the invoice created by 
Day End Processing for Accounts Payable.

Retainage  

If the Retainage option is selected in Accounts Payable, you can select  retainage accounting for the 
invoice.

Additional retainage fields appear for each invoice   detail line to let you enter a different retainage 
percentage and period.

On the Retainage tab, you can specify the   retainage terms and specify the exchange rate that you 
use for multicurrency   retainage invoices.

Vendor Account Set

The account set from the vendor record appears in this field as the   default. It specifies the general 
ledger payables   control, purchase discounts, prepayment, and retainage accounts to which   the 
transaction will be distributed.

You can change the account set for a particular purchase order, receipt,   return, invoice, credit note, 
or debit note. If you use   multicurrency accounting, however, the new account set must use the same   
currency as the vendor's account set.

Note: If you change the account set on a receipt, make sure that you use the   same account set 
for returns, invoices, and credit or debit notes.

Year and Period  

This is the fiscal year and period to which the invoice transactions   will be posted in the general 
ledger. You can change   the fiscal period by changing the posting date.
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You can enter a different invoice date, and you can enter a different   posting date for the document.

Note: You cannot post transactions to closed fiscal periods.

1099/CPRS Amount and Code

These fields appear only if the Subject To 1099 Reporting option is selected   for the vendor in 
Accounts Payable.

For vendors who are subject to 1099 reporting, enter the 1099 code and amount.

The1099 code and amount are included on the invoice created by Day End   Processing for Accounts 
Payable.

Details table

Use the Details table on the Invoice tab to:

 l Edit or remove item detail   lines for an invoice from a primary vendor. For more 
information, see "About Vendors" (page 81).  

Note: You cannot add more detail lines to the invoice tab. All lines must have been on 
the receipt. You can, however, add costs to the Additional Costs tab, and you can 
change the quantity being invoiced.

 l Edit received quantities, item costs, and detail discounts, if you have security rights to do 
so.   

 l Enter comments and optional fields for the details.

 l Display all the fields, including tax fields, for a selected detail on the P/O Item/Tax Detail 
screen.

Allocated Tax              

This field displays the total tax amount that was allocated to the selected detail   line for each tax 
authority.

Billing Type, Billing Rate, and A/R Item Number (job-related only)                                     

For job-related invoices, you also specify the billing type, billing rate, and AR item number that 
will be used for the customer invoice.
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You must select the Job Related option on the Invoice tab for these fields to appear.

A/R     Item Number

This field displays the A/R item number associated with the project resource     used for the contract in 
Project and Job Costing. You can select a different     A/R item number only for time and material 
projects, as follows:

 l On a standard project,        this field displays the A/R item number and unit of measure specified        
for the project resource category as the default. You can accept the item       number or select 
another valid A/R item number.

 l On a basic project, this field        displays the A/R item number and unit of measure specified for 
the project        category. You can accept the item number or select another valid A/R item       
number.

 l If you change the A/R        item number, the item number must be a valid item number in 
Accounts Receivable,        and the unit of measure must be a valid unit of measure both for the 
new       item number and the vendor’s currency.

Cost plus and fixed price projects do not use an A/R item number. 

Billing Currency

This field appears only in multicurrency systems for time and materials projects and for fixed price 
projects using billings and costs or accrual-basis accounting methods.

The billing currency is the customer's currency specified on the contract, and you cannot change it.

Billing currency is blank for Fixed Price projects using completed project or project percentage 
complete methods, and for Cost Plus projects.

Note: Billing currency is not displayed for basic or standard internal Time and Materials projects, 
or for single-currency Fixed Price projects that use billings and costs or accrual-basis accounting 
methods.

Billing Rate

This field displays the billing rate for the specified resource (for standard projects) or category (for 
basic projects).

You can edit the billing rate if the billing type is Billable. The field displays 0.000000 if the billing type 
is Non-Billable or No Charge.
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Note: 
 l You can specify the billing rate for Time and Materials projects and for Fixed Price projects 

that use Billings and Costs or Accrual-Basis accounting methods.

 l Billing rate is disabled and set to 0.000000 on a basic or standard internal contract for 
Time and Materials projects or for Fixed Price projects using Billings and Costs or Accrual-
Basis accounting methods.

 l The billing rate cannot be negative.

Billing     Type

This field appears in the detail-entry section only for job-related     purchase orders.

The billing type indicates to Project and Job Costing whether to bill      the cost to the customer. You 
can change this field only for a time and     materials project, as follows:

On a basic project:

For a billable project,        the category billing type determines whether you can change the billing       type 
for the detail. If the specified category is:

 l Billable, the default       billing type for the detail is billable, but you can change it.

If the detail is billable you can specify a billing     rate for the detail.

If you change the billing type for the detail to no      charge or non-billable, the program sets the billing 
rate to zero and     you cannot change it.

 l No charge or non-billable,        the program sets the same billing type for the detail, and cannot 
change        it. You cannot specify a billing rate for the detail, which the program       sets as zero.

If the project is no charge        or non-billable, the detail uses the same billing type as the project,       the 
billing rate is set to zero, and you cannot change them.

On a standard project:

If the project is billable,        the resource billing type determines whether you can change billing type       for 
the detail.  If the specified resource is:

 l Billable, the program        displays Billable as default billing type, but you can change it for the        
detail. If the detail is billable, you can specify a billing rate for       the detail.

If you change the billing type for the detail to no      charge or non-billable, the program sets the billing 
rate to zero, and     you cannot change it.
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 l No charge or non-billable,        the program sets same billing type for the detail, and you cannot 
change        it. You cannot specify a billing rate for the detail, which the program       sets as zero.

If the project is no charge        or non-billable, the detail uses the same billing type as the project,        and 
you cannot change it. The program also sets the billing rate to zero,       and you cannot change it.

For fixed price and cost plus projects,      the Billing Type field is blank. A billing type is not required for 
these     types of projects.

Unit     of Measure

This field appears for Time and Materials projects if you selected the     Job Related option for this 
transaction.

You must enter a unit of measure that is valid for the item number/resource     that you specified and 
for the contract customer's currency.

Note: For internal time and materials projects (basic or standard     contracts) the A/R item unit of 
measure will be disabled or blank.

Comments             

Enter an optional comment for the document.

Any comments you entered for the detail on the receipt are included   on the invoice, but you can 
change or delete them.

Lines automatically wrap when you reach the end. If you want to start   a new line before the line 
wraps, press Enter. 

Contract, Project, Category and Resource (job-related only)                                     

If the invoice is job related, specify for each purchase order detail   where the items or 
resources are going to be used. If you use different   terms than “Contract,” “Project,” and 
“Category” in Project and Job Costing,   those terms appear here.

For job-related invoices:

 l You must select the Job Related option for these fields   to appear.

 l You also specify the billing type, billing rate, and A/R item number for the customer 
invoice near the   end of the detail line.

 l You select the resource   using the Item Number field. 
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 l If the invoice is being   created from multiple receipts, all receipts must be either job-
related   or non-job-related.

 l Purchase Orders updates   the committed quantities and costs for jobs with the amounts 
on purchase   orders. 

Contract

Specify a contract number for each detail. You can enter or   select only contracts that are open or 
on hold. (You cannot process transactions   to a contract that is on hold, if it has never been 
opened.)

Cost   Class

This field displays the cost class for the category used in each detail.   You cannot change this field.

Item   Number

Use the Item Number field to specify the resource for this detail. 

You must specify a resource that you have assigned to the project in   Project and Job Costing (such 
as an equipment code or a subcontractor   code). You cannot leave this field blank.

Project

You can only enter or select projects that are:

 l Assigned to the contract   that you selected.

 l Open or on hold. (If   a project that is on hold has never been opened, you cannot select it.)

 l Not closed to costs.

Discount %

Enter a percentage to calculate   the discount amount for the item detail.

If you prefer not to enter discounts for individual details, you can   enter a discount percentage for the 
entire invoice on the Totals tab.   Purchase Orders then prorates the discount amount for the 
document details,   overriding any discounts you may have entered manually for the details.

Discount Amount

Enter an amount in the Discount Amount field to calculate   and display the discount percentage 
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based on the extended cost. Alternatively,   you can enter a percentage in the Discount % field, and 
let the program   calculate the discount amount.

If you prefer not to enter discounts for individual details, you can   enter a discount amount for the 
entire invoice on the Totals tab. Purchase   Orders then prorates the discount amount for the 
document details, overriding   any discounts you may have entered manually for the details.

You can enter a separate discount percentage or     amount for each detail. When you enter a 
discount amount, the program     calculates the discount percentage, and displays the result in this 
field.     If you enter a percentage, the program calculates and displays the discount    amount.

Note: If you enter a discount for the invoice on the Totals tab,     the program distributes the total 
discount amount to the details, overwriting    any detail discounts you entered.

Discountable

Select Yes in the Discountable field if the vendor payment terms allow early payment discount.

Discounted Extended Cost

This field displays the extended cost less the discount amount.

Expense Account

If you entered a non-inventory item number for the detail line, enter   the account number of the 
general ledger expense account to which you   want to post the detail. 

This field displays the number entered with the detail on the   receipt, but you can change the 
number.

For new detail lines, this field displays the account number specified   on the P/O Options screen for 
the Default Inventory Expense Account option.   

Extended Cost

Enter the extended cost for the number of units of the item that you   ordered.

If you change the extended cost, the program automatically recalculates   the unit cost.

Extended Weight

Enter the extended weight for the number of units of the item that you   ordered.
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If you change the extended weight, Purchase Orders automatically recalculates   the unit weight.

The total weight entered for all items on the purchase order appears on the Totals tab.

Fully Invoiced

Use the Fully Invoiced field to indicate whether the detail line is now fully invoiced:

 l If the quantity invoiced   equals the quantity you received for the detail, accept Yes in this field.    

 l If the quantity invoiced   is less than the quantity received, either double-click the field or press 
the spacebar to select No.

Note: When working with a serialized or lotted item, Yes can appear by default   when the receipt 
number is entered. This cannot be changed to No for serial   and lot detail lines and they will be 
marked as fully invoiced even if   the Quantity Invoiced field is changed to less than the quantity 
received.

Item Description

This field displays the item description from the P/O Vendor Contract   Costs record (if one exists) or 
from the Inventory Control or Purchase   Orders item record. If necessary, you can change it. 

If you enter an item number that does not exist in Inventory Control,   you also enter the description 
for the item. You can enter non-existent item   numbers only if you selected the Allow Non-inventory 
Items option on   the P/O Options screen. 

Purchase Orders displays the item description that was entered with the   detail on the receipt, but 
you can change it.

Item Number                                      

The program displays the item number that was entered with the detail   on the receipt. 

Line Number

To select an existing line to edit or delete, click the line, or   enter its line number in this field on the 
P/O Detail Items/Taxes screen.

Note: You cannot   delete completed lines.
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Location

This field displays the location code entered for the detail on the   receipt.

Manufacturer's Item Number

If you entered a manufacturer's item number in the Item Number field   on the requisition or 
purchase order, the number appears in the Manufacturer's Item Number field. 

Manufacturer's item numbers are alternative item numbers—  such as bar codes or shortcut codes—  
that identify your inventory items. You set up manufacturer's item numbers   in Inventory Control.

You can enter manufacturer's item numbers wherever you enter item numbers   in Purchase Orders.

Net Of Tax             

This field displays the extended item cost, minus any applicable tax   amount. You cannot edit the 
amount.

Non-Stock Clearing Account

Use the Non-Stock Clearing Account field to change the non-stock clearing account associated 
with this item's account set.

If the item used in the detail is a non-stock item, the non-stock clearing   account associated with the 
item's account set appears.

If you are returning a non-stock item, the non-stock clearing account   associated with the item's 
account set appears. You can specify a different   account, if necessary.

Optional Fields 

Optional fields are fields that have been added by your company to the   transaction-entry screens 
and detail lines in purchase orders transactions.

Note: You must have Transaction Analysis and Optional Field Creator   to add and use optional 
fields.

If the Optional Fields column appears, you can click the column heading to display the optional 
fields that have been assigned to this screen, and   edit their contents.

Optional field information on invoice detail lines is inherited from   any matching optional fields in the 
receipts.
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If the optional fields   were not on the receipt: 

 l For non-job related invoices,   optional field information defaults come from item records or, if 
the   fields do not match, from the default value in the P/O Optional Fields   screen.

 l For job-related invoices,   the optional field defaults depend on the contract style and project 
type.   

If you use the same optional fields for categories   or resources in Project and Job Costing, default 
optional field information   will be inherited from the category for basic projects, or from the resource   
with standard projects.

For more information, see "About Optional Fields" (page 51).

Order Number

Enter the number of a sales order for which you are creating the detail. If you use Sage 300 Order 

Entry with Purchase Orders, you can also use the Finder  to select an Order Entry order number.

You can change or erase an order number that is displayed with a detail   you added from a 
purchase order or posted previously with the screen.

If you change an order number that is displayed with a detail line, the new order number does not 
replace the previous number on the corresponding receipt and will not be reported on the P/O 
Shippable Backorders report.

You also enter the unit weight, extended weight, vendor item number,    comments, and the G/L 
expense account specified for non-inventory items.

Quantity Invoiced

Use the Quantity Invoiced field to edit the number of units of the item that you received.

If the item is a serialized and/or lotted item, you may have to allocate   numbers in a separate screen. 
Purchase Orders displays the number of units entered   for the detail on the receipt, in the unit of 
measure selected for the   detail.

Be sure that any new quantity you enter is in the unit of measure   that is used for the detail. You 
cannot change the unit of measure on   the invoice.

If     you increase or decrease the invoiced quantity, the Quantity Invoiced     field is updated on the 
purchase order. During posting or during Day End     Processing, item costs are updated in Inventory 
Control and, if necessary,    new general ledger transactions are created to reflect the change.
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Receipt Number                                       

Purchase Orders displays the receipt number for each detail, indicating   the source of the detail.

Retainage %, Retainage Amount, and Retention Period

If the Retainage option was selected for the receipt, retainage-related fields appear for each 
invoice detail line.

The default retainage percentage and retention period that appears in   these fields are based on the 
Default Retainage From option for the contract   in Project and Job Costing.

On the Retainage tab, you can specify the   exchange rate that you want to use for the retainage 
amount on multicurrency   invoices.

Note: Retainage accounting applies only to job-related transactions,   and is available only if you 
selected retainage accounting in Accounts   Payable.

Tax Included                                     

In the Detail table, this field displays the amount of tax that is included in the extended   item cost 
(when the cost includes tax).

On the zoomed Detail Items/taxes screen, this field displays Yes or No to indicate whether tax 
amounts are included in the item   cost for each tax authority. The default choice for this option is 
provided from the vendor record   in Accounts Payable or from the vendor contract cost. 

Note: You can select Yes only if the tax authority is set up in   Tax Services to allow tax-included 
costing.

You can also edit total tax amounts on the Taxes tab.

Unit Cost 

Enter the cost of a single unit of the item you are ordering in the detail.   

Purchase Orders displays a default cost as follows:

 l If you have set up vendor   contract costs, Purchase Orders displays the cost specified as a 
contract   cost for the item and unit of measure. 

 l If P/O does not find a   valid contract cost, it uses the inventory cost specified on the P/O 
Options   screen.
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Use the Finder  to view any vendor contract costs, regular   vendor costs, and other costs 

maintained by Inventory Control.

Purchase Orders uses the unit cost to calculate the extended cost. If you   change the unit cost, the 
extended cost is recalculated.

In multicurrency ledgers, the cost is expressed in the vendor's currency.

Note: You can assign security to the Unit Cost and Extended    Cost fields, to prevent unauthorized 
changes to the fields.

If you use Project and Job Costing, unit cost is defaulted as follows:

 l If   the project is a standard project:

 l For a category cost   class of Subcontractor, Overhead, or Miscellaneous Equipment, 
the unit   cost is defaulted from the category resource.

 l For a category cost   class of Labor, the default unit cost is based on the Default Unit 
Cost   From option for the employee resource category.

 l For a category cost   class of Material (if you are using Inventory Control), the default 
unit   cost is based on Purchase Orders' default item cost (set in P/O Options).

 l For a category cost   of Material (if you are not using Inventory Control), the unit cost is   
based on Purchase Orders vendor costs.

 l If   the project is a basic project:

 l For a category cost   class of Subcontractor, Overhead, or Miscellaneous Equipment, 
the unit   cost is defaulted from the category.

 l For a category cost   class of Labor, the default unit cost is based on the Default Unit 
Cost   From option for the labor category.

 l For a category cost   class of Material (if you are using Inventory Control), the default 
unit   cost is based on Purchase Orders' default item cost (set in P/O Options).

 l For a category cost   of Material (if you are not using Inventory Control), the unit cost is   
based on Purchase Orders vendor costs.

Unit of Measure

This field displays the unit of measure entered for the detail on the   receipt.

Unit Weight

Enter the weight of a single unit of the item you are ordering in the   detail. On new detail lines, the 
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weight specified in the Inventory Control   item record is displayed, but you can change it.

Purchase Orders uses the unit weight to calculate the extended weight. If   you change the unit 
weight, the extended weight is recalculated.

You can select from the weight units of measure defined in Purchase   Orders. Weight is expressed 
in the unit selected   for the Weight Unit Of Measure option on the I/C Options   screen.

On invoices, enter the weight of a single unit of the item for which you were invoiced.   The program 
displays the weight specified for the item on the receipt   but you can change it.

Purchase Orders uses the unit weight to calculate the extended weight. If   you change the unit 
weight, the extended weight is recalculated.

You can see the total weight estimated from your entries for the invoiced   items on the Totals tab.

Vendor Item Number             

Enter the code the vendor uses to identify the item. 

If the vendor's item number is specified in the Inventory Control item   record, the code appears in 
this field. (Enter vendors' item numbers when   assigning vendor types in Inventory Control item 
records.)

If the vendor's item number is specified on the receipt for which you   are entering an invoice, the 
code appears in this field. (You can enter   vendors' item numbers when assigning vendor types in 
Inventory Control   item records.)

Optional Fields tab

The Optional Fields tab contains optional fields   added by your company that apply to the 
transaction as a whole. Optional   fields on detail lines apply to the individual transaction detail.

This tab appears only if you use Transaction Analysis and Optional Field Creator.

For more information, see "About Optional Fields" (page 51).

Rates tab

This tab appears if you use multicurrency accounting. Use it to review and edit exchange rates 
for Purchase Orders documents.
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Invoice Exchange Rate

The program displays the exchange rate currently in effect for the specified   currency and the 
displayed rate type and rate date, but you can change the   rate.

You receive a warning if you change an exchange rate by an amount that exceeds   the Spread 
setting for the currency in Common Services' Currency Rates table.

The program also displays the exchange rate entered on the receipt.

Invoice Rate Date

Type or select the date to use to select the exchange rate for the document you are entering.

The program displays the rate date that is nearest the   document date you entered, but you can 
specify a different date for which   an exchange rate exists for the currency in   Common Services' 
Currency Rates table.

If you change the rate date, Purchase Orders checks the rate tables   for a date match, and updates 
the rate if necessary. 

Invoice Rate Type

Use the Invoice Rate Type field to enter the rate type code.

Purchase Orders uses rate types when converting multicurrency amounts on   the invoice to 
functional currency. Examples of rate types might be "spot   rate," "average rate," and "contract rate."

You define rate types using the Currency Rate Types screen in Common Services,   and assign the 
default rate type for Purchase Orders on the Processing   tab of the P/O Options screen.

Receipt Exchange Rate

This field displays the exchange rate entered on the receipt.

Receipt Rate Date

This field displays the rate date used with the receipt.

Receipt Rate Type

This field displays the rate type used with the receipt.
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Retainage tab

This tab appears only if you select the Retainage option for job-related   invoices. (This option 
appears only if you use retainage accounting   in Accounts Payable.) 

You use this tab to:

 l Select payment terms   for retained amounts.

 l Specify whether to use   the original retainage exchange rate for the receipt or use the 
current   exchange rate (if the items were originally received in another currency).

Taxes tab

Use the Taxes tab to:

 l Check or change the vendor's   tax group.

 l Check tax information   or edit the tax class and tax amount for the vendor's tax 
authorities.

Import Declaration Number

If the invoice is for imported goods, enter the import declaration number for the invoice. This 
number is required for tax purposes in some jurisdictions (such as Malaysia and Singapore).

Tax Group  

For new vendors (not yet added to Accounts Payable), select the tax group   that identifies the tax 
authorities to which the vendor is subject. You must use a tax group that is defined   for your company 
in Common Services.

When entering invoice information for a vendor who is defined in Accounts   Payable, you can change 
the default tax group.

You must enter a valid tax group for every invoice vendor.

Total Tax

This field displays the total tax amount calculated for each authority   in the vendor's tax group. You 
can change this amount, if necessary. 

To cancel all your changes   to tax amounts at the same time, click the Calculate Taxes button. 
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Table

Retainage Tax Amount

This field appears on the Taxes tab for Receipt Entry, Invoice Entry,   Return Entry, and Credit/Debit 
Note Entry if retainage applies to the   document. 

It shows the amount of tax calculated for this authority for the retainage   portion of the document if 
you report tax for retainage amounts when you   create the retainage document (not when you 
create the original document).   

Retainage appears only on job-related documents if you select   the Retainage option on the first tab 
of the transaction entry screen.

Retainage tax amounts are computed using the retainage tax base and   the tax rate for each tax 
authority. 

Retainage Tax Base

The retainage tax base is the amount (before included taxes) used as   the base for calculating taxes 
on the retained amount.

Essentially, the retainage tax base is the retainage portion of the   document (excluding tax) if you 
report tax for retainage amounts at the   time that you create the retainage document (not when you 
create the original   document). 

Retainage appears only on job-related documents if you select   the Retainage option on the first tab 
of the transaction entry screen.

Retainage tax amounts are computed using the retainage tax base and   the tax rate for each tax 
authority. 

Reverse Charges Amount

From all details in the document, the total of reverse chargeable tax amounts owed to a tax 
authority, if the Reverse Charges Base for the tax authority is above the reverse charges threshold 
amount for the tax authority. If the Reverse Charges Base is not above the reverse charges 
threshold amount, this field displays 0.

Note: The amount in this field is calculated automatically, but you can change it.
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Reverse Charges Base

From all details in the document, the total of Tax Base amounts used to calculate reverse 
chargeable tax amounts owed to a tax authority.

Tax Amount             

This field displays the amount of tax that is due for each authority.

For each authority, Purchase Order calculates a tax amount if:

 l The vendor is subject   to tax. 

 l The transaction contains   taxable items or taxable additional costs. 

 l Tax rates are specified   for the tax authorities and classes in Tax Services.

If no tax amounts appear, click the Calculate Taxes button. 

Tax amounts   are not automatically calculated on a purchase order until you post it   or click the 
Totals tab.

Tax Authority and Description                             

These columns list the codes and corresponding descriptions for all the tax authorities in the tax 
group specified for the document. 

You enter tax information in the Tax Services module in Common   Services. 

Tax Base  

The tax base shows, for the tax authority, the net cost of items before   tax is added. (This field is 
useful for items that have tax included in   their prices.)

Tax Excluded                               

The program displays the total amount of tax that is not included in   item costs for the authority.

Tax Included

The program displays the total amount of tax that is included in item costs for the authority.

You can include tax amounts in item costs only if permitted by the authority.
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Tax Reporting Currency

Tax reporting fields appear on the Taxes tab only if the tax group's tax reporting currency is 
different from your functional currency and the vendor's   currency.

Along with the tax reporting currency, the program displays the amount of included   and excluded 
tax to be reported in that currency on tax tracking reports   for all the tax authorities listed on the 
document.

You set the tax reporting currency for tax groups in the Tax Services module   in Common Services.                    

Tax Reporting Total             

This field displays the sum of the tax reporting amounts for all tax authorities.   

It appears only if the tax reporting currency for the   tax group is different from your functional 
currency and the   vendor's currency. 

You set the tax reporting currency for tax groups in the Tax Services module   in Common Services.

Total Retainage Tax

This field appears on the Taxes tab for Receipt Entry, Invoice Entry,   Return Entry, and Credit/Debit 
Note Entry if retainage applies to the   document.

It shows the total amount of tax calculated for the retainage portion   of the document if you report tax 
for retainage amounts when you create   the retainage document (not when you create the original 
document). 

Retainage appears on job-related documents only  if you select   the Retainage option on the first tab 
of the transaction entry screen.

Retainage tax amounts are computed using the retainage tax base and   the tax rate for each tax 
authority. 

Vendor Tax Class and Tax Class Description

These columns list the tax classes that   are assigned to the tax authorities to which the vendor is 
subject, and their corresponding descriptions. 

You can change a tax   class to another tax class that is assigned to the authority, but not   the 
description.
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To change the description for the tax class or make other changes   for the specified tax group, use 
the Tax Services screens in Common Services. 

Terms tab

Use the Terms tab to

 l Check the vendor's terms.

 l Enter or edit the due   date and discount terms of an invoice.

 l Edit a payment schedule   when you are making a series of payments over time.

Amount Due

Enter the amount due for each of the payments in a schedule.

As of Date

Enter the date from which the terms are calculated. Purchase   Orders automatically displays the 
document date, but you can type another   date.

For example, if the first payment is not due for six months (so you   would consider the first invoice 
date as six months from today), add six   months to the As of Date, then press the Tab key to 
recalculate the schedule.

Discount %

This field displays the discount percentage specified for the terms   code, if any.

You can change the displayed rate. If the terms code does not use discounts,   you can enter a 
discount percentage for the individual invoice, if necessary.

Discount Amount

This field displays the discount amount specified for the terms code,   if any.

You can change the displayed amount. If the terms code does not use   discounts, you can enter a 
discount amount for the individual invoice,   if necessary.

Discount Date

If the terms code uses discounts, this field displays the date on which   the period for an early-
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payment discount expires. You can change the date.

If the terms code does not use discounts, this field displays the session   date. You can assign a 
discount amount and date for an individual invoice. 

Due Date

This field displays the due date calculated from the invoice date and   the specifications for the terms 
code but you can change the date, if   necessary.

Number of Payments

When you specify a terms code that uses a payment schedule, this field  displays the number of 
payments permitted in the schedule.

You can enter payment amounts for all the payments in the schedule,   or for only some of them. You 
cannot enter more payments than are permitted   by the schedule.

Edit the terms code in Accounts Payable to change the   number of payments in a payment schedule.

Payment Number

When you are entering a payment schedule, this field displays the number   of each payment line.

Terms Code

Use the Terms Code field to add or change the code that identifies the payment terms the vendor 
allows your company.

To change a terms code, type the new code or select the code from the   Finder. You must enter a 
terms code for each vendor and you must use one   of the terms codes you have defined in Accounts 
Payable.

You can also edit dates, payment, and discount information on the Terms   tab.

Totals tab

Use the Totals tab to:

 l Check tax and detail   totals. 

 l Verify invoice totals   for the vendor. 
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 l Enter a discount percentage   or a total discount for the invoice. When you enter a 
discount   on this tab, the program distributes the total amount to the invoice details,   
overwriting any discounts you entered for details.

 l Enter comments for the   invoice.

 l Check the estimated weight   of the goods for which you were invoiced.

 l Check the number of item   and additional cost details entered for the vendor on the 
invoice.

 l Check the invoice subtotal   and total additional costs and excluded taxes for the vendor. 

Comment

Enter an optional comment for the invoice, up to 250 characters.

Estimated Tax

This is the tax amount that will be applied to the retainage invoice   (if the tax authority allows you to 
defer tax on retained amounts on an original receipt and invoice).

If you are applying all tax amounts to the original invoice, this amount   will be zero.

Retainage amounts are invoiced at a later time, in Accounts Payable.

Included Tax 

This field displays the total amount of tax that is included in item   costs for the authority.

You can include tax amounts in item costs only if permitted by the authority.   

Invoice Detail Subtotal  

This field displays the total of all item detail costs, if any, entered   from the invoice, including tax-
included amounts. 

The subtotal does not   include tax amounts that are not included in item costs or the additional   costs 
you added for the vendor.

Less Invoice Discount

You can enter an optional discount percentage or discount amount   for the entire document, or enter 
discounts for individual detail lines.
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If you enter a discount for the entire document, Purchase Orders   prorates the discount amount for 
the document details, overriding any discounts   you may have entered manually for the details.

Less Retainage  

This field appears if this invoice is a job-related document that includes   retainage amounts.

Net Invoice Total  

This field appears if this invoice is a job-related document that includes retainage amounts.

Number of Costs                            

The program displays the number of additional cost detail lines you   entered for the document.

Check this number against source documents to make sure you entered   all the details you require.

Number of Lines                               

The program displays the number of item detail lines you entered for the   primary vendor on the 
document.

Check this number against source documents to make sure you entered   all the details you require.

Plus Additional Costs 

This field displays the total amount of additional costs entered with   the invoice, excluding taxes 
(except taxes that are included in the cost   amounts).

This figure appears on invoices for primary vendors that include both   item and additional cost 
details. 

Plus Excluded Tax                              

This field displays the total excluded tax amount of all item and additional   cost details for the vendor. 
This amount does not include   taxes that are included in the cost amounts.

Total Invoice 

This field displays the total of all item and/or additional costs and   taxes for the vendor and invoice.
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Total Reverse Charges

The total of Reverse Charges Amounts for the document.

Total Tax

This field displays the total tax amount calculated for each authority   in the vendor's tax group. You 
can change this amount, if necessary. 

To cancel all your changes   to tax amounts at the same time, click the Calculate Taxes button. 

Total Weight 

This field displays the total weight of the invoiced goods, calculated   from the weight and invoiced 
quantity entered for each item detail.

Use this amount to check invoiced shipping charges.

P/O Bill-To Location Screen

To Open this Screen

 1. Open Purchase Orders > P/O Transactions > Invoice Entry.

 2. Click the Zoom  button beside the Bill-To Location field, or press       the F9 key in the field.

Overview   

Use the Bill-To Location screen to edit an existing bill-to location address or to type a new billing 
address for the invoice.

Fields and Controls

Address

Use the Address field to type the address for the location, or edit the displayed information   if 
necessary.
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Bill-To Location 

If you use Inventory Control and you selected a bill-to location code,   the program displays the 
location code.

If you do not use Inventory Control, you can click the Zoom  button beside the field name.

Enter the bill-to location information by typing   in the screen that appears.

Contact

Enter the name of a contact person, department, or position.

Description

Use the Description field to type a description of the location, such as a company name, or edit   a 
displayed description if necessary. You do not have to include a description.

E-mail

Use the E-mail field to type the e-mail address for the location, or edit the displayed address   if 
necessary.

Fax Number

Use the Fax Number field to type the fax number for the location or edit a displayed number if 
necessary.

Phone Number

Use the Phone Number field to type the telephone number for the location or edit a displayed 
number   if necessary.

P/O Remit-To Location Screen

To Open this Screen

 1. Open Purchase Orders > P/O Transactions > Invoice Entry.
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 2. Click the Zoom  button       next to the Remit-To Location field, or click the Remit-To Location 
field, and then press the F9 key. 

Overview

Use this screen to look up the address information entered for the selected remit-to location. Address 
information appears only if you select a remit-to code for the vendor.

You cannot edit information on this screen. Use Accounts Payable to add and edit remit-to locations 
for vendors.

P/O Create Invoice from Receipts Screen   

To Open this Screen

 1. Open Purchase Orders > P/O Transactions > Invoice Entry.

 2. Do one of the following:       

 l Click the Zoom  button beside the From Multiple Receipts option.

 l Select the From Multiple Receipts option, and then press F9.

Overview

Use the P/O Create Invoice from Receipts screen to select multiple receipts and add them to an 
invoice.

When   you create an invoice from more than one receipt:

 l All of the invoice header   information (including the fields on the Optional Fields tab) will come   
from the first receipt that you select. 

 l You cannot change   the tax group or add or delete item detail lines (for the primary vendor).   

 l You can add additional cost details.

 l The receipt details that appear include all item and additional cost   details for the primary 
vendor, or all the additional costs for vendor  who charged only additional costs on the original 
receipts.

 l Once all the details from a receipt are fully invoiced, you can no longer   use the receipt in an 
invoice
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Fields and Controls

Buttons

Close

Click this button to close the screen.

Note: If you click Close without first clicking Invoice, receipt details are not added to the invoice.

Invoice

Click this button to add the receipt details from the selected receipts to the invoice.

Receipt Number

If you are creating an invoice based on multiple receipts, you use this field to specify the receipts to 

use. You can enter receipt numbers manually or you can select them using the Finder .

P/O Invoice Entry Detail Items/Taxes Screen

To Open this Screen

 1. Open Purchase Orders > P/O Transactions > Invoice Entry.

 2. Enter header information for the invoice, including the invoice number, vendor number, and 
the receipt or receipts that you are invoicing.

 3. On the detail entry table, select a detail line, and then press F9 or click   the Item/Tax button.

Related Tasks

 l "Entering an Invoice" (page 150)

 l "Entering Additional Costs on Invoices" (page 153)

 l "Receiving and Invoicing Lotted Items" (page 189)

 l "Receiving and Invoicing Serialized Items   " (page 187)
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Overview

Use the Invoice Entry Detail Items/Taxes screen to check and edit invoice detail lines.

The Detail Items/Taxes screen contains the same fields as the detail entry grid on the Invoice tab, 
plus additional tax-related fields that you use to view or change tax information for a selected detail.

Rather than displaying fields for all the details in tabular format, this screen lets you see all the fields 
for a single detail on a separate screen without needing to scroll.

Press F9 or click Close to return to the Invoice tab.

Fields and Controls

Buttons

Calc. Taxes

Click the Calc. Taxes button to see tax amounts for   a detail before you post the document. 

Note: Tax amounts are not   calculated automatically until you click the Taxes tab or the Totals tab, 
or you post the purchase order.

Save

Use the Save button to save the changes you make to a detail   in the Detail Items/Taxes screen.

Allocated Tax (total for detail)

The program displays the total amount of tax allocated to the detail in the top part of the Detail 
Items/Taxes screen. (Allocated tax is broken down by tax authority in the tax table in the lower 
portion of the screen.)

Allocated taxes are included in the cost of the detail. Recoverable and expensed taxes are not 
included in detail costs.

Comments 

To view comments for a selected detail line, click the Zoom  button beside the Comments field. 

The program displays any comments entered for the detail line on   the receipt, but you can change   
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or delete them.

Tip: You can also press the Shift and F9 keys together to open   or close the screen using your 
keyboard.

To enter comments for the selected detail, click the Detail Comments table, press the Insert key, and 
then type the comments on the new line. 

Lines automatically wrap. If you want to start   a new line before the line wraps, press Enter. 

For more information, see "P/O Detail Comments Screen" (page 503).

Discount %

You can enter a discount as a percentage or an amount. The program uses the amount you enter in 
this field to calculate the   discounted cost for the item detail. 

If you enter a percentage in this field, Purchase Orders calculates   the discount amount for the item 
detail.

Tip: If you prefer not to enter discounts for individual details, you can   enter a discount percentage 
for the entire document on the Totals tab. Purchase   Orders then prorates the discount amount for 
the transaction details,   overriding any discounts you may have entered manually for the details.

Discount Amount

The program uses the amount you enter in this field to calculate the   discounted extended cost for 
the item detail. If you enter a discount   amount, the program calculates and displays the discount 
percentage based   on the extended cost. (Alternatively, you can enter a percentage in the   Discount 
% field, and let the program calculate the discount amount.)

If you prefer not to enter discounts for individual details, you can   enter a discount amount for the 
entire receipt on the Totals tab. Purchase   Orders then prorates the discount amount for the 
document details, overriding   any discounts you may have entered manually for the details. 

Discounted            Ext. Cost 

The program displays the item cost, less the discount amount, in this   field.

Expense Account

If you entered a non-inventory item number for the detail line, enter   the account number of the 
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general ledger expense account to which you   want to post the detail. 

This field displays the number entered with the detail on the   receipt, but you can change the 
number.

For new detail lines, this field displays the account number specified   on the P/O Options screen for 
the Default Inventory Expense Account option.   

Extended Cost

Enter the extended cost for the number of units of the item that you   ordered.

If you change the extended cost, the program automatically recalculates   the unit cost.

Extended Weight

Enter the extended weight for the number of units of the item that you   ordered.

If you change the extended weight, Purchase Orders automatically recalculates   the unit weight.

The total weight entered for all items on the purchase order appears on the Totals tab.

Item Description

This field displays the item description from the P/O Vendor Contract   Costs record (if one exists) or 
from the Inventory Control or Purchase   Orders item record. If necessary, you can change it. 

If you enter an item number that does not exist in Inventory Control,   you also enter the description 
for the item. You can enter non-existent item   numbers only if you selected the Allow Non-inventory 
Items option on   the P/O Options screen. 

Purchase Orders displays the item description that was entered with the   detail on the receipt, but 
you can change it.

Item Number (display only)

The program displays the item number entered for the selected detail   line.

Line Number

To select an existing line to edit or delete, click the line, or   enter its line number in this field on the P/O 
Detail Items/Taxes screen.
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Note: You cannot   delete completed lines.

Location

The program displays the location code entered for the detail on the   receipt. You cannot change it.

Net Of Tax             

This field displays the extended item cost, minus any applicable tax   amount. You cannot edit the 
amount.

Optional Fields 

If optional fields have been defined for invoice details, you can click the Zoom  button beside the 

Optional Fields field to display the optional fields assigned to a selected detail, and edit their 
contents.

For more information about using optional fields in transactions, see "About Optional Fields in 
Transactions" (page 80). 

Order Number

Enter the number of a sales order for which you are creating the detail. If you use Sage 300 Order 

Entry with Purchase Orders, you can also use the Finder  to select an Order Entry order number.

You can change or erase an order number that is displayed with a detail   you added from a purchase 
order or posted previously with the screen.

If you change an order number that is displayed with a detail line, the new order number does not 
replace the previous number on the corresponding receipt and will not be reported on the P/O 
Shippable Backorders report.

You also enter the unit weight, extended weight, vendor item number,    comments, and the G/L 
expense account specified for non-inventory items.

Quantity Invoiced

Use the Quantity Invoiced field to edit the number of units of the item that your received.

If the item is a serialized and/or lotted item, you may have to allocate numbers in a separate screen. 
The program displays the number of units entered   for the detail on the receipt, in the unit of measure 
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selected for the detail. Be sure that any new quantity you enter is in the unit of measure that is used 
for the detail. You cannot change the unit of measure on the invoice.

Receipt Number                                       

Purchase Orders displays the receipt number for each detail, indicating   the source of the detail.

Unit Cost 

Enter the cost of a single unit of the item you are ordering in the detail.   

Purchase Orders displays a default cost as follows:

 l If you have set up vendor   contract costs, Purchase Orders displays the cost specified as a 
contract   cost for the item and unit of measure. 

 l If P/O does not find a   valid contract cost, it uses the inventory cost specified on the P/O 
Options   screen.

Use the Finder  to view any vendor contract costs, regular   vendor costs, and other costs 

maintained by Inventory Control.

Purchase Orders uses the unit cost to calculate the extended cost. If you   change the unit cost, the 
extended cost is recalculated.

In multicurrency ledgers, the cost is expressed in the vendor's currency.

Note: You can assign security to the Unit Cost and Extended    Cost fields, to prevent unauthorized 
changes to the fields.

If you use Project and Job Costing, unit cost is defaulted as follows:

 l If   the project is a standard project:

 l For a category cost   class of Subcontractor, Overhead, or Miscellaneous Equipment, 
the unit   cost is defaulted from the category resource.

 l For a category cost   class of Labor, the default unit cost is based on the Default Unit 
Cost   From option for the employee resource category.

 l For a category cost   class of Material (if you are using Inventory Control), the default 
unit   cost is based on Purchase Orders' default item cost (set in P/O Options).

 l For a category cost   of Material (if you are not using Inventory Control), the unit cost is   
based on Purchase Orders vendor costs.
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 l If   the project is a basic project:

 l For a category cost   class of Subcontractor, Overhead, or Miscellaneous Equipment, 
the unit   cost is defaulted from the category.

 l For a category cost   class of Labor, the default unit cost is based on the Default Unit 
Cost   From option for the labor category.

 l For a category cost   class of Material (if you are using Inventory Control), the default 
unit   cost is based on Purchase Orders' default item cost (set in P/O Options).

 l For a category cost   of Material (if you are not using Inventory Control), the unit cost is   
based on Purchase Orders vendor costs.

Unit of Measure

Enter the unit of measure in which to order the item. If you are creating a purchase order from a 
requisition, the unit of   measure entered for the detail on the requisition is displayed, but you   can 
change it.

If you are entering new detail lines, the program displays the stocking   UOM by default, unless you 
have set up vendor contract costs using a different   UOM.

You must use one of the units of measure that is assigned for the item   in Inventory Control. 

Note: The weight UOM can be different from the   order UOM.

Unit Weight

Enter the weight of a single unit of the item you are ordering in the   detail. On new detail lines, the 
weight specified in the Inventory Control   item record is displayed, but you can change it.

Purchase Orders uses the unit weight to calculate the extended weight. If   you change the unit 
weight, the extended weight is recalculated.

You can select from the weight units of measure defined in Purchase   Orders. Weight is expressed in 
the unit selected   for the Weight Unit Of Measure option on the I/C Options   screen.

On invoices, enter the weight of a single unit of the item for which you were invoiced.   The program 
displays the weight specified for the item on the receipt   but you can change it.

Purchase Orders uses the unit weight to calculate the extended weight. If   you change the unit 
weight, the extended weight is recalculated.

You can see the total weight estimated from your entries for the invoiced   items on the Totals tab.
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Vendor Item Number             

Enter the code the vendor uses to identify the item. 

If the vendor's item number is specified in the Inventory Control item   record, the code appears in this 
field. (Enter vendors' item numbers when   assigning vendor types in Inventory Control item records.)

If the vendor's item number is specified on the receipt for which you   are entering an invoice, the 
code appears in this field. (You can enter   vendors' item numbers when assigning vendor types in 
Inventory Control   item records.)

Tax table

Allocated Tax             

This column displays the tax amounts allocated to the selected detail   line for each tax authority.

Detail Tax Class and Description

These columns list the tax classes and corresponding descriptions that   are assigned to the tax 
authority. You can change the tax   class (to another tax class that is assigned to the authority), but 
not   the description.

To change the tax class description or make other changes to the information   for the specified tax 
group, use the Tax Services screens in Common Services. 

Expensed Tax

The program displays the amount of tax that is separately posted (expensed)   to a general ledger 
account, rather than allocated to details on the credit   note or debit note.

Recoverable Tax 

The program displays the amount of tax that can be recovered by your   company, such as, for 
example, recoverable Canadian Goods and Services   Tax (GST) amounts.

Reverse Chargeable

Indicates if the tax amount owed to a tax authority for a detail may become a reverse charge.
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A reverse chargeable tax amount will not necessarily become a reverse charge. Tax amounts 
become reverse charges only if the Reverse Charges Base for the tax authority to which the tax 
amounts are owed (shown on the Taxes tab) is above the reverse charges threshold amount for the 
tax authority. For more information about threshold amounts, see the Tax Services help.

Tax Amount 

The program displays the amount of tax that is due for each authority.

For each authority, Purchase Orders calculates a tax amount if:

 l The vendor is subject to tax.

 l The transaction contains taxable items or taxable additional costs.

 l Tax rates are specified for the tax authorities and classes in Tax Services.

You cannot edit the tax amount for a detail except indirectly, by changing   the tax class or tax-
included option on the Detail Items/Taxes screen.

To edit tax amounts for the invoice, make your changes on the Taxes   tab.

Tax Authority and Description                                              

These columns list the tax authorities and   that are assigned to the tax group you specified for the 
document.

Tax information is maintained in the Tax Services screens in Common   Services.

Tax Base 

This field shows, for the selected detail, the net cost   of items before tax is added for the tax 
authority. You cannot change   the amount that appears in this field.

This field is particularly useful for items that have tax included in   their prices.

Tax Included                                     

This field displays the amount of tax that is included in the extended   item cost (when the cost 
includes tax).

502Sage 300 2021 Purchase Orders User's Guide



P/O Detail Comments Screen

To Open this Screen

 1. Open Purchase Orders > P/O Transactions >  Invoice Entry.

 2. On the Invoice tab, click the Commentsfield for the detail line you need.

 3. Click the Zoom  button, or press the Shift and F9 keys to open the Detail Comments 
screen.

Use this screen to enter comments for a selected invoice detail line.

To enter or edit a comment:

 1. Type the comment, pressing Enter to start each new line.

 2. When finished, click Close to close the screen.

To delete comments:

 1. Highlight the text to       delete, then press the Delete key. If a message appears      asking you to 
confirm the deletion, click Yes.

 2. When finished, click Close      to return to detail entry.

Tip: You can also delete comments by changing the entry in theComments field to No on the 
Invoice tab. If you decide before posting the invoice that you want to use the remarks, change the 
Comment field to Yes. Your original remarks will reappear. 

P/O Additional Costs Detail Costs/Taxes Screen

To Open this Screen

 1. Open Purchase Orders > P/O Transactions > Invoice Entry.

 2. Enter header information for the invoice. 

 3. On the Additional Costs tab, add or select a detail line, and then click the Cost/Taxbutton or 
press the F9 key.
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Related Tasks

 l "Entering Additional Costs on Invoices" (page 153)

 l "    Distributing Additional Costs to Multiple Receipts on a Debit Note" (page 178)

Overview   

Use the Additional Costs Detail screen to view or edit an additional cost detail.

Instead of presenting the details of an additional cost in a tabular format, the Detail Costs/Taxes 
screen displays all the fields for a single detail on a data entry screen. In addition, it includes fields that 
allow you to change the tax information or enter a comment for a detail.

 l Check tax information   and calculations for a selected additional cost detail.

 l Edit the tax class and   tax-included options for the tax authorities.

 l Add a comment for an additional   cost detail.

 l Add a new additional cost   detail.

Fields and Controls

Buttons

Add

Use the Add button to add an additional cost detail you entered on the Detail Cost/Taxes screen.

Calculate Tax

Use the Calculate Tax button to recalculate tax amounts for an additional   cost detail after you 
change the Tax Class or Tax Included field. (Tax   amounts are not automatically calculated until you 
choose Post for the   invoice or select the Taxes tab or Totals tab.)

Close

Use the Close button, or press the F9 key, to close the Detail Costs/Taxes screen and return   to the 
Additional Costs tab.
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Save

Use the Save button to save changes you make to an additional cost.

Additional Cost                                      

Type the code for the additional cost you want to add, or select the   code from the Finder. 

If you are adding a cost for which no code is defined,   skip this field and type the name of the cost in 
the Description field   (the field beside the Additional Cost field in the Detail Cost/Taxes   screen).

Note: You use the Additional Costs screen (in the P/O Setup folder) to maintain  the additional cost 
charges you use in Purchase Orders.

Allocated Tax 

The program displays the tax allocated for each tax authority on the Detail Costs/Taxes screen. It 
displays the total for the additional cost in the Total Tax field, and on the detail line on the Additional 
Costs tab.

Note: Allocated taxes are included in the cost of the detail. Recoverable   and expensed taxes are 
not included in detail costs.

Amount

Use the Amount field to enter the amount of the cost (excluding taxes, unless you are entering   a tax-
included cost).

Comments             

Enter an optional comment for the document.

Any comments you entered for the detail on the receipt are included   on the invoice, but you can 
change or delete them.

Lines automatically wrap when you reach the end. If you want to start   a new line before the line 
wraps, press Enter. 

Detail Tax Class and Description

These columns list the tax classes and corresponding descriptions that are assigned to the tax 
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authority. In this screen, you can change the tax class (to another tax class that is assigned to the 
authority) but not the description.

Tip: To change the tax class description or make other changes to the information for the 
specified tax group, use the Tax Services screens in Common Services.

Expense Account

Use the Expense Account field to specify the general ledger account to which to expense a 
selected additional cost.

Note: You do not specify a general ledger account number if you select a proration method for the 
additional cost.

Expensed Tax 

The program displays the amount of the tax that is separately posted   (expensed) to a general ledger 
account, rather than allocated to details   on the invoice.

Line Number

To select an existing line to edit or delete, click the line, or   enter its line number in this field on the P/O 
Detail Items/Taxes screen.

Note: You cannot   delete completed lines.

Net of Tax

The program displays the net amount of the additional cost you entered   for the detail (excluding 
allocated taxes that are not included in the   cost amount).

Optional Fields (Additional Cost Details)

If optional fields have been defined in Purchase Orders for additional cost details for a transaction 
screen, an Optional Fields column appears in the detail entry table on the Additional Costs tab. You 
can click the column heading   to display the optional fields assigned to a selected detail, and   edit their 
contents.   

In the Detail Costs/Taxes screen, you click the Zoom  button beside the Optional Fields field to 

display the optional fields for a detail.
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For more information about using optional fields in transactions, see "About Optional Fields in 
Transactions" (page 80). 

Proration

For new additional costs , specify whether to prorate the cost   to the received items by cost, quantity, 
or weight, or to expense the   cost to a general ledger account.

If you are adding additional costs for non-inventory items, you must   choose No Proration, or you will 
not be able to post  the invoice.

Note: You can   manually prorate additional costs only on receipts. The option is not   available on 
invoices.

You cannot change the proration method for an additional cost   that was included on the receipt you 
are now invoicing.

Receipt Number                                       

Purchase Orders displays the receipt number for each detail, indicating   the source of the detail.

Recoverable Tax 

The program displays the amount of the tax that can be recovered by   your company (such as, for 
example, recoverable Canadian Goods and Services   Tax [GST] amounts).

Reference

Enter optional reference information for the detail.

Return Expense Account

If you plan to expense the additional cost prorated to any items you return, specify the general 
ledger account number to which to post the cost.

Return Proration

For new additional cost details, select the reproration method to use if you need to return any of the 
received items, and you did not select No Proration or Prorate Manually for the Proration field. 
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Note: You cannot change the reproration method for an additional cost that was included on the 
receipt you are now invoicing, and you cannot expense job-related costs.

Tax Amount

The program displays the amount of tax that is due for each tax authority.

For each authority, Purchase Orders calculates a tax amount if:

 l The vendor is subject to tax.

 l The additional cost is taxable.

 l Tax rates are specified for the tax authorities and classes in Tax Services.

You cannot edit the tax amount for an additional cost except indirectly, by changing the tax class or 
tax-included option on the Detail Cost/Taxes screen.

Tip: To edit tax amounts for the invoice, make your changes on the Taxes tab. 

Tax Authority and Description 

These columns list the tax authorities and corresponding descriptions   that are assigned to the 
specified tax group.

Tax authorities and other tax information is maintained in the Tax Services screens in Common   
Services.

Tax Base)

This field shows, for the selected additional cost detail, the net cost   of items before tax is added for 
the tax authority. You cannot change   the amount that appears in this field.

Note: This field is particularly useful for items that have tax included in   their prices.

Tax Included (display only unless allowed by authority)

The program displays the total amount of taxes that were included in   the additional cost amount.

To edit tax settings, press F9 to display the zoomed entry screen.

You can also edit total tax amounts on the Taxes tab.
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Vendor Number

The program displays the vendor number for your information.

P/O Cost Allocation Screen

To Open this Screen

 1. Open Purchase Orders > P/O Transactions > Invoice Entry.

 2. Enter header information for the invoice, including multiple receipts that you are now invoicing. 

 3. Click the Additional Costs tab.

 a. Select or add the additional cost you need to distribute to receipts.

 b. Click the Dist. Cost button to open the Cost Allocation screen.

Related Tasks

 l "Entering Additional Costs on Invoices" (page 153)

Overview   

Use this screen to allocate a new additional cost to more than one   receipt on an invoice.

Note: This screen is available only if you are adding an additional cost to   an invoice that is based on 
multiple receipts. 

You can prorate and allocate the additional cost amount manually, or   you can let Purchase Orders 
automatically allocate amounts to receipts   according to the proration method you chose.

Fields and Controls

Buttons

Clear

Use the Clear button to clear all amounts on the screen.
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Redistribute

Use the Redist. button to have Purchase Orders automatically distribute the additional cost amount 
for the receipts.

Amount (additional cost detail total)

The program displays the total amount entered for the additional cost detail at the top of the Cost 
Allocation screen.

Amount (prorated for each receipt)

The program displays the amount of the additional cost allocated to each receipt when you click the 
Redist. button.

To distribute the additional cost manually, you can enter   amounts beside each receipt number. The 
sum of all the amounts you allocate   to receipts must equal the total amount for the additional cost 
detail.

Billing Rate

If the receipt was job-related, Purchase Orders displays a billing rate for the cost that you are 
allocating (along with the amount being allocated).

Note: The   Billing Rate is also allocated with the additional costs to more than   one receipt.

If you are prorating the cost manually to other receipts, you can enter   a different billing rate with 
each distribution.

Distribute Proration (appears if manually prorating cost)

Use the Distribute Proration field to open the Distribute Proration Details screen.

For more information, see "P/O Distribute Proration Screen" (page 511).

Proration Method (display only)

You cannot change the proration method for an existing cost.

If you are adding a new additional cost you can prorate by quantity,   by cost, or by weight, or you can 
prorate manually. 

If the invoice is job-related:

510Sage 300 2021 Purchase Orders User's Guide



 l You can also adjust the   retainage amounts and period if retainage applies to the document.

 l You can adjust the billing   rate and currency if prorating by cost, quantity or weight.

 l You can specify a single   contract, project and category, or use the Distribute Proration button   
to distribute costs to more than one contract, project, and/or category   (if applicable) if you are 
prorating manually. 

Receipt Number

The program displays the receipt numbers used in this invoice. You cannot change the receipt 
numbers.

Retainage Percentage, Amount, and Period

If the receipts were job-related and the credit note or debit note uses the retainage option, the   
program displays additional retainage fields for each receipt to which   you can allocate additional 
costs.

The default retainage percentage and retention period that appears in   these fields depends on how 
you are prorating the costs.

 l If prorating by cost,   quantity, or prorating manually, the settings come from the vendor record.

 l If you are not prorating,   the retainage settings are based on the Default Retainage From 
option   for the contract in Project and Job Costing.

P/O Distribute Proration Screen

To Open this Screen

 1. Open Purchase Orders > P/O Transactions > Invoice Entry.

 2. Enter header information for the invoice. 

 3. On the Additional Costs tab, add or select a detail line, and then click the Distribute Proration 
column heading.

Overview   

You use this screen to distribute additional costs to jobs on job-related invoices.
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Fields and Controls

Amount

Use the Amount field to enter the amount of the additional cost that is being allocated to this   line 
item. The amounts on all lines must add up to the total amount of   the additional cost.

Billing Type, Billing Rate, and A/R Item Number                                      

For job-related additional costs that you are manually prorating, you   also specify the billing 
information to be used on the customer invoice.   

A/R     Item Number

This field displays the A/R item number associated with the project resource     used for the contract in 
Project and Job Costing. You can select a different     A/R item number only for time and material 
projects, as follows:

 l On a standard project,        this field displays the A/R item number and unit of measure specified        
for the project resource category as the default. You can accept the item       number or select 
another valid A/R item number.

 l On a basic project, this field        displays the A/R item number and unit of measure specified for 
the project        category. You can accept the item number or select another valid A/R item       
number.

 l If you change the A/R        item number, the item number must be a valid item number in Accounts 
Receivable,        and the unit of measure must be a valid unit of measure both for the new       item 
number and the vendor’s currency.

Cost plus and fixed price projects do not use an A/R item number. 

Billing Currency

This field appears only in multicurrency systems for time and materials projects and for fixed price 
projects using billings and costs or accrual-basis accounting methods.

The billing currency is the customer's currency specified on the contract, and you cannot change it.

Billing currency is blank for Fixed Price projects using completed project or project percentage 
complete methods, and for Cost Plus projects.
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Note: Billing currency is not displayed for basic or standard internal Time and Materials projects, 
or for single-currency Fixed Price projects that use billings and costs or accrual-basis accounting 
methods.

Billing Rate

This field displays the billing rate for the specified resource (for standard projects) or category (for 
basic projects).

You can edit the billing rate if the billing type is Billable. The field displays 0.000000 if the billing type 
is Non-Billable or No Charge.

Note: 
 l You can specify the billing rate for Time and Materials projects and for Fixed Price projects 

that use Billings and Costs or Accrual-Basis accounting methods.

 l Billing rate is disabled and set to 0.000000 on a basic or standard internal contract for Time 
and Materials projects or for Fixed Price projects using Billings and Costs or Accrual-Basis 
accounting methods.

 l The billing rate cannot be negative.

 l If a job-related additional cost is prorated by cost, quantity, or weight, the specified billing 
rate in functional currency will be prorated to the item details for projects that are Time and 
Materials or Fixed Price with an accounting method of Billings and Costs or Accrual-Basis.

The billing rate is not prorated to item details for Cost Plus or Fixed Price projects with completed 
project or project percentage complete accounting methods. Instead, it is converted to the contract 
customer’s currency when it is prorated to the item details during day end processing (using the 
current exchange rate).

The prorated billing rate for each detail is not displayed (and, therefore, you cannot change it).

Note: This field is disabled if you are prorating manually.

Billing     Type

This field appears in the detail-entry section only for job-related     purchase orders.

The billing type indicates to Project and Job Costing whether to bill      the cost to the customer. You can 
change this field only for a time and     materials project, as follows:
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On a basic project:

For a billable project,        the category billing type determines whether you can change the billing       type 
for the detail. If the specified category is:

 l Billable, the default       billing type for the detail is billable, but you can change it.

If the detail is billable you can specify a billing     rate for the detail.

If you change the billing type for the detail to no      charge or non-billable, the program sets the billing 
rate to zero and     you cannot change it.

 l No charge or non-billable,        the program sets the same billing type for the detail, and cannot 
change        it. You cannot specify a billing rate for the detail, which the program       sets as zero.

If the project is no charge        or non-billable, the detail uses the same billing type as the project,       the 
billing rate is set to zero, and you cannot change them.

On a standard project:

If the project is billable,        the resource billing type determines whether you can change billing type       for 
the detail.  If the specified resource is:

 l Billable, the program        displays Billable as default billing type, but you can change it for the        
detail. If the detail is billable, you can specify a billing rate for       the detail.

If you change the billing type for the detail to no      charge or non-billable, the program sets the billing 
rate to zero, and     you cannot change it.

 l No charge or non-billable,        the program sets same billing type for the detail, and you cannot 
change        it. You cannot specify a billing rate for the detail, which the program       sets as zero.

If the project is no charge        or non-billable, the detail uses the same billing type as the project,        and 
you cannot change it. The program also sets the billing rate to zero,       and you cannot change it.

For fixed price and cost plus projects,      the Billing Type field is blank. A billing type is not required for 
these     types of projects.

Unit     of Measure

This field appears for Time and Materials projects if you selected the     Job Related option for this 
transaction.

You must enter a unit of measure that is valid for the item number/resource     that you specified and 
for the contract customer's currency.
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Note: For internal time and materials projects (basic or standard     contracts) the A/R item unit of 
measure will be disabled or blank.

Contract, Project, Category and Resource

For job-related additional costs that are manually prorated, choose the items/resources to 
which you are allocating the additional cost.

The program displays the “Contract,” “Project,” and “Category” that you specified for each 
invoice detail line. The "resource" appears in the Item Number column.

You also specify the Billing Rate for the additional cost.

Note: The proration screen is   available only if you choose to manually prorate additional 
costs to detail   lines. The following fields from the invoice detail lines are shown as   display-
only fields on this screen: Contract, Project, Category, Cost Class,   Item Number, and 
Description.

Category

Select or enter a category that is assigned to the project in Project   and Job Costing.

Contract

Specify a contract number for each detail. You can enter or   select only contracts that are open or on 
hold. (You cannot process transactions   to a contract that is on hold, if it has never been opened.)

Cost   Class

The program displays the cost class for the category used in each detail.   You cannot change this 
field.

Item   Number (Resource)

Use the Item Number field to identify the resource for this detail.

You must specify a resource that is assigned to the project and category in   Project and Job Costing. 
You can specify an inventory item number, or the code for another type of resource (such as an 
equipment code, subcontractor code, or employee number). 
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Note: You cannot leave this field blank.

Project

You can only enter or select projects that are:

 l Assigned to the contract   that you selected.

 l Open or on hold. (If   a project that is on hold has never been opened, you cannot select it.)

 l Not closed to costs.

Item Description

The program displays the item description from Inventory Control or   the description you entered for 
the detail on the purchase order.

Item Number

The program displays all of the items on the purchase order so you can   easily distribute the 
additional cost in the amount fields.
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P/O Purchase Order Entry Screen  

To Open this Screen

Open Purchase Orders > P/O Transactions > Purchase Order Entry.

Secondary Screens

 l "P/O Purchase Order Entry Bill-To Location Screen" (page 544)

 l "P/O Create PO From Requisition Screen" (page 547)

 l "P/O Purchase Order Entry Detail Comments/Instructions Screen" (page 559)

 l "P/O Purchase Order Entry Detail Items/Taxes Screen   " (page 549)

 l "P/O Purchase Order Entry Drop-Shipment Address Screen" (page 556)

 l "P/O Purchase Order Entry Ship-To Location Screen" (page 546)

 l "P/O Vendor Information Screen   " (page 543)

Related Tasks

 l "Entering a Purchase Order" (page 103)

 l "Entering a Blanket Purchase Order" (page 106)

 l "Entering a Future Purchase Order" (page 107)

 l "Entering a Standing Purchase Order" (page 108)

Overview   

Use the P/O Purchase Order Entry screen to:

 l Enter, edit, and post purchase orders, including active, blanket, future, and standing purchase 
orders.

 l Enter purchase order details.

 l Specify drop-ship addresses for purchase order details.

 l Check and edit tax distributions by detail line and for the purchase order.

 l Import and export purchase orders.
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Order Tab

Use the Order tab to enter general information for a purchase order:

 l An optional template code to specify the default entries in purchase order header and vendor 
information fields.

 l Whether the purchase order is on hold.

 l Whether to create the purchase order from one or more requisitions.

 l Purchase order date.

 l Arrival date.

 l Purchase order type   (active, blanket, future, standing).

 l An optional FOB (free-on-board)   location.

 l Ship-via information,   and the default shipping and billing locations code for the purchase order.

 l A terms code for the vendor.

 l An optional description   and reference.

 l Details included in the purchase   order.

Taxes Tab      

Use the Taxes tab to view and edit tax information. You can: 

 l View or change the tax   group for the vendor for this purchase order.

 l Edit tax classes and   tax-included options for this purchase order.

 l Check tax information   for the document.

 l Edit vendor tax classes and amounts.

You can change a tax class to another tax class that is assigned to   the authority, and you can change 
the selection for the Tax Included option   (if the tax authority permits tax-included costs).

To automatically recalculate taxes   based on the new tax class or tax included status and the tax 
tables in   Tax Services, click the Calculate Taxes button.

Optional Fields Tab      

If you use Transaction Analysis and Optional Field Creator, and if you have assigned optional fields to   
the P/O Purchase Order Entry screen, you can use the Optional Fields tab to add or change 
information   in the optional fields assigned to the screen. 
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Note: You must use the P/O Optional Fields setup screen to add fields before they will appear on 
this screen.

For more information, see "About Optional Fields" (page 51).

Rates Tab      

This panel appears in multicurrency ledgers when you enter   a purchase order for a vendor who does 
not use your company's functional currency.

Use the Rates tab to change the rate type,   rate date, and exchange rate for converting the document 
amount from the   vendor's currency to your functional (home) currency.

Totals Tab     

Use the Totals tab to:

 l Enter a comment   for the purchase order.

 l Enter a discount percentage   or a total discount amount for the purchase order.

 l Verify purchase order   and tax totals.

 l Specify the number of mailing labels   to print for the purchase order.

 l Check the estimated weight   of the goods on the purchase order.

Fields and Controls

Buttons

Calculate Taxes

Click Calculate Taxes to see tax amounts for a detail before you post the purchase order. (Tax 
amounts are not automatically calculated until you click the Taxes tab or the Totals tab or post the 
purchase order.)

If you edit tax amounts on the Taxes tab and then click Calculate Taxes, the program replaces all 
new amounts you entered with the amounts recalculated using the tax tables from Tax Services.

Derive Rate

Click the Derive Rate button to derive the exchange rate for the tax reporting currency, if you 
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change the calculated amount on the Taxes tab.

When Purchase Orders calculates the tax amount in a tax reporting currency, it uses the Tax 
Reporting Currency Exchange Rate that appears (or that you enter) on the Rates tab. If you have 
changed the tax reporting amount that appears on the Taxes tab, you can click the Derive Rate 
button to see the actual exchange rate between the tax amount and the tax reporting amount.

History

Click the History button to open the P/O Purchase History screen, where you can check information 
about the items you have purchased from your vendors.

For more information, see "P/O Purchase History Screen" (page 375).

Item/Tax

To view all the information for a single item in the Detail table on a separate Detail Items/Taxes 
screen, select the detail line, and then click Item/Tax.

The P/O Detail Items/Taxes screen includes additional tax fields that let you check tax information or 
change the tax classes and taxable status for a detail. You can check or edit information for an 
existing detail, and you can enter new details.

New

Click the New button to begin creating a new record.

Post

Click Post to post the document, including any changes you   made to an existing document. 

Entered By

This field indicates how the transaction was entered or created:

 l If the transaction was entered manually in Purchase Orders, the field displays the user ID of 
the person who entered the transaction.

 l If the transaction was created by an e-commerce solution, the field displays Internet.

Last Receipt Number

Each time you post a receipt for a purchase order, this field displays the latest receipt number.
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PO Number

A purchase order number is a unique number, up to 22 characters, which is usually assigned by the 
program using the prefix, length, and next number that you specified on the P/O Options screen.

To add a new purchase order, press the Tab key or click the New  button. If you do not want 

Purchase Orders to assign the order number, type the new number in this field.

To select an existing purchase order for editing, you can:

 l use the Finder  or navigation buttons

 l Type the purchase order number, and then press Tab or Enter

You can change all information from an existing purchase order except the vendor number, 
template code (if any), and tax group.

Vendor Number

The vendor number identifies the vendor to whose account you will post the document. This number 
determines the vendor and billing address, and sets the   default tax group and payment terms. In 
multicurrency systems, the vendor   number also specifies the currency of the document.

 l To select an existing vendor, use the Finder  , or type the number and press Tab.

 l To add a new vendor, do one of the following:

 l If you want to add the vendor record now, click the New  button after typing the vendor 
number, and then enter information for the vendor in Accounts Payable.

 l If you do not want to add the vendor record now, type only the vendor number. (You can 
enter the vendor name on the next tab.)

Important! Although you can add a purchase order before you add the vendor record in 
Accounts Payable, you should not use this option in a multicurrency system.                         

If the tax reporting currency for the tax group that you want to use differs from the vendor’s 
currency, you must create the   vendor record before you enter the invoice.

In any case, you must create the vendor record in Accounts Payable before you can post an 
invoice in A/P.

 l To edit the vendor's billing address, click the Zoom  button, or click in the Vendor   Number 
field, and then press F9. 
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Note: If the vendor is on hold in Accounts Payable, the purchase order will   also be placed on hold 
until you remove the hold in Accounts Payable.

Order tab

Arrival Date 

If known, enter the date when you expect the goods to arrive.

Bill-To Location

Select a code for the inventory location to which you want the vendor to   send the bills for the order. 

You can also click the Zoom  button to open the P/O Bill-To Location screen, where you can edit 

the address for the code you select.

If you prefer, you can omit the code and enter a billing address in this field.

Description

Enter an optional description of up to 60 characters for the purchase order. 

FOB Point

Enter the name of the free-on-board point, or the location where the vendor begins charging you 
freight on shipments.

From Requisition

To select the requisitions from which to create a new purchase order, select the From Requisition 

option, and then click the Zoom  button to open the P/O Create PO from Requisition screen and 

select requisitions.

Note: When you create a purchase order from more than one requisition, optional fields for the 
first requisition you select appear on the Optional Fields tab for the purchase order.

Job-Related

Select this option if the purchase order is for a project you are managing with Project and Job 
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Costing.

If the purchase order is job-related:

 l Additional fields appear in the Detail table that you can use to enter job-related information.

 l All items must be for contracts, projects and categories in Project and Job Costing.

 l Posting the purchase order updates committed quantities and amounts for the jobs.

Note: 
 l If you are creating a purchase order from multiple requisitions, all requisitions must be 

either job-related or non-job-related.

 l You cannot add serialized items or items assigned to lots to job-related purchase orders. 
Instead, you must use a non-job-related purchase order, receive them into inventory, and 
then use the PJC Material Usage screen in Project and Job Costing to move them from 
inventory to jobs.

On Hold

Select this option if you need to put a purchase order on hold.

A purchase order is automatically placed on hold if the vendor account is on hold, or if the On Hold 
option is selected for the template being used. If the template is on hold, you can clear the selection. 

You can post a purchase order that is on hold,   and posting increases item quantities on purchase 
order in Inventory Control.   You cannot post receipts for the purchase order until you remove the on-
hold   designation.

You can list the purchase orders currently on hold on the P/O Purchase Order Action report.

Order Subtotal

This field displays the total of all items on the purchase order before taxes.

Original Amount

Enter the maximum amount that can be ordered on a blanket purchase order.

The amount remaining is calculated and displayed each time you post new details to a blanket 
purchase order. You cannot post details that   would exceed the amount available.

PO Date

Specify the date you want to use as the purchase order date. By default, this field displays the Sage 

523Sage 300 2021 Purchase Orders User's Guide



300 session date.

This date is used by the P/O Aged Purchase Orders report to assign the purchase order to an aging 
period.

When you run Day End Processing on the date you specify, all future orders in your Purchase 
Orders system become active.

PO Type

Select the purchase order type: active, standing, future, or blanket.

For more information, see "Purchase Order Types " (page 77).

Reference

Enter an optional reference of up to 60 characters for the purchase order.

Ship-To Location

If you use Inventory Control, enter the code for the inventory location to which you want the vendor 
to ship the order.

If you do not use Inventory Control, or if you want to use a description and address of a location that 
is not in your Inventory Control system, enter the ship-to description and address manually, or you 
can omit the ship-to location.

The location you specify becomes the default location for the detail lines you add to the requisition 
or purchase order.

You can click the Zoom  button to open the P/O Ship-To Location Information screen, which you 

use to enter a ship-to address or edit the address for the selected code.

Ship Via

Optionally, specify the shipping method by which you expect to receive the goods you are ordering 
from the vendor, and enter a description of the shipping method.

Template Code

This field displays the code for the default template specified on the P/O Options screen. You can 
select another template if you wish, or leave the field blank.
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The template determines which entries are displayed for the FOB point, description, reference, 
comment, ship-to location and bill-to location   (if you use Inventory Control), and ship-via code.

If the vendor record has not yet been added in Accounts Payable, the template also displays entries 
for the tax group (which specifies the currency in a multicurrency system) and terms.

On the P/O Options screen, you can specify a default template to display a standard set of default 
vendor and purchase order settings for each new transaction you create. The default template 
provides initial settings, but these   are overridden by settings from the vendor record—and from 
another template if you choose another one.

For more information, see "About Templates" (page 60).

Terms Code

Select the terms code (defined in Accounts Payable) that represents the payment terms you expect 
the   vendor to allow on the order.

Vendor Account Set

The account set from the vendor record appears in this field as the   default. It specifies the general 
ledger payables   control, purchase discounts, prepayment, and retainage accounts to which   the 
transaction will be distributed.

You can change the account set for a particular purchase order, receipt,   return, invoice, credit note, 
or debit note. If you use   multicurrency accounting, however, the new account set must use the same   
currency as the vendor's account set.

Note: If you change the account set on a receipt, make sure that you use the   same account set 
for returns, invoices, and credit or debit notes.

Details table

Allocated Tax

This field displays the tax amount allocated to item details, including taxes that are included in item 
costs. Recoverable and expensed tax amounts are not included.

Allocated taxes form part of the item costs that are posted from receipts, invoices, returns, credit 
notes, and debit notes to the Inventory Control item records by Day End Processing.
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Billing Type, Billing Rate, and A/R Item Number                                    

These fields appear when you select the Job Related option on the Order tab.

For job-related purchase orders, you specify the billing type,   billing currency, billing rate, and 
A/R item number (if appropriate) to use for the customer invoice.

A/R     Item Number

This field displays the A/R item number associated with the project resource     used for the contract in 
Project and Job Costing. You can select a different     A/R item number only for time and material 
projects, as follows:

 l On a standard project,        this field displays the A/R item number and unit of measure specified        
for the project resource category as the default. You can accept the item       number or select 
another valid A/R item number.

 l On a basic project, this field        displays the A/R item number and unit of measure specified for 
the project        category. You can accept the item number or select another valid A/R item       
number.

 l If you change the A/R        item number, the item number must be a valid item number in 
Accounts Receivable,        and the unit of measure must be a valid unit of measure both for the 
new       item number and the vendor’s currency.

Cost plus and fixed price projects do not use an A/R item number. 

Billing Currency

This field appears only in multicurrency systems for time and materials projects and for fixed price 
projects using billings and costs or accrual-basis accounting methods.

The billing currency is the customer's currency specified on the contract, and you cannot change it.

Billing currency is blank for Fixed Price projects using completed project or project percentage 
complete methods, and for Cost Plus projects.

Note: Billing currency is not displayed for basic or standard internal Time and Materials projects, 
or for single-currency Fixed Price projects that use billings and costs or accrual-basis accounting 
methods.

Billing Rate

This field displays the billing rate for the specified resource (for standard projects) or category (for 
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basic projects).

You can edit the billing rate if the billing type is Billable. The field displays 0.000000 if the billing type 
is Non-Billable or No Charge.

The billing rate is defaulted as follows:

 l For basic projects:     

 l For a category cost class of Subcontractor, Overhead, Miscellaneous Equipment, or 
Material, the billing rate is defaulted from the category resource.

 l For a category cost class of Labor, the default billing rate is based on the Default 
Billing Rate From option for the employee resource category.

 l For standard projects:     

 l For a category cost class of Subcontractor, Overhead, Miscellaneous Equipment, or 
Material, the billing rate is defaulted from the category.

 l For a category cost class of Labor, the default billing rate is based on the Default 
Billing Rate From option for the labor category.

The Billing Rate option does not apply to internal contracts.

Note: 
 l You can specify the billing rate for Time and Materials projects and for Fixed Price projects 

that use Billings and Costs or Accrual-Basis accounting methods.

 l Billing rate is disabled and set to 0.000000 on a basic or standard internal contract for 
Time and Materials projects or for Fixed Price projects using Billings and Costs or Accrual-
Basis accounting methods.

 l The billing rate cannot be negative.

Billing     Type

This field appears in the Detail table for job-related   purchase orders.

The billing type indicates to Project and Job Costing whether to bill   the cost to the customer. You 
can change this field only for a time and   materials project or for fixed price projects that use billings 
and costs   or accrual-basis accounting methods (unless they are internal contracts,   in which case 
this field will be disabled or set to non-billable).

Basic projects. For a billable project,        the category billing type determines whether you can change 
the billing       type for the detail. If the specified category is:
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 l Billable, the default       billing type for the detail is billable, but you can change it.

If the detail is billable you can specify a billing     rate for the detail.

If you change the billing type for the detail to no      charge or non-billable, the program sets the billing 
rate to zero and     you cannot change it. 

 l No charge or non-billable,        the program sets the same billing type for the detail, and you 
cannot change        it. You cannot specify a billing rate for the detail, which the program       sets as 
zero.

If the project is no charge        or non-billable, the detail uses the same billing type as the project,       the 
billing rate is set to zero, and you cannot change them.

Standard projects. If the project is billable,        the resource billing type determines whether you can 
change billing type       for the detail.  If the specified resource is:

 l Billable, the program        displays Billable as default billing type, but you can change it for the        
detail. If the detail is billable, you can specify a billing rate for       the detail.

If you change the billing type for the detail to no      charge or non-billable, the program sets the billing 
rate to zero, and     you cannot change it.

 l No charge or non-billable,        the program sets same billing type for the detail, and you cannot 
change        it. You cannot specify a billing rate for the detail, which the program       sets as zero.

If the project is no charge        or non-billable, the detail uses the same billing type as the project,        and 
you cannot change it. The program also sets the billing rate to zero,       and you cannot change it.

For fixed price and cost plus projects,      the Billing Type field is blank. A billing type is not required 
for these     types of projects.

Unit     of Measure

This field appears for Time and Materials projects if you selected the     Job Related option for this 
transaction.

You must enter a unit of measure that is valid for the item number/resource     that you specified and 
for the contract customer's currency.

Note: For internal time and materials projects (basic or standard     contracts) the A/R item unit of 
measure will be disabled or blank.

Comments/Instructions

To enter comments or instructions for a detail line, click the Zoom 
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 button beside   the field, or press Shift+F9. 

If you are creating a purchase order from a requisition, any comments   or instructions you entered 
for the detail line on the requisition are   included on the purchase order, but you can change or 
delete them.

Completed

You can complete a line only   if the outstanding quantity is zero. If necessary, mark an existing line 
as completed using one of the following methods:

 l In the Detail table, press any key   to enter "Yes" in the Completed column

 l In the P/O Detail Items/Taxes screen, select the Completed   option.

When you post receipts to complete   a purchase order line, Completed is selected automatically.

Contract, Project, Category and Item Number/Resource

If the purchase order is job-related, you specify for each purchase order detail where the items or 
resources are going to be used. If you use different terms than "Contract," "Project," and "Category" 
in Project   and Job Costing, the program displays them instead.

For job-related purchase orders, you can also specify the billing type, billing rate, and AR item 
number for the customer invoice near the end of the detail line.

Purchase Orders updates the committed quantities and costs for jobs with the amounts on 
purchase orders. 

Note: 
 l You must select the Job Related   check box on the Order tab for these fields to appear.

 l If the purchase order is being created from multiple requisitions, all requisitions must be 
either job-related or non-job-related.

 l You use the Item Number field to specify a resource.

 l Cost Plus and Fixed Price projects do not use an A/R item number.

 l You cannot change these fields after you add the detail line.

Category

Select or enter a category that is assigned to the project in Project   and Job Costing.
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Contract

Specify a contract number for each detail. You can enter or   select only contracts that are open or 
on hold. (You cannot process transactions   to a contract that is on hold, if it has never been 
opened.)

Cost   Class

The program displays the cost class for the category used in each detail.   You cannot change this 
field.

Item   Number (Resource)

Use the Item Number field to identify the resource for this detail.

You must specify a resource that is assigned to the project and category in   Project and Job Costing. 
You can specify an inventory item number, or the code for another type of resource (such as an 
equipment code, subcontractor code, or employee number). 

Note: You cannot leave this field blank.

Project

You can only enter or select projects that are:

 l Assigned to the contract   that you selected.

 l Open or on hold. (If   a project that is on hold has never been opened, you cannot select it.)

 l Not closed to costs.

Discount %

You can enter a discount as a percentage or an amount. The program uses the amount you enter in 
this field to calculate the   discounted cost for the item detail. 

If you enter a percentage in this field, Purchase Orders calculates   the discount amount for the item 
detail.

Tip: If you prefer not to enter discounts for individual details, you can   enter a discount percentage 
for the entire document on the Totals tab. Purchase   Orders then prorates the discount amount 
for the transaction details,   overriding any discounts you may have entered manually for the 
details.
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Discount Amount

You can enter a discount as a percentage or an amount. The program uses the amount you enter in 
this field to calculate the   discounted cost for the item detail. 

If you enter a discount amount,   the program calculates and displays the discount percentage based 
on the   cost. (Alternatively, you can enter a percentage in the Discount   Percent field, and let the 
program calculate the discount amount.)

Tip: If you prefer not to enter discounts for individual details, you can   enter a discount amount for 
the entire document on the Totals tab. Purchase   Orders then prorates the discount amount for 
the transaction details,   overriding any discounts you may have entered manually for the details.

Discounted Extended Cost

This field displays the extended cost less the discount amount.

Drop Ship

To enter a drop-ship address for a detail, click the Zoom  button beside the Drop Ship field, or 

select the field and press Shift+F9. 

Select the type of address to enter, and if necessary, select the   location code, customer number, or 
ship-to address code for the address.

Expected Arrival Date

If necessary, enter or edit the date on which you expect to receive   the goods ordered on the detail 
line. 

If you entered a date in the Arrival Date field on the Order tab (or   on a requisition from which you 
are creating the purchase order), the   date is used as the default expected arrival date for new 
details   you add to the purchase order.

Expense Account

If you entered a non-inventory item number for the detail line, enter   the account number of the 
general ledger expense account to which you   want to post the detail. 

This field displays the number entered with the detail on the   receipt, but you can change the 
number.
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For new detail lines, this field displays the account number specified   on the P/O Options screen for 
the Default Inventory Expense Account option.   

Expensed Tax

This field displays the amount of tax that is posted separately (expensed) to a general ledger 
account, rather than allocated to details on the purchase order.

Tax on all non-inventory items is expensed to the general ledger account you specify with the 
transaction (or the default inventory expense account you specify on the P/O Options screen).

Extended Cost

Enter the extended cost for the number of units of the item that you   ordered.

If you change the extended cost, the program automatically recalculates   the unit cost.

Extended Weight

Enter the extended weight for the number of units of the item that you   ordered.

If you change the extended weight, Purchase Orders automatically recalculates   the unit weight.

The total weight entered for all items on the purchase order appears on the Totals tab.

Item Description

This field displays the item description from the P/O Vendor Contract   Costs record (if one exists) or 
from the Inventory Control or Purchase   Orders item record. If necessary, you can change it. 

If you enter an item number that does not exist in Inventory Control,   you also enter the description 
for the item. You can enter non-existent item   numbers only if you selected the Allow Non-inventory 
Items option on   the P/O Options screen. 

Purchase Orders displays the item description that was entered with the   detail on the receipt, but 
you can change it.

Item Number

Enter the number of the item, or use the Finder  to select it. 
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If you selected the Allow Receipt Of Non-stock Items option in Inventory Control and the Allow 
Non-inventory Items option in Purchase Orders, you can enter non-stock item numbers in this 
field.

If you are creating a purchase order from a requisition, the item number entered with the requisition 
appears and you cannot change it. However, you can delete the line if necessary. 

If you have added manufacturers' item numbers or bar codes in Inventory control, you can enter 
those numbers in this field. These numbers could include internally-used bar codes, UPC numbers, 
or ISBNs, enabling you to use a scanner (or enter a short code) to enter inventory item numbers.

If you enter a manufacturer's item number, Purchase Orders replaces it with your inventory item 
number, and then displays the manufacturer's item number you entered in the Manufacturer's 
Item Number field, near the end of the detail line.

Line Number

To select an existing line to edit or delete, click the line, or   enter its line number in this field on the 
P/O Detail Items/Taxes screen.

Note: You cannot   delete completed lines.

Location

This field appears only if you use Inventory   Control.

Enter the code for the location where you expect to receive the shipment   (or to which you want to 
post drop-shipped items). 

The program displays the ship-to location code, if any, entered on the   first tab, but you can select a 
different location. You can omit the location   when adding details for non-inventory items.

Note: If you change  locations after assigning serial and/or lot numbers, you must re-assign the 
serial and/or lot numbers.

Manufacturer's Item Number

If you entered a manufacturer's item number in the Item Number field   on the requisition or 
purchase order, the number appears in the Manufacturer's Item Number field. 

Manufacturer's item numbers are alternative item numbers—  such as bar codes or shortcut codes—  
that identify your inventory items. You set up manufacturer's item numbers   in Inventory Control.
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You can enter manufacturer's item numbers wherever you enter item numbers   in Purchase Orders.

Net Of Tax             

This field displays the extended item cost, minus any applicable tax   amount. You cannot edit the 
amount.

Non-Stock Clearing Account

If this is a non-stock item, the non-stock clearing account associated with the item's account set 
appears. You can change the account, if necessary.

Optional Fields

Optional fields are fields that have been added by your company to the transaction entry screens 
and detail lines in purchase orders transactions.

If you use optional fields, an Optional Fields column appears in the table. You can click the column 
heading to display the optional fields assigned to a selected detail, and edit their contents.

Note: You must use Transaction Analysis and Optional Field Creator to add and use optional 
fields.

For more information about using optional fields in transactions, see "About Optional Fields in 
Transactions" (page 80). 

Order Number

Enter the number of a sales order for which you are creating the detail. If you use Sage 300 Order 

Entry with Purchase Orders, you can also use the Finder  to select an Order Entry order number.

You can change or erase an order number that is displayed with a detail   you added from a 
purchase order or posted previously with the screen.

If you change an order number that is displayed with a detail line, the new order number does not 
replace the previous number on the corresponding receipt and will not be reported on the P/O 
Shippable Backorders report.

You also enter the unit weight, extended weight, vendor item number,    comments, and the G/L 
expense account specified for non-inventory items.
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Quantity Ordered

For new detail lines, type the item quantity to order (in the unit you   select for the Unit Of Measure 
field).

If you are creating a purchase order from a requisition, the quantity   entered for the detail on the 
requisition appears in this field, but you can change   it.

Quantity Outstanding             

On new purchase order detail lines, this field displays   the quantity ordered. Each time you post a   
receipt for a detail, its outstanding quantity is reduced on the purchase   order. When the outstanding 
quantity is zero, the purchase order detail   line is completed and you cannot make further changes 
to it.

To reduce the outstanding quantity on an existing detail line you are   editing, enter the desired 
amount (enter zero to complete a line and cancel   remaining outstanding units).

Quantity Received             

This field displays the total amount received to date for the detail.   It is updated each time you post a 
receipt   for the detail.

Recoverable Tax

This field displays the amount of tax that can be recovered by your company (for example, 
recoverable Canadian Goods and Services Tax [GST] amounts).

Tax Included                                     

In the Detail table, this field displays the amount of tax that is included in the extended   item cost 
(when the cost includes tax).

On the zoomed Detail Items/taxes screen, this field displays Yes or No to indicate whether tax 
amounts are included in the item   cost for each tax authority. The default choice for this option is 
provided from the vendor record   in Accounts Payable or from the vendor contract cost. 

Note: You can select Yes only if the tax authority is set up in   Tax Services to allow tax-included 
costing.

You can also edit total tax amounts on the Taxes tab.
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Unit Cost 

Enter the cost of a single unit of the item you are ordering in the detail.   

Purchase Orders displays a default cost as follows:

 l If you have set up vendor   contract costs, Purchase Orders displays the cost specified as a 
contract   cost for the item and unit of measure. 

 l If P/O does not find a   valid contract cost, it uses the inventory cost specified on the P/O 
Options   screen.

Use the Finder  to view any vendor contract costs, regular   vendor costs, and other costs 

maintained by Inventory Control.

Purchase Orders uses the unit cost to calculate the extended cost. If you   change the unit cost, the 
extended cost is recalculated.

In multicurrency ledgers, the cost is expressed in the vendor's currency.

Note: You can assign security to the Unit Cost and Extended    Cost fields, to prevent unauthorized 
changes to the fields.

If you use Project and Job Costing, unit cost is defaulted as follows:

 l If   the project is a standard project:

 l For a category cost   class of Subcontractor, Overhead, or Miscellaneous Equipment, 
the unit   cost is defaulted from the category resource.

 l For a category cost   class of Labor, the default unit cost is based on the Default Unit 
Cost   From option for the employee resource category.

 l For a category cost   class of Material (if you are using Inventory Control), the default 
unit   cost is based on Purchase Orders' default item cost (set in P/O Options).

 l For a category cost   of Material (if you are not using Inventory Control), the unit cost is   
based on Purchase Orders vendor costs.

 l If   the project is a basic project:

 l For a category cost   class of Subcontractor, Overhead, or Miscellaneous Equipment, 
the unit   cost is defaulted from the category.

 l For a category cost   class of Labor, the default unit cost is based on the Default Unit 
Cost   From option for the labor category.

 l For a category cost   class of Material (if you are using Inventory Control), the default 
unit   cost is based on Purchase Orders' default item cost (set in P/O Options).
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 l For a category cost   of Material (if you are not using Inventory Control), the unit cost is   
based on Purchase Orders vendor costs.

Unit of Measure

Enter the unit of measure in which to order the item. If you are creating a purchase order from a 
requisition, the unit of   measure entered for the detail on the requisition is displayed, but you   can 
change it.

If you are entering new detail lines, the program displays the stocking   UOM by default, unless you 
have set up vendor contract costs using a different   UOM.

You must use one of the units of measure that is assigned for the item   in Inventory Control. 

Note: The weight UOM can be different from the   order UOM.

Unit Weight

Enter the weight of a single unit of the item you are ordering in the   detail. On new detail lines, the 
weight specified in the Inventory Control   item record is displayed, but you can change it.

Purchase Orders uses the unit weight to calculate the extended weight. If   you change the unit 
weight, the extended weight is recalculated.

You can select from the weight units of measure defined in Purchase   Orders. Weight is expressed 
in the unit selected   for the Weight Unit Of Measure option on the I/C Options   screen.

On invoices, enter the weight of a single unit of the item for which you were invoiced.   The program 
displays the weight specified for the item on the receipt   but you can change it.

Purchase Orders uses the unit weight to calculate the extended weight. If   you change the unit 
weight, the extended weight is recalculated.

You can see the total weight estimated from your entries for the invoiced   items on the Totals tab.

Vendor Item Number             

Enter the code the vendor uses to identify the item. 

If the vendor's item number is specified in the Inventory Control item   record, the code appears in 
this field. (Enter vendors' item numbers when   assigning vendor types in Inventory Control item 
records.)
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If the vendor's item number is specified on the receipt for which you   are entering an invoice, the 
code appears in this field. (You can enter   vendors' item numbers when assigning vendor types in 
Inventory Control   item records.)

Weight UOM

This is the unit of measure for the weight of this item on the purchase order—such as, pounds, 
kilograms, tons.

By default, the program displays the weight unit of measure from the item record, but you can 
change it to another defined unit of measure (and the program will recalculate the weight 
accordingly).

The weight UOM for the complete order is determined by the default weight unit of measure set in 
the I/C Options (or in the P/O Options screen if you do not use Inventory Control).

Taxes Tab

Reverse Charges Amount

From all details in the document, the total of reverse chargeable tax amounts owed to a tax 
authority, if the Reverse Charges Base for the tax authority is above the reverse charges threshold 
amount for the tax authority. If the Reverse Charges Base is not above the reverse charges 
threshold amount, this field displays 0.

Note: The amount in this field is calculated automatically, but you can change it.

Reverse Charges Base

From all details in the document, the total of Tax Base amounts used to calculate reverse 
chargeable tax amounts owed to a tax authority.

Tax Amount             

This field displays the amount of tax that is due for each authority.

For each authority, Purchase Order calculates a tax amount if:

 l The vendor is subject   to tax. 

 l The transaction contains   taxable items or taxable additional costs. 
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 l Tax rates are specified   for the tax authorities and classes in Tax Services.

If no tax amounts appear, click the Calculate Taxes button. 

Tax amounts   are not automatically calculated on a purchase order until you post it   or click the Totals 
tab.

Tax Authority and Description                             

These columns list the codes and corresponding descriptions for all the tax authorities in the tax 
group specified for the document. 

You enter tax information in the Tax Services module in Common   Services. 

Tax Base

This field displays the net cost of items, before tax is added, for the tax authority. 

Tip: The Tax Base field is particularly useful for items that have tax included in their prices.

Tax Class and Description

These columns list the tax classes that   are assigned to the tax authorities to which the vendor is 
subject, and their corresponding descriptions. 

You can change a tax   class to another tax class that is assigned to the authority, but not   the 
description.

To change the description for the tax class or make other changes   for the specified tax group, use 
the Tax Services screens in Common Services. 

Tax Excluded                               

The program displays the total amount of tax that is not included in   item costs for the authority.

Tax Group

For new vendors (not yet added to Accounts Payable), enter the tax group code that identifies the 
tax authorities to which the vendor is subject. You must use a tax group that is defined for your 
company in Common Services.

When entering a document for an existing vendor (defined in Accounts Payable), you can change 
the tax group that appears as the default. 
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You must enter a valid tax group code with every purchase order.

Tax Included

The program displays the total amount of tax that is included in item costs for the authority.

You can include tax amounts in item costs only if permitted by the authority.

Tax Reporting Currency

Tax reporting fields appear on the Taxes tab only if the tax group's tax reporting currency is different 
from your functional currency and the vendor's   currency.

Along with the tax reporting currency, the program displays the amount of included   and excluded 
tax to be reported in that currency on tax tracking reports   for all the tax authorities listed on the 
document.

You set the tax reporting currency for tax groups in the Tax Services module   in Common Services.                    

Tax Reporting Total             

This field displays the sum of the tax reporting amounts for all tax authorities.   

It appears only if the tax reporting currency for the   tax group is different from your functional 
currency and the   vendor's currency. 

You set the tax reporting currency for tax groups in the Tax Services module   in Common Services.

Vendor Tax Class

The program displays the tax classes assigned to the vendor's tax authorities. You can change 
each tax class to another tax class that is permitted by the authority.

Tax Class Description

The program displays the description of each tax class. You can change the description only in Tax 
Services.

Optional Fields Tab

The Optional Fields tab contains optional fields   added by your company that apply to the 
transaction as a whole. Optional fields on detail lines apply to the individual transaction detail.
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This tab appears only if you use Transaction Analysis and Optional Field Creator, and have 
added optional fields to the P/O Purchase   Order Entry screen.

For more information, see "About Optional Fields" (page 51).

Rates Tab

Currency

In multicurrency ledgers, the vendor's currency code appears after you enter the vendor number. 
All amounts you enter for the purchase order are in the vendor's currency.

The currency is assigned for the vendor in Accounts Payable and you cannot change it in Purchase 
Orders.

Exchange Rate

The program displays the exchange rate currently in effect for the specified   currency and the 
displayed rate type and rate date, but you can change the   rate.

You receive a warning if you change an exchange rate by an amount that exceeds   the Spread 
setting for the currency in Common Services' Currency Rates table.

Rate Date

Type or select the date to use to select the exchange rate for the document you are entering.

The program displays the rate date that is nearest the   document date you entered, but you can 
specify a different date for which   an exchange rate exists for the currency in   Common Services' 
Currency Rates table.

If you change the rate date, Purchase Orders checks the rate tables   for a date match, and updates 
the rate if necessary. 

Rate Type

If the rate type you want to use is not displayed, enter the new code.

Purchase Orders uses rate types when converting multicurrency amounts on the order to functional 
currency. Examples of rate types might be "spot rate," "average rate," and "contract rate."
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You define rate types using the Currency Rate Types  screen in Common Services, and assign the 
default rate type for Purchase Orders on the Processing tab of the P/O Options screen.

Totals Tab

Comments             

Enter an optional comment for the document.

Any comments you entered for the detail on the receipt are included   on the invoice, but you can 
change or delete them.

Lines automatically wrap when you reach the end. If you want to start   a new line before the line 
wraps, press Enter. 

Less PO Discount

You can enter an optional discount percentage or discount amount   for the entire document, or enter 
discounts for individual detail lines.

If you enter a discount for the entire document, Purchase Orders   prorates the discount amount for 
the document details, overriding any discounts   you may have entered manually for the details.

Number of Labels

Enter the number of labels you want to print for the purchase order, such as to paste on envelopes 
you are mailing to the vendor.

The number of labels you specify is printed by the P/O Mailing Labels screen when you print labels 
for the purchase order.

Number of Lines

This field displays the number of detail lines you entered on the purchase order.

Check this number against source documents to make sure you entered all details for the purchase 
order.

Order Subtotal

This field displays the total of all detail costs entered for the purchase   order, including tax-included 
amounts. This subtotal does not include   tax amounts that are included in item costs.
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Plus Excluded Tax

This field displays the total excluded tax amount of all details on   the purchase order. This amount 
does not include taxes that are included   in item costs.

Tax Included

This field displays the total amount of tax included in item costs for the authority.

You use the Tax Services screens to specify whether a tax authority allows tax-included costs in 
item prices.

Total 

This field displays the total of all item costs and taxes for the purchase order.

Total Reverse Charges

The total of Reverse Charges Amounts for the document.

Total Weight

This field displays the total estimated weight of the purchase order, calculated from the weight you 
enter for each item detail.

Use this amount to estimate shipping charges for the order.

P/O Vendor Information Screen   

To Open this Screen

On a Purchase Orders transaction entry screen, click the Zoom  button beside the Vendor 
Number field.

Overview

Use the Vendor Information screen to specify:

 l A name for a new vendor number that is not yet added to Accounts Payable. 

 l The vendor's address, phone numbers, and contact name.
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Fields and Controls

Address

Enter the address for the vendor.

Contact

Enter the name of a contact person, department, or position.

Fax

Enter the vendor's fax number.

Phone

Enter the vendor's telephone number.

Vendor Name

If you specify a vendor number that has not yet been added in Accounts Payable, you can use this 
field to enter the new vendor's name. Otherwise, this field displays the name for the selected vendor, 
and cannot be edited.

Note: The vendor name appears beside the vendor number on transaction screens.

Vendor Number 

Identifies the vendor from whom you received the document. The vendor number sets the default 
tax group and payment terms. In multicurrency systems, the vendor number also specifies the 
currency of the document.

P/O Purchase Order Entry Bill-To Location Screen

To Open this Screen

 1. Open Purchase Orders > P/O Transactions >  Purchase Order Entry.

 2. Click the Zoom  button beside the Bill-To Location field, or press       the F9 key in the field.
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Overview   

Use the Bill-To Location screen to edit an existing bill-to location address, or to type    a new billing 
address for the purchase order.

You do not have to enter a bill-to location code or address information.

Fields and Controls

Address

Use the Address field to type the address for the location, or edit the displayed information   if 
necessary.

Bill-To Location 

If you use Inventory Control and you selected a bill-to location code,   the program displays the 
location code.

If you do not use Inventory Control, you can click the Zoom  button beside the field name.

Enter the bill-to location information by typing   in the screen that appears.

Contact

Enter the name of a contact person, department, or position.

Description

Use the Description field to type a description of the location, such as a company name, or edit   a 
displayed description if necessary. You do not have to include a description.

E-mail

Use the E-mail field to type the e-mail address for the location, or edit the displayed address   if 
necessary.

Fax Number

Use the Fax Number field to type the fax number for the location or edit a displayed number if 
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necessary.

Phone Number

Use the Phone Number field to type the telephone number for the location or edit a displayed 
number   if necessary.

P/O Purchase Order Entry Ship-To Location Screen

To Open this Screen

 1. Open Purchase Orders >       P/O Transactions >       Purchase Order Entry.

 2. Click theZoom  button beside the Ship-To Location field, or press       the F9 key in the field.

Overview   

Use the Ship-To Location screen to edit an existing ship-to location address or to enter    a new ship-to 
address for the purchase order. If you select an Inventory     Control location code, the code appears as 
the default location code for    the purchase order detail lines.

Fields and Controls

Address

Type the address for the location where goods are to be shipped, or edit the displayed information   if 
necessary.

Contact

Type the name of a contact person, department, or position at the ship-to   location, and enter a 
phone number, fax number, and e-mail address if   appropriate (or edit the displayed contact).

Description

Type a description of the location, such as a company name, or edit   displayed information if 
necessary.
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Fax Number

Type the fax number for the location, or edit displayed number if necessary.

Phone Number

Type the phone number for the location, or edit displayed number if necessary.

Ship-To Location (display only)                     

The program displays the code for the specified ship-to location, if any.

P/O Create PO From Requisition Screen

To Open this Screen

 1. Open Purchase Orders >        P/O Transactions >         Purchase Order Entry.

 2. Click the Zoom   button beside the From Requisition Number field, or tab to the field and 
then press the F9 key.

Overview   

Use this screen to:

 l Select a requisition from which to create a purchase order.

 l Select several requisitions from which to create a single purchase order.

Using requisitions is optional. You can create purchase orders without requisition numbers.

To use the From Requisition Number field:

 1. Click the Zoom button beside the From Requisition Number field, or tab to the field, then press      
the F9 key.

 2. Type the requisition number to use or select it from the Finder.

 3. Choose whether to select requisition details with no vendor numbers for your purchase order.

 4. If you are including details with blank vendor numbers, choose the vendor type (optional).

 5. Choose other requisition numbers, if applicable.
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Note: When you create a purchase order from more than one requisition, the fields on the 
Optional Fields tab will be taken from the first requisition that    you select.

 6. When ready, choose the Order button. Yes appears in the Ordered column for each requisition 
and the session (sign-on) date appears in the Date Ordered column.

 7. Choose Close to close the screen.

Use the following buttons to:

 l Order.To select the specified requisition details, insert Yes in the Ordered column for each 
requisition, and insert the session (sign-on) date in the Date Ordered column.

 l Close.To close the Create PO From Requisition screen.

Fields and Controls

Requisition Number

Type the requisition number from which you want to create a purchase   order, or select it from the 
Finder.

You can select more than one requisition number for the purchase order.

Note: When   you create a purchase order from more than one requisition, the fields   on the 
Optional Fields tab will be taken from the first requisition that   you select.

Use Blank Vendors

Choose this option to add requisition details with no vendor numbers   to the purchase order.

Use I/C Vendors

Choose this option to add requisition details without vendor numbers   to the purchase order if the 
purchase order vendor is assigned as the   specified vendor type in the Inventory Control item 
records.

Ordered (display only)

When you press the Order button, Purchase Orders inserts Yes in this   field, to indicate that the 
requisition details have been added to the   purchase order.
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Date Ordered (display only)

Choose this option to add requisition details with no vendor numbers   to the purchase order.

P/O Purchase Order Entry Detail Items/Taxes Screen   

To Open this Screen

 1. Open Purchase Orders > P/O Transactions > Purchase Order Entry.

 2. Enter header information for a new purchase order, or select an existing purchase order.

 3. Select a detail line, and then press F9 or click Item/Tax.

Overview

The Detail Items/Taxes screen displays all the fields for a single detail, rather than rows of data for all 
the details of an order. The screen also displays additional tax information for the detail that doesn't 
appear on the detail-entry grid.

Use this screen to add, edit, and delete purchase order detail lines.

Fields and Controls

Buttons

Add

Use the Add button to add a new detail you entered in the Detail Items/Taxes window.

Calc. Taxes

Click the Calc. Taxes button to see tax amounts for   a detail before you post the document. 

Note: Tax amounts are not   calculated automatically until you click the Taxes tab or the Totals tab, 
or you post the purchase order.

Delete

Use the Delete button to delete the detail displayed in the Detail Items/Taxes window.
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Save

Use the Save button to save the changes you made to a detail you edited in the Detail Items/Taxes 
screen.

Allocated Tax

This field displays the total amount of tax allocated to the cost of the item.

Comments/Instructions

Type a comment about the item or detail, up to 75 characters.

To open the Detail Comments/Instructions window, do one of the following:

 l Click the Zoom  button to the right of this option.

 l Select the option, and then press Shift+F9.

Completed

Indicates whether the ordered items are outstanding or have all been received   or canceled.

You can specify that a line is completed when you add it, but you would   not then be able to edit the 
line. You normally complete lines by posting   receipts that automatically complete lines when the full 
quantity is received.

You manually select Completed status for a detail when you want to cancel   remaining units. You 
must also enter zero in the Quantity Outstanding   field before posting. Alternatively, if you enter zero 
as the Quantity   Outstanding, the Completed status is changed to Yes. 

When a purchase order detail line is complete, it is omitted from the purchase   order details you see 
when you apply a receipt to the purchase order number.

Contract, Project and Category

 For job-related purchase orders, you use these fields to enter information for the related job in 
Project   and Job Costing.

Note: If   you use different terms than "Contract," "Project,"   and "Category" in Project and Job 
Costing, the program displays   them instead. For more information, see "About Job-Related 
Transaction Details  " (page 179).
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Discount %

You can enter a discount as a percentage or an amount. The program uses the amount you enter in 
this field to calculate the   discounted cost for the item detail. 

If you enter a percentage in this field, Purchase Orders calculates   the discount amount for the item 
detail.

Tip: If you prefer not to enter discounts for individual details, you can   enter a discount percentage 
for the entire document on the Totals tab. Purchase   Orders then prorates the discount amount for 
the transaction details,   overriding any discounts you may have entered manually for the details.

Discount   Amount

You can enter a discount as a percentage or an amount. The program uses the amount you enter in 
this field to calculate the   discounted cost for the item detail. 

If you enter a discount amount,   the program calculates and displays the discount percentage based 
on the   cost. (Alternatively, you can enter a percentage in the Discount   Percent field, and let the 
program calculate the discount amount.)

Tip: If you prefer not to enter discounts for individual details, you can   enter a discount amount for 
the entire document on the Totals tab. Purchase   Orders then prorates the discount amount for the 
transaction details,   overriding any discounts you may have entered manually for the details.

Drop-Ship

Indicates whether the goods are to be shipped to a different address, such as to your customer's 
address, or shipped to another location from the location specified for the detail line (if you use 
Inventory Control) or for the order (if you do not use Inventory Control).

To open the Drop-Shipment Address window, do one of the following:

 l Click the Zoom  button to the right of this option.

 l Select the option, and then press Shift+F9.

Note: If you use Accounts Receivable, you can select a customer's   address or ship-to location for 
a drop shipment.
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Expected Arrival Date

The date you expect   to receive the item.

Extended Cost

The quantity outstanding multiplied by the unit cost.

Purchase Orders calculates the extended cost, but you can change it.   If you change the amount, the 
unit cost is recalculated accordingly.

Extended costs are not displayed if item costs are password-protected   in Inventory Control, unless 
you type in a unit cost for the detail.

Extended Weight

The quantity ordered multiplied by the unit weight you entered for the detail.

General Ledger Expense Account

This is the general ledger account number to which you post the expense of non-inventory items (if 

your system allows non-inventory items). You can select the account number using the Finder  

for the field.

The default account number comes from the Purchase Orders G/L Integration screen.

Item Number 

Type the number of the item you are ordering, or select it from the Finder.

Note: The field to the right displays the description for the item for existing Inventory Control item 
numbers. For non-inventory items, you can enter a description.

You can enter a non-stock item, if Inventory Control permits them. If your Purchase Orders system 
allows non-inventory items, you can also enter item numbers that are not defined in Inventory 
Control.

If manufacturer's item numbers or bar codes have been added in Inventory Control, you can enter 
them in most item   number fields. These numbers could include internally-used bar codes, UPC 
numbers,   or ISBNs - letting you use a scanner (or type a short code) for entering   inventory item 
numbers.
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The program inserts the correct item number, and—on transaction detail lines  —inserts the 
manufacturer's   item number in the manufacturer's item number field at the end of the   line.

Line Number

This field indicates the line number of the selected detail.

You can select a different detail using the navigation buttons, or by entering the line number. You 

can also create a new detail by clicking the New  button.

Tip: To delete the line you selected, click the Delete button. Click Yes   if a message appears 
asking you to confirm the deletion. You cannot delete   completed lines.

Location

This field appears only if you use Inventory   Control.

Enter the code for the location where you expect to receive the shipment   (or to which you want to 
post drop-shipped items). 

The program displays the ship-to location code, if any, entered on the   first tab, but you can select a 
different location. You can omit the location   when adding details for non-inventory items.

Note: If you change  locations after assigning serial and/or lot numbers, you must re-assign the 
serial and/or lot numbers.

Non-Stock Clearing Account

This is the general ledger account number that you debit when you receive   non-stock items and 
credit when you ship them.

You can use non-stock items to handle specially ordered items which   you do not stock in your 
inventory, and to handle service charges that   appear on invoices.

You specify the default account numbers for non-stock items in the I/C   Account Sets window in 
Inventory Control.

Optional Fields

If optional fields have been defined for purchase orders details , you can click the Zoom  button 

beside the Optional Fields field to display the optional fields assigned to a selected detail, and edit 
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their contents.

For more information about using optional fields in transactions, see "About Optional Fields in 
Transactions" (page 80). 

Manufacturer's Item Number 

A manufacturer's item number is another number or code that you use   for an inventory item—such 
as a UPC code, an internally-used bar code,   a particular part number used by the manufacturer,   or a 
shortcut code for commonly used inventory items.

Manufacturers' item numbers must be set up in the Inventory Control   program.

If you enter a manufacturer's item number in the Item Number field of   a transaction detail line, 
Purchase Orders will replace the manufacturer's   item number with your inventory item number, and 
insert the manufacturer's   item number in this field. 

Order Number

A sales order number of up to 22 characters.

If you use Order Entry with Purchase Orders, you can select   active Order Entry order numbers from 
a Finder, and you can automatically   create purchase orders that contain order numbers, using the 
Create POs   From O/E window. If you use the option to Allow Receipt Of Non-stock Items in Inventory   
Control, you can also accept non-stock items from Order Entry.

You can enter sales order numbers with purchase order details for your   own information.

Quantity Ordered

The number of units ordered.

If you use the Allow Fractional Quantities option in Inventory Control,   you can order items in fractions 
of units. 

When editing a purchase order, you can increase or decrease the quantity   for item details that are 
not yet fully received or canceled.

If you have selected the option to Allow Receipt Of Non-stock Items in Inventory   Control, you can 
enter details for them in Purchase Orders.

Quantity Outstanding

The number of item units that you have not yet received or canceled.
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This field is updated when you post receipts for the purchase order   and detail line. You can edit the 
outstanding quantity yourself, such   as to cancel outstanding units. 

Quantity Received

The quantity of each detail that has been received (this number is updated when you post receipts   
for the detail).

Reverse Chargeable

Indicates if the tax amount owed to a tax authority for a detail may become a reverse charge.

A reverse chargeable tax amount will not necessarily become a reverse charge. Tax amounts 
become reverse charges only if the Reverse Charges Base for the tax authority to which the tax 
amounts are owed (shown on the Taxes tab) is above the reverse charges threshold amount for the 
tax authority. For more information about threshold amounts, see the Tax Services help.

Unit Cost

Displays the unit cost from the item record. You can edit the cost in this field.

If you use Inventory Control, the type of cost that is displayed is determined by the selection for the 
Default Item Cost option on the I/C Options screen.   You can select a different cost type for a detail 
line on a purchase order.   Cost amounts are displayed with six decimal places.

If you do not use Inventory Control, the default item cost is the vendor   cost and you will not be able to 
use the Finder to select a different   type of cost. 

If item costs are password-protected in Inventory Control, users entering   purchase orders will see 
zeroes as the costs of items, and costs in Finders   for the Unit Cost and Extended Cost fields will be 
zero, but you can still   enter a cost for the detail. 

Note: For multicurrency ledgers, although   costs are maintained in functional currency in Inventory 
Control, the   costs in Finders and unit costs in detail lines are displayed in the vendor's   currency.

Unit Of Measure

The unit of measure for the quantity being ordered.

The stocking unit for the item is displayed by default, but you can   select any other unit of measure 
that is assigned in the item record.
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If you use the Finder to select another unit of measure, the conversion factor for that unit of measure 
appears in the Finder screen. (The conversion   factor is the number of stocking units contained in the 
alternative unit.   For example, if you use a stocking unit of "each," and "carton"   has a conversion 
factor of 36, it takes 36 stocking units to equal one   carton.)

Unit Weight

The weight of one unit of the item, in the unit of measure you specified   for the detail.

Vendor Item Number

The code or number used by   the vendor to identify the ordered item.

Tax Amount 

The amount of tax that   is included in the extended item cost. (Tax amounts are not displayed   until 
you click the Calc. Taxes button or the Totals tab, or you post   the purchase order.)

Tax Base 

The net cost of items   with tax included in their prices.

P/O Purchase Order Entry Drop-Shipment Address Screen

To Open this Screen

 1. Open Purchase Orders > P/O Transactions >  Purchase Order Entry.

 2. On the Details table, for a selected detail line, click in the Drop-Ship field, then click the Zoom 

 button   (or press the Shift and F9 keys at the same time).

Overview   

Use this screen to enter or edit address information for a detail if you want the vendor to ship items 
directly to a different address than the inventory     location specified in the    Location field.

To enter a drop-shipment address:

 1. In the Drop-Shipment     Address screen, select the type of address to enter.

 2. Select     the location code, customer number, or ship-to location code for the address, as 
needed.
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 3. Type the address, or edit the     displayed information.

 4. ClickClose.

To edit drop-shipment addresses:

 1. Make any changes you need in the Drop-Shipment     Address screen.       You can change all the 
information in the screen, including the type of      address.

 2. When finished, click Close.

To delete drop-shipment addresses:

Change the entry in the Drop-Ship field to No on the detail entry grid,     or clear the Drop-Ship option on 
the Detail Items/Taxes screen.

Fields and Controls

Address

Type the address information for the drop shipment, or accept the displayed   information.

If you are creating a purchase order from a requisition, the program   displays any information 
entered with the drop-shipment address on the   requisition, but you can change it.

Contact

Type the name of the contact person or position at the drop-shipment   address, and enter a phone 
number, fax number, and e-mail address if appropriate.

If you are creating a purchase order from a requisition, the program   displays the contact, if any, 
entered with the drop-shipment address on   the requisition, but you can change it.

Customer Number

To ship an order to a customer from your Accounts Receivable database,   type the customer number 
or select it from the Finder.

When you enter a customer number, the address and other information   entered for the customer in 
Accounts Receivable is displayed, but you   can change it.

If you are creating a purchase order from a requisition, the program   displays the customer number, 
if any, entered with the drop-shipment address   on the requisition.
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Customer Ship-to Location

Type the code for the customer's ship-to location, if any, to which   the item will be drop-shipped, or 
select the location from the Finder.   You can enter a ship-to location only if you have defined ship-to 
locations in   Accounts Receivable for the customer.

When you enter a ship-to location code, the address and other information   entered for the location is 
displayed but you can change it.

If you are creating a purchase order from a requisition, the program   displays the customer ship-to 
code, if any, entered with the drop-shipment   address on the requisition.

Description

Type the name of the person or a description of the location to receive   the drop-shipment.

If you are creating a purchase order from a requisition, the program   displays the description, if any, 
entered with the drop-shipment address   on the requisition but you can change it.

E-mail

Type the e-mail address for the location, or edit the displayed address   if necessary.

Fax Number

Type the fax number at the location where the drop-shipment will be   received.

If you are creating a purchase order from a requisition, the program   displays the fax number, if any, 
entered with the drop-shipment address   on the requisition, but you can change it.

Location Code

To send the shipment to an inventory location (other than the location   specified for the detail line), 
type the location code or select it from   the Finder. When you enter a location code, the address and 
other information   entered for the location in Inventory Control is displayed, but you can   change it.

If you are creating a purchase order from a requisition, the program   displays the location code, if 
any, entered with the drop-shipment address   on the requisition.

Phone Number

Type the phone number at the location where the drop-shipment will be   received, or make any 
changes you need to a displayed number.
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Set Drop Shipment Address To

Specify the type of drop-shipment address you are entering. You can   select:

 l Address Entered—  select this option when you want to type the address information for the   
shipment.

 l Inventory Location Address—select this option when you   want to drop-ship the items to an 
Inventory Control location.

 l Customer Address—  select this option when you want to drop-ship the items to the address   of 
one of your Accounts Receivable customers.

 l Customer Ship-To Address—select this option when you   want to drop-ship the items to one 
of the ship-to addresses defined for   the customer in Accounts Receivable customers.

P/O Purchase Order Entry Detail Comments/Instructions Screen

To Open this Screen

 1. Open Purchase Orders > P/O Transactions >  Purchase Order Entry.

 2. On the Order tab, click the Comments/Instructionsfield for the detail line you need.

 3. Click the Zoom  button or press the Shift and F9 keys to open the Detail Comments screen.

Use this screen to type comments or instructions for a selected order detail    line. You    can print the 
remarks on the purchase order.

Note: You can enter both comments and instructions for a detail line. 

To enter or edit a comment or instruction:

 1. In the Type field, select Comment or Instruction.

 2. In the space provided, type the comment or instruction, pressing Enter to start each new line.

 3. When finished, click Close to close the screen.

To delete comments or instructions:

 1. Highlight the text to       delete, then press the Delete key. If a message appears      asking you to 
confirm the deletion, click Yes.

 2. When finished, click Close      to return to detail entry.
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Tip: You can also delete comments or instructions by changing the entry in     
theComments/Instructions field to No on the Order tab. If you use this method, your remarks are 
not deleted, but they     are not printed on the purchase order. If you decide     to use the remarks later , 
change the Comments/Instructions field to Yes. Your original remarks will reappear.     

You can also add or clear comments on the Detail Items/Taxes screen. 
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P/O Receipt Entry Screen

To Open this Screen

Open Purchase Orders > P/O Transactions > Receipt Entry.

Secondary Screens

 l "    P/O Fixed Assets Screen" (page 636)

 l "P/O Receipt Entry Additional Cost Vendor Information Screen" (page 645)

 l "P/O Receipt Entry Additional Cost Vendor Taxes Screen" (page 647)

 l "P/O Receipt Entry Bill-To Location Screen" (page 611)

 l "P/O Receipt Entry Detail Comments Screen" (page 637)

 l "P/O Receipt Entry Detail Costs/Taxes Screen" (page 638)

 l "P/O Receipt Entry Detail Items/Taxes Screen" (page 617)

 l "P/O Receipt Entry Drop-Shipment Address Screen" (page 614)

 l "P/O Receipt Entry Invoice Screen" (page 648)

 l "P/O Receipt Entry Ship-To Location Screen" (page 612)

 l "P/O Vendor Information Screen   " (page 543)

Related Tasks

 l "    Adding or Editing Details Using the Detail Items/Taxes Screen" (page 138)

 l "Entering Receipts" (page 134)

 l "Printing Receiving Slips" (page 224)

 l "Receiving and Invoicing Serialized Items   " (page 187)

 l "Receiving and Invoicing Lotted Items" (page 189)

Overview   

Use the Receipt Entry screen to:
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 l Enter receipts of goods into Purchase Orders—for   inventory or non-inventory items.

 l Edit existing receipts.

 l Enter or change the vendor address information.

 l Enter additional costs for receipts (from primary or secondary vendors).

 l Invoice receipts and additional costs.

 l Identify items as fixed assets for management by Sage Fixed Assets.

 l Specify drop-ship addresses   for receipt details.

 l Check and edit tax distributions   by detail line and for the primary and secondary vendors.

 l Import and export receipts.

 l Assign serial numbers   to serialized items (if you use Serialized Inventory and Lot Tracking).

 l Assign lot numbers to   lotted items  (if you use Serialized Inventory and Lot Tracking).

Integration with Sage Fixed Assets

If you use Sage Fixed Assets to manage the fixed assets   in your company, you can also mark 
received goods as fixed assets, and   select the Sage Fixed Assets template that you want to use for 
the new asset. Sage 300transfers the asset information to Sage Fixed Assets when you run Create   
Assets in Sage Fixed Assets Integration.

Use the P/O Fixed Assets screen to enter information for fixed assets. For more information, see "    
P/O Fixed Assets Screen" (page 636).

Additional Costs Tab

Use the Additional Costs tab to:

 l Add additional costs charged on the shipment by both primary vendors   and secondary 
vendors, such as for handling charges, service charges, and duty. Mo re ...

To   display additional costs you have entered for a vendor, use the navigation buttons beside 
the Additional Cost Vendors field or enter the vendor number in the Vendor Number field. 

 l Edit additional-cost amounts on previously posted receipts that are not yet fully invoiced.

 l Assign or edit the terms code and tax group for the additional cost vendor.

 l Check the number of details and the total amount of additional costs entered for the vendor.

 l In multicurrency ledgers, edit exchange rate information for vendors who do not use the 
functional currency.

 l Specify how to reallocate prorated costs of received items that you return.
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 l Open the Vendor Information screen to view information for secondary vendors. Mo re ...

To open   the Vendor Information  , click the   Vendor Number field, and then click the Zoom  

button or press the F9 key.

 l Open the Additional Cost Vendor Taxes screen to check and edit tax information for   the 
vendor. Mo re ...

To open the Additional Cost Vendor Taxes screen, click the Vendor Taxes   button.

For more information, see "P/O Receipt Entry Additional Cost Vendor Taxes Screen" (page 
647).

 l Open the Detail   Costs/Taxes screen to check and edit tax information for   the detail. Mo re ...

To open   the Detail   Costs/Taxes screen, select an additional cost   detail, and then click the 
Cost/Tax button or press the F9 key .

For more information, see "P/O Receipt Entry Detail Costs/Taxes Screen" (page 638).

Individual additional costs appear in the details table on the tab. Totals for the selected vendor are 
displayed at the bottom of the Additional Costs tab.

Non-inventory Items

If you are adding additional costs for non-inventory items, you must choose No Proration. If you 
choose to prorate by quantity, cost, or weight, the program will display an error message and prevent 
you from posting the receipt.

For step-by-step instructions on using the Additional Costs tab, see "Adding, Editing, or Deleting 
Additional Costs" (page 139).

Optional Fields Tab

Note: This tab appears only if you have Transaction Analysis and Optional Field Creator, and 
receipt optional fields have been assigned to the Requisition Entry screen using the Optional Fields 
setup screen.

Use the Optional Fields tab to add or change information in the optional fields that apply to the 
transaction as a whole. You edit optional fields for requisition details, separately, on the detail entry 
table or using the Item Details screen.

For more information about using optional fields in transactions, see "About Optional Fields in 
Transactions" (page 80).
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For information about defining optional fields for the Receipt Entry   screen, see the "P/O Optional 
Fields Screen  " (page 340).

Receipt Tab       

Use the Receipt tab to enter:

 l A name for new vendor accounts that are not yet added to Accounts Payable.

 l The vendor's address, phone numbers, and contact name on the Vendor Information screen.

 l The code that identifies the vendor's payment terms for the receipt.

 l An optional template code to specify the default entries in receipt header and vendor 
information fields.

 l The receipt date.

 l An optional FOB (free-on-board) location.

 l An optional shipping method or carrier.

 l The default shipping and billing location codes for the receipt.

 l An optional description and reference.

Use the detail information section of the Receipt tab to:

 l Add item detail lines to the receipt.

 l Edit or delete existing detail lines.

 l Specify received quantities and discounts. If you use Project and Job costing, use the same 
unit of measure that is on the estimate. (For more information, see "About Converting Units of 
Measure for Committed and Actual Quantities" (page 181).)

 l Enter additional receipt   information using comments fields and optional fields.

 l Identify items as fixed   assets for management by Sage Fixed Assets.

 l Open the Detail Items/Taxes screen where you can view all the fields for a selected detail at 
once. This screen also lets you change   tax information for the detail.

Retainage Tab        

Note: This tab appear only if the receipt is job-related and you use   retainage accounting.

Use the Retainage tab to specify the retainage rate and retainage terms for the current receipt.

You enter job-related retainage amounts, retention periods, and retainage   due dates with each job 
detail. 
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Rates Tab        

Note: This tab appears only in multicurrency ledgers when you enter   a receipt for a primary vendor 
who does not use the functional currency. For more information, see "About Vendors" (page 81).

Use the Rates tab to:

 l Change the rate type,   rate date, and exchange rate for converting the receipt amount from the   
vendor's currency to your functional (home) currency.

 l Look up the rate information   entered with the purchase order (if you are entering a receipt to a 
purchase   order).

Taxes Tab       

Use the Taxes tab to specify:

 l The vendor's tax group.

 l Tax classes for each tax   authority.

 l Tax-included options and   amounts for the vendor's tax authorities

Click the Calculate Taxes button to cancel changes you made to tax amounts   and reinsert the taxes 
originally calculated for the receipt by the program.

Totals Tab       

Use Totals tab to:

 l Enter comments for a receipt.

 l Enter a discount percentage   or a total discount amount for the receipt. 

 l Verify receipt totals   for the primary vendor. For more information, see "About Vendors" (page 
81).

 l Check tax amounts for   the primary vendor.

 l Check manual proration   amounts to be sure you have fully allocated all manually prorated   
charges for the receipt. For more information, see "About Manually Prorated Amounts" (page 
134).

 l Check the estimated weight   of the goods on the receipt.

 l Check the number of item   and additional cost details entered for the vendor on the receipt.

 l Check the receipt subtotal   and total additional costs and excluded taxes for the primary vendor. 
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Fields and Controls

Buttons

Calculate Taxes

Use the Calculate Taxes button to recalculate tax amounts after you change the Tax Class or Tax 
Included field. (Tax amounts are not automatically calculated until you choose Post for the invoice or 
select the Totals tab.)

New

Click the New button to begin creating a new record.

Post

Use the Post button to post the document or to post changes you have made to existing documents.

Note: You cannot edit receipts after posting them.

Receive All

Use the Receive All button to add to the Receipt Entry screen all the detail lines from the specified 
purchase orders.

Note: If working with serialized or lotted items, you cannot use the Receive All button. You must 
assign serial and lot numbers manually.

Entered By

If the transaction was entered manually in Purchase Orders, the field displays the user ID of the 
person who entered the transaction.

Receipt Number

You can enter a unique number in this field for a new receipt, using up to 22 characters.
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Tip: Leave the field showing ***NEW*** to let Purchase Orders assign the receipt number during 
posting.

To display an existing receipt, type its number, or use the Finder or the navigation buttons beside 
the Receipt Number field to select it.

Vendor Number

Identifies the vendor from whom you received the goods. The vendor number   sets the default tax 
group and payment terms. In multicurrency systems,   the vendor number also specifies the currency 
of the document.

 l To select an existing   vendor, use the Finder, or type the number and press Tab.

 l To add a new vendor, do   one of the following:

 l To add   the vendor record now, click the New button after   typing the vendor number. 
After you fill in the vendor information in Accounts Payable,   click Add, then click Close 
to return to Purchase Orders.

 l If you do not want   to add the vendor record now, type only the vendor number. 
However, you must create the vendor record before you can post an invoice in 
Accounts Payable.

Warning! Although   you can add a receipt before you add the vendor record in Accounts Payable,   
you should not do so in a multicurrency system. If the tax reporting currency for the tax group that   
you want to use differs from the vendor’s currency, you must create the   vendor record before you 
enter the invoice.

If a vendor account is inactive, you cannot enter a receipt for the   vendor. 

Additional Costs Tab

Additional Cost Vendors

This field lets you use navigation buttons or the Finder to select an   additional cost vendor that you 
have added to a receipt. As you scroll   through the list of existing vendors, Purchase Orders displays 
the vendor   number and the additional cost details you entered on the tab. 

The field also lets you clear displayed information from the tab so   that you can enter a new 

additional cost. (To begin a new additional cost,   click the New  button  next to the Additional Cost 

Vendors field.)
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Cost Subtotal (display only)                             

The sum of the additional costs before excluded taxes entered on this   receipt for the selected 
vendor.

Currency (multicurrency ledgers, display only)                             

The program displays the vendor's currency (the currency associated   with the vendor's tax group). 
When you are adding a new vendor, the program   displays the code for the functional currency until 
you select the tax   group, then the currency for the tax group is displayed.

Exchange Rate (multicurrency ledgers)                             

The program displays the exchange rate currently in effect for the specified   currency and the 
displayed rate type and rate date, but you can change the   rate.

You receive a warning if you change an exchange rate by an amount that exceeds   the Spread 
setting for the currency in Common Services' Currency Rates table.

Included Tax 

The sum of the taxes that are included in the additional costs entered   on this receipt for the selected 
vendor.

Less Retainage 

The Less Retainage and Net Costs Total fields appear with the additional costs summary at the 
bottom   of the screen if you choose the Retainage option on the Additional Costs   tab.

The program will also display additional retainage fields for each additional   cost detail to let you 
enter a different retainage percentage (or amount)   and period for each additional cost.

Net Costs Total 

The Less Retainage and Net Costs Total fields appear with the additional costs summary at the 
bottom   of the screen if you choose the Retainage option on the Additional Costs   tab.

The program will also display additional retainage fields for each additional   cost detail to let you 
enter a different retainage percentage (or amount)   and period for each additional cost.

Number of Costs 

The number of additional cost detail lines entered for the selected   secondary vendor.
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Optional Fields Plus Excluded Tax (display only)                             

The program displays the total amount of additional cost details for   the primary vendor on the 
receipt, excluding taxes (except taxes that   are included in the cost amounts).

Rate Date (multicurrency ledgers)                             

Type the date to use to select the exchange rate for the additional cost.

The program displays the rate date that is nearest the document date you entered, but you can 
specify a different date for which an exchange rate exists for the currency in Common Services' 
Currency Rates table.

If you change the rate date, Purchase Orders checks the rate tables for a date match, and updates 
the rate if necessary. 

Rate Type (multicurrency ledgers)                             

If the rate type you want to use is not displayed, type the code or   choose it from the Finder.

The program uses rate types when converting multicurrency amounts on the receipt to functional 
currency. Examples of rate types might be "spot rate," "average rate," and "contract rate."

You define rate types using the Currency Rate Types screen in Common Services, and assign the 
default rate type for Purchase Orders on the Processing tab of the P/O Options screen.

Retainage Percentage and Period (job-related)                             

If the retainage option is selected for the receipt and for the additional   cost, the program displays 
additional retainage fields for each additional   cost detail line. If you select No Proration, you can 
enter a   retainage percentage and period.

Note: You can edit these  fields for secondary vendors, but not for the primary vendor.

Default Retainage Percentage and Period

The default retainage percentage and retention period that appears in   these fields depends on how 
you are prorating the costs.

 l If prorating by cost,   quantity or prorating manually, the settings are based on the Vendor 
record.

 l If using no proration,   the retainage settings are based on the Default Retainage From option   
for the contract in Project and Job Costing.
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Tax Group and description

For new vendors, type the code for the tax group to use or select the   code from the Finder. For 
existing vendors, the tax group is displayed,   but you can change it.

Terms Code and description

For new vendors, type the terms code that represents the vendor's payment   terms for the additional 
cost, or select the code from the Finder. 

For existing vendors, the program displays the vendor's terms code,   but you can change it to 
another terms code that is defined in Accounts   Payable.

Total Costs 

The sum of the additional costs plus taxes entered on this receipt for   the selected vendor.

Vendor Account Set

The account set from the vendor record appears in this field as the   default. It specifies the general 
ledger payables   control, purchase discounts, prepayment, and retainage accounts to which   the 
transaction will be distributed.

You can change the account set for a particular purchase order, receipt,   return, invoice, credit note, 
or debit note. If you use   multicurrency accounting, however, the new account set must use the same   
currency as the vendor's account set.

Note: If you change the account set on a receipt, make sure that you use the   same account set 
for returns, invoices, and credit or debit notes.

Vendor Number and Name

If you used the buttons beside the Additional Cost Vendors   field to select an additional cost vendor 
that you have already added to this receipt, the program displays the selected vendor number in this 
field.

You can always add an additional cost vendor to a receipt for which you have not yet created an 
invoice. You can use the Finder to select a vendor that exists in Accounts Payable, or you can add a 
new additional cost vendor.

For information about adding a new secondary vendor to a receipt, see "    Adding a New Secondary 
Vendor to a Receipt" (page 617).
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Additional Cost details table

Additional Cost                                      

Type the code for the additional cost you want to add, or select the   code from the Finder. 

If you are adding a cost for which no code is defined,   skip this field and type the name of the cost in 
the Description field   (the field beside the Additional Cost field in the Detail Cost/Taxes   screen).

Note: You use the Additional Costs screen (in the P/O Setup folder) to maintain  the additional 
cost charges you use in Purchase Orders.

Amount

Enter the amount of the additional cost in this field.

Billing Currency (if job-related and multicurrency, display only)                                     

This field appears only in multicurrency systems for time and materials   projects and for fixed price 
projects using billings and costs or accrual-basis   accounting methods. 

The billing currency is the customer's currency specified on the contract,   and you cannot change it.

Note: 
 l Billing currency is blank   for Fixed Price projects using completed project or project 

percentage   complete methods, and for Cost Plus projects.

 l Billing currency is NOT displayed for basic or standard internal Time and Materials projects 
or for Fixed Price projects that use billings and costs or accrual-basis accounting methods.

Billing Type, Billing Rate, and A/R Item Number (if job-related)                                     

For job-related additional costs on receipts, you also specify the Billing   Type, Billing Rate, AR Item 
Number, and AR Item UOM that will be used   for the customer invoice.

The following fields appear only for job-related receipts.

AR Item Number

The program displays the A/R item number associated with the category   or Item Number/Resource 
used for the contract in Project and Job Costing. You can select a different A/R item number only for 
time and materials   projects, as follows: 
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 l On a standard project,   the program displays the A/R item number and unit of measure 
specified   for the project resource category as the default. You can accept the item   number or 
select another valid A/R item number. 

 l On a basic project, program   displays the A/R item number and unit of measure specified for 
the project   category. You can accept the item number or select another valid A/R item   
number. 

 l If you change the A/R   item number, the item number must be a valid item number in 
Accounts Receivable,   and the unit of measure must be a valid unit of measure both for the 
new   item number and the vendor’s currency.

Cost plus and fixed price projects do not use an A/R item number. Internal   contracts for time and 
materials projects also do not use an AR Item Number.

AR Item UOM

This field appears for Time and Materials projects if you selected the   Job Related option for this 
transaction.

You must enter a unit of measure that is valid for the category or item   number/resource that you 
specified and for the contract customer's currency.

Note: For internal time and materials projects (basic or standard   contracts) the A/R item unit of 
measure will be disabled/blank.

Billing Currency

This field appears only in multicurrency systems for time and materials   projects and for fixed price 
projects using billings and costs or accrual-basis   accounting methods.

The billing currency is the customer's currency specified on the contract,   and you cannot change it.

Note: Billing currency is blank   for Fixed Price projects using completed project or project 
percentage   complete methods, and for Cost Plus projects. It is NOT displayed for basic or 
standard internal   Time and Materials projects or for Fixed Price projects that use billings   and 
costs or accrual-basis accounting methods.

Billing Rate

Purchase Orders displays the billing rate for the specified resource   (for standard projects) or 
category (for basic projects). 

You can edit the billing rate if the billing type is Billable. The field will display 0.000000 if the billing 
type is Non-Billable or No Charge.
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Note that:

 l Billing rate can be specified   for Time and Materials projects and for Fixed Price projects that 
use   Billings and Costs or Accrual-Basis accounting methods. Billing rate is disabled   and set to 
0.000000 on a basic or standard internal contract for Time   and Materials projects or for Fixed 
Price projects using billings and   costs or accrual-basis accounting methods. It cannot   be 
negative.

 l If a job-related additional   cost is prorated by cost, quantity, or weight, the specified billing rate   
in functional currency will be prorated to the item details for projects   that are Time and 
Materials or Fixed Price with an accounting method of   billings and costs or accrual-basis.

The billing rate will not be prorated to item details   for Cost Plus or Fixed Price projects with 
completed project or project   percentage complete accounting methods. Instead, it will be 
converted   to the contract customer’s currency when it is prorated to the item details   during 
day end processing (using the current exchange rate).

The prorated billing rate for each detail will not   be displayed (and, therefore, will not be 
editable).

 l This field is not available if you are prorating manually.

Billing Type

This field appears in the detail-entry section only for job-related   purchase orders.

The billing type indicates to Project and Job Costing whether to bill   the cost to the customer. You 
can change this field only for a time and   materials project or for a fixed price project that uses 
billings and   costs or accrual-basis accounting methods, as follows:

On a basic project:

 l For a billable project,   the category billing type determines whether you can change the billing   
type for the detail. If the specified category is:

 l For a billable project,   the category billing type determines whether you can change the 
billing   type for the detail. If the specified category is:

 l Billable, the default   billing type for the detail is billable, but you can change it. 

If the detail is billable you can specify a billing   rate for the detail.

If you change the billing type for the detail to no   charge or non-billable, the program 
sets the billing rate to zero and   you cannot change it. 

 l No charge or non-billable,   the program sets the same billing type for the detail, and 
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cannot change   it. You cannot specify a billing rate for the detail, which the program   
sets as zero.

 l If the project is no charge   or non-billable, the detail uses the same billing type as the 
project,   the billing rate is set to zero, and you cannot change them.

On a standard project:

 l If the project is billable,   the resource billing type determines whether you can change billing 
type   for the detail. If the specified resource is:

 l Billable, the program   displays Billable as default billing type, but you can change it for the   
detail. If the detail is billable, you can specify a billing rate for   the detail. If you change the 
billing type for the detail to no   charge or non-billable, the program sets the billing rate to 
zero, and   you cannot change it.

 l No charge or non-billable,   the program sets same billing type for the detail, and you cannot 
change   it. You cannot specify a billing rate for the detail, which the program   sets as zero.

 l No charge or non-billable,   the program sets same billing type for the detail, and you cannot 
change   it. You cannot specify a billing rate for the detail, which the program   sets as zero.

 l If the project is no charge   or non-billable, the detail uses the same billing type as the project,   
and you cannot change it. The program also sets the billing rate to zero,   and you cannot 
change it.

For fixed price and cost plus projects,   the Billing Type field is blank. A billing type is not required for 
these   types of projects. For internal contracts using time and materials, or   fixed price billings and 
costs or accrual basis, the billing type is set   to non-billable.

Cost   Class

The program displays the cost class for the category used in each detail.   You cannot change this 
field.

Calculate Labor (if job-related)                                     

Select the Calculate Labor field if you want Project and Job Costing   to calculate labor amounts for 
this cost and pass the amount back to Purchase   Orders. (Purchase Orders creates the G/L entries 
for the additional costs.)   

Do not select this option for an additional cost for which you don't   want to calculate labor.
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The program also lets you specify whether overhead or labor is calculated   if you expense the 
additional cost. 

Note: This field is disabled   if you specify No Proration, and you specify a 
contract/project/category   where the category uses a flat rate. No labor or overhead is   calculated 
for additional costs if you are using a flat rate per labor   hour/unit or a flat rate per unit for 
overhead.

Calculate Overhead (if job-related)                                     

Select the Calculate Overhead field if you want Project and Job Costing   to calculate overhead 
amounts for this cost and pass the amount back to   Purchase Orders. (Purchase Orders creates the 
G/L entries for the additional   costs.) 

Overhead is usually calculated on the discounted extended amount.

For example, you would not select this option if a receipt had additional   shipping costs for which you 
didn't want to calculate overhead or labor.

The program also lets you specify whether overhead or labor is calculated   if you expense the 
additional cost. 

Note: This field is disabled   if you specify No Proration, and you specify a 
contract/project/category   where the category uses a flat rate. No labor or overhead is   calculated 
for additional costs if you are using a flat rate per labor   hour/unit or a flat rate per unit for 
overhead.

Comments             

Enter an optional comment for the document.

Any comments you entered for the detail on the receipt are included   on the invoice, but you can 
change or delete them.

Lines automatically wrap when you reach the end. If you want to start   a new line before the line 
wraps, press Enter. 

Contract, Project, Category, Cost Class, and Item Number/Resource (if job-related)                                     

For job-related receipts, either expense the additional cost or specify   where the items or resources 
are going to be used. If you use different   terms than “Contract,” “Project,” and “Category” in Project 
and Job Costing,   the program displays them instead. 
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You also specify the Billing Type, Billing Rate, AR Item Number, and   AR Item UOM for the customer 
invoice.

Note: You enter/select the resource   using the Item Number field. These fields will appear   only for 
job-related receipts, and be enabled only for No Proration additional   costs.

Category

Select or enter a category that is assigned to the project in Project   and Job Costing.

Contract

Specify a contract number for each detail. You can enter or   select only contracts that are open or 
on hold. (You cannot process transactions   to a contract that is on hold, if it has never been 
opened.)

Cost   Class

The program displays the cost class for the category used in each detail.   You cannot change this 
field.

Item   Number (Resource)

Use the Item Number field to identify the resource for this detail.

For No Proration additional costs, use the Resource field to specify the resource for this detail.

You must specify a resource that is assigned to the project and category in Project and Job Costing. 
You can specify an inventory item number, or the code for another type of resource (such as an 
equipment code, subcontractor code, or employee number).

Note: You cannot leave this field blank.

Project

You can only enter or select projects that are:

 l Assigned to the contract   that you selected.

 l Open or on hold. (If   a project that is on hold has never been opened, you cannot select it.)

 l Not closed to costs.
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Distribute Proration

If you selected manual proration, click the column heading to display the distribution screen.

You cannot add/save a manually prorated additional cost detail line until the total amount prorated 
manually equals the total additional cost amount. 

Taxes

You do not need to manually calculate and prorate allocated taxes. The program will do that for you 
during day end or during posting (depending on your settings).

Non-Job-Related Receipts

You can manually prorate additional costs only to item details with   valid inventory item numbers. 
You cannot manually prorate costs to non-inventory   items.

Job-Related Receipts

The distribution screen lets you specify the amount allocated to each detail and the billing rate. All 
other fields are displayed only.

Expense Account

If you entered a non-inventory item number for the detail line, enter   the account number of the 
general ledger expense account to which you   want to post the detail. 

This field displays the number entered with the detail on the   receipt, but you can change the 
number.

For new detail lines, this field displays the account number specified   on the P/O Options screen for 
the Default Inventory Expense Account option.   

Line Number

To select an existing line to edit or delete, click the line, or   enter its line number in this field on the 
P/O Detail Items/Taxes screen.

Note: You cannot   delete completed lines.

Net Of Tax             

This field displays the extended item cost, minus any applicable tax   amount. You cannot edit the 
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amount.

Optional Fields

Optional fields appear on the Additional Costs tab for additional cost   that are charged by secondary 
vendors. 

You can also add optional fields to individual additional cost detail lines if you are not prorating the 
additional costs. If you are prorating by cost, quantity, weight, or manually, the optional fields 
column is   disabled.

If you are allocating additional costs to more than one receipt, you can edit the optional fields for 
each allocation on the Cost Allocation screen (choose the Dist. Cost button on the Additional Cost 
tab). Note that   you must have chosen multiple receipts on the Invoice tab in order to distribute the 
costs.

If you assigned the same optional fields to additional cost records and to invoice additional costs, 
the optional field entries in additional cost records will appear on invoices by default.

Optional field information can pass from invoices (or credit/debit notes) to downstream ledgers like 
Accounts Payable and General Ledger.

Proration Method

Specify whether to prorate the cost to the received items by cost, quantity,   or weight, or manually, or 
to expense the cost to a general ledger account.

Note: If you are adding additional costs for non-inventory items, you must   choose No Proration. 

Reference

Type an optional reference for the detail.

Retainage Percentage, Amount, and Period

If the retainage option is selected for the receipt and for the additional   cost, the program will display 
additional retainage fields for each additional   cost detail line. If you select No Proration for cost, you 
can enter a   retainage percentage and period.

Note: These   fields are editable for secondary vendors, but not for the primary vendor.
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Default Retainage Percentage and Period

The default retainage percentage and retention period that appears in   these fields depends on how 
you are prorating the costs.

 l If prorating by cost,   quantity or prorating manually, the settings are based on the Vendor 
record.

 l If using no proration,   the retainage settings are based on the Default Retainage From option   
for the contract in Project and Job Costing.

Return Expense Account

In this field, enter the general ledger account number to which to post   prorated additional cost 
amounts if you   return items.

Reproration / Return Proration                                       

This field is called Return Proration on the Detail Costs/Taxes screen.

Select the reproration method to use if you need to return any of the   received items and you did not 
select No Proration or Prorate Manually   as the proration method.

Note: You cannot expense job-related costs. 

Tax Included

This field displays the total amount of taxes included in   the additional cost amount.

Tax Included (Yes or No in the zoomed cost entry screen)                                     

This field appears on the zoomed item entry screen (click the Item/Tax...   button).

Use this field to indicate whether tax amounts are included in the item   cost. 

To toggle between Yes and No in this field, type any character in the   field or double-click the field 
with a mouse. 

The default choice for this option is provided from the vendor record   in Accounts Payable or from 
the vendor contract cost. 

Note that you can choose Yes only if the tax authority is set up in   Tax Services to allow tax-included 
costing.
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Allocated Tax                                       

This field displays the amount of allocated tax for the detail. (Allocated   taxes are included in the cost 
of the detail. Recoverable and expensed   taxes are not included in detail costs.) 

Distribute Proration (if prorating additional cost manually)

These fields appear in the Additional Cost table if you are manually prorating additional cost.

Billing Type, Billing Rate, A/R Item            Number, and A/R Item UOM (if job-related)                                     

For job-related additional costs that you are manually prorating, you   also specify the Billing Rate 
that will be used for the customer invoice.   The following billing fields from the receipt detail line are 
display-only   on this screen: Billing Type, Billing Currency, AR Item Number, and AR Item   UOM.

These fields will only appear for job-related receipts.

AR   Item Number

The program displays the A/R item number associated with the Category   or Item Number/Resource 
used for the contract in Project and Job Costing.   You can select a different A/R item number only for 
time and materials   projects, as follows: 

 l On a standard project,   the program displays the A/R item number and unit of measure 
specified   for the project resource category as the default. You can accept the item   number or 
select another valid A/R item number. 

 l On a basic project, program   displays the A/R item number and unit of measure specified for 
the project   category. You can accept the item number or select another valid A/R item   
number. 

 l If you change the A/R   item number, the item number must be a valid item number in 
Accounts Receivable,   and the unit of measure must be a valid unit of measure both for the 
new   item number and the vendor’s currency.

Cost plus and fixed price projects do not use an A/R item number. Internal   contracts for time and 
materials projects also do not use an A/R item   number.

AR   Item UOM

This field appears for Time and Materials projects if you selected the   Job Related option for this 
transaction.
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You must enter a unit of measure that is valid for the category or item   number/resource that you 
specified and for the contract customer's currency.

Note: For internal time and materials projects (basic or standard   contracts) the A/R item unit of 
measure will be disabled/blank.

Billing   Currency

This field appears only in multicurrency systems for time and materials   projects and for fixed price 
projects using billings and costs or accrual-basis   accounting methods. 

The billing currency is the customer's currency specified on the contract,   and you cannot change it. 
Note that:

 l Billing currency is blank   for Fixed Price projects using completed project or project 
percentage   complete methods, and for Cost Plus projects.

 l Billing currency is NOT displayed for basic or standard internal Time and Materials projects 
or Fixed Price projects that use billings and costs or accrual-basis accounting methods.

Billing   Rate

Purchase Orders displays the billing rate for the specified resource   (for standard projects) or 
category (for basic projects). You can edit the billing rate if the billing type is Billable. The field   will 
display 0.000000 if the billing type is Non-Billable or No Charge. Note that:

 l Billing rate can be specified   for Time and Materials projects and for Fixed Price projects that 
use   Billings and Costs or Accrual-Basis accounting methods.

 l Billing rate is disabled   and set to 0.000000 on a basic or standard internal contract for Time   
and Materials projects or for Fixed Price projects using billings and   costs or accrual-basis 
accounting methods.

 l The billing rate cannot   be negative.

Billing   Type

This field appears in the detail-entry section only for job-related   purchase orders.

The billing type indicates to Project and Job Costing whether to bill   the cost to the customer. You 
can change this field only for time and   materials projects or for fixed price projects that use billings 
and costs   or accrual-basis accounting method, as follows:
On a basic project:

 l For a billable project,   the category billing type determines whether you can change the billing   
type for the detail. If the specified category is:
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 l Billable, the default   billing type for the detail is billable, but you can change it.  If the detail is 
billable you can specify a billing   rate for the detail. If you change the billing type for the detail 
to no   charge or non-billable, the program sets the billing rate to zero and   you cannot 
change it. 

 l No charge or non-billable,   the program sets the same billing type for the detail, and cannot 
change   it. You cannot specify a billing rate for the detail, which the program   sets as zero. If 
the project is no charge   or non-billable, the detail uses the same billing type as the project,   
the billing rate is set to zero, and you cannot change them.

On a standard project:

 l If the project is billable,   the resource billing type determines whether you can change billing 
type   for the detail. If the specified resource is:

 l Billable, the program displays Billable as default billing type, but you can change it for 
the detail. If the detail is billable, you can specify a billing rate for   the detail.

If you change the billing type for the detail to no   charge or non-billable, the program 
sets the billing rate to zero, and   you cannot change it.

 l No charge or non-billable,   the program sets same billing type for the detail, and you 
cannot change   it. You cannot specify a billing rate for the detail, which the program   
sets as zero.

If the project is no charge   or non-billable, the detail uses the same billing type as the 
project,   and you cannot change it. The program also sets the billing rate to zero,   and 
you cannot change it.

For fixed price and cost plus projects,   the Billing Type field is blank. A billing type is not required for 
these   types of projects. For internal contracts using time and materials or fixed price billings and 
costs or accrual-basis, the billing type is set to non-billable.

Contract, Project, Category, Cost Class, and Item Number/Resource (if job-related)                                     

For job-related additional costs that are manually prorated, choose   the items/resources to which 
you are allocating the additional cost.

The program displays the “Contract,” “Project,” and “Category” that you specified for each receipt 
detail line. The "resource" appears   in the Item Number column.

You also specify the Billing Rate for the additional cost.

Note: The proration screen is available only if you choose to manually prorate additional costs to 
detail lines. The following fields from the receipt detail lines are shown as   display-only fields on 
this screen: Contract, Project, Category, Cost Class,   Item Number, and Description.
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Category

Select or enter a category that is assigned to the project in Project   and Job Costing.

Contract

Select or enter a contract number for each detail. You can enter or   select only contracts that are 
open or on hold. (You cannot process transactions   to an account that is on hold, if it has never been 
opened.)

Cost   Class

The program displays the cost class for the category used in each detail.   You cannot change this 
field.

Item   Number (Resource)

Use the Item Number field to specify the resource for this detail. 

You must specify a resource that you have assigned to the project in   Project and Job Costing (such 
as an equipment code or a subcontractor   code). You cannot leave this field blank.

Project

You can only enter or select projects that are:

 l Assigned to the contract   that you selected. 

 l Open or on hold. If   a project that is on hold has never been opened, you cannot select it.

 l Not closed to costs.

Item Number

The program displays all of the items on the purchase order so you can   easily distribute the 
additional cost in the amount fields.

If this is a job-related receipt, the Item Number may be a resource.

Item Description

The program displays the item description from Inventory Control or   the description you entered for 
the detail on the purchase order. 
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Amount

Enter the amount of the additional cost that is being allocated to this   line item. The amounts on all 
lines must add up to the total amount of   the additional cost.

Receipt Tab

Bill-To Location

If you use Inventory Control, select a location code to which bills   for the receipt will be sent. 

You can also use theZoom  button to open separate screen where you can edit the address for 

the bill-to location, or you can omit the code and type in a billing address, or not specify a bill-to 
location at all.

Description

Type an optional description for the receipt, using up to 60 characters.   

If you are working with an existing purchase order, the description   entered on the purchase order is 
displayed, but you can change it.

From Multiple POs

To receive all incomplete purchase orders from the vendor, click the   Zoom  button beside the 

From Multiple POs option. Use the   screen that appears to add purchase orders to the receipt, as 
follows: 

 l Use the Finder to list   and select purchase orders.

 l Press the Insert key to move to a new line.

 l After selecting the purchase orders you want to add, click Receive and then click Close.

All the details from the purchase orders are then listed in the detail   entry table on the Receipt 
tab.   

If you select the From Multiple POs check box, the PO Number field is not available. The option is 
automatically selected if you click the Zoom button   next to the field.
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Note: When   you create a receipt from more than one purchase order, all of the receipt   header 
information (including the fields on the Optional Fields tab) will   come from the first purchase order 
that you select.

FOB Point

Type the name of the Free-On-Board point, or the location   where the vendor begins charging you 
freight on shipments. You can also   leave this field blank.

Job Related

Select the Job Related option if the receipt is for a project you   are managing with Project and Job 
Costing.

If the receipt is job-related, different fields appear for the details   to let you enter job-related 
information.

Note: If   you are creating the receipt from multiple purchase orders, all purchase   orders must be 
either job-related or non-job-related. Also, you cannot add serialized items or items assigned to 
lots to job-related   receipts. Instead, you must receive them into inventory, and then use   the 
Material Usage screen in Project and Job Costing to move them from inventory   to jobs.

Last Receipt Number 

This field shows the number of the last receipt posted to the specified   purchase order. Each time 
you post a receipt for a particular purchase   order, the program enters the new receipt number in this 
field.

Number of Receipts 

This field displays the number of receipts that have been posted to   the purchase order selected for 
the current receipt. The number is updated   with each new receipt you post to the purchase order.

PO Number

If you are entering a receipt of a single purchase order, type the purchase   order number or select 
the number from the Finder of the vendor’s purchase   orders. 

If you specify a single purchase order number in this field, you will   not be able to use the From 
Multiple POs field.
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You do not have to specify purchase order numbers with receipts. However,   if you do specify a 
purchase order number, the purchase order details   are displayed and you cannot add new details 
or receive a quantity that   is greater than the quantity ordered on the purchase order.

The Finder for this field shows only incomplete purchase order numbers.   (You cannot post receipts 
to completed purchase orders.)

You cannot change the purchase order number after posting the receipt.

Posting Date

Enter the posting date for the receipt in addition to the document date.   

The posting date is the date for transactions being posted to the General   Ledger, so it also 
determines the contents of the Fiscal Year and Period   fields.

If you are also entering invoice information, the posting date that   you specify here also applies to the 
invoice.

If you have a multicurrency system, currency revaluation also uses posting   dates to select open 
documents for revaluation purposes and thus, revaluation   adjustments are posted to General 
Ledger in the correct fiscal year and   period.

Depending on your settings in the P/O Options screen, Purchase Orders   automatically displays the 
session date or the document date by default   in this field. 

You can change the posting date, but you cannot separately change   the fiscal year and period. 

Note: If   you consolidate G/L transactions, the posting date for consolidated entries   is the last date 
of the fiscal period.

Receipt Date

Type the date you want to use as the receipt date. The program displays   the sign-on date you 
entered to start Sage 300.

You can also change the posting date if you want a different date for   the G/L transactions when they 
are posted in the General Ledger. (The   posting date determines the fiscal year and period 
displayed beside the   Posting Date field.)

Receipt Subtotal (display only)                             

The Subtotal field in the lower-right corner of the screen displays the   total of all items on the receipt. 
This amount does not include taxes   and additional costs.
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Reference

Type an optional reference for the receipt.

If you are working with an existing purchase order, the reference from   the purchase order is 
displayed, but you can change it.

Retainage

You can choose retainage accounting for the job-related receipts if   the retainage option is selected 
in the Accounts Payable module. 

The program will display additional retainage fields for each receipt detail line to let you enter a 
different retainage percentage (or amount) and period for each detail line in the receipt.

The program will also display the Retainage tab to let you specify the retainage terms and specify 
the exchange rate that you use for multicurrency retainage invoices.

Ship-To Location

If you use Inventory Control, select the location code which identifies the location at which the items 
were received.

You can also use the Zoom button (or press F9) to open a separate screen where you can edit the 
address for the code you select, or you can skip the code and type in a ship-to address. You can 
also omit ship-to information.

The ship-to location you specify, if any, becomes the default location for new lines you add to a 
receipt.

If you are working with an existing purchase order, the location code entered on the purchase order 
is displayed. You can change the code, but your change does not change the location codes 
entered with the detail lines.

Ship Via 

Use these fields to specify the shipping method by which you received the goods from the vendor. 
The program displays the ship-via description for the code you select or for the code, if any, in the 
template you selected for a new receipt on the Receipt tab.

Type an optional ship-via code or use the Finder to select one of the ship-via codes you have 
defined in Purchase Orders. 
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You can also skip the Ship Via field and type a description of the shipping method by which you will 
receive the goods in the field beside the Ship Via field, or leave both fields blank.

Terms 

The vendor's terms code is displayed, but you can change it.

To change a terms code, type the new code or select the code from the   Finder. You must enter a 
terms code for each vendor and you must use one   of the terms codes you have defined in Accounts 
Payable.

Template Code

On receipts entered without purchase order numbers, the default template   code, if any, is 
displayed, but you can change it.

If you select a new template after choosing the vendor, Purchase Orders   will replace the receipt 
information with the information from the template.

 l You cannot change the   template after you have added details to the receipt.

 l You cannot change the   displayed template code if you specify an existing purchase order 
number   or you are working with a previously posted receipt.

Vendor Account Set

The account set from the vendor record appears in this field as the   default. It specifies the general 
ledger payables   control, purchase discounts, prepayment, and retainage accounts to which   the 
transaction will be distributed.

You can change the account set for a particular purchase order, receipt,   return, invoice, credit note, 
or debit note. If you use   multicurrency accounting, however, the new account set must use the same   
currency as the vendor's account set.

Note: If you change the account set on a receipt, make sure that you use the   same account set 
for returns, invoices, and credit or debit notes.

Year and Period (display only)                             

This is the fiscal year and period to which the receipt transactions   will be posted in the general 
ledger. You can change   the fiscal period by changing the Posting Date.

You can enter a different Receipt Date, and you can enter a different   Posting Date for the document.
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(Remember that you cannot post transactions to closed fiscal periods.)

Receipt Details table

Allocated Tax (display only)                                     

Shows the total tax amount that was allocated to the selected detail   line for the tax authority.

Arrival Date

Type the date on which you received the items. The program displays   the session date as the 
default, but you can change it.

Billing Type, Billing Rate, A/R Item Number, and A/R Item UOM (if job-related)                                     

For job-related receipts, you can also specify the Billing Type, Billing Rate, AR Item Number, and 
AR Item UOM (unit of measure) that will be used for the customer invoice.

You must select the Job Related option in the top part of the Receipt Entry screen for these fields to 
appear.

AR Item Number

The program displays the A/R item number associated with the category or Item Number/Resource 
used for the contract in Project and Job Costing.   You can select a different A/R item number only for 
time and materials   projects, as follows: 

 l On a standard project,   the program displays the A/R item number and unit of measure 
specified   for the project resource category as the default. You can accept the item   number or 
select another valid A/R item number. 

 l On a basic project, program   displays the A/R item number and unit of measure specified for 
the project   category. You can accept the item number or select another valid A/R item   
number. 

 l If you change the A/R   item number, the item number must be a valid item number in 
Accounts Receivable,   and the unit of measure must be a valid unit of measure both for the 
new   item number and the vendor’s currency.

Cost plus and fixed price projects do not use an A/R item number. Internal   contracts for time and 
materials projects also do not use an A/R item   number.
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AR   Item UOM

This field appears for Time and Materials projects if you selected the   Job Related option for this 
transaction.

You must enter a unit of measure that is valid for the category or item   number/resource that you 
specified and for the contract customer's currency.

Note: For internal time and materials projects (basic or standard   contracts) the A/R item unit of 
measure will be disabled/blank.

Billing   Currency

This field appears only in multicurrency systems for time and materials   projects and for fixed price 
projects using billings and costs or accrual-basis   accounting methods. 

The billing currency is the customer's currency specified on the contract,   and you cannot change it. 
Note that:

 l Billing currency is blank   for Fixed Price projects using completed project or project 
percentage   complete methods, and for Cost Plus projects.

 l Billing currency is NOT displayed for basic or standard internal Time and Materials projects 
or Fixed Price projects that use billings and costs or accrual-basis accounting methods.

Billing Rate

Purchase Orders displays the billing rate for the specified resource   (for standard projects) or 
category (for basic projects). The billing rate is defaulted as follows:

 l On a standard project:

 l For a category cost   class of Subcontractor, Overhead, Miscellaneous Equipment, or 
Material,   the billing rate is defaulted from the category resource.

 l For a category cost   class of Labor, the default billing rate is based on the Default 
Billing   Rate From option for the employee resource category.

 l On a basic project:

 l For a category cost   class of Subcontractor, Overhead, Miscellaneous Equipment, or 
Material,   the billing rate is defaulted from the category.

 l For a category cost   class of Labor, the default billing rate is based on the Default 
Billing   Rate From option for the labor category.

The Billing Rate option does not apply to internal contracts.
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You can edit the billing rate if the billing type is Billable. The field will display 0.000000 if the billing 
type is Non-Billable or No Charge. Note that:

 l Billing rate can be specified   for Time and Materials projects and for Fixed Price projects that 
use   Billings and Costs or Accrual-Basis accounting methods.

 l Billing rate is disabled   and set to 0.000000 on a basic or standard internal contract for Time   
and Materials projects or for Fixed Price projects using billings and   costs or accrual-basis 
accounting methods.

 l The billing rate cannot   be negative.

Billing   Type

This field appears in the detail-entry section only for job-related   purchase orders.

The billing type indicates to Project and Job Costing whether to bill   the cost to the customer. You 
can change this field only for time and   materials projects or for fixed price projects that use billings 
and costs   or accrual-basis accounting method, as follows:

On a basic project:

 l For a billable project,   the category billing type determines whether you can change the billing   
type for the detail. If the specified category is:

 l Billable, the default   billing type for the detail is billable, but you can change it.  If the detail is 
billable you can specify a billing   rate for the detail. If you change the billing type for the detail 
to no   charge or non-billable, the program sets the billing rate to zero and   you cannot 
change it. 

 l No charge or non-billable,   the program sets the same billing type for the detail, and cannot 
change   it. You cannot specify a billing rate for the detail, which the program   sets as zero. If 
the project is no charge   or non-billable, the detail uses the same billing type as the project,   
the billing rate is set to zero, and you cannot change them.

On a standard project:

 l If the project is billable,   the resource billing type determines whether you can change billing 
type   for the detail. If the specified resource is:

 l Billable, the program   displays Billable as default billing type, but you can change it for 
the   detail. If the detail is billable, you can specify a billing rate for   the detail.

If you change the billing type for the detail to no   charge or non-billable, the program 
sets the billing rate to zero, and   you cannot change it.

 l No charge or non-billable,   the program sets same billing type for the detail, and you 
cannot change   it. You cannot specify a billing rate for the detail, which the program   
sets as zero.
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If the project is no charge   or non-billable, the detail uses the same billing type as the 
project,   and you cannot change it. The program also sets the billing rate to zero,   and 
you cannot change it.

On a basic project: 

For fixed price and cost plus projects,   the Billing Type field is blank. A billing type is not required for 
these   types of projects. For internal contracts using   time and materials or fixed price billings and 
costs or accrual-basis,   the billing type is set to non-billable.

Comments

To enter comments for a detail line, click the Zoom  button beside the   field (or press the Shift and 

F9 keys at the same time in the field),   type the remarks, then click Close.

If you are creating a receipt from a purchase order, any comments you   entered for the detail line on 
the purchase order are included on the   receipt, but you can change or delete them.

Completes PO

Select Yes by pressing the Spacebar or by double-clicking in this field   if you have received or 
canceled all the items described in the detail   line. 

Until you post the receipt, you can change the response back to No,   if you wish, but you cannot 
change to No after posting.

Detail lines are completed on purchase orders when you specify that   the entire quantity is received 
or if you cancel any outstanding quantity.   Once a purchase order detail line is completed, you 
cannot make any further   changes to it on the purchase order. You can still edit the detail on   the 
receipt until you post an invoice for the primary vendor.

Contract, Project, Category and Item Number/Resource            (if job-related)                                     

If the receipt is job-related, specify for each receipt detail where   the items or resources are going to 
be used. If you use different terms   than “Contract,” “Project,” and “Category” in Project and Job 
Costing,   the program displays them instead. 

For job-related receipts, you can also specify the Billing Type, Billing   Rate, AR Item Number, and 
AR Item UOM for the customer invoice near the   end of the detail line.

Purchase Orders updates the actual and committed quantities and costs   for jobs with the amounts 
on receipts. 
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Note: You can enter/select the resource   using the Item Number field. If the receipt is being   
created from multiple purchase orders, all POs must be either job-related   or non-job-related. 
Also, you must select the Job-Related   check box in the top part of the Receipt Entry screen for 
these fields to   appear.

Category. Select or enter a category that is assigned to the project in Project   and Job Costing.

Contract. Select or enter a contract number for each detail. You can enter or   select only contracts 
that are open or on hold. (You cannot process transactions   to an account that is on hold, if it has 
never been opened.)

Cost   Class. The program displays the cost class for the category used in each detail.   You cannot 
change this field.

Item   Number (Resource). Use the Item Number field to specify the resource for this detail. 

For standard projects, you must specify a resource that you have assigned   to the project in Project 
and Job Costing (such as an equipment code or   a subcontractor code). 

For basic projects, you can select anything you want in this field   to identify the cost, but you cannot 
leave this field blank.

Project. You can only enter or select projects that are:

 l Assigned to the contract   that you selected. 

 l Open or on hold. If   a project that is on hold has never been opened, you cannot select it.

 l Not closed to costs.

Discount %

You can enter a discount as a percentage or an amount. The program uses the amount you enter in 
this field to calculate the   discounted cost for the item detail. 

If you enter a percentage in this field, Purchase Orders calculates   the discount amount for the item 
detail.

Tip: If you prefer not to enter discounts for individual details, you can   enter a discount percentage 
for the entire document on the Totals tab. Purchase   Orders then prorates the discount amount 
for the transaction details,   overriding any discounts you may have entered manually for the 
details.
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Discount Amount

The program uses the amount you enter in this field to calculate the   discounted extended cost for 
the item detail. If you enter a discount   amount, the program calculates and displays the discount 
percentage based   on the extended cost. (Alternatively, you can enter a percentage in the   Discount 
% field, and let the program calculate the discount amount.)

Tip: If you prefer not to enter discounts for individual details, you can   enter a discount amount for 
the entire receipt on the Totals tab. Purchase   Orders then prorates the discount amount for the 
document details, overriding   any discounts you may have entered manually for the details. 

Discounted            Extended Cost 

The program displays the item cost, less the discount amount, in this   field.

Drop Ship

To enter a drop-ship address for a detail, click the Zoom  button beside the Drop Ship field, or 

select the field and press Shift+F9. 

Select the type of address to enter, and if necessary, select the   location code, customer number, or 
ship-to address code for the address.

Expense Account

You specify a general ledger expense account for non-inventory item   details. You can select 
general ledger   account numbers using the Finder.

The program displays the number entered with the detail on the   purchase order, if any, or the 
account number specified in the P/O Options   screen for the Default Inventory Expense Account 
option, but you can change   the number on the receipt.

Extended Cost

Type the extended cost for the number of units of the item that you received.

If you change the extended cost, the program automatically recalculates the unit cost.

Note: If security is turned on in Sage 300, you cannot see this field unless you are authorized to 
view costing information.
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Extended Weight

Type the extended weight for the number of units of the item that you   received.

If you change the extended weight, the program automatically recalculates   the unit weight.

The total weight for all items on the document is displayed in the Totals   tab.

Fixed Assets

If you use Sage Fixed Assets to manage the fixed assets in your company,   you can mark goods that 
you receive as fixed assets using the Fixed Assets screen. To display the Fixed Assets screen:

 l In the Detail table, double-click the Fixed   Assets column in the detail line to display Yes, and 
then click the Fixed   Assets column heading.

 l On the Detail Items/Taxes screen, select   the Fixed Assets option, and then click the Zoom 

 button.

Fill in the fields on the Fixed Assets screen that appears.

Item Description

This field displays the item description from the P/O Vendor Contract   Costs record (if one exists) or 
from the Inventory Control or Purchase   Orders item record. If necessary, you can change it. 

If you enter an item number that does not exist in Inventory Control,   you also enter the description 
for the item. You can enter non-existent item   numbers only if you selected the Allow Non-inventory 
Items option on   the P/O Options screen. 

Purchase Orders displays the item description that was entered with the   detail on the receipt, but 
you can change it.

Item Number

Type the number of the item you received, or select it from the Finder.

You can also type an item number that does not exist in your Inventory Control data if you use the 
Allow Non-inventory Items option (selected in the P/O Options screen).

If you are creating a receipt from a purchase order, the item number entered with the purchase 
order appears and you cannot change it. However, you can delete the line, if you wish. 
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To delete a detail line from the detail entry grid on the Receipt tab, select the line, then press the 
Delete key on your keyboard. In the Detail Items/Taxes screen, display the line, then click the 
Delete button.

If you see a message asking you to confirm your wish to delete the line, choose Yes.

Manufacturers' item numbers or bar codes. Purchase Orders also lets you enter manufacturers' 
item   numbers in this field if they have been added in Inventory Control. These   numbers could 
include internally-used bar codes, UPC numbers, or ISBNs   — letting you use a scanner (or type a 
short code) for entering inventory   item numbers.

If you enter a manufacturer's item number, Purchase Orders will replace   it with your inventory item 
number, and then display the manufacturer's   item number you entered in the Manufacturer's Item 
Number field, near   the end of the detail line.

Line Number

To select an existing line to edit or delete, click the line, or   enter its line number in this field on the 
P/O Detail Items/Taxes screen.

Note: You cannot   delete completed lines.

Location

This field appears only if you use Inventory   Control.

Enter the code for the location where you expect to receive the shipment   (or to which you want to 
post drop-shipped items). 

The program displays the ship-to location code, if any, entered on the   first tab, but you can select a 
different location. You can omit the location   when adding details for non-inventory items.

Note: If you change  locations after assigning serial and/or lot numbers, you must re-assign the 
serial and/or lot numbers.

Manual Proration

This item details field appears only for documents created with Purchase   Orders 5.3A and earlier.

If you have added an additional cost that uses manual proration to the   receipt, type the amount to 
prorate to the detail. You must assign the   full amount of the manually prorated charge to item 
details before you   can post the receipt.
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You can manually prorate additional costs only to item details with   valid inventory item numbers 
(including non-stock numbers, if used). You   cannot manually prorate costs to non-inventory items.

Note that in multicurrency systems, you can manually prorate amounts   only on receipts that are in 
the functional currency.

Manufacturer's Item Number

If you entered a manufacturer's item number in the Item Number field   on the requisition or 
purchase order, the number appears in the Manufacturer's Item Number field. 

Manufacturer's item numbers are alternative item numbers—  such as bar codes or shortcut codes—  
that identify your inventory items. You set up manufacturer's item numbers   in Inventory Control.

You can enter manufacturer's item numbers wherever you enter item numbers   in Purchase Orders.

Net Of Tax             

This field displays the extended item cost, minus any applicable tax   amount. You cannot edit the 
amount.

Non-Stock Clearing Account

If you are receiving a non-stock item, the non-stock clearing account   associated with the item's 
account set appears. You can specify a different   account, if necessary.

Number of Labels

If you want to print item labels for the received items, type the number  of labels to print. 

Note: 
You use the Item Labels screen in Inventory Control to print the labels.

On the Inventory Control Item Labels screen, select Received in the For   Each Item field, then 
specify the receipt numbers for which you want to   print labels. The program then prints the 
number of labels you specified   for each item detail on a selected Purchase Orders receipt.

You cannot specify a number of labels for non-inventory item details.

Optional Fields

Optional fields are fields that have been added by your company to the transaction entry screens 
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and detail lines in purchase orders transactions.

If you use optional fields, an Optional Fields column appears in the table. You can click the column 
heading to display the optional fields assigned to a selected detail, and edit their contents.

Note: You must use Transaction Analysis and Optional Field Creator to add and use optional 
fields.

For more information about using optional fields in transactions, see "About Optional Fields in 
Transactions" (page 80). 

Order Number

Enter the number of a sales order for which you are creating the detail. If you use Sage 300 Order 

Entry with Purchase Orders, you can also use the Finder  to select an Order Entry order number.

You can change or erase an order number that is displayed with a detail   you added from a 
purchase order or posted previously with the screen.

If you change an order number that is displayed with a detail line, the new order number does not 
replace the previous number on the corresponding receipt and will not be reported on the P/O 
Shippable Backorders report.

You also enter the unit weight, extended weight, vendor item number,    comments, and the G/L 
expense account specified for non-inventory items.

PO Number

If you selected a purchase order from the PO Number field, or from the   Create Receipt from PO 
screen, the purchase order number for each detail   appears in this column. 

Quantity Canceled

Type the number of units to cancel for the detail (the number of units,   if any, that you do not expect 
to receive). 

You can enter a canceled quantity only   when you are editing a detail from a purchase order. When 
you post the   receipt, the Quantity Outstanding field on the purchase order is reduced   by the number 
of units you canceled on the receipt.

Quantity Outstanding

You can enter an outstanding quantity (the number of units not yet received   or canceled) on detail 
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lines only   when you are entering a receipt to a purchase order.

The Quantity Outstanding field is automatically updated by the program   when you post a received 
amount, but you can also type the outstanding   quantity.

To reduce the outstanding quantity on an existing detail line you are   editing, enter the desired 
amount; enter zero to complete a line and cancel   remaining outstanding units.

When you post the receipt for a purchase order, the outstanding quantities   are reduced on the 
purchase order. If you post a receipt for the full   outstanding quantity or for a larger quantity than 
was specified on the   purchase order, the purchase order detail is completed.

Quantity Received

Type the number of units of the item that you received. 

When entering received units for a purchase order detail, you can enter   a greater number than are 
outstanding for the detail, if necessary.

When you post the receipt, the outstanding quantity on the purchase   order (if any) is updated with 
the number of received units, and any purchase   order details for which you did not enter a received 
quantity are deleted   from the receipt. You must add a new receipt to receive the other details   on the 
purchase order.

Note: If   this is a job-related receipt, you should enter the quantity using the   unit of measure that 
was used for the estimate in Project and Job Costing.   Purchase Orders does not convert   the 
quantity received when it sends the quantity to PJC if the units of   measure are different.

If you use Serialized Inventory and Lot Tracking, and the item is serialized or lotted,  a separate 
Generation/Allocation screen appears after you enter the quantity of serialized or lotted   items 
received, then press Tab or Enter. You use this screen to assign serial/lot numbers for the item. 
(This screen also   opens when you click the Zoom button beside the Quantity field.)

Received To Date 

The program displays the number of units of the item that have already   been received on the 
receipt.

Retainage %, Retainage Amt., and Retention Period (retainage accounting only)                                     

Retainage accounting applies only to job-related transactions, and is   available only if you selected 
retainage accounting in the Accounts Payable   program.
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If the retainage option is selected for the receipt, the program   displays additional retainage fields for 
each receipt detail line to let   you enter a retainage percentage or amount and the retention period 
for   each detail line in the receipt.

The program also displays the Retainage tab to let you specify the   exchange rate that you want to 
use for the retainage amounts on multicurrency   invoices.

If you clear the Retainage option, the percentage and retention period fields disappear from the 
item detail section, and the Retainage   tab also disappears.

Default Retainage Percentage and Period

The default retainage percentage and retention period that appears in   these fields depends on the 
retainage settings that were selected for   the category in the Project and Job Costing module. You 
can choose in   PJC whether to default the retainage settings from the vendor record in   Accounts 
Payable, or use specific retainage settings entered for the category.

Tax Included                                     

In the Detail table, this field displays the amount of tax that is included in the extended   item cost 
(when the cost includes tax).

On the zoomed Detail Items/taxes screen, this field displays Yes or No to indicate whether tax 
amounts are included in the item   cost for each tax authority. The default choice for this option is 
provided from the vendor record   in Accounts Payable or from the vendor contract cost. 

Note: You can select Yes only if the tax authority is set up in   Tax Services to allow tax-included 
costing.

You can also edit total tax amounts on the Taxes tab.

Tax Reporting Amount

The Tax Reporting Amount appears for each detail if the tax group's tax reporting currency   is 
different from your functional   currency and the vendor's currency. 

On the Taxes tab, this field is the sum of the tax reporting amounts   for the entire document. You can 
change the amount on the Taxes tab (for   example, if you also change the Tax Amount, and then 
derive the Tax Reporting   Exchange rate on the Rates tab). 

If you edit this amount, but leave the exchange rate, you can click the Calc. Taxes button to 
recalculate the tax reporting   amount. 
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You set the tax reporting currency for tax groups in the Tax Services module   in Common Services.

Unit Cost 

Enter the cost of a single unit of the item you are ordering in the detail.   

Purchase Orders displays a default cost as follows:

 l If you have set up vendor   contract costs, Purchase Orders displays the cost specified as a 
contract   cost for the item and unit of measure. 

 l If P/O does not find a   valid contract cost, it uses the inventory cost specified on the P/O 
Options   screen.

Use the Finder  to view any vendor contract costs, regular   vendor costs, and other costs 

maintained by Inventory Control.

Purchase Orders uses the unit cost to calculate the extended cost. If you   change the unit cost, the 
extended cost is recalculated.

In multicurrency ledgers, the cost is expressed in the vendor's currency.

Note: You can assign security to the Unit Cost and Extended    Cost fields, to prevent unauthorized 
changes to the fields.

If you use Project and Job Costing, unit cost is defaulted as follows:

 l If   the project is a standard project:

 l For a category cost   class of Subcontractor, Overhead, or Miscellaneous Equipment, 
the unit   cost is defaulted from the category resource.

 l For a category cost   class of Labor, the default unit cost is based on the Default Unit 
Cost   From option for the employee resource category.

 l For a category cost   class of Material (if you are using Inventory Control), the default 
unit   cost is based on Purchase Orders' default item cost (set in P/O Options).

 l For a category cost   of Material (if you are not using Inventory Control), the unit cost is   
based on Purchase Orders vendor costs.

 l If   the project is a basic project:

 l For a category cost   class of Subcontractor, Overhead, or Miscellaneous Equipment, 
the unit   cost is defaulted from the category.

 l For a category cost   class of Labor, the default unit cost is based on the Default Unit 
Cost   From option for the labor category.
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 l For a category cost   class of Material (if you are using Inventory Control), the default 
unit   cost is based on Purchase Orders' default item cost (set in P/O Options).

 l For a category cost   of Material (if you are not using Inventory Control), the unit cost is   
based on Purchase Orders vendor costs.

Unit of Measure

Type the unit of measure in which you received the item, or select it from the Finder.

You must use one of the units of measure that is assigned to the item in Inventory Control. On new 
detail lines, the program displays the stocking unit of measure.

If you are creating a receipt from a purchase order, the unit of measure entered for the detail on the 
purchase order is displayed, but you can change it.

If this is a job-related receipt, you should use the unit of measure that was used for the estimate in 
Project and Job Costing. Purchase Orders does not convert the quantity received when it sends the 
quantity to PJC   if the units of measure are different.

Unit Weight

Enter the weight of a single unit of the item you are ordering in the   detail. On new detail lines, the 
weight specified in the Inventory Control   item record is displayed, but you can change it.

Purchase Orders uses the unit weight to calculate the extended weight. If   you change the unit 
weight, the extended weight is recalculated.

You can select from the weight units of measure defined in Purchase   Orders. Weight is expressed 
in the unit selected   for the Weight Unit Of Measure option on the I/C Options   screen.

On invoices, enter the weight of a single unit of the item for which you were invoiced.   The program 
displays the weight specified for the item on the receipt   but you can change it.

Purchase Orders uses the unit weight to calculate the extended weight. If   you change the unit 
weight, the extended weight is recalculated.

You can see the total weight estimated from your entries for the invoiced   items on the Totals tab.

Vendor Item Number             

Enter the code the vendor uses to identify the item. 
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If the vendor's item number is specified in the Inventory Control item   record, the code appears in 
this field. (Enter vendors' item numbers when   assigning vendor types in Inventory Control item 
records.)

If the vendor's item number is specified on the receipt for which you   are entering an invoice, the 
code appears in this field. (You can enter   vendors' item numbers when assigning vendor types in 
Inventory Control   item records.)

Weight UOM

This is the unit of measure for the weight of this item on the receipt—such as, pounds, kilograms, 
tons.

By default, the program displays the weight unit of measure from the purchase order, but you can 
change it to another defined unit of measure (and the program will recalculate the weight 
accordingly). For example,   the item might arrive in differently sized bags than were ordered, 
leading   you to change the UOM.

The weight UOM for the complete order is determined by the default weight unit of measure set in 
the I/C Options screen (or in the P/O Options screen, if you do not use Inventory Control).

Optional Fields tab

The Optional Fields tab contains optional fields   added by your company that apply to the 
transaction as a whole. (Optional   fields on detail lines apply to the individual transaction detail.)

Note: This tab appears only if you use Transaction Analysis and Optional Field Creator.

For more information, see "About Optional Fields" (page 51).

Rates Tab (multicurrency ledgers)                     

Currency (display only)                             

In multicurrency ledgers, the vendor's currency code is displayed after   you enter the vendor 
number. All amounts you enter for the receipt will   be in the vendor's currency.

The currency is assigned for the vendor in Accounts Payable, and you   cannot change it in Purchase 
Orders.
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Derive Rate

When Purchase Orders calculates the tax amount in a tax reporting currency,   the program uses the 
Tax Reporting Currency Exchange Rate that appears   (or that you enter) on the Rates tab.

However, if you have changed the tax reporting amount that appears on   the Taxes tab, you can 
click the Derive Rate button to see the actual   exchange rate between the tax amount and the tax 
reporting amount.

In other words, the Derive Rate button appears so you can derive the   exchange rate for the tax 
reporting currency if you change the calculated   amount on the Taxes tab.

Purchase Order Exchange Rate

If you are entering a receipt for a multicurrency purchase order, the   program displays the exchange 
rate that was posted on the PO. You can   enter a different rate for the receipt.

Purchase Order Rate Date

If you are entering a receipt for a multicurrency purchase order, the   program displays the rate date 
for the exchange rate that was posted on   the PO. You can specify different exchange rate 
information for the receipt.

Purchase Order Rate Type

If you are entering a receipt for a multicurrency purchase order, the   program displays the rate type 
that you used to select the exchange rate   for the PO. You can select a different rate type for the 
receipt.

Receipt Exchange Rate

The program displays the exchange rate currently in effect for the specified   currency and the 
displayed rate type and rate date, but you can change the   rate.

You receive a warning if you change an exchange rate by an amount that exceeds   the Spread 
setting for the currency in Common Services' Currency Rates table.

Receipt Rate Date

Type the date to use to select the exchange rate for the additional   cost. The program displays the 
rate date that is nearest the receipt date   you typed, but you can change to another date for which an 
exchange rate   is entered for the currency in the Currency screens in Common Services.   
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If you change the rate date, Purchase Orders checks the rate tables   for a date match and updates 
the rate if necessary. 

Receipt Rate Type

If the rate type you want to use is not displayed, type the code or   choose it from the Finder.

The program uses rate types when converting multicurrency amounts on   the order to functional 
currency. Examples of rate types might be "spot   rate," "average rate," and "contract rate."

You define rate types using the Currency Rate Types screen in Common Services, and assign the 
default rate type for Purchase Orders on the Processing tab of the P/O Options screen.

Retainage Tab

The Retainage panel lets you specify:

 l The exchange rate that   you want to use if this is a multicurrency receipt. You can: 

 l Use the original document   exchange rate (entered for the PO)

 l Use the current exchange   rate

 l The retainage terms (defined   in the Accounts Payable program). You can override 
the general terms with   a percentage and retention period on each detail line.

Note: This tab will appear only if the receipt is job-related and you use   retainage accounting.

Taxes Tab

Retainage Tax Amount

This field appears on the Taxes tab for Receipt Entry, Invoice Entry,   Return Entry, and Credit/Debit 
Note Entry if retainage applies to the   document. 

It shows the amount of tax calculated for this authority for the retainage   portion of the document if 
you report tax for retainage amounts when you   create the retainage document (not when you 
create the original document).   

Retainage appears only on job-related documents if you select   the Retainage option on the first tab 
of the transaction entry screen.

Retainage tax amounts are computed using the retainage tax base and   the tax rate for each tax 
authority. 
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Retainage Tax Base

The retainage tax base is the amount (before included taxes) used as   the base for calculating taxes 
on the retained amount.

Essentially, the retainage tax base is the retainage portion of the   document (excluding tax) if you 
report tax for retainage amounts at the   time that you create the retainage document (not when you 
create the original   document). 

Retainage appears only on job-related documents if you select   the Retainage option on the first tab 
of the transaction entry screen.

Retainage tax amounts are computed using the retainage tax base and   the tax rate for each tax 
authority. 

Reverse Charges Amount

From all details in the document, the total of reverse chargeable tax amounts owed to a tax 
authority, if the Reverse Charges Base for the tax authority is above the reverse charges threshold 
amount for the tax authority. If the Reverse Charges Base is not above the reverse charges 
threshold amount, this field displays 0.

Note: The amount in this field is calculated automatically, but you can change it.

Reverse Charges Base

From all details in the document, the total of Tax Base amounts used to calculate reverse 
chargeable tax amounts owed to a tax authority.

Tax Amount

The program displays the total tax amount calculated for each authority   in the primary vendor's tax 
group. You can change this amount, if necessary.   

To cancel all your changes to tax amounts at the same time, click the   Calculate Taxes button. 

Tax Authority and Description                             

These columns list the codes and corresponding descriptions for all the tax authorities in the tax 
group specified for the document. 

You enter tax information in the Tax Services module in Common   Services. 
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Tax Base                              

The net cost of an item for which tax is included in its price.

Tax Group

For new vendors (not yet added to Accounts Payable), type the tax group   that identifies the tax 
authorities to which the vendor is subject, or   select the group from the Finder. You must use a tax 
group that is defined   for your company in Common Services.

When entering a receipt for an existing vendor, you can change the tax group that appears as the 
default. 

You must enter a valid tax group for every receipt vendor.

Tax Included

The program displays the total amount of tax that is included in item costs for the authority.

You can include tax amounts in item costs only if permitted by the authority.

Tax Excluded                               

The program displays the total amount of tax that is not included in   item costs for the authority.

Tax Reporting Currency

Tax reporting fields appear on the Taxes tab only if the tax group's tax reporting currency is different 
from your functional currency and the vendor's   currency.

Along with the tax reporting currency, the program displays the amount of included   and excluded 
tax to be reported in that currency on tax tracking reports   for all the tax authorities listed on the 
document.

You set the tax reporting currency for tax groups in the Tax Services module   in Common Services.                    

Tax Reporting Amount

The Tax Reporting Amount appears only if the tax reporting currency for one or more of the tax 
group authorities is different from your functional currency and the vendor's currency.

You set the tax reporting currency for taxes in the Tax Services module in Common Services.
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On the Taxes tab, this field is the sum of the tax reporting amounts for all tax authorities. You can 
change the amount on the Taxes tab (for example, if you also change the Tax Amount, and then 
derive the Tax Reporting   Exchange rate on the Rates tab).

If you edit this amount, but leave the exchange rate, the tax reporting amount will be recalculated if 
you click the Calc. Taxes button.

This field also appears for each detail line on the zoomed Detail Items/Taxes screen.

Total Retainage Tax

This field appears on the Taxes tab for Receipt Entry, Invoice Entry,   Return Entry, and Credit/Debit 
Note Entry if retainage applies to the   document.

It shows the total amount of tax calculated for the retainage portion   of the document if you report tax 
for retainage amounts when you create   the retainage document (not when you create the original 
document). 

Retainage appears on job-related documents only  if you select   the Retainage option on the first tab 
of the transaction entry screen.

Retainage tax amounts are computed using the retainage tax base and   the tax rate for each tax 
authority. 

Total Tax

This field displays the total tax amount calculated for each authority   in the vendor's tax group. You 
can change this amount, if necessary. 

To cancel all your changes   to tax amounts at the same time, click the Calculate Taxes button. 

Vendor Tax Class and Tax Class Description

These columns list the tax classes that   are assigned to the tax authorities to which the vendor is 
subject, and their corresponding descriptions. 

You can change a tax   class to another tax class that is assigned to the authority, but not   the 
description.

To change the description for the tax class or make other changes   for the specified tax group, use 
the Tax Services screens in Common Services. 
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Totals Tab

Comment

Type an optional comment for the receipt, using up to 250 characters. The program automatically 
wraps text as you reach the end of a line. If you wish to insert your own line breaks, press the Ctrl 
and Enter keys where you want a line break to occur.

Estimated Tax

This is the tax amount that will be applied to the retainage invoice if the tax authority allows you to 
defer tax on retained amounts.

Retainage amounts are invoiced at a later time, in the Accounts Payable module.

Excluded Tax 

The program displays the total amount of tax that is not included in   item costs for the authority.

Included Tax 

The program displays the total amount of tax that is included in the   primary vendor's item and 
additional costs for the authority.

You use the Tax Services screens to specify whether a tax authority allows   tax-included costs in 
item prices.

Less Receipt Discount

You can enter an optional discount percentage or discount amount   for the entire document, or enter 
discounts for individual detail lines.

If you enter a discount for the entire document, Purchase Orders   prorates the discount amount for 
the document details, overriding any discounts   you may have entered manually for the details.

Less Retainage

This field appears if the receipt is job-related and includes retainage   amounts (in other words, will 
have amounts held back on the invoice).   

The Net Receipt total is the amount of that will be invoiced from this   receipt.
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Retainage amounts are invoiced at a later time, in the Accounts Payable   module.

Number of Costs                            

The program displays the number of additional cost detail lines you   entered for the document.

Check this number against source documents to make sure you entered   all the details you require.

Number of Lines                               

The program displays the number of item detail lines you entered for the   primary vendor on the 
document.

Check this number against source documents to make sure you entered   all the details you require.

Plus Additional Costs 

The program displays the total amount of additional cost details for   the primary vendor on the 
receipt, excluding taxes (except taxes that   are included in the cost amounts).

Plus Excluded Tax 

The program displays the total excluded tax amount of all item and additional   cost details for the 
primary vendor on the receipt. This amount does not   include taxes that are included in the cost 
amounts.

Receipt Detail Subtotal 

The program displays the total of all item detail costs entered for   the primary vendor on the receipt, 
including tax-included amounts. This   subtotal does not include tax amounts that are not included in 
item costs   or the additional costs you added for the primary vendor.

Receipt Total 

The program displays the total of all item and additional costs and   taxes for the primary vendor. 

Total Reverse Charges

The total of Reverse Charges Amounts for the document.
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Total Tax 

The program displays the sum of the included and excluded taxes calculated   on the receipt for the 
primary vendor. It does not include tax amounts   calculated for secondary vendors. 

Total Weight 

The program displays the total estimated weight of the receipt, calculated   from the weight you enter 
for each item detail.

Use this amount to check shipping charges for the order.

P/O Receipt Entry Bill-To Location Screen

To Open this Screen

 1. Open Purchase Orders > P/O Transactions > Receipt Entry.

 2. Click the Zoom  button beside the Bill-To Location field, or press       the F9 key in the field.

Overview   

Use the Bill-To Location screen to edit an existing bill-to location address, or to enter    a new billing 
address for the receipt.

Note: You do not have to enter a bill-to location code or address information. 

Fields and Controls

Address

Use the Address field to type the address for the location, or edit the displayed information   if 
necessary.

Bill-To Location 

If you use Inventory Control and you selected a bill-to location code,   the program displays the 
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location code.

If you do not use Inventory Control, you can click the Zoom  button beside the field name.

Enter the bill-to location information by typing   in the screen that appears.

Contact

Enter the name of a contact person, department, or position.

Description

Use the Description field to type a description of the location, such as a company name, or edit   a 
displayed description if necessary. You do not have to include a description.

E-mail

Use the E-mail field to type the e-mail address for the location, or edit the displayed address   if 
necessary.

Fax Number

Use the Fax Number field to type the fax number for the location or edit a displayed number if 
necessary.

Phone Number

Use the Phone Number field to type the telephone number for the location or edit a displayed 
number   if necessary.

P/O Receipt Entry Ship-To Location Screen

To Open this Screen

 1. Open Purchase Orders > P/O Transactions > Receipt Entry.

 2. Click the Zoom  button beside the Ship-To Location field, or press       the F9 key in the field.
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Overview   

Use the Ship-To Location screen to edit an existing ship-to location address or to enter    a new ship-to 
address for the receipt.

Note: You do not have to enter a ship-to location code or address information.

Fields and Controls

Address

Type the address for the location where goods are to be shipped, or edit the displayed information   if 
necessary.

Contact

Type the name of a contact person, department, or position at the ship-to   location, and enter a 
phone number, fax number, and e-mail address if   appropriate (or edit the displayed contact).

Description

Type a description of the location, such as a company name, or edit   displayed information if 
necessary.

Fax Number

Type the fax number for the location, or edit displayed number if necessary.

Phone Number

Type the phone number for the location, or edit displayed number if necessary.

Ship-To Location (display only)                     

The program displays the code for the specified ship-to location, if any.
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P/O Receipt Entry Drop-Shipment Address Screen

To Open this Screen

 1. Open Purchase Orders > P/O Transactions > Receipt Entry.

 2. On the Details table, for a selected detail line, click in the Drop-Ship field, then click the Zoom 

 button   (or press the Shift and F9 keys at the same time).

Overview   

Use this screen to enter or edit address information for a detail where     the goods were shipped directly 
to an address other than the inventory    location specified for the detail line.

To enter a drop-shipment address:

 1. In the Drop-Shipment      Address screen, select the type of address to enter.

 2. Select      the location code, customer number, or ship-to location code for the address, as 
needed.

 3. Type the address or edit      displayed information.

 4. ClickClose.

To edit a drop-shipment address:

 1. Make the changes you need in the Drop-Shipment      Address screen. You can change all the 
information in the screen, including the type of      address.

 2. When finished, clickClose.

To delete drop-shipment addresses:

On the Receipt tab, change the entry in the Drop-Ship field to No for the selected detail, or clear the 
Drop-Ship option on the Detail Items/Taxes     form (click the field or press the Shift and F9 keys at the 
same time    in it).

Fields and Controls

Address

Type the address information for the drop-shipment, or accept the displayed   information.
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If you are creating a receipt from a purchase order, information entered   with the drop-shipment 
address on the purchase order is displayed, but   you can change it.

Contact

Type the name of the contact person or position at the drop-shipment   address, and enter a phone 
number, fax number, and e-mail address if appropriate   (or accept the displayed information).

If you are creating a receipt from a purchase order, the contact, if   any, entered with the drop-
shipment address on the purchase order is displayed,   but you can change it.

Customer Number

This field appears if you selected Customer Number or Customer Ship-To   Address in the Set Drop-
Ship Items To field.

To enter a drop-shipment to a customer from your Accounts Receivable   database, type the 
customer number or select it from the Finder.

When you enter a customer number, the address and other information   entered for the customer in 
Accounts Receivable is displayed, but you   can change it.

If you are creating a receipt from a purchase order, the program displays   the customer number, if 
any, entered with the drop-shipment address on   the purchase order.

Customer Ship-to Location

This field appears if you selected Customer Ship-To Address in the Set   Drop-Ship Items To field.

Type the code for the customer's ship-to location, if any, at which   the drop-shipped items were 
received, or select the location from the   Finder. You can enter a ship-to location only if you have 
defined ship-to locations in   Accounts Receivable for the customer. 

When you enter a ship-to location code, the address and other information   entered for the location is 
displayed, but you can change it.

If you are creating a receipt from a purchase order, the program displays   the customer ship-to code, 
if any, entered with the drop-shipment address   on the purchase order.

Description

Type the name of the person or a description of the location which received   the drop shipment.
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If you are creating a receipt from a purchase order, the description,   if any, entered with the drop-
shipment address on the purchase order is   displayed, but you can change it.

E-mail

Type the e-mail address for the location to which the items were drop-shipped.

If you are creating a receipt from a purchase order, the e-mail address,   if any, entered with the drop-
shipment address on the purchase order is   displayed, but you can change it.

Fax Number

Type the fax number at the location where the drop-shipment was received.

If you are creating a receipt from a purchase order, the fax number,   if any, entered with the drop-
shipment address on the purchase order is   displayed, but you can change it.

Location

This field appears if you use Inventory Control and you selected Inventory   Location Address in the 
Drop-Ship Items To field.

If items were drop-shipped to an inventory location other than the location   specified for the detail 
line, type the location code or select it from   the Finder. When you select a location code, the address 
and other information   entered for the location in Inventory Control is displayed, but you can   change 
it.

If you are creating a receipt from a purchase order, the location code,   if any, entered with the drop-
shipment address on the purchase order is   displayed, but you can change it.

Phone Number

Type the phone number at the location to which the items were drop-shipped.

If you are creating a receipt from a purchase order, the phone number,   if any, entered with the drop-
shipment address on the purchase order is   displayed, but you can change it.

Set Drop Shipment Address To

Specify the type of drop-shipment address you are entering. You can   select:

 l Address Entered—  select this option when you want to type the address information for the   
shipment.
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 l Inventory Location Address—select this option when the   items were drop-shipped to a 
different Inventory Control location than   the designated receipt location.

 l Customer Address—  select this option when the items were drop-shipped to the address of   
one of your Accounts Receivable customers.

 l Customer Ship-To Address—select this option when the   items were drop-shipped to one of 
the ship-to addresses defined for the   customer in Accounts Receivable.

    Adding a New Secondary Vendor to a Receipt

To add an additional cost vendor to a receipt:

 1. On the Additional Costs tab, in the Vendor Number field, enter the vendor number, and then 
press the Tab key.

 2. Click the Zoom  button beside the Vendor Number field.

 3. In the Vendor Address Information screen that appears, enter the address and contact 
information for the new secondary vendor.

 4. When finished, click the Close button to return to the Additional Costs tab.

Note: To add a new Accounts Payable vendor, you must create a vendor record in the A/P 
program.

P/O Receipt Entry Detail Items/Taxes Screen

To Open this Screen

 1. Open Purchase Orders > P/O Transactions > Receipt Entry.

 2. Enter header information for the receipt, including the vendor number and, if you are receiving 
an existing purchase order, specify the purchase order number (or numbers if you are 
receiving multiple purchase orders).

 3. Select an existing detail or enter a new one, and then press F9 or click the Item/Tax       button.

Related Tasks

 l "Entering Receipts" (page 134)

 l "Printing Receiving Slips" (page 224)
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 l "Receiving and Invoicing Serialized Items   " (page 187)

 l "Receiving and Invoicing Lotted Items" (page 189)

Overview   

Use this screen to add, edit, and delete receipt detail lines. You also use it to edit the tax classes and 
tax-included options    for individual receipt details.

This screen displays the fields for a single detail in a separate window,     letting you see all the 
information you entered for the detail, including    tax information. 

Fields and Controls

Buttons

Calc. Taxes

Click the Calc. Taxes button to see tax amounts for   a detail before you post the document. 

Note: Tax amounts are not   calculated automatically until you click the Taxes tab or the Totals tab, 
or you post the purchase order.

Close

Click the Close button to close the Detail Items/Taxes screen.

On the Detail Items/Taxes screen and the Detail Costs/Taxes screen, you can also press the F9 key 
on your keyboard to close the screen.

Delete

Click the Delete button to delete the detail displayed in the zoomed detail-entry screen.

Save/Add

Use the Save button to save the changes you made to a detail you edited in the Detail Items/Taxes 
screen.

For a new detail, this button is called Add.
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Allocated Tax  

The program displays the total tax amount that has been allocated to the   detail, including taxes that 
are included in the item cost. Recoverable   and expensed tax amounts not included.

Allocated taxes form part of the item costs that are posted to the Inventory   Control item records by 
Day End Processing.

Arrival Date

Type the date on which you received the items. The program displays   the session date as the 
default, but you can change it.

Comments 

To view comments for a selected detail line, click the Zoom  button beside the Comments field. 

The program displays any comments entered for the detail line on   the receipt, but you can change   
or delete them.

Tip: You can also press the Shift and F9 keys together to open   or close the screen using your 
keyboard.

To enter comments for the selected detail, click the Detail Comments table, press the Insert key, and 
then type the comments on the new line. 

Lines automatically wrap. If you want to start   a new line before the line wraps, press Enter. 

For more information, see "P/O Detail Comments Screen" (page 503).

Discount %

You can enter a discount as a percentage or an amount. The program uses the amount you enter in 
this field to calculate the   discounted cost for the item detail. 

If you enter a percentage in this field, Purchase Orders calculates   the discount amount for the item 
detail.

Tip: If you prefer not to enter discounts for individual details, you can   enter a discount percentage 
for the entire document on the Totals tab. Purchase   Orders then prorates the discount amount for 
the transaction details,   overriding any discounts you may have entered manually for the details.
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Discount Amount

The program uses the amount you enter in this field to calculate the discounted extended cost for 
the item detail. If you enter a discount amount, the program calculates and displays the discount 
percentage based on the extended cost. (Alternatively, you can enter a percentage in the Discount 
% field, and let the program calculate the discount amount.)

If you prefer not to enter discounts for individual details, you can   enter a discount amount for the 
entire receipt on the Totals tab. Purchase   Orders then prorates the discount amount for the 
document details, overriding   any discounts you may have entered manually for the details. 

Discounted Extended Cost

The program displays the item cost, less the discount amount, in this field.

Drop Ship

To enter a drop-ship address for a detail, click the Zoom  button beside the Drop Ship field, or 

select the field and press Shift+F9. 

Select the type of address to enter, and if necessary, select the   location code, customer number, or 
ship-to address code for the address.

Expense Account

You specify a general ledger expense account for non-inventory item   details. You can select general 
ledger   account numbers using the Finder.

The program displays the number entered with the detail on the   purchase order, if any, or the 
account number specified on the P/O Options   screen for the Default Inventory Expense Account 
option, but you can change   the number on the receipt. 

Extended Cost

Type the extended cost for the number of units of the item that you received.

If you change the extended cost, the program automatically recalculates the unit cost.

Note: If security is turned on in Sage 300, you cannot see this field unless you are authorized to 
view costing information.
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Extended Weight

Type the extended weight for the number of units of the item that you received.

If you change the extended weight, the program automatically recalculates   the unit weight.

The total weight for all items on the document is displayed in the Totals   tab.

Item Number 

The program displays the item number entered for the selected detail line. 

Line Number

To select an existing line to edit or delete, click the line, or   enter its line number in this field on the P/O 
Detail Items/Taxes screen.

Note: You cannot   delete completed lines.

Location

This field appears only if you use Inventory   Control.

Enter the code for the location where you expect to receive the shipment   (or to which you want to 
post drop-shipped items). 

The program displays the ship-to location code, if any, entered on the   first tab, but you can select a 
different location. You can omit the location   when adding details for non-inventory items.

Note: If you change  locations after assigning serial and/or lot numbers, you must re-assign the 
serial and/or lot numbers.

Net Of Tax             

This field displays the extended item cost, minus any applicable tax   amount. You cannot edit the 
amount.

Number of Labels

If you want to print item labels for the received items, type the number  of labels to print. 

621Sage 300 2021 Purchase Orders User's Guide



Note: 
You use the Item Labels screen in Inventory Control   to print the labels.

In the Inventory Control Item Labels screen, select Received in the For Each Item field, then 
specify the receipt numbers for which you want to print labels. The program then prints the 
number of labels you specified   for each item detail on a selected Purchase Orders receipt.

You cannot specify a number of labels for non-inventory item details.

Optional Fields 

If optional fields have been defined in Purchase Orders for receipt details, you can click the Zoom 

 button beside the Optional Fields field to display the optional fields assigned to a selected detail, 

and edit their contents.

For more information about using optional fields in transactions, see "About Optional Fields in 
Transactions" (page 80). 

Quantity Canceled

Type the number of units to cancel for the detail (the number of units,   if any, that you do not expect 
to receive). 

You can enter a canceled quantity only   when you are editing a detail from a purchase order. When 
you post the   receipt, the Quantity Outstanding field on the purchase order is reduced   by the number 
of units you canceled on the receipt.

Quantity Outstanding

You can enter an outstanding quantity (the number of units not yet received   or canceled) on detail 
lines only   when you are entering a receipt to a purchase order.

The Quantity Outstanding field is automatically updated by the program   when you post a received 
amount, but you can also type the outstanding   quantity.

To reduce the outstanding quantity on an existing detail line you are   editing, enter the desired 
amount; enter zero to complete a line and cancel   remaining outstanding units.

When you post the receipt for a purchase order, the outstanding quantities   are reduced on the 
purchase order. If you post a receipt for the full   outstanding quantity or for a larger quantity than was 
specified on the   purchase order, the purchase order detail is completed.
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Quantity Received

Type the number of units of the item that you received. 

When entering received units for a purchase order detail, you can enter   a greater number than are 
outstanding for the detail, if necessary.

When you post the receipt, the outstanding quantity on the purchase   order (if any) is updated with 
the number of received units, and any purchase   order details for which you did not enter a received 
quantity are deleted   from the receipt. You must add a new receipt to receive the other details   on the 
purchase order.

Note: If   this is a job-related receipt, you should enter the quantity using the   unit of measure that 
was used for the estimate in Project and Job Costing.   Purchase Orders does not convert   the 
quantity received when it sends the quantity to PJC if the units of   measure are different.

If you use Serialized Inventory and Lot Tracking, and the item is serialized or lotted,  a separate 
Generation/Allocation screen appears after you enter the quantity of serialized or lotted   items 
received, then press Tab or Enter. You use this screen to assign serial/lot numbers for the item. 
(This screen also   opens when you click the Zoom button beside the Quantity field.)

Received To Date 

The program displays the number of units of the item that have already   been received on the 
receipt.

Tax Included 

This field displays the total amount of tax that is included in the extended   item cost (when the cost 
includes tax).

Unit Cost 

Enter the cost of a single unit of the item you are ordering in the detail.   

Purchase Orders displays a default cost as follows:

 l If you have set up vendor   contract costs, Purchase Orders displays the cost specified as a 
contract   cost for the item and unit of measure. 

 l If P/O does not find a   valid contract cost, it uses the inventory cost specified on the P/O 
Options   screen.
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Use the Finder  to view any vendor contract costs, regular   vendor costs, and other costs 

maintained by Inventory Control.

Purchase Orders uses the unit cost to calculate the extended cost. If you   change the unit cost, the 
extended cost is recalculated.

In multicurrency ledgers, the cost is expressed in the vendor's currency.

Note: You can assign security to the Unit Cost and Extended    Cost fields, to prevent unauthorized 
changes to the fields.

If you use Project and Job Costing, unit cost is defaulted as follows:

 l If   the project is a standard project:

 l For a category cost   class of Subcontractor, Overhead, or Miscellaneous Equipment, 
the unit   cost is defaulted from the category resource.

 l For a category cost   class of Labor, the default unit cost is based on the Default Unit 
Cost   From option for the employee resource category.

 l For a category cost   class of Material (if you are using Inventory Control), the default 
unit   cost is based on Purchase Orders' default item cost (set in P/O Options).

 l For a category cost   of Material (if you are not using Inventory Control), the unit cost is   
based on Purchase Orders vendor costs.

 l If   the project is a basic project:

 l For a category cost   class of Subcontractor, Overhead, or Miscellaneous Equipment, 
the unit   cost is defaulted from the category.

 l For a category cost   class of Labor, the default unit cost is based on the Default Unit 
Cost   From option for the labor category.

 l For a category cost   class of Material (if you are using Inventory Control), the default 
unit   cost is based on Purchase Orders' default item cost (set in P/O Options).

 l For a category cost   of Material (if you are not using Inventory Control), the unit cost is   
based on Purchase Orders vendor costs.

Unit of Measure

Type the unit of measure in which you received the item, or select it   from the Finder. 

You must use one of the units of measure that is assigned to the item   in Inventory Control. On new 
detail lines, the program displays the stocking   unit of measure. 
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If you are creating a receipt from a purchase order, the unit of measure   entered for the detail on the 
purchase order is displayed, but you can   change it.

If this is a job-related receipt, you should use the unit of measure   that was used for the estimate in 
Project and Job Costing. Purchase Orders   does not convert the quantity received when it sends the 
quantity to PJC   if the units of measure are different.

Unit Weight

Enter the weight of a single unit of the item you are ordering in the   detail. On new detail lines, the 
weight specified in the Inventory Control   item record is displayed, but you can change it.

Purchase Orders uses the unit weight to calculate the extended weight. If   you change the unit 
weight, the extended weight is recalculated.

You can select from the weight units of measure defined in Purchase   Orders. Weight is expressed in 
the unit selected   for the Weight Unit Of Measure option on the I/C Options   screen.

On invoices, enter the weight of a single unit of the item for which you were invoiced.   The program 
displays the weight specified for the item on the receipt   but you can change it.

Purchase Orders uses the unit weight to calculate the extended weight. If   you change the unit 
weight, the extended weight is recalculated.

You can see the total weight estimated from your entries for the invoiced   items on the Totals tab.

Vendor Item Number             

Enter the code the vendor uses to identify the item. 

If the vendor's item number is specified in the Inventory Control item   record, the code appears in this 
field. (Enter vendors' item numbers when   assigning vendor types in Inventory Control item records.)

If the vendor's item number is specified on the receipt for which you   are entering an invoice, the 
code appears in this field. (You can enter   vendors' item numbers when assigning vendor types in 
Inventory Control   item records.)

Weight UOM

This is the unit of measure for the weight of this item on the receipt—such as pounds, kilograms,   tons.

The program displays the weight unit of measure from the   purchase order as the default, but you 
can change it to another defined unit of measure   (and the program will recalculate the weight 
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accordingly). For example,   the item might arrive in differently sized bags than were ordered, leading   
you to change the UOM.

The weight UOM for the complete order is determined by the default weight   unit of measure set in 
the I/C Options screen (or in the P/O Options screen if you do not use Inventory Control).

Tax table

Allocated Tax             

This column displays the tax amounts allocated to the selected detail   line for each tax authority.

Detail Tax Class and Description

These columns list the tax classes and corresponding descriptions that   are assigned to the tax 
authority. You can change the tax   class (to another tax class that is assigned to the authority), but 
not   the description.

To change the tax class description or make other changes to the information   for the specified tax 
group, use the Tax Services screens in Common Services. 

Expensed Tax

The program displays the amount of tax that is separately posted (expensed)   to a general ledger 
account, rather than allocated to details on the credit   note or debit note.

Recoverable Tax 

The program displays the amount of tax that can be recovered by your   company, such as, for 
example, recoverable Canadian Goods and Services   Tax (GST) amounts.

Reverse Chargeable

Indicates if the tax amount owed to a tax authority for a detail may become a reverse charge.

A reverse chargeable tax amount will not necessarily become a reverse charge. Tax amounts 
become reverse charges only if the Reverse Charges Base for the tax authority to which the tax 
amounts are owed (shown on the Taxes tab) is above the reverse charges threshold amount for the 
tax authority. For more information about threshold amounts, see the Tax Services help.
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Tax Amount 

The program displays the amount of tax that is due for each authority.

For each authority, Purchase Orders calculates a tax amount if:

 l The vendor is subject to tax.

 l The transaction contains taxable items or taxable additional costs.

 l Tax rates are specified for the tax authorities and classes in Tax Services.

You cannot edit the tax amount for a detail except indirectly, by changing   the tax class or tax-
included option on the Detail Items/Taxes screen.

To edit tax amounts for the invoice, make your changes on the Taxes   tab.

Tax Authority and Description                                              

These columns list the tax authorities and   that are assigned to the tax group you specified for the 
document.

Tax information is maintained in the Tax Services screens in Common   Services.

Tax Base 

This field shows, for the selected detail, the net cost   of items before tax is added for the tax 
authority. You cannot change   the amount that appears in this field.

This field is particularly useful for items that have tax included in   their prices.

Tax Included                                     

This field displays the amount of tax that is included in the extended   item cost (when the cost 
includes tax).

P/O Lot Numbers Generation/Allocation Screen

To Open this Screen

 1. Open Purchase Orders >       P/O Transactions >       Purchase Order Entry or Invoice Entry.

 2. Enter a value       in the Quantity Received field, and then press either the Enter key or      the Tab 
key.
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Related Tasks

 l "Receiving and Invoicing Lotted Items" (page 189)

Overview   

When you receive lotted items from vendors in Purchase Orders, the program prompts you to assign 
lot numbers.

Note: Lot numbers are used for tracking stock from the point of receipt through   to the point of sale, 
and can be used to track returned items from the   customer and back to the vendor.

You use the same procedure when entering a vendor invoice, except you start with the Invoice Entry 
screen instead of the Receipt Entry screen.

Assigning Lot Numbers During Receipt Entry or Invoice Entry   

You can assign lot numbers when you receive lotted items or when you     create the invoice for the 
items, provided the item does not use the lot     costing method and the Allow Lot Quantity To Be 
Different From The Quantity    In The Entries option is selected on the I/C Items screen.

Generally, there are not big differences in assigning numbers during     receipt or invoicing. However, 
there can be an    impact when using the Inventory Control Lot Inquiry report.

Note: If you chose not to assign numbers in the PO receipt screen,     but did so using the PO Invoice 
screen, the cost that appears in the Inventory     Control Lot Inquiry report will be zero, as this inquiry 
reports only     the net change from the time of receipt to invoice, not the original receipt    cost.    

Example: Say you enter the cost of a lotted item as two dollars during receipt entry, but you do 
not assign the lot number. Then,     you use the Invoice Entry screen to enter the lot number, and 
you change     the cost of the item to three dollars. The value that appears on the I/C    Lot Number 
Inquiry for that transaction is one dollar.

Fields and Controls

Buttons

Add

Click the Add button to add   the lot or serial number displayed in the Next Lot Number or Next 
Serial   Number field.
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Auto Alloc

Click the Auto Alloc button   to automatically allocate lot numbers to the items. The required number   
of lot numbers appears in the Lot Numbers list.

To start allocating from a specific lot number, specify this number   in the Auto-Allocate From field, 
before you click Auto Alloc.

Auto Gen

The Auto Gen button appears if you had selected the option Allow Auto-Generation of Lot 
Numbers in PO on the Settings tab of the   I/C Options screen.

When you click the Auto Gen button, a dialog box opens, where you indicate   how many lot numbers 
need to be created.

Clear

Click the Clear button to remove lot   numbers or quantities allocated, or both, depending on the 
screen.

Close

Click the Close button to end the lot number allocation process.

Auto-Allocate From

Use the Auto-Allocate From field   to specify the starting lot number from which to automatically 
allocate   the lot numbers.

 1. Select the Auto-Allocate   From check box to display a field beside it.

 2. In this field, use the   Finder to find and select a starting lot number, or enter it manually.   

 3. Click the Auto   Allocate button to allocate the required number of lot numbers,   starting from 
the specified number.

Make Lots OR Each Has

When you auto-generate lots, you must enter a number in one of these   fields to define how the lots 
are generated:
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 l Make   __ Lots. If you want to create a fixed number of lots, with the   quantity evenly distributed 
across all of the lots, enter the number of   lots.

Example: If you create 10 lots and have 400 items,   each lot will have 40 items.

OR 

 l Each   Lot Has __. If you want to distribute a fixed quantity to each   lot, enter the number to 
include in each lot.

Example: If  you want to have 50 items in each lot,          the process will generate the number of lots 
needed to accommodate the         quantity of items.

Next Lot Number

This field displays the next sequential lot number available for the   item. Depending on which buttons 
are displayed, you can use this number   in these ways:

 l Click Add   to add the displayed number to the Lot Numbers list. Repeat this for as   many 
numbers as you need.

 l Click Auto-Gen   to add the required number of lot numbers to the Lot Numbers list,   starting 
from the displayed number.

 l Click Auto-Alloc   to add the required number of lot numbers to the Lot Numbers list, starting   
from the displayed number.

When you finish, this field displays the next lot number that is now   available.

Count section

Allocated / Generated / Returned count

This display field indicates how many lot numbers have been selected.

Lot Qty Required

This field indicates how many lot numbers are required, as indicated   on the quantity field from which 
you accessed the Lot Numbers Allocation   pop-up.

Remaining

This figure represents the quantity still to be entered on the Lot Tracking   pop-up screen. This 
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number should be zero after you have finished allocating   lot numbers.

P/O Serial Numbers Generation/Allocation Screen

To Open this Screen

 1. Open Purchase Orders > P/O Transactions >  Receipt Entry or Invoice Entry.

 2. Enter a value        in the Quantity Received field, and then press either the Enter key or the Tab key 
to display the Serial Numbers Generation/ Allocation screen.

Fields and Controls

Buttons

Add

After entering a number in the New Serial Number field, click the Add   button to add the number to 
the Generated Serial Numbers list.

Auto Alloc

After entering a serial number in the blank field above the Available   Serial Numbers list, click the 
Auto Alloc. button. The required serial   numbers will appear in the Returned Serial Numbers list, 
beginning with   that number.

Auto Gen

Click the Auto Gen button after entering a number in the New Serial   Number field, or after 
highlighting a number in the Existing Serial Numbers   list. 

The correct quantity of required serial numbers will appear in the   Generated Serial Numbers list, 
beginning with that number.

Clear

Click the Clear button to remove all the serial numbers listed in the   Generated Serial Numbers or 
the Returned Serial Numbers lists.
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A message appears, asking if this is what you really want to do.

Return All

On the Serial Numbers Allocation screen, click the Return All button   to return all of the items with 
the serial numbers listed. All of the lines in the Returned column are shown as Yes.

Note: Do not confuse this button with the Return All button on the Return   Entry screen, which is 
used to return all items listed on a selected invoice,   rather than on an individual detail line.

Auto-Allocate From

Use the Auto-Allocate From field   to specify the starting serial number from which to automatically 
allocate   the serial numbers.

 1. Select the Auto-Allocate   From check box to display a field beside it.

 2. In this field, use the   Finder to find and select a starting serial number, or enter it manually.   

 3. Click the Auto   Allocate button to allocate the required number of serial numbers, starting 
from   the specified number.

Next Serial Number

This field displays the next sequential serial number for the item.   Depending on which buttons are 
displayed, you can use this number in these   ways:

 l Click Add   to add the displayed number to the Serial   Numbers list. Repeat this for as many 
numbers as you need.

 l Click Auto-Gen   to add the required number of serial   numbers to the Serial Numbers list, 
starting from the displayed number.

 l Click Auto-Alloc   to add the required number of serial   numbers to the Serial Numbers list, 
starting from the displayed number.

When you finish, this field displays the next serial number that is   now available.

Unit of Measure

The default unit of measure displayed in the Serialized Inventory pop-up   is the same unit as on the 
underlying transaction.

632Sage 300 2021 Purchase Orders User's Guide



Count section

Allocated / Generated / Returned

This indicates how many serial numbers you have been selected.

Remaining

This indicates how many serial numbers still need to be assigned.

Serial No's Required

This field indicates how many serial numbers are required, as indicated   on the quantity field from 
which you accessed the Serial Numbers Allocation   screen.

Related Tasks

 l "Receiving and Invoicing Serialized Items   " (page 187)

Overview

When you receive serialized items from vendors in Purchase Orders, the program prompts you to 
assign serial numbers.

Note: Serial numbers are used for tracking stock from the point of receipt   through to the point of 
sale, and can be used to track returned items   from the customer and back to the vendor.

You use the same procedure when entering a vendor invoice, except you start with the Invoice Entry 
screen instead of the Receipt Entry screen.

Assigning Serial Numbers During Receipt Entry or Invoice Entry

You can assign serial numbers when you receive serialized items, or     when you create the invoice for 
the items, provided the item does not     use the serial costing method and the Allow Serial Quantity To 
Be Different     From The Quantity In The Entries option is selected on the I/C Items screen.    

Generally, there are not big differences in assigning numbers during     receipt or invoicing. However, 
there can be an    impact when using the Inventory Control Serial Inquiry report.
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Note: If you chose not to assign numbers in the P/O Receipt Entry     screen, but did so using the P/O 
Invoice Entry screen, the cost that appears     in the Inventory Control Serial Inquiry report will be 
zero, as this inquiry     reports only the net change from the time of receipt to invoice, not the     original 
receipt cost.    

Example: Say you enter the cost of a serialized     item as two dollars during receipt entry, but you 
don't assign the serial     number. Then, you use the P/O Invoice Entry screen to enter the serial 
number,     and you change the cost of the item to three dollars. The value that appears    on the I/C 
Serial Number Inquiry for that transaction is one dollar.

Fields and Controls

Buttons

Add

After entering a number in the New Serial Number field, click the Add   button to add the number to 
the Generated Serial Numbers list.

Auto Alloc

After entering a serial number in the blank field above the Available   Serial Numbers list, click the 
Auto Alloc. button. The required serial   numbers will appear in the Returned Serial Numbers list, 
beginning with   that number.

Auto Gen

Click the Auto Gen button after entering a number in the New Serial   Number field, or after 
highlighting a number in the Existing Serial Numbers   list. 

The correct quantity of required serial numbers will appear in the   Generated Serial Numbers list, 
beginning with that number.

Clear

Click the Clear button to remove all the serial numbers listed in the   Generated Serial Numbers or 
the Returned Serial Numbers lists.

A message appears, asking if this is what you really want to do.
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Return All

On the Serial Numbers Allocation screen, click the Return All button   to return all of the items with 
the serial numbers listed. All of the lines in the Returned column are shown as Yes.

Note: Do not confuse this button with the Return All button on the Return   Entry screen, which is 
used to return all items listed on a selected invoice,   rather than on an individual detail line.

Auto-Allocate From

Use the Auto-Allocate From field   to specify the starting serial number from which to automatically 
allocate   the serial numbers.

 1. Select the Auto-Allocate   From check box to display a field beside it.

 2. In this field, use the   Finder to find and select a starting serial number, or enter it manually.   

 3. Click the Auto   Allocate button to allocate the required number of serial numbers, starting 
from   the specified number.

Next Serial Number

This field displays the next sequential serial number for the item.   Depending on which buttons are 
displayed, you can use this number in these   ways:

 l Click Add   to add the displayed number to the Serial   Numbers list. Repeat this for as many 
numbers as you need.

 l Click Auto-Gen   to add the required number of serial   numbers to the Serial Numbers list, 
starting from the displayed number.

 l Click Auto-Alloc   to add the required number of serial   numbers to the Serial Numbers list, 
starting from the displayed number.

When you finish, this field displays the next serial number that is   now available.

Unit of Measure

The default unit of measure displayed in the Serialized Inventory pop-up   is the same unit as on the 
underlying transaction.

Count section

Allocated / Generated / Returned

This indicates how many serial numbers you have been selected.
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Remaining

This indicates how many serial numbers still need to be assigned.

Serial No's Required

This field indicates how many serial numbers are required, as indicated   on the quantity field from 
which you accessed the Serial Numbers Allocation   screen.

    P/O Fixed Assets Screen

To Open this Screen

 1. Open Purchase Orders > P/O Transactions > Receipt Entry.

 2. Enter receipt information as usual, including item details for the fixed assets.

 3. In in the detail line, double-click the Fixed   Assets column to display Yes, and then click the 
Fixed   Assets column heading.

Note: If you enter details using the Detail Items/Taxes screen, rather than the Details table, 

select   the Fixed Assets option, and then click the Zoom  button.

    Overview   

If you use Sage Fixed Assets to manage the fixed assets   in your company, you can also mark 
received goods as fixed assets, and   select the Sage Fixed Assets template that you want to use for 
the new asset. Sage 300 transfers the asset information to Sage Fixed Assets when you run Create   
Assets in Sage Fixed Assets Integration.

Fields and Controls

Asset Description

Use the Description field to enter the description that you want to   use for the asset in Sage Fixed 
Assets.
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Fixed Asset UOM

Type the unit of measure for the quantity you entered.

Fixed Asset Value

Type the value to book for the asset in Sage Fixed Assets.

Quantity

Enter the quantity of asset items that you are receiving.

If the quantity is more than one, and you want to create separate asset   records for each item in Sage 
Fixed Assets, select the Separate Assets option.

Separate Assets

If the quantity is more than one, and you want to create separate asset   records for each item in Sage 
Fixed Assets, select the Separate Assets option.

The program allocates the fixed asset value entered on the Fixed Assets screen proportionately to 
each Sage Fixed Assets record it creates. For example, for a quantity of 10 and a value of $25,000, 
the program creates 10 asset records with a value of $2,500 each.

Template

If you want to use a different template from the one displayed on the Fixed Assets screen , use the 
Finder for the Template field to select a different one.

Otherwise, either accept the default template code that appears or clear the entry from this field. 
(You do not have to use a template to create the asset in Sage Fixed Assets.)

P/O Receipt Entry Detail Comments Screen

To Open this Screen

 1. Open Purchase Orders > P/O Transactions >  Receipt Entry.

 2. On the Receipt tab , click the      Comments field for the detail line you need.

 3. Click the Zoom  button or press the Shift and F9 keys to open the Detail Comments screen.
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Use this screen to enter comments for a selected receipt detail line. You can    also print the remarks on 
the receiving slip. 

To enter or edit a comment:

 1. Type the comment, pressing Enter to start each new line.

 2. When finished, click Close to close the screen.

To delete comments:

 1. Highlight the text to       delete, then press the Delete key. If a message appears      asking you to 
confirm the deletion, click Yes.

 2. When finished, click Close      to return to detail entry.

Tip: You can also delete comments by changing the entry in     theComments field to No on the 
Receipt tab. If you use this method, your remarks are not deleted, but they     are not printed on the 
receiving slip. If you decide     to use the remarks later, change the Comment field to Yes. Your 
original remarks will reappear.     

P/O Receipt Entry Detail Costs/Taxes Screen

To Open this Screen

 1. Open Purchase Orders > P/O Transactions > Receipt Entry.

 2. Enter header information for the receipt. 

 3. On the Additional Costs tab, add or select a detail line, and then click the Cost/Taxbutton or 
press the F9 key.

Related Tasks

 l "Adding, Editing, or Deleting Additional Costs" (page 139)

Overview   

This screen displays the fields for a single detail in a separate window,     letting you see all the 
information you entered for the additional cost    detail, including tax information.

Use this screen to:
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 l Add, edit, or delete additional      cost detail lines.

 l Edit the tax classes and      tax-included options for additional cost details.

Fields and Controls

Additional Cost                                      

Type the code for the additional cost you want to add, or select the   code from the Finder. 

If you are adding a cost for which no code is defined,   skip this field and type the name of the cost in 
the Description field   (the field beside the Additional Cost field in the Detail Cost/Taxes   screen).

Note: You use the Additional Costs screen (in the P/O Setup folder) to maintain  the additional cost 
charges you use in Purchase Orders.

Allocated Tax                                       

This field displays the amount of allocated tax for the detail. (Allocated   taxes are included in the cost 
of the detail. Recoverable and expensed   taxes are not included in detail costs.) 

Amount

Enter the amount of the additional cost in this field.

Comments             

Enter an optional comment for the document.

Any comments you entered for the detail on the receipt are included   on the invoice, but you can 
change or delete them.

Lines automatically wrap when you reach the end. If you want to start   a new line before the line 
wraps, press Enter. 

Expense Account

If you are going to expense an additional cost, type the general ledger account number in this field, 
or select the account number using the Finder.
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Note: You do not enter a general ledger account number if you are prorating the additional cost.

Line Number

To select an existing line to edit or delete, click the line, or   enter its line number in this field on the P/O 
Detail Items/Taxes screen.

Note: You cannot   delete completed lines.

Net of Tax              

This field displays the net amount of the additional cost you entered   for the detail (excluding 
allocated taxes that are not included in the   amount of the cost).

Optional Fields

If optional fields have been defined in Purchase Orders for additional cost details in receipts, you can 

click the Zoom  button beside the Optional Fields field to display the optional fields assigned to a 

selected detail, and edit their contents.   

For more information about using optional fields in transactions, see "About Optional Fields in 
Transactions" (page 80). 

Proration Method

Specify whether to prorate the cost to the received items by cost, quantity,   or weight, or manually, or 
to expense the cost to a general ledger account.

Note: If you are adding additional costs for non-inventory items, you must   choose No Proration. 

Reference

Enter optional reference information for the detail.

Return Expense Account

In this field, enter the general ledger account number to which to post   prorated additional cost 
amounts if you   return items.
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Reproration / Return Proration                                       

This field is called Return Proration on the Detail Costs/Taxes screen.

Select the reproration method to use if you need to return any of the   received items and you did not 
select No Proration or Prorate Manually   as the proration method.

Note: You cannot expense job-related costs. 

Tax Included

This field displays the total amount of taxes included in   the additional cost amount.

Detail taxes

Allocated Tax 

The program displays the tax amount allocated to item details.   (Recoverable and expensed tax 
amounts are not included.) 

Allocated taxes form part of the item costs that are posted to the Inventory   Control item records by 
Day End Processing. 

Expensed Tax 

The program displays the amount of the tax that is separately posted   (expensed) to a general 
ledger account, rather than allocated to details   on the receipt. 

Recoverable Tax 

The program displays the amount of the tax that can be recovered by   your company, for example, 
recoverable Canadian Goods and Services Tax   (GST) amounts. 

Tax Amount 

The program displays the amount of tax that is due for each authority.

For each authority, Purchase Orders calculates a tax amount if:

 l The vendor is subject   to tax.

 l The additional cost is   taxable.
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 l Tax rates are specified   for the tax authorities and classes in Tax Services.

Tax Authority and Description

These columns list the tax authorities and corresponding descriptions   that are assigned to the 
specified tax group.

Tax authorities and other tax information is maintained in the Tax Services screens in Common   
Services.

Tax Base 

The net cost of an additional cost detail for which tax is included in its price.

Tax Class and Description

These columns list the tax classes and corresponding descriptions that are assigned to the tax 
authority. In this screen, you can change the tax class (to another tax class that is assigned to the 
authority), but not the description.

To change the description for the tax class or make other changes   for the specified tax group, use 
the Tax Services screens in Common Services. 

Tax Included

Use this field to indicate whether tax amounts are included in the additional cost (instead of charged 
separately on the detail cost).

To toggle between Yes and No in this field, type any character in the field, or double-click the field.

P/O Receipt Entry Cost Allocation Screen

To Open this Screen

 1. Open Purchase Orders > P/O Transactions > Receipt Entry.

 2. Enter header information for the receipt, specifying the purchase order numbers for which you 
are creating the receipt. 

 3. Click the Additional Costs tab.
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 a. Select the additional cost you need to distribute.

 b. Click the Dist. Cost button to open the Cost Allocation screen.

Related Tasks

 l "    Distributing Additional Costs to Multiple Receipts on a Debit Note" (page 178)

Overview   

Use the Cost Allocation screen to distribute an additional cost to more than one    receipt.

Note: This screen is available only if you are adjusting an existing additional cost from an invoice 
that is based on multiple receipts. 

You cannot automatically prorate the costs to multiple receipts. Instead, you identify the amount to 
distribute to each receipt on the debit note.

You can prorate and allocate the additional cost amount manually, or     you can let Purchase Orders 
automatically allocate amounts to receipts    according to the proration method identified on the 
Additional Costs tab.

Fields and Controls

Buttons

Clear

Use the Clear button to clear all amounts in the screen.

Dist. Cost

Use the Dist. Cost button to open the Cost Allocation screen for an additional cost detail.

Redistribute

Use the Redist. button to have Purchase Orders automatically prorate   the additional cost amount 
for the receipts.
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Amount (additional cost detail total)

The program displays the amount you enter for the additional cost detail at the top of the Cost 
Allocation screen.

Amount (prorated for each receipt)

The program displays the amount of the additional cost allocated to   each receipt when you click the 
Redist. button.

Note: To allocate the additional cost manually, you can enter   amounts beside each receipt 
number. The sum of all the amounts you allocate   to receipts must equal the total amount for the 
additional cost.

Billing Rate

If the receipt was job-related, Purchase Orders displays a billing rate   for the cost that you are 
allocating, along with the amount being allocated.

Note: The   billing rate is also used to allocate additional costs to more than   one receipt.

If you are prorating the cost manually to other receipts, you can enter   a different billing rate with 
each distribution.

Proration Method (display only)

You cannot change the proration method for an existing additional cost. 

Receipt Number

The program displays the receipt numbers used in this invoice, credit   note, or debit note. You cannot 
change the receipt numbers.

Retainage Percentage, Amount, and Period

If the receipts were job-related and the credit note or debit note uses the retainage option, the   
program displays additional retainage fields for each receipt to which   you can allocate additional 
costs.

The default retainage percentage and retention period that appears in   these fields depends on how 
you are prorating the costs.
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 l If prorating by cost,   quantity, or prorating manually, the settings come from the vendor record.

 l If you are not prorating,   the retainage settings are based on the Default Retainage From 
option   for the contract in Project and Job Costing.

P/O Receipt Entry Additional Cost Vendor Information Screen

To Open this Screen

 1. Open Purchase Orders > P/O Transactions > Receipt Entry.

 2. Enter header information for the receipt, including the primary vendor.

 3. On the Additional Costs       tab, select a secondary vendor for an existing additional cost, or use 
the Vendor Number field to specify a different vendor for a new additional cost. Mo re ...

Use the navigation buttons beside the Additional Cost Vendors field       to select an existing 
secondary vendor or use the Finder to view the secondary       vendors associated with the 
receipt, then select from the list the vendor      whose information you want to review.

Note: The code for the secondary vendor appears in the Vendor    Number field after 
selecting it using the Additional Cost Vendor field.

 4. Beside the Vendor       Number field (with the vendor code displayed), click the Zoom  button to      
display the address information for the secondary vendor.

Related Tasks

 l "    Adding a New Secondary Vendor to a Receipt" (page 617)

Overview   

Use this screen when adding or editing additional costs from secondary vendors    to enter or edit the 
vendor's      address, contact information, phone number, or fax number.

Note: A secondary vendor is a vendor who charged you for additional costs on a shipment   of goods 
(for example, freight, customs brokerage fees, or special handling), but who did not supply the 
actual goods. You cannot enter item details for secondary vendors. You enter only the additional   
cost details.
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Fields and Controls

Vendor Name (display only)

For new vendors, type the vendor name. You cannot edit this field for   existing vendors.

Vendor Number and Name

If you used the buttons beside the Additional Cost Vendors   field to select an additional cost vendor 
that you have already added to this receipt, the program displays the selected vendor number in this 
field.

You can always add an additional cost vendor to a receipt for which you have not yet created an 
invoice. You can use the Finder to select a vendor that exists in Accounts Payable, or you can add a 
new additional cost vendor.

For information about adding a new secondary vendor to a receipt, see "    Adding a New Secondary 
Vendor to a Receipt" (page 617).

Address

Type the vendor's address (for a new vendor) or edit a displayed address   if necessary.

Contact

Type the name of a contact person, department, or position at the vendor's   place of business, and 
enter a phone number, fax number, and e-mail address   if appropriate.

Fax Number

Type the vendor's fax number or edit a displayed number if necessary.

Phone

Type the vendor's phone number or edit a displayed number if necessary.
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P/O Receipt Entry Additional Cost Vendor Taxes Screen

To Open this Screen

 1. Open Purchase Orders > P/O Transactions > Receipt Entry.

 2. Enter the receipt, including additional costs, as usual.

 3. On the Additional Costs        tab, select the secondary vendor, then click the Vendor Taxesbutton.

Overview

Use this screen when entering additional costs for secondary vendors to:

 l Check tax information and calculations for the selected additional cost vendor.

 l Edit the tax class and tax-included options for the tax authorities.

Note: A secondary vendor is a vendor who charged you for additional costs on a shipment   of goods 
(for example, freight, customs brokerage fees, or special handling), but who did not supply the 
actual goods. You cannot enter item details for secondary vendors. You enter only the additional   
cost details.

To change tax information for an additional cost charged by the primary vendor, you use the Detail 
Costs/Taxes screen. (On the Additional Costs tab, select the additional cost for the primary vendor, 
and then click the Cost/Tax button or press the F9 key.)

For more information, see "P/O Receipt Entry Detail Costs/Taxes Screen" (page 638).

Fields and Controls

Tax Amount                                       

The program displays the amount of tax that is due for each authority.

For each authority, Purchase Orders calculates a tax amount if:

 l The vendor is subject   to tax.

 l The additional cost is   taxable.

 l Tax rates are specified   for the tax authorities and classes in Tax Services.
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Tax Authority and Description

These columns list the tax authorities and corresponding descriptions that are assigned to the tax 
group you specified for the vendor.

Tax information is added and modified in the Tax Services screens in Common Services.

Tax Base 

This field displays the net cost of an additional cost detail for which tax is included   in its price.

Tax Excluded

The program calculates the tax amount that is not included in the additional cost amount.

Tax Included

The program calculates the tax amount that is included in the additional cost amount.

Vendor Tax Class and Tax Class Description

These columns list the tax classes and corresponding descriptions that   are assigned to the tax 
authority for the selected vendor. You can change the tax   class to another tax class that is assigned 
to the authority, but not   the description.

Tip: To change the tax class description or make other changes to the information for the 
specified tax group, use the Tax Services screens in Common Services.

P/O Receipt Entry Invoice Screen

To Open this Screen

 1. Open Purchase Orders > P/O Transactions > Receipt Entry.

 2. Enter header information for the receipt, including the vendor number and, if you are receiving 
an existing purchase order, specify the purchase order number (or numbers if you are 
receiving multiple purchase orders).

 3. Use the Details table to receive items on the purchase order, or click Receive All to receive all 
the items.

 4. Click the Invoice button.
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Overview

Use this screen to create invoices for the primary and secondary vendors on a receipt. For more 
information, see "About Vendors" (page 81).

Note: On this screen, you cannot enter duplicate invoice numbers for a vendor. However, you can 
enter duplicate invoice numbers as long as each of the invoices with the same number is for a 
different vendor.

Invoices are created during posting. You can post only one invoice for each vendor on the receipt, 
and the invoice includes all charges entered for the vendor on the receipt.

After posting, you cannot change information in the Invoice screen or on the receipt for item and 
additional costs you have invoiced.

Important! You should use the P/O Invoice Entry screen to enter 1099 information for vendors. Mo re ...

The 1099 Code and 1099 Amount fields appear on the Vendor Information tab in the Invoice Entry 
screen only for vendors for whom the Subject To 1099 Reporting option is selected in Accounts 
Payable.

For more information, see "P/O Invoice Entry Screen" (page 451).

Fields and Controls

Primary Vendor Invoice Number

To create an invoice for the primary vendor, type the invoice number in the Invoice Number field at 
the top of the screen.

Note: The primary vendor is the vendor from which you received goods. You can include both 
item details and additional cost details for primary vendors on receipts, invoices, credit notes, and 
debit notes.

Invoice Number (additional cost vendors)                     

To create invoices for secondary vendors, type the invoice numbers in the Invoice Number field for 
each vendor whose invoice you are creating. 
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When you post the receipt, the program will create an invoice for all the additional costs entered on 
the receipt for the secondary vendors.

Note: A secondary vendor is one that adds charges to the receipt—such as for freight

Invoiced                      

This field shows whether an invoice has been posted for the selected   secondary vendor.

You can post only one invoice for each vendor on a receipt. After you   post the invoice, you can no 
longer change information for the vendor   on the receipt.

Vendor Number and Name                     

The program displays the number and name of each secondary vendor for   whom you have added 
an additional cost on the receipt.

To create an invoice for all the additional cost details entered on the receipt for a secondary vendor,   
select (highlight) the line for the vendor, then type the invoice number.
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P/O Requisition Entry Screen 

To Open this Screen

Open Purchase Orders > P/O Transactions > Requisition Entry.

Secondary Screens

 l "P/O Requisition Entry Detail Comments Screen" (page 669)

 l "P/O Requisition Entry Detail Items Screen" (page 669)

 l "P/O Requisition Entry Drop-Shipment Address Screen" (page 665)

Related Tasks

 l "Creating a New Purchase Requisition   " (page 94)

 l "Editing a Requisition   " (page 97)

 l "Deleting a Requisition" (page 99)

 l "Importing Requisitions   " (page 98)

 l "Printing Requisitions   " (page 98)

Overview   

Use the Requisition Entry screen to:

 l Enter requisitions for   purchases you plan to make and for which you may need approval before   
you can create purchase orders.

 l Edit or delete requisitions   you posted previously.

 l Print requisitions.

 l Import requisitions from   other Sage 300 databases or from non-Sage 300 programs.

 l Export requisitions to   other Sage 300 databases or non-Sage 300 programs.

Requisitions are optional in Purchase Orders. You can enter purchase   orders with or without 
requisition numbers.
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Note: If you use requisitions, Purchase Orders provides a requisition approval system to enforce 
purchase approvals. For more information, see "About Requiring Approval for Requisitions" (page 
734).

You can make changes to requisitions and individual requisition detail lines until they are completed. 
When you post a purchase order that uses a requisition detail, the detail is completed, regardless of 
the quantity that was ordered.

Requisition Tab

Use the Requisition tab to:

 l Specify the requisition date, required date, and expiration date.

 l Put a requisition on hold or remove the hold.

 l Say who requested the merchandise.

 l Select an optional location code to be the default location for the requisition details, if you use 
Inventory Control, or type the name of a location.

 l Type a description, reference, and comment for the requisition.

 l Add requisition details.

 l Edit or delete existing incomplete details.

Details are saved as you enter them on the detail entry grid, or when you   click Add or Save in the 
Detail Items screen. 

You can also work with details using the Detail Items screen, which lets you view all the information for 
a detail without needing to scroll. (  To open the Detail Items screen, select a detail line, and then click 
the Detail   button or press the F9 key.) For more information, see "P/O Requisition Entry Detail Items 
Screen" (page 669).

Details are saved as you enter them on the detail entry grid or when you   click Add or Save in the 
Detail Items screen. 

Optional Fields Tab

This tab appears only if you have Transaction Analysis and Optional Field Creator, and requisition 
optional fields have been assigned to   the Requisition Entry screen using the Optional Fields setup 
screen. 

Use the Optional Fields tab to add or change information   in the optional fields that apply to the 
transaction as a whole. You edit optional fields for requisition details, separately, on the detail entry 
table or using the Item Details screen.
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For more information, see "About Optional Fields in Transactions" (page 80)

Totals Tab         

Use this tab to:

 l Enter a comment   for the requisition.

 l Check the estimated weight   of the goods on the requisitions.

 l Check the number of detail   lines and the requisition total.

Fields and Controls

Buttons

History

Click the History button to open the P/O Purchase History screen, where you can check information 
about the items you have purchased from your vendors.

For more information, see "P/O Purchase History Screen" (page 375).

New

Click the New button to begin creating a new record.

Post

Click Post to post the document, including any changes you   made to an existing document. 

Entered By

This field indicates how the transaction was entered or created:

 l If the transaction was entered manually in Purchase Orders, the field displays the user ID of 
the person who entered the transaction.

 l If the transaction was created by an e-commerce solution, the field displays Internet.
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Requisition Number

You can enter a unique number in this field for a new requisition you want to add. You can use up to   
22 characters. 

Tip: Leave the field showing ***NEW***   to let Purchase Orders assign the requisition number 
during posting.

To display an existing, incomplete requisition, type its number, or   use the Finder or the navigation 
buttons beside the Requisition Number   field to select it.

Vendor Number (and name)

Type the vendor number to use for the requisition or select it from the Finder.

You can also type a new vendor number that you have not yet added to your Accounts Payable data, 
or you can leave the Vendor Number field blank, if you do not want to specify a vendor for the 
requisition.

If you enter a vendor number, it becomes the default vendor number on   the detail lines you add to 
the requisition.

You can add new vendor records to Accounts Payable from the Requisition Entry screen. Type the 
new number, then click the New button to open the Accounts Payable Vendors screen where you 
can add the record.

You cannot enter a requisition for an inactive vendor.

Optional Fields tab

The Optional Fields tab contains optional fields   added by your company that apply to the 
transaction as a whole. (Optional   fields on detail lines apply to the individual transaction detail.)

Note: This tab appears only if you use Transaction Analysis and Optional Field Creator.

For more information, see "About Optional Fields" (page 51).

Requisition Tab

Approval Status 

The approval status shows whether posted requisitions have been approved   and can be added to a 
purchase order.
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Note: If you use Purchase Order's requisition approval feature, all requisitions must   be posted by 
a user who has authorization to approve requisitions before the requisition can be converted to a 
purchase order.. For more information, see "About Requiring Approval for Requisitions" (page 
734).

If you do not use the requisition approval feature, all requisitions   are automatically approved when 
posted.

Approver Name 

This field shows the ID of the user who approved the requisition. 

Note: If you use Purchase Order's requisition approval feature, all requisitions must   be posted by 
a user who has authorization to approve requisitions before the requisition can be converted to a 
purchase order.. For more information, see "About Requiring Approval for Requisitions" (page 
734).

If you do not use the requisition approval feature, all requisitions   are automatically approved when 
posted.

Date Required

Type the date by which you need to issue the purchase order, or a date   you use for another 
purpose.

Description

Type a description using up to 30 characters. This description will appear on purchase   orders, 
receipts, invoices, etc. 

If you want to describe the item more completely, use the comments fields.

Expiration Date

Type the date on which you want to delete the requisition during Day   End Processing. You must 
create any purchase orders you need from the   requisition before running Day End Processing on 
this date. 

Job-Related

Select the Job Related option if the requisition is for a project   you are managing with Project and 
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Job Costing.

After you select the Job Related option, different fields appear for   the details, letting you enter the 
contract, project, category, cost class   and resource for the job. 

If you use different terms than “Contract,” “Project,” and “Category”   in Project and Job Costing, the 
program displays them instead.

Note: 
If you select the Job   Related option, all requisition details must be job-related. You   cannot mix job-
related items and non-job-related items on the same requisition.

You   cannot add serialized items or items assigned to lots on job-related requisitions.   Instead, you 
must use a non-job-related requisition, receive them into   inventory, and then use the Material 
Usage screen in Project and Job Costing   to move them from inventory to jobs.

Location

Type the code for the location to use as the default location   for requisition details, or use the Finder 
to select the code. 

You can also   type the name of a location, but it will not appear on the detail-entry   section of the 
Requisition tab.

On Hold

Use this field to put a requisition on hold or to remove a hold. 

You cannot create a purchase order from a requisition that is on hold.

If your Purchase Orders system uses requisition approval, and you do not have authorization to 
approve requisitions, the program   will automatically put requisitions on hold when you post them. 
For more information, see "About Requiring Approval for Requisitions" (page 734).

Reference

Type an optional reference for the requisition.

Requested By

Type the name of the person requesting the order (using up to 60 characters)   or leave the field 
blank if your company does not use it.
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If you use Sage 300 Payroll, a Finder appears, letting you choose   an employee's payroll number. 
However, the requester   does not have to be a Sage 300 user or an employee listed in the   payroll 
system.

Requisition Date

Type the date to use for the requisition. The program displays the sign-on   date, but you can type 
another date.

Details table

Comments/Instructions

To enter comments or instructions for a detail line, click the Zoom  button beside   the field, or 

press Shift+F9. 

If you are creating a purchase order from a requisition, any comments   or instructions you entered 
for the detail line on the requisition are   included on the purchase order, but you can change or 
delete them.

Completed

If necessary, mark the line as completed by selecting the Completed   check box. Purchase Orders 
also marks requisition detail lines as completed   when they are used in a purchase order.

After a line is marked Completed, you cannot make any changes to it.

Contract, Project, Category and Resource (job-related only)                                     

If the requisition is job-related, specify for each requisition detail where the items or resources are 
going to be used.

If you use different terms than “Contract,” “Project,” and “Category” in Project and Job Costing, the 
program displays them instead.
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Note: 
 l You must select the Job Related option in the top part of the Requisition Entry screen for 

these fields   to appear.

 l All details on a job-related requisition must be job-related. You cannot mix job-related 
details with non-job-related details on a document.

 l You select the resource   using the Item Number field.

 l You cannot change these   fields once you have added the detail line.

Contract

Specify a contract number for each detail. You can enter or   select only contracts that are open or on 
hold. (You cannot process transactions   to a contract that is on hold, if it has never been opened.)

Cost   Class

The program displays the cost class for the category used in each detail.   You cannot change this 
field.

Item   Number (Resource)

Use the Item Number field to specify the resource for this detail.

You must specify a resource that you have assigned to the project in   Project and Job Costing (such 
as an equipment code or a subcontractor   code). You cannot leave this field blank.

Project

You can only enter or select projects that are:

 l Assigned to the contract   that you selected.

 l Open or on hold. If   a project that is on hold has never been opened, you cannot select it.

 l Not closed to costs.

Copy Cost to Purchase Order

Select this option if you want to copy the costs specified on the requisition   to the purchase order. 
For example, you would select this option if you   negotiated particular prices for this purchase.

Do not select this option if you want to recalculate costs or take them   from vendor records when you 
create the PO. For example, the requisition   may provide estimates rather than a negotiated best 
price.
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Drop-Ship

Use this field to specify for a selected detail a shipping address that different from the location used 
for the requisition. 

To open the Drop-Shipment Address screen to enter or change a drop-ship address for a selected 

detail, click in the Drop-Ship field, then click the Zoom  button   (or press the Shift and F9 keys at 

the same time). For more information, see "P/O Receipt Entry Drop-Shipment Address Screen" 
(page 614).

Exchange Rate

The program displays the exchange rate currently in effect for the specified   vendor currency, if 
different from your functional currency. You can change   the rate for the requisition.

The exchange rate will be "1" if you don't specify a vendor   because the program will assume your 
functional currency.

Expected Arrival Date

Type the date when you expect to receive the items. 

If you specified an expected arrival date on the Requisition tab, that   date is displayed in this field but 
you can change it.

Extended Cost

Type the extended cost for the number of units of the item that you ordered.

If you change the extended cost, the program automatically recalculates the unit cost.

Extended Weight

Type the extended weight for the number of units of the item that you ordered.

If you change the extended weight, the program automatically recalculates   the unit weight.

The total weight for all items on the document is displayed in the Totals   tab.

Item Description

The program displays the item description from Inventory Control but   you can change it. 
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If you typed an item number that does not exist in Inventory Control, you type the description for it 
as well. You can enter non-existent item numbers only if you selected the Allow Non-inventory Items 
option (in the P/O Options screen).

Item Number

Type the number of the item you wish to order, or select it from the   Finder.

You can also type an item number that does not exist in your Inventory Control data if you use the 
Allow Non-inventory Items option (selected in the P/O Options screen). 

Purchase Orders also lets you enter   manufacturers' item numbers in this field if they have been 
added in Inventory   Control. These numbers could include internally-used bar codes, UPC numbers,   
or ISBNs, so you can use a scanner (or type a short code) for entering   inventory item numbers.

If you enter a manufacturer's item number, Purchase Orders replaces   it with your inventory item 
number, and then displays the manufacturer's   item number you entered in the Manufacturer's Item 
Number field, near   the end of the detail line.

Line Number

To select an existing line to edit or delete, click the line, or   enter its line number in this field on the 
P/O Detail Items/Taxes screen.

Note: You cannot   delete completed lines.

Location

This field appears only if you use Inventory   Control.

Enter the code for the location where you expect to receive the shipment   (or to which you want to 
post drop-shipped items). 

The program displays the ship-to location code, if any, entered on the   first tab, but you can select a 
different location. You can omit the location   when adding details for non-inventory items.

Note: If you change  locations after assigning serial and/or lot numbers, you must re-assign the 
serial and/or lot numbers.

Manufacturer's Item Number

If you entered a manufacturer's item number in the Item Number field   on the requisition or 
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purchase order, the number appears in the Manufacturer's Item Number field. 

Manufacturer's item numbers are alternative item numbers—  such as bar codes or shortcut codes—  
that identify your inventory items. You set up manufacturer's item numbers   in Inventory Control.

You can enter manufacturer's item numbers wherever you enter item numbers   in Purchase Orders.

Name (Vendor)

Type a name for a new vendor number you have not yet added to Accounts   Payable. 

If you specified a valid Accounts Payable vendor number, the vendor's   name appears and you 
cannot change it. 

Optional Fields

Optional fields are fields that have been added by your company to the transaction entry screens 
and detail lines in purchase orders transactions.

If you use optional fields, an Optional Fields column appears in the table. You can click the column 
heading to display the optional fields assigned to a selected detail, and edit their contents.

Note: You must use Transaction Analysis and Optional Field Creator to add and use optional 
fields.

For more information about using optional fields in transactions, see "About Optional Fields in 
Transactions" (page 80). 

Order Number

Type the number of a sales order for which you are creating the requisition   detail. If you use Sage 
300 Order Entry with Purchase Orders you can   also select an Order Entry order number from the 
Finder.

Quantity Ordered

Type the quantity to order (expressed in the unit of measure you select).

Rate Date

Type or select the date to use to select the exchange rate for the document you are entering.
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The program displays the rate date that is nearest the   document date you entered, but you can 
specify a different date for which   an exchange rate exists for the currency in   Common Services' 
Currency Rates table.

If you change the rate date, Purchase Orders checks the rate tables   for a date match, and updates 
the rate if necessary. 

Unit Cost 

Enter the cost of a single unit of the item you are ordering in the detail.   

Purchase Orders displays a default cost as follows:

 l If you have set up vendor   contract costs, Purchase Orders displays the cost specified as a 
contract   cost for the item and unit of measure. 

 l If P/O does not find a   valid contract cost, it uses the inventory cost specified on the P/O 
Options   screen.

Use the Finder  to view any vendor contract costs, regular   vendor costs, and other costs 

maintained by Inventory Control.

Purchase Orders uses the unit cost to calculate the extended cost. If you   change the unit cost, the 
extended cost is recalculated.

In multicurrency ledgers, the cost is expressed in the vendor's currency.

Note: You can assign security to the Unit Cost and Extended    Cost fields, to prevent unauthorized 
changes to the fields.

If you use Project and Job Costing, unit cost is defaulted as follows:

 l If   the project is a standard project:

 l For a category cost   class of Subcontractor, Overhead, or Miscellaneous Equipment, 
the unit   cost is defaulted from the category resource.

 l For a category cost   class of Labor, the default unit cost is based on the Default Unit 
Cost   From option for the employee resource category.

 l For a category cost   class of Material (if you are using Inventory Control), the default 
unit   cost is based on Purchase Orders' default item cost (set in P/O Options).

 l For a category cost   of Material (if you are not using Inventory Control), the unit cost is   
based on Purchase Orders vendor costs.
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 l If   the project is a basic project:

 l For a category cost   class of Subcontractor, Overhead, or Miscellaneous Equipment, 
the unit   cost is defaulted from the category.

 l For a category cost   class of Labor, the default unit cost is based on the Default Unit 
Cost   From option for the labor category.

 l For a category cost   class of Material (if you are using Inventory Control), the default 
unit   cost is based on Purchase Orders' default item cost (set in P/O Options).

 l For a category cost   of Material (if you are not using Inventory Control), the unit cost is   
based on Purchase Orders vendor costs.

Unit of Measure

Enter the unit of measure in which to order the item. If you are creating a purchase order from a 
requisition, the unit of   measure entered for the detail on the requisition is displayed, but you   can 
change it.

If you are entering new detail lines, the program displays the stocking   UOM by default, unless you 
have set up vendor contract costs using a different   UOM.

You must use one of the units of measure that is assigned for the item   in Inventory Control. 

Note: The weight UOM can be different from the   order UOM.

Unit Weight

Enter the weight of a single unit of the item you are ordering in the   detail. On new detail lines, the 
weight specified in the Inventory Control   item record is displayed, but you can change it.

Purchase Orders uses the unit weight to calculate the extended weight. If   you change the unit 
weight, the extended weight is recalculated.

You can select from the weight units of measure defined in Purchase   Orders. Weight is expressed 
in the unit selected   for the Weight Unit Of Measure option on the I/C Options   screen.

On invoices, enter the weight of a single unit of the item for which you were invoiced.   The program 
displays the weight specified for the item on the receipt   but you can change it.

Purchase Orders uses the unit weight to calculate the extended weight. If   you change the unit 
weight, the extended weight is recalculated.

You can see the total weight estimated from your entries for the invoiced   items on the Totals tab.
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Vendor Number (and name)

Type the vendor number to use for the requisition or select it from the Finder.

You can also type a new vendor number that you have not yet added to your Accounts Payable 
data, or you can leave the Vendor Number field blank, if you do not want to specify a vendor for the 
requisition.

If you enter a vendor number, it becomes the default vendor number on   the detail lines you add to 
the requisition.

You can add new vendor records to Accounts Payable from the Requisition Entry screen. Type the 
new number, then click the New button to open the Accounts Payable Vendors screen where you 
can add the record.

You cannot enter a requisition for an inactive vendor.

Vendor Item Number             

Enter the code the vendor uses to identify the item. 

If the vendor's item number is specified in the Inventory Control item   record, the code appears in 
this field. (Enter vendors' item numbers when   assigning vendor types in Inventory Control item 
records.)

If the vendor's item number is specified on the receipt for which you   are entering an invoice, the 
code appears in this field. (You can enter   vendors' item numbers when assigning vendor types in 
Inventory Control   item records.)

Totals Tab

Comments             

Enter an optional comment for the document.

Any comments you entered for the detail on the receipt are included   on the invoice, but you can 
change or delete them.

Lines automatically wrap when you reach the end. If you want to start   a new line before the line 
wraps, press Enter. 
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Number of Lines                               

The program displays the number of item detail lines you entered for the   primary vendor on the 
document.

Check this number against source documents to make sure you entered   all the details you require.

Requisition Total 

The Requisition Total field on the Totals tab displays the total amount   of all items on the order 
requisition in the functional currency (in a   multicurrency ledger). This amount does not include   
taxes.

Total Weight 

The program displays the total estimated weight of the order requisition,   calculated from the weight 
you enter for each item detail, and displayed   in the default weight unit of measure specified in the 
Inventory Control   module.

You can use the weight to estimate shipping charges for the requisition   or to decide on a shipping 
method.

P/O Requisition Entry Drop-Shipment Address Screen

To Open this Screen

 1. Open Purchase Orders > P/O Transactions >  Requisition Entry.

 2. On the Details table, for a selected detail line, click in the Drop-Ship field, then click the Zoom 

 button   (or press the Shift and F9 keys at the same time).

Fields and Controls

Address

Type the address information for the drop shipment, or edit the displayed   information.
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Contact

Type the name of the contact person or position at the drop-shipment   address, and enter a phone 
number, fax number, and e-mail address if appropriate   (or accept the displayed information).

Customer Number

Type the customer number for the drop shipment, or select the number   from the Finder. (You can 
select customer numbers only if you use Sage 300 Accounts Receivable with Purchase Orders.)

Description

Type the name of the person or location to receive the drop shipment.

Fax Number

Type the fax number at the drop-shipment address.

Location Code

Type the code for the location where you expect to receive the item   ordered on the detail, or select 
the code from the Finder.

Phone Number

Type the telephone number at the drop-shipment address.

Set Drop Shipment Address To

Specify the type of drop-shipment address you are entering. You can   select:

 l Address Entered—  select this option when you want to type the address information for the   
shipment.

 l Inventory Location Address—select this option when the   items are to be drop-shipped to a 
different Inventory Control location   from the location selected for the detail line.

 l Customer Address—    select this option when the items are to be drop-shipped to the address   
of one of your Accounts Receivable customers.

 l Customer Ship-To Address—select this option when the   items are to be drop-shipped to one 
of the ship-to addresses defined for   the customer in  Accounts Receivable.
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Ship-to Location

If you use Sage 300 Accounts Receivable with Purchase Orders, you   can select any of the ship-to 
locations defined in Accounts Receivable   for the customer as the drop shipment.

Overview   

Use this screen to enter or edit address information for a detail where     the goods will be shipped 
directly to an address other than the inventory    location specified for the detail line.

Note: Purchase Orders does not consolidate requisition detail lines with drop-shipment     addresses 
when you create purchase orders by vendor number from requisitions.

To enter or edit a drop-shipment address:

 1. In the Drop-Shipment     Address screen, select the type of address to enter.

 2. Select     the location code, customer number, or ship-to location code for the address, as 
needed.

 3. Type the address, or edit     the displayed information.

 4. Click Close.

To delete drop-shipment addresses:

On the Requisition tab, change the entry in the Drop-Ship field to No for the selected detail, or clear 
the Drop-Ship option on the Detail Items/Taxes     form (click the field or press the Shift and F9 keys at 
the same time    in it).

Fields and Controls

Address

Type the address information for the drop shipment, or edit the displayed   information.

Contact

Type the name of the contact person or position at the drop-shipment   address, and enter a phone 
number, fax number, and e-mail address if appropriate   (or accept the displayed information).
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Customer Number

Type the customer number for the drop shipment, or select the number   from the Finder. (You can 
select customer numbers only if you use Sage 300 Accounts Receivable with Purchase Orders.)

Description

Type the name of the person or location to receive the drop shipment.

Fax Number

Type the fax number at the drop-shipment address.

Location Code

Type the code for the location where you expect to receive the item   ordered on the detail, or select 
the code from the Finder.

Phone Number

Type the telephone number at the drop-shipment address.

Set Drop Shipment Address To

Specify the type of drop-shipment address you are entering. You can   select:

 l Address Entered—  select this option when you want to type the address information for the   
shipment.

 l Inventory Location Address—select this option when the   items are to be drop-shipped to a 
different Inventory Control location   from the location selected for the detail line.

 l Customer Address—    select this option when the items are to be drop-shipped to the address   
of one of your Accounts Receivable customers.

 l Customer Ship-To Address—select this option when the   items are to be drop-shipped to one 
of the ship-to addresses defined for   the customer in  Accounts Receivable.

Ship-to Location

If you use Sage 300 Accounts Receivable with Purchase Orders, you   can select any of the ship-to 
locations defined in Accounts Receivable   for the customer as the drop shipment.
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P/O Requisition Entry Detail Comments Screen

To Open this Screen

 1. Open Purchase Orders > P/O Transactions >  Requisition Entry.

 2. On the Requisition tab, click the Comments/Instructionsfield for the detail line you need.

 3. Click the Zoom  button or press the Shift and F9 keys to open the Detail Comments screen.

Use this screen to enter comments or instructions for a selected requisition detail    line. You    can print 
the remarks on the purchase order.

Note: You can enter both comments and instructions for a detail line. 

To enter or edit a comment or instruction:

 1. In the Type field, select Comment or Instruction.

 2. In the space provided, type the comment or instruction, pressing Enter to start each new line.

 3. When finished, click Close to close the screen.

To delete comments or instructions:

 1. Highlight the text to       delete, then press the Delete key. If a message appears      asking you to 
confirm the deletion, click Yes.

 2. When finished, click Close      to return to detail entry.

Tip: You can also delete comments or instructions by changing the entry in     
theComments/Instructions field to No on the Requisition tab. If you use this method, your remarks 
are not deleted, but they     are not printed on the requisition. If you decide     to use the remarks later , 
change the Comments/Instructions field to Yes. Your original remarks will reappear.     

You can also add or clear comments on the Detail Items/Taxes screen. 

P/O Requisition Entry Detail Items Screen

To Open this Screen

 1. Open Purchase Orders > P/O Transactions > Requisition Entry.
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 2. Select an existing requisition, or create a new one (specifying the vendor number and other 
header information for the requisition).

 3. Click a detail line       on the Requisition tab, then either press F9 or click   the Details button to 
open the Detail Items screen. 

Related Tasks

 l "Approving a Purchase Requisition   " (page 735)

 l "Creating a New Purchase Requisition   " (page 94)

 l "Deleting a Requisition" (page 99)

 l "Deleting a Requisition" (page 99)

Overview   

Use this screen to add, edit, and delete requisition detail lines. 

This screen displays the fields for a single detail in a separate window,     letting you see all the 
information you entered for the detail, including    tax information. 

Fields and Controls

Buttons

Close

Click the Close button to close the Detail Items/Taxes screen. 

On the Detail Items/Taxes screen and the Detail Costs/Taxes screen, you can also press the F9 key 
on your keyboard to close the screen.

Delete

Click the Delete button to delete the detail displayed in the zoomed   detail-entry screen.

New

Use the New button to start a new detail.
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Save/Add

Use the Save button to save the changes you made to a detail you edited in the Detail Items/Taxes 
screen.

For a new detail, this button is called Add.

Comments/Instructions

You can type comments or instructions for the detail.

To view comments or instructions for a selected detail line, click the Zoom  button beside the 

Comments/Instructions field. The program displays any comments and instructions entered for the 
detail line on   the receipt, but you can change   or delete them.

Tip: You can also press the Shift and F9 keys together to open   or close the screen using your 
keyboard.

To enter comments for the selected detail, select Comment as the type, click the 
Comments/Instructions table, press the Insert key, and then type the comments on the new line. 

To enter instructions for the detail, select Instruction as the type. 

Lines automatically wrap. If you want to start   a new line before the line wraps, press Enter. 

For more information, see "P/O Requisition Entry Detail Comments Screen" (page 669).

Completed

If necessary, mark the line as completed by selecting the Completed check box. Purchase Orders 
also marks requisition detail lines as completed when they are used in a purchase order.

Once a line is marked as completed, you cannot make any changes to it.

Drop Ship

To enter a drop-ship address for a detail, click the Zoom  button beside the Drop Ship field, or 

select the field and press Shift+F9. 

Select the type of address to enter, and if necessary, select the   location code, customer number, or 
ship-to address code for the address.
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Expected Arrival Date

Type the date when you expect to receive the items.

If you specified an expected arrival date on the Requisition tab, that date is displayed in this field but 
you can change it.

Item Description

The program displays the item description from Inventory Control but   you can change it.

If you typed an item number that does not exist in Inventory Control,   you type the description for it as 
well. You can enter non-existent item numbers only if you selected the Allow Non-inventory Items 
option (in the P/O Options screen). 

Item Number 

Type the number of the item you want to order, or select it from the   Finder.

Note: The field to the right displays the description for the item for existing Inventory Control item 
numbers. For non-inventory items, you can enter a description.

You can enter a non-stock item, if Inventory Control permits them. If your   Purchase Orders system 
allows non-inventory items, you can also enter   item numbers that are not defined in Inventory 
Control.

If manufacturer's item numbers or bar codes have been added in Inventory Control, you can enter 
them in most item   number fields. These numbers could include internally-used bar codes, UPC 
numbers,   or ISBNs - letting you use a scanner (or type a short code) for entering   inventory item 
numbers.

The program inserts the correct item number, and—on transaction detail lines  —inserts the 
manufacturer's   item number in the manufacturer's item number field at the end of the   line.

Line Number

This field indicates the line number of the selected detail.

You can select a different detail using the navigation buttons, or by entering the line number. You 

can also create a new detail by clicking the New .
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Tip: To delete the line you selected, click the Delete button. Click Yes   if a message appears 
asking you to confirm the deletion. You cannot delete   completed lines.

Location

This is the location to which the ordered goods   will be delivered. This field appears only if you use 
Inventory   Control.

The program displays the ship-to location code, if any, entered on the   first tab, but you can select a 
different location. You can omit the location   when adding details for non-inventory items.

Location

This field appears only if you use Inventory   Control.

Enter the code for the location where you expect to receive the shipment   (or to which you want to 
post drop-shipped items). 

The program displays the ship-to location code, if any, entered on the   first tab, but you can select a 
different location. You can omit the location   when adding details for non-inventory items.

Optional Fields 

If optional fields have been defined in Purchase Orders for requisition details, you can click the 

Zoom  button beside the Optional Fields field to display the optional fields assigned to a selected 

detail, and edit their contents.

For more information about using optional fields in transactions, see "About Optional Fields in 
Transactions" (page 80). 

Order Number

Type the number of a sales order for which you are creating the requisition   detail. If you use Sage 
300 Order Entry with Purchase Orders you can   also select an Order Entry order number from the 
Finder.

Quantity Ordered

Type the quantity to order (expressed in the unit of measure you select).
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Unit Of Measure

Type the unit of measure in which to order the item, or select it from   the Finder.

You must use one of the units of measure that is assigned for the item   in Inventory Control. The 
program displays the stocking unit of measure.

Vendor Number (and name)

If you entered a vendor number for the requisition, it appears as the default vendor for any detail 
lines you add to the requisition. You can change the vendor number for the detail by typing it or 
selecting it using the Finder. 

You can also add a new vendor record to Accounts Payable by typing the new number, then clicking 
the New button   to open the Accounts Payable Vendors screen, where you can add the record.   

You cannot enter a requisition for an inactive vendor.

Vendor Item Number             

Enter the code the vendor uses to identify the item. 

If the vendor's item number is specified in the Inventory Control item   record, the code appears in this 
field. (Enter vendors' item numbers when   assigning vendor types in Inventory Control item records.)

If the vendor's item number is specified on the receipt for which you   are entering an invoice, the 
code appears in this field. (You can enter   vendors' item numbers when assigning vendor types in 
Inventory Control   item records.)
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P/O Return Entry Screen   

To Open this Screen

Open Purchase Orders > P/O Transactions > Return Entry.

Secondary Screens

 l "P/O Return Entry Bill-To Location Screen" (page 699)

 l "P/O Return Entry Detail Comments Screen" (page 701)

 l "P/O Return Entry Detail Items/Taxes Screen   " (page 701)

Related Tasks

 l "About Day End Processing of Returns" (page 200)

 l "About Currency Exchange Rates" (page 90)

 l "About Tax Information and Amounts" (page 83)

 l "Entering Returns   " (page 161)

 l "About Printing Returns" (page 158)

Overview

Use the Return Entry screen to:

 l Enter, edit, and post returns of merchandise to vendors.

 l Export returns to non-Sage 300 programs and other Sage 300 Purchase Orders databases.

 l Assign serial/lot numbers to returned items (if you use Serialized Inventory and Lot Tracking  ).

Return Tab

Use the Return tab to enter:

 l The return date.

 l The receipt number to which the return applies (if any).

 l The billing address for the return.
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 l An optional description, reference, and comment.

 l The details of items you are returning to a vendor.     

Note: The information you can enter is restricted if the return includes a receipt number or 
you have already posted the return.

This tab also lets you:

 l Open the "P/O Return Entry Bill-To Location Screen" (page 699).

 l Edit details on a return you posted previously.

 l Open the "P/O Return Entry Detail Items/Taxes Screen   " (page 701) on which to enter details 
instead of using the spreadsheet-style grid you see on the Return tab. (The Detail Items/Taxes 
screen displays all the fields for a single detail, including tax fields.)

Taxes Tab

Use the Taxes tab to:

 l Check the vendor's tax group.

 l Check tax information and edit the tax-included options and amounts for the vendor's tax 
authorities.     

To cancel changes you make to tax amounts, click the Calc. Taxes button. The program 
recalculates the taxes using the tax tables in Tax Services.

Retainage Tab

The Retainage tab appears only for returns of job-related items that had amounts retained on the 
receipt or invoice. If the items were originally received in another currency, you use this tab to specify 
the exchange rate to use for the return:

 l Original retainage exchange rate for the return.

 l Current exchange rate.

Optional Fields Tab

This tab appears if you have assigned optional fields to the Return Entry window, and allows you to 
add or change information in these fields. Mo re ...

The Optional Fields tab displays only the optional fields that are assigned to the Return Entry window. 
For more information about assigning optional fields to a window, see "P/O Optional Fields Screen  " 
(page 340).

676Sage 300 2021 Purchase Orders User's Guide



Note: 
 l You may be required to enter information in some or all of the fields on this tab.

 l Some optional fields may allow you to select from pre-defined codes. If you select a code that 
includes a description, the description will be displayed. You cannot edit descriptions in this 
window, but you can edit them in the Optional Fields screen in Common Services. For more 
information, see the System Manager help.

Rates Tab

The Rates tab appears only in multicurrency ledgers when you are entering a return for a vendor who 
does not use the functional currency. Mo re ...

Use the Rates tab to:

 l Change the rate type, rate date, and exchange rate for converting the return amount from the 
vendor's currency to your functional (home) currency.

 l Look up the rate information entered with the receipt.

Totals Tab

Use the Totals tab to:

 l Enter a comment for the return.

 l Enter the discount percentage or amount for the entire return.

 l Verify return totals for the vendor.

 l Check the estimated weight of the goods for that you are returning.

 l Check the number of item details entered for the vendor on the return.

 l Check the return subtotal and tax amounts for the vendor.

Fields and Controls

Buttons

History

Click this button to open the "P/O Purchase History Screen" (page 375) and check information about 
the items you have purchased from your vendors.
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Entered By

If the transaction was entered manually in Purchase Orders, the field displays the user ID of the 
person who entered the transaction.

Return Number

Enter a unique number for a new return you want to add. Use up to 22 characters. You can also 
leave the field showing ***NEW*** to let Purchase Orders assign the return number during posting.

When editing an existing, incomplete return, enter its number or select it from the Finder beside the 
Return Number field.

You specify the length, prefix, and next number to assign to returns in the P/O Options screen.

Vendor Number (and name)

Identifies the vendor to whom you are returning the items. The vendor   number sets the default tax 
group and payment terms. In multicurrency   systems, the vendor number also specifies the currency 
of the document.

 l To select an existing   vendor, enter the vendor's number and then press Tab.

 l To add a new vendor, do   one of the following:

 l If you want to add   the vendor record now, click the New button after   entering the vendor 
number. Fill in the vendor information in Accounts Payable,   choose Add, then choose 
Close to return to Purchase Orders.

 l If you do not want to add the vendor record now, enter only the vendor number. (You 
can enter the vendor name on the next tab.)

Note: You must   add the vendor record in Accounts Payable before you can post invoices,   credit 
notes, and debit notes for the vendor in the Accounts Payable program. You cannot enter returns 
for vendors whose accounts are inactive in   Accounts Payable.

Return   tab

Bill-To Location

If you use Inventory Control, select an Inventory Control location code to which the vendor can send 
the credit note for the return.
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You can also use the Zoom  button to open a separate screen where you can edit the address 

for the code you select, or you can omit the code and enter an address manually. You do not need 
to specify a bill-to location.

If you are entering a return to a receipt, the bill-to information from the receipt is displayed, but you 
can change it. 

You can edit bill-to information as long as the return is not complete (that is, you have not issued a 
credit note from the return).

Description

Enter an optional description for the return.

If you are entering a return to a receipt, the description entered on the receipt (if any) is displayed, 
but you can change it. 

If you are editing a posted return, you cannot change the description.

Job-Related

If the purchase order and receipt were job-related, the Job-Related   check box will be selected for 
the return, and you will not be able to   change this selection.

If you are not referencing a particular receipt, you have to choose   Job Related if you are returning 
materials related to a job.

The contract, project, category, cost class and resource (item number   column) for each receipt 
detail will be provided by the program — as will the customer billing   type, billing rate, and A/R item 
used for billing.

Note: If you use different terms than “Contract,” “Project,” and “Category”   in Project and Job 
Costing, the program displays them instead.

PO Number (display only)                             

If you are entering a return without a receipt number, you can enter   a purchase order number, 
including a number that has not been added to   Purchase Orders, or leave the field blank.

If you are entering a return to a receipt, you cannot edit the field.   If the receipt specified a purchase 
order number, the purchase order number   is displayed.
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Posting Date

Enter the posting date for the transaction.

The posting date is different from the document   date. The posting date is the date for transactions 
being posted to the General   Ledger, so it also determines the contents of the Fiscal Year and Period   
fields.

If you have a multicurrency system, currency revaluation uses posting   dates to select open 
documents for revaluation purposes, and thus, revaluation   adjustments are posted to General 
Ledger in the correct fiscal year and   period.

Depending on your settings in the P/O Options screen, Purchase Orders   automatically displays the 
session date or the document date by default   in this field.

You can change the posting date, but you cannot separately change   the fiscal year and period.

Note: If you consolidate G/L transactions, the posting date for consolidated entries is the last date 
of the fiscal period.

Receipt Date

After you select the receipt number for the return, the receipt date   is displayed for your information.

Receipt Number

Enter the number of the receipt, if any, from which you are returning   items. (The receipt must exist in 
Purchase   Orders.)

Reference

Enter an optional reference for the return.

If you are entering a return to a receipt, the reference entered   on the receipt (if any) is displayed, but 
you can change it. 

If you are editing a posted return, you cannot change the reference. 

Retainage

If the receipt used retainage accounting, the program will display additional   retainage fields for each 
return detail line to display the retainage   percentage and period for each detail line in the return.
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The program will also display the Retainage tab to let you specify the   exchange rate that you want to 
use for returns of multicurrency retainage   receipts.

Return Date

Enter the date you want to use as the return date. The program displays   the sign-on date you 
entered to start Sage 300.

You can also change the posting date if you want a different date for   the G/L transactions when they 
are posted in the General Ledger. (The   posting date determines the fiscal year and period 
displayed beside the   Posting Date field.)

Return Subtotal

The Return Subtotal field in the lower-right corner of the screen displays   the total of all item cost 
details on the return. This amount does not   include taxes (unless tax amounts are included in detail 
cost amounts).

Ship Via

Use the Ship Via fields to specify the shipping method by which you plan to   return the goods to the 
vendor. The program displays the ship-via description   for the code you select.

Enter an optional ship-via code or use the Finder to select one of the   ship-via codes you have 
defined in Purchase Orders. 

You can also skip the Ship Via field and enter a description of the shipping   method in the field beside 
the Ship Via field, or leave both fields blank.

Template Code

Enter an optional template code from the templates defined in the Templates   screen.

The template code provides default information for the Return tab. If   you selected a receipt number 
for the return or you are editing a previously   posted return, you cannot change the entry in the 
Template Code field.

On returns you enter without receipt numbers, if the vendor record specifies   different information 
from those used with the template, the information   from the vendor record is inserted in place of the 
default template information.

If you select a new template after choosing the vendor, Purchase Orders   will replace the return 
information and vendor information with the information   from the new template.
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You cannot change the template after you have added details to the return.

Vendor Account Set

The account set from the vendor record appears in this field as the   default. It specifies the general 
ledger payables   control, purchase discounts, prepayment, and retainage accounts to which   the 
transaction will be distributed.

You can change the account set for a particular purchase order, receipt,   return, invoice, credit note, 
or debit note. If you use   multicurrency accounting, however, the new account set must use the same   
currency as the vendor's account set.

Note: If you change the account set on a receipt, make sure that you use the   same account set 
for returns, invoices, and credit or debit notes.

Year and Period

This is the fiscal year and period to which the return transactions   will be posted in the general 
ledger. You can change   the fiscal period by changing the Posting Date.

You can enter a different Return Date, and you can enter a different   Posting Date for the document.

(Remember that you cannot post transactions to closed fiscal periods.)

Return Details table

Open this table from the Return tab.

Allocated Tax  

The program displays the total tax amount allocated to the   detail, including taxes that are included 
in the item cost. Recoverable   and expensed tax amounts not included.

Allocated taxes form part of the item costs that are posted to the Inventory Control item records by 
Day End Processing.

Billing Type, Billing Rate, and A/R Item Number

For job-related returns, the program provides the Billing Type, Billing Rate, and AR Item 
Number that was used for the receipt.
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The Job-Related check box in the top part of the screen will be selected if the receipt was job-
related.

A/R     Item Number

This field displays the A/R item number associated with the project resource     used for the contract in 
Project and Job Costing. You can select a different     A/R item number only for time and material 
projects, as follows:

 l On a standard project,        this field displays the A/R item number and unit of measure specified        
for the project resource category as the default. You can accept the item       number or select 
another valid A/R item number.

 l On a basic project, this field        displays the A/R item number and unit of measure specified for 
the project        category. You can accept the item number or select another valid A/R item       
number.

 l If you change the A/R        item number, the item number must be a valid item number in 
Accounts Receivable,        and the unit of measure must be a valid unit of measure both for the 
new       item number and the vendor’s currency.

Cost plus and fixed price projects do not use an A/R item number. 

Billing Currency

This field appears only in multicurrency systems for time and materials projects and for fixed price 
projects using billings and costs or accrual-basis accounting methods.

The billing currency is the customer's currency specified on the contract, and you cannot change it.

Billing currency is blank for Fixed Price projects using completed project or project percentage 
complete methods, and for Cost Plus projects.

Note: Billing currency is not displayed for basic or standard internal Time and Materials projects, 
or for single-currency Fixed Price projects that use billings and costs or accrual-basis accounting 
methods.

Billing Rate

This field displays the billing rate for the specified resource (for standard projects) or category (for 
basic projects).

You can edit the billing rate if the billing type is Billable. The field displays 0.000000 if the billing type 
is Non-Billable or No Charge.
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Note: 
 l You can specify the billing rate for Time and Materials projects and for Fixed Price projects 

that use Billings and Costs or Accrual-Basis accounting methods.

 l Billing rate is disabled and set to 0.000000 on a basic or standard internal contract for 
Time and Materials projects or for Fixed Price projects using Billings and Costs or Accrual-
Basis accounting methods.

 l The billing rate cannot be negative.

Billing     Type

This field appears in the detail-entry section only for job-related     purchase orders.

The billing type indicates to Project and Job Costing whether to bill      the cost to the customer. You 
can change this field only for a time and     materials project, as follows:

On a basic project:

For a billable project,        the category billing type determines whether you can change the billing       type 
for the detail. If the specified category is:

 l Billable, the default       billing type for the detail is billable, but you can change it.

If the detail is billable you can specify a billing     rate for the detail.

If you change the billing type for the detail to no      charge or non-billable, the program sets the billing 
rate to zero and     you cannot change it.

 l No charge or non-billable,        the program sets the same billing type for the detail, and cannot 
change        it. You cannot specify a billing rate for the detail, which the program       sets as zero.

If the project is no charge        or non-billable, the detail uses the same billing type as the project,       the 
billing rate is set to zero, and you cannot change them.

On a standard project:

If the project is billable,        the resource billing type determines whether you can change billing type       for 
the detail.  If the specified resource is:

 l Billable, the program        displays Billable as default billing type, but you can change it for the        
detail. If the detail is billable, you can specify a billing rate for       the detail.

If you change the billing type for the detail to no      charge or non-billable, the program sets the billing 
rate to zero, and     you cannot change it.
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 l No charge or non-billable,        the program sets same billing type for the detail, and you cannot 
change        it. You cannot specify a billing rate for the detail, which the program       sets as zero.

If the project is no charge        or non-billable, the detail uses the same billing type as the project,        and 
you cannot change it. The program also sets the billing rate to zero,       and you cannot change it.

For fixed price and cost plus projects,      the Billing Type field is blank. A billing type is not required for 
these     types of projects.

Unit     of Measure

This field appears for Time and Materials projects if you selected the     Job Related option for this 
transaction.

You must enter a unit of measure that is valid for the item number/resource     that you specified and 
for the contract customer's currency.

Note: For internal time and materials projects (basic or standard     contracts) the A/R item unit of 
measure will be disabled or blank.

Comments

To enter comments for a detail line, click the Zoom  button beside the Comments field, enter 

comments, then click Close. (Press Shift+F9   to open or close the screen using your keyboard.)

Any comments entered for the detail line on the receipt are included on the return, but you can 
change or delete them.

You can print the comments on the return form.

Contract, Project, Category and Resource

If the purchase order and receipt were job-related, the program will   provide the job to which 
each detail was assigned. If you use different   terms than “Contract,” “Project,” and “Category” 
in Project and Job Costing,   the program displays them instead.

Purchase Orders updates the actual quantities and costs for jobs with   the amounts on returns. 

For job-related returns:

 l The Job-Related check box   will be automatically selected if the purchase order and 
receipt were   job-related.

 l You enter/select the resource   using the Item Number field.
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Category

Select or enter a category that is assigned to the project in Project   and Job Costing.

Contract

Specify a contract number for each detail. You can enter or   select only contracts that are open or 
on hold. (You cannot process transactions   to a contract that is on hold, if it has never been 
opened.)

Cost   Class

The program displays the cost class for the category used in each detail.   You cannot change this 
field.

Item   Number (Resource)

Use the Item Number field to identify the resource for this detail.

You must specify a resource that is assigned to the project and category in   Project and Job Costing. 
You can specify an inventory item number, or the code for another type of resource (such as an 
equipment code, subcontractor code, or employee number). 

Note: You cannot leave this field blank.

Project

You can only enter or select projects that are:

 l Assigned to the contract   that you selected.

 l Open or on hold. (If   a project that is on hold has never been opened, you cannot select it.)

 l Not closed to costs.

Discount %

You can enter a discount as a percentage or an amount. The program uses the amount you enter in 
this field to calculate the   discounted cost for the item detail. 

If you enter a percentage in this field, Purchase Orders calculates   the discount amount for the item 
detail.
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Tip: If you prefer not to enter discounts for individual details, you can   enter a discount percentage 
for the entire document on the Totals tab. Purchase   Orders then prorates the discount amount 
for the transaction details,   overriding any discounts you may have entered manually for the 
details.

Discount Amount

You can enter a discount as a percentage or an amount. The program uses the amount you enter in 
this field to calculate the   discounted cost for the item detail. 

If you enter a discount amount,   the program calculates and displays the discount percentage based 
on the   cost. (Alternatively, you can enter a percentage in the Discount   Percent field, and let the 
program calculate the discount amount.)

Tip: If you prefer not to enter discounts for individual details, you can   enter a discount amount for 
the entire document on the Totals tab. Purchase   Orders then prorates the discount amount for 
the transaction details,   overriding any discounts you may have entered manually for the details.

Discounted Return Cost

The program displays the return cost less the discount amount in this   field.

Expense Account

You specify a general ledger expense account for non-inventory item   details. You can select 
general ledger   account numbers using the Finder.

The program displays the number entered with the detail on the   receipt, if any, but you can change 
the number. 

Extended Cost

If you are entering a return to an existing receipt, the program displays   the extended cost from the 
receipt, and you cannot change the amount.   This field shows zero on returns entered without 
receipt numbers.

Extended Weight

Enter the extended weight for the number of units of the item that you   are returning.

If you change the extended weight, the program automatically recalculates   the unit weight.
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The total weight for all items on the document is displayed in the Totals   tab.

Item Description

The program displays the description for the item number you entered,   or that was entered with the 
detail on the receipt, but you can change   it.

If you enter an item number that is not defined in your Inventory   Control system, no description is 
displayed. Enter the description that   you want to use.

Item Number 

On new returns you are entering without receipt numbers, you enter the   item number or select it 
from the Finder. If you use the Allow Non-inventory   Item Numbers option in Purchase Orders, you 
can also enter an item number   that is not included in your Inventory Control data.                   

If you are entering a return to a receipt or you are editing a return   you posted previously, the 
program displays the item number that was entered   with the detail. You cannot change it.

Line Number

Location

This field appears if you use Inventory Control.

If you are entering a return without a receipt number, enter the code   for the location from which you 
are returning the items.

If you are entering a return to a receipt or editing a previously posted   return, the program displays 
the location code entered for the detail   on the receipt. You cannot change it.

Manufacturer's Item Number

If a manufacturer's item number was used on the receipt or return, the   program also displays the 
manufacturer's item number on the return.

Manufacturer's item numbers are alternative item numbers —   such as bar codes or shortcut codes —   
that identify your inventory item. You set up manufacturer's item numbers   in the Inventory Control 
system. 

You can enter manufacturer's item numbers wherever you enter item numbers   in Purchase Orders.
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Net Of Tax             

This field displays the extended item cost, minus any applicable tax   amount. You cannot edit the 
amount.

Non-Stock Clearing Account

Use the Non-Stock Clearing Account field to change the non-stock clearing account associated 
with this item's account set.

If the item used in the detail is a non-stock item, the non-stock clearing   account associated with the 
item's account set appears.

If you are returning a non-stock item, the non-stock clearing account   associated with the item's 
account set appears. You can specify a different   account, if necessary.

Optional Fields 

If optional fields have been defined in Purchase Orders for return details, you can click the Zoom 

 button beside the Optional Fields field to display the optional fields assigned to a selected detail, 

and edit their contents.

For more information about using optional fields in transactions, see "About Optional Fields in 
Transactions" (page 80). 

Order Number

Enter the number of a sales order to which the detail applies. If you use Order Entry with Purchase 
Orders, you can also select an Order Entry order number from the Finder.

You can change or erase an order number that is displayed with a detail you added on the receipt.

Quantity Received

If you are entering a return to an existing receipt, the program displays   the received quantity, and 
you cannot change the amount. This field shows   zero on returns entered without receipt numbers.

Quantity Returned

Enter the number of units of the item that you are returning.
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If you are entering a return to an existing receipt or editing a previously posted return, be sure that 
the return quantity you enter is in the unit of measure that is used for the detail. You cannot change 
the unit of   measure that was entered with the receipt or previously posted return.

If you do not allow negative inventory levels   in Inventory Control and you enter a return quantity that 
will drop the   item quantity on hand below zero, a warning message is displayed. You must then 
choose whether you still want to return that quantity.

If you use Serialized Inventory and Lot Tracking, a separate screen appears after you have entered 
the quantity of serialized/lotted items returned, then press Tab (or press Enter). (This screen also 
opens when you click the Zoom button in the Quantity column header.)

Receipt Discount

This field displays the discount amount from the original receipt.

Return Cost

You can enter a return cost on returns that do not reference a receipt   number.

Note that if you change the displayed return cost, the unit cost is   recalculated. The program also 
recalculates the return cost if you change   the unit cost.

If you are working with an existing receipt or return, you cannot change   either of these entries.

Retainage %, Retainage Amount, and Retention Period

If the Retainage option was selected for the receipt, the program will   display additional retainage 
fields for each return detail line to let   you enter a retainage percentage or amount and the retention 
period.

The program will also display the Retainage tab to let you specify the   exchange rate that you want 
to use for the retainage portion of multicurrency   returns.

If you clear the Retainage option, the percentage and period retainage   fields disappear from the 
item detail section, and the Retainage   tab also disappears.

By default, the program displays the retainage percentage/amount and   retention period that was in 
effect for the receipt.

Note: Retainage accounting applies only to job-related transactions,   and is available only if you 
selected retainage accounting in the Accounts   Payable program.
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Tax Included

This field displays the amount of tax that is included in the extended item cost (when the cost 
includes tax).

To edit tax settings, press F9 to display the Detail Items/Taxes screen. You can also edit total tax 
amounts on the Taxes tab.

Tax Included

This field appears on the Detail Items/Taxes screen.

Use this field to indicate whether tax amounts are included in the item   cost (instead of charged in 
addition to the detail cost). 

To toggle between Yes and No in this field, enter any character in the   field, or double-click the field 
with a mouse. 

The default choice for this option is provided from the vendor record   in Accounts Payable or from 
the vendor contract cost. 

You can choose Yes for this option only if the Allow Tax In Price option   is selected for the authority in 
Tax Services.

Unit Cost

The program displays the unit cost entered for the detail on the receipt.   You can change the cost if 
you have security rights to do so. Make sure   that the cost you enter is the correct item cost for the 
unit of measure.

Unit of Measure

The program displays the unit of measure entered for the detail on the   receipt. You cannot change 
it.

Unit Weight

If you are adding a return without a receipt number, enter the unit of   measure to use or select it from 
the Finder. (If you entered a non-inventory   item number, you cannot select a unit of measure from 
the Finder.)

If you are entering a return to a receipt, the program displays the   unit of measure entered for the 
detail on the receipt. You cannot change   it.
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Vendor Item Number

Enter the code the vendor uses to identify the item or edit a displayed   code, if necessary.

If the vendor's item number is specified in the item record (when you   are adding a new detail) or on 
the receipt for which you are entering   a return, the code appears in this field. (You can enter 
vendors' item   numbers when assigning vendor types in Inventory Control item records.)

Weight Unit of Measure

This is the unit of measure (such as pounds, kilograms,   tons) for the weight of this item on the 
return.

By default, the program displays the weight unit of measure from the receipt (if you specified one), 
but you can change it to another defined unit of measure (and the program will recalculate the 
weight accordingly).   

The weight UOM for the complete return is determined by the default weight unit of measure set in 
the I/C Options screen (or in the P/O Options screen, if you do not use Inventory Control).

Taxes   tab

Retainage Tax Amount

This field appears on the Taxes tab for Receipt Entry, Invoice Entry,   Return Entry, and Credit/Debit 
Note Entry if retainage applies to the   document. 

It shows the amount of tax calculated for this authority for the retainage   portion of the document if 
you report tax for retainage amounts when you   create the retainage document (not when you 
create the original document).   

Retainage appears only on job-related documents if you select   the Retainage option on the first tab 
of the transaction entry screen.

Retainage tax amounts are computed using the retainage tax base and   the tax rate for each tax 
authority. 

Retainage Tax Base

The retainage tax base is the amount (before included taxes) used as   the base for calculating taxes 
on the retained amount.
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Essentially, the retainage tax base is the retainage portion of the   document (excluding tax) if you 
report tax for retainage amounts at the   time that you create the retainage document (not when you 
create the original   document). 

Retainage appears only on job-related documents if you select   the Retainage option on the first tab 
of the transaction entry screen.

Retainage tax amounts are computed using the retainage tax base and   the tax rate for each tax 
authority. 

Tax Amount

The program displays the total tax amount calculated for each authority   in the vendor's tax group. 
You can change this amount, if necessary.

To cancel all your changes   to tax amounts at the same time, choose the Calculate Taxes button.

Tax Base

The tax base shows, for the tax authority, the net cost of items before   tax is added. (This field is 
useful for items that have tax included in   their prices.)

Tax Group

Enter the tax group that identifies the tax   authorities to which the vendor is subject. You must use a 
tax group that is defined for your company in Common   Services.

You must enter a valid tax group for every return vendor.

Tax Authority and Description                             

These columns list the codes and corresponding descriptions for all the tax authorities in the tax 
group specified for the document. 

You enter tax information in the Tax Services module in Common   Services. 

Tax Authority and Description

The program displays the codes and descriptions of the tax authorities   assigned to the vendor's tax 
group.

Note: You define codes for tax authorities and edit their descriptions in   Tax Services.
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Tax Class and Tax Class Description

The program displays the tax classes and their corresponding descriptions   as assigned to the 
vendor's tax authorities. You can change each tax class   to another tax class that is permitted by the 
authority.

Note: You can change a tax class description only in Tax Services.

Tax Excluded                               

The program displays the total amount of tax that is not included in   item costs for the authority.

Tax Included

The program displays the total amount of tax that is included in item costs for the authority.

You can include tax amounts in item costs only if permitted by the authority.

Tax Reporting Currency

Tax reporting fields appear on the Taxes tab only if the tax group's tax reporting currency is different 
from your functional currency and the vendor's   currency.

Along with the tax reporting currency, the program displays the amount of included   and excluded 
tax to be reported in that currency on tax tracking reports   for all the tax authorities listed on the 
document.

You set the tax reporting currency for tax groups in the Tax Services module   in Common Services.                    

Tax Reporting Total             

This field displays the sum of the tax reporting amounts for all tax authorities.   

It appears only if the tax reporting currency for the   tax group is different from your functional 
currency and the   vendor's currency. 

You set the tax reporting currency for tax groups in the Tax Services module   in Common Services.

Total Retainage Tax

This field appears on the Taxes tab for Receipt Entry, Invoice Entry,   Return Entry, and Credit/Debit 
Note Entry if retainage applies to the   document.
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It shows the total amount of tax calculated for the retainage portion   of the document if you report tax 
for retainage amounts when you create   the retainage document (not when you create the original 
document). 

Retainage appears on job-related documents only  if you select   the Retainage option on the first tab 
of the transaction entry screen.

Retainage tax amounts are computed using the retainage tax base and   the tax rate for each tax 
authority. 

Total Tax

This field displays the total tax amount calculated for each authority   in the vendor's tax group. You 
can change this amount, if necessary. 

To cancel all your changes   to tax amounts at the same time, click the Calculate Taxes button. 

Retainage   tab

The Retainage tab lets you specify the exchange   rate that you want to use for returns of 
multicurrency retainage receipts.   You can:

 l Use the original document   exchange rate

 l Use the current exchange   rate

Note: This tab will appear only if you used retainage accounting on the original   receipt or 
invoice.

Optional Fields tab

The Optional Fields tab contains optional fields added by your company that apply to the 
transaction as a whole. Optional fields on detail lines apply to the individual transaction detail.

Note: This tab will appear only if you have Transaction Analysis and Optional Field Creator.

Rates tab

The Rates tab appears only for multicurrency ledgers.
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Currency

Displays the vendor's currency code and a description   of the currency. All amounts you enter for the   
return will be in the vendor's currency.

The currency is assigned for the vendor in Accounts Payable and you   cannot change it in Purchase 
Orders.

Derive Rate

When Purchase Orders calculates the tax amount in a tax reporting currency,   the program uses the 
Tax Reporting Currency Exchange Rate that appears   (or that you enter) on the Rates tab.

However, if you have changed the tax reporting amount that appears on   the Taxes tab, you can 
click the Derive Rate button to see the actual   exchange rate between the tax amount and the tax 
reporting amount.

In other words, the Derive Rate button appears so you can derive the   exchange rate for the tax 
reporting currency, if you change the calculated   amount on the Taxes tab.

Return Exchange Rate

The program displays the exchange rate currently in effect for the specified   currency and the 
displayed rate type and rate date, but you can change the   rate.

You receive a warning if you change an exchange rate by an amount that exceeds   the Spread 
setting for the currency in Common Services' Currency Rates table.

If you are entering a return to a receipt, the screen also displays the exchange rate entered on the 
receipt.

Return Rate Date

Type or select the date to use to select the exchange rate for the document you are entering.

The program displays the rate date that is nearest the   document date you entered, but you can 
specify a different date for which   an exchange rate exists for the currency in   Common Services' 
Currency Rates table.

If you change the rate date, Purchase Orders checks the rate tables   for a date match, and updates 
the rate if necessary. 

If you are entering a return to a receipt, the screen also displays the rate date used with the receipt.
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Return Rate Type

If the rate type you want to use is not displayed, enter the code or choose it from the Finder.

The program uses rate types when converting multicurrency amounts on the invoice to functional 
currency. Examples of rate types might be "spot rate," "average rate," and "contract rate."

You define rate types using the Currency Rate Types screen in Common Services, and assign the 
default rate type for Purchase Orders on the Processing tab of the P/O Options screen.

If you are entering a return to a receipt, the screen also displays the rate type used with the receipt.

Receipt Exchange Rate

If you are entering a return to a receipt, the Rates tab displays the   exchange rate entered on the 
receipt.

Receipt Rate Date

If you are entering a return to a receipt, the screen displays the rate   date used with the receipt.

Receipt Rate Type

If you are entering a return to a receipt, the screen displays the rate   type used with the receipt.

Totals tab

Comment

Enter a comment for the return, using up to 250 characters.   The program automatically wraps text 
as you reach the end of a line. If   you wish to insert your own line breaks, press Ctrl+Enter where you 
want a line break to occur.

If you are entering a return to a receipt, the comment, if any, entered   on the receipt is displayed, but 
you can change it. 

If you are editing a posted return, you cannot change the comment.

Estimated Tax

This is the tax amount that will be applied to the retainage invoice   (if the tax authority allows you to 
defer tax on retained amounts on an original receipt and invoice).
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If you are applying all tax amounts to the original invoice, this amount   will be zero.

Retainage amounts are invoiced at a later time, in Accounts Payable.

Less Retainage

This field lists any retained amounts that apply to the items being   returned (so that the net return 
total will reflect the currently invoiced   value of returned items).

This field appears only if amounts were retained on the original document.

Less Return Discount

You can enter an optional discount percentage or discount amount   for the entire document, or enter 
discounts for individual detail lines.

If you enter a discount for the entire document, Purchase Orders   prorates the discount amount for 
the document details, overriding any discounts   you may have entered manually for the details.

Net Return Total

This field lists the net return total after deducting any retained amounts   that apply to the items being 
returned. (The result reflects the currently   invoiced value of returned items.)

This field appears only if amounts were retained on the original document.

Number of Labels

This field lets you specify the number of mailing labels to print for   the returned shipment.

Number of Lines                               

The program displays the number of item detail lines you entered for the   primary vendor on the 
document.

Check this number against source documents to make sure you entered   all the details you require.

Plus Excluded Tax                              

This field displays the total excluded tax amount of all item and additional   cost details for the vendor. 
This amount does not include   taxes that are included in the cost amounts.
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Return Subtotal

The program displays the total of all item detail costs, if any, entered   from the return, including tax-
included amounts. This subtotal does not   include tax amounts that are not included in item costs.

Return Total

The program displays the total of all item costs and taxes for the vendor   and return.

Tax Included

The program displays the total amount of tax that is included in item costs for the authority.

You can include tax amounts in item costs only if permitted by the authority.

Total Tax

The total tax amount is the sum of the tax included and tax excluded.

Total Weight

The program displays the total weight of the returned goods, calculated   from the weight and 
returned quantity entered for each item detail.

Use this amount to check returned shipping charges.

P/O Return Entry Bill-To Location Screen

To Open this Screen

 1. Open Purchase Orders > P/O Transactions > Return Entry.

 2. Click the Zoom  button beside the Bill-To Location field, or press the F9 key in the field.

Overview

Use the Bill-To Location screen when entering returns without a receipt number to specify the 
address to which the vendor should send the credit note for the return.

Note: If you are editing a return to a receipt, you cannot change the    bill-to location.
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Fields and Controls

Address

Use the Address field to type the address for the location, or edit the displayed information   if 
necessary.

Bill-To Location 

If you use Inventory Control and you selected a bill-to location code,   the program displays the 
location code.

If you do not use Inventory Control, you can click the Zoom  button beside the field name.

Enter the bill-to location information by typing   in the screen that appears.

Contact

Enter the name of a contact person, department, or position.

Description

Use the Description field to type a description of the location, such as a company name, or edit   a 
displayed description if necessary. You do not have to include a description.

E-mail

Use the E-mail field to type the e-mail address for the location, or edit the displayed address   if 
necessary.

Fax Number

Use the Fax Number field to type the fax number for the location or edit a displayed number if 
necessary.

Phone Number

Use the Phone Number field to type the telephone number for the location or edit a displayed 
number   if necessary.
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P/O Return Entry Detail Comments Screen

To Open this Screen

 1. Open Purchase Orders > P/O Transactions >  Return Entry.

 2. On the Return tab , click the      Comments field for the detail line you need.

 3. Click the Zoom  button or press the Shift and F9 keys to open the Detail Comments screen.

Use this screen to enter comments for a selected return detail line.

To enter or edit a comment:

 1. Type the comment, pressing Enter to start each new line.

 2. When finished, click Close to close the screen.

To delete comments:

 1. Highlight the text to       delete, then press the Delete key. If a message appears      asking you to 
confirm the deletion, click Yes.

 2. When finished, click Close      to return to detail entry.

Tip: You can also delete comments by changing the entry in     theComments field to No on the 
Return tab. If you decide     before posting the return that you want to use the remarks, change the 
Comment field to Yes. Your original remarks will reappear. 

P/O Return Entry Detail Items/Taxes Screen   

To Open this Screen

 1. Open Purchase Orders > P/O Transactions > Return Entry.

 2. Enter header information for the return, and, if you are creating a new return for an existing 
receipt, specify the receipt number.

 3. Select a detail line, and then press F9, or click the Item/Tax       button.
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Related Tasks

 l "    Adding or Editing Details Using the Detail Items Taxes Screen" (page 165)

 l "Entering Returns   " (page 161)

Overview

Use this screen to check and edit return detail lines. You also use this screen to check or to edit tax 
information for a return detail.

This screen displays all the fields for a single detail in a separate window,      making it easier to see the 
information you entered for the detail. 

Fields and Controls

Buttons

Calc. Taxes

Click the Calc. Taxes button to see tax amounts for   a detail before you post the document. 

Note: Tax amounts are not   calculated automatically until you click the Taxes tab or the Totals tab, 
or you post the purchase order.

Close

Click the Close button to close the Detail Items/Taxes screen. 

On the Detail Items/Taxes screen and the Detail Costs/Taxes screen, you can also press the F9 key 
on your keyboard to close the screen.

Delete

Click the Delete button to delete the detail displayed in the zoomed   detail-entry screen.

New

Use the New button to start a new detail.
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Save/Add

Use the Save button to save the changes you made to a detail you edited in the Detail Items/Taxes 
screen.

For a new detail, this button is called Add.

Allocated Tax  

The program displays the total tax amount that has been allocated to the detail, including taxes that 
are included in the item cost. Recoverable and expensed tax amounts not included.

Allocated taxes form part of the item costs that are posted to the Inventory Control item records by 
Day End Processing.

Billing Type, Billing Rate, and A/R Item Number

For job-related returns, the program provides the Billing Type, Billing Rate, and AR Item 
Number that was used for the receipt.

The Job-Related check box in the top part of the screen will be selected   if the receipt was job-
related.

A/R     Item Number

This field displays the A/R item number associated with the project resource     used for the contract in 
Project and Job Costing. You can select a different     A/R item number only for time and material 
projects, as follows:

 l On a standard project,        this field displays the A/R item number and unit of measure specified        
for the project resource category as the default. You can accept the item       number or select 
another valid A/R item number.

 l On a basic project, this field        displays the A/R item number and unit of measure specified for 
the project        category. You can accept the item number or select another valid A/R item       
number.

 l If you change the A/R        item number, the item number must be a valid item number in Accounts 
Receivable,        and the unit of measure must be a valid unit of measure both for the new       item 
number and the vendor’s currency.

Cost plus and fixed price projects do not use an A/R item number. 
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Billing Currency

This field appears only in multicurrency systems for time and materials projects and for fixed price 
projects using billings and costs or accrual-basis accounting methods.

The billing currency is the customer's currency specified on the contract, and you cannot change it.

Billing currency is blank for Fixed Price projects using completed project or project percentage 
complete methods, and for Cost Plus projects.

Note: Billing currency is not displayed for basic or standard internal Time and Materials projects, 
or for single-currency Fixed Price projects that use billings and costs or accrual-basis accounting 
methods.

Billing Rate

This field displays the billing rate for the specified resource (for standard projects) or category (for 
basic projects).

You can edit the billing rate if the billing type is Billable. The field displays 0.000000 if the billing type 
is Non-Billable or No Charge.

Note: 
 l You can specify the billing rate for Time and Materials projects and for Fixed Price projects 

that use Billings and Costs or Accrual-Basis accounting methods.

 l Billing rate is disabled and set to 0.000000 on a basic or standard internal contract for Time 
and Materials projects or for Fixed Price projects using Billings and Costs or Accrual-Basis 
accounting methods.

 l The billing rate cannot be negative.

Billing     Type

This field appears in the detail-entry section only for job-related     purchase orders.

The billing type indicates to Project and Job Costing whether to bill      the cost to the customer. You can 
change this field only for a time and     materials project, as follows:

On a basic project:

For a billable project,        the category billing type determines whether you can change the billing       type 
for the detail. If the specified category is:
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 l Billable, the default       billing type for the detail is billable, but you can change it.

If the detail is billable you can specify a billing     rate for the detail.

If you change the billing type for the detail to no      charge or non-billable, the program sets the billing 
rate to zero and     you cannot change it.

 l No charge or non-billable,        the program sets the same billing type for the detail, and cannot 
change        it. You cannot specify a billing rate for the detail, which the program       sets as zero.

If the project is no charge        or non-billable, the detail uses the same billing type as the project,       the 
billing rate is set to zero, and you cannot change them.

On a standard project:

If the project is billable,        the resource billing type determines whether you can change billing type       for 
the detail.  If the specified resource is:

 l Billable, the program        displays Billable as default billing type, but you can change it for the        
detail. If the detail is billable, you can specify a billing rate for       the detail.

If you change the billing type for the detail to no      charge or non-billable, the program sets the billing 
rate to zero, and     you cannot change it.

 l No charge or non-billable,        the program sets same billing type for the detail, and you cannot 
change        it. You cannot specify a billing rate for the detail, which the program       sets as zero.

If the project is no charge        or non-billable, the detail uses the same billing type as the project,        and 
you cannot change it. The program also sets the billing rate to zero,       and you cannot change it.

For fixed price and cost plus projects,      the Billing Type field is blank. A billing type is not required for 
these     types of projects.

Unit     of Measure

This field appears for Time and Materials projects if you selected the     Job Related option for this 
transaction.

You must enter a unit of measure that is valid for the item number/resource     that you specified and 
for the contract customer's currency.

Note: For internal time and materials projects (basic or standard     contracts) the A/R item unit of 
measure will be disabled or blank.
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Comments 

To view comments for a selected detail line, click the Zoom  button beside the Comments field. 

The program displays any comments entered for the detail line on   the receipt, but you can change   
or delete them.

To enter comments for the selected detail, click the Detail Comments table, press the Insert key, and 
then type the comments on the new line. 

Lines wrap automatically. To start a new line before the line wraps, press Enter. 

For more information, see "P/O Return Entry Detail Comments Screen" (page 701).

Contract, Project, Category and Resource

If the associated purchase order and receipt were job related, the return is also job related. For 
job-related returns:

 l The Job Related option  is selected automatically.

 l Purchase Orders displays the job to which each detail was assigned.

 l You specify the resource   using the Item Number field.

Purchase Orders updates jobs with the actual quantities and costs on returns. 

Note: If you use different   terms than “Contract,” “Project,” and “Category” in Project and Job 
Costing,   the program displays them instead.

Category

Select or enter a category that is assigned to the project in Project   and Job Costing.

Contract

Specify a contract number for each detail. You can enter or   select only contracts that are open or on 
hold. (You cannot process transactions   to a contract that is on hold, if it has never been opened.)

Cost   Class

The program displays the cost class for the category used in each detail.   You cannot change this 
field.
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Item   Number (Resource)

Use the Item Number field to identify the resource for this detail.

You must specify a resource that is assigned to the project and category in   Project and Job Costing. 
You can specify an inventory item number, or the code for another type of resource (such as an 
equipment code, subcontractor code, or employee number). 

Note: You cannot leave this field blank.

Project

You can only enter or select projects that are:

 l Assigned to the contract   that you selected.

 l Open or on hold. (If   a project that is on hold has never been opened, you cannot select it.)

 l Not closed to costs.

Discount %

You can enter a discount as a percentage or an amount. The program uses the amount you enter in 
this field to calculate the   discounted cost for the item detail. 

If you enter a percentage in this field, Purchase Orders calculates   the discount amount for the item 
detail.

Tip: If you prefer not to enter discounts for individual details, you can   enter a discount percentage 
for the entire document on the Totals tab. Purchase   Orders then prorates the discount amount for 
the transaction details,   overriding any discounts you may have entered manually for the details.

Discount Amount

You can enter a discount as a percentage or an amount. The program uses the amount you enter in 
this field to calculate the   discounted cost for the item detail. 

If you enter a discount amount,   the program calculates and displays the discount percentage based 
on the   cost. (Alternatively, you can enter a percentage in the Discount   Percent field, and let the 
program calculate the discount amount.)
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Tip: If you prefer not to enter discounts for individual details, you can   enter a discount amount for 
the entire document on the Totals tab. Purchase   Orders then prorates the discount amount for the 
transaction details,   overriding any discounts you may have entered manually for the details.

Discounted Return Cost

The program displays the return cost less the discount amount in this   field.

Expense Account

You specify a general ledger expense account for non-inventory item   details. You can select general 
ledger   account numbers using the Finder.

The program displays the account number entered with the detail on the   receipt, if any, or the 
account number specified in the Options   screen for the Default Inventory Expense Account option. 
You can change   the number on the return. 

Extended Cost

If you are entering a return to an existing receipt, the program displays   the extended cost from the 
receipt, and you cannot change the amount.   This field shows zero on returns entered without receipt 
numbers.

Extended Weight

Enter the extended weight for the number of units of the item that you   are returning.

If you change the extended weight, the program automatically recalculates   the unit weight.

The total weight for all items on the document is displayed in the Totals   tab.

Item Description

The program displays the description for the item number you entered,   or that was entered with the 
detail on the receipt, but you can change   it.

If you enter an item number that is not defined in your Inventory   Control system, no description is 
displayed. Enter the description that   you want to use.

Item Number 

On new returns you are entering without receipt numbers, you enter the   item number or select it 
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from the Finder. If you use the Allow Non-inventory   Item Numbers option in Purchase Orders, you 
can also enter an item number   that is not included in your Inventory Control data.                   

If you are entering a return to a receipt or you are editing a return   you posted previously, the 
program displays the item number that was entered   with the detail. You cannot change it.

Line Number

Each detail is identified with its own line number.

To select an existing line to edit or delete, click the line, or   enter its line number in this field on the P/O 
Detail Items/Taxes screen.

Location

This field appears if you use Inventory Control.

If you are entering a return without a receipt number, enter the code   for the location from which you 
are returning the items.

If you are entering a return to a receipt or editing a previously posted   return, the program displays 
the location code entered for the detail   on the receipt. You cannot change it.

Manufacturer's Item Number

If a manufacturer's item number was used on the receipt or return, the   program also displays the 
manufacturer's item number on the return.

Manufacturer's item numbers are alternative item numbers—such as bar codes or shortcut codes—
that identify your inventory item. You set up manufacturer's item numbers   in the Inventory Control 
system. 

You can enter manufacturer's item numbers wherever you enter item numbers   in Purchase Orders.

Net Of Tax             

This field displays the extended item cost, minus any applicable tax   amount. You cannot edit the 
amount.

Non-Stock Clearing Account

Use the Non-Stock Clearing Account field to change the non-stock clearing account associated 
with this item's account set.
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If the item used in the detail is a non-stock item, the non-stock clearing   account associated with the 
item's account set appears.

If you are returning a non-stock item, the non-stock clearing account   associated with the item's 
account set appears. You can specify a different   account, if necessary.

Optional Fields 

If optional fields have been defined in Purchase Orders for receipt details, you can click the Zoom 

 button beside the Optional Fields field to display the optional fields assigned to a selected detail, 

and edit their contents.

For more information about using optional fields in transactions, see "About Optional Fields in 
Transactions" (page 80). 

Order Number

Enter the number of a sales order to which the detail applies. If you   use Order Entry with Purchase 
Orders, you can also select   an Order Entry order number from the Finder.

You can change or erase an order number that is displayed with a detail   you added on the receipt.

Quantity Received

If you are entering a return to an existing receipt, the program displays   the received quantity, and 
you cannot change the amount. This field shows   zero on returns entered without receipt numbers.

Quantity Returned

Enter the number of units of the item that you are returning.

If you are entering a return to an existing receipt or editing a previously posted return, be sure that 
the return quantity you enter is in the unit   of measure that is used for the detail. You cannot change 
the unit of measure that was entered with the receipt or previously posted return.

If you do not allow negative inventory levels in Inventory Control and you enter a return quantity that 
will drop the item quantity on hand below zero, a warning message is displayed. You must then 
choose whether you still want to return that quantity.

If you use Serialized Inventory and Lot Tracking,   a separate screen appears after you enter the 
quantity of serialized/lotted   items returned, then press Tab (or press Enter). (This screen also 
appears when you click the Zoom button in the Quantity column header.)
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Receipt Discount

This field displays the discount amount from the original receipt.

Retainage %, Retainage Amount, and Retention Period

If the Retainage option was selected for the receipt, the program displays additional retainage fields 
for each return detail line to let   you enter a retainage percentage or amount and the retention 
period.

The program also displays the Retainage tab, where you specify the   exchange rate to use for the 
retainage portion of multicurrency returns.

If you clear the Retainage option, the percentage and period retainage fields disappear from the 
item detail section, and the Retainage   tab also disappears.

By default, the program displays the retainage percentage/amount and   retention period that was in 
effect for the receipt.

Note: Retainage accounting applies only to job-related transactions, and is available only if you 
selected retainage accounting in the Accounts Payable program.

Return Cost

You can enter a return cost on returns that do not reference a receipt   number.

Note that if you change the displayed return cost, the unit cost is   recalculated. The program also 
recalculates the return cost if you change   the unit cost.

If you are working with an existing receipt or return, you cannot change   either of these entries.

Tax Included

This field appears on the Detail Items/Taxes screen.

Use this field to indicate whether tax amounts are included in the item   cost (instead of charged in 
addition to the detail cost). 

To toggle between Yes and No in this field, enter any character in the   field, or double-click the field 
with a mouse. 

The default choice for this option is provided from the vendor record   in Accounts Payable or from the 
vendor contract cost. 
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You can choose Yes for this option only if the Allow Tax In Price option   is selected for the authority in 
Tax Services.

Unit Cost

The program displays the unit cost entered for the detail on the receipt.   You can change the cost if 
you have security rights to do so. Make sure   that the cost you enter is the correct item cost for the 
unit of measure.

Unit of Measure

The program displays the unit of measure entered for the detail on the   receipt. You cannot change 
it.

Unit Weight

If you are adding a return without a receipt number, enter the unit of   measure to use or select it from 
the Finder. (If you entered a non-inventory   item number, you cannot select a unit of measure from 
the Finder.)

If you are entering a return to a receipt, the program displays the   unit of measure entered for the 
detail on the receipt. You cannot change   it.

Vendor Item Number

Enter the code the vendor uses to identify the item or edit a displayed   code, if necessary.

If the vendor's item number is specified in the item record (when you   are adding a new detail) or on 
the receipt for which you are entering   a return, the code appears in this field. (You can enter 
vendors' item   numbers when assigning vendor types in Inventory Control item records.)

Weight Unit of Measure

This is the unit of measure (such as pounds, kilograms,   tons) for the weight of this item on the return.

Purchase Orders displays the weight unit of measure from the   receipt (if you specified one) as the 
default, but you can change it to another defined   unit of measure. The program recalculates the 
weight accordingly.   

The weight UOM for the complete return is determined by the default   weight unit of measure set in 
the I/C Options screen (or in the P/O Options screen, if you do not use Inventory Control).
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Tax table

Allocated Tax             

This column displays the tax amounts allocated to the selected detail   line for each tax authority.

Detail Tax Class and Description

These columns list the tax classes and corresponding descriptions that   are assigned to the tax 
authority. You can change the tax   class (to another tax class that is assigned to the authority), but 
not   the description.

To change the tax class description or make other changes to the information   for the specified tax 
group, use the Tax Services screens in Common Services. 

Expensed Tax

The program displays the amount of tax that is separately posted (expensed)   to a general ledger 
account, rather than allocated to details on the credit   note or debit note.

Recoverable Tax 

The program displays the amount of tax that can be recovered by your   company, such as, for 
example, recoverable Canadian Goods and Services   Tax (GST) amounts.

Tax Amount 

The program displays the amount of tax that is due for each authority.

For each authority, Purchase Orders calculates a tax amount if:

 l The vendor is subject to tax.

 l The transaction contains taxable items or taxable additional costs.

 l Tax rates are specified for the tax authorities and classes in Tax Services.

You cannot edit the tax amount for a detail except indirectly, by changing   the tax class or tax-
included option on the Detail Items/Taxes screen.

To edit tax amounts for the invoice, make your changes on the Taxes   tab.
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Tax Authority and Description                                              

These columns list the tax authorities and   that are assigned to the tax group you specified for the 
document.

Tax information is maintained in the Tax Services screens in Common   Services.

Tax Base 

This field shows, for the selected detail, the net cost   of items before tax is added for the tax 
authority. You cannot change   the amount that appears in this field.

This field is particularly useful for items that have tax included in   their prices.

Tax Included                                     

This field displays the amount of tax that is included in the extended   item cost (when the cost 
includes tax).

P/O Lot Numbers Allocation Screen

To Open this Screen

 1. Open Purchase Orders >       P/O Transactions > Return Entry or Debit/Credit Note Entry.

 2. Enter a value in the Quantity Returnedfield for the lotted items you want to return, and press 
either the Enter or Tab key.

Related Tasks

 l "Returning and Issuing Credit/Debit Notes for Lotted Items" (page 190)

Overview

Purchase Orders prompts you to allocate lot numbers when you return lotted items to vendors. You 
use the P/O Lot Numbers Allocation screen to allocate these numbers.

Note: Lot numbers are used for tracking stock from the point of receipt through   to the point of sale, 
and can be used to track returned items from the   customer and back to the vendor.

You also use the following procedure when entering a debit note or a credit note for a vendor, except 
that you start from the Credit/Debit Note Entry screen instead of the Return Entry screen.
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Fields and Controls

Buttons

Add

Click the Add button to add   the lot or serial number displayed in the Next Lot Number or Next 
Serial   Number field.

Auto Alloc

Click the Auto Alloc button   to automatically allocate lot numbers to the items. The required number   
of lot numbers appears in the Lot Numbers list.

To start allocating from a specific lot number, specify this number   in the Auto-Allocate From field, 
before you click Auto Alloc.

Auto Gen

The Auto Gen button appears if you had selected the option Allow Auto-Generation of Lot 
Numbers in PO on the Settings tab of the   I/C Options screen.

When you click the Auto Gen button, a dialog box opens, where you indicate   how many lot numbers 
need to be created.

Clear

Click the Clear button to remove lot   numbers or quantities allocated, or both, depending on the 
screen.

Close

Click the Close button to end the lot number allocation process.

Auto-Allocate From

Use the Auto-Allocate From field   to specify the starting lot number from which to automatically 
allocate   the lot numbers.
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 1. Select the Auto-Allocate   From check box to display a field beside it.

 2. In this field, use the   Finder to find and select a starting lot number, or enter it manually.   

 3. Click the Auto   Allocate button to allocate the required number of lot numbers,   starting from 
the specified number.

Make Lots OR Each Has

When you auto-generate lots, you must enter a number in one of these   fields to define how the lots 
are generated:

 l Make   __ Lots. If you want to create a fixed number of lots, with the   quantity evenly distributed 
across all of the lots, enter the number of   lots.

Example: If you create 10 lots and have 400 items,   each lot will have 40 items.

OR 

 l Each   Lot Has __. If you want to distribute a fixed quantity to each   lot, enter the number to 
include in each lot.

Example: If  you want to have 50 items in each lot,          the process will generate the number of lots 
needed to accommodate the         quantity of items.

Next Lot Number

This field displays the next sequential lot number available for the   item. Depending on which buttons 
are displayed, you can use this number   in these ways:

 l Click Add   to add the displayed number to the Lot Numbers list. Repeat this for as   many 
numbers as you need.

 l Click Auto-Gen   to add the required number of lot numbers to the Lot Numbers list,   starting 
from the displayed number.

 l Click Auto-Alloc   to add the required number of lot numbers to the Lot Numbers list, starting   
from the displayed number.

When you finish, this field displays the next lot number that is now   available.

Count section

Allocated / Generated / Returned count

This display field indicates how many lot numbers have been selected.
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Lot Qty Required

This field indicates how many lot numbers are required, as indicated   on the quantity field from which 
you accessed the Lot Numbers Allocation   pop-up.

Remaining

This figure represents the quantity still to be entered on the Lot Tracking   pop-up screen. This 
number should be zero after you have finished allocating   lot numbers.

P/O Serial Numbers Allocation Screen

To Open this Screen

 1. Open Purchase Orders > P/O Transactions > Return Entry or Credit/Debit Note Entry.

 2. Enter a value        in the Quantity Returned field for the serialized items you want to return, and 
then press       either the Enter key or the Tab key to display the Serial Numbers Allocation screen.

Fields and Controls

Buttons

Add

After entering a number in the New Serial Number field, click the Add   button to add the number to 
the Generated Serial Numbers list.

Auto Alloc

After entering a serial number in the blank field above the Available   Serial Numbers list, click the 
Auto Alloc. button. The required serial   numbers will appear in the Returned Serial Numbers list, 
beginning with   that number.

Auto Gen

Click the Auto Gen button after entering a number in the New Serial   Number field, or after 
highlighting a number in the Existing Serial Numbers   list. 

717Sage 300 2021 Purchase Orders User's Guide



The correct quantity of required serial numbers will appear in the   Generated Serial Numbers list, 
beginning with that number.

Clear

Click the Clear button to remove all the serial numbers listed in the   Generated Serial Numbers or 
the Returned Serial Numbers lists.

A message appears, asking if this is what you really want to do.

Return All

On the Serial Numbers Allocation screen, click the Return All button   to return all of the items with 
the serial numbers listed. All of the lines in the Returned column are shown as Yes.

Note: Do not confuse this button with the Return All button on the Return   Entry screen, which is 
used to return all items listed on a selected invoice,   rather than on an individual detail line.

Auto-Allocate From

Use the Auto-Allocate From field   to specify the starting serial number from which to automatically 
allocate   the serial numbers.

 1. Select the Auto-Allocate   From check box to display a field beside it.

 2. In this field, use the   Finder to find and select a starting serial number, or enter it manually.   

 3. Click the Auto   Allocate button to allocate the required number of serial numbers, starting 
from   the specified number.

Next Serial Number

This field displays the next sequential serial number for the item.   Depending on which buttons are 
displayed, you can use this number in these   ways:

 l Click Add   to add the displayed number to the Serial   Numbers list. Repeat this for as many 
numbers as you need.

 l Click Auto-Gen   to add the required number of serial   numbers to the Serial Numbers list, 
starting from the displayed number.

 l Click Auto-Alloc   to add the required number of serial   numbers to the Serial Numbers list, 
starting from the displayed number.

When you finish, this field displays the next serial number that is   now available.
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Unit of Measure

The default unit of measure displayed in the Serialized Inventory pop-up   is the same unit as on the 
underlying transaction.

Count section

Allocated / Generated / Returned

This indicates how many serial numbers you have been selected.

Remaining

This indicates how many serial numbers still need to be assigned.

Serial No's Required

This field indicates how many serial numbers are required, as indicated   on the quantity field from 
which you accessed the Serial Numbers Allocation   screen.

Related Tasks

 l "Returning and Issuing Credit/Debit Notes for Serialized Items   " (page 188)

Overview   

Purchase Orders prompts you to allocate serial numbers    when you return serialized items to vendors. 
You use the P/O Serial Numbers Allocation screen to allocate these numbers.

Note: Serial numbers are used for tracking stock from the point of receipt   through to the point of 
sale, and can be used to track returned items   from the customer and back to the vendor.

Fields and Controls

Buttons

Add

After entering a number in the New Serial Number field, click the Add   button to add the number to 
the Generated Serial Numbers list.
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Auto Alloc

After entering a serial number in the blank field above the Available   Serial Numbers list, click the 
Auto Alloc. button. The required serial   numbers will appear in the Returned Serial Numbers list, 
beginning with   that number.

Auto Gen

Click the Auto Gen button after entering a number in the New Serial   Number field, or after 
highlighting a number in the Existing Serial Numbers   list. 

The correct quantity of required serial numbers will appear in the   Generated Serial Numbers list, 
beginning with that number.

Clear

Click the Clear button to remove all the serial numbers listed in the   Generated Serial Numbers or 
the Returned Serial Numbers lists.

A message appears, asking if this is what you really want to do.

Return All

On the Serial Numbers Allocation screen, click the Return All button   to return all of the items with 
the serial numbers listed. All of the lines in the Returned column are shown as Yes.

Note: Do not confuse this button with the Return All button on the Return   Entry screen, which is 
used to return all items listed on a selected invoice,   rather than on an individual detail line.

Auto-Allocate From

Use the Auto-Allocate From field   to specify the starting serial number from which to automatically 
allocate   the serial numbers.

 1. Select the Auto-Allocate   From check box to display a field beside it.

 2. In this field, use the   Finder to find and select a starting serial number, or enter it manually.   

 3. Click the Auto   Allocate button to allocate the required number of serial numbers, starting 
from   the specified number.
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Next Serial Number

This field displays the next sequential serial number for the item.   Depending on which buttons are 
displayed, you can use this number in these   ways:

 l Click Add   to add the displayed number to the Serial   Numbers list. Repeat this for as many 
numbers as you need.

 l Click Auto-Gen   to add the required number of serial   numbers to the Serial Numbers list, 
starting from the displayed number.

 l Click Auto-Alloc   to add the required number of serial   numbers to the Serial Numbers list, 
starting from the displayed number.

When you finish, this field displays the next serial number that is   now available.

Unit of Measure

The default unit of measure displayed in the Serialized Inventory pop-up   is the same unit as on the 
underlying transaction.

Count section

Allocated / Generated / Returned

This indicates how many serial numbers you have been selected.

Remaining

This indicates how many serial numbers still need to be assigned.

Serial No's Required

This field indicates how many serial numbers are required, as indicated   on the quantity field from 
which you accessed the Serial Numbers Allocation   screen.

P/O Serial/Lot Numbers Allocation/Generation Screen

To Open this Screen

 1. Open Purchase Orders > P/O Transactions.
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 2. Select the screen for the type of document you want to enter (for example, Receipt Entry or 
Invoice Entry).

 3. Enter document information, including details for serialized or lotted items.

When you specify the quantity for a serialized or  lotted item in a detail, and then tab out of the 
quantity field, the respective Serial/Lot Numbers Allocation or Generation screen appears. 
You use it to assign the required serial numbers and lot numbers to items in the detail line.

Tip: You can also open the Serial/Lot Number Allocation/Generation screen by clicking the 

quantity column heading (with the Zoom  button).

Related Tasks

 l "Receiving and Invoicing Lotted Items" (page 189)

 l "Returning and Issuing Credit/Debit Notes for Lotted Items" (page 190)

 l "Receiving and Invoicing Serialized Items   " (page 187)

 l "Returning and Issuing Credit/Debit Notes for Serialized Items   " (page 188)

Overview

You use the P/O Serial/Lot Numbers Generation screen to generate serial or lot numbers when you 
enter receipts, invoices, and debit notes that include serialized or lotted items.

You use the P/O Serial/Lot Numbers Allocation screen to allocate serial or lot numbers when you 
enter returns and credit notes that include serialized or lotted items.

Serials Tab

On the Serials tab, you assign serial numbers to serialized items when you enter receipts, invoices, 
returns, debit notes, and credit notes.

Serial numbers are used to track individual items. Each serial number must be unique to one specific 
item.

Example: An electronics retailer can use serial numbers to record sales of items that have 
warranties.
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Lots Tab

On the Lots tab, you assign lot numbers to lotted items when you enter purchase orders, receipts, 
invoices, returns, debit notes, and credit notes.

Lot numbers are used to track groups of items. Unlike serial numbers, a lot number can be allocated 
to multiple items.

Example: A food distribution company can use lot numbers to record purchases and sales of 
unique batches of product.

Fields and Controls

Buttons

Add

Click this button to generate the number displayed in the Next Serial Number or Next Lot Number 
field.

Auto Alloc.

Click this button to allocate required serial numbers   or lot numbers automatically to items.

If you specify a number in the Auto-Allocate From field before you click   the button, Inventory 
Control assigns numbers starting with the number you   specify.

Allocated numbers appear in the list of serial number or lot numbers.

Auto Gen

Click the Auto Gen button to generate all the serial numbers or lot   numbers you require.

Note: When generating lot numbers, you must use the Make [ ] Lots OR Each Lot Has [ ] field 
to specify how lot numbers are generated.

The program generates and assigns serial numbers and lot numbers, starting   with the next serial 
number or lot number you specified.

If you did not specify the next number to use, the program automatically   assigns the next available 
numbers.

723Sage 300 2021 Purchase Orders User's Guide



Clear All

Click this button to remove all allocated numbers from   the list.

Close

Click Close to close the screen.

Item Number

Displays the item number from the document detail.

Location

Displays the location specified for the document detail.

Stock Date

The stock date is assigned when you ship items from inventory or return them to inventory.

The stock date is used to calculate expiry dates.

Example: If an item is received on August 1st, and the number of days from which it expires is 30, 
August 31st will be the expiry date.

The stock date is also used to calculate quarantine release dates for lots.

Lots tab

Allocated

Indicates how many lot quantities you have allocated.

Auto-Allocate From

Use this field to specify the lot number from which to start allocating quantities.

If you do not enter a number in this field, or if you clear the check box to the left of this field, 
quantities will be allocated starting with the first available lot.
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Generated

Indicates how many lot quantities you have generated and assigned to the items you are returning 
to inventory.

Lot Qty Required

Indicates the quantity you need to allocate to lots.

Make [ ] Lots OR Each Lot Has [ ]

Enter a number in one of these fields to specify how lot numbers are generated when you click the 
Auto-Gen. button:

 l Make [ ] Lots. Enter a number in this field to generate a specific number of lots. The required 
quantity is divided equally among the lots. If you return 400 items and you specify that 10 lots 
should be created, each lot has 40 items.

 l Each Lot Has [ ]. Enter a number in this field to generate lots with a specific quantity in each 
lot. If you return 400 items and you specify that there should be 100 items in each lot, 4 lots 
are generated.

Next Lot Number

This field displays the next sequential lot number available for the   item. You can:

 l Click Add   to add the displayed number to the Lot Numbers list. Repeat this for as   many 
numbers as you need.

 l Click Auto-Gen   to add the required number of lot numbers to the Lot Numbers list, starting   
from the displayed number.

After you add numbers, this field displays the next lot number that is now   available.

Remaining

Indicates how many lot quantities you need to assign.

When you are allocating or generating lot quantities, this field displays the difference between the lot 
quantities required and the number allocated or generated.

Note: You must allocate all the required lot quantities before you can save the allocation.
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Unit of Measure

Displays the unit of measure (such as DOZEN, BOX, or EACH) for an item.

The unit of measure determines how many lot numbers are Required, Generated, and Remaining.

Example: If the detail line specifies 2 as the order quantity, but the unit of measure is DOZEN and 
you have lots with available quantities of 6 EACH, when you click the Auto-Alloc. button, 0.5 
dozen is allocated for 4 lots.

Table

Lot Number

Indicates the lot numbers to which the current item quantities are allocated.

Quantity

Indicates the quantity of items assigned to a lot.

Serials tab

Allocated

Indicates how many serial numbers you have allocated.

Auto-Allocate From

Use this field to specify the serial number from which to start allocating serials.

If you do not enter a number in this field, or if you clear the check box to the left of this field, serial 
numbers will be allocated starting with the first available number.

Generated

Indicates how many serial numbers you have generated and assigned to the items you are 
returning to inventory.

Next Serial Number

This field displays the next sequential serial number available for   the item. You can:
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 l Click Add   to add the displayed number to the Serial Numbers list. Repeat this for   as many 
numbers as you need.

 l Click Auto-Gen   to add the required number of numbers to the Serial Numbers list, starting   
from the displayed number.

After you add numbers, this field displays the next number that is now available.

Remaining

Indicates how many serial numbers you need to assign.

When you are allocating or generating serial numbers, this field displays the difference between the 
serial numbers required and the number allocated or generated.

Note: You must allocate all the required serial numbers before you can save the allocation.

Serial Nos. Required

Indicates how many serial numbers you need to allocate.

Unit of Measure

Displays the unit of measure (such as DOZEN, BOX, or EACH) for an item.

The unit of measure determines how many serial numbers are Required, Allocated, and Remaining.

Example: If the detail line specifies 10 as the order quantity, but the unit of measure is DOZEN, 
you must allocate 120 serial numbers.

Table

Serial Number

Indicates the serial numbers that are allocated to the items in the current detail.
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Appendix B: Purchase Orders Security 
Authorizations

If security is turned on for your Sage 300 system, the system administrator must assign users security 
authorization for Purchase Orders screens.

For information on turning on security, setting up security groups, and assigning authorizations, refer 
to the System Manager help.

Note: To change the print destination for forms and reports, you must have Change Print 
Destination security authorization for Administrative Services.

To view records and to print reports in Purchase Orders, you must belong to a security group with 
Common Inquiry authorization. Common Inquiry authorization by itself does not let you edit any 
Purchase Orders records.

To edit records or perform processing tasks, the system administrator must grant the group access to 
additional tasks from the following list:

Security 
Authorization

Description

Sage 300 Inquiry Query Purchase Orders data in web screens. If you also have Export 
Processing authorization for Purchase Orders, print or export the results of 
these queries.

Common Inquiry Print setup reports.
View and print setup screens.

Cost Inquiry (in 
stand-alone P/O 
systems).

View default vendor cost during transaction entry.
With Show Receipt Costing Information authorization, also view receipts.

Create POs 
Automatically

Automatically create purchase orders from requisitions, create POs from I/C, 
create POs from O/E (if you also have Transaction Inquiry authorization for 

Purchase Orders Security Authorizations
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Security 
Authorization

Description

O/E).

Credit/Debit Note 
Entry

View, add, and post in Credit/Debit Note Entry. (Requires additional 
authorization to edit quantities and costs for returns.)
View Invoice Entry, Return List.
View and print Invoice List, Credit Note List, Debit Note List.
With Transaction Inquiry or Day End Processing authorization, view 
Purchase History.
With authorization for A/P, view, add, edit, and delete Vendor records.
With authorization for O/E, select O/E order numbers for item details.

Dashboard View the Purchase Orders dashboard.

Day End 
Processing 
(Service)

In a stand-alone system, run Day End Processing.
View and print Posting Journals, G/L Transactions, Payables Clearing Audit 
List, and Item Transaction History reports.
Post Create G/L Batch and Post A/P Batch
View, print, and—if Allow Edit Of Statistics is selected for P/O—edit statistics for 
requisitions, purchase orders, receipts, invoices, returns, credit/debit notes.

Edit Blanket PO 
Amount (requires 
Purchase Order 
Entry 
authorization)

Change the Original Amount field on blanket purchase orders.
Add and post purchase orders.

Edit Credit Note 
Cost (requires 
Credit/Debit Note 
Entry 
authorization)

View, add, edit costs in, and post credit notes and debit notes.
View Invoice Entry.

Edit Credit Note 
Quantity (requires 
Credit/Debit Note 
Entry 
authorization)

View, add, edit item quantity in, and post credit notes.
View Invoice Entry.
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Security 
Authorization

Description

Edit Invoiced Cost 
(requires Invoice 
Entry 
authorization)

View, add, edit costs in and post invoices. 

Edit Invoiced 
Quantity (requires 
Invoice Entry 
authorization)

Allows users to view, add, edit quantity and post Add invoices, change item 
quantities on invoices to receipts.

Export Processing Export the following records, if you are also authorized to use the 
corresponding screen: requisitions, purchase orders, receipts, invoices, 
returns, credit notes and debit notes, purchase statistics, ship-via codes, 
templates, additional costs, vendor contract costs, e-mail messages, and 
optional fields.

History Clearing Clear history and delete inactive records (in a stand-alone Purchase Orders 
system).

Import Processing Import, edit, and delete the following records, if you are also authorized to 
use the corresponding screen: ship-via codes, templates, additional costs, 
vendor contract costs, e-mail messages, optional fields, requisitions, 
purchase orders, receipts, purchase statistics (if Allow Edit Of Statistics is 
selected and you have Day End Processing authorization).
Show Receipt Costing Information authorization is also required to edit costs 
on receipts.

Import Processing 
and Credit/Debit 
Note Entry

Import and add credit notes and debit notes.
View posted credit notes and debit notes.

Import Processing 
and Invoice Entry

Import and add orders; view posted invoices.

Import Processing 
and Setup 
Maintenance

Print setup reports; import setup options.
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Security 
Authorization

Description

Invoice Entry View, add, and post invoices. (Requires additional authorization to edit 
quantities and costs entered for receipts.)
View Purchase History if you also have Transaction Inquiry or Day End 
Processing authorization.
View, add, edit, and delete Vendor records, if you have authorization for A/P.
Select O/E order numbers for item details, if you also have authorization for 
O/E.
View Receipt List.
View and print Invoice List.

Item Maintenance 
(Service)

In a stand-alone system, view Items and Vendor Details.

Mailing Label 
Printing

Print mailing labels. 

Purchase Order 
Entry

View, add, edit, delete and post purchase orders (default costs appear only if 
you also have Cost Inquiry authorization for I/C).
View Purchase History, if you also have Transaction Inquiry or Day End 
Processing authorization.
View, add, edit, and delete vendor records, if you also have authorization for 
A/P.
Select O/E order numbers for item details, if you also have authorization for 
O/E.
View, edit, delete, and post from Copy Purchase Orders.
View and print Purchase Order List.

Purchase Order 
Printing

Print Purchase Orders (both from the P/O Forms folder and Purchase Order 
Entry).

Receipt Entry View, add, edit, and post receipts. (Default costs appear only if you also have 
Show Receipt Costing Information for P/O or Cost Inquiry for in I/C (when no 
purchase order is referenced)).
View Purchase History, if you also have Transaction Inquiry or Day End 
Processing authorization.
Add and post invoices, if you also have Invoice Entry authorization.
View, add, edit, and delete vendor records (if you also have authorization for 
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Security 
Authorization

Description

A/P).
View Pending Receipts Inquiry.
View and print Receipt List.

Receiving Slip 
Printing

Print receiving slips (from the P/O Forms folder and the Receipt Entry 
screen).

Requisition Entry View, add, edit, delete and post requisitions.
View and print Purchase History, if you also have Transaction Inquiry or with 
Day End Processing authorization.
View, add, edit, and delete vendor records (if you have authorization for 
A/P).
Select O/E order numbers for item details, if you also have authorization for 
O/E.
View and print Requisition List (from the Transaction List screen).

Requisition 
Printing

View and print a Requisition List (from the Transaction List screen).

Requisitions 
Manual Approval

Post approved requisitions. (Unapproved requisitions are placed On Hold.)

Return Entry View, add, edit, and post returns. (Costs appear only if you have 
authorization for Cost Inquiry in I/C and you are entering returns without 
receipt numbers.)
View Purchase History, if you also have Transaction Inquiry or Day End 
Processing authorization.
View, add, edit, and delete vendor records, if you also have authorization for 
A/P.
Select O/E order numbers for item details, if you also have authorization for 
O/E.
View Receipt List, and view and print Return List.

Return Printing Print returns (from the P/O Forms folder and the Return Entry screen).

Setup 
Maintenance

Vew and edit Options and G/L Integration.
View, add, edit, and delete ship-via codes, vendor contract costs, e-mail 
messages, optional fields, templates, additional costs, and account sets.
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Security 
Authorization

Description

In a stand-alone system, view Items, vendor details, and weight units of 
measure.

Show 
Requisition/Receipt 
Costing 
Information

View costing information in Receipt Entry.

Transaction Inquiry View and print purchase statistics.
View and print purchase history and analytical reports.
View Requisition Entry, Purchase Order Entry, Receipt Entry, Invoice Entry, 
Return Entry, Credit/Debit Note Entry, and Pending Receipts Inquiry.

Transaction 
Optional Fields

Add, edit, and delete optional fields in Requisition Entry, Purchase Order 
Entry, Receipt Entry, Invoice Entry, Return Entry, Credit/Debit Note Entry, 
and in Purchase Orders functions that create transactions automatically. 

Sage 300 Web API Use the Sage 300 Web API to process GET, POST, PUT, PATCH, and 
DELETE requests.

Note: You must also have authorization to view and/or modify any records 
or transactions for which API requests will be processed.

About Requiring Approval for Requisitions
Purchase Orders provides a requisition approval system so you can ensure that only particular 
employees can approve purchase requisitions.

Requisitions that have been approved can be added to purchase orders.

Note: You must turn on security for the system database in the Sage 300 Database Setup program 
to use the requisition approval feature.

Requisition approval is based on the Requisitions Manual Approval security authorization.

 l If you have authorization to approve requisitions, all requisitions that you post are automatically 
approved.
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The Requisition Entry screen displays the approval status, as well as the approver's name, for 
a selected requisition. 

 l If you do not have authorization to approve requisitions, requisitions that you post are 
automatically put on hold, and their approval status remains Entered until they are posted by a 
user with approval authorization.

If you do not use the requisition approval feature, all requisitions are automatically approved when 
posted.

Turning on Requisition Approval

You turn on requisition approval by:

 l Selecting Require Approval in the P/O Options screen.

 l Turning on system-wide security in the Sage 300 Database Setup program.

 l Assigning approvers to security groups with Requisitions Manual Approval authorization.

 l Assigning other users to security groups that do not have Requisitions Manual Approval 
authorization.

Approving Requisitions that Are On Hold

Requisitions posted by user who do not have authorization to approve requisitions are automatically 
put on hold.

Requisition approvers must open unapproved requisitions, remove the On Hold status, and post the 
requisitions again to approve them. 

Approving a Purchase Requisition   

If the Require Approval option is selected in the P/O Options screen, purchase requisitions must be 
approved. You can approve a requisition only if you have the Requisitions Manual Approval security 
right (which is assigned in the Security Group screen in Administrative Services). Mo re ...

 l If your security group is assigned the security right to approve requisitions, all requisitions that 
you post are automatically approved, and your User ID appears in the Approver Name field 
after posting.

 l If your security group is not assigned the security right to approve requisitions, all requisitions 
that you post are automatically put on hold, and the Approval Status field will display "Entered" 
until the requisition is posted by a user with approval rights.                     

The approver will have to open the requisition, remove the on-hold status, and then post the 
requisition.
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To approve a requisition:

 1. Open Purchase Orders > P/O Transactions > Requisition Entry.

 2. In the Requisition Number field, use the Finder  or the navigation buttons to select the 
requisition you want to approve.

 3. Confirm that requisition details and totals are correct. Mo re ...

 l Review requisition details in the detail table.       

Note: Purchase Orders lets you hide columns and change column order.

You can also click the Detail button to review all the fields for a single detail.

 l On the Totals tab, review the requisition comment and item totals.

 l On the Optional Fields tab, review additional information for the requisition.

 4. On the Requisition tab, clear the On Hold option.              

Note: You cannot create purchase orders from on-hold requisitions.

 5. Click Post.

Purchase Order Entry lets you print the purchase requisition after posting. You can also print the 
purchase requisition separately, from the P/O Forms folder.

Note: If you have approval rights, the Approval Status field will say "Approved," and the description 
for your User ID will appear in the Approver Name field. If you do not have the security right to 
approve requisitions, the requisition will still be on hold after you post it, and the Approval Status 
field will display "Entered."

About Using Security with Purchase Orders   
You can use security with the Purchase Order Entry screen, separately specifying the persons who 
can:

 l Add, edit, post, or delete:

 l Requisitions.

 l Purchase orders.

 l Receipts.

 l Returns.
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 l Invoices.

 l Credit or debit notes.

 l Create purchase orders automatically from:

 l Requisitions.

 l Inventory Control.

 l Order Entry.

 l Approve purchase requisitions.

 l View cost information.

 l Edit invoiced quantities or costs.

 l Print:

 l Requisitions.

 l Purchase orders.

 l Receiving slips.

 l Returns.

 l Mailing labels.

 l Edit setup information and options.

 l Import or export purchase orders.

On blanket purchase orders, you can also assign security to the Original Amount field on the Order 
tab of the Purchase Order Entry screen. By restricting access to this field, you can ensure that no 
unauthorized changes are made to the amount.

You can assign security to item costs in Inventory Control if you do not want to display the item costs 
from Inventory Control on purchase order detail lines. The Unit Cost and Extended Cost fields will 
then display only zeroes in Purchase Orders, and you enter cost amounts when entering 
transactions.

For more information about using security, see "Purchase Orders Security Authorizations" (page 
729).

About Using Security with Receipts   
You can use security with the Receipt Entry screen, separately specifying the persons who can:

 l Add, edit, and invoice receipts.

 l View receipt costing information.
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 l Print receiving slips.

 l Import receipts.

 l Export receipts.

Purchase Orders provides a security authorization that allows warehouse staff to receive goods and 
enter quantities received, but prevent them from viewing cost information.

If users do not have Show Receipt Costing Information authorization, they cannot view item unit 
cost information on receipts—including totals, taxes, discounts, and additional cost amounts. (In other 
words, the Taxes tab, Additional Costs tab, and Totals tab do not appear on the Receipt Entry screen 
for users who do not have this authorization.)

Note: Pre-printed forms PORCP03.RPT and PORCP04.RPT will print cost information. To hide 
costs on these forms, you will need to customize them.

You can also assign security to item costs in Inventory Control if you do not want to display the item 
costs from Inventory Control on receipt detail lines. The Unit Cost and Extended Cost fields will then 
display only zeroes in Purchase Orders, although you can enter cost amounts when entering 
transactions.

Note: Item cost security in I/C does not apply to any Vendor Contract Costs entered in Purchase 
Orders.

For more information about using security, see "Purchase Orders Security Authorizations" (page 
729).
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Appendix C: Data Entry Tools, Tips, and 
Shortcuts

Use these tools and tips to speed up data entry in Sage 300.

Menu Commands
The following commands appear on the File, Settings (when available), and Help menus on Sage 300 
screens.

Note: Menu names and commands may differ by screen.

File Menu

Command Description Notes

Close Closes the current screen. You can also press Alt+F4 to close a screen.

Customize Lets you hide or display 
fields for users by UI Profile 
ID. 

Click File > Customize to hide fields on an open 
screen for users assigned to a UI Profile ID for that 
screen. 
When these fields are hidden, data that would 
normally appear in these fields cannot be printed.
For more information, see the help for the UI Profile 
Maintenance screen in the System Manager help.

Export Exports data records to 
other Sage 300 databases 
and non-Sage 300 
programs.

Click File > Export to export data. 
For example, you could export purchase statistics for 
use in spreadsheet or database software.

Note: You cannot export serial or lot numbers for 
kit components.

File Menu Commands
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Command Description Notes

Import Imports data records from 
other databases and from 
non-Sage 300 programs. 

Click File > Import to import data.
For example, you could use a spreadsheet to enter 
current requisitions         or purchase orders when setting 
up your system, and then import        the transactions 
later.

Note: You cannot import serial or lot numbers for 
kit components.

Print Prints the current report, 
list, or screen.

On screens with a corresponding report, click File > 
Print to open the report screen, which you use to 
select report options (if applicable) before printing 
the report.

Print Setup Selects a printer and sets 
printing options. 

Click File > Print Setup to set up your printer. You 
can select the default printer or select another from 
the list of installed printers.
For more information about print options, refer to 
your operating system documentation.

Save Saves the entries or 
changes you have made to 
the current screen.

If you have just entered a new record, Add appears 
instead of Save.

Settings Menu

Command Description Notes

Auto Clear Creates a new entry 
automatically when you 
post a transaction. 

Use the Auto Clear option to streamline data 
entry in transaction entry screens.

 l If Auto Clear is turned on, all fields are 
cleared each time you post a transaction, 
allowing you to immediately begin 
entering another transaction. 

 l If Auto Clear is turned off, transaction 
information remains on the screen after 
you post it. Click the New button to begin 
entering another transaction. 

Settings Menu Commands
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Command Description Notes

Clear Saved 
Settings

Restores default settings 
for a report.

This command is available for screens and for 
some reports.

Save Settings as 
Defaults

Saves the current report 
settings as personal 
defaults.

This command is available for screens and for 
some reports.

Help Menu

Command Description

About Displays version and copyright information for the current screen and program.

Contents Opens Help.

Using Help Opens Help to an introductory topic on how to use Help.

Help Menu Commands

Data Entry Tools and Shortcuts
Use these tools and shortcuts to speed up data entry in Sage 300.

Tool Shortcut 
Key

Description

 Alt + A Add or save a new record.

Calendar F4 
or 
Alt + Down 
Arrow

Display the calendar for a date field.

 Alt + C 
or 
Alt + F4

Close a screen or dialog box

 Del or 
Alt + D

Delete the selected row or record.

Data Entry Tools and Shortcuts
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Tool Shortcut 
Key

Description

Drilldown n/a The Drilldown  button appears beside some data entry fields and 

in some column headings in transaction detail entry tables. Click it to 
view details of the record or transaction in the corresponding field. Mo re ...

You can "drill down" both within Sage 300 programs and between 
separate programs. For example, you can drill down:

 l From General Ledger transactions to original transaction 
entries.

 l From Accounts Receivable to Order Entry.

 l From Accounts Payable to Purchase Orders.

 l From one transaction to an originating transaction (such as 
from a credit note to the invoice) within a program.

 Alt + E Open the Set Criteria dialog box to filter the list of records to display 
in the Finder.

Finder F5 The Finder  appears in some data entry fields, and in some table 

headings in transaction entry screens. Click it when you want to look 
up records you can select for a field. Mo re ...
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Tool Shortcut 
Key

Description

Use the Finder to search lists of codes maintained in         or used by 
Sage 300 programs (such as document numbers, terms codes, and 
account set codes). You can use menu commands in the Finder to 
help you search, as follows:

 l On the Settings menu, select  Color options to          highlight a field 
using color for the text or for the background.

 l On the Settings menu, select Field Name as Column           
Heading to use field descriptions or internal field names          as 
column headings.

 l On the Settings menu, use Columns options to specify 
columns that appear in the table. 

 l On the Global Settings menu, select the Go to Filter First 
option if you want the Finder to display the same filter settings 
you specified on the Find By list the next time you search this 
type of record.

You can also use the Auto Search option to locate a record quickly          
in a long list. To do this, select Auto Search and the criteria by which          
you want to search, and then begin typing the characters that start 
or are contained         in the field you are searching on.

Note: Records that appear in the Finder are restricted by          any 
selection criteria          you apply to this field.  If you cannot find the 
record you are          looking for with the Finder or the navigation 
buttons, check the Finder          to see whether any criteria are being 
used to limit the selection. If         necessary, remove the selection 
criteria. (For more information, see "Setting Finder Criteria" (page 
747))

Tip: For additional instructions on using the Finder to select 
records, press F1 when the Finder screen appears.

Go F7 The Go  button appears on screens where you must enter 

information (such as filter criteria) before viewing records that match 
the information you enter. Mo re ...

For example, on some Statistics and Inquiries screens, you must 
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Tool Shortcut 
Key

Description

select a range of years and periods and specify an item number or 
vendor number before you can view statistics. (If you use 
multicurrency accounting, you must also specify a currency.) After 
specifying this information, you click the Go  button or press F7 to 

view statistics.

Navigation n/a Click the Previous and Next buttons to navigate through a list of 
existing records, or click the First and Last buttons to navigate to the 
first and last records. Mo re ...

Note: If you clicked the Set Criteria button on the Finder screen 
and specified criteria, only records that match the criteria you 
specified will appear when you use the navigation buttons. If a 
record does not appear, click the Finder  and check to see 

whether you have specified criteria that prevent the record from 
appearing.

New n/a Click the New  button or select New from a menu to begin 

creating a new record.

 Alt + S Save changes to the displayed record.

Zoom F9 Click the Zoom  button  or press the F9 key to view or enter 

supplementary information        for a transaction detail or for a field. Mo re ...
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Tool Shortcut 
Key

Description

In any detail entry table, you can select a detail line and press F9 to 
open a screen that displays all the fields for a single detail,          including 
additional tax-related fields that do not appear on the detail          table. 
You can edit existing details, and even add new details for         the 
document.
Beside any field that displays a Zoom button, you can click the 
button (         or select the field and then press F9) to open          a separate 
screen where you can view and enter supplementary information 
specific         to that field. 

Note: If another Zoom button appears on the detail screen, you 
can click it or press Shift+F9 to open the new detail screen. (If you 
simply press F9 again, the first detail screen closes.) This function 
is referred to as "Detail Zoom." To close the second detail screen, 
press Shift+F9 again.

After viewing or editing the information in the detail screen, you can 
press F9 to close the screen.

Working with Detail Entry Tables
The first tab of each transaction entry screen in Sage 300 contains    a detail entry table that shows the 
document details in tabular format.

In most cases, you can enter all the necessary details for a document    right on the table.

Tip: If there are more columns than can be displayed at one time, you can     use the horizontal scroll 
bar at the bottom of a list to view the additional     columns. You can also rearrange the order of 
columns, or change column    widths, consistent with how you enter data. 

You can also view and edit all the fields for a single detail on a separate    Detail Items/Taxes screen. To 
view this screen, select a detail line and click the Item/Tax button below the table, or press F9. 

Note: You use the Detail Items/Taxes screen to view or change tax    information for a detail. Detail 
tax fields do not appear in the detail table.
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To add details using the detail table, do one of the following:

 l If a blank line is highlighted,      tab to the Item Number field, then either type the item number or 
select     it from the Finder. Enter the remaining information for the detail.

 l To start a new line, press      Insert or tab through the end of the last line on the table. 

If you want       to insert a new line in a specific location, highlight the line above     the location, and 
then press Insert.

Note: A detail line is saved as you enter it on the detail entry table. 

To edit details using the detail table: 

 l Select the line you     want to edit, and then enter your changes on that line.

Note: For information about using your keyboard to move within a detail table, see "Keyboard 
Shortcuts for Detail Tables" (page 746)

To delete details using the detail table: 

 1. Select the line you     want to delete.

 2. Press the Delete key on     your keyboard.

 3. If you see a message asking     you to confirm the deletion, click Yes.

To edit item information or detail tax information using the Detail Items/Taxes screen:

 1. Select the detail on the table, and  then either click the Item/Tax button, or press F9.

 2. Edit the item information and/or change     the Tax Class or Tax Included options for the detail.

Keyboard Shortcuts for Detail Tables
Use the following keyboard shortcuts to navigate in detail tables.

Key Menu Command Action

Ins/Insert New Insert a blank row to add a new record.

Del/Delete Delete Remove the selected row.

Up or Down Arrow  Go up or down one row.
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Key Menu Command Action

Left or Right Arrow  Go left or right one column.

Pg        Up  Go to the top row in view.

Pg Dn  Go to the bottom row in view.

Home First Go to the first row in a list.

End Last Go to the last row in a list.

Tab or Enter; 
Shift+Tab        or 
Shift+Enter

 Go to the next or previous column in a list.

Setting Finder Criteria
To help you search quickly through a long list of records, you can use criteria to restrict the records 
that are displayed in the Finder and when    you use the navigation buttons. 

However, at other times, if the Finder uses criteria, it    might not display all the records you expect to 
see.

To check or remove the criteria:

 1. Click the Finder .

 2. Click the Set Criteria button.

 3. On the screen that appears, click the Clear button.

For instructions on setting criteria, click the Help button when the    Set Criteria screen appears.

Using Visual Basic Macros
System Manager provides full support for Microsoft Visual Basic for Applications (VBA), allowing 
Purchase Orders to integrate smoothly with Microsoft’s entire Office suite.

You can record, edit, and run VBA macros from within Sage 300. You can also continue to run VBA 
macros for another application that includes VBA (such as Microsoft Excel).
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Purchase Orders comes with a workflow macro that lets employees enter purchase requests that can 
be sent as e-mail attachments to managers for approval or rejection. The macro creates purchase 
orders for approved requests.

The workflow macro consists of:

 l WorkReq.avb. Mo re ...

This macro lets employees complete a form to request the purchase of items and to specify the 
estimated cost of the request. The request is sent as an attachment to the e-mail address 
specified on the request for approval. A Purchase Orders requisition is automatically posted for 
the request.

The WorkReq.avb macro should be available only to employees who have authorization to 
enter requisitions in Purchase Orders.

 l Workflow.avb. Mo re ...

This macro lets employees send the details of requisitions for approval. The employee 
highlights the requisition for which approval is required, and sends it as an e-mail attachment to 
the manager’s e-mail address.

The Workflow.avb macro should be available only to employees who have authorization to 
enter requisitions in Purchase Orders.

 l Workmonitor.avb. Mo re ...

This macro lets managers approve requests for purchases from employees. When a 
Requisition Request e-mail is received from an employee, the manager can either approve or 
reject the request. If the request is approved, a purchase order is automatically created for the 
item and an e-mail confirmation is sent to the employee. If the request is rejected, the manager 
can provide the reason for rejecting the request and an e-mail is sent to the employee.

The Workmonitor.avb macro should be available only to employees who have authorization to 
approve requisitions.

To run a macro:

 1. On the Sage 300 Desktop, click Run Macro (in the Macros section of the ribbon).

The Run Macro screen appears.

 2. In the Files Of Type field, select VBA Macro Files.

 3. Double-click the macro you want to run.
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To add an icon for a macro to your desktop:

 1. On the Sage 300 Desktop, select (highlight) Purchase Orders, and then click Object > New > 
Macro.

 2. In the Title field, enter a title for the macro, such as Requisition Request or Requisition 
Approval.

 3. Click Next.

 4. Click Browse, and then select the folder and the macro (for example, {installation 
path}\macros\workreq.avb).

 5. Click Finish.
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Appendix D: Support and Resources

Find support and resources to help get Sage 300 up and running quickly.

Finding Help and Documentation
You can find information about setting up and using Sage 300 in the Sage 300 help and in the product 
documentation included with this release.

Note: For technical support, visit our customer support website at https://support.na.sage.com or 
contact your Sage business partner.

Context-Sensitive Help

Sage 300 features context-sensitive help that you can use to quickly open and view articles and 
information directly from Sage 300 screens.

 l On the Sage 300 Desktop, press F1 to view help for the current screen.

 l On Sage 300 Web Screens, click the help menu at the top of the screen to see help articles and 
resources related to your current task.

Product Documentation

Sage 300 includes guides in printable PDF format, including the Installation and Administration 
Guide, Upgrade Guide, and other documentation related to installation and setup.

These guides are available in the Docs folder on the Sage 300 server, and online at:

 l https://cdn.na.sage.com/docs/en/customer/300erp/Sage300ERP_Documentation.htm.

To view the guides in the Docs folder:

 l On the Windows taskbar, click Start > Programs > Sage 300 > Documentation.
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Support and Resources
Use the links below to find instructions,   software training, one-on-one support, technical 
specifications, or other   resources to get Sage 300 working smoothly for your business.

Your Sage Business Partner is also an excellent resource to consult when you have questions about 
Sage 300.

How can we help you?

I'm setting up Sage 300 and need information or assistance

 l Sage 300 Resources online — 
https://cdn.na.sage.com/docs/en/customer/300erp/Sage300ERP_Documentation.htm

Find and download user guides, technical specifications, and more.

 l Sage 300 Web Portal — www.sage.com/us/erp/sage-300

Find a business partner, get priority support, and more.

I'm looking for instructions to complete a task in Sage 300

While using Sage 300, you can get instructions directly from the software in the following ways:

 l Contextual Help  — To see topics related to your current task:

 l In the Sage 300 Desktop, press F1.

 l In Sage 300 Web Screens, click the help menu at the top of the screen.

 l Help Topics — To explore topics and information in the Sage 300 Desktop, click Help > Help 
Topics.

I think something is broken, or I'm getting error messages                 

Search our knowledge base for solutions to common issues, or contact us for one-on-one 
assistance.

 l Knowledge Base — https://support.na.sage.com

Find answers and solutions to FAQs and known software issues.
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 l Customer Center — https://customers.sagenorthamerica.com/irj/portal/anonymous/login

Exclusive support for Sage customers.

 l Partner Center — https://partners.sagenorthamerica.com

Exclusive support for Sage partners.

I'm looking for downloads, updates, or technical specifications                 

Find product updates, download resources, or review technical specifications for Sage 300.

 l Sage 300 Resources online — 
https://cdn.na.sage.com/docs/en/customer/300erp/Sage300ERP_Documentation.htm

Find and download user guides, technical specifications, and more.

 l Sage Business Care — www.sage.com/us/erp/sage-business-care

Find links to support services, contact our support team, and learn how to guarantee your 
Sage software is always up to date.

I want to become a more skilled user of Sage 300

Find links to Sage software training, online communities, and more.

 l Sage University — https://sageu.csod.com/LMS/catalog/Welcome.aspx?tab_page_id=-67

Convenient, professional training options to help you achieve your business goals.

 l Sage Summit — www.sage.com/sage-summit

Connect with peers and experts at our annual conference.

 l Priority Software Support — www.sage.com/us/erp/sage-business-care

Learn how to get unlimited support by phone, e-mail, and live chat.

I want to share knowledge with other Sage 300 users                 

Find and share tips, tricks, and solutions online in the Sage 300 Community.

 l Sage 300 Community — http://sagecity.na.sage.com/support_communities/sage300_erp

Explore Sage 300 blogs, discussions, FAQs, resources, and more. 
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 l Sage Summit — www.sage.com/sage-summit

Connect with peers and experts at our annual conference.

I want to contact a Sage 300 representative                 

 l Support and Services — http://support.na.sage.com

Find links to support services, contact our support team, and learn how to guarantee your 
Sage software is always up to date.
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A

access  737

account sets  39, 300

deleting  40

editing  40

fields  314

removing  40

Account Sets Report screen  300

Account Sets screen  314

fields and controls  314

Accounts Payable

posting invoices  275

accumulating statistics  14

activate Serialized Inventory pop-ups  187, 

631

adding details  102, 562, 675

adding vendor details  63

additional cost codes  41, 238, 301

Additional Cost Vendor Information screen

fields and controls  646

additional costs  131, 181, 301

allocating to multiple receipts  147

deleting  44

editing  44

entering  129, 171, 398

entering on invoices  147

removing  44

Additional Costs Detail Costs/Taxes 
screen  503

fields and controls  504, 639, 647

Additional Costs Report screen  301

fields and controls  301

Additional Costs screen  316

fields and controls  316

Aged Purchase Orders Report  279

Aged Purchase Orders Report screen  279

fields and controls  280

aging  279

approval for requisitions  92, 734-735

assigning lot numbers  628

assigning serial numbers  633

to P/O Receipts  187, 631

to P/O Returns  188, 717

audit trail  282, 284-285, 297

Auto-Gen button  189, 627

automatically creating purchase 
orders  110, 246, 250, 254

Index
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B

backorders  296

batches  202

creating  275

general ledger  275

Bill-To Location screen  434, 491, 544, 611, 

699

fields and controls  434, 491, 545, 611, 

700

blanket purchase orders  78, 106

buttons

Drilldown  742

Finder  742

Go  743

Navigation  744

New  744

Zoom  744

C

changing a serial number  187-188, 631, 

717

checking totals  165

Clear History screen  271

fields and controls  271

clearing  278

clearing historical data  211

history  271

Payables Clearing Audit list  271

statistics  271

codes  4, 24

additional cost  41

ship-via  58, 308

template  60

templates  309

commands  741

company address  344

company name  344

company tab  344

consolidating requisition details on 
purchase orders  112

contract costs  310

copy purchase orders  122, 389

Copy Purchase Orders screen  389

fields and controls  389

cost  141

prorating by  141

Cost Allocation Details screen  509

fields and controls  449, 509, 643

Cost Allocation screen  448, 642

costs

additional  129, 301, 398

additional details  562

Create Batch screen  275

fields and controls  275

create e-mail messages  45

Create Invoice From Receipts screen  493

fields and controls  494
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Create POs From I/C screen  246

Create POs From O/E screen  250

fields and controls  250

Create POs From Requisitions screen  254, 

547

fields and controls  254, 548

Create Purchase Orders screens

Create POs From I/C  246

Create POs From O/E  250

Create POs From Requisitions  254

creating

batches  275

transactions  102-103, 106-107, 110, 

126, 157, 171

creating G/L batches  202

creating invoices/multiple receipts  493

credit note statistics  379

credit notes  169, 171, 197

adding details  398

Credit/Debit Note Entry screen  397

Detail Item/Taxes screen  436

fields and controls  400

credit/debit notes

zoomed screens  443

currency  23-24, 90

custom fields  See optional fields

custom forms

about LNTYPE codes  70

customizing forms  69

D

data entry screens  746

datapiped forms

parameters  70

day-end processing  16, 195-200

Day End Processing (stand-alone)  277

debit notes  169, 171, 197

adding details  398

default expense account  27

default options and settings  9, 29, 61, 359

Delete Inactive Records screen  278

fields and controls  278

deleting  214, 271

Delivery Method  321

Detail Comments screen  443-444, 503, 

559, 637, 669, 701

Detail Costs/Taxes screen  638

fields and controls  445

detail entry tables  745

Detail Items screen  669

fields and controls  670

Detail Items/Taxes screen  435, 494, 549, 

617, 701

credit notes and debit notes  436

fields and controls  436, 495, 549, 618, 

702

Receipt Entry  618
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details  102

adding  746

adding for credit/debit notes  398

consolidating  112

deleting  746

detail costs/taxes  85

detail items/taxes  85

editing  746

displaying lot numbers  189, 627

Distribute Proration Details screen  511

fields and controls  512

document numbering options  5

document numbers

assigned to generated POs  110

document tax information  83

documentation and help  751

documents    See also transactions

documents tab  345

Drilldown button  742

Drop-Shipment Address screen  556, 614, 

665

fields and controls  557, 614, 665, 667

E

e-mail

printing reports as attachments to  241

E-mail Messages report screen  303

E-mail Messages screen  321

e-mail POs and returns  45, 321

replacement symbols  46

editing

exchange rates  91

purchase orders  103

tax information  83

Email Messages screen

fields and controls  321

email POs and returns  303

entering

additional costs  129, 398

credit notes and debit notes  171

exchange rates  91

invoices with receipts  648

returns  161

exchange rates  90-91

expense accounts  27

exporting  38, 82, 129, 157

F

fax number  344

fields  80

File menu commands  739

Close  739

Customize  739

Export  739

Import  740

Print  740

Print Setup  740
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Save  740

Finder button  742

setting criteria  747

Fixed Assets screen

Receipt Entry  636

forms  69

customizing  70

printing  222

function keys  741

future purchase orders  78, 107

G

G/L description  27

G/L Integration Report screen  304

G/L Integration screen  323

fields and controls  325

G/L reference  30

G/L transactions  79

G/L Transactions Report screen  282

General Ledger  35, 202, 275, 282

General Ledger journal entries  79

general ledger options  33

general ledger transactions  282

Go button  743

guides and documentation  751

H

Help menu  741

history  211, 240, 271, 289, 294

clearing  271

keeping  14

I

icons  741

importing  38, 82, 103, 128

inactive records  278

deleting  214

Inquiry screens

Pending Receipt Inquiry  383

Purchase History  375

Purchase History Detail  376

Purchase Statistics  379

Receipt Details  386

Installation and Administration Guide  751

installing Sage 300, documentation on  751

integration with General Ledger  323

integration with Project and Job Costing

converting UOMs  181

Inventory Control  36, 110

Invoice Entry screen  451

fields and controls  454

Invoice screen (in Receipt Entry)  648

fields and controls  649

invoice statistics  379

invoices  146, 198

additional costs on  147
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invoicing  145-146

item and tax details  84

item records

deleting  50

editing  50

removing  50

item transaction history  283

Item Transaction History Report screen  283

item transactions  283

items  48, 305

setting up  48

Items Report screen  305

Items screen  335

fields and controls  336

J

job-related transactions  179, 181, 185, 196

journal entries  79

K

keep purchase history  14

keyboard shortcuts

for detail tables  746

keys  741

L

lists  297

LNTYPE code  70

look up receipts  383

lot numbers  186, 189, 191, 628, 714

lot numbers count  190, 714

on Allocation/Generation screen  723

lot tracking  186

Lot Tracking screens

fields and controls  628, 715

M

macros  747

mailing labels  223

Mailing Labels screen  257

fields and controls  257

managing serial numbers  188, 717

manual proration  143

menus and commands  739, 741

File  739

Help  741

Settings  740

month-end  193, 271

multicurrency  23-24, 90

multiple receipts, entering on an 
invoice  493

N

Navigation buttons  744

New button  744

Number of labels/returns  698
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numbers  5, 25, 345

assigned to generated POs  110

O

optional fields  51, 80

setting up  53, 340

settings  340

transactions  439, 498, 553, 622, 673, 

689, 710

optional fields report  306

Optional Fields Report screen  306

fields and controls  306

Optional Fields screen  340

fields and controls  341

options  5, 18, 27, 307, 344, 352

about  18

settings  18

Options Report screen  307

Options screen  344

fields and controls  346

Order Entry  110

creating purchase orders from  250

orders  36

overview  344, 359

P

P/O processing options  19

setting up  19

passwords  736-737

Payables Clearing Audit List report 
screen  284

Pending Receipts Inquiry screen  383

fields and controls  383

periodic processing  193-194, 214

Periodic Processing screens

Clear History  271

Create Batch  275

Delete Inactive Records  278

posting  149

posting journals  285

Posting Journals screen  285

fields and controls  286

posting options  21, 323, 344

print destinations  221, 241

e-mail attachment  241

file  241

physical printer  241

preview (on screen)  241

Printed status  238, 244

printer

assigning to a specific report  240

printer, physical

setting as print destination  241

printing  158, 225, 233, 283, 289, 296, 300, 

305, 312-313

reports  244

setting a print destination  221
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vendor forms  222

printing reports  240

processing  90, 124, 145, 150, 155, 169, 

193-194, 196-200, 209, 211, 277

processing options  345

prorating  131, 133, 141, 143

proration  43

of additional costs on invoices  147

of additional costs to received items  129

of taxes for additional costs  147

purchase  379

purchase history  289, 375

about  14

Purchase History Detail screen  376

fields and controls  376

Purchase History report

printing  243

Purchase History Report screen  289

Purchase History screen  375

purchase order

printing single  229, 232

Purchase Order Action Report screen  291

fields and controls  292

purchase order approval  100, 734-735

Purchase Order Entry screen  517

fields and controls  519

purchase order forms

editing  71

non-datapiped  71

purchase order history  289, 294

Purchase Order screens

Requisition Entry  651

purchase orders  108, 279

entering a standing PO  108

Purchase Orders  227

Purchase Orders (program)  3

purchase orders (transactions)  77-78, 80, 

91, 102-103, 106-107, 110, 122, 199, 

225, 736

creating  250, 254

Purchase Orders codes

codes  25

Purchase Orders forms  67

Purchase Orders G/L entries  79

Purchase Orders reports

about  238

Purchase Orders screen  267

fields and controls  268

Purchase Orders security  737-738

purchase statistics  15, 294, 379

Purchase Statistics Report  294

Purchase Statistics screen  379

fields and controls  295, 379

purchases  289, 294

Q

quantity  423, 439, 689, 710

prorating by  133
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quantity received  383

R

receipt details  618

Detail Items/Taxes screen  618

Receipt Details screen  386

fields and controls  387

Receipt Entry

Fixed Assets screen  636

receipt entry screen  137, 139

additional costs  139

creating  137

Receipt Entry screen  561

fields and controls  566

receipt quantities  386

receipts  124-125, 128-129, 131, 134, 137, 

143, 146, 158, 199, 562, 737

Detail Items/Taxes screen  618

entering additional costs  129

invoicing  648

zoomed screens  618, 645, 647

receiving slips  224

Receiving Slips screen  259

fields and controls  260

records  40, 44, 50, 59, 211

adding  40, 43, 49, 58-59

deleting  64, 214, 278

editing  64

ship-via  58-59

reference  30

Remit-To Location screen  492

removing  271, 278

reorder quantities  110

replacement symbols  46

Report screens

Additional Costs  301

Optional Fields  306

Payables Clearing Audit List  284

Purchase Order Action  291

Purchase Statistics  294

Ship-Via Codes  308

Transaction List  297

Vendor Details Report  312

reporting  238

reporting Purchase Orders data  66

reports  66, 238, 283, 312

Additional Costs  301

Aged Purchase Orders  279

analytical reports  239

E-mail Messages Report  303

forms  67

Optional Fields Report  306

Options Report  307

Posting Journals  285

print destinations  240-241

Printed status  238, 244

printing  244

printing Purchase History  243
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printing to a destination  221

Purchase Order Action  291

Purchase Statistics  294

settings  241

setup reports  238

Ship-Via Codes  308

Templates  309

Transaction List  297

Vendor Contract Costs  310

Reports screens

Account Sets Report  300

Aged Purchase Orders  279

E-mail Messages  303

G/L Integration Report  304

G/L Transactions  282

Item Transaction History  283

Items Report  305

Options  307

Posting Journals  285

Purchase History Report  289

Shippable Backorders Report  296

Templates  309

Vendor Contract Costs  310

Weight Units of Measure Report  313

reproration  43, 160

require requisition approval  92, 734

requisition approval  92, 734-735

Requisition Entry  95

Requisition Entry screen  651

fields and controls  653

requisitions  94, 97-99, 110, 231, 359, 651

creating  94

creating purchase orders from  254

deleting  99

editing  97

importing  98

job-related  93

new  94

printing  98

removing  99

Requisitions screen  262

fields and controls  263

restricting access  737

return

printing single  236

Return Entry

screen  161

Return Entry screen  675

fields and controls  677

Returned Serial Numbers list  188, 717

returns  149, 155, 157-158, 165, 200, 233-
234, 676

entering  161

entering taxes for  676

zoomed screens  699, 702

Returns screen  264

fields and controls  264
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S

sales orders  250

creating purchase orders from  250

screen guides  245

Reports  279

search pending receipts  383

security  736-737

security authorizations  729

serial numbers  186-188, 633, 719

on SN/LT Allocation/Generation 
screen  722

Serial/Lot Number Generation screen  721

Serial/Lot Numbers Allocation/Generation 
screen  722

fields and controls  723

Serialized Inventory popups

fields and controls  631, 634, 717, 719

serialized items  186

setting up  3, 39, 41, 53, 58, 60, 63, 340

setting up optional fields  56

purchase orders  56

settings

reports  241

Settings menu commands  740

Auto Clear  740

Clear Saved Settings  741

Save Settings as Defaults  741

setup  357, 359

options  307

Setup screen

Optional Fields  340

Setup screens

Account Sets  314

Additional Costs  316

E-Mail Messages  321

G/L Integration  323

Items  335

Options  344

Ship-Via Codes  357

Templates  359

Vendor Contract Costs  362

Vendor Details  369

Weight Units of Measure  372

Ship-To Location screen  546, 612

fields and controls  546, 613

ship-via addresses  308, 357

ship-via codes  58, 238, 308

Ship-Via Codes Report screen  308

fields and controls  308

Ship-Via Codes screen  357

fields and controls  357

shippable backorders  296

Shippable Backorders Report screen  296

shipping methods  308

shortcuts  741

765Sage 300 2021 Purchase Orders User's Guide



stand-alone system  277

day end processing  277

standing purchase orders  77

entering  108

statistics  14, 239, 294, 379

clearing  271

status  239

reports  239

steps  3

sufficient stock  383

suppliers  63, 369

symbols  46

system options  307, 344

T

tax information  83

taxes  83, 157, 676

technical support  751-752

telephone number  344

templates  60-62, 309, 359

adding  61

customizing  70

deleting  62

editing  62

Templates report

fields and controls  309

Templates Report screen  309

Templates screen  359

fields and controls  359

tools  741

totals  137, 165

credit/debit note  399

return  676-677

track returned items  186, 189, 191, 628, 

714

tracking returned items  186-188, 633, 719

tracking stock  186-188, 633, 719

Transaction details, job-related  179

Transaction List Report screen  297

Transaction List screen

fields and controls  298

transaction reports  239

transaction screens

Serial/Lot Number Allocation  721

Transaction screens

Additional Costs Detail Costs/Taxes  503

Bill-To Location  434, 491, 544, 611, 699

Cost Allocation  448, 642

Cost Allocation Details  509

Create Invoice From Receipts  493

Create PO From Requisition  547

Credit/Debit Note Entry  397

Detail Comments  443-444, 503, 559, 

637, 669, 701

Detail Costs/Taxes  638

Detail Items  669

Detail Items/Taxes  494, 549, 617, 701

Detail Items/Taxes screen  435

Distribute Proration Details  511

766Sage 300 2021 Purchase Orders User's Guide



Drop-Shipment Address  556, 614, 665

Invoice (in Receipt Entry)  648

Purchase Order Entry  517

Remit-To Location  492

Ship-To Location  546, 612

Vendor Information Details  543

transactions  79, 82-83, 90, 102-103, 110, 

146, 149, 155, 169, 171, 211, 225, 

297, 379, 397

Transactions screens

Copy Purchase Orders  389

Invoice Entry  451

Receipt Entry  561

Return Entry  675

U

Units of weight for items (stand-alone 
P/O)  13

Upgrade Guide  751

using multicurrency accounting  24

V

vendor contract costs  65

deleting  65

editing  65

Vendor Contract Costs Report screen  310

fields and controls  310

Vendor Contract Costs screen  362

fields and controls  363

vendor details  63-64, 312

adding  63

Vendor Details Report screen  312

Vendor Details screen  369

fields and controls  369

vendor forms  67, 69

Mailing Labels  257

printing  222

Purchase Orders  267

Receiving Slips  259

Requisitions  262

Returns  264

Vendor Information Details screen  543

fields and controls  544

vendor tax information  83

View Details  376

visual basic macros  747

W

weight units of measure  313

Weight units of measure

defining (stand-alone P/O)  13

Weight Units of Measure Report 
screen  313

Weight Units of Measure screen  372

fields and controls  373

Workflow macro  747
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Y

year-end  193

Z

Zoom button  744
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